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""¦vuõQ, ©õØÓ©øh¢x \›¯õÚ AÔÂß ‰»® 

|õmkUS¨ ÷£õß÷Ó •Ê E»QØS® AÔÄa _hµõS[PÒ''

öPÍµÁ PÀÂ Aø©a\›ß ö\´v

Ph¢x ö\ßÓ C¸ u\õ¨u[PÐUS Asª¯ Põ»©õÚx E»P Áµ»õØÔÀ Â÷\h öuõÈÝm£ 

©õØÓ[PÒ {PÌ¢uöuõ¸ Põ»©õS®. uPÁÀ öuõÈÝm£® ©ØÖ® FhP[PøÍ •ßÚo¯õPU 

öPõsh £À÷ÁÖ xøÓPÎÀ HØ£mh x›u ÁÍºa]²hß Cøn¢x ©õnÁº  ©zv°À £À÷ÁÖ                

\ÁõÀPÒ ÷uõßÔ²ÒÍÚ. CßÖ \‰PzvÀ Põn¨£k® öuõÈÀÁõ´¨¤ß C¯À£õÚx ªP 

ÂøµÂÀ ]Ó¨£õÚ ©õØÓ[PÐUS Em£h»õ®.  CzuøP¯ `Ç¼À ¦v¯ öuõÈÝm£ AÔøÁ²® 

vÓøÚ²® Ai¨£øh¯õPU öPõshöuõ¸ \‰PzvÀ öÁÆ÷ÁÖ Âu©õÚ C»m\U PnUPõÚ 

öuõÈÀÁõ´¨¦PÒ E¸ÁõQßÓÚ. GvºPõ»  \ÁõÀPøÍ öÁØÔöPõÒÐ® ö£õ¸mk }[PÒ 

£»®ö£Ó ÷Áskö©ß£x PÀÂ Aø©a\öµßÓ ÁøP°À GÚx® G©x Aµ]Úx® ¤µuõÚ 

÷|õUP©õS®.

C»Á\U PÀÂ°ß ]Ó¨¦ªUPöuõ¸ ¤µv£»ÚõP E[PÐUS C»Á\©õPU QøhzxÒÍ C¢¡ø» 

^µõP¨ £¯ß£kzxÁx® Auß‰»® ÷uøÁ¯õÚ AÔøÁ¨ ö£ØÖUöPõÒÁx÷© E[PÒ J÷µ 

SÔU÷PõÍõP C¸UP ÷Ásk®. Azxhß E[PÒ ö£Ø÷ÓõºPÐm£h ‰z÷uõ›ß ]µ©zvÚx® 

v¯õPzvÚx® ¤µv£»ÚõP÷Á C»Á\¨ £õh¡ÀPøÍ Aµ]ÚõÀ E[PÐUS¨ ö£ØÖzuµ •iQÓx 

Gß£øu²® }[PÒ ÂÍ[QUöPõÒÍ ÷Ásk®.

Kº Aµ\õP |õ®, ªP ÷ÁP©õP ©õÔ Á¸® E»P ©õØÓzvØS¨ ö£õ¸¢x® ÂuzvÀ ¦v¯ 

£õhzvmhzøu Aø©¨£x® PÀÂz xøÓ°À wºUP©õÚ ©õØÓ[PøÍ ÷©ØöPõÒÁx® J¸   |õmiß 

GvºPõ»® PÀÂ ‰»÷© ]Ó¨£øh²® Gß£øu ªP |ßÓõP¨ ¦›¢x øÁzxÒÍuÚõ÷»÷¯¯õS®. 

C»Á\U PÀÂ°ß Ea\¨ £¯øÚ AÝ£Âzx |õmiØS ©õzvµ©ßÔ E»SU÷P ö\¯ØÔÓßªUP Kº 

C»[øP¨ ¤µø\¯õP }[PÐ® ÁÍº¢x {Ø£uØS wº©õÛUP ÷Ási²ÒÍx. CuØPõP C¢¡ø»¨ 

£¯ß£kzv }[PÒ ö£ØÖUöPõÒÐ® AÔÄ E[PÐUS EuÄö©ß£x GÚx |®¤UøP¯õS®.

Aµ_ E[PÒ PÀÂ°ß {ªzu® ö\»ÂkQßÓ ªPU Ti¯ {vzöuõøPUS ö£Ö©vö¯õßøÓa                  

÷\º¨£x E[PÒ Phø©¯õÁxhß £õh\õø»U PÀÂ³hõP }[PÒ ö£ØÖUöPõÒÐ® AÔÄ 

©ØÖ® vÓßPÒ ÷£õßÓøÁ÷¯ E[PÒ GvºPõ»zøuz wº©õÛUQßÓÚ Gß£øu²® }[PÒ |ßS 

PÁÚzvØöPõÒÍ ÷Ásk®. }[PÒ \‰PzvÀ G¢u {ø»°¼¸¢u÷£õx® \P» uøhPøÍ²® uõsi 

\‰PzvÀ ªP E¯º¢uöuõ¸ ChzvØS¨ £¯oUS® BØÓÀ PÀÂ ‰»©õP÷Á E[PÐUSU 

QøhUQßÓx Gß£øu }[PÒ |ßS ÂÍ[QUöPõÒÍ ÷Ásk®.

GÚ÷Á C»Á\U PÀÂ°ß ]Ó¢u ¤µv£»øÚ¨ ö£ØÖ, ©v¨¦ ªUPöuõ¸ ¤µø\¯õP |õøÍ¯ 
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|õ©zøu C»[Pa ö\´ÁuØS® E[PÍõÀ C¯¾©õPmk® GÚ PÀÂ Aø©a\º GßÓ ÁøP°À |õß 

¤µõºzvUQß÷Óß.

AQ» Âµõä Põ›¯Á\®

PÀÂ Aø©a\º
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C»Á\¨ £õh¡ÀC»Á\¨ £õh¡ÀPB 1

C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

●	 uµÄPøÍ²® uPÁÀPøÍ²® ÷ÁÖ£kzv CÚ[PõnÀ

●	 öuõSv Gß£x ¯õx?

●	 vÚ\› ÁõÌÂÀ Põn¨£k® öuõSvPÒ

●	 uµ©õÚ uPÁ¼ß C¯À¦PÒ

●	 uPÁÀ, öuõhº£õhÀ  öuõÈÝm£Â¯À

●	 uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß ¤µ÷¯õP[PÒ

●	 PoÛ°ß £›nõ© ÁÍºa]

		Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

 1.1 uµÄPÐ® uPÁÀPÐ®
	

	 ÷ÁÖ÷ÁÓõP Gkzx, P¸zx AÎUP¨£h •i¯õu GsPÒ, ö\õØPÒ, 

SÔ±kPÒ, Áøµ¦PÒ BQ¯Ú uµÄPÒ (Data)	GÚ¨£k®.

 

 uµÄPøÍz öuõS¨£uß ‰»•® u¯õºö\´Áuß ‰»•® Aºzu•ÒÍ 

uPÁÀPøÍ¨ (Information) ö£ÓzuUPuõP C¸US® A÷u÷ÁøÍ wº©õÚ® 

÷©ØöPõÒÁuØS®  AzuPÁÀPÒ G©US EuÄ®.

             uµÄPøÍz u¯õ›¨£uØPõÚ ÁÈ¨£kzuÀ EÒÏk (Input) GÚÄ® uµÄPøÍ 

uµ¨£mh AÔÄÖzuÀPÐU÷PØ£ uPÁÀPÍõP ©õØÖ® ö\¯À•øÓ¯õÚx 

•øÓÁÈ¯õUP® (Processing)	 GÚÄ® C¢u uµÄPøÍ²®, uPÁÀPøÍ²® 

÷uUQøÁzuÀ (Storage)	GÚÄ® u¯õºö\´u uPÁÀPøÍ¨ ö£ÖuÀ öÁÎ±k 

(Output) GÚÄ® AøÇUP¨£k®.	 CøÁ	 AøÚzvÚx® ö©õzu® öuõSv 

GÚ¨£h»õ®.

 

 J¸ öuõSv°ß ¤µuõÚ öuõÈ»õÚx uµÄPøÍ¨ ö£Öu¾® AÁØøÓz 

u¯õº ö\´Áx® ÷uUQøÁ¨£x® ÷uøÁ¯õÚ÷£õx ÷uøÁ¯õÚ uPÁÀPøÍ 

ÁÇ[SÁx® BS®.

1 uPÁÀ   ©ØÖ®   öuõhº£õhÀ 

öuõÈÝm£Â¯À



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À2 3

Euõµn® 1	
	 £õh\õø»z uÁøn¨ £Ÿmø\°ß CÖv°À ÁS¨¦¨ ¤ÒøÍPÎß 

ö£¯ºPøÍ²® ¦ÒÎPøÍ²® ÷ÁÖ÷ÁÓõP GkUS®÷£õx

µÂ  78,		90,		79,		67,		76,	78;		›ìÁõß	87,	70,		80,		75,	80,	80;			QÔ\õß	76,		78,		67,		80,	79,		76

÷©ØSÔzu ¦ÒÎPÎÞhõPU P¸zøu¨ ö£Ó•i¯õuõøP¯õÀ C¨ö£¯º 

PøÍ²® ¦ÒÎPøÍ²® AmhÁøn¨£kzu»õ®.

ö£¯º ö©õÈ Pou® ÂgbõÚ® Áµ»õÖ
 
_Põuõµ® B[Q»® 

µÂ 78 90 79 67 76 78
QÔ\õß 76 78 67 80 79 76
›ìÁõß 87 70 80 75 80 80

	 CÆÁmhÁøn°¼¸¢x ¤ÒøÍPÎß ¦ÒÎPÒ £ØÔ¯ uPÁÀPÒ 

öu›QßÓÚ. GÛÝ® CzuPÁÀPÒ J¸ •iÂØS Á¸ÁuØS¨ ÷£õv¯ÚÁõP 

CÀ»õv¸UP»õ®.

CÆÁmhÁøn¨£kzv¯ ¦ÒÎPøÍU Po¨¦US Em£kzu»õ®.

ö£¯º ö©õÈ Pou® ÂgbõÚ® Áµ»õÖ _Põuõµ® B[Q»® ö©õzu® \µõ\› {ø»

µÂ 78 90 79 67 76 78 468 78 2

QÔ\õß 76 78 67 80 79 76 456 76 3
›ìÁõß 87 70 80 75 80 80 472 78.66 1
	
 C¨÷£õx B]›¯º CÆÁmhÁøn°ÞhõPz ÷uøÁ¯õÚ uPÁÀPøÍ¨ 

ö£Ó»õ® Gß£øu }[PÒ ÂÍ[QU öPõÒÃºPÒ.

 AuõÁx,   JÆöÁõ¸ ¤ÒøÍ°Úx® ö©õzu¨ ¦ÒÎPÒ AÁºPÐøh¯ 

\µõ\›¨ ¦ÒÎPÒ, AÁºPÒ £õhzvÀ öPõskÒÍ vÓø©, {ø» Gß£Ú £ØÔ¯ 

uPÁÀPÍõS®. CÆÁõÖ ö£ØÓ uPÁÀPÒ B]›¯º wº©õÚ® ÷©ØöPõÒÁuØS 

•UQ¯zxÁ® Áõ´¢uøÁ.



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À2 3

Euõµn® 2 

uµÄ, uPÁ¼ØS Cøh÷¯¯õÚ ÷ÁÖ£õmøh CÚ[Põs£uØS¨ ¤ßÁ¸® 

E¸UPøÍU P¸x÷Áõ®.

    CÆÄ¸UPøÍ  ÷ÁÖ÷Á 

ÓõP GkUS®÷£õx P¸zøu¨ 

ö£Ó•i¯õx. BÚõÀ AÁØ   

øÓ¨   ö£õ¸zu¨£õmkhß     

÷\º¨£uß ‰»® C[S J¸

Sk®£zvß EÖ¨¤ÚºPÒ 

C¸¨£øu ÂÍ[QU öPõÒ

Í»õ®.  ÷©¾®  EÖ¨¤Úº 

PÎß E¯µ[PøÍ²® J¨ 

¥k ö\´x öPõÒÍ»õ®.

E¸ 1.1  ©Ûu E¸Á[PÒ

E¸  1.2  J¸ Sk®£®

CUSÔ±kPøÍ¨ £õºUP.

	+,	-,	×	,	÷	,	=

   2 + 5 = 7 
   2 × 8 = 16
  20 - 5 = 15
  10 ÷ 2 = 5

P¸zøu¨ ö£ÖÁuØS CU 

SÔ±kPøÍ  GsPÐhß 

÷\ºzx   GÊu  ÷Ásk®. 

A¨÷£õx |õ® •iÄPøÍ¨ 

ö£Ó»õ®.

74
   2 7 7 1 2 3 7 V

  ¤Ó¢u 

  BsøhU 

  PõmhÀ
 

0	_	4	Áøµ²ÒÍ C»UP[PÎÚõÀ Boß ÷u]¯ BÍøh¯õÍ Amøh 

          Gß£øu²®

5	_	9		Áøµ²ÒÍ C»UP[PÎÚõÀ ö£soß ÷u]¯ BÍøh¯õÍ Amøh 

          Gß£øu²® CÚ[Põn»õ®



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À4 5

 ö\¯Ø£õk 

uµÄPÐUS® uPÁÀPÐUS® ÷ÁÖ I¢x Euõµn[PøÍ GÊxP.

 1.2  J¸ öuõSv°ß TÖPÒ

	 AßÖ ÷£øÚø¯ AÀ»x ö£ß]ø» AÀ»x ÷Á÷Óõº E£PµnzøuU 

öPõsk uµÄPøÍa ÷\P›zu ©Ûuß CßÖ PoÛPøÍ¨ £¯ß£kzvz 

uµÄPøÍz u¯õº ö\´QßÓõß.

	 öuõSv Gß£x J¸ SÔzu £oø¯ {øÓ÷ÁØÖÁuØPõPa ]» TÖPøÍ 

Jß÷ÓõöhõßÖ öuõhº£õPa ö\¯Ø£kzu»õS®.

		 PoÛ |õ® ÁÇ[S® uµÄPøÍ G©x PmhøÍPÐU÷PØ£z u¯õ›zx 

G©USz ÷uøÁ¯õÚ uPÁÀPøÍz ÷uøÁ¯õÚ ÂuzvÀ ÁÇ[SQßÓx. GÚ÷Á 

PoÛø¯ J¸ öuõSv¯õP AÔ•P® ö\´¯»õ®.	

uµÄPøÍ ÁÇ[PÒ uµÄPøÍz  u¯õº  ö\´u¾® 

÷uUQ øÁzu¾®

÷uøÁ¯õÚ uPÁÀPøÍ 

ÁÇ[PÀ

E¸ 1.3  

	 AßÓõh   ÁõÌÂÀ CzuøP¯ öuõSvPÒ AvP AÍÂÀ £¯ß£kzu¨ 

£k® A÷u÷ÁøÍ G©USU Qmi¯ ]» \¢uº¨£[PøÍU P¸x÷Áõ®.

Euõµn® 1	-	Á[Qz öuõSv°À £¯ß£kzu¨£k® uõÛ¯[S® Põ\õÒ ö£õÔ             

  (ATM)
	 C[S Á[Q AmøhzuõÒ	ATM	ö£õÔUSÒ÷Í ¦Szu¨£k®÷£õx uµÄ 

•øÓÁÈ¯õUP® |øhö£ØÖ, PnUSz öuõhº£õÚ uPÁÀPÒ QøhUQßÓÚ. 
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 ² ö£¯º

 ² øÁ¨¦ Gs

 ² «v¨ £n®

 ² £n® ö£ÖuÀ

	ATM	Amøh 		ATM	ö£õÔ

 දත්ත  සකස් කිරීම f;dr;=re	,eîu

     E¸ 1.4 uõÛ¯[S® Põ\õÒ ö£õÔ

     uµÄ   u¯õº ö\´uÀ
       uPÁÀ    

     QøhzuÀ

Euõµn® 2	-	ÁµøÁ AÔUøP°kÁuØS {ÖÁPzvÀ £¯ß£kzu¨£k®   

  ÂµÀ Aøh¯õÍ¨ ö£õÔ          

 ² Á¸øP ÷|µ® 

 ² ö\ÀøP ÷|µ®

 දත්ත  සකස් කිරීම 

E¸ 1.5	 ÂµÀ Aøh¯õÍzøu Áõ]US® ö£õÔ

f;dr;=re	,eîu     uµÄ   u¯õºö\´uÀ uPÁÀ
QøhzuÀ

Euõµn® 3	-	ö\´vzuõÒPÎ¾® \g]øPPÎ¾® £¯ß£kzu¨£k® QR   

  SÔ•øÓ   (QR Code)

      ö\À÷£]  (Smartphone)	 ‰»® Á¸i¯  ¤ßÚº (Scan)	 AuÞhõP 

Cøn¯zxhß öuõhº¦£kzxÁuß ‰»® AÆÁÔÂzuÀ £ØÔ¯ ÷©»vPz 

uPÁÀPøÍ A¢{ÖÁPzvß Áø»zuÍzv¼¸¢x ö£Ó»õ®.
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E¸ 1.6			QR	SÔ•øÓ •øÓÁÈ¨£kzuÀ

QR	SÔ•øÓUS 

ö|Ô¨£kzuÀ

{ÇØ£hö©kzuÀ £›£õk }UPÀ Cøn¯zuÍzvÀ 

~øÇuÀ

Euõµn® 4	-	\¢øuz uPÁÀPøÍ •øÓÁÈ¨£kzuÀ

 

 ÷©ØSÔzu Euõµn[PÎÀ Põn¨£kQßÓÁõÖ uµÄPøÍz u¯õ›¨ 

£uØPõP J¸ PoÛ AÀ»x PoÛ¨£kzv¯ J¸ ö£õÔ £¯ß£kzu¨£kQßÓx 

Gß£x® Auß ‰»® QøhUS® uPÁÀPÒ wº©õÚ[PÒ ÷©ØöPõÒÍ¨ 

£¯ß£kzu¨£kQßÓÚ Gß£x® öuÎÁõS®.

 

u¯õº ö\´uÀ

uµÄ 

uPÁÀ 

QøhzuÀ

wº©õÚ® 

GkzuÀ

  öPõÒÁÚÄ 

ö\´uÀ,

ÂØ£øÚPÒ,	

100000,

Bsk,	

Á¸©õÚ®,	2013,	
2014,	C»õ£®

					2000,	50000,
Gs, ö\»Ä,

|mh®

  

E¸	1.7	\¢øuz uPÁÀPøÍ •øÓÁÈ¨£kzuÀ
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uµÄPøÍz u¯õ›¨£uß ‰»® uPÁÀPÒ ö£Ó¨£k® A÷u÷ÁøÍ 

AzuPÁÀPøÍz  wº©õÚ®  ÷©ØöPõÒÁuØS¨  £¯ß£kzu»õö©ß£x  öuÎ

ÁõS®. GÛÝ® AÆÁõÖ ö£Ö® uPÁÀPÒ JÆöÁõßÖ® wº©õÚ® ÷©Ø 

öPõÒÁuØS EP¢uußÓõP C¸UP»õ®.

 J¸ £s£Ô uPÁ¼À £» C¯À¦PÒ C¸US® AÁØÔØ ]» ¤ßÁ¸©õÖ

£s£Ô uPÁ¼ß C¯À¦PÒ	 Euõµn®

a)		ö£õ¸zu®		
 

 

									

J¸Á¸øh¯ E¯º PÀÂz uøPø©PøÍU Põmhz 

÷uøÁ¯õÚ J¸ \¢uº¨£zvÀ •u»õsi¼¸¢x 

ö£ØÓ PÀÂ ÂÁµ[PøÍ •ßøÁzuÀ AÁ]¯©ßÖ.

b)	 GÀ»õ A®\[PÐ® C¸zuÀ		
 

 

J¸ |õmiß BÒÃu Á¸©õÚzøuU Po¨£uØSa  

]Ô¯ SÊÂß uPÁÀPøÍ ©õzvµ® ö£ÖuÀ 

÷£õv¯ußÖ. §µn©ØÓ uPÁÀPÒ uÁÓõÚ 

wº©õÚ[PÐUS ÁÈÁSUS®. 

c)	ö\®ø©					
 

 

			

J¸ ÷|õ¯õÎ £ØÔz uÁÓõÚ uPÁÀPøÍ J¸ 

©¸zxÁ›h® ÁÇ[QÚõÀ ÷|õ¯õÎUS B£zuõP 

C¸UP»õ®.

ö\¯Ø£õk

Cx }[PÒ Áõ[S® ]» ö£õ¸ÒPÎß 

ö£õv²øÓ°À Põn¨£k® E¸Á©õS®. 

Cx  £møhU SÔ•øÓ (Barcode) BS®. 

}[PÒ ö£õ¸øÍ Áõ[S®÷£õx ÁºzuP 

{ÖÁÚzvÚõÀ £møhU SÔ•øÓ Áõ]¨ 

£õß  (Barcode	 Reader)	‰»® C¢u Gs  

÷\õvUP¨£kQßÓx.

Cx }[PÒ Áõ[S® AÀ»x 

¡»Pzv¼¸¢x ö£Ö® ]» ¦zu 

P[PÎß ¤Ø£UPzvÀ Põn¨ 

£k®. Cx ISBN	 (\ºÁ÷u\ {¯©¨ 

¦zuP Gs)	BS®.

GsPÒ Aø©UP¨£mkÒÍ Âuzøu¨ £›^¼zx A¨ö£õ¸Ò AÀ»x ¦zuP® £ØÔ¯ 

uPÁÀPøÍ ÷ÁÖ÷ÁÓõP GÊxP.

£h®  2 £h®  1

R÷Ç uµ¨£mkÒÍ £h®	1 I²®  £h®	2 I²® AÁuõÛUP. 

(A) (B)
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d)	Põ»zvØS¨  ö£õ¸zu©õP

    C¸zuÀ					
 

 

					

uPÁÀPÒ G¨÷£õx® CØøÓ¨£kzu¨£mi¸zuÀ 

÷Ásk®. CßÖ ö£Ö® ÁõÛø» AÔUøPPÒ 

|õøÍ¯    ÁõÛø»   £ØÔz    wº©õÛUP¨  ö£õ¸z               

u©õÚøÁ¯À».

e)	Qµ¯® CÈÁÍÁõuÀ	

	

J¸ {ÖÁÚzvß C»õ£ EøÇ¨¦PøÍ Â¸zv 

ö\´¯z ÷uøÁ¯õÚ vmh[PøÍ ÷©ØöPõÒÐ•ß 

£õPa ÷\P›UP Gvº£õºUS® uPÁÀPÐUPõP AvP 

AÍÄ Qµ¯zøuz uõ[P ÷|›k® Cx {ÖÁÚzvØS 

HØ£k® |mh©õS®.

  ö\¯Ø£õk

÷©ØSÔzu	(a)	öuõhUP®	(e)	Áøµ²ÒÍ C¯À¦PÐUS ÷ÁÖ 

Euõµn[PÒ  GÊxP.

 1.3		uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À

	 uµÄPøÍ JÊ[S•øÓ¯õPz u¯õº ö\´Áuß ‰»® uPÁÀPÒ 

ö£Ó¨£kQßÓÚ GÚÄ® AzuPÁÀPÒ G©USz wº©õÚ® ÷©ØöPõÒÁuØS 

EuÄQßÓÚ GÚÄ® |õ® PØ÷Óõ®. CÆÁõÖ |õ® ö£Ö® uPÁÀPøÍ 

÷ÁöÓõ¸Á¸hß AÀ»x ÷ÁöÓõ¸ SÊÄhß £›©õÓÀ uPÁÀ öuõhº£õhÀ 

BS®.

 BvPõ»zv¼¸¢÷u ©Ûuß uµÄPøÍz u¯õºö\´x uPÁÀPøÍ¨ 

ö£ÖÁøu²® £›©õÔU öPõÒÁøu²® ö\´x Á¸QßÓõß. A¨÷£õx 

£» Chº£õkPøÍ GvºöPõÒÍ ÷|›mh÷£õv¾® öuõÈÝm£Â¯¼ß 

•ß÷ÚØÓzxhß uPÁÀPøÍz u¯õºö\´u¾® £›©õÖu¾® ªPÄ® GÎ¯ 

Âh¯[PÍõP Aø©¢xÒÍÚ.

 uµÄPøÍz u¯õºö\´x uPÁÀPÍõP ©õØÖÁuØS® AÁØøÓ¨ 

£›©õÔUöPõÒÁuØS® öuõÈÝm£Â¯À £À÷ÁÖ Âu©õPU £¯ß£kz 

u¨£kQßÓx. Cx uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À GÚ¨£k®.

1.4		uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß ¤µ÷¯õP[PÒ

 CßÖ    uPÁÀ,   öuõhº£õhÀ    öuõÈÝm£Â¯ø»¨   £¯ß£kzuõu 

|£÷µõ, Ch÷©õ  CÀø»ö¯ßÖ TÓ»õ®. ]» Euõµn[PÒ R÷Ç Põmh¨ 

£mkÒÍx.			
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øPzöuõÈÀ

Â¯õ£õµ®

ö£õÊx ÷£õUS

 öuõÈÝm 

    £Â¯À

÷£õUSÁµzx
ÂÁ\õ¯®

_Põuõµ®

PÀÂ

ªßÚµ

\õ[P®

uPÁÀ, 

  öuõhº£õhÀ

E¸ 1.8  uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß ¤µ÷¯õP[PÒ

1'4'1 ªß & Aµ\õ[P® (e - Government) 

	 Kº Aµ\õ[P® uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯ø»¨ £¯ß£kzvz 

uÚx |õmiß ¤µø\PÐhÝ® P®£ÛPÒ, Aµ\õ[P Aø©¯[PÒ, Aµ\õ[Pa             

\õº£ØÓ Aø©¯[PÒ, ÷ÁÖ Aµ\õ[P[PÒ BQ¯ÁØÖhÝ® öuõhº¦øhø© 

PøÍ¨ ÷£nø» ªß & Aµ\õ[P®  (e	-	Government)	 GÚU öPõÒÍ»õ®.

	 Czöuõhº¦øhø©PÐUPõP C»[øP Aµ\õ[Pzvß Áø»¨£UP®, 

Aµ\õ[Pz uPÁÀ {ø»¯®, uPÁÀ öuõhº£õhÀ öuõÈÝm£Â¯À {ø»¯® 

(ICTA)	  ÷£õßÓ Aµ\õ[Pzxhß öuõhº¦£mh ]» Áø»zuÍ[PÒ C¸US® 

A÷u÷ÁøÍ Cuß ‰»® Aµ\õ[Pzxhß öuõhº¦£mka ö\¯Ø£k®÷£õx® 

Aµ\õ[Pz uPÁÀPøÍ¨ ö£Ö®÷£õx® EÒÍ Chº¨£õkPøÍz uÂºUP •i²®.

³ ªßÚg\¼ß öuõhº¦øhø©PÒ 	(http://www.gov.lk).
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E¸ 1.9	ªß & Aµ\õ[Pz öuõhº¦øhø©PÒ

				
				G2C	(Government	to
				Citizens)

*	Aµ\õ[P {ÖÁP¨   

  ö£¯º¨£mi¯À

*	Aµ\õ[P {ÖÁ   

  P[PÒ

*	]møhU öPõk¨   

  £ÚÄa ÷\øÁ

*	Cøha ö\¯Ø£õm  

  ka ÷\øÁ

*	ÁõPÚ   EzuµÄa  

  ^mkPøÍ¨ ¦x¨ 

  ¤zuÀ

*	Aµ\õ[Pz uPÁÀ  

   {ø»¯a ÷\øÁPÒ

*	Aµ]¯»ø©¨¦

*	\mhz öuõSvPÒ

*	C»[øP¨ £h[ 

  PÒ.

  ÷ÁÖ Aµ\õ[P[

  PÐUS 
			G2G	(Government
			to	Government)

*	uõÛPº A¾Á 

»P[PÐ® Ã\õ   

  Á\vPÒ £ØÔ¯ 

  ÂÁµ[PÐ®.

*	EÀ»õ\¨ £¯o  

PÐUPõÚ EuÂ   

PÒ

*	Aµ\õ[Pa \m   

h[PÒ

*	C»[øPa _[P 

ÂÁµ[PÒ

*	C»[øP°ß 

AÇPõÚ 

Ch[PÒ

*	C»[øP¨ £h®

Â¯õ£õµ[PÐUS 
G2B	(Government
to	Business)

*	Cøha ö\¯Ø 

£õmka ÷\øÁPÒ 

*	£nU öPõk¨£ 

 ÚÄa ÷\øÁPÒ

*	Á[Qz uPÁÀPÒ

*	Â¯õ£õµ[PøÍ¨ 

£vÄö\´uÀ

*	Â¯õ£õµ[PÐ® 

•u½kPÐ®

*	ÁºzuP Aø©¯z 

uPÁÀPÒ

öuõÈ»õÍºPÐUS
G2E	(Government
to	Employee)

*	£iÁ[PÒ

*	Áºzu©õÛ

*	_ØÖ{¸£[PÒ

*	Phß Á\vPÒ £Ø   

Ô¯ ÂÁµ[PÒ
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1.	 C»[øP Aµ\õ[Pzvß Áø»¨ £UP®, Aµ\õ[Pz uPÁÀ 

{ø»¯®, uPÁÀ öuõhº£õhÀ öuõÈÝm£Â¯À {ÖÁP® 

(ICTA)	 ÷£õßÓ  Aµ\õ[Pzxhß öuõhº¦£mh Áø»zuÍ[P 

Ðhß öuõhº¦£kP. Auß ‰»® |õmiß ¤µø\PÍõQ¯ }[PÒ 

ö£ÓzuUP uPÁÀPøÍ £mi¯Ø£kzxP.

  

2.			 ÷ÁÖ |õkPÎ¼¸¢x ö£ÓzuUP ªßÚµ\õ[Pa ÷\øÁPøÍ 

AÔ¢x AÁØøÓ¨ £mi¯Ø£kzxP. 

                   Euõµn® :	©÷»]¯õ, ][P¨§º, C[Q»õ¢x

ö\¯Ø£õk 

1.4.2 PÀÂ²®  uPÁÀ  öuõhº£õhÀ  öuõÈÝm£Â¯¾®

		 	 			
  AßÖ 	 	 	 	 CßÖ

	 	 	 	 	 	 	¦zuP[PÒ FhõP ÷Ási¯ uPÁÀPøÍa ÷\P›zu Põ»® £i¨£i¯õP 

G®ªhª¸¢x AØÖ¨ ÷£õQßÓx. J¸ Á\v¯õÚ Chzv¼¸¢x Á\v¯õÚ 

ÂuzvÀ C¸¢x öPõsk •Ê E»øP²® £õº¨£uØPõÚ Avmh® E[PÐUS 

C¨÷£õx QøhzxÒÍx. CuØSz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß 

•ß÷ÚØÓ® Põµn©õS®.

	    	



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À12 13

E¸ 1.10  G¢u Chzv¾® G¢÷|µzv¾® PÀÂø¯¨ ö£ÖÁuØPõÚ Á\v

a.		ÁS¨£øÓ°À    
	 ÁS¨£øÓ°À PoÛ, Cøn¯U PÀÂ°À £À÷ÁÖ Âu©õP £¯ß£kzu 

u¨£kQßÓx.   AuõÁx  

● {PÌzxøPPÒ	(Presentations)	u¯õ›¨£uØS

●	 £›÷\õuøÚPÐUPõÚ JÎ²¸U (Video) Põm]PÒ 

u¯õ›¨£uØS

 	
●	 £h[PøÍ²® JÎ²¸UPøÍ²® u¯õ›¨£uØS

●	 \g]øPPÒ, PmkøµPÒ, BÁn[PÒ BQ¯ÁØøÓz 

u¯õ›zu¾® Aa]ku¾®	
		
●	 CD-ROM	FhPzvÀ uPÁØ PØøP PÀÂ\õº ÂøÍ¯õmkPÒ

●	 Cøn¯zvÞhõPU PÀÂz uPÁÀPøÍa ÷\P›zuÀ (E¸ 1.11) 

E¸ 1.11	
ÁS¨£øÓ°À PoÛ
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b.	G¢u÷Áõº Chzv¾® G¢uöÁõ¸ ÷|µzv¾®  

    PÀÂø¯¨ ö£ÖuÀ  
	 E®ªhzvÀ PoÛ, Cøn¯ Á\vPÒ 

C¸¢uõÀ, Ãmi¼¸¢x AÀ»x ÷ÁÖ Á\v¯õÚ 

ChzvÀ ÷uøÁ¯õÚ ÷|µzvÀ PÀÂø¯¨ ö£Ó 

»õ®.
 

●	 AÔÁP® 	(nenasala.lk)

●		 e-uU\»õÁ (www.e-thaksalawa.moe.gov.lk)

●			 Áø»¨ £õh\õø»			(www.edulanka.lk)

●			 Âx ©[ö£u		(www.vidumanpetha.com)
	
	 ÷£õßÓ Áø»¯zuÍ[PøÍ¨ £¯ß£kzvU PÀÂø¯ ÷©®£kzxÁuØS 

}º _¯©õPU PÀÂ PØÓ¼À Dk£h»õ®. AÆÁõ÷Ó Ãmi¼¸¢x Cøn¯zøu¨ 

£¯ß£kzv Kº B]›¯¸hß öuõhº¦£kÁuß ‰»® (Web	 Based	 Learning) 
÷©»vPU PÀÂø¯ }º ö£ÓzuUPuõP C¸US®. Cuß ‰»® ÷£õUSÁµzx 

Chº¨£õk® ö\»Ä® CÈÁÍÁõuÀ, ÷|µ® «u¨£kzu¨£kuÀ, PøÍ¨¦ 

CÈÁÍÁõuÀ ÷£õßÓ £» AÝT»[PÒ QøhUS®.

÷©÷» £» Áø»zuÍ[PÒ Põmh¨£mkÒÍÚ. ÷©÷» Põmi¯ J¸ 

Áø»z uÍzvØS¨ ¤µ÷Á]UP, AÆÁø»z uÍzvÞhõP E©x 

PÀÂUS¨ £¯ß£kzuzuUP A®\[PøÍ¨ £mi¯Ø£kzxP.

  ö\¯Ø£õk 

c.		 B]›¯¸USU PØ¤UP  EuÄuÀ

 B]›¯º £õh\õø»°À  J¸ PØÓÀ  xøn

¯õPz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯ø» 

AvP AÍÂÀ £¯ß£kzu ÷|›kQßÓx. 
	
●	ÂÁ›¨£uØSU  PiÚ©õÚ £õh[PÐUPõP  Á›¨ 

£h[PøÍ²®  JÎ²¸U Põm]PøÍ²® PõmhÀ

●	ªß  •ßøÁ¨ø£¨  £¯ß£kzv¨  £õhzvÀ 

PÁºa]ø¯ HØ£kzu¾® J¨£øhPøÍ ÁÇ[ 

P¾®

E¸ 1.12 
¯õuõ°Ý® Kº ChzvÀ PÀÂ 

E¸ 1.13	
B]›¯¸USU

PØ¤UP EuÂ¯õP C¸zuÀ
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●		PoÛø¯¨ £¯ß£kzv¨ £õhU SÔ¨¦PøÍz u¯õ›zuÀ

●		Cøn¯zvß ‰»® £õhzvØS E›¯ uPÁÀPøÍ¨ ö£ÖuÀ

d.			PØÓÀ •Põø©

	 £»  |õkPÎÀ  £õh\õø»U  PÀÂ  •Põø©US®  E¯º PÀÂ •Põø©U 

S©õPU  PØÓÀ  •Põø©z  öuõSv		(Learning	Management	System	-	LMS)	£¯ß£kz 

u¨£kÁøuU  Põn»õ®.  CzöuõSv²hß   CønÁuØS   Cøn¯ Á\vPÒ

C¸UP ÷Ási¯ A÷u÷ÁøÍ £õh\õø» AÀ»x {ÖÁÚ® Áø»z uÍzvÀ 

£vÄ ö\´v¸zuÀ ÷Ásk®.

	 ¤ßÁ¸® E¸ÂÀ Põn¨£kQßÓÁõÖ PØÓÀ •Põø©z öuõSv°ß 

‰»® ©õnÁºPÐUS® B]›¯ºPÐ® £» ÷\øÁPøÍ¨ ö£Ó»õ®.

E¸ 1.14 PØÓÀ •Põø©z öuõSv

©õnÁº
uPÁÀPÒ÷©Ø£õºøÁ

J¨£øhPÒ

SÔ¨¦PÒ

£õhö|ÔPÒ

£õh\õø»z

uPÁÀPÒ

ö\¯Ø£õkPÒ vmh[PÒ

{ºÁõP®

©ßÓ[PÒ

ÂÚõ Âøh

©v¨¥kPÒ

B]›¯º

uPÁÀPÒ

vÓ¢u 

{ø»¯[PÒ

 AÔÁP  {ø»¯[PÒ 
 Ãk

 Cøn¯®

 öuõø»U

 Põm]

 ÂgbõÚ  {ø»¯[PÒ 

	 £» |õkPÎÀ £õh\õø»U PÀÂ •Põø©US® E¯º PÀÂ •Põø©US® 

PØÓÀ •Põø©z öuõSv £¯ß£kzu¨£kÁøuU Põn»õ®. CzöuõSv²hß 

öuõhº¦£kÁuØS Cøn¯ Á\vPÒ C¸zuÀ ÷Ásk®. £õh\õø» AÀ»x 

{ÖÁP® Áø»zuÍzvÀ £vÄö\´v¸zuÀ ÷Ásk®. A[S EÒÍ ]»                    

Á\vPøÍ CÆÁõÖ Põmh»õ®.
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©õnÁÝUS •Põø©zxøÓUS 

£õh\õø»°À AÀ»x ÃmiÀ AÀ»x  Á\v 

¯õÚ Kº ChzvÀ ¯õuõ°Ý® J¸  ÷|µzvÀ 

PØÓÀ A»SPÐhß öuõhº¦£kÁuØPõÚ 

BØÓÀ   

•Põø©°ÞhõP¨ £s¦\õº PØÓÀ A»Sz 

öuõSvPøÍ CønzuÀ

£õh\õø» J¨£øhPøÍ ÃmiÀ ö\´x 

•izx¨ £v÷ÁØÓg ö\´ÁuØPõÚ (Upload) 
BØÓÀ 	

ö\¯Ø£õkPøÍ ÷©Ø£õºøÁ ö\´u¾® ö£Ö 

÷£ÖPøÍU Põmh¾®

©ßÓ[PÐhß öuõhº¦£kÁuß ‰»® ¤µa  

]øÚPøÍ •ßøÁzuÀ, P¸zxPøÍU Põm-

hÀ, ÂøhPøÍ¨ ö£ÖÁuØPõÚ BØÓÀ   

©õnÁº, B]›¯ºPÒ, £õh\õø»z uPÁÀ 

•Põø©²® CØøÓ¨£kzx® BØÓ¾®

JÎ²¸U  Põm]PÎß  ‰»®  Cøn¨£õh 

ÂuõÚa   ö\¯Ø£õkPÐhß    öuõhº¦£k 

ÁuØPõÚ BØÓÀ

●	©ßÓ[PÐhß  öuõhº¦£kÁuß  ‰»® 

   P¸zxPøÍU PõmhÀ, £vÀPøÍ¨ ö£Ö

   ÁuØPõÚ  BØÓÀ

●	£õh÷ÁøÍPøÍ ÷ÁÖ£kzvU PõmkÁuØ

   Sa  _¯©õP  PoÛ   öuõSvø¯¨  £¯ß

   £kzuÀ 

ö£Ø÷ÓõºPÒ ¤ÒøÍPÎß PÀÂ 

•ß÷ÚØÓzøu Ãmi¼¸¢÷u AÔ¢x 

öPõÒÍzuUPuõP C¸zuÀ

ªßÚg\¼ß ‰»® ö£Ø÷ÓõºPÒ, £õh\õø» 

A¤Â¸zva \[P®, £õh\õø»a \•uõ¯z-

vØSz ÷uøÁ¯õÚ uPÁÀPøÍ AÝ¨£À, 

uPÁÀPøÍ¨ ö£ÖÁuß Á\v.

e.		GÀ÷»õ¸® E¯º PÀÂø¯ AøhÁuØPõÚ BØÓÀ

 uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß •ß÷ÚØÓzxhß G¢uöÁõ¸ 

|õmi¼¸¢x® J¸Áº uÚUS Â¸¨£©õÚÁõÖ J¸ PÀÂ {ÖÁPzxhß öuõhº 

¦£kÁuÞhõP ªPU SøÓ¢u ö\»Ähß E¯º £õhö|Ôø¯U PØP»õ®. Cx 

{PÌ{ø» öuõø»U PÀÂ (Online	Distance	Learning)	GÚ¨£k®.

öuõø»U PÀÂ°ß uØÔÓßPÒ 

●	 vÚ\› ÷|µ`] CÀ»õu A÷u÷ÁøÍ Kº C»S 

ÁõÚ  Chzv¼¸¢x PÀÂø¯U PØP •i²®.

●	 £õhö|ÔUS¨ £vÄö\´øP°À ÁÇ[S® C»U 

P•øÓ ¡»Pz öuõhº¦øhø©, {PÌ{ø» (Online)	
J¨£øhPÒ, ÂÚõUöPõzxPÒ, {PÌ{ø»¯õP	
B]›¯¸hß öuõhº¦£kÁuØPõÚ Á\vPÒ, 

B÷»õ\øÚa  ÷\øÁ  Á\vPÒ  BQ¯ÁØøÓ¨ 

ö£ÓzuUPuõP  C¸zuÀ.

E¸ 1.15	öuõø»U PÀÂUS
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1.4.3 _Põuõµz xøÓUS 

	 G©x _Põuõµzøu¨ ÷£qÁvÀ uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À 

G©US¨ £» \¢uº¨£[PÎÀ EuÄQÓx. AÁØÔÀ ]» \¢uº¨£[PøÍ¨ 

¤ßÁ¸©õÖ Põmk÷Áõ®. 

E¸ 1.16 |ÃÚ _Põuõµ E£Pµn®

AÖøÁa ]Qaø\US¨ 

£¯ß£kzu¨£k® JÎ 

²¸U      Põm]PøÍ¨ 

ö£ÓzuUP P©µõ EÒÍ 

E£Pµn[PÒ.

©¸zxÁºPÐUS® uõv 

PÐUS®  £°Ø]¯Î¨£ 

uØS  ̈ £¯ß£kzu¨£k® 

|ÃÚ  E£Pµn[PÒ

uPÁÀPøÍ²®     ©¸zxÁ  

AÔUøPPøÍ²®   £õxPõ¨ 

£uØS®  AÁØøÓ  Aa]k 

ÁuØS®  £¯ß£kzu¨£k® 

PoÛPÐhß     öuõhº¦

£mh   EzvPÒ 

1. ©¸zxÁ £›÷\õuøÚUSz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À

	 ÷|õ´PøÍ CÚ[Põs£uØS® ]Qaø\ AÎ¨£uØS® ªPÄ® ÷©®£mh 

öuõÈÝm£Â¯ø»U öPõsh £» ö£õÔzöuõSvPÒ EØ£zv ö\´¯¨£m-

kÒÍÚ. CÁØÔß ‰»® ÷|õ´ Pkø©¯õÁuØS •ßÚº AuøÚ CÚ[Põn¾® 

AuØS EP¢u ]Qaø\ AÎUPÄ® C¯¾®. AÁØÔÀ ]» ¤ßÁ¸©õÖ:

●      PoÛ¨£kzv¯ Eh¼ß Aa_¨ £øh X-1  Pvº¨ ö£õÔ 

	 (CAT	-	Computerized	Axial	Tomography	Machine)
	
	 C¨ö£õÔ°ß ‰»®  

Eh¼ß  Em£SvPøÍ  ÷ÁÖ

÷ÁÓõP •¨£›©õn •øÓ¨ 

£i    £hö©kUP»õ®.  ÷|õ´

{ø»ø©ø¯      CÚ[Põs£ 

uØS Cx ö£›x® EuÄ®. 		

E¸ 1.17 
CAT ö£õÔ 

E¸ 1.18 

•¨£›©õn JÎ¨£h® 
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●	  Põ¢u¨ £›Ä Â®£©õUPØ ö£õÔ 

				(MRI	-	Magnetic	Resonance	Imaging	Machine)		
																																			
	 ÁõöÚõ¼ Aø» 

PÒ, Á¼ø©¯õÚ Põ¢u¨ 

¦»® BQ¯ ÁØÔß ‰»® 

Eh¼ß Em£SvPÎß 

ÂÁµ©õÚ JÎ¨ £h[ 

PøÍ¨ ö£ÖÁuØS 

C¨ö£õÔ EuÄQßÓx. 																		
						

²   ªß Cu¯Áøµ¯¨ ö£õÔ 	
						(ECG	-	Electrocardiogram	Machine)
  
 Cu¯zvß  xi¨ø£                

AÁuõÛ¨£uØS C¨ö£õÔ 

£¯ß£kzu¨£kQÓx.   Cu

¯zv¼¸¢x Eh¼ß A[P[

PÐUSU S¸vø¯ ÁÇ[S®

÷£õx Cu¯zvÀ EshõS® 

ªß xi¨¦U÷PØ£ EØ£z 

v¯õS® Aø»PÒ Áøµ¦z 

uõÎÀ £vÄ ö\´¯¨£k®. 

² Cu¯÷|õ´z vøµ°hØ ö£õÔ -	(Cardiac	Screening	Machine)

      Cu¯zvß öuõÈØ£õmøhU PoÛz vøµ°À PõmhÀ Cuß ‰»® 

|øhö£ÖQÓx.  Cu¯zvß

£À÷ÁÖ öuõØÖ  {ø»ø©

PøÍ CÚ[Põs£uß ‰»® 

÷uøÁ¯õÚ ]Qaø\US 

ÁÈ¨£kzuÀ  Cuß  ‰»® 

\õzv¯©õQÓx. 

E¸ 1.19
MRI	ö£õÔ 	

E¸ 1.20 
ÂÁµ©õÚ JÎ¨£h[PÒ

E¸ 1.21		ECG	ö£õÔ E¸ 1.22			ECG	£h®

E¸ 1.24             E¸ 1.23
     Cu¯÷|õ´z vøµ°hØ £h® 
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²   ªß ‰øÍ¯ Áøµ¤¯Ø ö£õÔ 

	 (EEG	-	Electro	-	Encephalography)

       ‰øÍ°ß  öuõÈØ£õmøh¨ 

£vÄ ö\´ÁuØS CÆÄ£Pµn® 

£¯ß£kzu¨£kQÓx.      uø»

÷¯õmiÀ Jmh¨£mh AÍÂÀ 

]Ô¯ E÷»õPz umkPÎß    (ªß 

•iÂh[PÒ) ‰»® ‰øÍ°¼ 

¸¢x ÂkÂUP¨£k®  ªß  xi¨ 

¦PÒ  ö£Ó¨£mk  ‰øÍ°ß  

öuõÈØ£õk  öuõø»UPõm]  

vøµ°À  £vÄö\´¯¨£kQÓx. ÷|õ¯õÎ  GÊ®÷£õx® x°¾®÷£õx® 

C¨ö£õÔ°ß ‰»® ÷uøÁ¯õÚ £vÄPÒ ÁÇ[P¨£kQßÓÚ. 

²   S¸va ^Ûø¯a ÷\õvUS® ö£õÔ 

						(Blood	Sugar	Testing	Machine)

	 C¨ö£õÔ   S¸v°À  EÒÍ  ^Ûø¯a

÷\õvUP¨ £¯ß£kzu¨£kQÓx. CÆÄ£Pµ 

nzvß ‰»® S¸v°ß ©õv› ÷\õvU 

P¨£mk, ^Û°ß AÍÄ Põs¤UP¨£k®.

²   S¸v AÊzuzøu AÍUS® E£Pµn®    

    (Blood	Pressure	Testing				Machine	)	
 CÆÄ£Pµnzøu £¯ß£kzv J¸Áº 

K´Â÷»õ AÀ»x H÷uÝ® ÷Áø» ö\´²® 

÷£õx øP°À ©oUPmiÀ AoÁuõÀ 

AÁµx S¸v AÊzuzøu AÍÂh •i²®.

1.25	
EEG	ö£õÔ 

E¸	1.26	
EEG	Põm]¨ £kzuÀ

E¸ 1.28	
S¸v AÊzua ÷\õuøÚ

E¸ 1.27 
S¸va ^Û ÷\õuøÚ
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2' öuõø» ©¸zxÁ® (Tele		medicine)

E¸ 1.29	öuõø» ©¸zxÁ®

       uPÁÀ,   öuõhº£õhÀ   öuõÈÝm£Â¯ø»¨  £¯ß£kzv  J¸ ©¸zxÁ

©øÚ°¼¸¢x öuõø»ÂÀ EÒÍ Kº ChzvÀ C¸US® J¸ ÷|õ¯õÎø¯ 

AÁuõÛzuÀ AÀ»x ]Qaø\ ö\´uÀ öuõø»©¸zxÁ® GÚ¨£k®. ©¸zx 

Á©øÚ°ß Â÷\h {ø»¯zøu²® Â÷\h ©¸zxÁºPÎß Cøn¨ø£²® 

Ai¨£øh¯õPU  öPõsk  J¸  öuõhº£õhÀ  Áø»¯ø©¨£õQ¯  Cv¼¸¢x 

}[PÒ £» AÝT»[PøÍ¨ ö£Ó»õ®. CÁØÔÀ ]» AÝT»[PÒ:

²  öuõø» ]Qaø\ £µõ©›¨¦		(Remote	Clinical	Care)	     																																																											
÷|õ¯õÎ J¸Áº J¸ ¤µuõÚ ©¸zxÁ©øÚ²hß öuõhº¦£h •i¯õu \¢uº¨ 

£zvÀ (|Pµzv¼¸¢x öuõø»ÂÀ EÒÍ ¤µ÷u\z 

vÀ BPõ¯ Â©õÚzvÀ AÀ»x £¯oU P¨£¼À) 
CÆÂhzvÀ C¸US® ©¸zxÁ©øÚ°À £°Ø] ö£ØÓ 

J¸Áº öuõhº£õhÀ Áø»¯ø©¨¦hß öuõhº¦£mk 

©¸zxÁ©øÚ°ß  Â÷\h   ©¸zxÁ›ß  AÔÄzu¾U 

÷PØ£a  \kva ]Qaø\ø¯  ÁÇ[Q ¤ß ©¸zxÁ©øÚUS 

AÝ¨¤øÁUP¨£kÁõº.
E¸	1.30	

	öuõø» ©¸zxÁ 

£õxPõ¨¦
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²		 Ãmi¼¸¢x ]Qaø\	
	 	 ÷|õ¯õÎ ÃmiÀ u[Q AÁ¸øh¯ 

{ø»ø©ø¯a ÷\õv¨£uØS Cøh° 

øn¨¦U  PsPõo¨¦z öuõSvø¯¨

 £¯ß£kzu¾® ]Qaø\ ÷uøÁ¨£k® 

÷£õx ©¸zxÁ ©øÚ°À ÷\¸u¾®.

²							öuõø» ©¸zxÁzuõÀ      

          AÔÄÖzuÀPøÍ¨   ö£ÓÀ

	
 

Â÷\h   ©¸zxÁº  ©¸zxÁ  ©øÚ°À

CÀ»õu÷£õx wÂµ PÁÛ¨¦ A» 

QØSz ÷uøÁ¯õÚ AÔÄÖzuÀPøÍ¨ 

ö£ÓzuUPuõP C¸zuÀ. 

																																																																	

²		 öuõø» AÖøÁa ]Qaø\ 

	 	 Â÷\h ©¸zxÁºPÒ CÀ»õu ©¸zx 

Á©øÚ°À ©¸zxÁºPÒ \kv AÖøÁa 

]Qaø\ø¯ ÷©ØöPõÒÍ ÷Ási¯ 

÷£õx  öuõhº£õhÀ Áø»¯ø©¨¦hß 

öuõhº¦£mk (öÁÎ|õmiÀ AÀ»x 

|P›À C¸US®) Â÷\h ©¸zxÁ›ß 

AÔÄÖzuÀPÐU÷PØ£ AÖøÁa   ]Qa                

 ø\ø¯a ö\´¯zuUPuõP C¸zuÀ.

	 	 	 	 	 	 	
öuõø»¨ £°Ø] 		

©¸zxÁ©øÚ¨ £o¯õÍº SÊÂß 

£°Ø]°ß÷£õx   ªPU   Qmi¯  £°Ø]

{ø»¯zvÀ öuõhº£õhÀ Áø»¯ø©¨ 

¦z öuõhºø£¨  £¯ß£kzv  Â÷\h  

©¸zxÁ›ß  AÔÄÖzuÀPøÍ²® £°Ø 

]ø¯²® ö£ÓzuUPuõP  C¸zuÀ. 

E¸ 1.34	
öuõø»¨ £°Ø] 

E¸ 1.33
 öuõø» AÖøÁa ]Qaø\

E¸	1.31	
	Ãmi¼¸¢x ÷|õø¯U PsPõozuÀ

E¸	1.32	
B÷»õ\øÚPøÍ¨ ö£ÖuÀ
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1.4.4 ÂÁ\õ¯z öuõÈÀ
						

	 ÂÁ\õ¯z öuõÈ¼¾® ¦v¯ ¦µm]ø¯ HØ£kzxÁvÀ uPÁÀ, öuõhº 

£õhÀ öuõÈÝm£Â¯À öÁØÔ±mi²ÒÍx. ÂÁ\õ¯zv¾® Â»[S ÁÍº¨ 

¤¾® «ß¤iz öuõÈ¼¾® uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß ¤µ÷¯õ 

P[PÒ £» Põn¨£kQßÓÚ.       

ÂÁ\õ¯zvØSz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À 

	 uÚx ÷|µzøu²® EøÇ¨ø£²® ö\»ÂmkU öPõsk ÂÁ\õ¯® ö\´u 

ÂÁ\õ°UPõP ªPÄ® |ÃÚ öuõÈÝm£Â¯ø»U öPõsh £» ußÛ¯UP¨ 

ö£õÔzöuõSvPÒ EØ£zv ö\´¯¨£mkÒÍÚ. Cuß ‰»® ÂÁ\õ°°ß 

£oPÒ GÎuõuÀ ©õzvµ©ßÔ ªPÄ® E¯º¢u {ø»ø©°À EÒÍ £°ºPøÍa 

\¢øuUS ÂkÂ¨£uØPõÚ  BØÓ¾® ÂÁ\õ°USU QøhzxÒÍx.

 A¤Â¸zv¯øh¢u |õkPÎÀ ÷£õßÖ A¤Â¸zv¯øh¢x Á¸® 

|õkPÎ¾® ÂÁ\õ¯zvØS¨ £¯ß£kzx® AzuøP¯ ]» ö£õÔz öuõSvPÒ 

R÷Ç uµ¨£mkÒÍx:

a.	ÁõÛø» AÍÃmk¨ ö£õÔPÒ

	 CÁØÔß ‰»® ÁõÛø», Põ»{ø», 

©øÇÃÌa], PõØÔß vø\ BQ¯ÁØÔß {ø» 

ø©PÒ   ö£Ó¨£k®.  AÁØÔØ÷PØ£     £°ºa

ö\´øPUS® AÖÁøhUS® EP¢u Põ»® 

wº©õÛUP¨£k®.

b.	ußÛ¯UP ÁskU Pmk¨£õmk¨ ö£õÔ																																				
	 C¨ö£õÔ°ß ‰»® £°ºPÐUS ÁskPÎÚõÀ HØ£k® ÷\uzøuz 

uÂºUP»õ®. §a]PÒ Ch®ö£¯¸® vø\ø¯²® AÁØÔß ö\ÔøÁ²® PoÛz 

vøµ°À AÁuõÛ¨£uß ‰»® C¢u BØÓø»¨ ö£Ó»õ®.

E¸ 1.35
 ÁõÛø» AÍÃmk¨ ö£õÔ
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E¸	1.36 
ußÛ¯UP ÁskU Pmk¨£õmk¨ ö£õÔ

c.	£°›k® {»zvß {ø»ø©ø¯ AÍÂk® ö£õÔ

	 	 C¨ö£õÔ°ß ‰»® 

£°›k® {»zvß {ø» 

ø©ø¯a (Dµ¼¨¦, ö\È¨¦) 
÷\õvzx Ax £°ºPÐUS 

EP¢uuõöÁÚz wº©õÛU 

P¨£k®.

d.	ö\õmk•øÓ }º ÁÇ[PÀ	(Drip	Irrigation)																																			
	 	 	 	 	
ußÛ¯UP •øÓ¯õPz 

öuõÈØ£k® C¨ö£õÔ 

|õ® ÁÇ[S® uµÄPÐU 

÷PØ£z öuõÈØ£mk, 

£°›k® {»zvØSz 

÷uøÁ¯õÚ  }øµU  Pm                                                 

k¨£õmkhß   ÁÇ[S 

QßÓx. BP÷Á AÚõ 

Á]¯ }º ~Pºa]

ø¯²® }º CÀ»õ©À 

÷£õÁuÚõÀ ÂÁ\õ¯® AÈÁøu²® uÂºUP»õ®.	

E¸ 1.38	
ußÛ¯UP }º ÁÇ[PÀ öuõSvPÒ

E¸ 1.37 £°›k® {»zvß {ø»ø©ø¯ AÍUS® ö£õÔ
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e.	ußÛ¯UPU PøÍ¯PØÖ® ö£õÔ

	 J¸ £°›k® {»zvÀ £°ºPÐU 

Qøh÷¯ A[S® C[S® ö\ßÖ öPõsk 

ÁÇ[P¨£k® AÔÄÖzu¾U÷PØ£¨ £°ºP 

øÍ²® PøÍPøÍ²® ÷ÁÖ£kzv CÚ[ 

Psk PøÍPøÍ APØÖ®.

f.		÷µõ÷£õz öuõÈÝm£Â¯¼ß  ‰»® ö\iPøÍ |kuÀ                          

	 ö£›¯ £°›k® {»z 

vÀ ö\iPøÍ A[S® C[S® 

öPõsk  ö\ÀÁuØS®  ö\i

PÐUQøh÷¯  ^µõÚ   Cøh

öÁÎø¯¨ ÷£o |õmiU 

öPõÒÁuØS® C¢u ÷µõ÷£õ¨ 

ö£õÔ•øÓ      £¯ß£kzu¨

£kQßÓx.

 

g.	÷µõ÷£õz öuõÈÝm£Â¯¼ß  ‰»® AÖÁøh ö\´uÀ

	 AÁuõÛ¨¤ß ‰»® £°›ß 

{ø»ø©ø¯a ÷\õv¨£uØS® Auß 

‰»® AÔUøP°kÁuØS® ö£›¯ 

£°›k® {»zvÀ AÖÁøh ö\´²® 

Chº¨£õmøhz uÂº¨£uØS® £¯ß 

£kzu¨£k® ÷µõ÷£õ¨ ö£õÔPÒ 

EÒÍÚ.

h.	£aø\°À»® (GreenHouses)	

 £°ºa ö\´øP°À ÂÁ\õ° uÚx 

£°ºPøÍ C¯ØøP AÚºzu[PÎ¼¸¢x 

(Pk® öÁ°À, ©øÇ, öÁ¨£{ø», SÎº, 

§a]PÒ, öPõÒøÍ÷|õ´) £õxPõ¨£uØS 

J¸ ]Ó¢u wºÁõP¨ £aø\°À»zøu    

AÔ•Pgö\´¯»õ®. £aø\°À»U Pmk¨£õmiØPõPz uPÁÀ, öuõhº£õhÀ 

E¸ 1.39	
ußÛ¯UPU PøÍ¯PØÖ® ö£õÔ

E¸ 1.40	
÷µõ÷£õz öuõÈÝm£Â¯¼ß ‰»® 

ö\iPøÍ |kuÀ

E¸ 1.41	
÷µõ÷£õz öuõÈÝm£Â¯¼ß ‰»® 

AÖÁøh ö\´uÀ

E¸	1.42	-	£aø\°À»[PÒ	(GreenHouses)
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öuõÈÝm£Â¯ø»¨ £¯ß£kzxÁuß ‰»® £°ºa ö\´øPPÐUS EP¢uÁõÖ 

JÎ, }º, Áõ² BQ¯Ú Pmk¨£kzu¨£kQßÓÚ. ªPÄ® E¯º¢u {ø»ø©°À 

EÒÍ EØ£zv¨ ö£õ¸ÒPøÍa \¢øuUSa ÷\ºzuÀ Cuß ‰»® \õzv¯©õS®.

1'4'5 Â»[S¨ £søn, «ß¤iz öuõÈÀ BQ¯ÁØÔØSz uPÁÀ,  

 öuõhº£õhÀ öuõÈÝm£Â¯À

a.	ÁõöÚõ¼a ø\øP Aøh¯õÍªkuÀ E£Pµn®

	 Â»[SPøÍU PnUQkuÀ, 

CÚ[PõnÀ,  AøÁ C¸US® ¤µ÷u 

\zøu AÔuÀ BQ¯ÁØÔØPõP Â»[

SPÎß Eh¼À ÁõöÚõ¼ «iÓß 

Aøh¯õÍ©ÔuÀ	 E£Pµn® ö£õ¸z 

u¨£k®.

b.		 {ø»ø©U Pmk¨£õk

 ußÛ¯UP •øÓ°À öuõÈØ 

£k®  C¨ö£õÔ  £_©õkPÎß  _Põ

uõµa ÷\õuøÚ, £õø»¨ ö£ÖuÀ, 

£õ¼ß    {ø»ø©ø¯a    ÷\õvzuÀ

BQ¯ÁØÔØPõP¨    £¯ß£kzu¨£k

QßÓx. 

c.	£õxPõ¨¦UPõP

  

	 ÂÁ\õ¯¨ £sønø¯U PÒÁº 

PÎhª¸¢x® ÷ÁÖ öuõÀø»PÎ¼¸¢x® 

£õxPõ¨£uØS ‰i¯ _ØÖ	 (Closed	 Circuit	
TV	 (CCTV), £¯ß£kzu¨£kQßÓx. P®¤ 

°À»õz (Wireless)	 öuõÈÝm£Â¯¼ß 

‰»® öuõhº¦£kzv ÂÁ\õ¯¨ 

£søn°À C¸¢x® öuõø»ÂÀ EÒÍ 

Chzv¼¸¢x® AÁuõÛUP»õ®.			
					
																												

E¸ 1.43	
ÁõöÚõ¼a ø\øP Aøh¯õÍªkuÀ E£Pµn®.

(RFID-Radio	Frequency	Identification	Device)

E¸ 1.44
	ußÛ¯UP•øÓ°À £õø»¨ ö£Öu¾® 

{ø»ø©a ÷\õuøÚ²®

E¸ 1.45
	‰i¯ _ØÖU P©µõ

 (Closed	Circuit	TV	(CCTV))
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d.	ÂÁ\õ¯¨ £søn •Põø©		
 ÂÁ\õ°PÒ u©x ÂÁ\õ¯¨ £søn £ØÔ¯ 

AÔUøPPøÍ¨ ÷£qÁuØS® C»õ£zøu²® |mhz 

øu²® Po¨£uØS® öuõÈ»õÍºPÎß \®£Í® £ØÔ¯ 

uPÁÀPøÍz ÷uUQ øÁ¨£uØS® EP¢u ¤µ÷¯õP[PøÍU 

öPõsh, A[S® C[S® öPõsk ö\À»zuUP (Laptop,	
Tablet	 PC,	 Smartphone)	  ÷£õßÓÚ £¯ß£kzu¨£kQßÓÚ. 

Cuß ‰»® Cøn¯zxhß öuõhº¦£mka \¢øu 

{ø»ø©ø¯ AÁuõÛ¨£x® uPÁÀPøÍ¨ £›©õÖÁx® {PÌPõ»z 

uPÁÀPøÍ¨ ö£ÖÁx® \õzv¯©õS®. 

1'4'6 ªß¤iz öuõÈÀ 

			
	 «ß¤iz öuõÈ¼À £¯ß 

£kzu¨£k® C¢u En›PÒ 

«ßPÒ EÒÍ ¤µ÷u\[PøÍ 

CÚ[Psh ¤ßÚº AzuPÁÀPÒ 

öuõhº£õhÀ  öuõÈÝm£Â¯À 

•øÓPøÍ¨ £¯ß£kzv «ß¤iU 

P»[PÎß PoÛPÐUS  ÁÇ[P¨

£k®.

1'4'7 øPzöuõÈÀPÐUS® Â¯õ£õµ[PÐUS® uPÁÀ,    

 öuõhº£õhÀ  öuõÈÝm£Â¯À

 ªPÄ®   E¯º¢u uµzvÀ EØ£zvPøÍ ÷©ØöPõÒÁuØS® ©Ûu EøÇ¨ 

ø£U SøÓ¢u £m\® £¯ß£kzva ö\»øÁU SøÓ¨£uØS® øPzöuõÈÀP 

ÐUS® Â¯õ£õµ[PÐUS®  uPÁÀ,  öuõhº£õhÀ  öuõÈÝm£Â¯À £¯ß 

£kzu¨£kQßÓx. Cuß ‰»® ~Pº÷Áõº E¯º {ø»ø©°À EÒÍ EØ£zv¨ 

ö£õ¸ÒPøÍU SøÓ¢u Âø»US¨ ö£Ó»õ®.

       øPzöuõÈÀPÐUPõPz  uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À GÆÁõÖ 

£¯ß£kQßÓx GßÖ £õº¨÷£õ®.

	

E¸	1.47	
	Ph¼ß RÌ 

EÒÍ En›PÒ

E¸	1.48	
uPÁÀPøÍz 

öuõhº£õhÀ

E¸	1.46	
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E¸ 1.49
 øPzöuõÈÀPÐUPõPz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯ø»¨ £¯ß£kzuÀ

CßÖAßÖ

 AßÖ øPzöuõÈÀPÐUPõP AvP GsoUøP°»õÚ öuõÈ»õÍºPÎß 

EøÇ¨¦ ÷uøÁ¨£mh ÷£õv¾® CßÖ |ÃÚ öuõÈÝm£Â¯¼ÚõÀ EØ£zv 

ö\´¯¨£k® ÷µõ÷£õ¨ ö£õÔPÒ EØ£zvUPõP¨ £¯ß£kzu¨£kQßÓÚ.

24 ©ozv¯õ»a ÷\øÁ, PøÍ¨£øh¯õø©, vÓø©, ö\®ø©, y´ø©

÷µõ÷£õ¨ ö£õÔPøÍ¨ £¯ß£kzxÁuß AÝT»[PÒ

	 EØ£zv°ß÷£õx |ÃÚz öuõÈÝm£Â¯À £¯ß£kzu¨£k® ]» 

\¢uº¨£[PÒ ¤ßÁ¸® E¸UPÎß ‰»® Põmh¨£kQßÓÚ.

E¸ 1.50	
PoÛ EØ£zv

E¸	1.52	
ö£õ¸ÒPøÍ¨  ö£õv ö\´uÀ

E¸	1.51 
ö£õv²øÓ EØ£zv

E¸ 1.53
ÁõPÚ EØ£zv 

E¸ 1.55
÷£õzuÀPøÍ {µ¨¦uÀ

E¸ 1.54 
ö£õ¸ÒPÎÀ _mkz xsikuÀ
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	 Â¯õ£õµ[PÐUPõPz uPÁÀ öuõhº£õhÀ öuõÈÝm£Â¯ø»¨ £¯ß 

£kzxÁuß ‰»® Â¯õ£õµ¨ £oPøÍ GÎuõUP»õ®. ¤ßÁ¸® Põm]PÎß 

‰»® CuøÚz öuÎÁõUP»õ®.

	 JÎ²¸U P»¢xøµ¯õhÀ (Video	Conferencing) •øÓ  £¯ß£kzu¨£kQßÓ 

ø©¯õÀ, £À÷ÁÖ ¤µ÷u\[PÎÀ C¸US® Â¯õ£õµ EÖ¨¤ÚºPÐhß P»¢x 

øµ¯õhÀPøÍ  |hzuÀ GÎuõS®. C[S 

P»¢xøµ¯õh¾US Â÷\h Ch® ÷uøÁ¨ 

£h©õmhõx. Cuß ‰»® ÷£õUSÁµz 

vØS GkUS® ÷|µ®, EøÇ¨¦, ö\»Ä 

BQ¯ÁØøÓ CÈÁõUP»õ®.

a.	©Ûu ÁÍ•Põø©

	 	 	 öuõÈ»õÍºPÎß ÁµøÁ¨ £vÄ 

ö\´ÁuØS¨ £¯ß£kzu¨£k® ÂµÀ 

Aøh¯õÍ A»Qh¼ (Finger	 Print	
Scanner), Amøh Áõ]¨£õß (Card	Reader) 
BQ¯ÁØÔß  ‰»®   {ÖÁPzvß EÖ¨  

¤ÚºPøÍ     CÚ[PõnÀ,    Á¸øP, 

ö\ÀøP BQ¯ÁØøÓa \›¯õPU SÔzuÀ 

Gß£ÁØÔß ÂøÍÁõPz uõ£Úzvß 

{ºÁõP® GÎuõuÀ.

	
	 ÂµÀ Aøh¯õÍ A»Qh¼ (Finger	 Print	 Scanner), Amøh Áõ]¨£õß 

(Card	 Reader) BQ¯Ú Â¯õ£õµ[PÎÀ ©õzvµ©À» CßÖ £» Aµ\õ[P 

{ÖÁP[PÎ¾® £¯ß£kzu¨£kQßÓÚ.

b.	ªß Á[Q¯À öuõSv (e-Banking System)	
	 ªß Á[Q°¯À öuõSv (e-Banking System) Põµn©õP   Â¯õ£õ›PøÍ¨   

÷£õßÖ  |õ•® ªP GÎuõP Á[Qz öuõÈø»²® öPõkUPÀ Áõ[PÀPøÍ²® 

÷©ØöPõÒÍ»õ®. AuõÁx, 

³ 	 ußÛ¯UPU Põ\õÒ ö£õÔ ‰»® G¢u ÷|µzv¾® 

G¢u Chzv¾® £nzøu¨ ö£Ö® BØÓÀ, 

³ 	 Cøn¯zxhß öuõkUP¨£mi¸¨£uÚõÀ 

C»[øP°À ©õzvµ©À» ÷ÁÖ |õkPÎ¼¸¢x® 

öPõkUPÀ Áõ[PÀPøÍa ö\´²® BØÓÀ.
E¸ 1.59 ªß Á[Q°¯À 

öuõSv  (e-Banking	System)

E¸ 1.56
	JÎ²¸U P»¢xøµ¯õhÀ (Video	Conferencing)

E¸	1.57	
ÂµÀ Aøh¯õÍ 

A»Qh¼  (Finger	Print	
Scanner)

E¸	1.58
Amøh Áõ]¨£õß

  (Card	reader)
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³ 		 ªß Á[Q°¯À öuõSv°À £vÄ ö\´¯¨£mi¸US®÷£õx Kº GÎuõÚ 

Chzv¼¸¢x E[PÒ Ch®, ö£¯º PoÛ, öuõø»÷£] BQ¯ÁØÔß 

‰»®   ]møhPÐUPõPU öPõk¨£ÚÄ ö\´uÀ, Á[QPÎøh÷¯ £nzøu¨ 

£›©õÓÀ, PnUøP¨ £›÷\õvzuÀ BQ¯ BØÓÀPÒ.

c)	{PÌ{ø» A[Põi öPõÒÁÚÄ 	(Online	Shopping)
	 ªß  ÁºzuP® AÀ»x  {PÌ{ø» A[PõiU öPõÒÁÚÄ (Online	Shopping)	 
Gß£x Cøn¯zvÞhõP C¢|õmiÀ AÀ»x   öÁÎ|õmiÀ   EÒÍ  ÁºzuP 

{ÖÁP[PÎß ö£õ¸ÒPøÍ AÀ»x ÷\øÁPøÍ  ÁÇ[SÁx®  ~Pº÷ÁõºPÒ  

ö£õ¸ÒPøÍ  AÀ»x  ÷\øÁPøÍU öPõÒÁÚÄ ö\´Áx® BS®. ~Pº÷Áõº 

öu›¢öukUS® ÁºzuP  {ø»¯zv¼¸¢x  

AÁ¸US Â¸¨£©õÚ ÂuzvÀ J¸ ö£õ¸øÍ 

AÀ»x ÷\øÁø¯ Kº GÎuõÚ Chzv¼¸¢x 

PmhøÍ°mkU öPõsk Áµ»õ®. C[S EÒÍ 

AÝT»[PøÍ¨ ¤ßÁ¸©õÖ Põmh»õ®.

    G¢uöÁõ¸ |õmi¾® Cøn¯zvÀ EÒÍ 

J¸ ÁºzuP {ø»¯zøuz öu›¢öukUP»õ®. 

24 ©o ÷|µ•® vÓ¢v¸zuÀ, Kº GÎuõÚ 

Chzv¼¸¢x ö£õ¸ÒPøÍ AÁuõÛzxU 

PmhøÍ°k® BØÓÀ, ö\»Ä Amøh (Credit	
Card) ‰»® £nzøua ö\¾zx® Á\v, ö£õ¸øÍ AÀ»x ÷\øÁø¯ ÃmiØS¨ 

ö£ÖÁuØPõÚ Á\v, Cuß ÂøÍÁõP¨ £¯nUPøÍ¨¦, ÷|µ® ÃnõuÀ 

BQ¯Ú uÂºUP¨£k®.

1'4'8 ÷£õUSÁµzvØPõPz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À

	 Ãv ö|›\ø»z uÂºzxU öPõsk ÷£õUSÁµzøu GÎuõUSÁuØS 

Aø©UP¨£mkÒÍ ]» öuõSvPøÍ¨ ¤ßÁ¸©õÖ Põmh»õ®.

²  ußÛ¯UPU Pmk¨ 

£õmkz öuõSvPÒ

Aøhzu  _ØÖz  öuõø»U 

Põm]U (Closed	 Circuit	 TV	
(CCTV)),	 	 P©µõ Põµn©õP, 

ÁõPÚ ö|›\À, \kv Â£zx, 

\mhzvØS Â÷µõu©õÚ 

ö\¯ÀPÒ BQ¯ÁØøÓ  AÁ 

uõÛzxU  öPõsk  E›¯ |hÁiUøPø¯ ÷©ØöPõÒÍ»õ®.

E¸ 1.61	ußÛ¯UP Pmk¨£õmkz öuõSvPÒ

Closed	Circuit	TV	(CCTV)

E¸ 1.60	{PÌ{ø» A[Põi   

öPõÒÁÚÄ

(Online	Shopping)
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² ªß ø\øP ÂÍUS (Traffic	 Light	 Control	
System)

	 ußÛ¯UP©õPz  öuõÈØ£k®  Cz  öuõS

vø¯  |Pµa  \¢vPÎÀ  Põn»õ®.  Cuß  ‰»®

ÁõPÚ[PøÍ²® £õu\õ›PøÍ²® JÊ[S£kzvU 

öPõsk \kv Â£zxPøÍ CÈÁÍÁõUP»õ®.

² Aøh¯õÍU SÔ±mk •øÓ

	 	 	 	 	 ÁõPÚ® {Ø£õmkÁuØPõÚ 

¤›ÂØS¨ ¤µ÷Á]US®  AÝ©v 

¯møh   ÁõPÚzvÀ  ö£õ¸zu¨£m 

kÒÍx. ÁõPÚzøu {Ø£õmkÁ 

uØPõÚ   ¤›ÂØS¨     ¤µ÷Á]US®

PuÂß  öuõSv  ‰»® ÷\õvzx 

AÆÂhzvÀ £vÄ ö\´¯¨£mkÒÍ 

GsönÛß ©õzvµ® £hø» 

vÓUP¨£k®. AÆÁõ÷Ó AÆÂ 

hzøuz    uøh¨£kzuõ©À ÷\õv¨ 

£x® _¯©õP |øhö£Ö®.

÷©÷» Põmi¯ EuõµnzvØS ÷©»vP©õPU øPzöuõÈÀPÐUS® 

Â¯õ£õµ[PÐUS® uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À 

£¯ß£kzu¨£k® \¢uº¨£[PøÍU Psk¤izx Kº J¨£ 

øhø¯z u¯õ›UP.

ö\¯Ø£õk

1.4.9 ö£õÊx÷£õUQØSz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À

	 uØ÷£õx Aø©v¯ØÓ SÇ¨£©õÚ ÁõÌÄ ÁõÊ® ©Ûuß uPÁÀ, 

öuõhº£õhÀ öuõÈÝm£Â¯¼ß ‰»® KµÍÄ ©Ú Aø©vø¯¨ ö£ÓzuUP 

E£Pµn[PÒ EØ£zv ö\´¯¨£mkÒÍÚ. AzuøP¯ E£Pµn[PÎß ‰»®

³ 	 \¼¨¤¼¸¢x Âk£kÁuØSa \[Ruzøua  ö\Â©kzuÀ

³ 	 Cøn¯zxhß Cøn¢x, £õºUPz uÁÔ¯ öuõø»UPõm] {PÌa]ø¯ 

AÀ»x    Â¸¨£©õÚ vøµ¨£hzøu¨ £õºzuÀ

³ 	 \‰P Áø»¯ø©¨¤ÞhõP Cøn¢x, öuõhº¦£h •i¯õu öÁÎ|õmiÀ 

E¸ 1.63	
Aøh¯õÍU SÔ±mk •øÓ

E¸	1.62	
ªß ø\øP ÂÍUSPÒ	

(Traffic Light Control System)



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À30 31

ÁõÊ® £» Põ»©õPa \¢vUPõu EÓÂÚºPÐhÝ® |s£ºPÐhÝ® uPÁÀ 

PÍ¨ £›©õÓÀ

³ 	 E¯º öuõÈÝm£Â¯ø»¨ £¯ß£kzv EØ£zv ö\´¯¨£mkÒÍ öuõø»U 

Põm]°ß  ‰»®  öuÎÁõÚ  Põm]PøÍU öPõsh  {PÌa]PøÍ Cµ]zuÀ

³ 	  ¤ÒøÍPÒ K´ÁõP C¸US®÷£õx AÁºPÒ Ãmi¼¸¢uÁõ÷Ó Cøn¯zvß 

‰»® AÀ»x PoÛ°À uõ¤zu PÀÂ AÀ»x ö£õÊx÷£õUS ÂøÍ¯õmk 

{PÌa]PÐhß CønuÀ

³ 	 Cøn¯zxhß Cøn¢x ªßÞÀPøÍ Áõ]zuÀ

³ 	 EÒÍ[PÁ¸® Ch[PøÍ²® \¢uº¨£[PøÍ²® P©µõ ‰»® £hö©kzuÀ, 

    AÁØøÓU PoÛ°À £õxPõzuÀ BQ¯ÁØÔÀ Dk£kuÀ.

\‰P Áø»¯ø©¨¦z
öuõhº¦PÒ 

(Social	network)

\[Ruzøu ö\Â©kz 

u¾® vøµ¨£h[ 

PøÍ  Cµ]zu¾®
C»UP•øÓ¨ £ha 

\mh[PÒ PoÛ ÂøÍ 

¯õmkPÒ

uPÁÀ öuõÈÝm£ 

Â¯ø»¨ £¯ß£kz-

vz vµ¨£h[PøÍ 

Cµ]zuÀ

C»UP•øÓz öuõÈÝm 

£Â¯ø»U     öPõsh 

öuõø»UPõm] {PÌa]

PøÍ Cµ]zuÀ

ªßö\´vzuõÒPøÍ²® 

ªß¦zuP[PøÍ²® Áõ]zuÀ

Cøn¯zv¼¸¢x  £õmk-

PøÍ¨ £vÂÓUPgö\´x 

ö\Â©kzuÀ

P©µõøÁU öPõsk 

£hzøu¨ ö£ÖuÀ

ö£õÊx 

÷£õUQØS® 

K´ÂØS®

E¸ 1.64
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1.5 		uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß wø©PÒ

	 uPÁÀ öuõhº£õhÀ öuõÈÝm£Â¯À E[PÒ £oPøÍ C»SÁõUSuÀ 

©õzvµ©À» E[PÒ ÁõÌÂÀ Kº B¨u |s£ÚõP ©õÔ²ÒÍx. }[PÒ E[PÒ 

|s£øÚz uPõu ÂuzvÀ £¯ß£kzvÚõÀ E[PÐUS ©õzvµ©À» •Êa 

\‰PzvØS® £õuP® HØ£h»õ®. AuõÁx

 � Aiø©¯õuÀ	-		£õh\õø»¨ ¤ÒøÍPÒ ©õzvµ©À» HøÚ¯ÁºPÐ® AÍÄU 

PvP©õPU PoÛø¯¨ £¯ß£kzxÁuÚõ¾® PoÛ ÂøÍ¯õmkPÎÀ 

Dk£kÁuÚõ¾® PÀÂ¨ £oPÒ vø\©õÖ®. A÷u÷ÁøÍ £À÷ÁÖ 

Chº¨£õkPÒ (Ps E£õøuPÒ, |õ›¨ ¤i¨¦, uø»Á¼) HØ£h»õ®.

 � \‰P Áø»¯ø©¨¤ÞhõPz uPõu |m¦PÒ HØ£h»õ®.

 � Cøn¯zøuz uPõu •øÓ°À £¯ß£kzxÁuÚõÀ PoÛ |a_ {µÀ 

Põµn©õPU PoÛ öuõÈØ£hõ©À C¸UP»õ®.

 � Cøn¯zvÀ  ö£õ¸zu©ØÓ  Áø»¨  £UP[PÐhß  CønÁuÚõÀ J¸Á 

¸US EÍ÷|õ´PÒ HØ£kÁ÷uõk AÁ¸US® \‰PzvØS® £õuP® HØ£ 

kQßÓx. 	
 � J¸Á¸øh¯ uÛ¨£mh ÁõÌÂØSz w[S£¯US® £h[PøÍ²® 

JÎ²¸UPøÍ²® EØ£zv ö\´uÀ. 

CzuøP¯ Põµn[PÎß ÂøÍÁõPz uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À 

©Ûu¸US¨ £õuPzøu HØ£kzxQßÓx Gß£x £»¸øh¯ A¤¨¤µõ¯ 

©õS®. GÛÝ® Auß ‰»® Aø©UP¨£mh öuõSvPÒ ©ÛuÛß £» 

£oPøÍ GÎuõUSQßÓÚöÁÚ |õ® PØ÷Óõ®. BP÷Á uPÁÀ, öuõhº£õhÀ 

öuõÈÝm£Â¯ø» |À» ÂuzvÀ £¯ß£kzuÀ G©x Phø©¯õS®.

1.6	 PoÛ°ß £›nõ© ÁÍºa]

	 uµÄPøÍz uPÁÀPÍõP ©õØÖÁuØS G©USU PoÛ EuÄQßÓx 

Gß£øu }[PÒ ÂÍ[QU öPõsi¸¨¥ºPÒ. uØ÷£õx ußÛ¯UP •øÓ°À 

öuõÈØ£k® £» PoÛz öuõSvPÒ C¸¢u ÷£õv¾® PoÛPÐ® ©ÛuøÚ¨ 

÷£õßÖ £À÷ÁÖ ²P[PøÍU Ph¢x C®÷©®£mh ²PzvØS Á¢xÒÍx.

	
	 Po¨¦ Á\vUPõP Kº E£Pµnzøua ö\´uxhß PozuÀ Bµ®¤zux. 

Cuß ÂøÍÁõP 500	 BskPÐUS •ßÚº Gs\mh® (ABACUS) GßÝ® 

E£Pµn® Aø©UP¨£mhx.	
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¤ØPõ»zvÀ £» ö£õÔPÐ® E£Pµn[PÐ® Aø©UP¨£mhÚ. AÁØÔÀ 

]»ÁØøÓU R÷Ç Põmi²Ò÷Íõ®.

E¸	1.65	
A£õUPì ABACUS

						 	

 ² 1642 CÀ Blaise	Pascal  Gß£Áº Adding	Machine  GßÝ® E£Pµnzøu 

EØ £zv ö\´uõº. Cx E»Qß •u»õÁx ö£õÔ•øÓU Poua 

ö\´øPPøÍa ö\´²® E£Pµn©õPU P¸u¨£kQßÓx. 

 ² 1674 CÀ Gottfried	Wilhelm	Von	Leibnitz  Gß£Áº  Pascal Cß E£Pµnzøu 

÷©®£kzvÚõº. Cuß ÂøÍÁõP ÁSzuÀ, ö£¸UPÀ BQ¯ÁØøÓ 

÷©¾® GÎuõPa ö\´¯zuUPuõP C¸¢ux. 

	² Joseph	Jacquard	GßÓ ¤öµg_ ÂgbõÛ xøÍ Amøh •øÓø© (Punch	
Card	System) ‰»® öuõÈØ£kzu¨£k® ö|\Ä¨ ö£õÔø¯ Aø©zuõº.

	² Charles	 Babbage Gß£Áº xøÍ Amøh •øÓø© GsnUP¸øÁ¨ 

£¯ß£kzv  Analytical	Engine GßÝ® E£Pµnzøu Aø©zuõº. AÁ¸ 

øh¯ CÆöÁsnUP¸ PoÛ°ß ÷©®£õmiØS EuÂ¯ø©¯õÀ, 

AÁº PoÛ°ß u¢øu¯õP AøÇUP¨£kQßÓõº.

 ² AÁ¸øh¯ C¨ö£õÔUSU PoÛ {PÌa]zvmh[PøÍz u¯õ›¨£uØS 

•¯ßÓ  Ada	Lovelace E»Qß •u»õÁx PoÛ {PÌa]zvmh ~m£ 

µõÁõº.  

	² Howard		Aiken  Gß£ÁµõÀ  íõÁõm  £ÀPø»UPÇPzvÀ  u©x   \PõUPÐh 

Ý® IBM P®£Û°ß EuÂ²hÝ® ußÛ¯UPz öuõh›U Pmk¨£õmkU 

Po¨£õß (Automatic	Sequence	Control	Calculator) GßÝ® E£Pµn® 1944 

CÀ EØ£zv ö\´¯¨£mhx. Cx MARK	I  GÚ¨£mhx.

 öuõhUPzvÀ Aø©UP¨£mh E£Pµn[PÒ ö£¸®£õ¾® ö£õÔ•øÓ 

E£Pµn[PÍõP C¸¢uÚ. ußÛ¯UPU PoÛPÒ Aø©UP¨£hz öuõh[Q¯ 

Põ»zv¼¸¢x uø»•øÓU PoÛPÍõP ÁSzxU Põmh¨£h»õ®.
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ö£õÈ¨¦

uÛzuÛ¯õP GkUS®÷£õx uPÁø»z uµõu E¸UPÒ, C»UP[PÒ, SÔPÒ,              

ö\õØPÒ,  Áøµ¦PÒ  BQ¯Ú uµÄPÒ GÚ¨£k®.

 ² uµÄPøÍz u¯õº ö\´Áuß ‰»® uPÁÀPøÍ¨ ö£Ó»õ®. uPÁÀPÒ   

wº©õÚ[PøÍ ÷©ØöPõÒÁuØS EuÄQßÓÚ.

 ² PoÛ J¸ öuõSv¯õS®.

 ² uµÄPøÍz u¯õº ö\´ÁuØSU PoÛPÐ® PoÛ Ai¨£øhz öuõSv 

PÐ® £¯ß£kzu¨£kQßÓÚ.

 ² uµÄPøÍ ÁÇ[PÀ EÒÏk GÚÄ® uPÁÀPøÍ¨ ö£ÖuÀ öÁÎ±k 

GÚÄ® AøÇUP¨£k®.

 ² uPÁÀPÎß £s¦ •UQ¯©õÚx.

 ²  uµÄ EÒÏk, •øÓÁÈ¯õUP®, uPÁÀ öÁÎ±k BQ¯Ú J¸ öuõSv°ß 

TÖPÍõS®.

 ² •øÓÁÈ¯õUQ¯ uPÁÀPøÍ¨ £›©õØÖÁuØSz öuõÈÝm£Â¯À £¯ß 

£kzu¨£kQßÓx. Cx uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯À GÚ¨£k®.

 ² uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯¼ß ¤µ÷¯õP[PÒ ©ÛuÛß £o 

PøÍ GÎuõUQ²ÒÍÚ. C¨¤µ÷¯õP[PÒ AuõÁx ªßÚµ\õ[P®, PÀÂ, 

_Põuõµ®, ÂÁ\õ¯®, Â¯õ£õµ®, ö£õÊx÷£õUS GÚ £»ÄÒÍÚ.

 ² PoÛ GsnUP¸ B°µUPnUPõÚ Á¸h[PÐUS •ßÚ÷µ 

Bµ®¤zu÷£õx® Auß ÁÍºa]ø¯ £» \¢uvPÍõP ÁøP¨£kzvU 

Põmh»õ®.

PoÛ°ß £›nõ© ÁÍºa] £ØÔ¯ uPÁÀPøÍ AÔ¢x J¸ _¸U 

P©õÚ AÔUøPø¯U SÊÁõPz u¯õ›UP.

ö\¯Ø£õk  
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C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ

 PoÛ°ÚõÀ £¯ß£kzu¨£k® SÔ•øÓPÒ

 PoÛ°ß C¯À¦PÒ

 PoÛ°ß £õS£õkPÒ

 PoÛz öuõSv°ß •øÓÁÈ²® Auß TÖPÐ®

 PoÛ°ß Ai¨£øh¨ £SvPÒ

 PoÛ°À EÒÍ xøÓPÒ

 PoÛ Áø»¯ø©¨¦PÒ

Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

     2.1 PoÛ Gß£x ¯õx?

 ©ÛuÛß £À÷ÁÖ £oPøÍ GÎuõUSÁuØSz öuõSvPÒ £¯ß£kzu¨ 

£kQßÓÚöÁÚ |õ® Azv¯õ¯® 1 CØ PØ÷Óõ®.

 ""£¯|›ÚõÀ EÒÎh¨£k® AÀ»x öuõSv°ÚõÀ ÷\ºUP¨£k® uµ 

ÄPøÍ¨ ö£ØÖU öPõsk AzuµÄPøÍ¨ £¯|›ÚõÀ uµ¨£k® AÔÄÖz 

uÀPÐU÷PØ£  •øÓÁÈ¨£kzv AÁ¸USz ÷uøÁ¯õÚÁõÖ uPÁÀPøÍ 

öÁÎ°k® ªß Á¾ÂÚõÀ C¯UP¨£k® E£Pµn®'' GÚU PoÛø¯ 

AøÇUP»õ®.

 

 PoÛ°À EÒÍ ]Ó¨¤¯À¦PÒ Põµn©õP Ax G©US Azv¯õÁ]¯©õÚ 

Kº A®\©õP ©õÔ²ÒÍx. AÁØÔÀ ]»ÁØøÓ¨ ¤ßÁ¸©õÖ  Põmh»õ®. 

2 PoÛø¯  CÚ[Põs÷£õ®
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Pv 

(Speed)
G¢uU  Po¨ø£²® ö\´ÁuØS J¸ PoÛ ªPU 

SÖQ¯ ÷|µzøu GkUQßÓx. J¸ ö\UPÛÀ 

ªÀ¼¯ÝUS ÷©Ø£mh AÔÄÖzuÀPøÍ |øh 

•øÓ¨£kzxÁuØPõÚ BØÓÀ  PoÛ°h® 

EÒÍx.

ö\®ø© / |®£PzuPÄ

 (Accuracy)
\›¯õÚ AÔÄÖzuÀPÐUS® uµÄPÐUS÷PØ£ 

PoÛ \›¯õÚ uPÁÀPøÍz u¸QßÓöuÚ 

EÖv¯õPU TÓ»õ®.

vÓß

(Efficiency)
PoÛ    PøÍ¨£øhÁvÀø».   Ax  24  ©o

÷|µ•®  J÷µ  Âu©õPz  öuõÈØ£mka  \›¯õÚ 

uPÁÀPøÍz u¸ÁuØPõÚ BØÓø»U öPõs 

kÒÍx.

£ÀvÓø© 

(Versatility)
£À÷ÁÖ  £oPÐUS¨  £¯ß£kzuU Ti¯ø©

PoÛ°ß J¸ ]Ó¨¤¯À£õS®. J¸ uhøÁ¨ 

¦ÒÎ¨ £mi¯ø»U PoUP¨ £¯ß£kzu¨£k® 

PoÛø¯  ÷ÁöÓõ¸ uhøÁ E[PÐUS  Â¸¨

£©õÚ  £õhø»U  ÷Pm£uØS  AÀ»x   ÂøÍ

¯õmøh ÂøÍ¯õkÁuØS¨ £¯ß£kzu»õ®.

÷uUQ øÁ¨£uØS® 

«mh¾US©õÚ 

BØÓÀ. 

(Storage and Retrieval)

¦zuP[PÎÀ uPÁÀPøÍ GÊv øÁzv¸US®  

Põ»®   A¸QÂmhx.   PoÛ°ß   J¸  ]Ô¯

A»QÀ AvP AÍÄ uPÁÀPøÍa ÷\ªzx  øÁ¨       

£÷u  CuØSU  Põµn©õS®.   AÆÁõÖ ÷\ªzx 

øÁzu  uPÁÀPøÍz ÷uøÁ¯õÚ÷£õx ªP 

ÂøµÁõP¨ ö£Ö® BØÓ¾® EÒÍx.

2.2  PoÛø¯ ÁøP¨£kzuÀ

       J¸ \¢uº¨£zvÀ E[PÒ BÁn[PøÍz u¯õ›US® PoÛ ÷ÁöÓõ¸ 

\¢uº¨£zvÀ öuõÈØ\õø»°ß ö£õÔzöuõSv²® ÷ÁöÓõ¸ \¢uº¨£zvÀ 

E[PÒ ÷|õ´ {ø»ø©PøÍ²® ÷\õv¨£uØS EuÄQßÓöuÚ  Azv¯õ¯® 1 

CÀ ÂÍ[QU öPõsjºPÒ. GÛÝ® PoÛ GÀ»õa \¢uº¨£[PÎ¾® J÷µ 

ö£ÍvP ÁiÁzøu Gk¨£vÀø» Gß£øu²® ÂÍ[QU öPõsi¸¨¥ºPÒ.

 BP÷Á |õ® £¯ß£kzx® PoÛPøÍa ]» ÁøPPÍõP¨ ÁøP¨£kzvU 

Põmh»õ®.  AuõÁx AÍÂØ÷PØ£Ä® öuõÈÝm£zvØ÷PØ£Ä® ÁøP¨£kz 

u»õ®.
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E¸  2.1  PoÛ ÁøPPÒ
 

2.2.1 PoÛPøÍ AÍÄPÐU÷PØ£ ÁøP¨£kzuÀ

(I)  «UPoÛPÒ  (Super Computers) 
          

E¸  2.2 «UPoÛPÒ

 CUPoÛPÒ Av²¯º BØÓÀ 

ªUPøÁ. ÂgbõÚ, ö£õÔ°¯À 

£oPÐUPõPÄ® ]UP»õÚ Pou¨ 

¤µ]Ú[PÐUS  wºÄ PõnÄ®  

£¯ß£kzu¨£k® CUPoÛPÒ |õ\õ 

(Nasa) ÷£õßÓ   {ÖÁP[PÎÚõ¾®    

ö£›¯ Â¯õ£õµ  {ÖÁP[PÎÚõ¾® 

CµõqÁ A¾ÁÀPÐUPõPÄ® £¯ß 

£kzu¨£kQßÓÚ.

(II)  ö£¸•PU PoÛPÒ (Mainframe Computers)

 CøÁ «UPoÛPÎ¾® £õºUP ÷ÁP®, BØÓÀ, Âø» SøÓ¢uøÁ. 

ö£¸•PU PoÛz öuõÈÝm£Â¯À Gß£x £» £¯|ºPÒ J¸ PoÛ²hß   

Cøn¢x £» •iÂh[PøÍ¨ £¯ß£kzvz uµÄPøÍ²® uPÁÀPøÍ²® 

£›©õÔUöPõÒÍÀ, ÷uUQ øÁzuÀ, «sk® ö£ÖuÀ BQ¯ÁØøÓ ÷©Ø 

öPõÒÍÀ BS®. ö£¸•PU PoÛPÒ ö£›¯ Â¯õ£õµ[PÒ ©ØÖ® ªß & ÁoP® 

÷£õßÓÁØÔÀ £¯ß£kzu¨£kQßÓÚ. CøÁ ö£›¯ ÁºuP {ÖÁÚ[PÍõ¾® 

C¨÷£õx £¯ß£kzu¨£kQßÓx.
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E¸  2.3  ö£¸•PU PoÛPÒ

E¸ 2.4 
 ö£¸•PU PoÛ Aø©¨¦ 

Terminals

Terminals

Supercomputer

(III)   ]Ö PoÛPÒ (Mini Computers)

 ö£¸•PU  PoÛPÎ¾®  £õºUP  ÷ÁP®, BØÓÀ, Âø» SøÓ¢u 

]Ö PoÛPÒ ö£õx ÷|õUPU PoÛPÒ GÚÄ® AøÇUP¨£k®. CøÁ 

£¯ß£kzxÁuØS GÎuõÚx. £» £¯|ºPÎÚõÀ £» •iÂh[PÎß ‰»® 

]Ö PoÛ²hß Cøn¢x uµÄPÐ® uPÁÀPÐ® £›©õÔUöPõÒÍ¨£k®. 

Cx ]Ô¯ PoÛ Áø»¯ø©¨¦ GÚ¨£k®. Á[Q°¯À öuõSvPøÍ CuØS 

Euõµn©õPU Põmh»õ®. 

•iÂh[PÒ (Terminals)

E¸ 2.5  ]Ö PoÛPÒ E¸ 2.6   ]Ö PoÛPÒ Aø©¨¦

«UPoÛ

•iÂh[PÒ

•iÂh[PÒ
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(IV) uÛ¯õÒ PoÛPÒ / ~sPoÛPÒ / ]ÖPoÛPÒ 

      (Personal Computers / Micro Computers / Mini Computers)
      

E¸ 2.7   ]ÖPoÛPÒ

Cx  ]Ô¯  PoÛ¯õS®.  CøÁ uÛ¯õÒ 

£¯ß£õmiØS¨  £¯ß£kzu¨£k®  CU

PoÛPÒ    SøÓ¢u          öPõÒvÓøÚU 

öPõsh {øÚÁPzøu¨ ÷£õßÖ 

AÍÂ¾® Âø»°¾® Pv°¾® 

SøÓ¢uÚÁõS®. CøÁ SøÓ¢u AÍÄ 

ªßøÚ²®  ~PºQßÓÚ.

©iU PoÛPÐ®, uÛ¯õÒ PoÛPÐ® 

CuØPõÚ Euõµn[PÒ BS®.

 2.2.2  öuõÈÝm£Â¯¼Ø÷PØ£ ÁøP¨£kzuÀ

 PoÛø¯z öuõÈØ£kzu¨ £¯ß£kzx® öuõÈÝm£Â¯¼Ø÷PØ£ 

AøÁ ÁøP¨£kzu¨£k®. AuõÁx,

(I)  Jzvø\U PoÛPÒ ( Analog Computers)
       

E¸ 2.8   Jzvø\U ø\øPPÒ

 _ØÓõh¼À EÒÍ ©õØÓ[PÒ (Pv, 

÷ÁõÀØÓÍÄ, A•UP®, öÁ¨£{ø») 

÷£õßÓ Jzvø\a ø\øPPøÍ  (Analog 
Signals) CÚ[Psk AuØ÷PØ£z öuõÈØ 

£k® PoÛPÒ Jzvø\U PoÛPÒ 

GÚ¨£k®. Pv©õÛ, En›PÒ EÒÍ Ãv 

ÂÍUSPÒ, ÁõÛø» AÍøÁ¨ ö£õÔ 

BQ¯ÁØøÓ CuØS Euõµn[PÍõPU 

Põmh»õ®.

(II)  C»UP•øÓU PoÛPÒ  (Digital Computers)
        

 |õ® vÚ\› ÁõÌÂÀ £¯ß£kzx® 

PoÛPÒ  C»UP•øÓU  PoÛPÒ BS®.

CUPoÛPÒ   C»UP•øÓa  ø\øPPøÍ 

(Digital Signals)   CÚ[Psk öuõÈØ£kQß 

ÓÚ. CøÁ ö\´{µ¼Ø÷PØ£ ªß Á¾ 

ÂÚõÀ öuõÈØ£kzu¨£kQßÓÚ.

E¸  2.9 C»UP•øÓU  ø\øPPÒ
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(III)  P»¨¤ÚU PoÛPÒ (Hybrid Computers)

 Jzvø\U PoÛPÒ (Analog Computers), C»UP•øÓU PoÛPÒ (Digital 
Computers) BQ¯ C¸ ÁøPPÎÚx® J¸ P»¨£õPU P»¨¤ÚU PoÛPøÍ  

AÔ•Pg ö\´¯»õ®. Cu¯zvß öuõÈØ£õmøh AÁuõÛ¨£uØS ©¸z 

xÁ©øÚ°À  £¯ß£kzu¨£k® ECG ö£õÔ J¸ P»¨¤ÚU PoÛ¯õS®. 

Jzvø\a ø\øP¯õQ¯ Cu¯zvß öuõÈØ£õmøh CÚ[Psk AuøÚ 

C»UP•øÓa ø\øP¯õP ©õØÔ Aaø\øPPøÍ Aa]kuÀ C¨ö£õÔ°ß ‰»® 

|øhö£ÖQßÓx.

2.3   PoÛz öuõSv°ß •øÓÁÈ

 J¸ PoÛz öuõSv°ß öuõÈ»õÚx uµÄPøÍ  EÒÎmk, 

AÁØøÓ •øÓ ÁÈ¯õUQ, ÷uUQ øÁzx, ÷uøÁ¯õÚ÷£õx ÷uøÁ¯õÚ 

uPÁÀPøÍ öÁÎ°ku»õS® GßÖ |õ® PØ÷Óõ®. J¸ PoÛz öuõSv 

°ß öuõÈØ£õmkUS¨ £À÷ÁÖ TÖPÒ Jß÷ÓõöhõßÖ Cøn¢x öuõÈØ 

£kQßÓÚ. A®•øÓÁÈø¯²® J¸ PoÛz öuõSv°ß Aø©¨ø£²® 

CÆÁõÖ Põmk÷Áõ®.

E¸ 2.10    J¸ öuõSv°ß Aø©¨¦  

•ußø© {øÚÁP®

Primary Memory

uµÄ PmhøÍ

Pmk¨£õmka ø\øPPÒ
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 Kº EÒÏmkU TÔß ‰»® EÒÎh¨£k® uµÄPÐ® AÔÄÖzuÀ 

PÐ® •uß•u¼À •ußø© {øÚÁPzvÀ ÷\ªUP¨£kQßÓx. Auß ¤ßÚº 

CzuµÄPÒ  •øÓÁÈ¨£kzu¨£kÁuØPõP   ø©¯  •øÓÁÈ  A»QØS ÁÈ¨

£kzu¨£kQßÓÚ. ø©¯ •øÓÁÈ A»Qß ‰»® •øÓÁÈ¨£kzu¨£mh 

uµÄPÐ® AÔÄÖzuÀPÐ® uPÁÀPÍõP ©Ö£i²® •ußø© {øÚÁPzvØS 

ÁÈ¨£kzu¨£kQßÓÚ. A[S öÁÎ±mkU TÖ ‰»® AzuPÁÀPÒ öÁÎ 

°h¨£kQßÓÚ. AÆÁõ÷Ó AzuPÁÀPøÍz ÷uUQ øÁ¨£uØSz xøn 

{øÚÁPzvØS ÁÈ¨£kzu¾® xøn {øÚÁPzvÀ EÒÍ uPÁÀPÒ ÷uøÁ¨ 

£k®÷£õx ©Ö£i²® •ußø© {øÚÁPzvÞhõP öÁÎ°h¨£kÁx® 

|øhö£ÖQßÓÚ. Pmk¨£õmk A»Qß ‰»® PoÛz öuõSv°À EÒÍ 

GÀ»õU  TÖPÐUS®  Pmk¨£õmka ø\øPPÒ öÁÎ°h¨£kQßÓÚ.

 2.4   J¸  PoÛz  öuõSv°ß  ö£ÍwP  TÖPÒ

 (Basic Physical Components of a Computer)

PoÛz öuõSv°ß öuõÈØ£õmkUS Azv¯õÁ]¯©õÚ ]» ö£ÍwP TÖPÒ 

EÒÍÚ.

2.4.1 EÒÏmka \õuÚ[PÒ   (Input Devices)

 PoÛz öuõSvUSz uµÄPÒ EÒÏmk TÖPÎß ‰»® ÁÇ[P¨ 

£kQßÓÚ. CzuøP¯ £» EÒÏmk TÖPÒ EÒÍÚ. AÁØÔØ ]»ÁØøÓ¨ 

¤ßÁ¸©õÖ Põmh»õ®.

(I) \õÂ¨£»øP  (Keyboard)

 PoÛUSz uµÄPøÍ EÒÎk® ¤µ]zvö£ØÓ TÖ \õÂ¨£»øP¯õS®. 

Ax Aø©¨¤À umöhÊzx¨ö£õÔ°ß \õÂ¨£»øP ÷£õÀ C¸¢uõ¾® AvÀ 

÷©»vPa ö\¯Ø£õkPÐUPõP ÷©»vP \õÂPÒ EÒÍÚ.

 ö£õxÁõPa \õÂ¨£»øP C¸ AÍÄPÎÀ EÒÍx. AuõÁx 101 / 102 
öuõhUP® 104 / 108 Áøµ¯õÚ \õÂPÒ EÒÍÚ. \õÂ¨£»øP°À EÒÍ    \õÂ 

PÎß öuõÈØ£õk ¤ßÁ¸©õÖ:
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E¸  2.11   \õÂ¨ £»øP

Typing Keys - GÊzxUPøÍ 

Aa]h¨ £¯ß£kzu¨£k®

Control Keys - {ø»Põmiø¯²® PoÛz 

vøµø¯²® Pmk¨£kzx® \õÂPÒ

Special Keys - 
Â÷\h ö\¯Ø 

£õmka \õÂPÒ

  Function Keys - ªPÄ® Â÷\h©õÚ öuõÈÀ         

  PÐUPõP ©õzvµ® £¯ß£kzu¨£kQßÓx

Numeric Keys - ªPÄ® Â÷\h©õP 

öuõÈÀPÐUPõP

(II) _mka \õuÚ[PÒ (Pointing Devices)
♦  _mi (Mouse)
 PoÛz xøÓ°À £¯ß£k®. 

_mka \õuÚ[PÎÀ _mi ¤µ]zv 

ö£ØÓ  Euõµn©õS®. _miø¯ J¸ 

SÔzu A®\zvß «x ö\õhUS® 

÷£õx AzöuõÈÀ J¸ uµÁõP EÒÎ 

h¨£kQßÓx. _mi°À Chx ö£õz 

uõß, Á»x ö£õzuõß GÚ C¸ÁøP¨ 

ö£õzuõßPÐ® vøµ«x ÷©÷»²® 

R÷Ç²®  E¸mkÁuØS  J¸  ]À¾®

EÒÍÚ.  AÆÁõ÷Ó  ©iU PoÛUSa 

(Laptop Computer)   _mka    \õuÚ©õPz 

öuõk{µ¨¤h® (öuõk vsk) (Touch
Pad) AÀ»x _mi £¯ß£kzu¨£k 

QßÓx.

♦ öuõkvøµ (Touch screen)
        ¦v¯ PoÛPÎ¾® ö\À 

÷£]PÎ¾® öuõkvøµ EÒÏ 

mka \õuÚ©õPÄ® öÁÎ±mka  

\õuÚ©õPÄ® öuõÈØ£kQß 

Óx.  Czvøµø¯z  öuõkÁuß

‰»®  uµÄPÒ   EÒÎh¨£kQ

ßÓÚ. CxÄ® J¸ _mka \õu 

Ú©õS®.

E¸ 2.13 öuõkvøµ

öuõk {µ¨¤h®

]À¾

Chx 

ö£õzuõß

Á»x 

ö£õzuõß

E¸ 2.12 _mi

E¸  2.14   öuõkvøµ
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♦   C¯US¤i (Joy stick)
 C¯US¤i²®   _miø¯¨

÷£õßÖ  PoÛz  vøµ  «x {ø»

Põmiø¯ C¯[Pa ö\´¯¨ £¯ß£ 

kzu¨£k® _mka \õuÚ©õS®. 

Cx PoÛ ÂøÍ¯õmkPÐUS¨ 

£¯ß£kzu¨£kQßÓx.

♦   JÎ¨÷£Úõ (Light pen)
       

E¸  2.16  JÎ¨÷£Úõ

 JÎ¨÷£Úõ ÷ÁöÓõ¸ _mka  \õuÚ©õS® 

PoÛz vøµ°À EÒÍ £mi E¸¨£iø¯U (Menu 
item)  PõmkÁuØS  AÀ»x  vøµ «x ÁøµÁuØS

AÀ»x GÊxÁuØS CÆÄzv £¯ß£kzu¨ 

£kQßÓx. Cx ÷uõØÓzvÀ \õuõµn ÷£ÚõøÁ¨ 

÷£õßÓx. Cx PoÛ²hß öuõhº¦£mh 

ÁiÁø©¨¦PÎÀ (CAD - Computer Aided Design)  
£¯ß£kzu¨£kQßÓx.

(III)  Â®£©õUS, JÎ²¸ EÒÏmka \õuÚ[PÒ (Imaging and Video 
Input Devices)

♦  C»UP•øÓU P©µõ (Digital Camera)
 C»UP•øÓU P©µõ Gß£x JÎ¨£hU 

Põm]ø¯²® JÎ²¸U Põm]ø¯²® PoÛUS 

EÒÎkÁuØS¨ £¯ß£kzu¨£k® EÒÏmk 

Ezv¯õS®.

♦  Áø»U P©µõ (Webcam)
    Cøn¯zvÞhõPU PoÛ²hß Cøn¢ 

v¸US® J¸Áº Põm]ø¯ Gk¨£uØS AÀ»x 

JÎ²¸U  Põm]ø¯¨  ö£ÖÁuØS  Áø»U  P©µõ

øÁ¨ £¯ß£kzxQßÓõº. CÆÄzv ©iU Po 

Û²hß Cønzx Aø©zu vøµUS (Monitor/
Visual Display Unit (VDU)) ÷©÷» Põn¨£k® 

A÷u÷ÁøÍ ©ØøÓ¯ PoÛPÐUS öÁÎ÷¯ 

CønUP¨£h»õ®.

E¸  2.15  C¯US¤i

E¸  2.17  C»UP•øÓ P©µõ

E¸  2.18   Áø»U P©µõ

Áø»U P©µõ
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♦ ‰i¯ _ØÖz öuõø»UPõm]U P©µõ (Closed circuit TV (CCTV))
         ‰i¯  _ØÖz  öuõø»UPõm]U P©µõÂß ‰»® 

E¸Á® AÀ»x JÎ²¸U Põm]ø¯ Gkzx AzuµøÁ 

Azxøn²Ö¨¦hß Cønzv¸US® PoÛUS 

EÒÎh¨£k®. CÆÄzv Ãva \mh[PøÍ¨ £õx 

PõzuÀ ÷£õßÖ Ch¨ £õxPõ¨¦US® ö£›x® £¯ß 

£kzu¨£kQßÓx.

(IV)  Á¸iPÒ (Scanners)

♦  \©uÍ¨£køP Á¸iPÒ (Flatbed Scanners) 
    

    \©uÍ¨ £køP Á¸i Gß£x JÎ¨ ¤µv¨ 

ö£õÔ¯õS®. Cx \©©õPz öuõÈØ£k® 

EÒÏmk P¸Â¯õS®. AuØS ÁÈ¨£kzu¨ 

£k®  •uÀ  (E¸ AÀ»x AmhÁøn) P¸Â 

°ÝÒ÷Í  Ah[S®  ÷»\ºU PvºPÎß ‰»® 

ö£Ó¨£mk C»UP•øÓz uµÄPÍõP ©õØÓ¨ 

£mkz ÷uUQ øÁ¨£uØPõPU PoÛUS EÒÎ 

h¨£kQßÓx.

♦   £møhU SÔ•øÓ Áõ]¨£õß (Barcode Reader)

      CU P¸Â  ‰»® ö£¸®£õ»õÚ ö£õ¸Ò 

PÎÀ Põn¨£k® £møhU SÔ•øÓ (Barcode) 
Áõ]UP¨£kQßÓx. A¨£møhU SÔ•øÓ  

GÊzöus  (Alphanumeric)  ö£Ö©õÚ©õP ©õØÓ¨ 

£mk AuÝhß CønUP¨£mkÒÍ PoÛUS 

EÒÎh¨£k®.

♦    Põ¢u ø© Á›²¸ Áõ]¨£õß   

     (Magnetic Ink Character Reader (MICR))
 CUP¸Â    Á[QPÎÀ     Põn¨£k

QßÓx.   Põ÷\õø»°À   EÒÍ   ö\®ø©ø¯a 

÷\õv¨£uØS CUP¸Â £¯ß£kzu¨ 

£kQßÓx. Põ÷\õø»°ß RÌ¨ £Sv°À 

EÒÍ GsPøÍ Áõ]zx AvÀ EÒÍ 

uPÁÀPÒ   (Á[QU SÔ•øÓ, Á[QU PnUS 

Gs) PoÛUS EÒÎh¨£k®.

E¸  2.19   ‰i¯ _ØÖz 

öuõø»UPõm]U P©µõ 

E¸ 2.20 \©uÍ¨ £køP Á¸i

E¸  2.21  £møhU SÔ•øÓ 

Áõ]¨£õß

E¸ 2.22 

Põ¢u ø© Á›²¸ Áõ]¨£õß
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♦   JÎ°¯À Á›²¸ PshÔuÀ (Optical Character Recognition (OCR)) 

     £» £UP[PøÍU öPõsh BÁn[PøÍ 

ªPU SÖQ¯ Põ»zvÀ Á¸iU PoÛ¨ 

£kzxÁuØS® PoÛ¨£kzv¯ BÁnz 

øu¨ £v¨¦a ö\´ÁuØS® JÎ°¯À  Á›²¸  

PshÔuÀ  £¯ß£kzu¨£kQßÓx. Cx 

¡»P[PÎ¾® Aµ\õ[P {ÖÁÚ[PÎ¾® 

£µÁ»õP¨ £¯ß£kzu¨£k® EÒÏmk Ezv¯õS®.

♦   JÎ°¯À SÔ PshÔuÀ (Optical Mark Recognition (OMR))
 JÎ°¯À  SÔ  PshÔuÀ   Gß£x

SÔPøÍ CÚ[Põn¨ £¯ß£kzu¨£k® 

EÒÏmk P¸Â¯õS®. ÷£ÚõÂÚõÀ AÀ»x

ö£ß]¼ÚõÀ  SÔUP¨£mh  £iÁ®, £Ÿm

ø\¨ £»ÂÝÒ öu›Ä ÂøhzuõÒPÐUS¨ 

¦ÒÎ°kuÀ BQ¯ÁØÖUS¨ £µÁ»õP¨ 

£¯ß£kzu¨£k® CÆÁ¸i°ß ‰»® 

•ßÚ÷µ {a\°UP¨£mh Ch[PÎÀ EÒÍ SÔPøÍ  Áõ]zxU  SÔPÒ A[S 

C¸zuÀ öuõhº£õPU PoÛUSz uµÄPÒ EÒÎh¨£k®.

♦   ußÛ¯UPU Põ\Î¨¦ G¢vµ® (Automated Teller Machine (ATM))
 Á[Qz öuõÈ¼À Kº A®\©õQ¯ 

CUP¸Â°ÚõÀ    PhÚmøh°ß  AÀ»x   Áµ

Ámøh°ß   ‰»®    |øhö£Ö®   öPõkUPÀ

Áõ[PÀ GÎuõUP¨£mkÒÍx.    CUP¸ÂUS 

ÁÈ¨£kzu¨£k® PhÚmøhø¯ AÀ»x 

ÁµÁmøhø¯  Áõ]zx  AvÀ EÒÍ GsPÒ 

÷\õvUP¨£mk Cøn¯zvÞhõP  AuØS  

E›¯ Á[QU PnUShß Cøn¢u  PoÛUSz  

uµÄPøÍ  EÒÎkÁuß  ‰»® öPõkUPÀ Áõ[P 

¼ØPõÚ uSv ÷\õvUP¨£kQßÓx.

♦  ~qUS¨£ßÛ (Microphone)
     PoÛUS  J¼ø¯   EÒÎkÁuØS¨  £¯ß

£kzu¨£k® xøn²Ö¨¦ ~qUS¨£ßÛ 

BS®.

E¸  2.23    JÎ°¯À Á›²¸ PshÔuÀ

E¸ 2.24   JÎ°¯À SÔ PshÔuÀ

E¸ 2.25   ußÛ¯UPU Põ\Î¨¦     

G¢vµ®

E¸  2.26    ~qUS¨£ßÛ
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2.4.2   öÁÎ±mka \õuÚ[PÒ   (Output Devices)

 PoÛz öuõSv°ß ‰»® u¯õºö\´¯¨£mh uPÁÀPøÍ G©USz u¸® 

ÂÁµ[PÒ EÒÍÚ. AÁØÔØ ]»:
(i) ö©ß|PÀ (Soft Copy)  
(ii) Áß|PÀ (Hard Copy) 

(iii) J¼ (Sound)

(i)  ö©ß|PÀ (Soft Copy)

 ö©ß|PÀ Gß£x vøµ «x £õº¨£uØPõP ©õzvµ® uPÁÀPøÍ 

öÁÎ°kuÀ BS®. ö©ß|PÀ ÁiÁzvÀ uPÁÀPøÍ öÁÎ°k® P¸Â 

PÍõÁÚ : 

♦  vøµ (Monitor / Screen)
           

ö©ß |P»õPz uPÁø» öÁÎ°k® •UQ¯ 

P¸Â PoÛz vøµ¯õS®. Cx Pm¦»U Põm] 

A»S (Visual Display Unit) BS®. PoÛz 

vøµ°ß £» ÁøPPÒ EÒÍÚ. AøÁ¯õÁÚ :

A - P÷uõmkU PvºU SÇõ²hß Ti¯ 

vøµ  (Cathode Ray Tube (CRT) and 
Monitor)

öuõhUPzv¼¸¢x CßÖ Áøµ öÁÎ±mk Ezv¯õP¨ £¯ß£kzu¨£k® 

CÆÁøPz vøµ AÍÂÀ ö£›¯uõP C¸US® A÷u÷ÁøÍ AvP AÍÄ ªßøÚ 

~PºQßÓx. BP÷Á, Cx £i¨£i¯õP¨ £¯ß£õmi¼¸¢x }[SQßÓx.

B - vµÁ¨ £Î[SU Põm] (Liquid Crystal 
Display - LCD)

 CUPoÛz vøµ \©uÍU Põm]z öuõÈÝm£ 

Â¯¾U÷PØ£ EØ£zv ö\´¯¨£mkÒÍx. C¸ 

ÁøÍuS •øÚÁõUQ¯ ªßÁõ´PÐUQøh÷¯ J¸

£Î[SU Pøµ\ø»a ÷\ºzx Cx E¸ÁõUP¨£m 

kÒÍx. Cx ]ÔuÍÄ ªß\õµzøu÷¯ ~PºQßÓx.

E¸  2.28    vµÁ¨ £Î[SU 

Põm]

E¸  2.27   P÷uõmkU PvºU 

SÇõ²hß Ti¯ vøµ  

P÷uõmkU PvºU 

SÇõ´
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C - JÎPõ¾® C¸Áõ°  
 (Light Emitting Diode - LED )

   vµÁ¨£Î[SU Põm]°À £¯ß£kz 

u¨£k® £Î[SU Pøµ\¾US¨ £v»õP 

JÎPõ¾® C¸Áõ°ø¯¨ ¤µ÷¯õQzx 

Aø©UP¨£mkÒÍ LED PoÛ vøµ ªUP 

PÁºa] ÷uøÁ¨£k® ö£õx Ch[PÎÀ ø\

øPPÒ, Põm]¨ £»øPPÒ, ÁºzuP¨ ö£¯º¨ 

£»øPPÒ BQ¯ÁØÖUS¨ £¯ß£kzu¨£k 

QßÓÚ. JÎPõ¾® C¸Áõ°z öuõÈÝm£ 

Â¯À CßÖ ¤µ]zvö£ØÓ FhP©õP 

©õÔ°¸¨£uØSU SøÓ¢u AÍÄ ªß  ~Pµ¨ 

£kQßÓø©÷¯  Põµn©õS®.  

♦   £À¿hP GÔøÁ (Multimedia Projector)
      J÷µ uhøÁ°À £»º Cµ]UPzuUP APßÓ 

vøµ uPÁÀPøÍ öÁÎ°h ÷Ási¯÷£õx 

£¯ß£kzu¨£k®   P¸Â   £À¿hP GÔøÁ¯õ 

S®. B]›¯ºPÒ PØ¤zuÀ FhP©õP¨ £¯ß 

£kzuzuUP  •ßøÁ¨¦PøÍU  PõmkÁuØS® 

Â¯õ£õµU  Tmh[PøÍ |hzxÁuØS® ö£õÊ

x÷£õUQØPõP JÎ²¸U Põm]PøÍ Cµ]¨£ 

uØS® £¯ß£kzu¨£k® Ca\õuÚzøuU 

PoÛz öuõSv²hß Cøn¨£uß ‰»® 

Kº APßÓ vøµ «x ÷uøÁ¯õÚ uPÁÀPøÍ 

öÁÎ°h»õ®.   

(ii)  Áß|PÀ (Hard Copy)

öuõhzuUP PoÛ öÁÎ±hõP Áß|Pø»U Põmh»õ®. Áß|Pø» öÁÎ°k® 

öÁÎ±mk P¸ÂPÍõÁÚ:

Aa_¨ ö£õÔPÒ (Printers)

Aa_¨ ö£õÔ •UQ¯©õP C¸ÁøP¨£k®. AøÁ¯õÁÚ:

E¸  2.29   JÎPõ¾® C¸Áõ°

 E¸ 2.30  £À¿hP GÔøÁ 
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AÊzua_¨ ö£õÔPÒ

(Impact Printers)

 � ÷»\º Aa_¨ö£õÔ (Laser Printer)
 � SªÈ / ø©z uõøµ Aa_¨ö£õÔ (Bubble 

Printer / Ink Jet Printer)
 � öÁ¨£ Aa_¨ö£õÔ  (Thermal Printer)

 � ¦ÒÎ Aø©Ä¸ Aa_¨ 

ö£õÔ   (Dot Matrix 
Printer)

 � Á› Aa\¨ö£õÔ

 (Line Printer)

AÊzuõu Aa_¨ö£õÔPÒ

(Non Impact Printers)

Aa_¨ 

ö£õÔPÒ    

 Printers

1.   AÊzua_¨ ö£õÔPÒ ( Impact Printers)

    Aa^mkz öuõÈÝm£Â¯¼À AÊzua_¨ ö£õÔPÒ •ußø© Á›ø\US 

E›¯ÚÁõS®. C[S ö£õÔ•øÓ P¸Â¯õÚx Aa]ß uø»  (Head) uõÎß «x 

£kÁuÞk  Aa^k |øhö£ÖQßÓø©¯õS®.  CÆÁÊzu®   Põµn©õP Ax 

öuõÈØ£k®÷£õx Cøµa\À HØ£mhõ¾® AvÀ £¯ß£kzu¨£k® ø© |õhõ 

(Ink Ribbon) Âø» Ti¯ußÖ BøP¯õÀ ªPÄ® C»õ£Pµ©õÚuõS®. Aa]

mh |PÀPøÍ øÁzxU öPõÒÐ® Á[QPÒ, PÍg]¯[PÒ BQ¯ÁØÔÀ CøÁ 

ö£›x® £¯ß£kzu¨£kQßÓÚ.

      

♦   ¦ÒÎ Aø©Ä¸ Aa_¨ ö£õÔ  (Dot Matrix Printer)

    Aa_¨ ö£õÔ°ß uø» F] 

÷£õßÓ TºPÎß ‰»® ø© EÒÍ 

|õhõÂÀ £kQßÓø©¯õÀ ]Ô¯                                                              

SØÖ ÁiÁzvÀ uõÎß «x GÊz 

xPÒ Aa]h¨£kQßÓÚ. 

             

♦   Á› Aa_¨ö£õÔ (Line Printer)

 J¸ uhøÁ J¸ Á› Ãu® Aa]k® C¨ö£õÔ 

ªPÄ® ÂøµÁõÚ Aa_¨ö£õÔ¯õS®. Cx J¸ {ªhz 

vØS HÓzuõÇ 3000 Á›PøÍ Aa]hzuUPx.

E¸ 2.31   ¦ÒÎ Aø©Ä¸ Aa_¨ö£õÔ

E¸ 2.32 Á› Aa_¨ö£õÔ
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2. AÊzuõ Aa_¨ö£õÔ (Non Impact Printers)

 CÆÁa_¨ö£õÔ £¯ß£kzu¨£k® uõÎß «x AÊzxÁvÀø» 

BøP¯õÀ, CÁØÔÀ Cøµa\À HØ£kÁvÀø». QøhUS® Aa_¨£iPÒ 

ªPz öuÎÁõÚøÁ²® x¨£µÁõÚøÁ²® BS®. GÛÝ®, CuØS¨ £¯ß 

£kzu¨£k® FhP® Âø»Ti¯x BøP¯õÀ, CuøÚ¨ £¯ß£kzuÀ 

C»õ £Pµ©õÚußÖ. CzuøP¯ ]» AÊzuõ Aa_¨ö£õÔPøÍ¨ ¤ßÁ¸©õÖ 

Põmh»õ®. 

♦   ÷»\º Aa_¨ö£õÔ   (Laser Printers)
 ÷»\º Aa_¨ö£õÔ°À Aa]h¨£h ÷Ási¯ £Sv J¸ ÷»\ºU PØøÓ°ß 

‰»® (Kº Bi°ÞhõP) Kº HØÔ¯ E¸øÍ (Drum) «x AÝ¨£¨£kÁx® Auß 

«x J¸ ö£õÔ²øÓ°À (Cartridge) EÒÍ E»º ø©¨ö£õi (Toner) £kÁuÞhõP 

Aa]h¨£ku¾® |øhö£ÖQßÓÚ.

 J¸ {ªhzvØS |õßS  A4 AÍÄ uõÒPøÍ Aa]k® Pv°À öuõÈØ£k® 

Aa_¨ ö£õÔPÐ® EÒÍÚ. PÖ¨¦ {Ó® ÷£õßÖ £À÷ÁÖ {Ó[PøÍU öPõsh 

ø©¨ö£õi (Toner) C¸¨£uÚõÀ, öuÎÁõÚ, uµ©õÚ E¸UPøÍ²® Aa_¨ 

£iPøÍ²® öÁÎ°kÁuØS ªPÄ® EP¢u \õuÚ® ÷»\º Aa_¨ö£õÔ¯õS®.

E¸ 2.33  ÷»\º Aa_¨ö£õÔ E¸ 2.34   ö£õv²øÓ

ø©¨ö£õi ö£õv²øÓ

(Toner cartridge)

E¸øÍ

(Drum)
÷»\ºU 

PØøÓ

Bi

           

E¸  2.35  SªÈ / 

ø©zuõøµ Aa_¨ö£õÔ

♦  SªÈ/ ø©z uõøµ Aa_¨ö£õÔ (Bubble / 
Ink jet Printer)

    C¢u  Aa_¨ö£õÔ°À ö£õv²øÓ°À (Cartridge) 
J¸ £õzvµzvÀ øÁUP¨£k® vµÁ {ø»ø©°À 

EÒÍ ø© (Liquid Ink) ]Ô¯ xÁõµ[PÎÞhõPz 

(Nozzles) uõÎß «x £mk Aa^k |øhö£ÖQßÓx.
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♦   öÁ¨£ Aa_¨ö£õÔ (Thermal Printer)
 C¢u Aa_¨ö£õÔ°À öÁ¨£zøu¨ £¯ß£ 

kzvz uõÎß «x Aa^k |øhö£ÖQßÓx. ÁºzuP 

Â¯õ£õµ®, ußÛ¯UPU Põ\Î¨¦¨ ö£õÔ BQ¯ÁØÔÀ 

£ØÖa^mkPøÍ ÁÇ[SÁuØS® _mkz xskPøÍ 

Aa]kÁuØS® Cx AvP AÍÂÀ £¯ß£kzu¨£k 

QßÓx.

♦   ÁøµÂ  (Plotter)
       PoÛ  öuõhº£õÚ   vmh

ªh¼À (PmhhU Pø» ÁiÁ 

ø©¨¦PÒ, |Pµz vmhªhÀPÒ, 

P¨£Ø £¯nz vmh[PÒ) AvP 

AÍÂÀ £¯ß£kzu¨£k® CÆ 

öÁÎ±mk P¸Â°ß ‰»® 

uõÎß «x J¸ ÷£Úõ A[S® 

C[S® ö\ÀÁuÚõÀ vmh® 

öÁÎ°h¨£kQßÓx.

            

(iii) J¼PÒ (Sounds)
     J¼ø¯ öÁÎ°k® P¸ÂPøÍ  

J¼ö£¸UQPÍõPU Põmh»õ®. 

ö£õxÁõP AÀ»x uÛ¨£mh 

ÂuzvÀ J¼ø¯ öÁÎ°hzuUP 

uõP J¼US® P¸ÂPÒ EÒÍÚ.

2.4.3  ø©¯ •øÓÁÈ¯õUP A»S  (Central Processing Unit) - CPU

 PoÛz öuõSv°ß Ai¨£øh A®\® ø©¯ •øÓÁÈ¯õUP A» 

PõS®. PoÛ°ß ‰øÍ¯õP AøÇUP¨£k® ø©¯ •øÓÁÈ¯õUP A»S 

PmhøÍPÐU÷PØ£z öuõÈØ£k® A÷u÷ÁøÍ Cx £oö\¯À •øÓø©²®                  

(Operating) ¤µ÷¯õP ö©ßö£õ¸øÍ²® (Application Software) •Põø© ö\´QÓx. 

ø©¯ •øÓÁÈ¯õUP A»S •UQ¯ ‰ßÖ £SvPøÍU öPõskÒÍx. 

E¸ 2.36
öÁ¨£ Aa_¨ö£õÔ

E¸  2.37   ÁøµÂ

E¸  2.38  J¼ ö£¸UQ
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1.  GsPou•® u¸UP A»S®                    

(Arithmetic & Logical Unit - ALU)
GÀ»õ ÁøP GsPou, u¸UPa ö\¯ÀPÒ 

|øhö£ÖQßÓÚ.

2.  Pmk¨£õmk A»S

    (Control Unit - CU)
PoÛz  öuõSv°ß  GÀ»õ   TÖPÐ® 

CuÚõÀ  Pmk¨£kzu¨£kQßÓÚ.

3.  {øÚÁP¨ £vÁP[PÒ

    (Memory Registers)
ø©¯ •øÓÁÈ¯õUP A»QÀ EÒÍÚ. 

GsPou, u¸UP A»QÀ öuõÈØ£mkU 

öPõsi¸US® •øÓÁÈPÐUSz ÷uøÁ

¯õÚ uµÄPÒ uØPõ¼P©õP øÁzv¸U 

P¨£kQßÓÚ.

    ø©¯ •øÓÁÈ¯õUP A»Qß ¤µuõÚ £SvPÒ

PoÛ°ß Pv 

 PoÛ°ß Pv PoÛ°ß J¸ ]Ó¨¤¯Àö£Ú |õ® PØ÷Óõ®. C[S 

ø©¯ •øÓÁÈ¯õUP A»QÚõÀ uµÄPøÍz u¯õºö\´ÁuØS GkUS® ÷|µ® 

Pv¯õP AøÇUP¨£kQßÓx. Cx PiPõµU Pv (Clock Speed) GÚ¨£k®. Põ»® 

AÍUP¨£k® A»S ÷íØì (Hertz - Hz) BP C¸US® A÷u÷ÁøÍ PoÛ°ß 

Pv ö©Põ÷íØì (Mega hertz - MHz) AÀ»x QPõ÷íØì (Giga hertz - GHz) 
GßÝ®  A»SPÎÀ  AÍUP¨£kQßÓx.-

2.4.4  PoÛ {øÚÁP[PÒ (Computer Memories)

 uµÄPøÍ²® uPÁÀPøÍ²® ÷uUQ øÁ¨£uØPõÚ BØÓÀ PoÛ°h® 

EsöhÚ |õ® PØ÷Óõ®. £À÷ÁÖ PoÛ {øÚÁP[PÒ (Computer Memories) 
AÀ»x ÷uUPPa \õuÚ[PÒ (Storage Devices) uµÄPøÍ²® uPÁÀPøÍ²® 

÷uUQøÁUP¨ £¯ß£kzu¨£k® A÷u÷ÁøÍ {øÚÁP[PÎß öuõÈØ£õk 

÷ÁÖ£mhx. CÆ ÷ÁÖ£õkPøÍ ¤ßÁ¸©õÖ ÁøP¨£kzu¨ £h»õ®.
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E¸ 2.39 PoÛ {øÚÁP[PÒ

(I) •uÀ  {øÚÁP® (Primary Memory)

 PoÛz öuõSvUS EÒÎh¨£k® uµÄPÒ ø©¯ •øÓÁÈ¯õUP 

A»QÚõÀ u¯õºö\´¯¨£kÁuØS •ßÚ¸® u¯õºö\´¯¨£mh ¤ßÚ¸® •uÀ 

{øÚÁPzvÀ (Primary Memory) AÀ»x •ußø© {øÚÁPzvÀ (Main Memory) 
øÁzv¸UP¨£kQßÓÚ. Cx •uÀ {øÚÁP® (Primary Storage) GÚ¨£k®. 

•uÀ {øÚÁP® ‰ßÖ ÁøP¨£k®.

 � uØ÷£õUS¨ ö£ÖÁÈ {øÚÁP®  ( Random Access Memory     
 (RAM)) 
           

       uØ÷£õUS¨ ö£ÖÁÈ {øÚÁPzøuz u¯õº 

ö\´ÁuØS ÁÈ¨£kzx® ÁøµUS® uµÄPÒ 

uØPõ¼P©õP øÁzxUöPõÒÍ¨£kQßÓÚ. 

AvÀ øÁzxUöPõÒÍ¨£k® uµÄPÒ PoÛ 

öuõÈØ£kuÀ {Ø£õmh¨£k®÷£õx (Switch 
off) {øÚÂ¼¸¢x APØÓ¨£k®. BP÷Á 

C¢{øÚÁP® AÈuS {øÚÁP® (Volatile 
Memory)   GÚ¨£k®.  AÆÁõ÷Ó   uPÁÀPøÍ

öÁÎ°kuÀ,  ÷uUQ øÁzuÀ,  «sk®  ö£ÖuÀ  BQ¯ÁØÖUS  •uÀ {øÚ

ÁPzvÞhõP÷Á xøn {øÚÁPzvØSz uµÄPÒ ÁÈ¨£kzu¨£kQßÓÚ. 

uØ÷£õx £¯ß£õmiÀ EÒÍ  uØ÷£õUS¨  ö£ÖÁÈ {øÚÁPzvß öPõÒvÓßPÒ 

1 GB  öuõhUP® 24 GB  Áøµ  C¸US® A÷u÷ÁøÍ öuõÈÝm£zvß •ß÷ÚØ 

Ózxhß C¢u AÍÄPÒ ©õÓ»õ®.

E¸  2.40    uØ÷£õUS¨ ö£ÖÁÈ 

{øÚÁP® 
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 � Áõ]¨¦ ©mk® {øÚÁP® (Read Only Memory (ROM))
            

E¸  2.41  Áõ]¨¦ ©mk® 

{øÚÁP®

    Áõ]¨¦ ©mk® {øÚÁPzvÀ EÒÍ uP 

ÁÀPÒ G¨÷£õx® ©õÓõ©À C¸US®. BP÷Á 

Ax AÈÄÓõ {øÚÁP©õS® (Non - Volatile 
memory). PoÛ°ß Ai¨£øh •øÓÁÈUSz 

÷uøÁ¯õÚ PmhøÍPÒ Áõ]¨¦ ©mk® 

{øÚÁPzvÀ ÷uUQ øÁUP¨£k®.

  Ai¨£øh EÒÏmk öÁÎ±mkz öuõSv  

((BIOS) - Basic Input Output System) PmhøÍ¯õP 

C¸US® CUPmhøÍPÒ PoÛ EØ£zv {ÖÁ 

PzvÚõÀ  Áõ]¨¦  ©mk® {øÚÁPzvÀ ]Ô¯ 

ChzvÀ ÷uUQ øÁUP¨£mk, PoÛz uõ´¨£

»øP°À ö£õ¸zu¨£mkÒÍÚ. 

 � £xUS {øÚÁP® - (Cache Memory)

 £xUS {øÚÁP® HøÚ¯ {øÚÁP[PÎ¾® £õºUP AÍÂØ ]Ô¯uõP 

C¸UQßÓ ÷£õv¾® ªPÄ® ÂøµÁõÚx. Cx ø©¯ •øÓÁÈ A»S 

{øÚÁP® (CPU Memory) GÚÄ® AøÇUP¨£k®. ø©¯ •øÓÁÈ A»QØS® 
(CPU) •ußø© {øÚÁPzvØS® (Main Memory) Cøh÷¯ EÒÍ Cx AiUPi 

£¯ß£kzu¨£k® uµÄPøÍ øÁzv¸US®.

 ø©¯ •øÓÁÈ A»Q¼¸¢x uµÄPÒ C¸UQßÓÚÁõ GßÖ £xUS 

{øÚÁPzvÀ (Cache Memory) ÷\õvzx¨ £õºUP¨£mk •øÓÁÈ¯õUQUS 

ÁÈ¨£kzu¨£k®. C®•øÓÁÈ Põµn©õP ø©¯ •øÓÁÈ A»Qß Pv 

AvP›US®. GÛÝ®, uµÄPÒ CÀ»õu÷£õx •ußø© {øÚÁPzv¼¸¢x 

uµÄPøÍ¨ ö£ØÖUöPõsk AÁØøÓ¨ £xUS {øÚÁPzvÀ ÷uUQ øÁzx 

ø©¯ •øÓÁÈ A»QØS ÁÈ¨£kzx®.

•ußø© {øÚÁP®

(Main memory)

£xUS {øÚÁP®

(Cache memory)

ø©¯ •øÓÁÈ A»S 

(CUP)

3. £xUS    {øÚÁ   

PzvÀ   CÀø»ö¯ 

ÛÀ      •ußø©       

{øÚÁPzvh®    

ÁÈ¨£kzu¨£k®

2. uµÄPÒ C¸¨¤ß AøÁ 

•øÓÁÈ¯õUQ°h® ÁÈ¨                                                                                                       

£kzu¨£k®.  ÷|µ®   «u¨ 

£kzu¨£k®

4. •ußø©  {øÚÁPzv¼¸¢x 

uµÄPÒ  £xUS  {øÚÁPzvØS 

ÁÈ¨£kzu¨£k®  AvÀ  ÷uUQ 

øÁUP¨£mk   •øÓÁÈ¯õUQ 

ÁÈ¨£kzu¨£k®

1. uµÄPÒ C¸UQßÓÚÁõ 

GÚ¨ £xUS {øÚÁPzvÀ 

÷\õvUP¨£k®.

E¸  2.42 £xUS {øÚÁP®
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(II)  xøn {øÚÁP® (Secondary  Memory  Auxiliary  Storage)

   xøn {øÚÁP® AÀ»x xønz ÷uUPP® uµÄPøÍ²® uPÁÀPøÍ²® 

{ø»¯õPz ÷uUQ øÁUS® xøn²Ö¨£õS®. Cx ¦Óz ÷uUPP® GÚÄ® 

AøÇUP¨£k®. EÒ÷Í  PoÛz  öuõSvUSz  öuõkUP¨£k®    ÷uUPPa 

\õuÚ[PÒ ÷£õßÖ ¦Óz÷u PoÛUSz öuõkUPU Ti¯x® A[S® C[S® 

öPõsk ö\À»zuUPx©õÚ xønz ÷uUPPa \õuÚ[PÒ EÒÍÚ. CÁØøÓa 

]» ÁøPPÍõP ÁøP¨£kzu»õ®.

E¸ 2.43  xøn {øÚÁP®

1. Põ¢u FhPa \õuÚ[PÒ (Magnetic Media Devices)

   Põ¢u FhPa \õuÚ[PÒ Põ¢u ¦»zvß  ‰»® uµÄPøÍz ÷uUQ 

øÁUS®. 

♦   ÁßÁmk (Hard Disk) 

        uµÄPøÍ²®  uPÁÀPøÍ²® ÷uUQ øÁUP¨ £¯ß£kzx® ¤µ]zv ö£ØÓ 

FhP©õQ¯ ÁßÁmk ö£õxÁõPU PoÛ°ÝÒ÷Í Põn¨£k®. GÛÝ® 

¦Óz÷u°¸¢x PoÛUSz öuõkUP¨£k® ÁßÁmkPÐ® EÒÍÚ. vÚ•® 

•ß÷ÚÖ® öuõÈÝm£Â¯À Põµn©õP¨ ö£›¯ öPõÒvÓøÚU (uµÄPÒ 

÷uUQ øÁUP¨£hzuUP Ch AÍÄ) öPõsh ÁßÁmkPÒ AvP AÍÂÀ 

Põn¨£kQßÓÚ. ÁßÁmiÀ EÒÍ uµÄPøÍ²® uPÁÀPøÍ²® Áõ]zu¾® 

Auß «x GÊxu¾® £¯|¸US C¯¾®. BP÷Á, Cx FhPzøu Áõ]US®, 

GÊx® {øÚÁP®  GÚ¨£k®. ÁßÁmiß öPõÒvÓß 250 GB  CØS® 4 TB 
CØSªøh÷¯ C¸US® A÷u÷ÁøÍ öuõÈÝm£Â¯¼ß •ß÷ÚØÓzxhß 

C¢u AÍÄ vÚ•® ©õÔ Á¸QßÓx. 
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ÁßÁmk £» £SvPøÍU öPõskÒÍx.

1.  {øÚÁPz umk (Platter)  & E÷»õPz 

umhõP C¸US® A÷u÷ÁøÍ  Cuß  

C¸ £UP[PÎ¾® uµÄPøÍz ÷uUQ 

øÁ¨£uØPõÚ BØÓÀ Esk. J¸   

Áß ÁmiÀ £» {øÚÁPz umkPÒ 

C¸UP»õ®.

      

2.  _ÇÀ usk (Spindle) & {øÚÁPz umøh øÁzxU öPõsk _Ç»a 

ö\´QßÓx.

3.   uø» (Head) &  {øÚÁPz  umiÀ  EÒÍ  Põ¢uz  uµÄPøÍ   Áõ]zuÀ

   {øÚÁPz   umiß «x GÊxuÀ BQ¯Ú uø»°ß ‰»® ÷©ØöPõÒÍ¨ 

£kQßÓÚ. J¸ {øÚÁPz umiØS ÷©÷»²® R÷Ç²® C¸ uø»PÒ 

Esk.

4.  ysi¨ ¦¯® (Actuator arm) & 

 uø»   ysi¨  ¦¯zvß    ‰»®

 A[S®  C[S® Aø\UP¨£kQß

 Óx. {øÚÁPz umiÀ  G¢u Chz

 v¾®   uµÄPøÍ   GÊxÁøu²® 

 Áõ]¨£øu²® \õzv¯©õUSQßÓx.

            

5.  Á¾z öuõk¨£õß  (Power 
connector) - Áß Ámiß öuõÈØ 

£õmiØSz ÷uøÁ¯õÚ ªßÁ 

¾øÁ öuõkUQßÓx.

6.    IDE öuõk¨£õß (IDE con 
nector) & {øÚÁPz umiØSz 

uµÄPøÍ¨ £›©õÖQßÓx.

7. ysi (Actuator) - CuÝhß öuõkUP¨£mkÒÍ ¦¯zøu A[S® 

C[S® öPõsk ö\À¾® ªß A[P©õQ¯ Cx ÷©õmh›ß ‰»® 

öuõÈØ£kzu¨£kQßÓx.

E¸ 2.44   Áß Ámk

£» {øÚÁPz 

umkPøÍU 

öPõsh Áß
öÁmk

¦Ó {ø» 

ÁßÁmk
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2.  Põ¢u |õhõ (Magnetic Tape)

SøÓ¢u Pvø¯²® E¯º öPõÒvÓøÚ²® 

öPõsi¸¨£uÚõÀ uµÄPøÍ²® uPÁÀ 

PøÍ²® £õxPõzx øÁ¨£uØS ©õzvµ® 

£¯ß£kzu¨£kQßÓx. vÚ\› ÁõÌÂÀ 

£¯ß£kzu¨£kÁvÀø».

JÎ°¯À FhP[PÒ (Optical media)

 Kº E÷»õPz umiÀ SÔ¨£uß (öÁmkÁuß) ‰»® uµÄPÒ ÷uUQ 

øÁUP¨£kQßÓÚ.   uµÄPøÍ²®   uPÁÀPøÍ²®  A[S® C[S® öPõsk 

ö\ÀÁuØS AvP AÍÂÀ £¯ß£kzu¨£k® £» ÁøP JÎ°¯À umkPÒ 

EÒÍÚ. AÁØÔÀ ]» R÷Ç uµ¨£mkÒÍÚ.

\õuÚ® ÁøP AÍÄ Â®£®

CÖÁmk

CD-ROM (Compact Disc 
- Read Only Memory)

uµÄPøÍ²® uPÁÀPøÍ²® Áõ]¨ 

£uØS ©õzvµ® £¯ß£kzu¨£k 

QßÓx Áõ]¨¦ ©mk® {øÚÁP®

650 - 900    
MB

CD-R (Compact Disc-Write 
once)

J¸ uhøÁ ©õzvµ® uµÄPøÍ²® 

uPÁÀPøÍ²® GÊv, ¤ßÚº 

Áõ]¨£uØS ©õzvµ® £¯ß£kzu¨ 

£kQßÓx (Write once then Read only)

CD-RW (Compact Disc 
Re-Writable)

£» uhøÁ uµÄPøÍ²® uPÁÀ 

PøÍ²® GÊu»õ®.

650 - 900 
MB

C»UP•øÓ¨ £ÀÂuz 

umkPÒ

DVD - ROM
Digital Versatile Disc - 
Read Only Memory

uµÄPøÍ²® uPÁÀPøÍ²® Áõ]¨ 

£uØS ©õzvµ® £¯ß£kzu¨£k 

QÓx 

 

4.7 - 9.4 
GB

DVD - R  (Digital Versa-
tile Disc - Write Once)

J¸ uhøÁ ©õzvµ® uµÄPøÍ²® 

uPÁÀPøÍ²® GÊv, ¤ßÚº                 

Áõ]zuø» ©õzvµ® ö\´QßÓx.

DVD - RW (Digital Versa-
tile Disc - Rewritable)

£» uhøÁ uµÄPøÍ²® uPÁÀ 

PøÍ²® GÊuzuUPx 

E¸ 2.45   Põ¢u |õhõ
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¦Ñ & ÷Ó 

Blu - ray (BD)  R

AvP AÍÄ uµÄPøÍz ÷uUQ 

øÁUPzuUP ö£›¯ öPõÒvÓøÚU 

öPõshx. Áõ]¨£uØS ©õzvµ® 

J¸ uhøÁ GÊuzuUPx. uµÄPøÍ 

GÊxÁuØS }» {Ó•ÒÍ ÷»\ºU 

PvºPÒ £¯ß£kzu¨£kQßÓÚ. 

 
25 - 128 
GB

Blu - ray RE
J¸ uhøÁ GÊu¨£mh uµÄPÐUS 

÷©»vP©õP «sk® B°µ® uhøÁ 

•ÊU öPõÒvÓÝ® {µ®¦® Áøµ 

uµÄPøÍa ÷\ºUP»õ®. 

Blu - ray 3D
3D Ãi÷¯õÂÀ £vÄö\´¯¨ £¯ß 

£kQßÓx.

 � vs© {ø»ø©a \õuÚ[PÒ  (Solid state devices)

A[S® C[S® ö\À»õu vs© A®\[PøÍU öPõsi¸¨£uÚõÀ Ca\õuÚ[PÒ 

vs© {ø»ø©a \õuÚ[PÒ  GÚ¨£kQßÓÚ. Ca\õuÚ[PÒ uµÄPøÍ²® 

uPÁÀPøÍ²® Áõ]UPÄ® GÊuÄ® £¯ß£kzu¨£kQßÓÚ.

        

 � USB £Îa^mka ö\¾zv  (USB 
flash drive)

 GÎuõP A[S® C[S® öPõsk ö\À 

»z uUPuõP C¸¨£uÚõ¾® ÂøµÁõPz uµÄ 

PøÍU Põs£uØPõÚ BØÓÀ Põµn©õPÄ® 
USB £Îa^mka ö\¾zv ªP¨ ¤µ]zvö£ØÓ 

xønz ÷uUPPa \õuÚ©õP EÒÍx.

     

 � {øÚÁP Amøh ( Memory card) 
                 
 USB      £Îa^mk  C¯UQø¯  Jzu    öuõÈØ 

£õmøhU öPõskÒÍx. BÚõÀ, PoÛ²hß 

öuõk¨£uØPõÚ öuõÈÝm£® ©õÖ® A÷u 

÷ÁøÍ AÍÄ® ]ÔuõS®. C»UP•øÓU P©µõ, 

ö\À÷£], PoÛ ÂøÍ¯õmk BQ¯ÁØÔÀ 

£¯ß£kzu¨£kQßÓx.

Euõµn® & £õxPõ¨£õÚ C»UP•øÓ Amøh

                      (SD Card - Secure Digital Card)

E¸ 2.46  USB £Îa^mka ö\¾zv 

E¸ 2.47   {øÚÁP Amøh
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 2.4.5   PoÛ°ß xøÓPÒ (Ports)

 PoÛø¯²® Auß EÖ¨¦PøÍ²÷©õ AÀ»x ÷ÁÖ PoÛPøÍ÷¯õ 

öuõkUP¨ £¯ß£k® Cøh •P[PÒ xøÓPÒ GÚ¨£k®. J¸ PoÛ°À 

xøÓPÒ PoÛ°ß ¤Ø£UPzvÀ AÀ»x •Ø£UPzvÀ EÒÍÚ. xøÓPøÍ 

CÚ[Põs£uØSU SÔ±kPÒ uµ¨£mkÒÍÚ. GÀ»õz xøÓPÐ® 

uõ´¨£»øP²hß  (Motherboard) öuõkUP¨£mkÒÍÚ. 

1. PS/2 xøÓ 5. J¼a \õuÚz xøÓ

2. \©õ¢uµz xøÓ 6. USB xøÓ

3. HDMI xøÓ 7. Video xøÓ

4. RJ 45 xøÓ    8. öuõhº{ø»z xøÓ

E¸  2.49  xøÓPÒ uõ´¨£»øP²hß 

 öuõkUP¨£mi¸US® Âu®

 E¸ 2.48  -xøÓPÒ (Ports)

              

 E¸ 2.50 PS / 2  -xøÓ

1.  PS/2  xøÓ &   \õÂ¨£»øPø¯²®    _mi                           

 ø¯²® PoÛz xøÓ²hß öuõk¨£ 

uØS¨ £¯ß£kzu¨£kQßÓx. Fuõ {Ó 

•ÒÍ    xøÓ  \õÂ¨£»øPUS®    £aø\ 

  {Ó•ÒÍ  xøÓ _miUS® E›¯Ú. BÚõÀ

 uØ÷£õx  \õÂ¨£»øPø¯²® _miø¯²® 

 PoÛz    öuõSv²hß    öuõk¨£uØS® 

 ö£¸®£õ¾® USB xøÓ £¯ß£kzu¨ 

£kQßÓx.

            

E¸  2.51 \©õ¢uµz xøÓ 

2.  \©õ¢uµz xøÓ (Parallel Ports) & \©õ¢uµz 

xøÓ°ß ‰»® Aa_¨ö£õÔ PoÛz 

öuõSv²hß öuõkUP¨£kQßÓx. Cx 
25 xÁõµ[PøÍU öPõskÒÍx. uØ÷£õx 

Aa_¨ö£õÔø¯U PoÛz öuõSv²hß 

öuõk¨£uØS  USB xøÓ ö£¸®£õ¾® 

£¯ß£kzu¨£kQßÓx.
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E¸ 2.52 - HDMI xøÓ

3.  HDMI  xøÓ - --& Â÷\h©õP ©iU 

PoÛ°À Põn¨£k® HDMI xøÓ 

PoÛz vøµ (Monitor), £À¿hP GÔøÁ, 

C»UP•øÓz öuõø»UPõm], C»UP•øÓ 

J¼ö£¸UQ BQ¯ÁØøÓz öuõkUP¨ 

£¯ß£kzu¨£kQßÓx.

                  

E¸ 2.53 RJ 45 xøÓ

4.  RJ 45 xøÓ & CzxøÓ°ß ‰»® PoÛ 

Áø»¯ø©¨¤À EÒÍ PoÛPÒ, Áø» 

¯ø©¨¦ ÁÈ¨£kzv (Network Router) 
BQ¯Ú ÷©õöh•hß (Modem) AÀ»x 

Áø»¯ø©¨¦ BÎ²hß (Network Switch) 
öuõkUP¨£kQßÓÚ.

               

E¸ 2.54  J¼a \õuÚz xøÓ

5.  ö\Â¨¦»z xøÓ / •øÚ (Audio Port / Jack) 
CzxøÓ ~qUS¨£ßÛ, J¼¨ö£¸UQ, 

uø»¨£ßÛ  (Head  Phone) ÷£õßÓ   ö\Â¨                                                                                          

 ¦» FhP[PøÍU PoÛz öuõSv²hß 

öuõkUP¨ £¯ß£kzu¨£kQßÓx.  

 }» {Ó®  & J¼ EÒÏk (Line In)
 £aø\ {Ó® & J¼ö£¸UQ (Line Out)
 Fuõ  {Ó® & ~qUS¨£ßÛ (Micro Phone)

               

E¸ 2.55 -uµÄz öuõhº¨£õmøhz 

xøÓ

6.  AQ»z öuõhº¨£õmøhzxøÓ (USB - 
Universal Serial Bus Port) - uØ÷£õx £» 

EÒÏmka \õuÚ[PÐ® öÁÎ±mka                     

\õuÚ[PÐ® PoÛ²hß USB xøÓ°ß 

‰»® öuõkUP¨£kQßÓÚ.
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7.  JÎ²¸zxøÓ (Video Port) - ÁøµÂ¯À 

xøÓ GÚÄ® AøÇUP¨£k® JÎ²¸z 

xøÓ PoÛz vøµ, öuõø»UPõm] 

AÀ»x £À¿hP GÔøÁ BQ¯ÁØøÓU 

PoÛz öuõSv²hß öuõkUP¨ £¯ß 

£kzu¨£kQßÓx. Cx 15 xÁõµ[PøÍU 

öPõskÒÍx.

                       

E¸  2.57 öuõhº{ø»z xøÓ

8.  öuõhº{ø»zxøÓ  (Serial Port)  & 

PoÛø¯   Cøn¯zxhß   öuõkUP¨ 

£¯ß£kzu¨£k® ÷©õöhzøuU  (Modem)  
 PoÛ²hß öuõkUP¨ £¯ß£kzu¨£k 

 QßÓx. uØ÷£õx Cz xøÓUS¨ £v»õP 

USB xøÓ £¯ß£kzu¨£kQßÓx. 

2.5  uµÄz öuõhº£õhÀ (Data Communication)
 

 J¸ PoÛ°ÚõÀ u¯õºö\´¯¨£mh uµÄPøÍ²® uPÁÀPøÍ²® 

÷ÁöÓõ¸ PoÛz öuõSvUS FkPhzuÀ uµÄz öuõhº£õhÀ BS®.

 CzuµÄz öuõhº£õh¼ØPõPU PoÛPÎøh÷¯ J¸ öuõk¨ø£ 

HØ£kzu ÷Ásk®. Azöuõk¨¦ PoÛPøÍ Áø»¯ø©¨£õUP¾US 

AÁ]¯©õS®.

 2.5.1  uµÄz öuõhº£õh¾USz ÷uøÁ¯õÚ Ai¨£øh A®\[PÒ

E¸ 2.58

E¸ 2.56 - JÎ²¸z xøÓ
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(i) uµÄ ‰»® & uµÄPøÍ AÝ¨¦|º

     (öuõø»÷£] AøÇ¨ø£¨ HØ£kzx|º)

(ii) FkPhzuÀ FhP® & uµÄPøÍ FkPhzu¨ £¯ß£kzx® FhP®          

(öuõø»÷£] |õsPÒ, |õsPÎÀ»õux)

(iii) uµÄÁõ[Q & uµÄPøÍ¨ ö£Ö|º                                                                                    

(öuõø»÷£] AøÇ¨ø£¨ ö£Ö|º)

  2.5.2  uµÄ FkPhzu¨£k® •øÓPÒ (Data Transmission Modes)

J¸ öuõSv°¼¸¢x ÷ÁöÓõ¸ öuõSvUSz uµÄPÒ öÁÆ÷ÁÖ •øÓPÎÀ 

FkPhzu¨£kQßÓÚ. AøÁ¯õÁÚ :

1) JØøÓ •øÓ (Simplex Mode) 

JØøÓz uµÄ FkPhzu¼À uµÄPÒ uµÄ •u¼¼¸¢x uµÄ Áõ[QUS ©õzvµ®            

ö\ÀQßÓÚ. Aa_¨£iPøÍ¨ ö£ÖuÀ, öuõø»UPõm] {PÌa]PøÍ Cµ]zuÀ, 

ÁõöÚõ¼ø¯a ö\Â©kzuÀ BQ¯ÁØøÓ CuØS Euõµn[PÍõPU Põmh»õ®.

AÝ¨¦|º / ‰»® ö£Ö|º

E¸ 2.59  JØøÓ •øÓ öuõhº£õhÀ

ö\´©v FkPhzuÀ

ö\´©vz umk

öuõø»UPõm]

>
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2)  Aøµ C¸ÁÈ¨÷£õUS •øÓ   (Half duplex Mode)

Aøµ C¸ÁÈ¨÷£õUS •øÓ°À uµÄPÒ J¸ vø\°À ©õzvµ® FkPhzu¨ 

£kQßÓÚ. AuõÁx ‰»zv¼¸¢x Áõ[QUSz uµÄPøÍ FkPhzuÀ 

•iÁøh²®÷£õx ©õzvµ® Áõ[S|º ‰»zvØSz uµÄPøÍ FkPhzu»õ®. 

Cøn¯zvÞhõPz uPÁÀPøÍ Â\õ›zu¾® ö£Öu¾®, £õxPõ¨¦¨ ¤›ÂÚº 

£¯ß£kzx® ÷ÁõUQ ÷µõUQ¨ ö£õÔ BQ¯Ú C®•øÓUS Euõµn[PÍõPU 

Põmh¨£h»õ®.

 

E¸ 2.60  ÷ÁõUQ ÷µõUQ  (Walki talki) (Aøµ C¸ÁÈ¨÷£õUS öuõhº£õhÀ)

AÝ¨¦|º AÀ»x Áõ[Q

(Sender or Receiver)
Áõ[Q AÀ»x AÝ¨¦|º

(Receiver or Sender)

Medium

FhP®

3)  •Ê C¸ÁÈ¨÷£õUS •øÓ  (Full Duplex Mode)

 •Ê C¸ÁÈ¨÷£õUS (Full  Duplex) •øÓ°À J÷µ uhøÁ°À C¸ vø\

PÎ¾® uµÄPÒ FkPhzu¨£kQßÓÚ. öuõø»÷£] Eøµ¯õhÀ C®•øÓUS 

Euõµn©õS®.

AÝ¨¦|º AÀ»x Áõ[Q

(Sender or Receiver)
Áõ[Q AÀ»x AÝ¨¦|º

(Receiver or Sender)

Medium

FhP®

E¸ 2.61 öuõø»÷£]  (•Ê C¸ÁÈ¨÷£õUS öuõhº£õhÀ)

2.5.3  uµÄ FkPhzuÀ (Data Transmission Medium)

   öuõSvPÎøh÷¯ öuõhºø£ HØ£kzxÁuØS •UQ¯©õÚ Kº A®\® 

FkPhzu¾US¨ £¯ß£kzu¨£k® FhP©õS®. FkPhzuÀ FhP[PÒ C¸ 

ÁøP°Ú. AuõÁx, ÁÈ¨£kzu¨£mh FhP•® ÁÈ¨£kzu¨£hõu FhP•® 

BS®. ¤ßÁ¸® E¸ÂÀ CÆÁøPPÐUS›¯ Euõµn[PÒ uµ¨£mkÒÍÚ.
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(i) ÁÈ¨£kzv¯ FhP®  (Guided / Wired)

 uµÄPøÍ FkPhzu¨ £¯ß£kzu¨£k® FhP® J¸ ö£ÍvP FhP®                      

(Physical Medium) GÛß, AuøÚ ÁÈ¨£kzv¯ FhP©õPU Põmh»õ®.

               

E¸ 2.63 £›ø\°hõu 

•ÖUQ¯ P®¤a ÷\õi

  JßÓõP •ÖUQ¯ P®¤a ÷\õi (Twisted  pair) 
uµÄ FkPhzu¼ØS¨ £¯ß£kzu¨£kQßÓx. Cx 

C¸ÁøP¨£k®.

1. £›ø\°hõu •ÖUQ¯ ÷\õi (Unshielded 
Twisted Pair (UTP)) - öuõø»÷£]z  öuõhº¦ 

PÐUPõP¨ £¯ß£kzu¨£k® JßÓõP •ÖUQ¯ 

ö\¨¦U P®¤a ÷\õi £›ø\°h¨£hõu •ÖUQ¯ P®¤a ÷\õi¯õS®. CøÁ 

ªPÄ® ÁøÍ¯zuUPuõP C¸US® A÷u÷ÁøÍ C»õ£Pµ©õÚx. GÛÝ® 

ö|k¢ yµzvØSz uµÄPøÍ FkPhzuÀ uøh¨£k®. 100 «ØÓº GßÝ® 

E¯º¢u£m\z yµzvØSz uµÄPøÍ FkPhzxÁuØS EP¢ux. 

                  

E¸ 2.64 £›ø\°mh 

•ÖUQ¯ P®¤a ÷\õi

2.  £›ø\°mh •ÖUQ¯ P®¤a ÷\õi (Shielded 
Twisted Pair (STP)) - - {øÓ Ti¯ ö\»Ä ªUP 

BÚõÀ £›ø\°mh •ÖUQ¯ P®¤a ÷\õi uµÄ 

FkPhzuÀ {ø»ø©ø¯ Â¸zv¯õUQ²ÒÍx.

E¸  2.62 uµÄ FkPhzuÀ FhP®
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E¸ 2.65 Kµa_ Ámh®

 � Kµa_ Áh® (Coaxial Cable) - Phzx® Áha ÷\õi 

JßøÓU öPõsh Kµa_ Áhzvß ö\¨¦U P®¤ Áø» 

÷£õßÓ J¸ ¦Ó Áh® ø©¯ Áhzøua _ØÔ ªß 

Põ¢uÂ¯Àø£ EshõUSQßÓx. CÆÁha ÷\õi 

¤ÍõzvUS¨ £›ø\°ÚõÀ ÷ÁÖ£kzu¨£mkÒÍx. 

öuõø»UPõm] AßöµÚõ, CCTV Áh[PÒ BQ¯ 

ÁØÖUS¨ £¯ß£kzu¨£k® CÆÁh® Âø» Ti¯x.

                

E¸ 2.66 JÎ°¯À 

|õºPÒ

 � JÎ°¯À |õºPÒ (Fiber Optics) - CÆÁh•® 

Phzx® Áha ÷\õiø¯U öPõskÒÍx. APo 

(Core) PsnõiU ÷Põ»õS®. AuøÚa _ØÔ 

ö©À¼¯ Psnõi |õºPÐ® CÆÁha ÷\õiø¯ 

÷ÁÖ£kzxÁuØS¨ ¤ÍõzvUSU Pg_P•® EÒ 

ÍÚ. CÆÅhPzvÀ EÒÍ ]Ó¨¤¯À¦ uµÄPøÍ 

FkPhzx®÷£õx JÎ öuÔ¨£øh¢x FkPhzu¨ 

£kÁuõS®. Cx PvºPÎß •ÔÄ GÚ¨£k®. Cx |ÃÚ öuõø»÷£] 

Áø»¯ø©¨¦PÎÀ £¯ß£kzu¨£kQßÓx. Cx Âø» Ti¯x.

                  
(ii)  ÁÈ¨£kzu¨£hõu FhP[PÒ

 (Unguided / Wireless) 
            

E¸  2.68 - ~snø»PÒ

E¸  2.67 ÁõöÚõ¼ Aø»PÒ

  ö£ÍvP¨ ö£õ¸ÒPøÍ¨ £¯ß£kz 

uõ©À ø\øPPÍõPz uµÄPøÍ FkPhz 

uÀ, ÁÈ¨£kzu¨£hõu FhP® GÚ¨ 

£k®.
 

 � ÁõöÚõ¼ Aø»PÒ (Radio 
Wave) - uµÄPøÍ FkPhzxÁuØS 

ÁõöÚõ¼ Aø» FhP® £¯ß 

£kzu¨£kQßÓx. øÁ ø£ (Wi-Fi), 
¦Ñ¸z (Bluetooth) BQ¯Ú ÁõöÚõ¼ 

Aø»PÎß «uõÚ öuõÈØ£õk 

PÐUS  Euõµn[PÍõS®.

 � ~snø»PÒ (Microwaves) - 
-~snø» FkPhzu¼ß÷£õx 

uµÄPÒ J¸ ÷PõmiÀ ö\ÀQßÓÚ. 

BP÷Á FkPhzuÀ {ø»¯[PÒ JßøÓö¯õßÖ  ÷|õUQ°¸zuÀ ÷Ásk®. 
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E¸ 2.69
ö\´©v FkPhzuÀ

 {ø»¯[PÐUQøh÷¯ EÒÍ yµ® £ØÔz 

wº©õÛUS®÷£õx  ¤µ÷u\zvß  ¦Â°¯À A®

 \[PÒ  P¸zvØ  öPõÒÍ¨£k®. ö\´©v FkP

 hzuÀ (Satellite Communication) ö\´©vz öuõhº 

£õh¼À uµÄPÒ ö\¾zx® Ag\»P[PÒ (tran-
sponders) ÁiÁzvÀ FkPhzu¨£kQßÓÚ. 

36000   Q÷»õ «ØÓº E¯µzv÷»  ÁõÛÀ  C¸US®   

ö\´©v  {ø»¯[PÎÚõÀ ¦Â°À EÒÍ ÷Põ¦

 µ[PÎÞhõP FkPhzu¨£k® uµÄPøÍ¨ ö£Ø 

Öz ÷uøÁ¯õÚ ÷Põ¦µ[PÐUS FkPhzxQßÓÚ. ö\´©v FkPhzu¼ß 

‰»® G¢uz yµzvØS® uµÄPøÍ FkPhzu»õ®. CuøÚ Cøn¯z 

öuõhº£õh¼ØS¨ £¯ß£kzu»õ®.

             

E¸ 2.70  ö\[RÌU PvºPÒ

 � ö\[RÌU PvºPÒ (Infrared) 
- öuõø»UPõm]°ß ÷\´ø©U 

Pmk¨£kzvPÎØ ÷£õßÖ |õsPÒ 

CÀ»õu \õÂ¨£»øPPøÍ²® _mi 

PøÍ²® Pmk¨£kzxÁuØSa ö\[ 

RÌU Pvºz uµÄPøÍ FkPhzx® FhP[PÒ £¯ß£kzu¨£kQßÓÚ.

2.5.4  PoÛ Áø»¯ø©¨¦PøÍz öuõkUS® \õuÚ[PÒ

           (Computer network connecting devices)

E¸ 2.71
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PoÛ  Áø»¯ø©¨ø£  HØ£kzxÁuØS  Cµsk  AÀ»x  CµsiØS  ÷©Ø

£mh PoÛPÒ C¸UP ÷Ásk®. CUPoÛPøÍ Jß÷ÓõöhõßÖ öuõk¨ 

£uØPõPz öuõkUS® \õuÚ[PÒ £¯ß£kzu¨£kQßÓÚ.

(i) Áø»¯ø©¨¦ Cøh•P Amøh (Network interface Card)

Cx PoÛ°ß uõ´¨£»øP°À ö£õ¸zu¨£mkÒÍx. |õ® ÷©ØSÔzu 

J¸ \¢uº¨£zvÀ PØÓ uµÄ FkPhzuÀ ÁÈPõmi FhP® (Guided / Wired) 
Áø»¯ø©¨¦ Cøh•P Amøh°À (Network interface card) EÒÍ Áø»¯ø©¨¦z 

xøÓUS (Network  port) PoÛ öuõkUP¨£kQßÓx. CÆÅhP® RJ 45 (Socket)
öuõk¨¤°ß ‰»® xøÓ²hß öuõkUP¨£kQßÓx.

E¸  2.72 Áø»¯ø©¨¦ Cøh•P Amøh E¸ 2.73 öuõk¨¤

(ii)  BÎ AÀ»x SÂ¯® Switch / Hub
       

E¸ 2.74   BÎ AÀ»x SÂ¯®

    Cµsk AÀ»x CµsiØS ÷©Ø

£mh PoÛPÐUQøh÷¯ EÒÍ 

öuõhºø£ E¸ÁõUSÁuØS BÎ 

AÀ»x SÂ¯® Cøh±hõPz öuõÈ 

Ø£kQßÓx. Czöuõhº¦UPõP ÁÈ 

Põmi¯ (Guided / Wired) FhP® 

£¯ß£kzu¨£k® A÷u÷ÁøÍ Kº 

A¢u® PoÛ°À EÒÍ Áø»¯ 

ø©¨¦z xøÓ²hÝ® ©ØøÓ¯ 

A¢u® BÎ°À AÀ»x SÂ¯zvÀ EÒÍ xøÓ²hÝ® öuõkUP¨£kQßÓÚ.

BÎ°¾® SÂ¯zv¾® EÒÍ ]» ÷ÁÖ£õkPÒ

   ¤µuõÚ ÷ÁÖ£õk £›©õÖ® Pv¯õS®. PoÛ Áø»¯ø©¨¤À EÒÍ 

PoÛPÐUQøh÷¯ uPÁÀPøÍ¨ £›©õÖ® ÷£õx SÂ¯® £›©õÖ® uPÁÀPÒ 

GÀ»õ® PoÛUS ÁÈ¨£kzu¨£k® A÷u÷ÁøÍ BÎ E›¯ PoÛUS 

©õzvµ® uPÁÀPøÍ ÁÈ¨£kzxQßÓx. C[S SÂ¯zvß ‰»® ÷uøÁ¯ØÓ 

öuõ¢uµÄ HØ£kzu¨£kQßÓx.
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uPÁÀPøÍ¨ £›©õØÖ®÷£õx SÂ¯® Aøµ & C¸ÁÈ¨÷£õUS (Half Duplex) 
•øÓ°À öuõÈØ£k® A÷u÷ÁøÍ BÎ •Ê & C¸ÁÈ¨÷£õUS (Full Duplex) 
•øÓUS¨ £¯ß£kzu¨£kQßÓx.

(iii)  øÁ ø£ (Wireless Fidelity - (Wi-Fi))
             

E¸  2.75 øÁ ø£

 CßÖ Áøµ PoÛ Áø»¯ø©¨¤À ¤µ]zv 

ö£ØÓ FhP©õP øÁ ø£ (Wi-Fi) HØ¤  Aø©¢xÒÍx. 

ÁõöÚõ¼ Aø»PÎß ‰»® ªP ÂøµÁõÚ PoÛz 

öuõk¨ø£¨ ÷£õßÖ ö\À÷£]PÐUS® ©iU PoÛ

PÐUS® ÂøµÁõÚ Cøn¯z öuõk¨ø£ HØ£kz 

xÁuØS øÁ ø£ HØ¤ FhP©õP Aø©QßÓx.

                    

E¸  2.76   ÁÈ¨£kzv 

(iv)  ÁÈ¨£kzv ( Router)
 Cµsk AÀ»x £» PoÛ Áø»¯ 

ø©¨¦PÎøh÷¯ öuõk¨ø£ HØ£kzu¨ 

£¯ß£kzx® \õuÚ® ÁÈ¨£kzv (Router) 
BS®. Ax Áø»¯ø©¨¦ ~øÇÁõ°À 

GÚÄ® AøÇUP¨£k®. uPÁø» Fk 

PhzxÁuØS ªPÄ® EP¢u ÁÈ¯õÚx 

ÁÈ¨£kzv°ÚõÀ wº©õÛUP¨£kQßÓx.

                    

E¸ 2.77 AP {ø» 

÷©õöh®

E¸ 2.78 ¦Ó{ø» ÷©õöh®

E¸ 2.79 Áh® CÀ»õu 

÷©õöh®

(v)  ÷©õöh®  (Modem) 

 PoÛ Áø»¯ø©¨¤À  EÒÍ PoÛPÎÀ 

£¯ß£kzu¨£k® uÛ¯õÒ PoÛø¯ Cøn¯zxhß 

öuõkUP¨ £¯ß£kzu¨£k® \õuÚ® ÷©õöh® BS®. 

÷©õöh® uµÄ¨ ö£¯º¨£õÍµõPz öuõÈØ£kQßÓx. 

AuõÁx PoÛ°À EÒÍ C»UP•øÓz (Digital) 
uµÄPøÍ²® uPÁÀPøÍ²® Jzvø\a (Analog) ø\

øPPÍõP¨ ö£¯ºzxz öuõø»÷£] Áh[PÎß ‰»® 

FkPhzuø»a ö\´QßÓx. Cx  Modulation, DEModulation 
GÚ AøÇUP¨£k® A÷u÷ÁøÍ  MODEM GßÝ® £u® 

CÆÂ¸ ö\õØPÎ¼¸¢x® ö£Ó¨£mkÒÍx. ÷©õöh® 

]» ÁøP¨£k®. AuõÁx AP{ø» ÷©õöh® (Internal) 
¦Ó{ø» ÷©õöh® (External), P®¤°À»õ (Wireless) 
÷©õöh® BS®.  
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MOdulation - DEModulation

(v)  wa_Áº   (Firewall)
 wa_Áº   Gß£x  PoÛ  

Áø»¯ø©¨ø£¨  £õxPõUS® 

öuõSv¯õS®. Cøn¯zvØS® 

PoÛ Áø»¯ø©¨¤ØSªøh÷¯ 

uµÄ   uPÁÀ  FkPhzuø»U  Pm

k¨£kzuz ÷uøÁ¯õÚ HØ£õk 

PÒ CvÀ Ch®ö£Ö®. wa_Áº 

Cøn¯zvØS® PoÛ Áø» 

¯ø©¨¤ØS® Cøh÷¯ J¸ £õx                                                                                        

Põ¨¦z uk¨£õPz uõ¤UP¨£kQßÓx. 

 Cx ö©ßö£õ¸Ò ÷£õßÖ Áßö£õ¸ÍõPÄ® £¯ß£kzu¨£k®. Cuß 

‰»® PoÛ Áø»¯ø©¨¦PÐUQøh÷¯ EÒÍ uµÄPøÍ²®, uPÁÀPøÍ²® 

£›©õÖ®÷£õx EshõS® ö|›\ø»U Pmk¨£kzxQßÓx.

2.5.5  ÷\øÁ¨ £¯|º / ÷\øÁ¯P  Áø»¯ø©¨¦  

 (Client/ Server network)

E¸  2.81
÷\øÁ¨ £¯|º / ÷\øÁ¯P  Áø»¯ø©¨¦

 

E¸  2.80    wa_Áº



71

 PoÛ Áø»¯ø©¨ø£U Pmk¨£kzx® J¸ ¤µuõÚ PoÛz öuõSv 

EÒÍx. Cx ÷\øÁ¯PU (Server) PoÛ GÚÄ® AuÝhß öuõhº¦£mh HøÚ¯ 

PoÛPÒ ÷\øÁ¨ £¯|º (Client) PoÛ GÚÄ® AøÇUP¨£k®. Áø»¯ø©¨¦¨ 

£oö\´ öuõSv (Network Operating System)  BÚx ÷\øÁ¯PU PoÛ°À 

{ÖÁ¨£k®. Cøn¯zv¼¸¢x AÀ»x ¤µ÷u\ Áø»¯ø©¨¤¼¸¢x uµÄPøÍ 

AÀ»x uPÁÀPøÍU ÷Põ¸£Áº ÷\øÁ¨ £¯|º (Client) GÚÄ® uµÄPøÍ²® 

uPÁÀPøÍ²® ÁÇ[S|º ÷\øÁ¯P® (Server) GÚÄ® AøÇUP¨£k®. 

2.5.6  PoÛ Áø»¯ø©¨¦ ÁøPPÒ  

 � PoÛ Áø»¯ø©¨¦ (Computer Network)
PoÛ Áø»¯ø©¨£õÚx AuÝhß CønUP¨£mh PoÛPÒ 

GÆÁõÖ ¦Â°¯À  \õº¢x ÂµÁÀ£kzu¨£mkÒÍx Gß£øu ö£õÖzx 

ÁøP¨£kzu¨£k®.

 

E¸  2.82 
PoÛ Áø»¯ø©¨¦ 

                   

E¸  2.83 

Chzx›¨ £µ¨¦ Áø»¯ø©¨¦

(i) Chzx›¨ £µ¨¦ Áø»¯ø©¨¦   Local 
Area Network (LAN)

 J¸ Pmhhzvß Kº AøÓ°À  AÀ»x 

]» AøÓPøÍ Cønzx {ÖÁ¨£k® 

PoÛ Áø»¯ø©¨¦ Chzx›¨ £µ¨¦ 

Áø»¯ø©¨¦ (LAN) GÚ¨£k®. J¸    £õh\õ 

ø»°À     AÀ»x   £ÀPø»UPÇzvÀ AÀ»x 

]Ô¯ AÍÄ Â¯õ£õµzvÀ AÀ»x A¾Á»PzvÀ 

÷©ØöPõÒÍ¨£k® Áø»¯ø©¨ø£ CuØS 

Euõµn©õPU  Põmh»õ®.
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E¸  2.85 
ö£¸® £µ¨¦ Áø» 

¯ø©¨¦

(ii)  ö£¸|Pº¨ £µ¨¦  Áø» 

¯ø©¨¦   (Metropolitan 
Area Network - MAN)

 16  ø©À AÀ»x Av¾® 

SøÓ¢u ¤µ÷u\zøu EÒÍhUS 

©õÖ Aø©¢u Chzx›¨ £µ¨¦ 

Áø»¯ø©¨¦PÒ ]»ÁØøÓU 

öPõsh ÷\º©õÚ® ö£¸|Pº¨ 

£µ¨¦ Áø»¯ø©¨¦ GÚ¨£k®. 

Á[Q Áø»¯ø©¨¦PÒ, QøÍ 

PÒ EÒÍ {ÖÁP Áø»¯ø©¨ 

¦PÒ, QøÍPÒ EÒÍ £ÀPø»U 

PÇP Aø©¨¦PÒ BQ¯ÁØøÓ 

CÁØÖUS Euõµn©õPU Põm 

h»õ®.

                    
(iii)  ö£¸® £µ¨¦ Áø»¯ø©¨¦PÒ  (Wide 

Area Network - WAN)
  ªPÄ® APßÓ J¸ ¤µ÷u\zøu EÒÍhU 

S©õÖ Aø©UP¨£k® Áø»¯ø©¨¦ (WAN) ö£¸®

£µ¨¦ Áø»¯ø©¨¦  GÚ¨£k®. J¸ |õmiß 

EÒ÷Í÷¯õ AÀ»x |õmiØS öÁÎ÷¯²ÒÍ 

£SvPøÍ÷¯õ EÒÍhUQ HØ£kzu¨£k® Áø» 

¯ø©¨¦z öuõk¨¦, ö£¸® £µ¨¦ Áø»¯ø©¨¦ 

GÚ¨ £k®. CuØSa ]Ó¢u Euõµn® Cøn¯® BS®.

2.5.7  Áø»¯ø©¨¦ ChÂ¯À  (Network Topology)

 J¸ Áø»¯ø©¨¤À PoÛz öuõk¨ø£z vmhªh¾® 

Áø»¯ø©¨£õUP•® Áø»¯ø©¨£õUP ChÂ¯À  GÚ¨£k®. £À÷ÁÖ 

Áø»¯ø©¨¦ ChÂ¯ÀPÒ EÒÍÚ. AøÁ¯õÁÚ : 

           

E¸  2.84 

ö£¸|Pº £µ¨¦  Áø»¯ø©¨¦ 

A¾Á»P® PÍg]¯®

¤µ÷u\U QøÍ 

A¾Á»P®

öuõÈØ\õø»
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i)  Ek ÁiÁzvØS Áø»¯ø©¨ 

£õUPÀ (Star Topology) 

ö£õxÁõPU PõnzuUP  ÁiÁø©¨£õQ¯ 

CvÀ SÂ¯zøu AÀ»x BÎø¯ ø©¯ 

©õPU öPõsk AuÝhß PnÛPÒ 

öuõkUP¨£kQßÓÚ.

ii)  £õmøh ÁiÁzvØS Áø»¯ø©¨ 

£õUPÀ

  (Bus Topology)
 ¤µuõÚ ÁhzvÞhõP GÀ»õz 

öuõk¨¦ PøÍ²® HØ£kzv Áø»¯ø©¨ 

£õUPø» CÆÁõÖ Põmh»õ®. CÆÁ 

hzvÀ HØ£k® JÊ[Qßø© GxÄ® 

Áø»¯ø©¨¤À EÒÍ GÀ»õU PnÛ 

PøÍ²® £õvUP»õ® BøP¯õÀ Áh® 

•xöP¾®¦  (Backbone) GÚ¨£k®. •x 

öP¾®¤ß C¸ A¢u[PÎ¾® •i¨ 

£õßPÒ  (Terminator)   Põn¨£k®.   Ax

÷£õßÖ CÆÁiÁø©¨¦  ªP GÎuõøP

¯õÀ     C[S SøÓ¢u   AÍÄ  Áh[PÒ 

÷uøÁ¨£kQßÓÚ.  C[S   Áøµ¯Özu 

GsoUøP°»õÚ PoÛPøÍ ©õzvµ®

öuõkUP»õ®.

iii)  ÁøÍ¯ ÁiÁzvØS Áø»¯ø©¨ 

£õUPÀ  (Ring Topology)
         PoÛPÒ J¸ ÁøÍ¯©õPz uõÚ¨£kzu¨ 

£mk  ÁhzvÚõÀ  Jß÷ÓõöhõßÖ  öuõkU

P¨£k®   CÆÁø»¯ø©¨¤À    G¢uöÁõ¸

uµÄ®  uPÁ¾®  ÁmhÁiÁzvÀ  ö\À¾®                                               

J¸ PoÛ°À AÀ»x ÁhzvÀ EÒÍ 

JÊ[Qßø© •Ê Áø»¯ø©¨¦® uPºÄÓU 

Põµn©õP C¸UP»õ®.

E¸ 2.86 
Ek ÁiÁzvØS Áø»¯ø©¨£õUPÀ

E¸  2.87 
£õmøhÁiÁzvØS Áø»¯ø©¨£õUPÀ

E¸  2.88 - ÁøÍ¯ ÁiÁzvØS 

Áø»¯ø©¨£õUPÀ
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iv)  ©µ ÁiÁzvØS ÁiÁø©¨£õUPÀ

 (Tree Topology)
     Ek ÁiÁzv»õÚ (Star Topology) ]» 

Áø»¯ø©¨¦PøÍ¨ £õmøh ÁiÁzvÀ 

Áø»¯ø©¨£õUPÀ ©µ ChÂ¯À GÚ¨£k®. 

C[S JÆöÁõ¸ Áø»¯ø©¨ø£²® ÷ÁÖ 

÷ÁÓõPU Pmk¨£kzuzuUPuõP C¸zuÀ Kº 

AÝT»©õS®. 

v)  Pso  ÁiÁzvØS Áø»¯ø©¨£õUPÀ (Mesh Topology)
 C[S Áø»¯ø©¨¤À EÒÍ GÀ»õU 

E¸  2.90 Pso ÁiÁzvØS 

Áø»¯ø©¨£õUPÀ

PoÛPÐ® Jß÷ÓõöhõßÖ öuõkUP¨£k®.             

]UP»õÚ öuõk¨¦ BøP¯õÀ Pmk¨£õk  Pi

Ú©õÚxhß  ö\»Ä®   Ti¯x.  GÛÝ® J¸

PoÛø¯ ÷ÁöÓ¢u PnÛ²hÝ® öuõkU 

P»õ®. Cøn¯zvÀ £À÷ÁÖ ÁøP Áø» 

¯ø©¨¦PÒ  C¸¨£øuU  Põn»õ®.  Cx J¸

]UP»õÚ  Áø»¯ø©¨£õP  C¸UQßÓ ÷£õv

¾® ö£¸®£õ¾® Áø» ÁiÁzvØS Áø»¯ 

ø©¨¦a ö\´¯¨£mi¸¨£øuU Põn»õ®.

2.5.8  Áø»¯ø©¨£õUPzvß AÝT»[PÒ

uµÄPøÍ²® uPÁÀPøÍ²® 

PoÛPÐUQøh÷¯ £›©õÓz 

uUPuõP C¸zuÀ                                         

 

uµÄPøÍ²® uPÁÀPøÍ²® PoÛ 

PÐUQøh÷¯ £›©õÓzuUPuõP C¸zuÀ 

Áø»¯ø©¨£õUPzvß J¸ •UQ¯ 

AÝT»©õS®. AÆÁõ÷Ó AzuµÄPøÍ 

AÀ»x uPÁÀPøÍa ÷\øÁ¯Pzvß 

(Server) PoÛ°À ÷uUQøÁ¨£uß FhõP 

AÆÁø»¯ø©¨¦hß CønUP¨£mkÒÍ 

÷\øÁ¨ £¯|ºPÒ  (Client) J÷µ ÷|µzvÀ 

uPÁÀPøÍ¨ ö£ÓzuUPuõP C¸US®. 

E¸  2.89
©µ ÁiÁzvØS ÁiÁø©¨£õUPÀ
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uµÄPøÍz SøÓ¢u ChzvÀ
÷uUQ øÁzuÀ

÷uøÁ¯ØÓ ÂuzvÀ J÷µ uµøÁ¨ £» 

PoÛPÒ ÷uUQ øÁUPõø©¯õÀ ÷uUQ 

øÁ¨£uØPõÚ Ch AÍÄ® Gg]°¸US®.

ÁÍzøu¨ ö£õxÁõP¨ £¯ß 

£kzuÀ

Aa_¨ö£õÔ, Á¸i (Scanner), ÷©õöh® 

(Modem) GßÝ® \õuÚ[PøÍU PoÛ 

Áø»¯ø©¨¦hß Cøn¨£uß ‰»® AÆ

Áø»¯ø©¨¦hß  Cøn¢xÒÍ  ÷\øÁ¨ 

£¯|ºPÒ (Client) u[PÒ PoÛø¯²® AÆ 

Áßö£õ¸ÒPøÍ²® CønzuÀ GÎuõS®.

J¸ •P¨£kzv¯ ö©ß 

ö£õ¸ÒPøÍU  Pmk¨£kzuÀ.

    ö£õxÁõP¨ £¯ß£kzuzuUP ö©ß 

ö£õ¸ÒPÒ    JÆöÁõßøÓ²®    PoÛUS 

÷ÁÖ÷ÁÓõP {ÖÄ®÷£õx ÷uøÁ¯ØÓ ÷|µ 

•® £n•® ö\»Âh¨£kQßÓÚ. A®ö©ß 

ö£õ¸ÒPøÍa  ÷\øÁ¯PU  (Server) PoÛ°À 

÷uUQ øÁ¨£uß ‰»® Áø»¯ø©¨¦hß 

Cøn¢xÒÍ ÷\øÁ¨ £¯|º (Client) A® 

ö©ßö£õ¸ÒPøÍ¨ £¯ß£kzu»õ®.

¯õuõ°Ý® Kº ChzvÀ G¢ 

÷|µzv¾® Cøn¨£uØPõÚ  

BØÓÀ. 

Cøn¯zxhß  CønÁuß  ‰»®  £¯|º

G¢u Kº Chzv¾® G¢÷|µzv¾® uÚx BÁ

n[PÐhÝ® uµÄPÐhÝ® Cøn¯»õ®.

£õxPõ¨¦ AÝ©vö£ØÓ ÷\øÁ¨ £¯|ºPÒ ©õzvµ® 

÷\øÁ¯Pzxhß Cøn¯»õ®. BøP¯õÀ 

AvÀ uµÄPøÍ²® uPÁÀPøÍ²® ÷uUQ 

øÁzuÀ ªPÄ® £õxPõ¨£õÚuõS®.

ªßÚg\À PoÛPÐUQøh÷¯ ªPÄ® GÎ¯ uPÁÀ 

£›©õØÓ •øÓ¯õP ªßÚg\À •øÓø¯¨ 

£¯ß£kzu»õ®.
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2.5.9  Áø»¯ø©¨£õUPzvß ¤µvT»[PÒ

uµÄPÐUSU SøÓ¢u £õxPõ¨¦ 

            

Áø»¯ø©¨£õUPzvß J¸ ¤µuõÚ ¤µv 

T»® uµÄPøÍ¨ £õxPõ¨£uØS •i¯õ 

ø©¯õS®. Áø»¯ø©¨¤À EÒÍ G¢uU 

PoÛ ‰»•® ÷\øÁ¯Pzxhß öuõhº¦ 

öPõsk, SÖ®£ºPÒ ÷\øÁ¯PzvÀ EÒÍ 

uPÁÀPøÍ ö£ÓU Ti¯uõP C¸US®. 

GÚ÷Á SÖ®£ºPÎh® C¸¢x uPÁÀPøÍ  

£õxPõ¨£x PiÚ©õS®.

Áø»¯ø©¨¦ uPºÄÖuÀ

                      

]»  Áø»¯ø©¨¦  ÁiÁø©¨¦PÎÀ  J¸

PoÛ AÀ»x Áh® uPºÄÖuÀ Áø»¯ 

ø©¨¤À EÒÍ HøÚ¯ PoÛPÎß öuõÈØ 

£õmøh¨ £õvUS®.

|a_{µÀ

                       

PoÛ Áø»¯ø©¨¤À  EÒÍ  J¸ PoÛ 

°À AÀ»x PoÛPÎÀ |a_{µÀ ¦S® 

÷£õx ©ØøÓ¯ PoÛPÐUS® Ax £µÁ 

»õ®.

PoÛz uÁÖPÒ

                     

¤µuõÚ PoÛ°À ÁÊUPÒ AÀ»x 

uPºÄÖuÀ HØ£kÁuõÀ ©ØøÓ¯ PoÛ 

PÐ® öuõÈØ£hõ©À C¸UP»õ®.

£°Ø]z ÷uøÁPÒ

                          

Áø»¯ø©¨¦ {ºÁõPzvh® ÷uºa] ö£ØÓ 

J¸Á›ß ÷uøÁ EÒÍx.
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♦ PoÛ Gß£x £¯|º  EÒÎk® AÀ»x öuõSv ÷\ºUS® uµÄ 

PøÍ¨ ö£ØÖU öPõsk AzuµÄPøÍ¨ £¯|º uµ¨£mkÒÍ AÔÄ 

ÖzuÀPÐU÷PØ£z u¯õºö\´x AÁ¸USz ÷uøÁ¯õÚÁõÖ uPÁÀPøÍ 

öÁÎ°k® ªßÛÚõÀ C¯UP¨£k® E£Pµnö©Ú AøÇUP»õ®.

♦  PoÛ°ß   ]Ó¨¤¯À¦PÒ  u¯õºö\´²®  Pv,  ö\®ø©/ |®£PzuPÄ,  

•¯Ø], £À£o°¯À¦, ÷uUQøÁUS® «sk® ö£Ö® BØÓÀ Gß£ 

ÚÁõS®. 

♦  PoÛ¨ £õS£õk

 � AÍÂØ÷PØ£¨ £õS£kzuÀ : «UPoÛ, uø»ø©U PoÛ, 

|kzuµU PoÛ, uÛ¯õÒ PoÛ, ~s PoÛ

 � öuõÈÝm£zxU÷PØ£ ÁøP¨£kzuÀ : Jzvø\U PoÛ, 

C»UP•øÓU PoÛ, P»¨¦U PoÛ

♦ PoÛz öuõSv°ß \õuÚ[PÒ

 � EÒÏmka \õuÚ[PÒ

 � öÁÎ±mka \õuÚ[PÒ 

 � ø©¯ •øÓÁÈ A»S: GsPou A»S, uºUP A»S, 

Pmk¨£õmk A»S, {øÚÁP¨ £vÁP®

 � •uÀ {øÚÁP® / •ußø© {øÚÁP®

 �  xøn {øÚÁP®

PoÛ°ß ¤µuõÚ ö£ÍvPU TÖPÒ  (Physical Components of a Computer)

 � öuõSv A»S  -& (System Unit), \õÂ¨ £»øP & -(Keyboard), 

       _mi - -& (Mouse),   PoÛz vøµ & (Monitor / VDU)

♦  ¦Óa \õuÚ[PÒ xøÓ°ß ‰»® PoÛ²hß CønUP¨£kQßÓÚ.

♦ uµÄPøÍz öuõhº¦£kzxÁuØSz ÷uøÁ¯õÚ Ai¨£øh A®\[PÒ 

uµÄ‰»®, FkPhzuÀ, FhPz uµÄ, Áõ[Q BQ¯ÁÚÁõS®.

♦  uµÄ FkPhzuÀ •øÓPÒ (Modes)

 �  JØøÓ •øÓ   (Simplex - Mode)

 �  Aøµ C¸ÁÈ¨÷£õUS •øÓ  (Half - Duplex Mode)

 �  •Ê C¸ÁÈ¨÷£õUS •øÓ  (Full Duplex Mode)

ö£õÈ¨¦
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♦ uµÄ FkPhzuÀ FhP® (Data Transmission Medium)

 � ÁÈ¨£kzv¯ FhP®  (Guided) ÁÈ¨£kzuõu FhP® (Un-
guided / Wireless) GÚ C¸ £SvPøÍU öPõskÒÍx.

♦  J¸ PoÛø¯ ÷ÁöÓõ¸ PoÛ²hß Cøn¨£uØPõÚ \õuÚ[PÒ  

EÒÍÚ.

♦  PoÛ Áø»¯ø©¨¦ ÁøPPÒ  LAN, MAN,  WAN BS®. 

♦  PoÛPøÍz öuõk¨£uØPõÚ ÁiÁø©¨¦ Áø»¯ø©¨¦ ChÂ¯À 

GÚ¨£k®.

Network Topology :   Star Topology , Bus Topology, Ring Topology, Tree 
Topology,  Mesh Topology 

♦  Áø»¯ø©¨£õUPzvÀ AÝT»[PÒ ÷£õÀ ¤µvT»[PÐ® Esk.
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 3.1 PoÛ°À uµÄPøÍ GkzxUPõmhÀ

A©»ß  µõáõ,  GÚUS  PoÛ  ‰»©õP  C¢u  Âsn¨£¨   £iÁzøuz   

      u¯õ›zxz    uµ•i²©õ? 

µõáõ B® u¯õ›zxz u¸Q÷Óß' A©»ß, CuøÚ¨ £õºzx Áõ]²[PÒ                

umha_ ö\´÷Áõ®.   “Application   …..”           
A©»ß      µõáõ,  PoÛ  \õÂ¨£»øP°À  “A”  GÝ®  GÊzøu AÊzx®  

÷£õx AuøÚU PoÛ GÆÁõÖ CÚ[PõsQÓx? 

µ÷©ì |õ® Cx £ØÔ G[PÒ B]›ø¯°h® ÷Pm÷£õ®. Ÿa\º, PoÛ°À 

“A” GÝ® GÊzx GÆÁõÖ GkzxUPõmh¨£kQÓx? 

B]›ø¯ ¤ÒøÍP÷Í, C¢u Á›¨£hzøu¨ £õ¸[PÒ.  

(E¸ 3.1 CøÚ AÁuõÛUP)

:

:

:

:

:

3
PoÛ°À uµÄPÒ 

GkzxUPõmh¨£k® •øÓPÒ
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E¸  3.1 - PoÛ°À “A” GÝ® GÊzx¸ GkzxUPõmh¨£k® £i•øÓPÒ

B]›ø¯ : E¸ 3.1 CÀ Põmh¨£mhÁõÖ \õÂ¨£»øP°À “A” GÝ® GÊzøu                                                                                                                                            

AÊzv¯x®  C¢ua  \ªUøb,  •øÓÁÈ¯õUPÀ A»SUS AÝ¨£¨                                                                                                       

£k®. C[S “A” GÝ® GÊzx C»zvµÛ¯À   \ªUøb¯õP ©õØÓ¨                                                                                                                 

£mk  C¢uU  ÷Põ»zøu  •øÓÁÈ¯õUSÁuØöPÚ {øÚÁzvÀ 

÷\ªUP¨£k®. “A” GÊzxUS›¯ ÷Põ»® Aø©UP¨£mh ¤ß “A” 
GÊzx PoÛzvøµ°À ÷uõßÖ®.

£i•øÓ 1

£i•øÓ 2

£i•øÓ 3

£i•øÓ 4
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 PoÛ°À  |õ®  GÊzöuõßøÓ  AÀ»x   ö\õÀö»õßøÓ     umha_a                                                                                                                                          

ö\´²®÷£õx A¢u GÊzøu AÀ»x ö\õÀø» PoÛ ußÚõÀ ÂÍ[QU 

öPõÒÍUTi¯ GsPÍõP ©õØÕk ö\´²® CÆÁõÖ PoÛ¯õÀ ÂÍ[ 

QUöPõÒÍUTi¯ C»UP[PÎß ÷\ºUøP "Gs•øÓø©' GÚ¨£k®. C¢u 

Gs•øÓø© 'digits' GÚ AøÇUP¨£kQßÓx. SÔ¨¤mh C»UP[PøÍ 

©mk® öPõsi¸US®. C¢u C»UP[PÎß Aø©ÂhzxUPø©¯ AÁØÔß  

C»UP[PÎß ö£Ö©v²® ÷ÁÖ£k®.

 E»Qß •uÀ PozuØö£õÔö¯ÚU P¸u¨£k® Gs\mhzvß (Aba-
cus) Gs•øÓø© GsnUP¸ £¯ß£kzu¨£kQÓx. Cx÷Á, PoÛ Áøµ 

Â¸zv¯øh¢xÒÍx. PoÛ°À uµÄPøÍ GkzxøµUP¨ £¯ß£kzu¨£k® 

Gs•øÓø©PÒ Á¸©õÖ : 
AmhÁøn 3.1 Gs•øÓø©PÎÀ £¯ß£kzu¨£k® C»UP[PÐ® A›a_ 

Ái GÊzxUPÐ® 

  Gs•øÓø© 
  (Number System)

Ai¨ö£Ö©õÚ®     

(Basic Value)
C»UP•®  A›a_Ái GÊzxU 

PÐ®   (Numbers  and   Alphabetic  
character used)

1.C¸©  (Binary ) 2       0,1

2. Gs© (Octal) 8       0,1,2,3,4,5,6,7

3. £vß©  (Decimal) 10
      0,1,2,3,4,5,6,7,8,9

4.£vÚÖ© (Hexa-decimal) 16       0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F

3.1.2 PoÛ°À uµÄPøÍ GkzxøµUP C¸© GsPÎß £¯ß£õk

         

E¸  3'2 - ªß_ØÔ¾ÒÍ 

BÎ

 

 PoÛ°À uµÄPøÍ GkzxøµUP Cµsk                           

\ªUøba  \¢uº¨£[PÒ  £¯ß£kzu¨£k®.  C¢u                                                                                                                                

Cµsk \ªUøba \¢uº¨£[PÐ® Cµsk ÷ÁõØ 

ÓÍÄ ©mhzøuU öPõshÚÁõS®. CÁØÖÒ 

JßÖ AvP ÷ÁõØÓÍÄ ©mh® öPõsh "1"  GÝ® 

{ø»¯õS®. ©ØøÓ¯x SøÓÁõÚ ÷ÁõØÓÍÄ 

öPõsh "0" GÝ® {ø»¯õS®. C¢u 1, 0 C»zvµÛ¯À _ØöÓõßÔß "ON", 
"OFF" BQ¯ {ø»PÐUS \©ÚõS®. "1", "0" C¢u C¸ C»UP[PÒ   ‰»®  

CÆÄ»QÀ Põn¨£k® G¢uz uµøÁ²® PoÛ°À GkzxøµUP •i²®.

3.1.1 Gs •øÓø©
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E¸ 3.3 CÀ Põmh¨£mhÁõÖ xøn{ø» {øÚÁPzv¾ÒÍ uµÄPÒ ¤µuõÚ 

{øÚÁPzvÞhõPa ö\À¾®÷£õx® Av¼¸¢x  •øÓÁÈ¯»QØS¨ £¯ 

oUS®÷£õx® C¸©U SÔ•øÓUS ©õØÕk ö\´¯¨£k®.

   
xøn{ø»  {øÚÁPz-

v¼¸¢x ¤µuõÚ {øÚ 

ÁPzxUSz uµÄ ¤µv 

ö\´¯¨£hÀ

¤µuõÚ {øÚÁP®            

(uØ÷£õUS ö£ÖÁÈ 

{øÚÁP®)

¤µuõÚ {øÚÁPz-

v¼¸¢x ©zv¯ 

•øÓÁÈ A»QØS 

uµÄPÒ AÝ¨£¨£hÀ

•øÓÁÈ¯»SÁmkaö\¾zv

          E¸ 3.3 xøn{ø» {øÚÁPzv¼¸¢x ©zv¯ •øÓÁÈ A»QØS uµÄPÒ     

  £¯oUS® Âu®

PoÛ°À Áºn¨ £¯ß£õmiÀ C¸© GsPÒ £¯ß£kzu¨£k® 

\¢uº¨£ö©õßøÓ ÷|õUS 

÷Áõ®. ]Á¨¦, £aø\,                                               

}»® BQ¯ ‰»{Ó[PøÍ 

÷ÁÖ£mh AÍÄPÎÀ  

P»¢x £À÷ÁÖ {Óa÷\º 

©õÚ[PøÍ ö£Ó»õ®.

CÆÁõÓõÚ ‰»{Ó[PøÍ 

Red, Green, Blue (RGB), 
©ØÖ® 0- 255 Áøµ¯õÚ   

G¢uöÁõ¸ ö£Ö©õÚ 

Ãa]¾® ÁøPSÔzxU 

Põmh»õ®.

Euõµn©õP PoÛ°À u¯õ›UP¨£mh BÁnö©õßÖUS ¤ßÚo¯õP 

P¸®Fuõ  (Dark purple)  {Ózøu  Ch÷Áskö©Ûß  |õ®  PoÛ°À    RGB                                                                                                                               
ö£Ö©õÚ[PÒ  •øÓ÷¯  "135, 31, 120"   GÚ  Colour picker  \õÍµzvÀ   (E¸ 3.4)                                                                  
EÒÎh ÷Ásk®. CÆÁõÖ EÒÎk®  "135, 31, 120" BQ¯ £vß© GsPÐUPõÚ 

C¸© GsPÒ •øÓ÷¯ 100001112 ,  111112 ,  11110002   BS®.

E¸ - 3.4 - PoÛ°À {µÀPÒ GkzxUPõmh¨£hÀ
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3.2 £vß©, C¸©, Gs©, £vÚÖ© Gs •øÓø©PÒ 

3.2.1 £vß© Gs •øÓø©

G¢uöÁõ¸ Gs•øÓø©²® A»S, C»UP®, Ai Gß£ÁØÔÚõ÷»÷¯ 

E¸ÁõUP¨£k®.

A»S (Unit)
 uÛ¯õÚ ö£õ¸öÍõß÷Ó A»S GÚ¨£k®. Euõµn©õP ©õ®£Ç®, J¸ 

¹£õ |õn¯USØÔ  J¸ |õÒ BQ¯Ú A»S GÚ¨£k®.

C»UP® (Number)
 Cx A»QøÚ AÀ»x AÍøÁ (Quantity) ÁøPSÔUS® SÔ±hõS®.

Ai (Basic/ Radix)
 Gs •øÓø©°À £¯ß£kzu¨£k® SÔ±kPÎß GsoUøP A¢u 

Gs •øÓø©°ß Ai GÚ¨£k®. G¢uöÁõ¸ Gs•øÓø©°Úx® Ai 

£vß© GsPÎÚõÀ Põmh¨£k®.

 
0 - 9 Áøµ¯õÚ C»UP[PøÍU öPõsh £vß© Gs •øÓø©ø¯¨ 

(Decimal numbers) £¯ß£kzv ÷©ØöPõÒÐ® Pouaö\´øPPøÍ |õ® ]Ö 

£µõ¯zv¼¸¢x PØÖÒ÷Íõ®. Euõµn©õP ªß, }º, öuõø»÷£]U Pmhn[PÒ, 

AßÓõhU öPõkUPÀ Áõ[PÀ BQ¯ÁØÔß÷£õx £vß© GsPøÍ÷¯ |õ® 

£¯ß£kzxQ÷Óõ®.  ö£õxÁõP £vß© Gs •øÓø©°À Ai¨ ö£Ö©õÚ® 

SÔzxPõmh¨£kÁvÀø». £vß©Gs    •øÓø©US›¯    C»UP[PÒ    ¤ß 

Á¸® AmhÁøn 3.2 CÀ Põmh¨£mkÒÍÚ.                

Gs•øÓø© £vß© /£zvøÚ Ai¯õPU öPõsh 

Gs•øÓø©

 Ai 10

£¯ß£kzu¨£k® C»U 

P[PÒ
0" 1" 2" 3" 4" 5" 6" 7" 8" 9

                        AmhÁøn 3.2 £vß© Gs •øÓø©US›¯ C»UP[PÒ

£vß© Gs •øÓø©°À Ah[Q²ÒÍ GsönõßÖ BUP¨£mkÒÍ Âuzøu 

AÔ¢xöPõÒ÷Áõ®.

Euõµn®

25 GÝ® Gs E¸ÁõQ²ÒÍ Âuzøu £õº¨÷£õ®

25 GÝ® Gs 20,5 BQ¯ GsPÒ Cøn¢x E¸ÁõQ²ÒÍx.

 25 =  20 +  5

  =  ^2 « 10&  ¬  ^5 « 1& 
   =  ^2 « 101& ¬ ^5 « 100&
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CÆÁõÓõÚ 100 , 101, 102, ....... BQ¯ Ch¨ö£Ö©õÚ[PÒ £vß©Gs 

•øÓø©°ß ©v¨÷£ØÖ® PõµoPÒ (Weighting factors) GÚ¨£k®. C¢u 

Gsøn Gs\mhzvÀ (E¸ 3.5) GkzxUPõmh •i²®. 

   

B°µ[PÒ            

1000
       103

¡ÖPÒ

100
102

JßÖPÒ

1
100

£zuõ°µ[PÒ               

10000
104 

£zxPÒ

10
101

E¸ 3.5    25 GßÓ £vß© Gsøn ÁøPSÔzuÀ

  CuøÚ¨ ¤ßÁ¸©õÖ® Põmh»õ®.

 

2  5
  

5 «100  =   5
2 «101  = 20
  25

Akzx, £vß© GsönõßÖ GÆÁõÖ E¸ÁõUP¨£kQßÓöuß£øu P¸x÷Áõ®.

Euõµn® 

102 101 100 10-1 10-2 - ©v¨÷£ØÖ® Põµo

  = 300 + 0 + 2 + 0.7 + 0.05
  = 302.75

10
5

100

= (3«102) ¬ (0«101) ¬ (2«100) ¬(7«10-1) ¬ (5« 10-2 )
= 300 + 0 + 2 + 7 + 

3 0 2 · 7 5

        

     

302.75

5 «10-2 = 0.05
7 «10-1 =   0.7
2 «100  = 2
0 « 101 =  0
3 « 102 =   300

302 .75

-- - £vß© Gs



85

3.2.1 C¸© Gs •øÓø©  (Binary Number System)
 

 PoÛUS uµÄ ©ØÖ® AÔÄÖzuÀPøÍ £vß© GsPÍõP EÒÏk 

ö\´uõ¾® PoÛ AzuµÄPøÍ 0,1 Gß÷Ó ¤µv{vzxÁ¨£kzx®. C¢u 0,1 
BQ¯ GsPøÍU öPõsh Gs •øÓø© C¸© Gs•øÓø© GÚ¨£k®.  

               E¸ 3.6 ªß _ØÖ

C¸© Gs•øÓø©°À EÒÍ C»UP[PÒ ¤ßÁ¸® AmhÁøn 3.3 CÀ 

uµ¨£mkÒÍx.

 
AmhÁøn 3.3 C¸© Gs •øÓø©US›¯ C»UP[PÒ   

Gs •øÓø© C¸© AÀ»x Cµsøh Ai¯õPU 

öPõsh Gs•øÓ

Ai 2

£¯ß£kzu¨£k® C»UP[PÒ 0" 1

Euõµn©õP 111011012  Gß£øuU P¸x÷Áõ®

1 1 1 0 1   1 0 1
2
  C¸© Gs 

27 26 25 24 23 22 21 20   ©v¨÷£ØÖ[ Põµo

 20,  21,  22,  23 ..........  BQ¯  ö£Ö©õÚ[PÒ  C¸©  Gs  •øÓø©°ß ©v¨ 

÷£ØÖ[ PõµoPÒ GÚ¨£k®. 

            

1 1 0 01 11 1

27 26 25 24 23 22 21 20
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C¢u Gsøn E¸ 3.7 CÀ Põmi¯ÁõÖ Cµsøh Ai¯õPU öPõsh Gs               

\mhzv¾® Põmh»õ®.

AÖ£zx 

|õßSPÒ 

64

26

•¨£zv                            

µskPÒ

32

25

£vÚõÖPÒ

16

24

GmkPÒ           

8

23

|õßSPÒ

4

22

CµskPÒ

2

21

JßÖPÒ

1

20

¡ØÔ C¸£z                    

öumkPÒ                                               

128

27

                

E¸ 3.7 C¸© GsPøÍ ÁøPSÔzuÀ

C¸© GsPøÍ GÊx®÷£õx Auß Aiø¯²® GÊu ÷Ásk®. GÛÝ®, 

|õ® £¯ß£kzx® £vß© GsPøÍ GÊx®÷£õx Aiø¯U SÔ¨¤hz 

÷uøÁ°Àø». PoÛz öuõÈÝm£Â¯¼À C¸© Gs •øÓø© ªP 

•UQ¯©õÚuõS®. Ax PoÛ°ß Ai¨£øh AÍÃmk A»PõÚ ¤ØÖ (bit) 
CøÚ E¸ÁõUSÁvÀ £[PÎ¨¦a ö\´QßÓx. C¢u Gs •øÓø©°À PõnU-

Ti¯  ]Ô¯  ö£Ö©õÚ®  0 BPÄ® ö£Ö©v Ti¯ ö£Ö©õÚ®  1 BPÄ®   

C¸US®.
 
C¢u

 
]Ô¯ A»S ¤ØÖ (Bit) B inaryDig it GÚ¨£k®.  

3.2.2 Gs© Gs •øÓø© (Octal Number System)

0,1,2,3,4,5,6,7 BQ¯ Gmk C»UP[PÐ® £¯ß£kzu¨£k® Gs •øÓø© Gs© 

Gs•øÓø© GÚ¨£k®. 

 
AmhÁøn 3.4 Gs© Gs •øÓø©°ß C»UP[PÒ

     

Gs •øÓø© Gs© AÀ»x Gmøh Ai¯õPU öPõsh Gs•øÓø©

Ai 8
£¯ß£kzu¨£k® 

C»UP[PÒ

0, 1, 2, 3, 4, 5, 6, 7

Euõµn©õP 2368   CøÚU P¸x÷Áõ®

2 3 6    Gs© Gs

 

82 81 80    ©v¨÷£ØÖ® Põµo 
     

       80, 81, 82, 83.....  BQ¯ ö£Ö©õÚ[PÒ Gs© Gs •øÓø©°ß ©v¨÷£ØÖ® 

PõµoPÒ GÚ¨£k®. C¢u Gsøn ¤ßÁ¸©õÖ Gmøh Ai¯õPU öPõsh 

Gs \mhzvÀ GkzxU Põmh»õ®. (E¸ 3.7)
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I¡ØÖ 

£ßÛ                              

µskPÒ                                  

512

83

GmkPÒ

8

81

AÖ£zx 

|õßSPÒ              

64

82

JßÖPÒ

1

80

|õßPõ°µzx

öuõsrØ                       

ÓõÖPÒ                          

4096

84

        
            

 E¸ 3.8 Gmøh Ai¯õPU öPõsh GsPøÍ ÁøPSÔzuÀ

3.2.3 £vÚÖ© Gs•øÓø© (Hexa-Decimal Number System)
 

 
 PoÛ C¸© GsPøÍ¨ £¯ß£kzxQÓx. CuøÚ ©Ûuº  ÂÍ[QU 

öPõÒÁx PiÚ©õS®. BP÷Á,  ©Ûu £¯ß£õmiØS C»SÁõP ¤µ÷¯õQUPz 

uUPuõP £vÚÖ©  GsPÒ £¯ß£kzu¨£kQßÓx. ö£õxÁõP Cµsk øP-

PÎ¾•ÒÍ 10 ÂµÀPøÍ¨ £¯ß£kzv GsqÁx ÁÇø©¯õS®. E[PÍx 

øPPÒ Cµsi¾® 16 ÂµÀPÒ EÒÍöuÚU öPõÒ÷Áõ®. C¨÷£õx Pozu-

ÀPÐUöPÚ 16 C»UP[PøÍ¨ £¯ß£kzu»õ®. £vÚÖ© Gs•øÓø©°À 

0 - 9 Áøµ¯õÚ £zx C»UP[PÐ®  A, B, C, D, E, F BQ¯ GÊzxUPÐ® 

£¯ß£kzu¨£k®. C[S 10,11,12,13,14,15 BQ¯ GsPÒ •øÓ÷¯ A, B, C, D, E, 
F BQ¯ GÊzxUPÍõÀ ¤µv{vzxÁ¨£kzu¨£kQßÓÚ. (AmhÁøn 3.5) 

  
   

£vß© GsPÒ   

£vÚÖ© GsPÒ

0 1

0 1 2 3

2 3 4

4

6

6

8

8

10

A

11

B

12

C

13

D

14

E

15

F

5

5

7

7

9

9

AmhÁøn 3.5 £vß©, £vÚÖ© GsPÎß J¨¥k

£vÚÖ© Gs•øÓø©°ß C»UP[PÒ ¤ßÁ¸® AmhÁøn 3.6 CÀ                                     

uµ¨£mkÒÍx.
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AmhÁøn 3.6 £vÚÖ© Gs •øÓø©°¾ÒÍ C»UP[PÒ

Gs•øÓø© £vÚÖ© AÀ»x £vÚõøÓ Ai¯õPU 

öPõsh Gs•øÓø©

Ai 16
£¯ß£kzu¨£k® C»UP[PÒ 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F

 £vÚÖ© Gs•øÓø©°ß ªP¨ö£›¯ GsnõÚ 15 CøÚ C¸© 

GsoÀ Põmk®÷£õx 4 ¤ØÖPÎÀ Põmh •i²® CuØPø©¯ 4 ¤ØÖ 

öPõsh GsoØS¨ £v»õP £zvøÚ Ai¯õPUöPõsh Gs•øÓø©°ß 

GsönõßøÓ¨ £¯ß£kzu»õ®. Euõµn©õP PoÛ°ß {øÚÁP •PÁ› 

PøÍ  (Memory addresses)   ÁøPSÔUP £vÚÖ© Gs £¯ß£kzu¨£k®. 

 E¸ 3.4 CÀ Põmh¨£mhÁõÖ Pk® Fuõ {ÓzxUPõÚ '#871F78'   
GÝ® SÔ±møh AÁuõÛUP •i²®. C[S {ÓzxUS›¯ ö£Ö©õÚ® # 
GÝ® SÔ±mkhß  Bµ®¤UQßÓx. C¢u¨ö£Ö©õÚ® PoÛ°À £vÚÖ© 

GsoUøP°÷»÷¯ ÁøPSÔUP¨£k®. AuõÁx ÷©÷»²ÒÍ Euõµnzvß£i 

Pk® Fuõ ÁºnzvØPõÚ SÔ '#  871878' BS®. C[S RGB BQ¯ÁØÔØS›¯ 

ö£Ö©õÚ[PøÍ 0-255 Áøµ¯õÚ £vß© GsPÎÀ ÁÇ[P •i²®. G¢uöÁõ¸ 

{ÓzvÚx® ö£Ö©vø¯ '# ' AÀ»x “&H” (ampersand) GÝ® SÔ±møh 

G¢uöÁõ¸ Gsoß •ßÝ® £¯ß£kzv¨ ¤µ÷¯õQ¨¤ß A¨ö£Ö©õÚ® 

£vÚÖ© GsnõS®. ¤ßÁ¸® AmhÁøn°À   (AmhÁøn 3.8) Pk® Fuõ 

{ÓzxUS›¯ £vÚÖ©¨ ö£Ö©õÚ•® RGB ö£Ö©õÚ•® Põmh¨£mkÒÍx.

AmhÁøn 3.7 P¸® Fuõ {ÓzxUS›¯ £vÚÖ©¨ ö£Ö©õÚ®

{ÓzxUS›¯ 

ö£¯º
{Ó® £vÚÖ©¨

ö£Ö©õÚ®

R G B

Fuõ #  871F78
&H 871F78

135 31 120

Euõµn©õP 15E16 CøÚU P¸x÷Áõ®

1 5 E16  -  £vÚÖ© Gs 

162 161 160  - ©v¨÷£ØÖ® Põµo         

162 161 160

15E 16

C[S 160, 161,162, 163...... BQ¯ ö£Ö©õÚ[PÒ £vÚÖ© Gs•øÓø©°À 

©v¨÷£ØÖ® Põµo (Hexadecimal Weighting factors) GÚ¨£k®.
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C¢u Gsøn ¤ßÁ¸©õÖ Ai £vÚõøÓU öPõsh Gs \mhzvÀ 

ÁøPSÔzxU Põmh»õ®. (E¸ 3.9)

JßÖPÒ

1
160

£vÚõÖPÒ

16
161

C¸¡ØÖ

I®£z

uõÖPÒ

256
162

|õßPõ°µzx 

öuõßÞØÖ

BÖPÒ

4096
163

E¸ 3.9 Ai 16 CØS›¯ Gs\mhzvÀ ÁøPSÔzuÀ

£vß©, C¸©, Gs©, £vÚÖ© GsPÐUQøh°»õÚ öuõhº¦ 

AmhÁøn 3.8 Gs •øÓø©PÐUQøh°»õÚ öuõhº¦

£vß© C¸© Gs© £vÚÖ©

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

0
1

10
11

100
101
110
111

1000
1001
1010
1011
1100
1101
1110
1111

10000
10001
10010
10011
10100
10101
10110
10111
11000

0
1
2
3
4
5
6
7
10
11
12
13
14
15
16
17
20
21
22
23
24
25
26
27
30

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F
10
11
12
13
14
15
16
17
18

80, 160

81

161

20

21

23

24
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3.3    C»UPö©õßÔß  Av²¯º, ªPUSøÓ¢u ö£õ¸Ðøh¯         

         Ch¨ö£Ö©õÚ[PÒ 

 £vß© GsPÒ, {øÓö¯sPÒ BQ¯ÁØÔß Ea\, SøÓ¢u {ø»¨ 

ö£Ö©õÚ[PøÍ PshÔ¯ Cµsk ÷ÁÖ£mh •øÓPÒ Põn¨£kQßÓÚ. 

SÔ¨¤mh {øÓö¯søn Chª¸¢x Á»©õP Áõ]US®÷£õx Á»x £UPz-

v¾ÒÍ ö£Ö©õÚ® ªPU SøÓ¢u ö£õ¸Ðøh¯ ö£Ö©õÚ©õP Aø©Áxhß 

Chx A¢uzv¾ÒÍ §a]¯® AÀ»õu ö£Ö©õÚ® Av²a\¨ ö£Ö©õÚ©õPÄ® 

Aø©²®. (E¸ 3.10)

                      

AvTi¯ 

ö£Ö©õÚ®
ªPU SøÓ¢u 

ö£Ö©õÚ®

       E¸ 3.10 GsönõßÔß AvTi¯, ªPUSøÓ¢u ö£õ¸Ðøh¯ Ch¨ö£Ö©õÚ[PÒ

 u\© GsoÀ u\©¨¦ÒÎUS Á»¨¦Ó A¢uzv¾ÒÍ §a]¯©À»õu 

ö£Ö©õÚ® ªPUSøÓ¢u ö£õ¸Ðøh¯ ö£Ö©õÚ©õS®. Ch¨£UP A¢uz -

v¾ÒÍ §a]¯©À»õu ö£Ö©õÚ® AvTi¯ ö£õ¸Ðøh¯ ö£Ö©õÚ® GÚU 

SÔ¨¤h¨£k®. (E¸ 3.10)

3.3.1   AvP ö£õ¸Ðøh¯ C»UP•® (MSD - Most Significant Digit)
          ªPU SøÓ¢u ö£õ¸Ðøh¯ C»UP•® (LSD -Least Significant Digit) 

 
         
 {øÓö¯sönõßÔß AÀ»x u\© GsönõßÔß AvP ö£õ¸Ðøh¯ 

C»UP•® ªPUSøÓ¢u C»UP•® AmhÁøn°À uµ¨£mkÒÍx. (Am-

hÁøn 3.9)
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AmhÁøn 3.9 GsönõßÔß AvTi¯ ö£õ¸Ðøh¯, ªPUSøÓ¢u 

ö£õ¸Ðøh¯ C»UP[PÒ.

 

             Gs MSD LSD
329

1237.0
58.32
0.0975

0.4

3
1
5
9
4

9
7
2
5
4

 C¸©, Gs©, £vÚÖ© GsPÐUS AvTi¯, ªPUSøÓ¢u ö£õ¸Ð 

øh¯ C»UP[PøÍ PshÔ²®÷£õx, £vß© GsPÐUSU øPUöPõÒÍ¨£mh 

•øÓ÷¯ Pøh¨¤iUP¨£k®. 

 

¤ßÁ¸® GsPÎß ªPUSøÓ¢u ö£õ¸Ðøh¯ C»UPzøu²® 

AvTi¯ ö£õ¸Ðøh¯ C»UPzøu²® SÔ¨¤kP. 

(i). 5687010  (ii). 154.0110  (iii). 23.0808 (iv). AD 23916    
(v). 0.001102 

 ö\¯Ø£õk

3.3.2   AvTi¯ ö£õ¸Ðøh¯ ¤ØÖ® (MSB – Most Significant Bit)
         ªPUSøÓ¢u ö£õ¸Ðøh¯ ¤ØÖ® (LSB – Least Significant Bit)

 

 C¸© Gs•øÓø©US ©mk÷© AvTi¯, ªPU SøÓ¢u ö£õ¸Ðøh¯ 

¤ØÖ £¯ß£kzu¨£k®. u\©® öPõsh C¸© GsPÎ¾® {øÓ C¸© 

GsPÎ¾® Cx Cµsk •øÓPÎÀ PshÔ¯¨£k®.

 SÔzuöÁõ¸ {øÓö¯søn Chª¸¢x Á»©õP Áõ]US® ÷£õx Á»x 

A¢uzv¾ÒÍ ¤ØÖ ªPU SøÓ¢u ö£õ¸Ðøh¯ ¤ØÓõP Aø©Áxhß Ch¨£UP 

A¢uzv¾ÒÍ §a]¯©À»õu ¤ØÖ AvP ö£õ¸Ðøh¯ ¤ØÓõS®. C¸© u\© 

GsoÀ u\©U SÔUS Á»x £UPzvÀ ÷\´ø©°¾ÒÍ §a]¯©À»õu ¤ØÖ 

ªPU Ti¯ ö£õ¸Ðøh¯ ¤ØÖ BP Aø©Áxhß u\©U SÔUS Chx £UPz-

vÀ Aø©¢xÒÍ §a]¯® AÀ»õu ¤ØÖ SøÓ¢u ö£õ¸Ðøh¯ ¤ØÓõS®.
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AmhÁøn 3.10
 GsPÎß AvTi¯, AvSøÓ¢u ö£õ¸Ðøh¯ ¤ØÖ

         C¸ÁøP MSB LSB
1001 1 = (23) 1 = (20)

011.101 1 = (21) 1 = (2-3)

¤ßÁ¸® GsPÎß AvP ö£õ¸Ðøh¯ ¤ØÖ, ªPU SøÓ¢u 

ö£õ¸Ðøh¯ ¤ØÖ BQ¯ÁØøÓU PõsP. 

(i) 10002 (ii) 0111012 (iii) 0.110012 (iv) 1.00102 

(v) 0.001102 

 ö\¯Ø£õk

 3.4  £vß© GsPøÍ C¸©, Gs©, £vÚÖ© GsPÍõP 

          ©õØÕk ö\´uÀ

3.4.1  £vß© Gsøn ÷ÁÖ Ai •øÓPÐUS ©õØÕk ö\´uÀ

 |õ® PoÛ°À EÒÎk® uµÄPÒ AøÚzx® PoÛ°ÚõÀ C¸© 

Gs•øÓø©°ß C»UP[PÒ 0,1 BP÷Á CÚ[Põn¨£k®. GÚ÷Á Ai 

£zøuU öPõsh GsPøÍ ÷ÁÖ AiPÐUS ©õØÕkö\´¯ AÔ¢v¸¨£x 

•UQ¯©õÚuõS®. C[S, £vß© GsPøÍ C¸© GsPÒ, Gs© GsPÒ, 

£vÚÖ© GsPÍõP  ©õØÕk ö\´Áx £ØÔ AÔ¢x öPõÒ÷Áõ®.

3.4.2  £vß© GsPøÍ C¸© GsPÍõP ©õØÕk ö\´uÀ

 £vß© Gsøn C¸© GsnõP ©õØÕk ö\´²®÷£õx «v 0 BS® 

Áøµ  SÔzu £vß© Gsøn CµshõÀ ÁSzx Auß «vPøÍ Á»x 

£UPzvÀ GÊvUöPõÒÍ ÷Ásk®. ¤ßÚº CÆÁõÖ GÊu¨£mh «vPÒ 

AøÚzøu²® RÈ¼¸¢x ÷©À Áøµ JÊ[PõP GÊxÁuß ‰»® C¸© 

Gsøn¨ ö£ØÖUöPõÒÍ»õ®.
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Euõµn®

12
10 

GÝ® Gsøn C¸© GsnõP ©õØÕk ö\´÷Áõ® 

* •u¼À C¢u Gsøn 2 BÀ ÁSzx «vPøÍ GÊvU öPõÒÐ[PÒ

   

  2 12
  2 6

  2 3
  2 1

0

0

0
1
1

DÄ

«v

* ¤ßÚº ö£Ó¨£mh «vPÒ AøÚzøu²® RÈ¸¢x ÷©À Áøµ GÊxP. 

    

    1210 = 11002  

Euõµn®  
4610  CøÚ C¸© GsnõP ©õØÕk ö\´P.

       

0

0

1
1
1

1

  2 46
  2 23

  2 11
  2 5

0

2
1

  2
  2

4610 = 1011102

¤ßÁ¸® £vß© GsPøÍ C¸© GsPÍõP ©õØÕk ö\´P.

(i). 15510  (ii).  47210 (iii).  116310  

 ö\¯Ø£õk
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3.4.3 £vß© GsPøÍ Gs© GsPÍõP ©õØÕk ö\´uÀ

 C¨÷£õx DÄ 0 BS®Áøµ uµ¨£mh Gsøn 8 CÚõÀ ÁSzx 

QøhUS® «vø¯ RÈ¸¢x ÷©À÷|õUQ GÊvUöPõÒ÷Áõ®.   

Euõµn® 
158

10
 CøÚ Gs© GsnõP ©õØÕk ö\´÷Áõ®.

 ¾ •u¼À CÆöÁsøn 8 CÚõÀ ÁSzx «vø¯ GÊvUöPõÒP.

   

  8 158
  8 19

  8 2
0

6
3
2

DÄ

 «v

 ¾ ¤ßÚº ÁSUP¨£mh «v°øÚ RÈ¸¢x ÷©À÷|õUQ JÊ[QÀ GÊxP.

 
158

10
= 236

8

R÷Ç uµ¨£mkÒÍ £vß© GsPøÍ Gs© GsPÍõP ©õØÕk 

ö\´P.

(i). 15510 (ii). 47210 (iii). 116310  

ö\¯Ø£õk

3.4.4 £vß© GsPøÍ £vÚÖ© GsnõP ©õØÕk ö\´uÀ

 C[S DÄ 0 BS®Áøµ   16 CÚõÀ ÁSzx QøhUS® «vø¯ RÈ¸¢x  

÷©À÷|õUQ  GÊvUöPõÒP.

Euõµn®

38
10
 GßÝ® Gsøn £vÚÖ© GsnõP ©õØÕk ö\´P.

 ¾ •u¼À CÆöÁsøn 16 CÚõÀ ÁSzx «vø¯ GÊvUöPõÒÍ                         

÷Ásk®.  
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16 38
16 2

0
6
2

«v

DÄ

 ¾ ¤ßÚº ÁSUP¨£mh «vPøÍ RÈ¸¢x ÷©À÷|õUQ JÊ[QÀ GÊxP.

 
3810  = 2616

Euõµn®

47
10 

CøÚ £vÚÖ© GsnõP ©õØÓÄ®.

4710  = 2F16

16 47
16 2

0
15
2

F
2

                           

¤ßÁ¸® £vß© GsPøÍ £vÚÖ© GsPÍõP GÊxP. 

(i).25610                ( ii). 47810               (iii). 196310 

ö\¯Ø£õk

3.5  C¸©,  Gs©,  £vß©  ©ØÖ® £vÚÖ© GsPÐUQøh°»õÚ   

©õØÕk
                                                                                               

 |õ® CuØS •ßÚº £vß© GsPøÍ (Ai£zx), C¸©, Gs©, 

£vÚÖ© GsPÍõP  ©õØÕk ö\´÷uõ®. C¨÷£õx C¸© GsPøÍ¨ £vß© 

GsPÍõPÄ® Gs© GsPøÍ¨ £vß© GsPÍõPÄ® £vÚÖ© GsPøÍ¨ 

£vß© GsPÍõPÄ® ©õØÕk ö\´Áøu¨ £õº¨÷£õ®. (E¸ 3.11)
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£vß© Gs 

^Ai 10&

C¸© Gs 

^Ai 2&

£vÚÖ© Gs 

^Ai 16&

Gs© Gs

^Ai 8&

E¸ 3.11  Gs •øÓø©PÐUQøh°»õÚ ©õØÕk

3.5.1  C¸© GsPøÍ £vß© GsPÍõP ©õØÕk ö\´uÀ

Euõµn®

 1101
2
  GßÝ® Gsøn £vß© GsnõP ©õØÖ÷Áõ®.

1 1 0 1  -  

 

23 22 21 20 

11012 = (1«23) ¬  (1«22) ¬ (0«21) ¬ (1«20)
 =  (1«8) ¬ (1«4)  ¬ (0«2) ¬ (1«1)
 =  8 ¬ 4  ¬ 0 ¬ 1 

11012= 1310 

 

 

 ¤ßÁ¸® C¸© GsPøÍ £vß© GsPÍõP ©õØÕk ö\´P.

(i). 1012  (ii). 1110101102 (iii). 10100101112 

ö\¯Ø£õk
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3.5.2  Gs© GsPøÍ £vß© GsPÍõP ©õØÕkö\´uÀ

Euõµn®

12758 GßÝ® Gsøn £vß© GsnõP ©õØÕk ö\´uÀ.

83 82 81 80

¤ßÁ¸® Gs© GsPøÍ £vß© GsPÍõP ©õØÕk ö\´P.

(i).  2308 (ii).  7458 (iii).  20658   

ö\¯Ø£õk

3.5.3 £vÚÖ© GsPøÍ £vß© GsPÍõP ©õØÕk ö\´uÀ

Euõµn®

329
16
 GÝ® Gsøn £vß©  GsnõP ©õØÕk ö\´uÀ.

161 160162
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Euõµn®

AB2
16 

GßÝ® Gsøn £vß©  GsnõP ©õØÕk ö\´uÀ.

162 161 160

¤ßÁ¸® £vÚÖ© GsPøÍ £vß© GsPÍõP ©õØÕk ö\´P.

(i). 1A16  (ii). 7EF (iii).  A4916

 ö\¯Ø£õk

3.5.4  C¸© Gsøn Gs© GsnõP ©õØÕk ö\´uÀ

 Gs© Gs•øÓø©°À £¯ß£kzu¨£k® C»UP[PÍõÚ  0, 1, 2, 3, 4, 
5, 6, 7 BQ¯ÁØÔÀ ªP¨ ö£›¯ C»UP®  7 BS®.  7  GÝ® Gsøn 111

2 
GÚ 

C¸© GsPÎÀ GÊu»õ®. CuØPø©¯ Gs© Gs•øÓø©°À ªP¨ö£›¯ 

C»UP©õÚ 7 CøÚ 3 ¤ØÖPÒöPõsh C¸© GsPÎÚõÀ ÁøPSÔUP 

•i²®. CÆÁõÖ Gs© Gs•øÓø©°À Pozu C»UP[PøÍ²® 3 ¤ØÖPÒ 

öPõsh GsPÎÚõÀ Põmh»õ®. Ai 8 Gs •øÓø©°À £¯ß£kzu¨£k® 

C»UP[PÐUS J¨£õÚ C¸©GsPÒ ¤ßÁ¸® AmhÁøn 3.11 CÀ Põm-

h¨£mkÒÍÚ. 
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AmhÁøn  3'11- Gs© C»UP[PøÍ¨ £vß© ©ØÖ® C¸© GsPÎÀ Põm-

kuÀ

      Gs© GsPÒ       £vß© GsPÒ       C¸© GsPÒ

0
1
2
3
4
5
6
7

0
1
2
3
4
5 
6
7

000
001
010
011
100
101
110
111

÷©ØPõmh¨£mh AmhÁønUPø©¯ Gs© GsPøÍ C¸© GsPÍõPU     

Põmk®÷£õx ‰ßÖ ¤ØÖPÒ £¯ß£kzu¨£k®. (8 = 23 ) 

C¨÷£õx |õ® C¸© GsPøÍ Gs© GsPÍõP ©õØÖ® •øÓø¯¨ £õº¨÷£õ®.

Euõµn®

1011101
2 
 GÝ® Gsøn Gs© GsnõP ©õØÕk ö\´÷Áõ®.

 

 ¾ •u¼À Á»x A¢uzv¼¸¢x Chx A¢u®Áøµ ‰ßÖ ¤ØÖUPÍõP 

÷ÁÓõUQU öPõÒP. Chx  A¢uzv¾ÒÍ  ¤ØÖz  öuõSv°À  ‰ßÖ 

¤ØÖPÒ CÀø»ö¯ÛÀ 0 I ÷\ºzx¨ §µn¨£kzxP. 

 ¾ GÀ»õz öuõSvPÐUS•›¯ Gs© Gsønz uÛzuÛ÷¯ GÊxP. 

 ¾ ¤ßÚº AzöuõSvø¯ Gs© C»UP[PøÍ¨ £¯ß£kzv uÛzuÛ÷¯ 

GÊxP.

 ¾ CÆÂ»UP[PøÍ Chx£UP A¢uzv¼¸¢x Á»x£UP A¢u®Áøµ 

JÊ[S•øÓ°À GÊxP. 

    

   



100

0

0 0 1 0 1 1 1 0 1

0 1 0 1 1 1 0 1

                   
10111012 = 1358

¤ßÁ¸® C¸© GsPøÍ Gs© GsPÍõP  ©õØÖuÀ.

(i). 100110012  (ii). 1111001112 (iii). 101010101102  

 ö\¯Ø£õk

3.5.5 C¸© GsPøÍ¨ £vÚÖ© GsPÍõP ©õØÖuÀ

 £vÚÖ© Gs•øÓø©°À £¯ß£kzu¨£k® SÔ±kPÎÀ ""F'' CÚõÀ 

ÁøPSÔUP¨£k® ö£Ö©õÚ® Ea\ GsnÍÄ¨ ö£Ö©õÚzøuU  öPõsh 

C»UP©õS®. CuøÚ   1111
2
  GßÝ® |õßS ¤ØÖPøÍU öPõsh C¸© GsPÎÀ 

Põmh»õ®. £vÚÖ© Gs•øÓø©°À £¯ß£kzu¨£k® C»UP[PÐUS 

J¨£õÚ C¸© GsPÒ AmhÁøn 3'12 CÀ Põmh¨£mkÒÍÚ.    
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AmhÁøn 3'12 - £vß© C»UP[PøÍ £vÚÖ©, C¸© GsPÒ ‰»® 

PõmkuÀ. 

£vß© Gs C¸© Gs£vÚÖ© Gs

             

÷©÷»²ÒÍ AmhÁøn 3.12 CØS Aø©¯ £vÚÖ© GsPøÍ C¸© 

GsPÎÚõÀ Põmk®÷£õx |õßS ¤ØÖPÒ £¯ß£kzu¨£k®.   ^16 = 24&

Euõµn®

10110
2 
GßÝ® Gsøn £vÚÖ© GsnõP ©õØÓ® ö\´uÀ.

 y •u¼À Á»x¦Ó A¢uzv¼¸¢x Chx¦Ó A¢u®Áøµ |õßS ¤ØÖUPÒ 

öPõsh öuõSvPÍõP¨ ¤›zxU öPõÒP. 

 y JÆöÁõ¸ öuõSvUS©õÚ £vÚÖ© Gsønz uÛzuÛ÷¯ GÊvU 

öPõÒP.

 y AÆöÁsPøÍ Chx A¢uzv¼¸¢x Á»x A¢u® Áøµ JÊ[QÀ GÊv 

Aiø¯²® SÔUP.
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0

0 0 0 1 0 1 1 0

0 0 1 0 1 1 0

Euõµn®

10111011100
2
  GßÝ® Gsøn £vÚÖ© GsnõP ©õØÖuÀ

0

0 1 0 1 1 1 0 1 1 1 0 0

1 0 1 1 1 0 1 1 1 0 0

5

¤ßÁ¸® C¸© GsPøÍ £vÚÖ© GsPÍõP ©õØÖP.

(i). 110110102     (ii). 111110011012   (iii). 100111000112
 

 ö\¯Ø£õk

3.5.6 Gs© GsPøÍ C¸© GsPÍõP ©õØÖuÀ

÷©÷» Gs© GsPøÍ C¸© GsPÍõPU Põmk®÷£õx ‰ßÖ C»UP[PÍõPU 

Põmh»õ® GÚU PØ÷Óõ®. 

CuØPø©¯ Gs© GsPÎ¾ÒÍ JÆ÷Áõº C»UPzøu²® Ai CµsiØS 

©õØÔ ‰ßÖ C»UP[PÒ öPõshuõP GÊu÷Ásk®. 
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Euõµn®

457
8
 GßÝ® Gsøn C¸© GsoØS ©õØÖuÀ.

 y •u¼À Gs© Gsoß AøÚzx C»UP[PøÍ²® ‰ßÖ ¤ØÖPÒ 

öPõshuõP C¸© GsoÀ GÊxP.

 y CµshõÁuõP A¢u ¤ØÖPÒ AøÚzøu²® JßÓõP GÊv Gs© 

GsPÐUS›¯ GsPøÍ GÊxP.  

4578  = 1001011112

  4
100

5
101

    7
111

 

¤ßÁ¸® Gs© GsPøÍ C¸© GsPÍõP ©õØÔ GÊxP.

(i). 108  (ii).  2458 (iii). 7068 

 ö\¯Ø£õk

3.5.7  Gs© GsPøÍ £vÚÖ© GsPÍõP ©õØÕk ö\´uÀ

 Cuß÷£õx Gs© GsPÒ •u¼À C¸© GsPÍõPU Põmh¨£mk ¤ß 

AøÁ £vÚÖ© GsPÍõP ©õØÓ¨£k®.

Euõµn®

1057
16 

GßÝ® Gsøn £vÚÖ© GsnõP ©õØÖP

 y •u¼À £vÚÖ© Gso¾ÒÍ GÀ»õ C»UP[PøÍ²® ‰ßÖ ¤ØÖPÎÀ 

C¸© GsPÍõP GÊxP.

 y QøhUS® C¸© Gsøn Á»x £UPzv¼¸¢x Chx£UP©õP |õßS 

¤ØÖPÒ öPõsh öuõSvPÍõP ¤›zxU öPõÒP.

 y JÆöÁõ¸ öuõSvUS® \©ÚõÚ £vÚÖ© GsPøÍ GÊxP.
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7501
001  000  101   111

   

00 1 0 0 0 1 0 1111

     2        2        15
     2        2         F

 

10578  = 22F16

R÷Ç uµ¨£mkÒÍ Gs© GsPøÍ £vÚÖ© GsPÍõP ©õØÖP.

(i). 3208  (ii).  4758 (iii). 16738 

 ö\¯Ø£õk

 3.5.8  £vÚÖ© GsPøÍ C¸© GsnõP ©õØÕk ö\´uÀ

 £vÚÖ© Gs•øÓ°¾ÒÍ G¢uöÁõ¸ Gsq® |õßS ¤ØÖPÒ öPõsh 

GsPÍõP GÊu¨£h •i²ö©Ú •ßÚº }[PÒ PØÖÒÏºPÒ. BP÷Á, £vÚÖ© 

Gsøn C¸© GsnõP ©õØÕk ö\´²®÷£õx Auß GÀ»õ GsPÐ® |õßS 

¤ØÖPÒ öPõsh C¸© GsPÎÀ Põmh¨£h ÷Ásk®. 

Euõµn®

   74
16
 GßÝ® Gsøn C¸© GsnõP ©õØÖP.

  
7416  = 11101002

7 4 
0111 0100

   2AE16  GßÝ® C¸© GsnõP ©õØÖP.

  

2 A  E
0010 1 010 1110

2AE16 = 10101011102
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¤ßÁ¸® £vÚÖ© GsPøÍ C¸© GsPÍõP ©õØÕk ö\´P.

(i) 7816          (ii)  B2C16      (iii) 4DEF16  

 ö\¯Ø£õk

3.5.9 £vÚÖ© GsPøÍ Gs© GsnõP ©õØÕkö\´uÀ

      C[S •u¼À £vÚÖ© Gsøn C¸© GsnõP ©õØÕk ö\´x ¤ßÚº 

Gs© GsPÍõP GÊu¨£k®.

Euõµn®

23A GÝ® Gsøn Gs© GsnõP ©õØÕk ö\´uÀ

     

2 3  A
0010 0011 1010

001 0 0 0 1 1 1 010

1  7  2 0

23A16 = 10728

¤ßÁ¸® £vÚÖ© GsPøÍ Gs© GsPÍõP ©õØÕkö\´P'

(i)  32016 (ii)  A7B16 (iii) 10ED16  

ö\¯Ø£õk
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1. “ 23 y ”  GßÝ® GsønU P¸xP. C[S y GÚU Põmh¨£m                                                                                                  

kÒÍx Gs•øÓø©°ß Ai¯õS®. 

“ 23 y” GßÝ® Gs  }º PØÓ G¢u Gs •øÓø©°øÚ AÀ»x 

•øÓø©PÎøÚa \õº¢uuõP C¸UP»õ®@

2' 83
10 

GßÝ® £vß© Gsøn C¸© GsnõP ©õØÕk ö\´P. E[PÍx 

ö\´øP°øÚU PõmkP. 

3' 10110111
2 
GßÝ® C¸© Gsøn Gs© GsnõP ©õØÕk ö\´P. E[PÍx 

ö\´øP°øÚU PõmkP. 

4' 23D
16 

 GßÝ® £vÚÖ© Gsøn C¸© GsnõP ©õØÕk ö\´P. 

5'  ¤ßÁ¸® AmhÁøn°À EÒÍ öÁØÔh[PøÍ {µ¨¦P.

AmhÁøn 3'13 - ]» {Ó[PÐ® AÁØÔØPõÚ RGB ö£Ö©õÚ[PÐ® ©ØÖ® 

£vÚÖ© ö£Ö©õÚ[PÐ®. 

 

  {Ózvß ö£¯º {Ó®        £vÚÖ©¨ 

ö£Ö©õÚ®
R 

 

G B

Pk®   

Fuõ 
#  871F78 135 31 120

    CÍ® 

    ]Á¨¦
 255 182 193

    Áõß

    }»®

50 153 204

   £aø\ 0 255 0

  ©g\Ò  255 238 0

 ö\¯Ø£õk

 3.6 uµÄz ÷uUPPU öPõÒÍÍÄ (Data Storage Capacity)

     PoÛ°À uµÄPøÍz  ÷uUSÁuØS SÔ¨¤mh Ch® ÷uøÁ¯õS®. uµÄz 

÷uUPPU  öPõÒÍÍÄ  ¤ØÖPÒ  (bits)  ø£mkPÒ  (bytes)  Q÷»õ  ø£mkPÒ  
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(kilobytes) ö©Põ ø£mkPÒ (Megabytes) QPõ ø£mkPÒ  (Gigabytes),  öµÓõ 

ø£mkPÒ  (Terabytes) ö£µõ ø£mkPÒ  (Petabytes) BQ¯ A»SPÎÀ 

AÍUP¨£k®. JßÖUöPõßÖ ÷ÁÖ£mh uµÄz÷uUPPU öPõÒÍÍÄPøÍa                                                    

]Ô¯ A»S öuõhUP® ö£›¯ A»S Áøµ JÊ[S •øÓ°À JÊ[S£kzxÁuß 

‰»® AÁØÖUQøh°»õÚ öuõhºø£ Áøµ¯ÖUP E[PÍõÀ C¯¾©õÚuõS®.

3.6.1   uµÄz ÷uUPP[PøÍ (Data Storage) AÍÂkÁuØS¨ £¯ß     

 £kzu¨£k®   A»SPÒ.

¤ØÖ (bit)
 PnÛ°À uµÄPøÍa ÷\ªUP¨ £¯ß£k® ªPa ]Ô¯ A»S ¤ØÖ (bit)  
BS®. Cx B inaryDig it  GßÝ® ö\õØPÎ¼¸¢x E¸ÁõUP¨£mhuõS®.  

ø£mk (byte)
 8 ¤ØÖPÒ J¸ ø£mk (byte) GÚ¨£k®.

Aøµ ø£mk  (Nibble)
 Aøµø£mk (Nibble) ¤ØÖ, ø£mk ÷£õ» AvPÍÂÀ £¯ß£kzu¨ 

£kÁvÀø». ø£ØÔß AøµÁõ]÷¯ CÆÁõÖ AøÇUP¨£k®.  

Q÷»õ ø£mk (Kilobyte)
 Cx  1024  (1024 = 210) ø£mkPøÍU öPõshuõS®. Cx KB AÀ»x 
Kbyte GÚ GÊu¨£k®.

ö©Põ ø£mk (Megabyte)
 Cx 1024 (1024 = 210) Q÷»õ ø£mkPøÍU öPõshuõS®. A÷u÷£õ»  

1048576 ø£mkPøÍU öPõshuõS®. Cx MB AÀ»x Mbyte GÚ GÊu¨£k®.

Qíõ ø£mk  (Giga byte)
 1024 ö©Põ ø£mkPøÍU (1024 MB) öPõshx Qíõ ø£mk BS®. 

Cx GB AÀ»x  g byte GÚ GÊu¨£k®. CuøÚ ""Gb'' GÚ GÊxuÀ uÁÓõS®. 

öµÓõ ø£mk (Terabyte) 
1024 QPõ ø£mkPøÍU (1024 GB) öPõshx öµÓõ ø£mk BS®. Cx TB 
AÀ»x  Tbyte GÚ GÊu¨£k®.

ö£µõ ø£mk (Petabyte)
1024 öµÓõ ø£mkPøÍU (1024 TB) öPõshx J¸ ö£µõ ø£mk BS®.
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uµÄz ÷uUPPU öPõÒÍÍÄPøÍ AÍÂk® A»S 

PÐUQøh°»õÚ öuõhº¦ Á¸©õÖ

8 bits    =  1 byte
4 bits    =  1 nibble
1024  bytes  =  1 kilobyte    (KB)
1024  kilobytes =  1 Megabyte    (MB)
1024  Megabytes =  1 Gigabyte    (GB)
1024  Gigabytes =  1 Terabyte      (TB)  

   1024  Terabytes =  1 Petabyte      (PB)

AÁuõÛ¨¦

÷©÷» uµ¨£mh A»SPÒ £ØÔ¯ ÂÍUPzøu¨ ö£ÖÁuØS ¤ßÁ¸® Euõµ 

nzvøÚ AÁuõÛUSP. (AmhÁøn  3.14)
AmhÁøn 3'14 öPõÒÍÍøÁ AÍÂk® A»SPÒ 

ö£¯º (Name) _¸UPUSÔ 
(Abbreviation)

AsnÍÁõÚ

ø£mk

(Approx Bytes)

\›¯õÚ 

ø£mkPÎß 

GsoUøP

(Exact Bytes)

AsnÍÁõÚ

£õh¨ £UP[PÒ

(Approx. Text 
Pages)

ø£mk (Byte) B JßÖ 1   1 GÊzx

Q÷»õ ø£mk    

(Kilobyte)
KB(or K) B°µ® 1,024 1

2
£UP[PÒ

ö©Põ ø£mk 

(Megabyte)
MB J¸ ªÀ¼¯ß 1,048,576 500 £UP[PÒ

QPõ ø£mk 

(Gigabyte)
GB J¸ ¤À¼¯ß 1,073,741,824 500,000 £UP[PÒ

öµÓõ ø£mk 

(Tera byte)
TB J¸ v›À¼¯ß 1,099,511,627,776 500,000,000

 £UP[PÒ

3.6.2 ÷uUPPa   \õuÚ[PÎß   uµÄz   ÷uUPPU   öPõÒÍÍÄPÒ

      (Capacities of Data Storage Devices)

      £À÷ÁÖ uµÄz÷uUPPa \õuÚ[PÎß öPõÒÍÍÄ JßÖUöPõßÖ ÷ÁÖ£k®. 

C¢u xøna\õuÚ[PÍõÀ BØÓ¨£k® £oPÐ® JßÖUöPõßÖ ÷ÁÖ£m-

høÁ¯õS®. C[S |õ® £À÷ÁÖ ÁøP£mh   \õuÚ[PÎß öPõÒÍÍÄ £ØÔ 

AÔ¢xöPõÒ÷Áõ®.   (E¸ 3.12)
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 £v÷Ámk {øÚÁP® (Register Memory) 

 1KB

 £xUS {øÚÁP® (Cache memory) 

 3 MB – 32MB

 CÖÁmk (Compact Disk (CD)                              

 650- 900 MB

 C»UP £ÀvÓÁõØÓÀ Ámk (Digital   
  Versatile Disk)    4.7 - 9 GB

 uØ÷£õUS ö£ÖÁÈ {øÚÁP®    

 (Random Access Memory) 

 01  - 64 GB

 Áõ]¨¦ ©mk® {øÚÁP® (Read Only         
  Memory    (ROM)       

 ]ªmk {øÚÁP® (Flash Memory)

 1 - 64GB   

 ÁßÁmk (Hard Disk)  

 100 GB  -   6 TB

 Põ¢u |õhõ (Magnetic Tape) 

 1TB  - 185 TB 

 u

 µ

 Ä

 U

öPõ

 Ò

 Í

 Í

 Ä

SøÓ¢u (Small)

AvP® (Large)

 

                     E¸ 3'12 ÷uUPPa \õuÚ[PÎß öPõÒÍÍÄ 

Áõ]US®÷£õx® GÊx®÷£õx® xøna \õuÚ[PÎÝÒ ~øÇ¯ GkUS® 

÷|µ®  ©õÖ£k®.  ¤ßÁ¸®  E¸Â¼¸¢x  AuøÚ  ÂÍ[QUöPõÒÍ»õ®. 

(E¸  3'13) 
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3.6.3 uµÄ¨ ö£ÖÁÈU Pv

ö©xÁõP (Slow)

ÂøµÁõP (Fast)
 £v÷Ámk {øÚÁP® 

 (Register Memory)
 £xUS {øÚÁP®

 (Cache  Memory)
 uØ÷£õUS ö£ÖÁÈ {øÚÁP®

 (Random Access  Memory)
 Áõ]¨¦ ©mk® {øÚÁP®

 (Read Only Memory)
 ]ªmk {øÚÁP®

 (Flash Memory)
 ÁßÁmk 

 (Hard Disk)
 C»UP £ÀvÓÁõØÓÀ Ámk

 (Digital Versatile Disk - DVD)
 CÖÁmk

 (Compact Disk (CD) )
 Põ¢u |õhõ 

 (Magnetic Tape)

    

            E¸ 3.13 uµÄ¨ ö£ÖÁÈU Pv

  u

  µ

  Ä

  ¨

ö£

 Ö

 Á

 È          

U

 P

 v
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3.6.4  J¸ ¤ØÖUPõÚ ö\»ÁõS® £n® (Cost per unit Storage)

÷uUPPa\õuÚ[PÎÀ uµÄPøÍU PÍg]¯¨£kzx®÷£õx J¸ ¤ØÖPÐUSU 

öPõkUP¨£k® £n®  ÷uUPPa \õuÚ[PÐU÷PØ£ ÷ÁÖ£k®.  Euõµn©õP 

£v÷Ámk {øÚÁPzvØS® ÷uUPP {øÚÁPzvØS® AvP ö\»Ä HØ£k®. 

¤ßÁ¸® Á›¨£hzvÀ CøÁ J¨¥mk Ÿv¯õPU Põmh¨£mkÒÍÚ. (E¸ 3.14 )

 £v÷Ámk {øÚÁP®

 (Register Memory)
 

 £xUS {øÚÁP®

 (Cache  Memory )
 

 uØ÷£õUS ö£ÖÁÈ {øÚÁP®

 (Random Access  Memory )
 

 Áõ]¨¦ ©mk® {øÚÁP®

 ( Read Only Memory )
 

 Põ¢u |õhõ

 (Magnetic Tape)

 ]ªmk {øÚÁP®

 (Flash Memory)
 

 ÁßÁmk

 (Hard Disk)
 

 C»UP £ÀvÓÁõØÓÀ Ámk

 (Digital Versatile Disk - DVD)
 

 CÖÁmk

 (Compact Disk  - CD) 

J
¸ 

¤
Ø
Ö
U
Põ
Ú 

£
n
®

SøÓ (Low)

AvP® (High)

                      

            

E¸ 3.14 J¸ ¤ØÖUPõÚ HØ£k® ö\»Ä 
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3.7 PoÛU SÔ•øÓPÒ (Coding Systems in Computers)

             
   E¸  3.15 PoÛ°À EÒÎh¨£k® uµÄPÐ® Az uµÄPÒ PoÛ°À 

GkzxUPõmh¨£k®  Âu•®

 E¸ 3.15  CÀ Põmh¨£mhÁõÖ PoÛ°À £À÷ÁÖ uµÄPøÍ EÒÎ 

k®÷£õx, PoÛ ‰»® AzuµÄPÒ 0, 1 BQ¯ C»UP[PÍõ»õÚ £À÷ÁÖ 

÷Põ»[PÍõP  ©õØÓ¨£k®. CuØPø©¯ |õ® umha_a ö\´²® C»UP[PÒ 

(Numeric) GÊzxUPÒ (Letters) Â÷\h SÔ±kPÒ (Special Characters) 
÷£õßÓ ÁiÁ[PÒ ©ØÖ® J¼ BQ¯Ú PoÛ°ß ÷uUPPa \õuÚ[PÎÀ 

PÍg]¯¨£kzv øÁUP¨£h C¸©U SÔ•øÓ £¯ß£kzu¨£k®. 

 }[PÒ C¢u Azv¯õ¯zvÀ  “A” GÝ® GÊzøu EÒÎk®÷£õx Ax 

PoÛ°À 1000 0001 GÚ ©õØÔk ö\´¯¨£k® GÚU PØÖÒÏºPÒ Ax “A” 
GÝ® GÊzxUS›¯ C¸©U SÔ•øÓ¯õS®. CvÀ Ah[Q²ÒÍ ¤ØÖPÎß 

GsoUøP 7 BS®. CÆÁõÖ JÆöÁõ¸ uµÄUöPÚÄ® öÁÆ÷ÁÖ ¤ØÖU 

÷Põ»[PÎøÚU öPõsh ÷PõºøÁPÒ £¯ß£kzu¨£k®. JÆöÁõ¸ 

SÔ•øÓUS©õÚ ¤ØÖPÎß GsoUøP ©õÖ£k®. CuØöPÚ öÁÆ÷ÁÖ 

SÔ•øÓPÒ EÒÍÚ. AøÁ Á¸©õÖ.

1. BCD       &  C¸© SÔ•øÓ¨ £vß©® (Binary Coded Decimal)
2. ASCII     &  uPÁÀ Cøh¨ £›©õØÓzvØPõÚ Aö©›UPz uµU SÔ•øÓ   
   (American Standard Code for Information Interchange)
3. EBCDIC &  Extended Binary Coded Decimal Interchange Code
4. Unicode  &    JØøÓU SÔ•øÓ
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3.7.1   C¸© SÔ•øÓ¨ £vß©®  (BCD - Binary Coded Decimal)
 

 C¢uU SÔ•øÓ Bµ®£Põ»zxU PoÛPÎÀ £¯ß£kzu¨£mhx. C¢u 

SÔ•øÓ°À J¸ C»UP® |õßS ¤ØÖPÍõÀ ÁøPSÔUP¨£k®. Cx £vß© 

GsPøÍ ©mk® ÁøPSÔUP¨ £¯ß£kzu¨£k®. Cuß‰»® 16 SÔ±kPøÍ  

(24 = 16)  ÁøPSÔUP •i²®. 0 - 9 Áøµ¯õÚ 10 C»UP[PÐUSö©Ú BCD  
SÔ•øÓ AmhÁøn 3.15 CÀ Põmh¨£mkÒÍx.

                               

     AmhÁøn 3.15 BCD
                 

£vß© Gs BCD 
ö£Ö©õÚ®

0

1

2

3

4

5

6

7

8

9

0000

0001

0010

0011

0100

0101

0110

0111

1000

1001

Euõµn®

37
10 

GÝ® C»UPzvß  BCD ö£Ö©õÚ[PøÍ GÊxP.

 3  7
10

001 0111

37
100
  00110111 

¤ßÁ¸® £vß© GsPÐUS›¯ BCD ö£Ö©õÚ[PøÍ GÊxP.

(i).  302  (ii).  2136 (iii).  17295

 ö\¯Ø£õk
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3.7.2 uPÁÀ Cøh¨ £›©õØÓzxUPõÚ Aö©›UP uµU SÔ•øÓ (ASCII)

 •u¼À C¢u SÔ•øÓ°ß÷£õx PoÛ°À EÒÎh¨£k® uµÄPÒ 

PoÛ°À 7 ¤ØÖPÒ öPõsh C¸© GsPÍõÀ ÁøPSÔUP¨£k®. C¢u 

SÔ•øÓø¯¨ £¯ß£kzv 128 ÁÈ C¯À¦PøÍ ÁøPSÔUP»õ®.

PoÛz uPÁØ \õuÚ[PÒ ÷£õßÓÁØÔÀ £õhzøu (Text) ÁøPSÔUP ASCII  
£¯ß£kzu¨£kQßÓx (Cøn¨¦ AmhÁøÚ 3.17). CU SÔ•øÓ Aö©›UP 

÷u]¯ uµ {ÖÁÚzvÚõÀ  (American National Standards Institute - ANSI) CÚõÀ 

E¸ÁõUP¨£mk {¯©¨£kzu¨£mkÒÍx.

Euõµn®

£õhz uµÄPÒ (Text)
School GÝ® ö\õÀø» \õÂ¨£»øP°ÞhõP  EÒÎk®÷£õx PoÛ AuøÚ 

EÒÁõ[QUöPõÒÐ® ÂuzøuU PõmkP. (CuØöPÚ AmhÁøn 3.17 CøÚ 

£¯ß£kzxP).

1) •u¼À C¢u SÔ±kPÐUS E›¯ £vß© GsPøÍ GÊxP.

 S - 83     c  - 99    h - 104    o - 111     l - 108  
2) C¢u JÆöÁõ¸ £vß© GsPÐUS® E›¯ C¸© GsPøÍ GÊxP.

   S - 1010011 c - 1100011  h - 1101000   o - 1101111     l - 1101100

3) SÔ•øÓø¯ •Êø©¯õP GÊxP.

  S   c     h         o           o  l
1010011  11000  1101000  1101111 1101111 1101100

ICT Gß£uØS›¯ ASCII SÔ•øÓø¯ C¸© GsPÎÀ GÊxP.

   

 ö\¯Ø£õk
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3.7.3 EBCDIC (Extended  Binary Coded Decimal  Interchange Code)

   ASCII  SÔ•øÓø¯¨  £¯ß£kzv 128 ÁÈ C¯À¦PøÍ ©mk÷© GÊu 

•i²®. EBCDIC SÔ•øÓø¯¨ £¯ß£kzv  256 ÁÈ C¯À¦PøÍ GÊu»õ®. 

C[S J¸ SÔ 8 ¤ØÖUPÍõÀ BUP¨£mh C¸© GsPÍõÀ GÊu¨£k®. BP÷Á, 

C¢u •øÓø¯¨ £¯ß£kzv 256 ÁÈC¯À¦PøÍ ÁøPSÔUP •i²®. C¢u 

SÔ•øÓ IBM mainframe PoÛPÎÀ £¯ß£kzu¨£mhx. C¢uU  SÔ•øÓ°À 

B[Q» ÷£öµÊzxUPÒ  (Capital) 26 US©õÚ JßÖUöPõßÖ ÷ÁÖ£mh EB-
CDIC SÔ±kPÐ® ]ØöÓÊzxUPÐUS   (Simple) JßÖUöPõßÖ ÷ÁÖ£mh  

EBCDIC SÔPÐ® ¤ßÁ¸® AmhÁøn ‰»®  Põmh¨£kQÓx.

    

AmhÁøn 3'16 B[Q» A›a_Ái°¾ÒÍ ÷£öµÊzxUPÒ, ]ØöÓÊzxUPÒ 

BQ¯ÁØÖUPõÚ  EBCDIC ö£Ö©õÚ[PÒ

     

Uppercase Lowercase

 

A

B

C

D

Character In Binary
EBCDIC

1100 0001

1100 0010

1100 0100

1100 0101

In Hexa 
Decimal

In Hexa 
Decimal

C1

C2

C4

C3

Character

a

b

c

d

EBCDIC
In Binary

1000 0001

1000 0010

1000 0011

1000 0100

81

82

83

84
 

3.7.4 JØøÓU SÔ•øÓ (Unicode)
    

        PoÛPÎÀ uµÄPøÍ GkzxUPõmh,  ASCII     ‰»©õP 128 SÔ±kPøÍ²® 

EBCDIC  ‰»®  256  SÔ±kPøÍ²®   ö£ØÖUöPõÒÍ  •i²®.  GÛÝ®, 

][PÍ®, á¨£õß, ^Ú, uªÌ ÷£õßÓ ö©õÈPÎÀ  EÒÍ GÊzxUPÒ  256 

C¾® AvP©õøP¯õÀ C¢u SÔ•øÓPøÍ¨ £¯ß£kzu C¯»õx. GÚ÷Á  16 

¤ØÖPÒ öPõsh JßÖUöPõßÖ ÷ÁÖ£mh SÔPÒ 65536 CøÚ   (216 = 65536) 
ÁøPSÔUPU Ti¯uõP uµ{¸n¯[PÐUS Aø©ÁõPz u¯õº£kzu¨£mh  

SÔ•øÓ÷¯  JØøÓU SÔ•øÓ BS®.

 R÷Ç²ÒÍ E¸ÂÀ Põmh¨£mhÁõÖ (E¸ 3.16) ][PÍ®, uªÌ, 

GÊzxUPøÍ ÁøPSÔUPÄ® Â÷\h SÔ±kPÒ, E¸UPÒ BQ¯ÁØøÓ 

ÁøPSÔUPÄ® JØøÓU SÔ•øÓ £¯ß£kzu¨£k®.
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E¸ 3.16 JØøÓUSÔ•øÓ £¯ß£kzu¨£k® \¢uº¨£[PÒ

Euõµn®

£h® ©ØÖ® ÁøµÂ¯À uµÄ   (Picture and Graphic Data) 
         

 ¤ßÁ¸® E¸ÂÀ Põmh¨£mkÒÍx (E¸ 3.17) ªPÄ® AsªzuuõP 

÷uõßÖ® ©ØÖ® AvP E¸¨ö£¸UP¨£mh £h® AÀ»x ÁøµÂ¯»õS®.

JÎ¨£h® ö£›¯ Pmh[PÎÚõÀ BUP¨£mh £À÷ÁÖ {Ó[PÒ öPõsh 

¦ÒÎPÎÚõÀ BUP¨£mhuõS®. CÆÁõÖ £h[PÒ, vøµ¨£ha \mhP[PÒ,  

]zvµ[PÒ Aø\Åmha \mhP[PÒ ÷£õßÓ PoÛ ]zvµÁiÂ»õÚ 

uµÄPÒ £À÷ÁÖ {Ó[PøÍU öPõsi¸US®. R÷Ç Põmh¨£mkÒÍ £h® 

JßÖUöPõßÖ ÷ÁÖ£mh  {Ó[PøÍU  öPõshuõS®.
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 E¸ 3.17  £h[PÎÀ EÒÍhUP¨£mkÒÍ {Ó[PÐ® AÁØÖUS›¯ C¸©     

              Gs  ö£Ö©õÚ[PÐ®

J¼z  (Sound) uµÄPÒ

 R÷Ç²ÒÍ E¸ÂÀ Põmh¨£mhÁõÖ ^E¸ 3'18& C»zvµÛ¯À 

J¼ö£¸UQ°ß ‰»® öÁÎÂh¨£k® J¼, ö£õxÁõP Jzvø\ Aø»¯õP 

ÁøP SÔUP¨£k®. GÛÝ®, PoÛ°À EÒÍ AøÚzxz uµÄPÐ® 

GsnÍÂ»õÚ uµÄPÍõøP¯õÀ AøÁ ø£mkPÎÀ u¯õºö\´¯¨£k®. 

CÆÁõÖ  J¼, C»UP•øÓz uµÁõP ©õØÕk ö\´¯¨£k®. J¼²® CÆÁõÖ 

0,1 BQ¯ÁØÓõÀ Aø©¢u ¤ØÖU ÷Põ»[PÎÚõÀ ÁøPSÔUP¨£k®.

    

2 Sec1 Sec

1

0

(1, -1)
=
0001 0000

(3, 1)
=
0011 1111

J¼ Aø©¢u uµÄPÒ 

C»UP•øÓUS ©õØÓ¨£hÀ

 

         

   E¸  3.18  Jzvø\  uµÁõÚ  J¼, C»UP•øÓz  uµÁõP ©õØÕk ö\´¯¨£k® Âu®
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 1' “A” ö£Ö® ÁÈ C¯À¦ ASCII  SÔ•øÓ°À 1000001                                                        

GÚ ÁøPSÔUP¨£kö©Ûß “F”  GÝ® ÁÈ C¯À¦ 

     ÁøPSÔUP¨£k®  ASCII SÔ±k ¯õx @

 2' BCD (Binary  Coded Decimal) ‰»©õP ÁøPSÔUP¨£k®  

ªP¨ö£›¯ Gs ¯õx@

3' £vÚÖ© GsnõÀ ¤µv{vzxÁ¨£kzu ÷uøÁ¯õÚ ¤ØÖ 

PÎß GsoUøP GÆÁÍÄ @

4' 1000010
2
 ‰»®  ASCII CÀ  “B”  ÁøPSÔUP¨£kö©Ûß" “L” Cß ‰»® 

ÁøP SÔUP¨£k® ASCII  SÔ ¯õx @

5' PoÛ°À £¯ß£kzu¨£k® SÔ•øÓPÒ ¯õøÁ? AÁØøÓ¨ £¯ß 

£kzxÁuß CßÔ¯ø©¯õø©ø¯ ÂÍUSP'

 ö\¯Ø£õk

♦  uµÄPøÍ GkzxUPõmh £¯ß£kzu¨£k® Gs •øÓø©PÒ

Gs •øÓø©PÒ  

C¸©

Gs©

£vß©

£vÚÖ©

Gs •øÓø© Ai C»UP[PÒ

2

8

16

10

   0, 1
    0, 1, 2, 3, 4, 5, 6, 7

0, 1, 2, 3, 4, 5, 6, 7, 8, 9
0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, 
C, D, E, F

 

♦  PoÛ°À £¯ß£kzu¨£k® SÔ•øÓ 

SÔ•øÓ £¯ß£kzu¨£k® ¤ØÖPÎß 

GsoUøP

BCD   -  Binary Coded Decimal 4

ASCII    -  American Standard Code 
for Information Interchange 
Code

7

EBCDIC- Extended Binary Coded 
Decimal Interchange Code

8

Unicode 16

  ö£õÈ¨¦
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Cøn¨¦ (Appendix)
ÁÈ C¯À¦PÐUS›¯ ASCII,  EBCDIC SÔ±kPÐUS›¯ £vß©, Gs©, 

£vÚÖ© GsPÒ 

AmhÁøn  3.17 ÁÈ C¯À¦PÐUS›¯   ASCII, EBCDIC  SÔ•øÓPÐ®  AÁØÖUS›¯ 

£vß©, Gs©, £vÚÖ© GsPÐ® 

             

Decimal Hex Octal EBCDIC 
Character

ASCII
Character

Decimal Hex Octal EBCDIC 
Character

ASCII 
Character

0 0 0 NUL NUL 128 80 200
1 1 1 SOH SOH 129 81 201 a
2 2 2 STX STX 130 82 202 b
3 3 3 ETX ETX 131 83 203 c
4 4 4 PF EOT 132 84 204 d
5 5 5 HT ENQ 133 85 205 e
6 6 6 LC ACK 134 86 206 f
7 7 7 DEL BEL 135 87 207 g
8 8 10 BS 136 88 210 h
9 9 11 HT 137 89 211 i
10 A 12 SMM LF 138 8A 212
11 B 13 VT VT 139 8B 213
12 C 14 FF FF 140 8C 214
13 D 15 CR CR 141 8D 215
14 E 16 SO SO 142 8E 216
15 F 17 SI SI 143 8F 217
16 10 20 DLE DLE 144 90 220
17 11 21 DC1 DCI 145 91 221 j
18 12 22 DC2 DC2 146 92 222 k
19 13 23 TM DC3 147 93 223 l

20 14 24 RES DC4 148 94 224 m
21 15 25 NL NAK 149 95 225 n
22 16 26 BS SYN 150 96 226 o
23 17 27 IL ETB 151 97 227 p
24 18 30 CAN CAN 152 98 230 q
25 19 31 EM EM 153 99 231 r
26 1A 32 CC SUB 154 9A 232
27 1B 33 CU1 ESC 155 9B 233
28 1C 34 IFS FS 156 9C 234
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29 1D 35 IGS GS 157 9D 235
30 1E 36 IRS RS 158 9E 236
31 1F 37 IUS US 159 9F 237
32 20 40 DS Space 160 A0 240
33 21 41 SOS ! 161 A1 241
34 22 42 FS " 162 A2 242 s
35 23 43 # 163 A3 243 t
36 24 44 BYP $ 164 A4 244 u
37 25 45 LF % 165 A5 245 v
38 26 46 ETB & 166 A6 246 w
39 27 47 ESC ' 167 A7 247 x
40 28 50 ( 168 A8 250 y
41 29 51 ) 169 A9 251 z
42 2A 52 SM * 170 AA 252
43 2B 53 CU2 + 171 AB 253
44 2C 54 , 172 AC 254
45 2D 55 ENQ - 173 AD 255 [
46 2E 56 ACK . 174 AE 256
47 2F 57 BEL / 175 AF 257
48 30 60 0 176 B0 260
49 31 61 1 177 B1 261
50 32 62 SYN 2 178 B2 262
51 33 63 3 179 B3 263
52 34 64 PN 4 180 B4 264
53 35 65 RS 5 181 B5 265
54 36 66 UC 6 182 B6 266
55 37 67 EOT 7 183 B7 267
56 38 70 8 184 B8 270

57 39 71 9 185 B9 271
58 3A 72 : 186 BA 272
59 3B 73 CU3 ; 187 BB 273
60 3C 74 DC4 < 188 BC 274
61 3D 75 NAK = 189 BD 275 ]
62 3E 76 > 190 BE 276
63 3F 77 SUB ? 191 BF 277
64 40 100 Space @ 192 CO 300 {
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65 41 101 A 193 C1 301 A
66 42 102 B 194 C2 302 B
67 43 103 C 195 C3 303 C
68 44 104 D 196 C4 304 D
69 45 105 E 197 C5 305 E
70 46 106 F 198 C6 306 F
71 47 107 G 199 C7 307 G
72 48 110 H 200 C8 310 H
73 49 111 I 201 C9 311 I
74 4A 112 CENT J 202 CA 312
75 4B 113 . K 203 CB 313
76 4C 114 < L 204 CC 314
77 4D 115 ( M 205 CD 315
78 4E 116 + N 206 CE 316
79 4F 117 | O 207 CF 317
80 50 120 & P 208 D0 320 }
81 51 121 Q 209 D1 321 J
82 52 122 R 210 D2 322 K
83 53 123 S 211 D3 323 L
84 54 124 T 212 D4 324 M
85 55 125 U 213 D5 325 N
86 56 126 V 214 D6 326 O
87 57 127 W 215 D7 327 P
88 58 130 X 216 D8 330 Q
89 59 131 Y 217 D9 331 R
90 5A 132 ! Z 218 DA 332
91 5B 133 $ [ 219 DB 333

92 5C 134 * \ 220 DC 334

93 5D 135 ) ] 221 DD 335
94 5E 136 ; ^ 222 DE 336
95 5F 137 _ 223 DF 337
96 60 140 - ` 224 E0 340
97 61 141 / a 225 E1 341
98 62 142 b 226 E2 342 S
99 63 143 c 227 E3 343 T
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100 64 144 d 228 E4 344 U
101 65 145 e 229 E5 345 V
102 66 146 f 230 E6 346 W
103 67 147 g 231 E7 347 X
104 68 150 h 232 E8 350 Y
105 69 151 i 233 E9 351 Z
106 6A 152 j 234 EA 352
107 6B 153 , k 235 EB 353
108 6C 154 % l 236 EC 354
109 6D 155 _ m 237 ED 355
110 6E 156 > n 238 EE 356
111 6F 157 ? o 239 EF 357
112 70 160 p 240 F0 360 0
113 71 161 q 241 F1 361 1
114 72 162 r 242 F2 362 2
115 73 163 s 243 F3 363 3
116 74 164 t 244 F4 364 4
117 75 165 u 245 F5 365 5
118 76 166 v 246 F6 366 6
119 77 167 w 247 F7 367 7
120 78 170 x 248 F8 370 8
121 79 171 y 249 F9 371 9
122 7A 172 : z 250 FA 372
123 7B 173 # { 251 FB 373
124 7C 174 @ | 252 FC 374
125 7D 175 ` } 253 FD 375
126 7E 176 = ~ 254 FE 376
127 7F 177 " DEL 255 FF 377
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                                  AmhÁøn  3'18  ][PÍ uÛUSÔ•øÓø©
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                                         AmhÁøn  3'19  uªÌ uÛUSÔ•øÓø©
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C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

·  C»zvµÛ¯¼À £¯ß£kzu¨£k® SÔ ©mh[PøÍ AÔ¢xöPõÒÍÄ®

· Ai¨£øh u¸UP Áõ°ÀPÒ Tmk u¸UP Áõ°À SÔ±kPøÍ 

CÚ[PõnÄ®

·  §¼¯ß ÷PõøÁPøÍ ö©´{ø» AmhÁøn ‰»® PõmhÄ®

·  §¼¯ß ÷PõøÁPÐUS›¯ C»UPa _ØÖUPøÍ Áøµ¯Ä®

·  Ai¨£øhz u¸UP Áõ°ÀPÎß EuÂ²hß Tmkz u¸UP Áõ°ÀPøÍ  

{¸©õoUPÄ®

·  C»UPa _ØÖUPÐUS›¯ §¼¯ß ÷PõøÁPøÍ GÊv AÁØÖUS›¯  

ö©´{ø» AmhÁønø¯ Pmiö¯Ê¨£Ä®

·  öuõøP°kg _ØÖ GßÓõÀ GßÚ GÚ AÔ¢x öPõÒÍÄ®

·  u¸UP Áõ°ÀPÎß |øh•øÓ¨ ¤µ÷¯õP[PøÍU SÔ¨¤hÄ®

Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ

 
ö£õxÁõP, u¸UPzøu¨ £¯ß£kzv ¯õ÷uÝ® JßøÓ ÷©ØöPõÒÐ® 

÷£õx Auß ö£Ö÷£Ö 'Esø©' (True) AÀ»x 'ö£õ´' (False) GÚ Aø©uÀ 

÷Ásk®.

 

 
AßÓõh ÁõÌÂÀ E°›Ú[PÐUQøh°À öuõhº£õhÀ £À÷ÁÖ 

Âu[PÎÀ {PÌQÓx. CuØSa \ªUøbPÒ £¯ß£kzu¨£k®. £søhU Põ»z-

vÀ •µö\õ¼ ‰»©õPa ö\´v öu›ÂUP¨£kÁuØPõÚ \ªUøb ÁÇ[P¨£k®. 

AÆÁõ÷Ó {Özv øÁUP¨£mkÒÍ öuõh¸¢vß £¯n Bµ®£zøuU SÔUS® 

•P©õP öuõh¸¢x¨ £õxPõÁ»›ÚõÀ FxSÇö»õ¼ GÊ¨£¨£mk £aø\{ÓU 

öPõi²® Aø\UP¨£mk \ªUøb ÁÇ[P¨£k®. öuõh¸¢x £¯nz öuõhUPz 

xUS øPPõmi ©µzvÀ EÒÍ £aø\{Ó JÎa \ªUøb ÷Ásk®. ]Á¨¦ {Ó 

JÎa \ªUøb Põn¨£mhõÀ öuõh¸¢x {Özu¨£h ÷Ásk®.

 £n¨ö£mhPö©õßøÓz vÓ¨£uØS Cµsk \õÂPÒ £¯ß£kzu¨£k 

©õ°ß Auß PuøÁz  vÓ¨£uØS A¢u \õÂPÒ Cµsk® AÁ]¯©õÚøÁ¯õS®. 

AÆÁõ÷Ó,  AßÓõh ÁõÌÂÀ |õ® ø\øPPÎß Ai¨£øh°À wº©õÚ[PøÍ    

÷©ØöPõÒÁuØS J¨£õP÷Á PoÛ²® \ªUøbPøÍ¨ £¯ß£kzxQÓx.   

 

4
u¸UP Áõ°ÀPÐ®   §¼¯ß 

uºUP[PÐ® 

 4.1  AÔ•P®
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 }[PÒ ©QÊ¢öuõßÔÀ (÷©õmhõºU Põº) £¯n®ö\´¯ •ß£uõP 

AvÀ HÔU PuÄPøÍ |ßS CÖP¨ §miUöPõÒÁx AÁ]¯©õS®. PuÄPÎÀ 

Jß÷ÓÝ® \›¯õP¨  §mh¨£hÂÀø»ö¯ÛÀ Põmi (Indicator) ªßSªÌ 

JÎºÁuß ‰»÷©õ J¼ö¯Ê¨¦Áuß ‰»÷©õ \õµvUS \ªUøb ÁÇ[P¨£k®. 

|õßS PuÄPÐ® CÖP¨ §mh¨£mi¸¨¤ß ©mk÷© CÆÁõÖ GÊ¨£¨£k®           

ø\øP {Özu¨£k®. Cuß ¤ßÚ÷µ £¯nzøu Bµ®¤UP•i²®.÷©¾®,                                     

ÁõPÚzvß •Ø¦Ó B\ÚzvÀ A©º¢v¸¨£Áº  £õxPõ¨¦ B\Ú¨£mi 

Ao¢v¸zuÀ ÷Ásk®. CÀø»÷¯À Ax £ØÔ¯ \ªUøb GÊ¨£¨£k®.

 E°›Ú[PÐUQøh÷¯ \ªUøbPÒ ‰»©õPz öuõhº£õhÀ ÷©Ø 

öPõÒÍ¨£kÁx  ÷£õßÖ  PoÛ²hÝ®  öuõhº£õhø» ÷©ØöPõÒÍ    \ªU

øbPÒ £¯ß£kzu¨£h ÷Ásk®. AuõÁx  'ON' , 'OFF'  BQ¯ {ø»ø©PÐÒ 

JßÔß ‰»©õP C¯UPUTi¯uõP PoÛ u¯õ›UP¨£mkÒÍx. C¢u 

{ø»ø©PÒ Cµsøh²® GkzxUPõmh C¸© Gs (Binary number) 
SÔ±mk •øÓø© £¯ß£kzu¨£k®. CuØPø©¯ PoÛ°À C¢u Cµsk 

{ø»ø©PøÍ²® ÁøPSÔUP 0 ©ØÖ® 1 BQ¯ C»UP® £¯ß£kzu¨£k®. 

C[S AND, OR, NOT BQ¯ Ai¨£øh u¸UPa ö\´øPPÒ £ØÔ²® AÁØøÓ 

GkzxU Põmh¨ £¯ß£kzu¨£k® u¸UP Áõ°ÀPÒ ©ØÖ® AøÁ öuõhº£õÚ 

§¼¯ß ÷PõøÁPÒ, ö©´{ø» AmhÁøn BQ¯Ú £ØÔ²® AÔ¢x-

öPõÒ÷Áõ®. 

 4.2  u¸UP Áõ°ÀPÒ

 C¸© GsPÎß EuÂ²hß SÔ¨¤mh ]» u¸UPa ö\´øPPøÍU  

Pmiö¯Ê¨¤ AÁØÔß ‰»® £À÷ÁÖ wº©õÚ[PøÍ ÷©ØöPõÒÍUTi¯ 

_Ø÷Ó u¸UPa _ØÖPÒ ( Logic circuits) GÚ¨£k®. HµõÍ©õÚ ]UP»õÚ C»UPa 

_ØÖUPøÍ¨ £¯ß£kzv÷¯ PoÛ E¸ÁõUP¨£mkÒÍx. u¸UP Áõ°ÀPÒ 

GÚ¨£k® Ai¨£øhz u¸UPa _ØÖUPÒ £» E›¯ÁõÖ CønUP¨£m÷h 

]UP»õÚ C»UPa _ØÖ (Digital circuit) ÁiÁø©UP¨£mkÒÍx. u¸UP 

Áõ°ÀPÐUS EÒÎh¨£k® ö£´¨¦ AÀ»x ö£´¨¦PøÍ P¸zvÀöPõsk 

AuØ÷PØÓÁõÓõÚ Á¸ÂøÍÄPøÍ ÁÇ[SÁ÷u u¸UP Áõ°ÀPÎß ‰»©õP 

÷©ØöPõÒÍ¨£kQßÓx.

 
ø©¯ •øÓÁÈ A»PõÚx (C.P.U) ªP AvPÍÁõÚ uºUP Áõ°ÀPøÍU 

öPõshx.
 

u¸UP Áõ°ÀPÒ £À÷ÁÖ£mh öuõÈÝm£ •øÓPøÍ¨ £¯ß£kzv 

E¸ÁõUP¨£kQßÓÚ. AÁØÔß APz÷u²ÒÍ _ØÖ vµõß]ìµº, C¸Áõ°               

(Diode),  uøh°PÒ  BQ¯ÁØøÓU  öPõsi¸US®  (E¸ 4.1 CøÚ¨ £õºUP). 

 u¸UPÁõ°À _ØÖPÒ £¯ß£kzu¨£k® ÂuzxUPø©¯ AÁØøÓ 

Cµsk ÁøPPÍõP ÁøP¨£kzu»õ®.
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1.  Ai¨£øhz u¸UP Áõ°ÀPÒ ( Basic Logic gates)

2.  ÷\º©õÚz u¸UP Áõ°ÀPÒ (Combinational Logic gates)

E¸ 4.1 Ai¨£øhz u¸UP Áõ°ÀPÒ öPõsh _ØÖ

 4.3  Ai¨£øh   u¸UP  Áõ°ÀPÒ

§¼¯ß ö\´øPPÍõÚ  OR, AND, NOT  BQ¯ÁØøÓ¨ ö£ÍvP Ÿv¯õP Gkzx-

øµUP Ai¨£øhz u¸UP Áõ°ÀPÒ £¯ß£kzu¨£k®. Ai¨£øhz u¸UP 

Áõ°ÀPÒ ‰ßÖ ÁøP¨£k® AøÁ Á¸©õÖ:

1. AND Áõ°À   (AND  gate)

2. OR Áõ°À     (OR  gate)

3. NOT Áõ°À    (NOT  gate)

4.3.1  AND Áõ°À (AND gate)

 

 AND u¸UPzøu ÂÍ[QU öPõÒÍöÁÚ¨ ¤ßÁ¸® Euõµn[PøÍU 

P¸zvØ öPõÒ÷Áõ®.

 

>
>

>
>

> >

>

>
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 E[PÍx PoÛ B´ÄThU PuÂØS §mk, Bø©¨§mk BQ¯Ú 

Ch¨£mk §mh¨£mi¸¨¤ß PuøÁz vÓ¨£uØS PuÂ¾ÒÍ §miß vÓ¨¦, 

Bø©¨§miß vÓ¨¦ BQ¯Ú AÁ]¯©õS®. C¢u Cµsk \õÂPøÍ²® 

£¯ß£kzvÚõÀ ©mk÷© A¢uU PuøÁz vÓUP•i²®. PuÂ¾ÒÍ §miß 

vÓ¨¦ AÀ»x Bø©¨§miß vÓ¨¦ BQ¯ÁØÖÒ JßøÓ ©mk® £¯ß£kzv 

A¢uU PuøÁ vÓUP •i¯õx. ÷©¾®, \õÂPÒ CßÔ²® A¢u PuøÁz vÓUP 

•i¯õx. 

AND ö\´øPø¯ ÂÍ[QUöPõÒÍ R÷Ç uµ¨£mkÒÍ öuõhº{ø»°»õÚ ªß 

_ØÔøÚU P¸x÷Áõ®.

E¸ 4.2  A , B  BQ¯ ö£´¨¦PÎß                            

u¸UPa \¢uº¨£® 0 BPÄÒÍuõÚ                     

ªß_ØÖ

Q

  E¸ 4'4  AND u¸UP 

Áõ°¼ÝÒÍ  ªß_ØÖ

E¸ 4'3  A , B BQ¯ ö£´¨¦PÎß                            

u¸UP \¢uº¨£®  1 BPÄÒÍuõÚ 

ªß_ØÖ     

 C[S A, B BQ¯ BÎPÐ® Q GÝ® ªßSªÊ® E»ºP»® ‰»® 

öuõhº{ø»°À CønUP¨£mkÒÍÚ. Cµsk BÈPøÍ²® ö£´¨£õPÄ® 

ªßSªøÇ £¯¨£õPÄ® öPõÒ÷Áõ®.

 C[S A, B BQ¯ BÎPÒ Cµsk® ‰i¯ {ø»°À EÒÍ÷£õx 

ªßSªÌPÒ JÎ¸®. A AÀ»x B BQ¯ BÎPÐÒ JßÖ ©mk® ‰i¯ 

{ø»°À EÒÍ ÷£õx ªßSªÌ JÎµõx. ÷©¾®, Cµsk BÎPÐ® vÓ¢u 

{ø»°À EÒÍ÷£õx® ªßSªÌ JÎµõx. C¢ua ö\¯ß•øÓø¯ ¤ßÁ¸©õÖ 

AmhÁøn¨£kzu»õ®.

 JÆöÁõ¸ BÎ²® ‰i²ÒÍ \¢uº¨£® AÀ»x ªßSªÌ JÎ¸® 

\¢uº¨£zøu    '1' GÝ® u¸UP® ‰»©õPÄ® (E¸ 4.3 CøÚ¨ £õºUP) JÆöÁõ¸ 

BÎ²® vÓ¢xÒÍ {ø» AÀ»x ªßSªÌ JÎµõu {ø» '0' GÝ® u¸UP® 

Q

Q
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‰»©õPÄ® (E¸ 4.2 CøÚ¨ £õºUP) ÁøPSÔUS®÷£õx AND u¸UP¨ Áõ°¼ß  

EÒÏk, Á¸ÂøÍÄ BQ¯Ú ¤ßÁ¸® AmhÁøn 4.1 CÀ Põmh¨£mkÒÍx.

             A              B            Q
vÓ¢u {ø»    vÓ¢u {ø»      JÎµõx

vÓ¢u {ø»    ‰i¯ {ø»      JÎµõx

‰i¯ {ø»    vÓ¢u {ø»      JÎµõx

‰i¯ {ø»    ‰i¯ {ø»      JÎ¸®

AmhÁøn 4.1  AND CøÚ Jzu ªß_ØÔÀ ªßSªÈß JÎºÄ

AmhÁøn 4.2  AND u¸UP 

Áõ°¾US›¯    ö©´{ø» 

AmhÁøn           

 

A B Q
0 0 0
0 1 0
1 0 0
1 1 1      

C[S A,B BQ¯ EÒÏkPÒ Cµsk® '1' GÝ® 

u¸UPzvÀ EÒÍ÷£õx ©mk÷© Q=1 BS®. 

C¢u Cµsk EÒÏkPÐ® 0 BS®÷£õx® J¸ 

EÒÏmiß  u¸UP® 1 BPÄ® ©Ö EÒÏmiß 

u¸UP® 0 BPÄ® EÒÍ÷£õx Q=0 BS®.    C¢u   

AmhÁøn   AND   Áõ°¾US›¯ ö©´{ø»    

AmhÁøn (Truth table) GÚ¨£k®.

AÁuõÛ¨¦ 

 AND Áõ°¼ß Á¸ÂøÍÄ 0 BÁuØS SøÓ¢ux 

J¸ EÒÎkøP÷¯Ý® 0 BP C¸UP÷Ásk®.

 C¢u u¸UP Áõ°À, Cµsk EÒÎkøPPøÍU öPõskÒÍuõÀ Am-

hÁøn°À |õßS (22 = 4) \¢uº¨£[PÒ Põmh¨£mkÒÍÚ.

AND Áõ°¼ß u¸UP[PÍõP A, B  BQ¯Ú Aø©¢v¸US® (A  AND  B). §¼¯ß 

C»UPªh¼ØPø©¯ Cx A.B GÚz uµ¨£k®. 

AND Áõ°¾US›¯ Ai¨£øh  §¼¯ß÷PõøÁ ©ØÖ® AND Áõ°¼ß SÔ±k 

BQ¯Ú Á¸©õÖ.
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A

B
Q = A.B

E¸  4.5  AND Áõ°¾US›¯ §¼¯ß 

Am\µPou ÷PõøÁ²® SÔ±k®

>

>
>

 C¢u AND Áõ°¼À SøÓ¢ux Cµsk EÒÏkPÒ EÒÍÚ. Cµsi¾® 

Ti¯ GsoUøP öPõsh  EÒÏkPÐhõÚ AND u¸UP Áõ°ÀPÐ® EÒÍÚ. 

‰ßÖ EÒÏkPøÍU öPõsh AND u¸UP Áõ°À R÷Ç uµ¨£mkÒÍx.

  ö\¯Ø£õk

1.  A, B , C  GÚ ‰ßÖ EÒÏkPÒ EÒÍ÷£õx   Q GÝ®  

 Á¸ÂøÍøÁ¨ ö£ÖÁxhß öuõhº£õÚ AND u¸UP Áõ°À   

 R÷Ç Põmh¨£mkÒÍx' (E¸ 4'6)

C¢u AND u¸UPÁõ°À ¤ßÁ¸® _ØÔÀ \©¨£kzu¨£mkÒÍx' 

  A
           Q
 
          
                 
      E¸ 4'7

»' C[S A, B BQ¯ÁØÔøÚ EÒÏkPÍõPU öPõsh AND u¸UP Áõ°¼ß  

Á¸ÂøÍÁõÚ P CøÚ GkzxU PõmkP.

»»' P, C BQ¯Ú EÒÏkPÍõP Aø©¢u  AND u¸UP Áõ°¼ß Á¸ÂøÍÁõÚ 
Q CøÚ GÊxP'

»»»' C[S, Q Cß ö£Ö©õÚ® ÷©÷» SÔ¨¤mh A, B , C  BQ¯ ‰ßÖ 

EÒÏkPÐhÚõÚ AND u¸UP Áõ°¼ß Á¸ÂøÍÄUSa \©©õS®'

 BP÷Á, C¢u _ØÖUS›¯ §¼¯ß÷PõøÁ Á¸©õÖ

 Q = A.B.C
 ÷©ØTÓ¨£mh _ØÖUS›¯ ö©´{ø» AmhÁøn°ÀGmk ^2

3 = 8&  

\¢uº¨£[PÒ EÒÍÚ. R÷Ç EÒÍ AmhÁøn°ß CøhöÁÎPøÍ¨ 

§µn¨£kzxP. 

A
B
C

Q = A.B.C 

E¸ 4'6 - ‰ßÖ EÒÏkPøÍU öPõsh AND u¸UP Áõ°À 

>
>
>

>

>

> >

>
>

>

P

C
B
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2' }[PÒ  CuØS •ßÚº PØÓ 2 EÒÏkPÐhÚõÚ AND Áõ°¼ß 

ö©´{ø» AmhÁøn°ß EuÂ²hß A.B {µÀPøÍ¨ §µn¨ 

£kzu»õ®. ¤ßÚº  A.B.C °øÚ¨ §µn¨£kzxP'

                

A B C A.B   Q=A.B.C
0 0 0   0 ......
0 0 1 ......   0
0 1 0   0 ......
0 1 1 ...... ......
1 0 0   0   0
1 0 1 ...... ......
1 1 0 ......   0
1 1 1 ...... ......

AmhÁøn 4'3 - ‰ßÖ EÒÏkPøÍU öPõsh  AND u¸UP Áõ°¾U 

S›¯ ö©´{ø» AmhÁøn 

4.3.2  OR  Áõ°À (OR gate)
OR  u¸UPzøu ÂÍ[QUöPõÒÍ ¤ßÁ¸® EuõµnzøuU P¸zvØöPõÒ÷Áõ®.

 ² Cµsk Áõ\ÀPøÍ²øh¯ ÷£¸¢vÀ £¯oUSö©õ¸Áº •ß   Áõ\¼Úõ÷»õ          

 ¤ß Áõ\¼Úõ÷»õ CÓ[P»õ®.

 ²  P Gß£Á›ß  ÃmkUSa ö\ÀÁuØS £À÷ÁÖ £õøuPÒ Põn¨£k©õ°ß    

A¢u  £õøuPÎÀ GuÞhõP÷ÁÝ® AÁº uÚx Ãmøh Aøh¯ •i²®.

 ² ¤ßÁ¸® GÎ¯ ªß_ØöÓõßøÓU P¸zvØ öPõÒ÷Áõ®. (E¸ 4.8, E¸ 4.9 I 

AÁuõÛUP).
       
 C[S A,B BQ¯ BÎPÒ, ªßSªÌ Q BQ¯ Cµsk® 

E»ºP»[PÐhß \©õ¢uµ©õP CønUP¨£mkÒÍÚ. Cµsk BÎPøÍ²® 

EÒÏhõPÄ® ªßSªøÇ Á¸ÂøÍÁõPÄ® P¸x÷Áõ®.

E¸ 4'8 -- Cµsk EÒÏkPÎÀ JßÖ  

u¸UPa  \¢uº¨£® 1 BS® ÷£õuõÚ 

ªß_ØÖ

E¸ 4'9 --- Cµsk EÒÏkPÎß u¸U-

Pa  \¢uº¨£® 0 BS® ÷£õuõÚ ªß_ØÖ
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C¢ua _ØÔÀ BÎ A ÷¯õ BÎ B ÷¯õ BÎPÒ A, B BQ¯ Cµsk÷©õ 

‰h¨£mkÒÍ \¢uº¨£zvÀ ©mk® C¢ua _ØÔÀ ªßSªÌ JÎ¸®. CuøÚ¨ 

¤ßÁ¸©õÖ (AmhÁøn 4.4) AmhÁøn°À Põmh»õ®.

    
 

     A           B           Q
 vÓ¢u {ø» vÓ¢u {ø»    JÎµõx

 vÓ¢u {ø» ‰i¯ {ø»    JÎ¸®

‰i¯ {ø» vÓ¢u {ø»    JÎ¸®

‰i¯ {ø» ‰i¯ {ø»    JÎ¸®

              AmhÁøn 4.4. - OR PøÍ Jzu  ªß_ØÔÀ ªßSªÈß JÎºÄ

JÆöÁõ¸ BÎ²® ‰i¯{ø»°À EÒÍ÷£õx AÀ»x ªßSªÌ JÎ¸® 

\¢uº¨£® (E¸ 4.8) 1 GÝ® u¸UP®    ‰»©õPÄ® BÎö¯õßÖ vÓ¢xÒÍ 

{ø» AÀ»x ªßSªÌ JÎµõu{ø» EÒÍ \¢uº¨£® (E¸ 4.9) 0 GÝ® u¸UP® 

‰»©õPÄ® GkzxU Põmk®÷£õx AuøÚ¨ ¤ßÁ¸©õÖ AmhÁøn¨£kzu 

•i²®. C¢u AmhÁøn OR  u¸UP Áõ°¾US›¯ ö©´{ø» AmhÁøn 

(Truth table) GÚ¨£k®. ( AmhÁøn 4.5 CøÚ¨ £õºUP ) 

                          

A B Q
0 0 0
0 1 1
1 0 1
1 1 1

    AmhÁøn 4.5  OR  u¸UP Áõ°¾US›¯ ö©´{ø» AmhÁøn

AÁuõÛ¨¦

 OR Áõ°¼ß Á¸ÂøÍÄ 1 BP Aø©ÁuØSU 

SøÓ¢ux J¸ EÒÏ÷hÝ® 1 BP Aø©¢v¸UP 

÷Ásk® 

 ÷©÷» OR Áõ°¼ß EÒÏkPÒ Cµsk® 0 BP EÒÍ÷£õx G¨÷£õx® 

Á¸ÂøÍÄ 0 BP C¸US®. ÷©¾®,  JßÖUS ÷©Ø£mh EÒÏkPøÍU 

öPõsh OR Áõ°¼À A¢u EÒÏkPÒ AøÚzx® 0 BP EÒÍ÷£õx Á¸ÂøÍÄ  

0 BS®.  

 ÷©÷» AmhÁøn 4.5 CØPø©¯ A=1  AÀ»x B = 1 AÀ»x  C = 1 
BS®÷£õx Q=1 BS®. C¢u AmhÁøn OR u¸UP Áõ°¾US›¯ ö©´{ø» 

AmhÁøn GÚ¨£k®.
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C¢ua ö\´øP §¼¯ß Am\µPouzvÀ “A + B” GÚU SÔ±mk ÁiÂÀ 

Põmh¨£k®. Cx }[PÒ Pou £õhzvÀ GsPøÍU TmkÁuØöPÚ¨ 

£¯ß£kzu¨£k® TmhÀ Pouaö\´øP AßÖ. ÷©¾®, ÷|öµsPøÍU 

SÔ¨¤h  ÷|º Aøh¯õÍ® £¯ß£kzu¨£hõx. Ax “ A  AÀ»x  B” AÀ»x                                 

“ A OR  B” GÚ÷Á Ea\›UP¨£k®.

OR u¸UP Áõ°¾US›¯ §¼¯ß ÷PõøÁ²® _ØÖ Á›¨£h•® E¸ 4.10 CÀ 

Põmh¨£mkÒÍx.

A

B
Q =A+B

>

>
>

E¸ 4.10  OR u¸UP¨ £hø»US›¯ §¼¯ß Am\µPouU ÷PõøÁ²® SÔ±k®

A, B,C  GÚ ‰ßÖ EÒÏkPÒ uµ¨£kªhzx Q GÝ® Á¸ÂøÍøÁ¨ 

ö£ÖÁuØS›¯ OR  u¸UPa _ØÖ Á¸©õÖ ^E¸ 4'11& 

 

 
 1'CuØS›¯ §¼¯ß ÷PõøÁø¯ GÊxP.

 2'÷©÷» ö£ÓzuUP Á¸ÂøÍÄPÐUPõÚ ö©´{ø» AmhÁønø¯   

   GÊxP.

                 

E¸ 4'11 -- ‰ßÖ  EÒÏkPøÍU öPõsh OR u¸UP Áõ°À

 

A
B
C

Q

A
B

C
Q

  ö\¯Ø£õk

>
>
>

>

>
>

>
>
>

>

4.3.3  NOT  Áõ°À (NOT  gate)

 NOT u¸UPÁõ°À £ØÔU PÁÚzvØ öPõÒÐ®÷£õx {µ¨¦ \ªUøb 

£ØÔ AÔ¢xöPõÒÁx AÁ]¯©õS®. EÒÏmiß ‰»® ÁÇ[P¨£k® u¸UPa                

\ªUøbø¯ CÚ[Psk AuØS›¯ {µ¨¦ \ªUøbø¯ Á¸ÂøÍÁõP 
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ÁÇ[SÁ÷u NOT Áõ°¼ß öuõÈØ£õhõS®. C[S Cµsk \ªUøbPÎÀ 

H÷uÝö©õßÖ ©ØøÓ¯uß {µ¨¤ (Complement) GÚ¨£k®. AuõÁx “ 0 ” Cß 

{µ¨¤ “1” BS®. “1”  Cß {µ¨¤ “ 0 ” BS®.

EÒÏk ö\´¯¨£k® u¸UP¨ ö£Ö©õÚzvß {µ¨¤ø¯ Á¸ÂøÍÁõP¨ 

ö£ÖÁuØS £¯ß£kzu¨£k® C»zvµÛ¯À xønUT÷Ó NOT Áõ°»õS®. 

¤ßÁ¸®  _ØøÓU P¸zvØ öPõÒ÷Áõ®. (E¸ 4.12 CøÚ¨ £õºUP)

R

E¸ 4.12  NOT.  u¸UP Áõ°¾UPõÚ  C»zvµÛ¯Ø _ØÖ  

QA

 C[S BÎ A  ‰i¯ {ø»°À EÒÍ÷£õx ªßSªÈÞhõP ªß÷Úõmh® 

£õ¯õu PõµnzvÚõÀ Ax JÎµõx. GÛÝ®, BÎ vÓ¢u {ø»°À EÒÍ÷£õx 

ªßSªÌ JÎ¸®. C[S EÒÏk A BP Aø©²®÷£õx A  Cß {µ¨¤ ( A ) 
Á¸ÂøÍÁõS®. NOT ö\´øPUS›¯ §¼¯ß ÷PõøÁ, _ØÖ Á›¨£h® BQ¯Ú 

E¸ 4.13 CÀ Põmh¨£mkÒÍx. 

E¸ 4'13 - NOT u¸UP Áõ°¾US›¯ §¼¯ß Am\µPouU ÷PõøÁ²® SÔ±k®

A Q = A> >

NOT Áõ°¾US›¯ ö©´{ø» AmhÁøn ¤ßÁ¸©õÖ Aø©²® (AmhÁøn 4.6)

A Q
0 1
1 0

                  
AmhÁøn 4.6  NOT u¸UP Áõ°¾US›¯ ö©´{ø» AmhÁøn
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4.4  Tmkz  u¸UPÁõ°ÀPÒ

 C»UP•øÓU PoÛ, Po¨£õß, \»øÁ C¯¢vµ®, ~snø» 

Ak¨¦, øP¯hUPz öuõø»÷£], |ÃÚ öuõø»UPõm]PÒ, C»UP•øÓU 

PiPõµ[PÒ, ÁÎ£uÚ©õUQPÒ BQ¯ÚÁØÔß  öuõÈØ£õk u¸UP Áõ°ÀPÎß 

öuõÈØ£õmiÀ u[Q²ÒÍx. ÷uøÁ¯õÚ ]UPÀ {ø»zu u¸UP® E¸ÁõS® 

ÁøP°À £À÷ÁÖ ÁøP¨£mh u¸UP Áõ°ÀPøÍ Cønzxz u¯õ›UP¨£mh 

C»zvµÛ¯À _ØÖPÒ AÁØÔÀ EÒÍÚ. Ai¨£øhz u¸UP Áõ°ÀPøÍ¨ 

£¯ß£kzv÷¯  CÆÁõÓõÚ  Tmkz u¸UPÁõ°ÀPÒ Aø©UP¨£kQÓx.

4.4.1  NOR  Áõ°À  (NOR gate)
 

 OR ö\´øP°ß {µ¨¤a ö\´øP AuõÁx NOT OR ö\´øP°ß u¸UP 

Áõ°À NOR Áõ°ö»Ú¨£k®. Cuß÷£õx OR Áõ°¼ß Á¸ÂøÍøÁ NOT 
Áõ°¾US ö\¾zv NOT Áõ°¼ß ‰»® Á¸ÂøÍøÁ¨ ö£ÓzuUP ÁøP°À 

NOT  OR  BQ¯Ú Cµsøh CønUS®÷£õx QøhUS® u¸UP® NOR  

Áõ°¼ß u¸UP©õS®. CuøÚ ¤ßÁ¸©õÖ Põmh»õ®. (E¸ 4.14)

A

B
 Q = BA+

Q1=A+B

E¸ 4'14 - NOR  u¸UP Áõ°¾UPõÚ u¸UPa _ØÖ

>

>
> >

Ai¨£øh ö©´{ø» AmhÁøn°ß EuÂ²hß CuØS›¯ ö©´{ø»                 

AmhÁønø¯ ¤ßÁ¸©õÖ Pmiö¯Ê¨£»õ®. (AmhÁøn  4.7 CøÚ¨ 

£õºUP).

A B   Q1 = A+B Q = A+B
0 0 0 1
0 1 1 0
1 0 1 0
1 1 1 0

AmhÁøn 4.7 - Ai¨£øh ö©´{ø» AmhÁøn°ß Ai¨£øh°À NOR u¸UP 

Áõ°¼ØS›¯ ö©´{ø» AmhÁøn   
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 ÷©÷»  NOR   u¸UP  Áõ°ÀPÎß EÒÏkPÒ Cµsk® 0 
BS®÷£õx Á¸ÂøÍÄ 1 BS®. AÆÁõ÷Ó CµskUS 

÷©Ø£mh EÒÏkPøÍU öPõsh OR u¸UP Áõ°ÀPÎÀ  

EÒÏkPÒ AøÚzx® 0 BS®÷£õx Á¸ ÂøÍÄ 1 BP 

Aø©¢v¸US®.

AÁuõÛ¨¦

CuØPø©¯  NOR  Áõ°ÀPÒ  Cµsk Jß÷ÓõöhõßÖ öuõhº{ø»°À                      

Cøn ¢xÒÍ   OR  ,  NOT Áõ°ÀPÒ CµsiØS \©Á¾ÁõÚx. NOR Áõ°¼ØS›¯ 

§¼¯ß ÷PõøÁ ©ØÖ® u¸UPU SÔ±k E¸ 4.15 CÀ Põmh¨£mkÒÍx.

A

B
Q = BA+

>

>
>

  

E¸ 4.15 NOR u¸UP uµÄUS›¯ §¼¯ß ÷PõøÁ²® SÔ±k®.

CuØS›¯ u¸UPa _ØÖ, ö©´{ø» AmhÁøn BQ¯Ú AmhÁøn 4.8 CÀ 

Põmh¨£mkÒÍx.

      

A B Q
0 0 1
0 1 0
1 0 0
1 1 0

AmhÁøn 4.8 - NOR u¸UP Áõ°¾US›¯ ö©´{ø» AmhÁøn
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A, B, C  GÚ ‰ßÖ EÒÏkPÒ Põn¨£k® {ø»°À, Q  GÝ® 

ö£Ö©v°øÚ¨ ö£ÖÁuØS›¯ u¸UPa _ØÖ E¸ 4.16 CÀ Põm-

h¨£mkÒÍx. 

 

  

 1' CuØS›¯ §¼¯ß ÷PõøÁø¯ GÊxP.
 
 2'÷©Ø£i Á¸ÂøÍøÁ¨ ö£ÖÁuØPõÚ ö©´{ø» AmhÁønø¯   

    GÊxP.

  ö\¯Ø£õk

AA
B
C

B

C

Q  = A+B+C

Q  = A+B+C

E¸  4.16 ‰ßÖ EÒÏkPøÍU öPõsh NOR u¸UP Áõ°À 

>
>
>

>

>
>

>
>
>

> >

4.4.2  NAND  Áõ°À  (NAND  gate)
 NAND ö\´øPø¯ ÂÍ[QUöPõÒÍ E¸ 4.17 CÀ Põmh¨£mh GÎ¯ 

ªß_ØøÓU P¸x÷Áõ®.

A B

Q

E¸ 4.17 NAND u¸UP Áõ°¾UPõÚ ªß _ØÖ

  C[S  A, B BQ¯ BÎPÒ, Q GÝ® ªßSªÌ BQ¯Ú GÎ¯ ªß 

P»[PÐhß CønUP¨£mkÒÍÚ. Cµsk BÎPøÍ²® EÒÏhõPÄ® ªß 

SªøÇ Á¸ÂøÍÁõPÄ® öPõÒ÷Áõ®. C[S A, B BQ¯ BÎPÒ ‰i²ÒÍ 

{ø»°À ©mk÷© ªßSªÌ JÎµõx. HøÚ¯ GÀ»õa \¢uº¨£[PÎ¾® 

ªßSªÌ JÎ¸®. C¢u ö\¯ß•øÓø¯ AmhÁøn°À ¤ßÁ¸©õÖ Põm-

h»õ®.

AND ö\´øP°ß {µ¨¦ ö\´øP AÀ»x NOT,   AND ö\´øPUS›¯  u¸UPÁõ°À  

NAND u¸UPÁõ°À GÚ¨£k®. C[S AND  Áõ°¼ß Á¸ÂøÍøÁ NOT 
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Áõ°¾hß öuõhº{ø»°À Cøn¨£uõÀ NAND Áõ°À E¸ÁõUP¨£kQÓx. 

Ax ¤ßÁ¸©õÖ Põmh¨£h»õ®. (E¸ 4.18)

Q1 = A.B

Q = A.B
A

B

>

>
> >

          E¸ 4.18 -- NAND u¸UP Áõ°¾UPõÚ u¸UPa _ØÖ 

Ai¨£øh u¸UP Áõ°ÀPÐUS›¯ ö©´{ø» AmhÁøn°À C¢u u¸UPz 

xUS›¯ ö©´{ø» AmhÁønø¯ ¤ßÁ¸©õÖ Pmiö¯Ê¨£»õ®. (Am-

hÁøn 4.9 CøÚ¨ £õºUP).

A B Q = A.B Q = A.B
0 0 0 1
0 1 0 1
1 0 0 1
1 1 1 0

AmhÁøn 4.9  Ai¨£øh ö©´{ø» Ai¨£øh°ß 

EuÂ²hß NAND u¸UP Áõ°¼ØPõÚ ö©´{ø» 

AmhÁøn

CuøÚ GkzxU Põmk® §¼¯ß ÷PõøÁ²® SÔ±k® R÷Ç Põmh¨£mkÒÍÚ. 

(E¸ 4.19 CøÚ¨ £õºUP).
A

B
Q = A.B

>

>
>

E¸ 4.19 NAND u¸UP Áõ°¼ØS›¯ §¼°ß ÷PõøÁ²® SÔ±k®.

NAND u¸UP  Áõ°¼ß ö©´{ø» AmhÁøn  R÷Ç Põmh¨£mkÒÍx.

A B Q = A.B
0 0 1
0 1 1
1 0 1
1 1 0

AmhÁøn 4.10 -  NAND u¸UP Áõ°¼ØPõÚ ö©´{ø» AmhÁøn
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NAND u¸UP Áõ°¼ß EÒÏkPÒ Cµsk® 1 BP 

Aø©²ªhzx G¨÷£õx® Á¸ÂøÍÄ 0 BS®.

AÁuõÛ¨¦

 
1.  A, B, C  BQ¯  EÒÏkPÒ ‰ßÖ EÒÍ÷£õx Q GÝ® Á¸ÂøÍÄU 

   S›¯  u¸UPa _ØÖ Á¸©õÖ 

E¸  4.20 ‰ßÖ EÒÏkPøÍU öPõsh NAND u¸UP Áõ°À 

1' CuØS›¯ §¼¯ß ÷PõøÁø¯ GÊxP.

2'  CuØS›¯ Á¸ÂøÍÂß ö©´{ø» AmhÁønø¯U GÊxP.

  ö\¯Ø£õk

A
B
C

A

B

C

Q = A.B.C Q = A.B.C
>
>
>

>

>
> >

> > >>

 4.5  §¼¯ß ÷PõøÁ²hß öuõhº£õÚ u¸UPa _ØÖPøÍ 

          {¸©õozuÀ

  Q = A.(A +B)+B  GÝ® §¼¯ß Am\µU PouU ÷PõøÁø¯¨ ö£ÖÁuØS 

u¸UP Áõ°ÀPÒ öPõsh _ØÔøÚ Aø©¨÷£õ®. 

 C¢ua _ØÔÀ A, B GÚ Cµsk EÒÏkPÒ EÒÍÚ. §¼¯ß ÷PõøÁUS›¯ 

u¸UPa _ØÖ Á¸©õÖ (E¸ 4.21) 

 
E¸ 4.21 Q = A.(A+B)+B GÝ® §¼¯ß Am\µU PouU ÷PõøÁUS›¯ _ØÖ.

A

B
Q = A.(A+B)+B

A
A

A+B

B

A.( A+B )

B
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01. ¤ßÁ¸® §¼¯ß ÷PõøÁUS›¯ u¸UPa _ØÖUPøÍ          

  Áøµ¢x ö©´{ø» AmhÁønø¯ E¸ÁõUSP.

      (a)  A+A.B
         (b)  A.(A+B)
         (c)  (A+B).(A.C)

      02. ¤ßÁ¸® u¸UPa _ØÖUS›¯ §¼¯ß ÷PõøÁø¯ GÊv                        

   AuØS›¯ ö©´{ø» AmhÁønø¯ E¸ÁõUSP.

      

     

 (a).

(b).

(c)

A

B
Q

A
B

Q

A

B
Q

C

   ö\¯Ø£õk
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(d).

(e)

(f)

A B C

Q

A
B
C

Q

A
B

Q

 

C¢ua  \¢uº¨£zvÀ  }[PÒ  PØÓ u¸UP Áõ°ÀPÒ AøÚzøu²® 
Multimedia Logic (MM Logic) ö©ßö£õ¸øÍ¨ £¯ß£kzv 

Áøµ¢x Auß EÒÏmk¨ ö£Ö©õÚ[PÐUPø©¯ öuõÈØ£õmøh 

AÁuõÛUP.  (http://www.softronix.com/logic.html)

     ö\¯Ø£õk
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 4.6 u¸UPz öuõøP°kg _ØÖPÒ (Integrated Circuits)

 C»zvµÛ¯Ø _ØÖUPøÍ E¸ÁõUPz ÷uøÁ¯õÚ C»zvµÛ¯À TÓõP 

öuõøP°kg _ØÔøÚU (IC) SÔ¨¤h»õ®. ÷©¾®, Cx ]UP»õÚ C»zvµÛ¯À 

_ØÖ¨  £SvPøÍU öPõshuõS®. Euõµn©õP |ÃÚ öuõø»UPõm], øP¯h-

UPz öuõø»÷£] ÷£õßÓÁØÔÀ _ØÖ¨ £SvPÒ HµõÍ©õP Põn¨£kQÓx. 

vµõß]ìµºPÒ (Transistors), uøh°PÒ (Resistors), öPõÒÍÍÂPÒ (Capacitors)  
C¸Áõ°PÒ (Diodes)  BQ¯ÁØøÓU öPõshx® SÔ¨¤mh öuõÈØ£õöhõßøÓ 

BØÖÁuØöPÚz u¯õ›UP¨£mhx©õÚ Â÷\h _ØÓõP öuõøP°kg _ØÖ 

P¸u¨£kQßÓx. J¸ _ØÖ¨ £Svø¯ •Êø©¯õP J¸ PÁ\zvÀ Cmkz u¯õ›U-

PUTi¯ öuõÈÝm£ •øÓPÒ uØ÷£õx £¯ß£kzu¨£kQßÓÚ. CÆÁõÖ 

u¯õ›UP¨£k® _Ø÷Ó öuõøP°kg _ØÖ GÚ¨£k®.

  ~s•øÓ ÁÈ¯õUQ°À (Microprocessor) u¸UP Áõ°ÀPøÍU öPõsh 

öuõøP°kg _ØÖUPÒ HµõÍ©õPU Põn¨£k®. (E¸ 4.23 I AÁuõÛUP).

 C¢uz öuõøP°kg _ØÔÀ u¸UPÁõ°Ø _ØÖPÒ EÒÍh[Q°¸US®. 

Euõµn©õP E¸ 4.22 CÀ AND Áõ°À £¯ß£kzu¨£k®  u¸UP öuõøP°kg 

_ØÖU Põmh¨£mkÒÍx. CÆÁõÖ GÀ»õ ÁøPz u¸UP Áõ°ÀPÐ® 

EÒÍh[Q¯ÁõÓõP Aø©UP¨£mh öuõøP°kg _ØÖPÐ® EÒÍÚ.

E¸ 4.22  AND Áõ°ÀPøÍ 

öPõsh u¸UP öuõøP°kg _ØÖ              

E¸ 4.23  öuõøP°kg _ØÔß     

    ¦Óz÷uõØÓ®

 C¢uz öuõøP°kg _ØÖPÎÀ (E¸ 4.22 ø¯¨ £õºUP) 1, 2, 4, 5, 9, 10, 12, 
13 BQ¯ •øÚPÒ (Pins) EÒÏkPÍõS®. Cv¾ÒÍ 3, 6, 8, 11 BQ¯ •øÚPÒ 

Á¸ÂøÍÄPÍõS®. ÷©¾®,  E¸ 4.23 CÀ 16 •øÚPÒ öPõsh öuõøP°kg                 

_ØÔß ¦Óz÷uõØÓ® Põmh¨£mkÒÍx.
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  ö\¯Ø£õk

 1. ¤ßÁ¸® öuõøP°kg _ØøÓU (IC) (E¸ 4.24) P¸xP.

 

14

1

13 12 11 10 9 8

2  3 4 5  6  7

 
E¸ 4.24 NOR u¸UP öuõøP°k® _ØÖ

÷©÷» Põmi¯ _ØÔÀ 1, 2, 3 BQ¯ •øÚPøÍU P¸zvØ öPõÒÐ®÷£õx 

•øÚPÒ 2 = 0, 3 = 0 BSö©Ûß •øÚ 1 ¯õuõ°¸US®?

02. R÷Ç uµ¨£mkÒÍ  öuõøP°kg  _ØÔÀ  (IC)  (E¸ 4.25)  1, 2 BQ¯ 

•øÚPÎÀ, •øÚ   1= 1, 2 = 1 BSö©Ûß •øÚ 3 ¯õuõ°¸US®? 

                    

14 13 12 11 10 9 8

2  3  4  5  6  71

                      E¸ 4.25 NAND u¸UP öuõøP°kg _ØÖ

 4.7 u¸UP Áõ°ÀPÎß |øh•øÓ ¤µ÷¯õP[PÒ 

Euõµn® -1
Ãmk A»õµ •øÓø© (Home alarm system)
 ÃmiÀ PÒÁº ~øÇ¯ •Ø£k®÷£õx Ax £ØÔ ÃmiÝÒ÷Í 

°¸¨÷£õ¸US AÔÂUS® \ªUøbz öuõSv R÷Ç Põmh¨£mkÒÍx. Cx OR  

u¸UP Áõ°ÀPøÍ¨ £¯ß£kzv Aø©UP¨£mkÒÍx. Cuß‰»©õP Ãmk 

¯ßÚÀPÒ   Cµsk   ©ØÖ®  •ß,   ¤ß¦ÓU    PuÄPÒ    Cµsk    BQ¯Ú                        
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£õxPõUP¨£k®. CÁØÖÒ G¢u ¯ßÚø»÷¯õ PuøÁ÷¯õ vÓ¢uõÀ B£zx 

\ªUøbU P¸Â C¯[Q J¼ GÊ¨¦®. C¢u _ØÔøÚ |øh•øÓ°À  

£¯ß£kzx® ÷£õx  áßÚÀ, PuÄPÐUS›¯ u¸UP Áõ°ÀPÒ, En›PÐhß 

(Sensors) CønUP¨£mi¸US®. C¢u _ØÔÀ ¯ßÚÀ, PuÄPÒ BQ¯Ú 

vÓ¢xÒÍ {ø»US›¯ EÒÏk 1 GÚÄ®  ‰i²ÒÍ \¢uº¨£zvÀ EÒÏk 0 
GÚÄ® öPõÒÍ¨£mkÒÍx. E¸ 4.27 CÀ Põmh¨£mkÒÍÁõÖ Cuß EÒÏk-

PÒ AøÚzx® ‰i¯ {ø»°À 0 BP EÒÍ ÷£õx B£zx \ªUøb J¼ 

GÊ¨£¨£hõx. AuõÁx C¢u {ø»°À ¯ßÚÀPÒ AøÚzx® ‰i°¸US®. 

GÛÝ® J¸ EÒÏk 1 BP÷Áõ AÀ»x EÒÏkPÒ AøÚzx®  1 BP÷Áõ 

EÒÍ¨÷£õx B£zxa  \ªUøb J¼ GÊ¨£¨£k®. Euõµn©õP E¸ 4.28 CÀ 

•u»õÁx ¯ßÚÀ |£öµõ¸ÁµõÀ vÓUP¨£mhÄhß Ãmk E›ø©¯õÍ¸US 

Ax £ØÔ B£zx \ªUøb   GÊ¨£¨£k® Âu® Põmh¨£mkÒÍx. CÆÁõÖ  

\ªUøbz öuõSv ‰»® B£zx AÔÂUP¨£k® \¢uº¨£[PÒ AmhÁøn 

4.11  CÀ Põmh¨£mkÒÍx.

                     E¸ 4.26  Ãmiß B£zx AÔÂ¨¦a \ªUøb •øÓø©

B£zxa \ªUøb

¯ßÚÀ 1 En›

¯ßÚÀ 2 En›

•Ø¦Ó PuÄ En›

¤Ø¦ÓU PuÄ En›

 
0

0

0

0

0

0
0

E¸ 4.27 Ãmiß  B£zx  AÔÂ¨¦a  \ªUøb •øÓø© ‰»® \ªUøb 

GÊ¨£¨£hõu \¢uº¨£®

¯ßÚÀ 1 En›

¯ßÚÀ 2 En›

•Ø¦Ó PuÄ En›

¤Ø¦ÓU PuÄ En›

1

0

0

0

1

0
1

E¸ 4.28  Ãmiß B£zx AÔÂ¨¦a \ªUøb •øÓø© ‰»® 

B£zx AÔÂUP¨£k® \¢uº¨£®

¯ßÚÀ 1 En›

¯ßÚÀ 2 En›

•Ø¦Ó PuÄ En›

¤Ø¦ÓU PuÄ En›
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¯ßÚÀ 1 ¯ßÚÀ 2 •ß PuÄ ¤ßPuÄ            \¢uº¨£®

0 0 0 0 0

0 0 0 1 1

0 0 1 0 1

0 0 1 1 1

0 1 0 0 1

0 1 0 1 1

0 1 1 0 1

0 1 1 1 1

1 0 0 0 1

1 0 0 1 1

1 0 1 0 1

1 0 1 1 1

1 1 0 0 1

1 1 0 1 1

1 1 1 0 1

1 1 1 1 1

AmhÁøn  4.11 - Ãmiß B£zx AÔÂ¨¦a \ªUøbUPõÚ ö©´{ø» 

AmhÁøn  

         
            \¢uº¨£®    (Status) 
vÓ¢u {ø»  = 1
‰i¯ {ø»      = 0
B£zx AÔÂ¨¦ AØÓ {ø» = 0
B£zx \ªUøb  öÁÎ°h¨£k® {ø»  = 1

Euõµn® -2
Ãv ÂÍUS •øÓø©°À HØ£k® ªß Ãs Âµ¯zvøÚU  SøÓ¨£uØPõP 

Aø©UP¨£mh _ØÖ

 ¦zuõUS|º J¸ÁµõÀ ÃvÂÍUSPÎÀ HØ£k® ªßÂµ¯zøuU 

SøÓ¨£uØS uºUPÁõ°ÀPøÍ¨ £¯ß£kzv E¸ÁõUP¨£mh _ØÖ (System to 
Control street lights) E¸ 4.29 CÀ Põmh¨£mkÒÍx. Cx  JÎ/ C¸Ò En›  

(Dark/Light sensor), PiøP  (Timer) øP•øÓ BÎ (Manual switch) BQ¯Ú 
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£¯ß£kzu¨£mk Aø©UP¨£mkÒÍx.

C[S ÂÍUSPÒ JÎ¸ÁuØPõP \¢uº¨£[PÒ ]» Põmh¨£mkÒÍÚ. 

AøÁ¯õÁÚ :

♦	 øP•øÓ BÎ ©mk® ‰i¯ {ø»°À C¸US® \¢uº¨£®.

♦		 _ØÔß PiøP EÒÏk 1 BPÄ®  A¯Ø`ÇÀ C¸ÍõPÄ®  EÒÍ \¢uº¨£®

4.7.2.1 øP•øÓ BÎ ©mk® ‰i¯ \¢uº¨£® 

 øP•øÓ BÎ ‰i¯ {ø»°À EÒÍ {ø»ø¯U P¸x®÷£õx Auß 

EÒÏk 1 BP Aø©ÁuõÀ ÂÍUSPÒ JÎ¸®.

4.7.2.2 _ØÔß PiøP EÒÏk 1 BPÄ® A¯Ø`ÇÀ C¸ÍõPÄ® EÒÍ 

\¢uº¨£®

 

 PiøP°ß  ÷|µ® •ßÚ÷µ u¯õºö\´¯¨£mh ÷|µ® BQ¯ÁØÖU 

Qøh°À ÷ÁÖ£õk Põn¨£iß EÒÏk 1 BS®, CÀø»ö¯ÛÀ 0 BS®. 

AuõÁx ¤.£.6.00, •.£.6.00 GÚ HØPÚ÷Á u¯õº ö\´¯¨£mi¸¨¤ß EÒÏk 

1 BPÄ® •.£.6.00 C¼¸¢x ¤.£.6.00 ©o Áøµ°»õÚ Põ» EÒÏk 0 BPÄ® 

C¸US®. ÷©¾®, JÎ En›°ß •ßÚ÷µ u¯õºö\´u ö£Ö©õÚ[PÐU÷Põ 

AøuÂh AvP©õÚ JÎ²ÒÍ \¢uº¨£zv÷»õ `ÇÀ ©øÇ •QÀPÎÚõÀ 

C¸mhõP EÒÍ÷£õx JÎ²n›°ß ö£Ö©õÚ® 0 B°Ý® PiøP°ß ÷|µ® 

¤.£. 6.00 & •.£. 6.00 Áøµ CÀø»ö¯ÛÀ ÃvÂÍUSPÒ JÎµõx.

Ãv ÂÍUS

E¸ 4.29 Ãv ÂÍUSPÎÀ HØ£k® ªß Âµ¯zøuU 

                 SøÓ¨£uØPõÚ _ØÖ

øP•øÓ BÎ

PiøP

JÎ²n›
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   ö\¯Ø£õk

÷©õmhõº ÁõPÚ Ev›¨£õP EØ£zv¯õÍºPÎÚõÀ ÷©õmhõº 

ÁõPÚ Gßâß ö\¯Ø£k® \¢uº¨£zvÀ ÁõPÚzvÀ Aø\Ä 

AÀ»x PsnõiUS¨ £õv¨¦ HØ£mhõÀ \ªUøb J¼ø¯ 

GÊ¨£UTi¯ £õxPõ¨¦a _ØÖ •øÓø© E¸ÁõUP¨£mkÒÍx. 

CuØöPÚ ÷©õmhõº ÁõPÚ Gßâß C¯[S®÷£õx ©mk® 

Á¸ÂøÍÄ 1 BP Aø©¯UTi¯ En›²® PsnõiUS¨ 

£õv¨¦ HØ£k®÷£õx ©mk® Á¸ÂøÍÄ 1 BP Aø©¯UTi¯ En›²® 

ÁõPÚ® C¯[S®÷£õx ©mk® Á¸ÂøÍÄ 1 BP Aø©¯UTi¯ En›²® 

£¯ß£kzu¨£k®.

C¢ua _ØÖ Ai¨£øh u¸UP Áõ°ÀPÒ ‰ßøÓ¨ £¯ß£kzv Aø©UP¨£m-

kÒÍx. CÁØÖÒ JßÖ  NOT Áõ°»õS®. HøÚ¯ Áõ°ÀPÒ Cµsk® öÁØÖU 

TmiøÚ öPõskÒÍx. AuØS ö£õ¸zu©õÚ u¸UP Áõ°ÀPÒ ¯õøÁ?

C¢u Áõ°ÀPøÍ £¯ß£kzv _ØÔøÚ «sk® ÁøµP. 

................

Gßâß En›

Psnõi En›

C¯UP En›

B£zx \ªUøb................
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ö£õÈ¨¦

  Logic Gate       Symbol  Boolean 
  Expression

     Truth Table

OR Q = A+B

AND Q = A.B

NOT Q = A

NOR Q = A+B

NAND Q = A.B

A
B

Q

Q
A
B

QA

A
B

Q

Q
A
B

A B Q
0 0 0
0 1 1
1 0 1
1 1 1

A B Q
0 0 0
0 1 0
1 0 0
1 1 1

A Q
0 1
1 0

A B Q
0 0 1
0 1 0
1 0 0
1 1 0

A B  Q
0 0 1
0 1 1
1 0 1
1 1 0
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5 £oö\¯À •øÓø©PÒ

C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

 ² £oö\¯À •øÓø©°ß CßÔ¯ø©¯õø©

 ² £oö\¯À •øÓø© öuõÈØ£hÀ

 ² £oö\¯À •øÓø©°ß Cøh•P®

 ² £oö\¯À •øÓø©°ß £oPÒ

 ² £oö\¯À •øÓø© ÁøPPÒ

 ² £oö\¯À •øÓø©°ß AÝT»[PÒ

 ² £oö\¯À •øÓø©°ß £¯ß£õmka ö\´{µÀ

 ² ö\¾zvPÒ, ÷Põ¨¦ EøÓPÒ, ÷Põ¨¦PÒ

Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

5.1 £oö\¯À •øÓø©°ß AÔ•P®

 PoÛ Áßö£õ¸Ò (Hardware), {ø»ö£õ¸Ò  (Firmware), ö©ßö£õ¸Ò 

(Software) BQ¯ £À÷ÁÖ£mh TÖPøÍU öPõshuõS®. 

    vmh©õÚ ÁiÁzøuU öPõshx® öuõmknµU Ti¯x©õÚ PoÛ¨ 

£õP[PÒ Áßö£õ¸mPÒ (Hardware) GÚ¨£k®. \õÂ¨£»øP,  _mi (Mouse), 
öu›Â¨¤ (Monitor), ÁßÁmk (Hard disk), Aa_¨ö£õÔ (Printer) BQ¯Ú 

Áßö£õ¸ÒPÍõS®.

   Áõ]¨¦ ©mk® {øÚÁPzv¾ÒÍ (ROM)  {ÖÂ, PoÛ°ß Ai¨£øhz 

öuõÈØ£õkPÐUPõÚ  (BOOT) AÔÄÖzuÀPÒ {ø»ö£õ¸ÒPÒ (Firm ware) 
GÚ¨£k®. £¯|µõÀ •u¼À vøµ°À PõnzuUP GÊzx¸øÁ AÀ»x 

£hÄ¸øÁ Á¸ÂøÍÁõPz u¸ÁÚ {ø»ö£õ¸ÒPÍõS®.                                                                          
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PoÛ°ß Bµ®£z öuõÈØ£õmøh ÷©ØöPõÒÐ® •øÓ  

 ² £¯|›ÚõÀ PoÛ°À ªß Cøn¨¦ HØ£kzu¨£mhx® ø©¯ •øÓ 

ÁÈ¯õUP  A»Qß  ‰»®  Ai¨£øh EÒÏk, Á¸ÂøÍÄ •øÓø© 

(Basic  Input  Output  System - BIOS) öuõÈØ£kzu¨£k®.

 ² •u¼À Power - On Self Test (POST) ö\´{µÀ Kmh® |øhö£Ö®. Cuß 

Bµ®£¨ £i•øÓ¯õP CMOS (Complementary Metal Oxide Semiconductor) 
{øÚÁPzvß ‰»©õP AøÚzx Áßö£õ¸ÒPÐ® ÷\ºUP¨£mk AøÁ 

AøÚzx® \›¯õP C¯[SQßÓÚÁõ GÚ EÖv¨£kzu¨£k®.

 ² Akzx PoÛ EØ£zv {ÖÁÚzvÚõÀ ÁÇ[P¨£mh AÔÄÖzuÀPÒ 

Ah[Q¯ Bootstrap Loader GÝ® {ø»ö£õ¸ÎØPø©¯ POST  ö\´{µ 

¼ÚõÀ CÚ[Põn¨£mh boot sequence / order  CÚõÀ öuõhUPa 

ö\¾zv°À (boot drive) Master Boot Record (MBR)  Áõ]UP¨£k®. 

 ² CÖv¯õP Boot drive C¾ÒÍ £oö\¯À •øÓø© uØ÷£õUS¨ ö£ÖÁÈ 

{øÚÁPzvÀ (RAM) ¤µ÷Á]US®.

 ² AuØS AkzuuõP PoÛ°ß •Êø©¯õÚ Pmk¨£õmøh, £oö\¯À 

•øÓø© ö£ØÖ, £¯|º Cøh•Pzøu (User Interface) AÎUS®.

 C¢u •Êø©¯õÚ ö\¯ß•øÓ öuõhUSuÀ (Booting) GÚ AøÇUP¨£k®. 

£oö\¯À •øÓø©, PoÛ°ß uØ÷£õUS¨ ö£ÖÁÈ {øÚÁPzvÀ (¤µuõÚ 

{øÚÁPzvÀ) ¤µ÷Á]zuÀ booting Gß£uß ö£õ¸ÍõS®.

 PoÛ°ß ‰»©õP SÔ¨¤mh £oø¯ ÷©ØöPõÒÍz ÷uøÁ¯õÚ 

AÔÄÖzuÀPÎß  vµm÷h ö©ßö£õ¸Ò (Software)  GÚ¨£k®. ö©ßö£õ¸ÒPÒ 

£» ÁøP¨£k®. AÁØøÓ¨ ¤ßÁ¸©õÖ ÁøP¨£kzvU Põmh»õ®.

 
E¸ 5.1 -  ö©ßö£õ¸Ò ÁøPPÒ

ö©ßö£õ¸ÒPÒ (Software)

¤µ÷¯õP ö©ßö£õ¸ÒPÒ 
(Application Software)

ö\õÀ •øÓÁÈ¨£kzuÀ (Word Processing)
Â›uõÒ (Spreadsheet)
uµÄzuÍ® (Database)
PoÛ ÂøÍ¯õmkPÒ (Computer Games)
Cøn¯z ÷uhØ ö£õÔPÒ (Web Engines)

•øÓø©ö©ßö£õ¸ÒPÒ
(System Software)

a. £oö\¯À •øÓø©
(Operating System)

b. £¯ß£õmk ö©ßö£õ¸ÒPÒ

(Utility Software)

c.  ö©õÈ ö£¯º¨¤PÒ
(Language Translators)

J¸[S ÷\º¨¤ (Assembler)
öuõS¨¤ (Compiler)
Á›ö©õÈ ©õØÔ (Interpeter)
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5.1.1  •øÓø© ö©ßö£õ¸Ò (System Software) 
1)  •øÓø© ö©ßö£õ¸Ò ¤µuõÚ©õP ‰ßÖ ÁøP¨£k®.  

a) £oö\¯À •øÓø© (Operating System) -& PoÛ°À {ÖÁ¨£mkÒÍ 

HøÚ¯ ö©ßö£õ¸ÒPÒ, Áßö£õ¸ÒPÒ BQ¯ÁØøÓ •Põø© ö\´x 

£¯|º PoÛø¯¨ £¯ß£kzu Á\vö\´x öPõk¨£÷u £oö\¯À 

•øÓø©°ß ¤µuõÚ öuõÈ»õS®. •øÓø© ö©ßö£õ¸Ò, ¤µ÷¯õP 

ö©ßö£õ¸Ò BQ¯Ú Áßö£õ¸ÒPÐhß Cøn¢x öuõÈØ£k® 

Âu® E¸ 5.2 CÀ Põmh¨£mkÒÍx.

¤µ÷¯õP ö©ßö£õ¸Ò

   •øÓø© ö©ßö£õ¸Ò

Áßö£õ¸Ò

_mi

\õÂ¨£»øP 

ö\õÀ •øÓÁÈ¨£kzuÀ

uµÄz uÍ®

PoÛ 

ÂøÍ¯õmkPÒ

Áø» 

÷©÷»õiPÒ

Â›uõÒ

£oö\¯À 

•øÓø©

£¯ß£õmk 

ö©ß£õ¸Ò

öu›Â¨¤

E¸ 5.2 Áßö£õ¸Ò, •øÓø© ö©ßö£õ¸Ò, ¤µ÷¯õP ö©ßö£õ¸Ò

b) £¯ß£õmk ö©ßö£õ¸Ò (Utility Software) 

 PoÛ°À {ÖÁ¨£mkÒÍ HøÚ¯ ö©ßö£õ¸ÒPøÍ¨ £S¨£õ´Ä 

ö\´uÀ, Cø¯£õUPÀ, SÔzu ö\¯Ø£õkPÐUS ªP¨ ö£õ¸zu©õÚ 

ö©ßö£õ¸ÒPøÍz öu›Äö\´uÀ, PoÛø¯¨ £µõ©›zuÀ BQ¯ 

|hÁiUøPPÐUöPÚ BUP¨£mhøÁ÷¯ C¢u ö©ßö£õ¸ÒPÍõS®. 

AÆÁõÓõÚ ]» ö©ßö£õ¸ÒPÒ Á¸©õÖ:
1.  |a_{µÀ Gvº ö©ßö£õ¸ÒPÒ (Antivirus Software) & |a_{µÀ öuõØÖ 

PÎ¼¸¢x PoÛø¯¨ £õxPõzuÀ.

2. Ámk ÁiÁø©zuÀ (Disk Formating) - -÷Põ¨¦PÒ, ÷Põ¨¦ EøÓPÒ 

BQ¯ÁØøÓ ÷\ªUP ö£õ¸zu©õÚ •øÓ°À ÁmiøÚz (Disk) u¯õº 

ö\´uÀ.
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c) ö©õÈö£¯º¨¤PÒ (Language Translators) 

 PoÛa ö\´{µÀPÒ (ö©ßö£õ¸ÒPÒ), AÔÄÖzuÀPÎß öuõS¨ 

¤ÚõÀ BUP¨£mhøÁ¯õS®. CøÁ ©Ûu ö©õÈPÐUS ö|¸UP 

©õÚ E¯º©mh ö©õÈPøÍ¨ (High Level Language) £¯ß£kzv÷¯ 

GÊu¨£mkÒÍÚ. CÁØøÓU PoÛ¯õÀ ÂÍ[QU öPõÒÍUTi¯ 

ö©õÈ¯õÚ (Machine Language) 1, 0 BQ¯ÁØÔÀ ö©õÈö£¯º¨£÷u 

ö©õÈö£¯º¨¤PÎß öuõÈ»õS®. J¸[S÷\º¨¤ (Assembler), 
öuõS¨¤ (Compiler), ö£õ¸Ò÷Põh¼ (Á›ö©õÈ ©õØÔ) (Interpreter) 
BQ¯Ú CuØPõÚ Euõµn[PÍõS®.

 5.1.2  ¤µ÷¯õP ö©ßö£õ¸ÒPÒ  (Application Software) 

 £oö\¯À •øÓø©¯õÀ ©mk® ö\¯Ø£k® ¤µ÷¯õP ö©ßö£õ¸ÒPÒ 

£¯|º  PoÛ \õº¢u ö\¯Ø£õkPøÍ  (BÁnz u¯õ›¨¦, Poua ö\´øPPÒ, 

uµÄ ÷\P›zuÀ, uµÄPøÍ {øµ¨£kzuÀ, PoÛ ÂøÍ¯õmkPÒ ÷£õßÓ) 
÷©ØöPõÒÍ EuÄ®. 

♦	 Euõµn® & ö\õÀ•øÓÁÈ¨£kzuÀ (Word Processing), Â›uõÒ (Spreadsheet), 
uµÄzuÍ® (Database), PoÛ ÂøÍ¯õmkPÒ (Computer Games), Cøn¯z 

÷uhØ ö£õÔPÒ (Web Engines)    
        

5.1.3 £oö\¯À •øÓø©°ß CßÔ¯ø©¯õø©

     £¯|º ©ØÖ® PoÛ Áßö£õ¸ÒPÒ BQ¯ÁØÖUQøh°»õÚ öuõhºø£ 

HØ£kzxÁ÷u  £oö\¯À  •øÓø©  ö©ßö£õ¸ÍõS®. Cuß‰»® 

£À÷ÁÖ  ¤µ÷¯õP ö©ßö£õ¸ÒPøÍU PoÛ°À {ÖÄuÀ, öuõÈØ£ha 

ö\´¯z  ÷uøÁ¯õÚ   PmhøÍPøÍ  ÁÇ[SuÀ,   EÒÏmka  \õuÚ[PÒ 

(Input Devices), Á¸ÂøÍÄa \õuÚ[PÒ (Output Devices), PoÛ {øÚÁP®                                                                                                                                 

(Computer Memory),  •øÓÁÈ (Process), ÷Põ¨¦UPÒ (Files), Põ¨¦ (Security) ©ØÖ® 

Áø»¯ø©¨¦ (Network) BQ¯ÁØøÓ •Põø©ö\´uÀ, PoÛ°À {ÖÁ¨£m-

kÒÍ HøÚ¯ ö©ßö£õ¸ÒPøÍ C¯USuÀ ÷£õßÓ £oPÒ ö\´¯¨£k®. 

Cv¼¸¢x, PoÛ°ß •Êø©¯õÚ C¯UPzøu¨ £oö\¯À •øÓø©÷¯ 

Cø¯¦£kzxQßÓx Gß£øu ÂÍ[QU öPõÒÍ»õ®. 
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£¯|º (Human User)

Áßö£õ¸Ò  (Hardware)

£oö\¯À •øÓø© (Operating System) 

¤µ÷¯õP ö©ßö£õ¸Ò

(Application Software)

HøÚ¯ •øÓø© ö©ßö£õ¸Ò

(Other System  Software)

     E¸ 5.3 £¯|¸US® PoÛUS® Cøh°»õÚ öuõhº¦

5.1.4  £À÷ÁÖ ÁøP¨£mh £oö\¯À •øÓø©PÒ

1.  Âß÷hõì (Windows) £oö\¯À •øÓø© 

   ø©U÷µõö\õ¨Ø (Microsoft)  {ÖÁÚzvÚõÀ E¸ÁõUP¨£mkÒÍ Âß÷hõì 

(Windows)  £oö\¯À •øÓø©, £v¨¦›ø© öPõshx® £n® ö\¾zv 

ö£ØÖUöPõÒÍ ÷Ási¯x©õÚ •øÓø© ö©ßö£õ¸ÍõS®. E»QÀ ªPÄ®  

¤µ£À¯©õÚ C¢u¨ £oö\¯À •øÓø©°ß £À÷ÁÖ £v¨¦PøÍ¨ (Versions) 
ö£ÓU Ti¯uõPÄÒÍx. Euõµn® :Windows XP,  Windows Vista, Windows 7, Windows 8

     CøÁuÂµU øP¯hUPz öuõø»÷£]PÒ, Áøµ¦ C»UP©õUQ (Tablet) ÁøPU 

PoÛPÒ BQ¯ÁØøÓz öuõÈØ£ha ö\´¯ Windows Mobile GÝ® £oö\¯À 

•øÓø© AÔ•Pg ö\´¯¨£mkÒÍx. ÷©¾®, ÷\øÁU PoÛPÎß (Server) 
öuõÈØ£õmiØöPÚ ÷\øÁ¨ £oö\¯À •øÓø©¯õP Windows Server GÝ® 

£oö\¯À •øÓø©²® E¸ÁõUP¨£mkÒÍx. 

2. Mac £oö\¯À •øÓø©

         Apple {ÖÁÚzuõÀ u¯õ›UP¨£mh Mac OS GÚ¨£k® £oö\¯À •øÓø© 

Apple Macintosh  PoÛPÎÀ £¯ß£kzu¨£k®. Cx £v¨¦›ø©²øh¯, £n® 
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ö\¾zvU öPõÒÁÚÄ ö\´¯¨£h ÷Ási¯ •øÓø© ö©ßö£õ¸ÍõS®. 

C¢u¨ £oö\¯À •øÓø©ø¯ Apple {ÖÁÚzvÚõÀ u¯õ›UP¨£mh PoÛ 

PÎÀ ©mk÷© {ÖÁ •i²®.

3. Ubuntu £oö\¯À •øÓø©

 Linux £oö\¯À •øÓø©ø¯ Ai¨£øh¯õPU öPõsk Ubuntu £o 

ö\¯À •øÓø© u¯õ›UP¨£mkÒÍx. CuøÚ C»Á\©õP¨ ö£ÓUTi¯ Á\

v²ÒÍx. BP÷Á, CuøÚ C»Á\ vÓ¢u ö©ßö£õ¸Ò (Free and Open Source 
Software) GÚÄ® AøÇ¨£º. 

http//www.ubuntu.com/download GÝ® Áø»U Ph¨¤hzv¼¸¢x C¢u £oö\¯À 

•øÓø©ø¯ C»Á\©õP¨ £vÂÓUP® ö\´¯•i²®.

4.   Android £oö\¯À •øÓø©

 Google {ÖÁÚzvß ‰»©õP Android £oö\¯À •øÓø© u¯õ›UP¨£m-

kÒÍx. øP¯hUPa \õuÚ[PÐUöPÚ (Mobile devices)  Â÷\h©õPz u¯õ›UP¨£mh 

£oö\¯À •øÓø©ö¯Ú  Android IU SÔ¨¤h»õ®. Cx  C»Á\©õP 

ÁÇ[P¨£k® £oö\¯À •øÓø©¯õS®. 

5. Hanthana Linux £oö\¯À •øÓø© 

 Cx Linux £oö\¯À •øÓø©ø¯ Ai¨£øh¯õPU öPõsk u¯õ›U 

P¨£mhuõS®. CuøÚ  www.hanthana.org C¼¸¢x C»Á\©õP £vÂÓUP® 

ö\´¯ •i²®. 

 

5.1.5   £oö\¯À  •øÓø©ø¯  ÁøP¨£kzuÀ

 PoÛø¯z öuõhUQ¯v¼¸¢x {Özx®Áøµ PoÛ°ß ÁßTÖPøÍ 

Ea\ÍÂÀ £¯ß£kzv £¯|¸USz ÷uøÁ¯õÚ ¤µ÷¯õP ö©ßö£õ¸ÒPøÍz 

öuõÈØ£haö\´¯z ÷uøÁ¯õÚ `Çø»U Pmiö¯Ê¨¦u÷» £oö\¯À •øÓ 

ø©°ß ¤µuõÚ©õÚ £o¯õS®. £oö\¯À •øÓø©PÎß öuõÈØ£õmkU 

Pø©¯ AÁØøÓ¨ ¤ßÁ¸©õÖ ÁøP¨£kzu»õ®.

1. uÛ¨ £¯ß£õk (Single user)
2.  £À £¯ß£õk (Multi user)
3.  £À öPõÒ£o (Multi tasking)
4.  {PÌ ÷|µ® (Real time)
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uÛ¨ £¯ß£õmk¨ £oö\¯À •øÓø©

 J¸ uhøÁ°À J¸ £¯|¸US ©mk® ÷\øÁø¯ ÁÇ[S® £oö\¯À 

•øÓø©÷¯ CxÁõS®.

E+® -& MS DOS £oö\¯À •øÓø©

£À £¯ß£õmk £oö\¯À •øÓø©

 J¸ uhøÁ°À JßÖUS ÷©Ø£mh £¯|ºPÍõÀ PoÛ°À öuõÈØ£õk 

PøÍ ÷©ØöPõÒÍU Ti¯ £oö\¯À •øÓø©÷¯ CxÁõS®. Mainframe  
÷£õßÓ J÷µ uhøÁ°À £À÷ÁÖ |£ºPÐUöPÚa ö\¯Ø£hUTi¯ PoÛPÎÀ 

CÆÁõÓõÚ £oö\¯À •øÓø© {ÖÁ¨£k®.

E+® & Linux, Windows Server

£À öPõÒ£o £oö\¯À •øÓø©

 J¸ uhøÁ°À  £» ö\¯Ø£õkPøÍ ÷©ØöPõÒÍU Ti¯ £oö\¯À 

•øÓø©÷¯  CxÁõS®. Cuß‰»® uÛ¨ £¯|µõÀ J¸ uhøÁ°À £» ö\¯Ø 

£õkPøÍ ÷©ØöPõÒÍ •i²®.

E+® & Windows 7, Windows 8, Ubuntu , Mac OS

{PÌ÷|µ £oö\¯À •øÓø©

 Cx EÒÏmøh ÁÇ[Q¯x® uõ©uªßÔ x»[Pø» ÁÇ[PUTi¯ 

£oö\¯À •øÓø©¯õS®. ußÛ¯UPU Pmk¨£kzvPøÍU öPõsh C¯¢ 

vµ[PÎÀ ö£¸®£õ¾® C¢u¨ £oö\¯À •øÓø© £¯ß£kzu¨£k®.

E+® &   ATM C¯¢vµ®, Po¨£õß.

5.1.6  £oö\¯À •øÓø©°ß ÷\øÁPÒ

£oö\¯À •øÓø©°ß £oPÒ

 £oö\¯À •øÓø© J¸ ö©ßö£õ¸ÍõS®. CuÚõÀ Áßö£õ¸ÒPÐ® 

¤Ó ö©ßö£õ¸ÒPÐ® •Põø© ö\´¯¨£k®. Cuß‰»® HøÚ¯ ö©ß 

ö£õ¸ÒPÐUPõÚ ÷\øÁPÒ ÁÇ[P¨£k®. PoÛ¨ £oö\¯À •øÓø© 

‰»©õP ÷©ØöPõÒÍ¨£k® ¤µuõÚ öuõÈÀPÒ Cµsk Á¸©õÖ:

1.  PoÛ •øÓø©°¾ÒÍ Áßö£õ¸ÒPøÍ •Põø© ö\´uÀ

2.  £¯|º |m¦ Cøh•Pzøu ÁÇ[SuÀ
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(1)    PoÛ •øÓø©°ß Áßö£õ¸ÒPøÍ •Põø© ö\´uÀ

PoÛ°À, £oö\¯À •øÓø© ‰»©õP ¤ßÁ¸® •Põø©zxÁz öuõÈØ 

£õkPÎß Ai¨£øh°À PoÛ°ß ÁßTÖPÒ •Põø© ö\´¯¨£kQÓx.

1. •øÓÁÈ •Põø© -(Process Management)
2. {øÚÁP •Põø© (Memory Management)
3. \õuÚ •Põø©       (Device Management)
4. ÷Põ¨¦ •Põø© (File Management)
5. Põ¨¦ •Põø©    (Security Management)
6. Áø»¯ø©¨¦ •Põø© (Network Management)

PoÛ°À C¢ua ö\¯Ø£õkPÒ |øhö£Ö® Âu® ©ØÖ® AÁØÔØQøh¯õÚ 

öuõhº¦ BQ¯Ú ¤ßÁ¸® Á›¨£hzvÀ Põmh¨£mkÒÍÚ. 

         E¸ 5.4 £oö\¯À •øÓø©°ß •Põø©¨£o

C¨÷£õx •Põø©¨ £oPÒ £ØÔ AÔ¢xöPõÒ÷Áõ®.

1.  •øÓÁÈ •Põø©zxÁ® (Process Management) 

 PoÛø¯¨ £¯ß£kzv |õ® £À÷ÁÖ £oPøÍ ÷©ØöPõÒÐ® Âu® 

£ØÔ }[PÒ AÔ¢xÒÏºPÒ. Euõµn©õP BÁnö©õßøÓ Aa_¨ö£õÔ ‰»® 

Aa]mkU öPõÒÁx öuõhº£õP AÔ¢v¸¨¥ºPÒ. BÁnzøu Aa]hÀ J¸ 

öuõÈØ£õöhÚ G©US ÷uõßÔ¯ ÷£õv¾® PoÛ°À C¢u öuõÈØ£õk £» 

A»SPÍõP¨ ¤›UP¨£m÷h {øÓ÷ÁØÓ¨£k®. £oö\¯À •øÓø©°ÚõÀ 

÷©ØöPõÒÍ¨£k®. CÆÁõÓõÚ A»Sz öuõÈØ£õkPÒ •øÓÁÈ GÚ 

AøÇUP¨£k®.
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E¸ 5.5  P1 - P7 Áøµ¯õÚ •øÓÁÈa ö\¯Ø£õkPÎß  (Process) •Põø©zxÁ®

 

 PoÛ°À ö\¯Ø£mkU öPõsi¸US® PoÛ ö©ßö£õ¸ÒPÒ 

AÀ»x {PÌa] {µÀPÎß £SvPøÍ •øÓÁÈPÒ GÚ GÎø©¯õPU TÓ»õ®. 

PoÛ°ß GÀ»õa ö\¯Ø£õkPÐ® JßÖ AÀ»x £» £i•øÓPÎÞhõP 

÷©ØöPõÒÍ¨£k®.

 •øÓÁÈUSz ÷uøÁ¯õÚ ÁøP°À ø©¯ •øÓÁÈ A»QÚõÀ ÷|µ® 

JxUP¨£hÀ, {øÚÁPzøu JxUQU öPõÒÍÀ, E›¯ •øÓÁÈUPõÚ EÒÏk, 

Á¸ÂøÍÄ A»øP ÷ÁÓõUQUöPõÒÍÀ ÷£õßÓ ÁÍ •Põø©zxÁ[PÒ 

£oö\¯À •øÓø©°ß •Põø©zxÁzvß÷£õx ÷©ØöPõÒÍ¨£k®.

 AÆÁõ÷Ó GÀ»õa ö\¯ß•øÓPøÍ²® E›¯ ÁøP°À JÊ[S£kzv                              

|hÁiUøP  Gk¨£÷u  £oö\¯À  •øÓø©°ß  öuõÈØ£õhõS®.   Euõµ                                                                                                                                            

n©õPU Piuö©õßøÓ Aa]k®÷£õx Cøh|kÂÀ \õÂ¨£»øPø¯¨ 

£¯ß£kzv H÷uÝö©õßøÓ EÒÎkÁøuU P¸zvØ öPõÒ÷Áõ®. Cuß 

÷£õx •u¼À PoÛ¯õÀ ÷©ØöPõÒÍ¨£h ÷Ási¯ P¸©® GxöÁÚz 

wº©õÛUP¨£h ÷Ásk®. C¢u Cµsk ö\¯Ø£õkPÐ® J÷µ uhøÁ°À 

|øhö£ÖÁx ÷£õÀ ÷uõßÔÚõ¾® PoÛ°À C¢u Cµsk ö\¯Ø£õk-

PÐ® Cµsk \¢uº¨£[PÎÀ ÷©ØöPõÒÍ¨£k®. AÆÁõ÷Ó Aa]h¨£k® 

BÁnö©õßÔÀ HuõÁx ö\õÀö»õßøÓz umha_a ö\´uõÀ ¯õx {PÊ®? 

|õ® Aa]h¾UPõÚ PmhøÍø¯ ÁÇ[Q¯ ¤ßÚº A¢u BÁnzvÀ ÷©Ø 

öPõÒÍ¨£mh v¸zu[PÒ Aa_¨ö£õÔ ‰»® Aa]h¨£k©õ? AÆÁõÖ 

Aa]h¨£hõx. GÚ÷Á, Cv¼¸¢x PoÛ ‰»©õÚ ö\¯Ø£õkPÒ, SÔzu 

JÊ[S•øÓ°À •Põø© ö\´¯¨£kQßÓÚ GÚ AÔ¯•iQÓx.  



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À158 159

2.   {øÚÁP •Põø©zxÁ®  (Memory Management)

PoÛ ö\¯Ø£k®÷£õx {øÚÁPzvÀ (¤µuõÚ©õP uØ÷£õUS ö£ÖÁÈ 

{øÚÁP©õÚ •ußø© {øÚÁP®) A÷ÚP ö\¯Ø£õkPÒ |øhö£ÖÁøu 

AÁuõÛUP»õ®. EÒÍhUP¨£k® AøÚzxz uµÄPÐ® ø©¯ •øÓÁÈ 

A»QØS AÝ¨£¨£k® Áøµ £v¢x  øÁzv¸UP¨£hÀ, •øÓÁÈ¯õUP¨£mh 

uµÄPøÍ AuõÁx uPÁÀPøÍ Á¸ÂøÍÄ A»QØS AÝ¨£¨£k® Áøµ 

£vuÀ BQ¯Ú {øÚÁPzv÷» |øhö£Ö®. GÚ÷Á, {øÚÁPzøu  {¯© 

•øÓ°À •Põø© ö\´uÀ PoÛ°ß ^µõÚ ö\¯Ø£õmiØS ªPÄ® 

CßÔ¯ø©¯õuuõS®. •øÓÁÈ¯õUPzvß÷£õx {øÚÁPzvÀ HØ£hUTi¯                                                                                                                                         

]UPÀPøÍz uÂºzx •øÓÁÈ¨£kzu¾USz ÷uøÁ¯õÚ Chzøu {øÚ 

ÁPzvÀ JxUQU öPõkzuÀ, A¢u •øÓÁÈø¯ CÖv°À {øÚÁPzv¼¸¢x 

}USuÀ ÷£õßÓ |hÁiUøPPøÍ {øÚÁP •Põø©÷¯ ÷©ØöPõÒÐ®.

E¸ 5.6 {øÚÁP •Põø©zxÁ®

 {øÚÁP •Põø©UöPÚ £oö\¯À •øÓø© ‰»® £À÷ÁÖ EzvPÒ 

øP¯õÍ¨£k®. AuõÁx £oö\¯À •øÓø© ¤µuõÚ {øÚÁP® (uØ÷£õUS 

ö£ÖÁÈ {øÚÁP®) ©ØÖ® xøn {øÚÁP® ÷£õßÓ Cµsk ÁøP¯õÚ 

{øÚÁP[PøÍ •Põø© ö\´QßÓx Gß£øu |õ® {øÚÂØ öPõÒÍ ÷Ásk®.

 Piuö©õßøÓ Aa]kÁuØPõP PmhøÍ ÁÇ[Q¯ ¤ßÚº AUPiuzvÀ 

H÷uÝö©õßøÓ Cøhaö\¸PÀ ö\´Áx £ØÔU P¸zvØ öPõÒP. C[S 

Piuö©õßÖ Aa_¨ö£õÔ°À Aa]h¨£k®÷£õx G®©õÀ AUPiuzvÀ 

EÒÍhUP¨£k® Âh¯[PÒ Aa_¨ö£õÔ ‰»® Aa]h¨£kÁvÀø». 

PoÛ°À uØ÷£õUS¨ ö£ÖÁÈ {øÚÁzvÀ EÒÍ Âh¯[PÒ ©mk÷© Aa]

h¨£k®. Auß ¤ßÚº G®©õÀ EÒÎh¨£k® Âh¯[PÒ Aa_¨ö£õÔ°ÚõÀ 

Aa]h¨£hõx.
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E[PÍx PoÛ°¾ÒÍ uØ÷£õUS¨ ö£ÖÁÈ {øÚÁPzvß 

(RAM) öPõÒvÓøÚ PshÔ²® ÂuzøuU GÊxP. Auß 

öPõÒvÓøÚ SÔzxU öPõÒP.

ö\¯Ø£õk

3. \õuÚ •Põø©zxÁ®   (Device Management)

 PoÛ •øÓø©°À AvP öÁÎ Cøn¨¦ \õuÚ[PÒ (Peripheral 
devices) £¯ß£kzu¨£kQßÓÚ Gß£øu }[PÒ AÔÃºPÒ. C¢u AøÚzx \õu 

Ú[PøÍ²® £oö\¯À •øÓø©÷¯ Pmk¨£kzxQÓx. \õuÚ •Põø©UöPÚ 

ÁßTÖ¨ £SvPÍõÚ \õuÚU Pmk¨£kzvPÒ (Device controllers), ö©ßö£õ¸Ò 

£SvPøÍ Pmk¨£kzuöÁÚa ö\¾zva ö\´{µÀPÒ (Device drivers) 
£¯ß£kzu¨£kQßÓÚ.

 E¸ 5.7 - \õuÚ •Põø©zxÁ®

 Euõµn©õP E[PÍõÀ öPõÒÁÚÄ ö\´¯¨£mh Aa_¨ö£õÔ E[PÍx 

PoÛ²hß \›¯õPz öuõÈØ£kÁuØS AuØS›¯ \õuÚa ö\¾zv (Device 
driver) £oö\¯À •øÓø©°À E›¯ÁõÖ {ÖÁ¨£h ÷Ásk®. AÆÁõÖ 

CÀø»ö¯ÛÀ Aa_¨ö£õÔ°¼¸¢x Aa]hø» ÷©ØöPõÒÍ •iQßÓ 

÷£õv¾®    Av¼¾ÒÍ    ußÛ¯UP©õP   Cµsk  £UP[PÎ¾®  Aa]hÀ  

÷£õßÓ  ÷©»vP  Á\vPøÍ¨  £¯ß£kzu  •i¯õu  {ø»  E¸ÁõS®. 

 
uØ\©¯® A÷ÚP \õuÚ[PÒ ö£õ¸zv¯Äh÷Ú÷¯ C¯[PUTi¯øÁ¯õP  

(Plug and play) u¯õ›UP¨£mi¸¨£xhß AuØS›¯ ö\¾zva ö\¯À{µÀPÒ 

(Device driver) ußÛ¯UP©õP÷Á £oö\¯À •øÓø©°À {ÖÁ¨£kÁøuU 

Põn»õ®. CuÚõÀ ö\¾zva ö\¯À{µÀPøÍ¨ ¦Ó®£õP {ÖÁ ÷Ási¯                                               

AÁ]¯ªÀø».
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}[PÒ  PoÛ²hß  ¦v¯ Aa_¨ö£õÔö¯õßøÓ (Printer) CønU

S®÷£õx £oö\¯À •øÓø© ‰»©õP Auß \õuÚa ö\¾zva 

ö\´{µÀ  ußÛ¯UP©õP÷Á  {ÖÁ¨£k®.  CÀø»÷¯À AuøÚ

|õ® ¦Ó®£õP {ÖÂUöPõÒÍ (Install) ÷Ásk®. ¦v¯ Aa_¨ 

ö£õÔPÐUS›¯ \õuÚa ö\¾zva ö\´{µÀ ußÛ¯UP©õP {ÖÁ¨ 

£k® ÂuzøuU SÔzxU öPõÒP.

ö\¯Ø£õk

4. ÷Põ¨¦ •Põø©zxÁ®  (File Management)

 PoÛ°À uµÄPøÍa ÷\ªzxøÁUPU ÷Põ¨¦PÒ £¯ß£kzu¨£k®. 

÷Põ¨¦PøÍ ^µõP •Põø© ö\´ÁuØS ÷Põ¨¦ EøÓPÒ (Folders) £¯ß£kzu¨ 

£k®. CÆÁõÓõÚ ÷Põ¨¦PøÍ •Põø© ö\´Áx® £oö\¯À •øÓø©°ß 

£o¯õS®. 

.cpp

.htm

.php

.xlsx

.pptx

.jpg

.TXT

 E¸ 5.8 ÷Põ¨¦ •Põø©zxÁ® 

 £oö\¯À •øÓø© ‰»® ÷Põ¨¦ •Põø©UöPÚ¨ ¤ßÁ¸® £oPÒ 

BØÓ¨£kQßÓøu AÁuõÛUP»õ®. 

 ² ¦v¯  ÷Põ¨¦PøÍz  E¸ÁõUP¾®  AÁØøÓ  E›¯ÁõÖ ÷\ªzu¾®

 ² ÷uøÁ¯ØÓ ÷Põ¨¦PøÍ }USuÀ

 ² ÷uøÁU÷PØ£ ÷Põ¨¦ EøÓPøÍ E¸ÁõUSu¾® ÷uøÁ¯ØÓ ÷Põ¨¦ 

EøÓPøÍ }USu¾®

 ² ÷Põ¨¦PÒ, ÷Põ¨¦ EøÓPÒ BQ¯ÁØÖUS «Ò ö£¯›hÀ

 ² ÷Põ¨¦PÒ, ÷Põ¨¦ EøÓPÒ BQ¯Ú C¸US® Ch[PøÍ ©õØÖuÀ

 ² ÷uøÁ¯õÚ \¢uº¨£[PÎÀ ÷uøÁ¯õÚ ÷Põ¨¦PøÍU Põ¨ö£kzuÀ 

(Backup)
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E¸  5.9  ÷Põ¨¦ •Põø©zxÁ®

 ÷Põ¨¦ •Põø©°ß÷£õx £oö\¯À •øÓø©°ß ‰»® ÷Põ¨¤ß 

C¯À¦PÒ, ÷Põ¨¤øÚU øP¯õÐuÀ, ÷Põ¨¤ÝÒ ~øÇÁuØPõÚ AÝ©v, 

÷Põ¨¦ •øÓø© BQ¯Ú öuõhº£õÚ Âh¯[PÒ P¸zvØ öPõÒÍ¨£k®.

1. ÷Põ¨¦PÒ / ÷Põ¨¦ EøÓPÒ BQ¯Ú £À÷ÁÖ C¯À¦PøÍU 

öPõskÒÍÚ. E[PÍx £oö\¯À •øÓø©°¾ÒÍ ÷Põ¨¦ / 

÷Põ¨¦ EøÓ JßøÓz öu›Äö\´x Auß C¯À¦PøÍ AÔ¢x 

öPõÒÐ® Âuzøu GÊxP. CÆ C¯À¦PøÍ SÔzxU öPõÒP.

    

    2. ¤ßÁ¸® ÁøP¯õÚ ÷Põ¨¦PÒ £¯ß£kzu¨£k® £oö\¯À 

•øÓø©PÒ GøÁö¯Ú PshÔP.

 ²  FAT16 
 ²  FAT32
 ²  NTFS
 ²  ext4
 ²  ReiserFS

3. £oö\¯À •øÓø©°À ¤ßÁ¸® ÷Põ¨¦PøÍ  AqS® (Access) 
•øÓPøÍ¨ £ØÔ _¸UP©õP ÂÁ›USP. 

  

 ² Á›ø\•øÓ AqPÀ (Sequential Access) 
 ² uØ÷£õUS AqPÀ (Random Access)

ö\¯Ø£õk
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Â£›¨£uØPõP ¤ßÁ¸® Á›£hzøu £¯ß£kzu»õ®.

E¸ 5.10 Á›ø\ •øÓ, uØ÷£õUS AqPÀ

5.  Põ¨¦ •Põø©zxÁ®  (Security Management)

 PoÛUS¨ £À÷ÁÖ Aa_ÖzuÀPÒ HØ£kÁøuU Põn»õ®. Euõµ 

n©õP PoÛ |a_{µÀ ‰»® PoÛ°ß ö©ßö£õ¸ÒPÎß ö\¯Ø£õmiß «x 

£À÷ÁÖ £õv¨¦PÒ HØ£kzu¨£kQßÓÚ. ÷©¾® PoÛ°À AÝ©v°ßÔ¨ 

¤µ÷Á]zx PoÛz uPÁÀPøÍ AÈzuÀ ÷£õßÓ £» ¤µa]øÚPÐUS PoÛ 

•P[öPõkUP ÷Ási¯ {ø» HØ£k®. 

CÆÁõÓõÚ £õv¨¦PÎ¼¸¢x PoÛø¯ £oö\¯À •øÓø© £õxPõUQÓx. 

Cuß ö£õ¸mk PoÛ¨ £oö\¯À •øÓø© ‰»® £À÷ÁÖ •øÓPÒ 

¤ß£ØÓ¨£kQÓx.

1. £oö\¯À •øÓø© ‰»® AÝ©v°ßÔ AqPø» uÂºzuÀ 

AÀ»x Pmk¨£kzuÀ BQ¯ÁØøÓ ÷©ØöPõÒÍ Põn¨£k® 

E£õ¯ •øÓPÒ GøÁö¯Úa _¸UP©õP Â£›USP. 

2. £oö\¯À •øÓø©US¨ ¦Óz÷u°¸¢x Á¸QßÓ |a_ ö\´{ 

µÀPÒ AøÚzøu²® Pmk¨£kzxÁx C¯»õu £o¯õS®. 

CuØöPÚ öÁÎ¯õ›hª¸¢x (‰ßÓõ® |£º) |a_{µÀ uk¨¦ 

ö©ßö£õ¸ÒPÒ ö£Ó¨£k®. £oö\¯À •øÓø©°ÚõÀ 

uÛzx Pmk¨£kzu •i¯õu |a_ ö\´{µÀPøÍU Pmk¨£kzu¨ 

£¯ß£kzu¨£k® |a_{µÀ uk¨¦ ö©ßö£õ¸øÍ ÂÁ›zx, A¢u 

ö©ßö£õ¸ÒPøÍ¨ £mi¯Ø £kzxP.

ö\¯Ø£õk 

6.  Áø»¯ø©¨¦ •Põø©zxÁ®  (Network Management)

A÷|P©õÚ £oö\¯À •øÓø©PÒ PoÛ Áø»¯ø©¨¦ ö\¯Ø£õkPÐUS 

AÝ\µøÚ¯õP ÂÍ[S®. Áø»¯ø©¨¤À EÒÍ PoÛPÒ, Aa_¨ö£õÔPÒ 

÷£õßÓ Áßö£õ¸ÒPÐ® ÷Põ¨¦PÍõPÄÒÍ ö©ßö£õ¸ÒPÒ ÷£õßÓ 
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ÁÍ[PÐ® P®¤PÎßÔ  CønUP¨£mk¨  £¯ß£kzuUTi¯  Á\v   ö\´¯¨£m -

kÒÍx. Áø»¯ø©¨¤ÝÒ öuõø»ÂÀ EÒÍ PoÛö¯õßøÓ AqPzuUP 

BØÓø» £oö\¯À •øÓø© ÁÇ[S®. CuØöPÚ GÎø©¯õÚ öuõhº£õhÀ 

©ØÖ® £À¿hP ÁøPz öuõhº£õhÀ BQ¯ÁØÖUPõÚ Á\vø¯ PoÛ 

Áø»¯ø©¨¦ ÁÇ[S®. uØ÷£õx PoÛ Áø»¯ø©¨ø£¨ £¯ß£kzvz 

öuõø»Â¾Ò÷Íõ¸hß uµÄz öuõhº£õhÀ Ea\ÍÂÀ ÷©ØöPõÒÍ¨£kQÓx. 

Cz uzxÁ® ÷©PU PoÛa ö\¯Ø£õk (Cloud Computing) GÚ AøÇUP¨£k®.

E¸ 5.11 PoÛ Áø»¯ø©¨¦ •Põø©zxÁ®

(2) £¯|º |m¦ Cøh•Pzøu ÁÇ[SuÀ

£¯|¸hß |hÁiUøPPøÍ ÷©ØöPõÒÍ Cøh•P® AÁ]¯©õS®. £oö\¯À 

•øÓø© ‰»©õP ÷uøÁ¯õÚ ö\¯Ø£õkPøÍ C»SÁõPÄ® GÎø©¯õPÄ® 

÷©ØöPõÒÍz ÷uøÁ¯õÚ PmhøÍPøÍ ÁÇ[SuÀ, AÔÄÖzuÀPøÍ ÁÇ[-

SuÀ BQ¯ÁØøÓ £¯|º |m¦ Cøh•P® BØÖQÓx. C¢u Cøh•Pzøu¨ 

£¯ß£kzvz ÷uøÁ¯õÚ GÀ»õa ö\¯Ø£õkPøÍ²® ]UP¼ßÔ C»SÁõP 

÷©ØöPõÒÍ •iQÓx. 

C[S ¤µuõÚ©õP Cµsk ÁøP¯õÚ Cøh•P[PÒ EÒÍÚ. 

1. PmhøÍU÷Põmk Cøh•P® (CLI - Command Line Interface)

2. ÁøµÂ¯À £¯|º Cøh•P® (GUI - Graphical User Interface) 

 CøÁ £ØÔ Â›ÁõP AÔ¢x öPõÒ÷Áõ®. 

1. PmhøÍU ÷Põmk Cøh•P (CLI - Command Line Interface)  £oö\¯À 

•øÓø© 

 Bµ®£ Põ»[PÎÀ E¸ÁõUP¨£mh \P» PoÛ¨ £oö\¯À •øÓ 

ø©PÎ¾®  PmhøÍU ÷Põmk Cøh•P÷© Põn¨£mhx. E›¯ Pm-

høÍPÒ, AÔÄÖzuÀPÒ BQ¯ÁØøÓ EÒÎkÁuØöPÚ {øÚÄz ysi 
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(Prompt) Põn¨£mhx. ÷uøÁ¯õÚ AøÚzxU PmhøÍPÒ, AÔÄÖzuÀPÒ 

BQ¯ÁØøÓ C¢u {øÚÄz ysi°À EÒÎh ÷Ási¯ {ø» C¸¢ux. 

÷©¾®, C[S  E›¯ PmhøÍPÒ, SÔ  (Syntax) BQ¯ÁØøÓ \›¯õPU øP¯õÒÁx 

AÁ]¯©õQßÓx.

  PmhøÍ

 Á¸ÂøÍÄ

{ø» Põmi

PmhøÍz 

{øÚÄz 

ysi

E¸ 5.12  PmhøÍU÷Põmk Cøh•P®

1.  }[PÒ £¯ß£kzx® PoÛ¨ £oö\¯À •øÓø©°À PmhøÍU 

÷Põmk Cøh•Pzøu¨ ö£Ö® ÂuzøuU GkzxøµUP.

2.  }[PÒ £¯ß£kzx® £oö\¯À •øÓø©°À PmhøÍU ÷Põmk 

Cøh•PzvÀ £¯ß£kzuU Ti¯ PmhøÍPÒ ]»ÁØøÓU 

SÔ¨¤mk, AÁØÔÚõÀ ÷©ØöPõÒÍ¨£k® £oPÒ ]»ÁØøÓ 

GÊxP.

ö\¯Ø£õk

2. ÁøµÂ¯À £¯|º Cøh•P (GUI - Graphical User Interface) £oö\¯À 

•øÓø©

uØ÷£õx £¯ß£õmi¾ÒÍ GÀ»õU PoÛPÎ¾® ÁøµÂ¯À •øÓ°»õÚ 

Cøh•P[P÷Í EÒÍÚ. £¯|›ÚõÀ C»SÁõPa _miø¯¨ £¯ß£kzv 

AÀ»x ÂµÀPøÍ¨ £¯ß£kzv (öuõkvøµö¯ÛÀ) ÷uøÁ¯õÚ ö\¯Ø£õk-

PøÍ ÷©ØöPõÒÍU Ti¯ Á\v CÁØÔÀ EÒÍx. Cuß‰»©õP ªP C»SÁõP 

£oö\¯À •øÓø©ø¯¨ £¯ß£kzv ÷uøÁ¯õÚ |hÁiUøPPøÍ 

÷©ØöPõÒÍ»õ®.

 ÁøµÂ¯À  £¯|º Cøh•Pzxhß Ti¯ £oö\¯À •øÓø©°À    

[Operating  Systems with Graphical User Interfaces (GUI)] |õßS ¤µuõÚ TÖPÒ 

‰»©õP £¯|¸UPõÚ Á\vPÒ ÁÇ[P¨£kQÓx. CøÁ _¸UP©õP WIMP GÚ 

AøÇUP¨£k®. AUTÖPÒ Á¸©õÖ:
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1.      \õÍµ® &     W indows

2.  £hÄ¸ & I cons

3.  £mi¯À & M enus

4.  _mhõß & P ointer         

£mi¯À _mhõß

£hÄ¸

   \õÍµ®

E¸ 5.13 & £¯|º |m¦ Cøh•P®

  1.  }[PÒ £¯ß£kzx® PoÛ¨ £oö\¯À •øÓø©°À 

öu›Ä ö\´¯¨£mh (öÁÆ÷ÁÖ ÁøP¨£mh) Cµsk \õÍ 

µ[PÎÀ Põn¨£k® TÖPøÍ¨ ö£¯›kP.

2.   E[PÍx £oö\¯À •øÓø©°ß £ozuÍzvÀ Põn¨£k® 

£hÄ¸UPÒ AøÚzøu²® ö£¯›kP.

3.  }[PÒ £¯ß£kzx® £oö\¯À •øÓø©°ß GÎø©¯õÚ ö\´{µÀPÒ 

Cµsiß £mi¯ÀPÎÀ EÒÍ \¢uº¨£[PøÍ¨ ¤µv°mk, AøÁ 

£¯ß£kzx® Âuzøu ÂÍUSP.

4. }[PÒ £¯ß£kzx® £oö\¯À •øÓø©°À _mhõß öÁÆ÷ÁÖ 

ÁiÁ[PÎÀ Põn¨£h»õ®. AÆÁiÁ[PÒ ]»ÁØøÓU SÔ¨¤kP.                 

_mhõß ÁiÁzøuz ÷uøÁU÷PØ£ GÆÁõÖ ©õØÔU öPõÒÍ»õ® GÚU 

SÔ¨¤kP.

5. £oö\¯À •øÓø©²hß öuõÈØ£k®÷£õx _mi²hß J¨¤køP°À 

ÂµÀPÒ (öuõkøP²nº EzvPÒ) £¯ß£kzxÁuß AÝT»[PÒ, 

¤µvT»[PÒ BQ¯ÁØøÓU SÔ¨¤kP.   

ö\¯Ø£õk
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£oö\¯À •øÓø©°À Põn¨£k® ¤µ÷¯õP ö©ßö£õ¸ÒPÒ

 PoÛ°ß ö\¯Ø£õmiØS¨ £oö\¯À •øÓø© £À÷ÁÖ ÁÈPÎÀ 

EuÄQßÓx Gß£øu }[PÒ uØ÷£õx AÔ¢xÒÏºPÒ. PoÛ°ß ̂ µõÚ C¯UP® 

©ØÖ® PoÛUS HØ£hUTi¯ Aa_ÖzuÀPøÍz ukzuÀ BQ¯ÁØÖUöPÚ 

£À÷ÁÖ ¤µ÷¯õP ö©ßö£õ¸ÒPÒ £oö\¯À •øÓø©°À EÒÍÚ. •ßÚº 

ö£õxÁõP ¤µ÷¯õP ö©ßö£õ¸ÒPøÍ uÛzuÛ¯õP öPõÒÁÚÄ ö\´x 

{ÖÁ ÷Ási C¸¢u÷£õx® CßÖ £» ¤µ÷¯õP ö©ßö£õ¸ÒPÒ £oö\¯À 

•øÓø©°ÝÒ÷Í÷¯ EÒÍhUP¨£mkÒÍÚ. 

£oö\¯À •øÓø©°À PõnzuUP ¤µ÷¯õP ö©ßö£õ¸ÒPÒ ]» Á¸©õÖ: 

♦	 Põ¨¦ ö©ßö£õ¸Ò     & ÷Põ¨¦PøÍ ¤µvö¯kzuÀ  ©ØÖ®   ÁßÁmk  

(Backup Software)  PÎ¼¸¢x Põ¨ö£kzuÀ. 

♦		 Ámk £Ÿm]¨£õß   &     ÁmkPÎÀ SøÓ£õkPÒ EÒÍ Ch[PøÍ CÚ[  

(Disk  Scanner)  Põq® ö©ßö£õ¸Ò.

♦			Ámk xshõUPÀ &        ÁmiÀ öÁÖø©¯õÚ ]Ô¯ ¤µ÷u\[PøÍ Cøn                                                                                                                                   

    (Disk  Defragmentation)     zx   ö£›¯   ¤µ÷u\zøu   E¸ÁõUQ    ÁmiøÚ  

  JÊ[Pø©zuÀ.

♦		 ÷Põ¨¦PÒ / uµÄPøÍa & AvP  öPõÒÍÍÄøh¯  ÷Põ¨¦UPøÍa  _¸UQ  

_¸USuÀ    SøÓ¢u öPõÒÍÍÄøh¯uõP ©õØÖuÀ.

    (File Compression)
                     

♦			öPõÒ£o •Põø©¯õÍº 

    (Task Manager)            &    Cuß ‰»©õPU  PoÛ°À  ö\¯Ø£k® ö\´{µÀ  

    PÒ, •øÓÁÈPÒ  £ØÔ¯ uPÁÀPøÍ ÁÇ[SuÀ,  

    PoÛ°ß ÁÇø©¯õÚ {ø»ø©PøÍ PõmkuÀ.  

     

♦			•øÓø© ÁÊUPøÍU 

    PshÔ²® P¸Â      &  Cuß  ‰»®  PoÛ°À  AÀ»x PoÛ Áø»¯        

    (System diagnosis tools) ø©¨¤À   EÒÍ   ö©ßö£õ¸ÒPÒ   ©ØÖ®  Áß  

             ö£õ¸ÒPÎ¾ÒÍ SøÓ£õkPÒ CÚ[Põn¨£k®.

                                        

♦			|a_ {µÀ Gvº¨¦  

    ö©ßö£õ¸ÒPÒ       &     ¦Óz÷u°¸¢x   Á¸QßÓ    |a_    ö\´{µÀPøÍ         

 (Anti - Virus Software) CÚ[PõnÀ, AÁØøÓ APØÖuÀ BQ¯Ú ‰»®   

     PoÛø¯¨ £õxPõzuÀ.
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♦	 uµÄPÒ AÀ»x ÷PõøÁPøÍ¨ £iö¯kzuÀ / öÁmiö¯õmkuÀ ÷£õßÓ    

P¸©[PÐUS®  AÁØøÓ SÖQ¯  Põ»zvØS¨  ÷£qÁuØS® Clip board 
EuÄ®.

♦				uµÄ J¸[Qøn¨¦ ö©ßö£õ¸Ò & Cuß  ‰»©õP  •ußø©  ÷uUPzv¼            

     (Data synchronization Software)              ¸¢x   C»USz  ÷uUPPzvß   EÖvz  

           ußø©ø¯  ÷£quÀ.

♦	 Ámk¨ ¤›ÂhÀ ö©ßö£õ¸Ò &   Cuß   ‰»©õP  uÛ¯õÚ   ö\¾zvø¯ 

(Disk Partitioning Software)       (drive)   £»  u¸UPa ö\¾zvPÍõP  ¤›U  

       S®   Á\v ö\´uÀ.   

     

♦		 PoÛa  ö\¯Ø£õk ÷©ØöPõÒÍ¨£hõu {ø»°À PnÛø¯¨ £õx-

Põ¨£uØöPÚ  Screeen Saver  £¯ß£kzu¨£hÀ.

♦	 	PoÛ°À {ÖÁ¨£mkÒÍ ö©ßö£õ¸ÒPÎß ÂÁµ[PÒ ©ØÖ® öuõhº 

¦øh¯ Áßö£õ¸ÒPÒ £ØÔ¯ ÂÁµ[PøÍ ÁÇ[SuÀ System	 profiles	Cß 

‰»©õP ÷©ØöPõÒÍ¨£k®.

♦	 PoÛ Áø»¯ø©¨¦PÎß öuõhº¦øhø©ø¯¨ £S¨£õ´uÀ, uµÄ 

©õØÕmøha ÷\õvzuÀ ÷£õßÓ P¸©[PÐUPõP Áø»¨ £¯ß£õmk 

ö©ßö£õ¸ÒPÒ (Network utilities) £¯ß£kzu¨£hÀ.

C[S G®©õÀ ¤ßÁ¸® £¯ß£õmk ö\´{µÀPÒ ]» £ØÔ ©õzvµ® P¸zvØ 

öPõÒÍ¨£k®.

 ■ Ámk¨ ¤›ÂhÀ  & Disk Partitioning
 ■ Ámk ÁiÁø©zuÀ  & Disk Formatting
 ■ J¸[Pø©zuÀ & Defragmentation

Ámk¨ ¤›ÂhÀ (Partitioning) 

 ö£õxÁõP PoÛ°À ö£ÍvP Ÿv¯õP J¸ ÁßÁmk ©mk÷© 

Põn¨£k®. GÛÝ®, Ax u¸UP Ÿv¯õP £õP[PÍõP ÷ÁÓõUP¨£k®. CÆÁõÖ 

ÁßÁmøh ÷uøÁU÷PØ£ £õP[PÍõP¨ ¤›zx ÷ÁÓõUSuÀ ÁßÁmk¨ 

¤›ÂhÀ  (Partitioning) GÚ¨£k®.

 Aø©ÁiÁ¨£kzx® (Configure) •uØ \¢uº¨£zv÷»÷¯ CuøÚ ÷©Ø 

öPõÒÍ ÷Ásk®. AÆÁõ÷Ó, H÷uÝ® PõµnzvÚõÀ ÷©»vP ÁßÁmkUPøÍ 

PoÛ°À ÷\ºUS®÷£õ÷uõ AÀ»x HØPÚ÷Á EÒÍ ÁßÁmøh APØÔ¨ ¦v¯ 

ÁßÁmøh  {ÖÄ®÷£õ÷uõ A¢u ÁßÁmøh ¤›ÂhÀ ö\´xöPõÒÍ •i²®.
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 ÷©¾®, HØPÚ÷Á ÷©ØöPõÒÍ¨£mkÒÍ ¤›Âhø» ©õØÔ¯ø©UP 

÷Ási¯ ÷uøÁ HØ£iß, A¢ua \¢uº¨£zv¾® ¤›Âhø» ÷©ØöPõÒÍ»õ®. 

GÆÁõöÓÛÝ® ¤›ÂhÀ ÷©ØöPõÒÍ¨£mkÒÍ ÁßÁmiÀ «sk® 

¤›Âhø» ÷©ØöPõÒÐ®÷£õx E›¯ ÁßÁmi¾ÒÍ AøÚzxz uµÄPÐ® 

AÈ¢xÂk®. BP÷Á, CÆÁõÓõÚ \¢uº¨£[PÎÀ ÷uøÁ¯õÚ uµÄPÎß 

Põ¨ø£  (Backup) ö£ØÖUöPõÒÁx •UQ¯©õÚuõS®.

 R÷Ç²ÒÍ Á›¨£h[PÎÀ ¤›Âhø» ÷©ØöPõÒÍ •ßÚ¸® ¤›ÂhÀ 

÷©ØöPõsh ¤ßÚ¸® ÁßÁmiß ÷uõØÓ® Põmh¨£mkÒÍx. 

E¸ 5.14 ÁßÁmk ¤›Âh¾US •ßÚ¸® ¤ßÚ¸® 

¤›Âh¼ß AÁ]¯®

£À÷ÁÖ Põµn[PÐUöPÚ ÁßÁmk TÖPÍõP¨ ¤›Âh¨£k®. ¤µuõÚ 

Põµn[PÒ ]» Á¸©õÖ:

 ² PoÛ°À ÷uUP¨£k® Âh¯[PøÍ öÁÆ÷ÁÓõPa ÷\ªzuÀ. (Euõµn©õP 

ö©ßö£õ¸ÒPÒ J¸ ¤›Â¾® uµÄPÒ CßÝö©õ¸ ¤›Â¾® ÷\ªUP¨ 

£k®).
 ² PoÛ¨ £oö\¯À •øÓø©PÒ £»ÁØøÓ {ÖÄuÀ (Euõµn©õP J÷µ 

PoÛ°À Windows, Ubuntu BQ¯ £oö\¯À •øÓø©PøÍ {ÖÄuÀ).

 ² £oö\¯À •øÓø©°ß ÷uøÁPøÍ¨ §ºzvö\´uÀ (Euõµn©õP ]» 

\¢uº¨£[PÎÀ £oö\¯À •øÓø©°ß £oUöPÚ ÁßÁmiß ÷©»vP 

¤›Ä ÷uøÁ¨£k®).

 ÁßÁmiÀ TÖPÍõP¨ ¤›Âhø» ÷©ØöPõÒÐ®÷£õx AÁØÔß 

TÖPøÍ uÛzuÛ¯õÚ ö\¾zvPÍõPU Põn»õ®. Windows `Ç¼À C¢uU 

TÖPÒ JÆöÁõßÖ® C GÊzvÀ Bµ®¤zx ö£¯›h¨£k®. •u»õ® ö\¾zv 

C ö\¾zv GÚ¨£k®. CµshõÁx ö\¾zv D ö\¾zv GÚ ö£¯›h¨£k®.

(New drive) (Partitioned  drive)

¦v¯ ö\¾zv
¤›Âh¨£mh ö\¾zv
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SÔ¨¦ : Âß÷hõì `Ç¼À PoÛ°À ö£õ¸zu¨£mkÒÍ C»UP•øÓ 

£ÀvÓÁõØÓÀ Ámka ö\¾zv, £Îa^mk {øÚÁP® BQ¯ 

ÁØøÓa ö\¾zvPÍõP÷Á PoÛ CÚ[Põq®. CÁØÔß ö£¯¸® 

C GÊzxUS¨ ¤ßÚº (ÁßÁmiß TÖUS¨ ö£¯ºPÒ ÁÇ[P¨£mh 

¤ßÚº) AkzxÁ¸® B[Q» GÊzuõÀ ÁøPU SÔUP¨£k®.
 

 Linux `Ç¼À ÁßÁmiß TÖPÒ,  C»UP £ÀvÓÁõØÓÀ Ámk,                         

£Îa^mk {øÚÁP® BQ¯Ú AøÚzx® ÷Põ¨¦ EøÓ°ÚõÀ (Linux CÀ CøÁ 

iöµUh› GÚ AøÇUP¨£k®.) ¤µv±k ö\´¯¨£k®. Linux `Ç¼À C, D GßÓ 

ö£¯ºPÎÀ ö\¾zvPøÍU Põn•i¯õx.

Ámk ÁiÁø©zuÀ (Disk Formatting) 

 ÁßÁmiÀ ¤›Âhø» ÷©ØöPõsh÷£õx ©õzvµ÷© AvÀ uµÄ 

PøÍa ÷\ªUP •i²®. A¢uU TÖPÒ AøÚzx® uÛzuÛ¯õP G®©õÀ 

ÁiÁø©UP¨£h ÷Ásk®.

        ÁiÁø©zuÀ ‰»©õP ÁßÁmk, ö|QÌÁmk BQ¯ÚÁØÔÀ AuØS›¯ 

•øÓø©ø¯ £¯ß£kzv ÷Põ¨¦z uµÄPøÍ ÷\ªUP HØÓÁõÖ ©õØÔ 

¯ø©UP¨£k®.

 uØPõ»zvÀ \¢øu°À A÷ÚP £Îa^mk {øÚÁP[PÒ •ßÚ÷µ 

ÁiÁø©UP¨£mh (Pre-formatted) {ø»°À EÒÍuõÀ AÁØøÓ ÷|µi¯õP¨ 

£¯ß£kzu •i²®.

÷uøÁU÷PØ£ ÁßÁmøh÷¯õ ö|QÌÁmøh÷¯ «sk® «sk® 

ÁiÁø©zu¾US Em£kzv¨ £¯ß£kzu •i²®. Cuß÷£õx Ámi¾ÒÍ 

AøÚzxz uPÁÀPÐ® AÈ¢xÂk® Gß£øu bõ£PzvÀ øÁzv¸¨£x 

AÁ]¯©õS®. BP÷Á, Ámi¾ÒÍ •UQ¯©õÚ ÷Põ¨¦PøÍ ÁiÁø©UP 

•ßÚº AÁØÔß Põ¨ø£  (Backup) Gkzx øÁzxU öPõÒÁx AÁ]¯©õS®.

¤›ÂhÀ, ÁiÁø©zuÀ BQ¯Ú ‰»©õP ö\¾zvPÒ uµÄPøÍ ÷\ª¨£uØS 

HØÓÁõÖ ©õØÓ¨£k®.

GÛÝ®, PoÛ°À •uØuhøÁ¯õP £oö\¯À •øÓø©ø¯ {ÖÄ®÷£õx 

¤›ÂhÀ, ÁiÁø©zuÀ BQ¯Ú ÷©ØöPõÒÍ¨£k®. Auß ¤ßÚº CøÁ ªP 

A›uõP÷Á ÷©ØöPõÒÍ¨£k®. 

R÷Ç²ÒÍ E¸UPÎÀ ¤›Âhø» ÷©ØöPõÒÍ¨£mh  ÁßÁmiÀ ÁiÁø©zuÀ 

ö\´¯¨£mh ¤ßÚº C¸US® Âu® Põmh¨£mkÒÍx.
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¤›Âh¼ß 

•ß

¤›Âh¼ß 

¤ß

ÁiÁø©UP¨£mh 

¤ß

E¸ 5.15 ÁßÁmiÀ ¤›ÂhÀ ÷©ØöPõÒÍ •ßÚº, ¤›ÂhÀ ÷©ØöPõsh ¤ßÚº, 

ÁiÁø©zuÀ ÷©ØöPõÒÍ¨£mh ¤ßÚº Põn¨£k® Âu®

J¸[Pø©zuÀ  (Defragmentation)

 Cx Âß÷hõì `Ç¼À ÷©ØöPõÒÍ¨£k®. ÷Põ¨¦ ÁßÁmiÀ 

Ch¨£k®÷£õx ]» \¢uº¨£[PÎÀ (÷Põ¨¦PÒ öPõÒÍÍÂÀ AvP©õP 

EÒÍ÷£õx) AÁØøÓ  J÷µ uhøÁ°À ÷\ªUP •i¯õu {ø» HØ£h»õ®. 

CÆÁõÖ ÷Põ¨¤ß JÆöÁõ¸ £Sv²® öÁÆ÷ÁÖ Ch[PÎÀ ÷\ªUP¨£hÀ 

xshõUPÀ  GÚ¨£k®.

E¸ 5.16 ÁmiÀ ÷Põ¨¦PÒ ÷\ªUP¨£mkÒÍ Âu®

 Â÷\h©õPU ÷Põ¨¦PÒ AiUPi öuõSUP¨£kÁuõÀ ÷Põ¨¤ß AÍÄ 

AvP›¨£uÚõÀ ÷Põ¨¦PøÍ¨ £õP[PÍõP¨ ¤›zx Ámiß öÁÆ÷ÁÖ 

£SvPÎÀ £oö\¯À •øÓ ‰»® ÷\ªUP»õ®. ÷Põ¨¦PøÍ }UQ ÁmiÀ ¦v¯ 

÷Põ¨¦PÎØPõÚ Chzøu¨ £¯ß£kzxÁuØS •¯ÀÁuÚõ¾® xshõUPÀ 

{PÊ®. 

 xshõUPÀ ‰»©õP ÷Põ¨¤øÚ Áõ]UP •¯¾®÷£õx Cuß £õP[PÒ 

J÷µ Á›ø\°À (JßÖUöPõßÖ Asø©°À) Aø©¢vµõø© Põµn©õP AÁ 

ØøÓ Áõ]UP }sh ÷|µ® ö\ÀÁuÚõÀ PoÛ°ß ö\¯ØÔÓß SøÓ²®.

 PoÛ°ß ö\¯ØÔÓß SøÓ²ö©Ûß Cx xshõUPÀ Põµn©õP {PÌ¢ 

v¸UP»õ® GÚ FQUP»õ®. (PoÛ°ß ö\¯ØÔÓß SøÓÁøh¯ ÷ÁÖ £» 

Põµn[PÐ® EÒÍÚ). CuØöPÚ ÂøµÁõP J¸[Pø©zuø» (Defragmentation) 
÷©ØöPõÒÁ÷u ]Ó¢uuõS®.
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E¸ 5.17 ÁmiÀ ÷Põ¨¦PÒ ÷\ªUP¨£mkÒÍ Âu®

 GÆÁõöÓÛÝ®, Linux I Ai¨£øh¯õPU öPõsh £oö\¯À •øÓ 

ø©PÎÀ ÷Põ¨¦PÒ ÷ÁÖ •øÓ°÷»÷¯ ÷\ªUP¨£k®. C[S ÷Põ¨¦PÒ 

JßÖUöPõßÖ Asø©°À ÷\ªUP¨£hõx. JÆöÁõ¸ ÷Põ¨¦UöPÚÄ® AvP 

Ch® JxUP¨£mk JßÖUöPõßÖ ÷\´ø©¯õPa ÷\ªUP¨£k®. CuÚõÀ 

Bµ®£ ÷Põ¨¤ß AÍÄ ö£›¯uõPU Põn¨£iÝ® Ax J÷µ uhøÁ°À ÷\ªUPU 

Ti¯ Ch® JxUP¨£mi¸US®. CuÚõÀ Linux £oö\¯À •øÓø©PÎÀ 

xshõUPÀ ÷©ØöPõÒÁuØPõÚ Áõ´¨¦U SøÓÁõS®. AÆÁõ÷Ó ÷Põ¨¤ß 

öPõÒÍÍÄ ªP¨ ö£›uõ°ß A¢uU ÷Põ¨¦ ÷Á÷Óõº ChzvÀ ö£¯ºUP¨£mk 

÷\ªUP¨£h Linux £oö\¯À •øÓø© |hÁiUøPö¯kUS®. CußPõµn©õP 

Linux £oö\¯À •øÓø©PÎÀ J¸[Pø©zu¾UöPÚ ÷©»vP ¤µ÷¯õP 

ö©ßö£õ¸ÒPÒ ÷uøÁ¨£hõx. 

5.2 ÷Põ¨¦ •øÓø©ø¯ CÚ[PõnÀ

 PoÛ°À ö£¸©ÍÁõÚ uµÄPøÍ ÷\ªzuÀ ©ØÖ® ÷\ªUP¨£mh 

uµÄPøÍ ªPU SÖQ¯ Põ»zvÝÒ «sk® ö£ØÖUöPõÒÍÀ BQ¯ Á\vPøÍ 

ÁÇ[PU Ti¯ ö£õÔ•øÓ÷¯ CxÁõS®. CÆÁõÖ ÷\ªUP¨£k® uµÄPÎß 

Aøh¯õÍzøu CÚ[PõnUTi¯uõP |õ® AuØöPÚU ÷Põ¨¦¨ ö£¯öµõßøÓ 

ÁÇ[P ÷Ásk®. AÆÁõ÷Ó PoÛ°À £oö\¯À •øÓø© ©ØÖ® ¤µ÷¯õP 

ö©ßö£õ¸ÐUS›¯ £õ›¯  ÷Põ¨¦PÒ Põn¨£k®. CÆÁõÖ PoÛ°ÝÒ 

Põn¨£k® \P» ÷Põ¨¦PÐ® Cµsk TÖPøÍU öPõskÒÍÚ. AøÁ 

÷Põ¨¦¨ ö£¯º (File Name) }m] (Extension) ÷£õßÓÚÁõS®. BÚõÀ £oö\¯À 

•øÓø© ‰»® ÷Põ¨¤ß }m] £¯|¸USz öu›¯õuÁõÖ ÷£n¨£k®.

5.2.1  ÷Põ¨¤ß }m]ø¯ AÁuõÛzuÀ

Start  Control Panel  Folder Options View  Hide Extensions for known 
File Types (E¸ 5.18 I AÁuõÛUP)  \› Aøh¯õÍzøu ( ) }USP.  OK 

PmhøÍ¨ ö£õzuõøÚ AÊzxP.  
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E¸ 5.18 ÷Põ¨¤ß ÂÁµ[PÒ

 Cuß  ¤ßÚº  G¢uöÁõ¸  ÷Põ¨¦  EøÓ°ß  «x®  Cµmøha ö\õhU

Suø»  (Double click) ÷©ØöPõsk Av¾ÒÍ ÷Põ¨¦  }m]°ß ö£¯øµ 

AÁuõÛUP»õ®. 

 

÷Põ¨¤ß ö£¯º
÷Põ¨¤ß ö£¯º Auß }m] 

BQ¯ÁØøÓ ÷ÁÓõUS® SÔ±k (.)}m]

E¸ 5.19 }m]ø¯¨  £õºøÁ°höÁÚz  u¯õ›UP¨£mh  \õÍµ®

SÔ¨¦ : ÷Põ¨¤ß }m]°¼¸¢x £oö\¯À •øÓø©°ß ÷Põ¨¦ ÁøPø¯  

(File Type) CÚ[Põn»õ®.
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 £À÷ÁÖ ÁøP¨£mh ÷Põ¨¦ }m]PÒ (File extension) EÒÍÚ. AÁØÖm 

]» Á¸©õÖ,

÷Põ¨¤ß }m] ÷Põ¨¦ ÁøP

exe Executable
docx Word
xlsx Excel
pptx PowerPoint
accdb Access

£oö\¯À •øÓø© ‰»® ÷Põ¨¦ öuõhº£õP¨ ÷£n¨£k® ÷©»vP 

Âh¯[PÒ

÷Põ¨¤øÚ ÷\ªUS® \¢uº¨£zvÀ G®©õÀ ÷Põ¨¤ß ö£¯º ©ØÖ® ÷£n¨£k®  

Ch® BQ¯Ú ÁÇ[P¨£k®. CøÁ uÂµ ÷Põ¨¦z öuõhº£õÚ £» uµÄPÒ 

÷£n¨£k®. AÁØÔÀ ]» Á¸©õÖ.

 ² ÷Põ¨¦ ÁøP (Type of File)

 ² ÷Põ¨¤ß £¸©ß (Size of the File)

 ² ÷Põ¨¦  ÷\ªUP¨£mh  vPv²® ÷|µ•®  (Saved Date and 
Time)

CÆÂ£µ[PøÍ SÔzu ÷Põ¨¤øÚ Á»x ö\õhUSuÀö\´x (Right 
Click), ö£Ó¨£k® £mi¯¼¾ÒÍ Properties   Gß£øu öu›Äö\´ÁuõÀ 

AÁuõÛUP»õ®.
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E¸ 5.20 ÷Põ¨¤ß ÂÁµ[PøÍ AÁuõÛzuÀ

÷Põ¨¤ß AÍÄ

÷Põ¨¦ ÷uUP¨£mkÒÍ 

Ch® 

÷Põ¨¦ ÷\ªUP¨£mh 

vPv, ÷|µ® 

÷Põ¨¤øÚ ÷uUS

ÁuØS {øÚÁPzvÀ 

÷ÁÓõUP¨£mkÒÍ 

Chzvß AÍÄ

÷Põ¨ø£¨  ÷£qÁuØPõÚ Chzøuz öu›Äö\´uÀ

 ÷Põ¨ø£¨ ÷£q®÷£õx |õ® Â¸®¤¯ ÷\ª¨£Pzøu öu›Äö\´x 

öPõÒÍ÷Ásk®. Ax ö\¾zv GÚ¨£k®. ÁßÁmk ¤›ÂhÀ ö\´¯¨£mh 

¤ßÚº ö\¾zvPÒ £» Põn¨£k®.

ö\¾zvPÒ  (Drives)

 PoÛ°À uµÄPøÍa ÷\ª¨£uØS¨ ¤µuõÚ©õP ÁßÁmk £¯ß£kzu¨ 

£k®. Ax £õP[PÍõP¨ ¤›ÂhÀ ö\´¯¨£hÂÀø»ö¯Ûß Ax [C:] ö\¾z-

v¯õPÄ®, ¤›ÂhÀ ö\´¯¨£mi¸¨¤ß £õP[PÎß GsoUøPUS Aø©¯ 

[C:], [D:], [E:] ÷£õßÓ ö\¾zvPÍõPÄ® Põm]¨£kzu¨£k®. 
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 PoÛ°À CD, DVD, Blu Ray Disk ö\¾zvPÒ Põn¨£kö©Ûß 

ÁßÁmiß £õP[PÎß GsoUøPUSa \õº£õP CÆÁõÓõÚ ö\¾zvPÐUS 

GÊzx¸UPÒ ÁÇ[P¨£k®. Euõµn©õP ÁßÁmk |õßS £SvPÍõP¨ ¤›UP¨ 

£mi¸¨¤ß  [C:], [D:], [E:] [F:] GÚ Põmh¨£k®. A¨÷£õx CD, DVD, Blu Ray Disk 
BQ¯ÁØÖUS›¯ ö\¾zv [G:] GÝ® GÊzvÚõÀ SÔzxU Põmh¨£mi¸US®.

 AÆÁõ÷Ó £Îa^mk {øÚÁPzøu (Flash Drive) PoÛ°À CønUS® 

÷£õx®  AuøÚU SÔ¨¤h  GÊzöuõßÖ ÁÇ[P¨£k®. Euõµn©õP Ax [K:] 
GÚ Põmh¨£h»õ®.

 PoÛ°¾ÒÍ  ö\¾zvPÎß GsoUøPø¯ AÁuõÛ¨£uØS Com-
puter GÝ® £hÄ¸øÁz vÓ¢x öPõÒP. (E¸ 5.21 I¨ £õºUP) C[S ¦Óz÷u 

ö£õ¸zu¨£k® CD, DVD, Blu Ray Disk, Flash Drive ÷£õßÓ APØÓ¨£hUTi¯ ÷uUP-

P[PÒ (Removable Storage) ö\¾zvPÍõPU Põmh¨£k®. 

E¸ 5.21 ö\¾zvPøÍ AÁuõÛzuÀ 

 ÷Põ¨¦PøÍ øÁ¨£uØöPÚ ö\¾zvPÒ £¯ß£kzu¨£mh÷£õx® 

ö£õxÁõPU ÷Põ¨¦PÒ C[S ÷|µi¯õP Ch¨£kÁvÀø». ö\¾zv°ÝÒ 

÷Põ¨¦ EøÓø¯ (Folder) E¸ÁõUQ AuÝÒ ÷Põ¨¦PÒ øÁUP¨£k®. ÷Põ¨¦ 

EøÓPÐUS® E›¯ ö£¯øµ ÁÇ[P ÷Ásk®.
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÷Põ¨¦ EøÓö¯õßøÓz u¯õ›zuÀ

1. ÷Põ¨¦ EøÓø¯z u¯õ›UP ÷Ási¯ ö\¾zvø¯z öu›Äö\´P.

2. £mi¯Ø £møh°À (Menu Bar) File £mi°À New Cß RÊÒÍ ÷Põ¨¦ 

EøÓø¯z (Folder) öu›Äö\´P. CÀø»÷¯À P¸Â¨ £møh°À New Folder  
CøÚz öu›Äö\´P.

3. ö£õ¸zu©õÚ ö£¯øµ ÁÇ[SP.

÷Põ¨¦PÒ, ÷Põ¨¦ EøÓPøÍU øP¯õÍÀ

ö\¾zvPÎ¾ÒÍ ÷Põ¨¦PÒ, ÷Põ¨¦ EøÓPÒ BQ¯ÁØÔÀ £À÷ÁÖ 

öuõÈØ£õkPøÍ ÷©ØöPõÒÍ÷Ási HØ£h»õ®. 

÷Põ¨¦, ÷Põ¨¦øÓ  BQ¯ÁØøÓ |PÀö\´x JmkuÀ (Copy & Paste)

1. |PÀ ö\´¯¨£h ÷Ási¯ ÷Põ¨¦ / ÷Põ¨¦ EøÓø¯z öu›Ä ö\´uÀ.

2. |PÀ ö\´ÁuØPõÚ Copy PmhøÍø¯a ö\¯Ø£kzxuÀ. 

 (Edit	→	Copy AÀ»x Ctrl +C)

3. JmkuÀ ö\´¯÷Ási¯ ö\¾zvø¯ AÀ»x ÷Põ¨¦ EøÓø¯z öu›Ä 

ö\´uÀ.

4. Jmk (Paste) GÝ® PmhøÍø¯a ö\¯Ø£kzuÀ. (Edit	→	Paste AÀ»x Ctrl + V)

÷Põ¨¦, ÷Põ¨¦ EøÓ BQ¯ÁØøÓ öÁmi JmkuÀ (Cut & Paste)

1. öÁmiö¯õmh ÷Ási¯ ÷Põ¨¦ / ÷Põ¨¦ EøÓø¯z  öu›Ä ö\´uÀ.

2. öÁmk (Cut) GÝ® PmhøÍø¯a ö\¯Ø£kzuÀ. (Edit	→	Cut  AÀ»x  Ctrl+X)

3. Jmh ÷Ási¯ ö\¾zvø¯ AÀ»x ÷Põ¨¦ EøÓø¯z öu›Ä ö\´uÀ.

4. Jmk  (Paste) GÝ® PmhøÍø¯a ö\¯Ø£kzuÀ. (Edit	→	Paste   AÀ»x   Ctrl + V)

÷Põ¨¦, ÷Põ¨¦ EøÓ BQ¯ÁØÖUS «Ò ö£¯›hÀ (Rename)

1. ö£¯º ©õØÓ® ö\´¯¨£h ÷Ási¯ ÷Põ¨¦ / ÷Põ¨¦ EøÓø¯z öu›Ä 

ö\´uÀ.

2. File £mi°À Rename PmhøÍø¯U ö\¯Ø£kzxuÀ.

3. Ch¨£h ÷Ási¯ ö£¯øµ umha_a ö\´x Enter \õÂø¯ AÊzxuÀ.
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÷Põ¨¦, ÷Põ¨¦ EøÓ BQ¯ÁØøÓ }USuÀ (Delete)

1. APØÓ¨£h÷Ási¯ ÷Põ¨¦ / ÷Põ¨¦ EøÓø¯z öu›Äö\´uÀ.

2. File £mi°À Delete GÝ® PmhøÍø¯a ö\¯Ø£kzuÀ / \õÂ¨£»øP°À 

Delete \õÂø¯ AÊzxuÀ. 

3. A¨÷£õx ÷uõßÖ® ö\õÀ»õhØ ö£mi°À Yes GÝ® PmhøÍø¯a 

ö\¯Ø£kzxuÀ. 

E¸ 5.22   Delete ö\õÀ»õhØ ö£mi 

Cuß÷£õx }UP¨£mh ÷Põ¨¦ / ÷Põ¨¦øÓ Recycle Bin CÀ uØPõ¼P©õP ÷uUQ 

øÁUP¨£k®.

}UP¨£mh ÷Põ¨¦ / ÷Põ¨¦øÓø¯ «Ò{ø»¨£kzuÀ (Restore)

1. Recycle Bin CøÚz vÓ¢xöPõÒÍÀ.

2.  CvÀ «Ò{ø»¨£kzu¨£h ÷Ási¯ ÷Põ¨¦ / ÷Põ¨¦øÓø¯z öu›Ä 

ö\´uÀ.

3.  File £mi¯¼À Restore PmhøÍø¯a ö\¯Ø£kzxuÀ.
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 ² PoÛ°ß ö\¯Ø£õmiØS £oö\¯À •øÓø© ªP CßÔ¯ø©¯õu 

uõS®.

 ² PoÛ°À {ÖÁ¨£mh  AøÚzx¨ ¤µ÷¯õP ö©ßö£õ¸ÒPÐ® 

£oö\¯À•øÓø© ‰»÷© ö\¯Ø£kzu¨£k®.

 ² £¯|º PoÛ ö©ßö£õ¸ÒPÐhß öuõhº¦Óz ÷uøÁ¯õÚ Á\vPÒ 

£oö\¯À •øÓø© Cøh•Pzvß ‰»® ÁÇ[P¨£k®.

 ² PmhøÍU÷Põmk Cøh•Pzøu Âh ÁøµÂ¯Ø £¯|º Cøh•P® 

£¯|¸hß ªP ö|¸UP©õPa ö\¯Ø£k®.

 ² uÛ¨ £¯ß£õk, £À £¯ß£õk, £À öPõÒ£o, {PÌ÷|µ® GÚ £o 

ö\¯À •øÓø©PÒ £» ÁøP¨£k®.

 ² J¸ uhøÁ°À J¸ £¯|º ©mk÷© ö\¯Ø£h Á\v ÁÇ[S® £o 

ö\¯À •øÓø© uÛ¨ £¯ß£õmk¨ £oö\¯À •øÓø© BS®.

 ² J¸ uhøÁ°À £» £¯|ºPÐUSa ö\¯Ø£h Á\v ÁÇ[S® £o ö\¯À 

•øÓø© £À£¯ß£õmk £oö\¯À •øÓø© GÚ¨£k®. 

 ² J¸ uhøÁ°À £» ö\¯Ø£õkPøÍ ÷©ØöPõÒÍzuUP BØÓÀ 

öPõshx £À öPõÒ£o  £oö\¯À •øÓø© GÚ¨£k®.

 ² £oö\¯À •øÓø©°ß ‰»©õP PoÛ°¾ÒÍ AøÚzx¨ £õP[ 

PÐ® •Põø©zxÁ® ö\´¯¨£k®.

 ² £oö\¯À •øÓø©ø¯ PoÛ°À {ÖÁ •ßÚº ÁßÁmøh¨ 

£õP[PÍõP¨ ¤›zx ÂkuÀ, ¤›ÂhÀ GÚ¨£k®.

 ² ÷Põ¨£õÚx ÷Põ¨¦¨ ö£¯º ©ØÖ® ÷Põ¨¦ }m] ÷£õßÓÁØøÓU 

öPõsi¸US®.

 ² ÷Põ¨¦PøÍ¨ ÷£qÁuØS ÷Põ¨¦ EøÓ £¯ß£kzu¨£k®.

 ² ÷Põ¨¦UPøÍ  ÷uUSÁuØPõP ÷Põ¨¦øÓPÒ £¯|›ÚõÀ ö\¾zv°À 

E¸ÁõUP¨£h ÷Ásk®.

ö£õÈ¨¦
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6 ö\õÀ •øÓÁÈ¨£kzuÀ

C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ, 

 ² ö\õÀ •øÓÁÈ¨£kzuÀ £ØÔ¯ P¸zx

 ² ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸Îß £¯ß£õkPÒ

 ² BÁnö©õßøÓz u¯õ›zuÀ

 ² ÁiÁø©zuÀ •øÓPÒ

 ² BÁnzvÀ B¯zu¨£h®, ÁøµÂ¯À E¸UPÒ, AmhÁønPÒ 

BQ¯ÁØøÓ EÒÎhÀ

 ² BÁn® JßøÓ ÷\ªzuÀ ©ØÖ® vÓzuÀ

 ² Ag\À JßÔøn¨¦

 ² BÁnzøu Aa]hÀ

 ² SÖUSÁÈa \õÂPÒ

 Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

6.1 ö\õÀ •øÓÁÈ¨£kzuÀ £ØÔ¯ AÔ•P®
 

           

Piu® 

AÔUøP

AøÇ¨¤uÌ

\õßÔuÌ

E¸ 6.1

      

 £õh\õø»°ß |h¨¦Á¸hU Pø»ÂÇõøÁ 

ªP Â©ºø\¯õPU öPõshõh ÷Áskö©Ú Av£º 

E©US AÔÂzxÒÍõº.  }[PÒ, ÂÇõÂß HØ£õm-

kUSÊ A[PzuÁµõP {¯ªUP¨£mhø© ªP 

©QÌa]¯õÚuõP C¸¢v¸US®. Pø»ÂÇõÂØS›¯ 

BÁn[PøÍz u¯õ›US® ö£õÖ¨¦® E©x uø» 

ø©°»õÚ SÊÂh® J¨£øhUP¨£mkÒÍx. CuØ 

öPÚ ö\´¯÷Ási¯ Âh¯[PÒ Á¸©õÖ:
 ² AøÇ¨¤uÌ u¯õ›zuÀ

 ² ö£Ø÷Óõøµ AÔÄÖzxÁuØPõÚ Piu® u¯õ›zuÀ

 ² \õßÔuÌ u¯õ›zuÀ 

 AøÁ ªPÄ® PÁºa]Pµ©õPz u¯õ›UP¨£mk Aa]h¨£h÷Ásk®. 

CøÁ öuõhº£õÚ _¸UPU SÔ¨ø£ GkzxUöPõsh }[PÒ CÁØøÓ GÆÁõÖ                                 

]Ó¨£õP u¯õ›UP»õö©ÚU ÷PmhÔ¢wºPÒ.
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 ""C¢u  AøÇ¨¤uøÇU  øPö¯ÊzvÀ  GÊx÷Áõ®.''   Cx   J¸Á›ß 

B÷»õ\øÚ¯õS®.

 ""|À» ÷¯õ\øÚ, BÚõÀ GÊzxUPÒ J÷µ AÍÂÀ J÷µ ÁiÂÀ 

Aø©¯©õmhõ÷u, AuÚõÀ |õ® Áõ]P\õø»°¾ÒÍ umha_ C¯¢vµzøu¨ 

£¯ß£kzx÷Áõ®,'' CßöÚõ¸ B÷»õ\øÚ.

 ""AÇQ¯ GÊzx ÁiÁ[PøÍ ö£ÓÄ® ÷Ásk®. £h[PÒ C¸¢uõÀ 

÷©¾® AÇPõP C¸US®. _ØÔÁµ ÂÎ®¦PøÍ (Border) Aø©zuõÀ ÷©¾® 

]Ó¨£õP C¸US®. umha]ÚõÀ CÁØøÓ ö\´¯ •i¯õ÷u'' CuØöPÚ¨ 

ö£õ¸zu©õÚ ÁÈ•øÓPøÍ øP¯õÍÄ® ÷Ási²ÒÍx.

 CÆÁõÖ |õÍõ¢u ÁõÌÂÀ £À÷ÁÖ P¸©[PÎß÷£õx £¯ß 

£kzu¨£k® BÁn[PÒ £À÷ÁÖ •øÓPÎÀ u¯õ›UP¨£kÁ÷u ö\õÀ 

•øÓÁÈ¨£kzuÀ GÚ¨£k®. ÷£øÚ ©ØÖ® ö£ß]ø» E£÷¯õQzx 

BÁn[PøÍz u¯õ›zu÷£õx •P[öPõkzu ¤µa]øÚPÐUS ©õØÕhõP 

umha_¨ ö£õÔ £¯ß£kzu¨£mhx. øPPÍõÀ u¯õ›UP¨£mh BÁn[PøÍ 

Âh Cx öuÎÁõP C¸¢u÷£õv¾® BÁn[PøÍ AÇS£kzuÀ, AÁØøÓ 

÷\ªzuÀ, ÷£õv¯ÍÄ Aaö\kzuÀ ÷£õßÓ £» Âh¯[PøÍ umha_ ‰»® 

ö\´x öPõÒÍ•i¯õx. 

 öuõÈÝm£ Â¸zv°ß Põµn©õPU QøhUP¨ö£ØÖÒÍ PoÛ CuØS 

ªP¨ ö£õ¸zu©õÚ÷uõº E£Pµn® Gß£øu |õ® AÔ¢xÒ÷Íõ®. Cuß‰»®                                                                                                                                     

ö\õÀ •øÓÁÈ¨£kzuø»a ö\´ÁuØS¨ ö£õ¸zu©õÚ ö©ßö£õ¸øÍ¨ 

£¯ß£kzu •i²®. C¢u ö©ßö£õ¸Î¾ÒÍ Á\vPÒ  Á¸©õÖ:

 ² BÁn[PøÍz u¯õ›zu¾® ÁiÁø©zu¾® (Creating and Formating)
 ² £h[PÒ, •ß B¯zu¨ £h[PÒ (Clip Art) ÷£õßÓÁØøÓ Em¦SzuÀ. (Insert 

Objects)
 ² ÷\ªzu¾® «Í vÓzu¾® (Saving and Retrieving)
 ² GÊzx¨ ¤øÇPøÍ²® C»UPn¨ ¤øÇPøÍ²® {Áºzv ö\´uÀ. (Spell-

ing and  Grammar checking)
 ² ö\õØPøÍz ÷ukÁx® AÁØÖUS ©õØÖa ö\õØPøÍ CkÁx® (Find and  

Replace)
 ² Ag\À Cøn¨ø£  (Mail Merge) Aø©zuÀ

 ² Aa]h •ßÚº Auß •ßPõm]PøÍ¨ £õºøÁ°hÄ® BÁn[PøÍ Aa]

hÄ® •iuÀ (Print Preview and Printing)
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6.1.1 ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸ÒPÒ

 ¤µ£»©õÚ ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸ÒPÒ £» \¢øu°À 

Põn¨£mh ÷£õv¾® CÁØÔÀ ]» ö©ßö£õ¸ÒPøÍ £n® öPõkz÷u 

Áõ[P ÷Ási²ÒÍx. GÛÝ®, E[PÍx Á\v P¸v C»Á\ ©ØÖ® vÓ¢u 

ö©ßö£õ¸ÒPøÍ (Free and open source software  - FOSS) Cøn¯uÍzvß ‰»® 

ö£ØÖU öPõÒÍ•i²®.

 ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸ÒPÒ ]» R÷Ç Põmh¨£mkÒÍÚ. 

Cøn¯z uÍzvøÚ¨ £¯ß£kzv C®ö©ßö£õ¸ÒPÒ öuõhº£õÚ ÷©»vP 

ÂÁµ[PøÍ¨ ö£ØÖUöPõÒÍU Ti¯ Á\vPÒ EÒÍÚ.

ö©ßö£õ¸Îß ö£¯º EØ£zv {ÖÁÚ®

AbiWord Source Gear Corporation

FrameMaker Adobe Systems Incorporated
iwork Pages Apple
Kingsoft Office  Writer Kingsoft
LibreOffice Writer The Document Foundation (Open Source)

LyX The LyX Project
Microsoft Office Word Microsoft Corporation
Open Office Writer Apache Software foundation (Open Source  Software)

Word Perfect Corel

AmhÁøn 6.1
 E©x PoÛ°À ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸ÒPÒ GøÁ²®  

CÀ»õu÷£õx® Th Cøn¯zvøÚ¨  £¯ß£kzv E©x BÁn[PøÍz 

u¯õº£kzvUöPõÒÍ•i²®. ÷©¾®, ÷©PU PoÛ°øÚ¨ (Cloud Computing) 
£¯ß£kzxÁuß ‰»•® E©x BÁn[PøÍz u¯õ›UPÄ® •i²®. 

Cuß‰»® £À÷ÁÖ |ßø©PÒ QøhUP¨ö£ÖQßÓÚ. AøÁ¯õÁÚ:
 ² E©x PoÛ°ÝÒ ö\õÀ•øÓ ÁÈ¨£kzuÀ ö©ßö£õ¸ÎøÚ {ÖÁ 

÷Ási¯ AÁ]¯ªÀø»

 ² CuØöPÚ PoÛ°ß ÁßÁmiÀ (Hard disk) ÷©»vP ChzvøÚ JxUP 

÷Ási¯ AÁ]¯ªÀø»

 ² E©x BÁnzvøÚ ÷\ªUPöÁÚ Cøn¯zvÀ E©UöPÚ Kº Ch® 

JxUP¨£mi¸zuÀ 

 ² Cøn¯uÍ Á\v²ÒÍ G¢u J¸ PoÛ°ß ‰»•® E©x BÁnzvøÚ 

«Íz vÓUPÄ® AuøÚ «Í JÊ[Pø©UPÄ® •i²®

     Euõµn® -  Google Docs,   Windows 365 Word,    Microsoft OneDrive Word
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 CuØS ÷©»vP©õPz uØPõ»zvÀ E¯º öuõÈÝm£zvøÚ¨ £¯ß£kzv 

EØ£zv ö\´¯¨£mkÒÍ `miøPz öuõø»÷£] (Smartphone) ©ØÖ® ÁøµÄ 

C»UP©õUQU PoÛPÒ (Tablet PCs) ÷£õßÓÚ ö\õÀ •øÓÁÈ¨£kzu¾UPõP¨ 

£¯ß£kzu¨£kÁ÷uõk AuØöPÚ Â÷\h©õÚ ö©ßö£õ¸ÒPÐ® Põn¨ 

£kQßÓÚ.  Documents To Go, Google Docs, Kingsoft Office, Polaris Office ÷£õßÓÚ 

AÁØÖm  ]»ÁõS®.

 E©x ÷uøÁU÷PØ£ BÁn[PøÍz u¯õ›¨£uØS PoÛ²hß 

öuõhº£õÚ ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸øÍ GÆÁõÖ £¯ß£kz 

u»õ® GÚ  AÁuõÛ¨÷£õ®. 

 CßÖ AvP©õP¨ £õÁøÚ°¾ÒÍ ö\õÀ •øÓÁÈ¨£kzuÀ ö©ß 

ö£õ¸ÒPÒ CµsiøÚ¨ £¯ß£kzx® •øÓ £ØÔ C¢u Azv¯õ¯zvÀ ÂÍU 

P¨£mkÒÍx. GÛÝ®, ÷ÁÖ £» ö©ßö£õ¸ÒPÒ, E£Pµn[PÒ £ØÔ²® 

C[S ÷©÷»õmh©õPU P»¢xøµ¯õh¨£k®.

6.1.2  ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸ÐUSÒ ¤µ÷Á]zuÀ

C[S Microsoft CøÚ Ai¨£øh¯õPU öPõsk Âh¯[PÒ •ßøÁUP¨ 

£mkÒÍÚ.

                            Microsoft Office Word  2010    

Start → All Programs → Microsoft Office → Microsoft Office Word 2010 

Microsoft Office Word 2010  ö©ßö£õ¸Îß •P¨¦ E¸ 6.2 CÀ Põmh¨£m

kÒÍx. 

E¸  6.2   Microsoft Office Word  2010
E¸ Pmk¨£õmkU P¸Â  

(Zoom Control)

  {ø»ø©¨ £møh 

    (Status Bar)

©mhU Põm]¨ 

ö£õzuõß (View Ruler 
Buttons)

÷©÷»õi¨ ö£õz 

uõß (Browse Buttons)Põm]¨ ö£õzuõß

(View Buttons)

 |õhõ

  (Ribbon){

 ö\õÀ»õhØ ö£mi 

{ÖÄøP

(Dialogue Box Launcher)

 uø»¨¦¨ £møh

   (Title Bar)

x›u ¤µ÷Á\U P¸Â¨ £møh  

    (Quick Accesse Tool Bar)

uzuÀPÒ (Tabs)

    _¸Ò £mi

     (Scroll Bar)
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1. uø»¨¦¨ £møh (Title Bar) 

 E¸ 6.3 CÀ Põmh¨£mkÒÍ Microsoft Office 2010 •P¨¤ß, ÷©À £UPzvÀ 

•u»õÁuõP Põn¨£k® £møh÷¯ uø»¨¦¨£møh BS®. vÓUP¨ 

£mkÒÍ BÁnzvß ö£¯º C[S Põm]¨£kzu¨£k®. ¦v¯ BÁn® 

Document "x" GÚU Põm]¨£kzu¨£k®. x Gß£x BÁnzvß C»UP©õS®. 

•P¨¤øÚ EÒÏºUS® ]Ö¨¤zuÀ ö£õzuõß (Minimize Button) AÀ»x 

ö£›uõUSuÀ ©ØÖ® «ÍzvÓzuÀ ö£õzuõß (Maximize / Restore), •P¨¤øÚ 

‰k® ö£õzuõß (Close) ÷£õßÓÚ Á»¨£UP ‰ø»°À Põn¨£kQßÓÚ.

E¸ 6.3 uø»¨¦¨ £møh (Title Bar)

2. |õhõ (Ribbon)  - 

 Word 2010 •P¨¤À Põn¨£k®  A®\÷© |õhõ (Ribbon) BS®. Cv¾ÒÍ 

File, Home, Insert etc ÷£õßÓÚ uzuÀPÒ (Tabs) GÚ¨£k®. JÆöÁõ¸ uzu¼¾® 

AuØPõÚ EÖ¨¦PÒ  £hÄ¸ÁõPU (Icons) Põm]¨£kzu¨£kÁx® AuÞhõP 

AÁØÔß ö\¯Ø£õkPÒ öuÎÄ£kzu¨£kÁx® Cuß ]Ó¨£®\©õS®. 

PoÛ¨ £¯Ú¸US AÁ]¯©õÚ ÂuzvÀ C¨£hÄ¸UPøÍ JÊ[S£kzvU 

öPõÒÍÄ® •i²®. ÷©¾®, C¢|õhõ £À÷ÁÖ öuõSvPÍõP¨ ¤›UP¨ 

£mkÒÍx. (Clipboard, Font, Paragraph, Styles, Editing etc)

Home  CÀ EÒÍ ]» EÖ¨¦UPÒ,

E¸ 6.4   Home Ribbon

1 2 3 4 5 6 7 8 9 10

17
16 15 1314 12 1118

1. ui¨¦  - Bold  
2. \õ´Ä  - Italic   
3. AiU÷Põk  -  Underline 
4. RÌJmk  - Subscript  
5. ÷©ÀJmk  - Superscript 
6. GÊzx {Ó®  -  Font colour  
7. ÷|º£kzuÀPÒ  -  Alignments  
8. Á› CøhöÁÎ  -  Line spacing
9. {ÇØ£kzuÀ  -  Shading
10.  ÂÎ®¦  -  Border 

11.    Á›ø\¯õUS      -  Sort
12.  EÒuÒÐuÀ   -  Indentation 
13.  GsquÀ   -  Numbering 
14.  SskSÔPÒ  -  Bullets  
15.  B[Q» GÊzxPøÍ 

 ÷£öµÊzxUPÍõPÄ® 

 ]ØöÓÊzxUPÍõPÄ® ©õØÖuÀ - Change case
16.  GÊzvß AÍÂøÚ¨ ö£¸¨¤zuÀ - Grow  Font  
17.  GÊzvß AÍÄ   -  Font Size   
18.  GÊzvß ö£¯º ÁøP  -  Font Name  
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3. x›u ¤µ÷Á\U P¸Â¨ £møh (Quick Access Tool Bar) 

 GÀ»õa \¢uº¨£[PÎ¾® Cx |õhõÂØS ÷©»õP Põn¨£kÁxhß  CuøÚ 

|õhõÂØS RÇõPÄ® Aø©UP •i²®. ¦v¯ BÁn® JßøÓ¨ ö£ÓÀ, 

BÁnzvøÚa ÷\ªzuÀ (Save), ö\´uøu }US (Undo), v¸®£a ö\´ (Redo) 
÷£õßÓ ªP AÁ\µ©õPa ö\´¯ ÷Ási¯ E£Pµn[PÐhß Ti¯ Czx-

›u ¤µ÷Á\ P¸Â £møh°øÚz £¯|›ß ÷uøÁU÷PØ£ ©õØÔUöPõÒÍ 

•i²®.

E¸ 6'5  x›u ¤µ÷Á\U P¸Â¨ £møh  (Quick Access Tool Bar)

÷\ªzuÀ

ö\´uøu Âk

v¸®£aö\´

4. ö\õÀ»õhØ  ö£mi  {Özx ÁøP  (Dialogue Box launcher) 

 |õhõÂÀ EÒÍ ]» A®\[PÎÞhõPz Põn¨£k® P¸ÂPÐUS ÷©»vP©õP 

£» E£Pµn[PÒ C¸UQßÓÚ Gß£øua ö\õÀ»õhØ ö£mi {Özx 

ÁøPP÷Í öÁÎ¨£kzxQßÓÚ. |õhõÂÝÒ EÒÍ ö£¯¸US Á»¨£UP©õP 

EÒÍ A®¦USÔ°ß ‰»® E›¯ ö\õÀ»õhØ ö£mi°øÚz vÓ¢xöPõÒÍ 

•i²®. Cuß‰»® |õhõÂÀ EÒÍ P¸ÂPÐUS ÷©»vP©õP¨ £» 

P¸ÂPøÍ¨ ö£ØÖ BÁnzvøÚz u¯õ›UP •i²®.

GÊzxPøÍz öu›Äö\´²® ö\õÀ»õhØ 

ö£mi {ÖzxÁøPø¯ «Ía ö\õhUSÁuß 

(Click) ‰»® vÓUP¨£mkÒÍ GÊzx¸a 

ö\õÀ»õhØ ö£mi¯õÚx E¸ 6.6 CÀ 

Põmh¨£mkÒÍx.

E¸ 6.6 GÊzx¸a ö\õÀ»õhØ ö£mi
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5. {ø»ø©¨ £møh (Status Bar) 
 Microsoft Word •P¨¤ß Ch¨£UP RÌ¨£Sv°À Cx Aø©¢xÒÍx. Cx 

BÁnzvß £UP GsoUøPPÒ, ö\õØPÎß GsoUøPPÒ, £¯ß 

£kzu¨£mkÒÍ ö©õÈ ÷£õßÓÁØøÓ AÁuõÛ¨£uØS® BÁnzvÀ ]Ö 

©õØÓ[PøÍ ö\´ÁuØS® EuÄ®.

E¸ 6.7 {ø»ø©¨ £møh  (Status Bar)

6. _¸Ò £møh (Scroll Bar) - 
 BÁnzvøÚ ÷©¾® RÊ©õP |PºzxÁuØS Cx £¯ß£kzu¨£k®.

7. E¸ AÍÄ  (ZOOM) 
 vøµ°À öuß£k® E¸UPÎß  AÍÂøÚ E¸ AÍÄ PmhøÍ (Zoom) ‰»® 

TmiU SøÓUP •i²®. Ca \¢uº¨£zvÀ BÁnzvÀ G¢u J¸ ©õØÓ•® 

{PÇ©õmhõx. umha_ ö\´£Á›ß Â¸¨£zvØ÷PØ£ ©õØÓ[PøÍa 

ö\´¯»õ®. ö£õxÁõP BÁnzvøÚ \µøÁ£õºUS®÷£õx (Proofreading) 
ö\´²®÷£õx E¸ AÍÄ £¯ß£kzu¨£kQßÓx.

E¸ 6.8   Zoom ö\´uÀ

÷©÷» P»¢xøµ¯õh¨£hõu HøÚ¯ P¸ÂPøÍ¨ £ØÔ AÔ¢x öPõÒÁuØS                 

_mi •øÚø¯ (Mouse pointer) E›¯ E£Pµnzvß «x öPõskö\ßÖ Tool tip 
I¨ £¯ß£kzv AÔ¢x öPõÒÍÄ®.

 LibreOffice Writer 4.1
Start → All Programs → LibreOffice Writer (£oö\¯À •øÓø©US Aø©¯ 

©õØÓ©øh¯ •i²®).
LibreOffice Writer  ö©ßö£õ¸Îß •P¨¦ E¸ 6.9 ‰»® Põmh¨£mkÒÍx.

E¸ 6.9    LibreOffice Writer

£mi¯À 

£møh
(Menu Bar)

      ÁiÁø©¨¦ P¸Â¨ £møh

    (Formatting Tool Bar)

{¯©U P¸Â¨ 

£møh
(Standard Tool Bar)

  {ø»ø©¨ £møh
  (Status Bar)

     _¸Ò £møh 
     (Scroll Bar)

       E¸ AÍÄU Pmk¨£õmk 

P¸Â      (Zoom Control)

      uø»¨¦¨ £møh
      (Title Bar)
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1. uø»¨¦¨ £møh  (Title Bar) 
 LibreOffice Writer •P¨¤ß ÷©À £UPzvÀ •u»õÁuõP Põn¨£kÁ÷u 

uø»¨¦¨ £møh BS®. vÓUP¨£mkÒÍ BÁnzvß ö£¯º CvÀ 

Põm]¨£kzu¨£k®. ¦v¯ BÁn® GÛß Untitled x GÚ ÷uõØÓ©ÎUS®. x  
Gß£x BÁn C»UPzøuU SÔUS®. 

E¸ 6.10    uø»¨¦¨ £møh  (Title Bar)

2. £mi¯Ø £møh (Menu Bar) 
  £mi¯Ø £møh¯õÚx uø»¨¦¨ £møhUSU  R÷Ç Aø©¯¨ ö£ØÖÒÍx. 

Av¾ÒÍ EÖ¨¦UPÒ •øÓ÷¯ File,  Edit,  View,  Insert,  Format,  Tools,  Window, 
Help BS®.  £mi¯Ø £møh°ß Kº EÖ¨¤øÚz öu›Ä ö\´²®÷£õx 

AuØS›¯  xøn¨ £mi¯À (Sub Menu) vÓUP¨£kÁ÷uõk ÷uøÁU÷PØ£ 

AÁØøÓ¨ £¯ß£kzu •i²®. 

E¸ 6.11 £mi¯Ø £møh ^Menu Bar&

 ² File £mi¯¼øÚz ÷uº¢öukUS®÷£õx vÓUP¨£k® xøn¨£mi (Sub 
Menu)  ‰»®   ¦v¯      BÁnzøu¨   ö£ØÖUöPõÒÍÄ®     BÁnzøua 

÷\ªUPÄ®   AÀ»x   vÓUPÄ®   AÀ»x  ‰hÄ®  •i²©õÚ  £» E£Pµ  

n[PøÍU Põn»õ®.

 ² xøn¨ £mi°À EÒÍ ‰ßÖ ¦ÒÎPÒ "...' EhÚõÚ xøn¨£mi öu›²® 

÷£õx ÷©¾® J¸ ö\õÀ»õhØ ö£mi (Dialouge box) CøÚz vÓ¢x öPõÒÍ 

•i²®. (E¸ 6.12)

 ² xøn¨ £mi°À EÒÍ Á»¨£UPzøu ÷|õUQ¯ A®¦USÔ°ß ‰»® 

÷©¾® J¸ xøn¨ £miø¯z vÓ¢xöPõÒÍ •i²®. (E¸ 6.12) 

E¸ 6.12  xøn¨ £miö£mi  (Sub Menu box)

‰ßÖ ¦ÒÎPÒ

A®¦USÔ
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 ² P¸Â¨ £møh (Tool bar)

 LibreOffice Writer •P¨¤À EÒÍ £mi¯À £møh°ß RÌ Aø©¢xÒÍ÷u 

P¸Â¨£møh  BS®. CvÀ EÒÍ {¯©U P¸Â¨ £møh  ©ØÖ®   

ÁiÁø©¨¦U  P¸Â¨ £møh Gß£ÁØøÓ Writter •P¨¤øÚz vÓ¨£uß 

‰»®  AÁuõÛUP •i²®. ÷©¾®, £¯|›ß ÷uøÁU÷PØ£ ÷ÁÖ P¸Â¨ 

£møhPøÍ¨ ö£ØÖU öPõÒÍ÷Áõ ‰iÂh÷Áõ •i²®. CuØöPÚ Põm]¨ 

£møhø¯z vÓ¢x AvÀ Põn¨£k® P¸Â¨ £møh xøn £mi°À 

EÒÍ ÷uøÁ¯õÚ P¸Â¨ £møh¨ ö£¯›øÚz öu›Áuß ‰»® P¸Â¨ 

£møh°øÚ¨ ö£ØÖUöPõÒÍ÷Áõ ‰iÂh÷Áõ •i²®.

3. {¯©U P¸Â¨ £møh (Standard Tool Bar)  - 

 {¯©U P¸Â¨ £møh°À (E¸ 6.13) EÒÍ P¸ÂPøÍ C»SÁõP¨ 

£¯ß£kzuUTi¯ Âu©õP AøÁ £hÄ¸UPÍõP¨ Põm]¨£kzu¨£m-

kÒÍÚ. 

E¸  6.13  uµU P¸Â¨ £møh

1.  ¦v¯          - New             8.  £hzöuõS¨¦  - Gallery 

2.  ÷\ªzuÀ         - Save             9.  ö\´uøu }US  - Undo

3.  £UP •ßPõm] - Page Preview        10. Jmk   - Paste 

4.  ¤µvö\´        - Copy            11. öÁmkP   - Cut

5.  v¸®£aö\´      - Redo            12. GÊzx® C»U

6.  AmhÁøn    - Table            Pn•®           - Spelling and grammar

7.  EuÂ      - Help            13. Aa]kuÀ  - Print

               14. vÓ    - Open

     

 

1 2 53 4 6 7

14 13 12 11 10 9 8
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4. ÁiÁø©¨¦U P¸Â¨ £møh (Formatting Tool Bar) 
 BÁnzv¾ÒÍ GÊzxUPøÍ ÁiÁø©¨¦a ö\´ÁuØS›¯ ÁiÁø©¨¦ 

•øÓPÒ AvP® Põn¨£kQßÓÚ. AuõÁx ÁiÁø©¨¦U P¸Â¨£m 

øh°À EÒÍ PmhøÍPøÍ¨ £¯ß£kzxÁuØS Á\v¯õP £hÄ¸UPÒ 

EÒÍhUP¨£mkÒÍÚ.

1 2 53 4 6 7

12 11 10

98

E¸  6.14   ÁiÁø©¨¦U P¸Â¨ £møh

1.  A»[Põµ[PøÍ Em¦SzuÀ -- Apply style 7.    GsohÀ -     - Numbering
2.  GÊzxÁ¸  - Font   8.   EÒuÒÍÀ-  - Indentation
3.  GÊzvß AÍÄ -- Font size  9.    ¤ßÚo Áºn®-   - Background color
4.  ui¨¦  -- Bold   10.  GÊzvß {Ó®- - Font color
5.  AiU÷Põk  -- Underline  11.  SskUSÔ-  - Bullets
6.  ÷|º¨£kzuÀ- - Alignment  12.  \õ´Ä-  - Italics

5.  {ø»ø©¨ £møh (Status Bar)  

 Writer •P¨¤ß Ch¨£UPU RÌ‰ø»°À Cx Aø©¢xÒÍx.  BÁnz-

vß £UP GsoUøP, Á\Ú GsoUøP ©ØÖ® £¯ß£kzu¨£mkÒÍ ö©õÈ 

÷£õßÓÁØøÓ AÁuõÛUP •iÁ÷uõk  BÁnzvÀ ]Ô¯ ©õØÓ[PøÍ 

÷©ØöPõÒÍÄ® •i²®.                                                                                   

6.   _¸Ò ö£õzuõß ©ØÖ® _¸Ò £mi  (Scroll Button and Scroll Bar)   

BÁnzvøÚ ÷©¾® RÊ©õP |PºzxÁuØS Cx £¯ß£kzu¨£k®.

7.  E¸ AÍÄ  (Zoom) 

      vøµ°À öuß£k® E¸UPÎß AÍÂøÚ E¸ AÍÄ (Zoom) ‰»® TmiU 

SøÓUP •i²®. Ca\¢uº¨£zvÀ BÁnzvÀ G¢u J¸ ©õØÓ•® {PÇ©õm-

hõx. umha_ ö\´£Á›ß Â¸¨£zvØ÷PØ£ ©õØÓ[PøÍa ö\´¯»õ®. ö£õx-

ÁõP BÁn[PøÍ \µøÁ£õº¨¦ (Proofreading) ö\´²®÷£õx £¯ß£kzu¨£k®. 

 ÷©÷» P»¢xøµ¯õh¨£hõu HøÚ¯ P¸ÂPøÍ¨ £ØÔ AÔ¢x 

öPõÒÁuØS  _mi •øÚø¯ E›¯ E£Pµnzvß «x öPõsk ö\ßÖ Tool Tip 
I¨ £¯ß£kzv AÔ¢x öPõÒÍÄ®.         
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 6.2   ¦v¯  BÁnö©õßøÓz  u¯õ›US®÷£õx  P¸zvØ   

         öPõÒÍ ÷Ási¯ •UQ¯ Âh¯[PøÍ AÔ÷Áõ®.   

-  

Pmh® 1

¦v¯ £UP® JßÔøÚ¨ ö£ØÖUöPõÒÍÀ,ö\õÀ •øÓÁÈ¨£kzuÀ 

ö©ßö£õ¸ÎøÚz vÓUS®÷£õxC¯À£õP÷Á ¦v¯ £UP•® 

vÓUP¨£kQßÓx.  ÷©»vP £UP[PÒ ÷uøÁ¨£iß AÁØøÓ 

|õ[PÒ ö£ØÖUöPõÒÍ ÷Ásk®.                                                                                                                           

    Microsoft Word  CÀ
 

   File →New (Ctrl+N) →Blank Document 
   → Create Ia ö\õhUSP.   

LibreOffice Writer  CÀ
 
 File→New (Ctrl+N)→Text Document  
 Ia ö\õhUSP.

Pmh® 2

File→Save (Ctrl+S) I 

   öu›Ä ö\´P. 

• ÷\ª¨£uØS¨ ö£õ¸zu©õÚ 

ChzvøÚz (Saving Loca   
tion) Save in GßÓ ChzvÀ 

öu›Äö\´P.    
•÷Põ¨¦US¨ ö£õ¸zu©õÚ 

ö£¯º JßÔøÚ    File name 
CØS Gv÷µ umha_ ö\´P.  

•Save  CøÚa ö\õhUSP.

     ÷Põ¨¤øÚa ÷\ªzuÀ (Save)
}[PÒ  u¯õ›zu   ÷Põ¨¦US 

ö£õ¸zu©õÚ ö£¯øµ ÁÇ[Q 

ö£õ¸zu©õÚ ChzvÀ ÷\ªzuÀ 

•UQ¯©õS®. Cx ÷Põ¨¤øÚ 

«Í¨ ö£ØÖUöPõÒÁuØS® 

EuÄ®. 
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Pmh® 3

÷\ªzu ÷Põ¨¦US ÷ÁÖ J¸ 

ö£¯øµ öPõkzx PoÛ°ÝÒ 

÷\ªzuÀ.

E®©õÀ HØPÚ÷Á ÷\ªzx 

øÁUP¨£mkÒÍ BÁnzvøÚ  

(Document) ÷\ªzu ¤ßÚº Ax 

÷Põ¨¦ (File) GÚ AøÇUP¨ 

£k®. CuøÚ ÷ÁÖ J¸ ö£¯›À 

AÀ»x ÷ÁÖ  J¸ ChzvÀ 

÷\ªUP •i²®. A¨÷£õx 

uØ\©¯® £¯ß£kzx® ö£¯›À 

J¸ ÷Põ¨¤¾® ¦v¯ ö£¯›À 

CßöÚõ¸ ÷Põ¨¤¾©õP J÷µ 

BÁn® Cµsk ÷Põ¨¦PÍõP 

QøhUS®. ÷Põ¨¤øÚ ö£¯º          

}m] (File Extension) JßÖhß ÷\

ªUP¨£kÁ÷uõk AuøÚ ÷uk 

Áx C»SÁõS®. ÷Põ¨¤ß }m 

]PÒ (File  Extension) ]»

   MS Word 2007$ 2010  -  .docx
   MS Word 97-2003     -   .doc
   LibreOffice Writer     -  .odt

File→Save as I öu›Ä ö\´P.

• ÷\ª¨£uØS ö£õ¸zu©õÚ Jº 

ChzvøÚ (Saving Location) Save 
in  Chzv¼¸¢x öu›Äö\´P.

• ÷Põ¨¦US¨ ö£õ¸zu©õÚ  

ö£¯º   JßÔøÚ File name     
CØS Gv÷µ umha_a ö\´P.

• Save CøÚa ö\õhUSP.

 

                                         

CuØöPÚ

Pmh® 4

 ÷Põ¨¤øÚ ‰kuÀ 

}º u¯õ›zx ÷\ªzu BÁnz-

vøÚ «Í¨ £¯ß£kzx® Áøµ 

‰iøÁ¨£÷u ¦zv\õx›¯©õÚ 

ö\¯»õS®. ÷uøÁ°ßÔ AuøÚz 

vÓ¢x øÁ¨£x PoÛ°ß HøÚ¯ 

ö\¯Ø£õkPÐUSz uøh¯õP Aø© 

²®.   

File → Close I öu›Äö\´P.

CuØöPÚ
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Pmh® 5 

÷Põ¨¤øÚ «Íz vÓzuÀ

E®©õÀ PoÛ°À ÷\ªzx         

øÁUP¨£mkÒÍ ÷Põ¨¤øÚ 

«Íz vÓUP ÷Ási HØ£k®

File → Open ̂Ctrl+O& I öu›Äö\´P. 

·  Open  GÝ®  ö\õÀ»õhØ ö£mi 

  °ÒÍ  Look in  GÝ®   ChzvÀ

    ö\õhUQ ÷\ªzu ÷Põ¨¤øÚz 

öu›Äö\´P.

· E›¯ ¤›ÂÀ ÷Põ¨¤øÚz 

öu›Äö\´P. 

·  Open Gß£øua ö\õhUSP.  

Pmh® 6

÷Põ¨¦US PhÄaö\õÀ  (Password) JßÔøÚ ÁÇ[Qa ÷\ªzuÀ 

E©x ÷Põ¨¤øÚ £õxPõ¨£õP ÷\ªUP ÷Áskö©Ûß PhÄa 

ö\õÀ (Password)  JßÔøÚ ÁÇ[Q £õxPõ¨£÷u ö£õ¸zu©õÚx. 

CÆÁõÖ ö\´ÁuÚõÀ E©x ÷Põ¨¤øÚ ÷ÁÖ GÁ¸® vÓ¢x 

£¯ß£kzu •i¯õx.

Microsoft Word CÀ    
· File→Save CøÚz öu›Äö\´P.       

· ÷\ª¨£uØS¨ ö£õ¸zu©õÚ 

ChzvøÚ (Saving Location) Save 
in C¼¸¢x öu›Äö\´P.  

· ÷Põ¨¦US¨ ö£õ¸zu©õÚ ö£¯ 

 ›øÚ File Name CØS Gv÷µ 

umha_a ö\´P.   
·  Tools Iz öu›Äö\´P. 

·  General Option Iz öu›Äö\´P.

·  Password to Open \xµzvÝÒ E©x 

PhÄaö\õÀ¼øÚ (Password) um 

ha_ ö\´x OK ö\´P.

·  A¢u PhÄaö\õÀø»÷¯ «sk® 

(Re-enter Password to Open)  \xµzvÀ 

umha_ ö\´x OK ö\´P.  

·  Save I ö\õhUSP.    

LibreOffice Writer CÀ 

· File →Save  CøÚz öu›Äö\´P.

· ÷\ª¨£uØS¨  ö£õ¸zu©õÚ 

ChzvøÚ ^Saving Location& Save in  
C¼¸¢x öu›Ä ö\´P. 

· ÷Põ¨¦US¨ ö£õ¸zu©õÚ ö£¯› 

 øÚ File Name Gv÷µ umha_ 

ö\´P. 

·  Save with a Password \xµzvøÚ                                                                                                                                           

ö\õhUSP.

· Save ö£õzuõøÚ ö\õhUSP.

·  Set Password \xµzvÝÒ ÷Põ¨¤ 

øÚ vÓ¨£uØS E›¯ PhÄa    

ö\õÀ¼øÚa  umha_ ö\´P.

·  A÷u PhÄaö\õÀ¼øÚ Cµs 

hõÁx \xµzvÝÒ «sk® Type 
ö\´x Ok ö\´P.   
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ö\¯Ø£õmk E¸  1

  ö\¯Ø£õk

}[PÒ £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸øÍz 

vÓ¢x R÷Ç öPõkUP¨£mkÒÍ ö\¯Ø£õmiøÚa ö\´P. 

1. ö\¯Ø£õmk E¸ 1 CÀ EÒÍ £¢v°øÚ umha_a ö\´x 

AuøÚ  ''Assign 1'' GÝ® ÷Põ¨¦¨ ö£¯›À  E[PÍx ÷Põ¨¦ 

øÓ°ÝÒ   (Folder) ÷\ªUPÄ®.        
2. ''Assign 1'' CøÚ «sk® vÓ¢x ''Assign 2" GÝ® ö£¯›À 

''Word 97, Word 2003'' CÀ ÷\ªUP. «Íz vÓ¢u E©x 

÷Põ¨¦øÓ°ÝÒ (Folder) ÷\ªzx ‰kP.

Word Processor
A word processor, or word processing program does exactly what the name 
implies. It processes words. It also processes paragraphs and entire papers. 
Some examples of word processing programs include Microsoft Word, Word 
perfect (Windows only), Apple Works (Mac only) and Open Office.org.

 6.3  BÁnö©õßÔøÚz  u¯õ›zuÀ

  6.3.1  £UP ÁiÁø©¨¦ (Page Setup)
   

¦v¯ BÁn® JßøÓz u¯õ›UP •ßÚº A¢u BÁnzvØS¨ ö£õ¸zu©õÚ 

J¸ £UPzøuz u¯õº£kzvU öPõÒÍ÷Ásk®. 

           Microsoft Word CÀ 

• Page layout → Page setup I 

£¯ß£kzxP. 

LibreOffice Writer CÀ

• Format →  Page ©ØÖ® Page  ö\õÀ  
»õhØ  ö£miø¯  £¯ß£kzxP.

   G¢uöÁõ¸ ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸Î¾® ö£õxÁõP¨ 

£¯ß£kzuU Ti¯ Âu©õÚ £UP ÁiÁø©¨¦ P¸ÂPÒ £» Põn¨£kQßÓÚ. 

 AuõÁx  \ºÁ÷u\  uµzvØS HØ£z u¯õ›UP¨£mh £À÷ÁÖ AÍÂ»õÚ 

(Size / Format) £UP[PøÍ¨ ö£ØÖU öPõÒÍ•i²®. AuõÁx  A4, A5, B4, Letter, 
... GßÓ ÁøP°À £¯|¸USz ÷uøÁ¯õÚ •øÓ°À  Âzv¯õ\¨£kzvU öPõÒÍ   

Á\vPÒ Põn¨£kQßÓÚ.
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 £UPzvøÚ ÁiÁø©US®÷£õx Auß vø\÷PõøÍ²® (Orientation) £UP 

GÀø»PøÍ²®  (Margins) BÁnzvØS¨ ö£õ¸zu©õÚ Âu©õP Aø©zxU 

öPõÒÍ ÷Ásk®.

BÁnz u¯õ›¨¤À Cµsk ÁøPz vø\÷PõÒPÒ Põn¨£kQßÓÚ. {øµz 

vø\ (Landscape)  , {µÀ vø\   (Portrait)    Gß£Ú÷Á AøÁ¯õS®.

6.3.2   GÊzx, £¢vPøÍ ÁiÁø©zuÀ (Formatting)

 umha_ GÊzxPÒ, £¢vPøÍz umha_a ö\´ÁuØS •ßÚº AÀ»x 

¤ßÚº ÁiÁø©zxU (Formatting) öPõÒÍ•i²®. CÆÁõÖ BÁn[PøÍ 

ÁiÁø©¨£uß ‰»® AøÁ öuÎÁõPÄ® PÁºa]Pµ©õPÄ® Aø©QßÓÚ.  

}[PÒ umha_ ö\´uuß  ¤ßÚº ÁiÁø©¨£uõ°ß •u¼À umha_a ö\´x 

¤ßÚº AÁØøÓ ÁiÁø©UP ÷Ásk®. 

umha_a ö\´¯ •ßÚº BÁnzøu ÁiÁø©UP •¯¾®÷£õx •u¼À 

ö£õ¸zu©õÚ ÁiÁø©¨¤øÚz öu›Äö\´x umha_ ö\´uÀ ÷Ásk®. 

6.3.3  öu›uÀ (Select) •øÓPÒ

 Kº BÁnzvÀ £À÷ÁÖ A®\[PÒ Põn¨£kQßÓÚ. AuõÁx 

GÊzxPÒ, Á\Ú[PÒ, A»[Põµ[PÒ, ]zvµ[PÒ, AmhÁønPÒ, Áøµ¦PÒ 

÷£õßÓÚ Põn¨£k®. AÆÁõ÷Ó £À÷ÁÖ \¢uº¨£[PÎÀ CÆÁ®\[PÎÀ 

©õØÓ[PøÍa ö\´¯÷Ási ÷|›k®. ©õØÓ[PøÍa ö\´¯ •ßÚº E›¯ A[Pz-

vøÚz öu›uÀ ÷Ásk®. CuØöPÚ ¤ß£ØÓ ÷Ási¯ ÁÈ•øÓPÒ ]» R÷Ç 

Põn¨£kQßÓÚ.

uÛ GÊzx AÀ»x 

£» GÊzxPÒ  

_miø¯a ö\õhUQ¯ÁõÖ GÊzvß FhõP CÊzxa 

ö\À»÷Ásk®. (Drag) 
ö\õÀ E›¯ ö\õÀ¼ß «x _mi°ÚõÀ Cµmøh ö\õhUPÀ    

(Double Click) ö\´¯ ÷Ásk®.

£» ö\õØPÒ E›¯ ö\õØöÓõh›ß Bµ®£a ö\õÀ¼ß «x _miø¯a 

ö\õhUQ CÖva ö\õÀ Áøµ _miø¯ CÊzxa 

ö\À» ÷Ásk®. (Drag)

 Á\Ú® E›¯ Á\Úzvß Bµ®£a ö\õÀ¼ß «x  _miø¯    

ö\õhUQ CÖv Áøµ CÊzxa ö\À» ÷Ásk®. 

Á› Á»¨£UP® ÷|õUQ¯ öÁsoÓ©õÚ A®¦USÔ 

öuß£k® Áøµ  Á›°ß Bµ®£zxUS _miø¯ Gkzx  

ö\À»Ä®.   AøuU PshÄhß J¸ •øÓ ö\õhUSP.
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£¢v £¢v°ß «x _miø¯ øÁzx J÷µ •øÓ°À ‰ßÖ 

ö\õhUPÀ ö\´¯ ÷Ásk®.

AÀ»x £¢v°ß •u»õÁx ö\õÀ«x _miø¯             

ö\õhUQ  CÖv Áøµ CÊzxa ö\À» ÷Ásk®. 

BÁn® (Document)  ² Âø\¨ £»øP°ß Ctrl + A   CøÚ J¸ •øÓ 

AÊzxP. 

 ² _miø¯ ö\õhUQ CÖv Áøµ CÊzxa ö\À» 

÷Ásk®. Á\Úzvß «x _miø¯ ö\õhUQ 

Á»¨£UP® ÷|õUQ¯ öÁsoÓ A®¦USÔÁ¸® 

Áøµ°À _miø¯ CÊzxa ö\À»Ä®. AøuU 

PshÄhß J÷µ •øÓ ö\õhUSP.

6.3.4  £õh® JßÔøÚ ÁiÁø©zuÀ (Text Formatting)
 

C[S, 

           

E¸ 6'15  ÁiÁø©zuÀ

1. GÊzx¸UPÎß AÍÂøÚ ©õØÓ 

•i²®.  (Font Size) 
2.  GÊzx¸UPÎß Aø©¨¤øÚ ©õØÓ 

•i²®.  (Font Style) GÊzvøÚ ui¨ 

£õUP¾® (Bold) \õ´ÁõP GÊxu¾® 

(Italic) 
3.  GÊzx¸UPÎß RÌ ÷PõikuÀ (Un-

derline)  
4. Âzv¯õ\©õÚ GÊzx¸UPøÍ ÷ÁÖ 

ö©õÈPÎ¼¸¢x ö£ØÖUöPõÒÍÀ (Font)  
5.             GÊzx¸UPÎß {ÓzvøÚ ©õØÖuÀ (Font Colour) 

           Microsoft Word CÀ 

·
       E©x £¢v AÀ»x GÊzvøÚz öu›P.

• Home → Font E[PÐUS  AÁ]¯©õÚ 

ÁiÁø©¨¦ P¸Â°ß «x ö\õhUSP. 

• Home → Font AÀ»x Font ö\õÀ 

»õhØ ö£miø¯z (Dialogue Box) 
vÓ¢x öPõÒP.  

AÆÁõÖ   J÷µ  \¢uº¨£zvÀ  £»  E£Pµ  

n[PøÍ¨    ö£ØÖUöPõÒÍ      •i²®  

Gß£øu P¸zvØ öPõÒP. 

LibreOffice Writer CÀ  

· E©x £¢v AÀ»x GÊzvøÚz öu›Ä 

ö\´P.

· Áiø©¨¦ P¸Â¨ £møhø¯ (Format-
ting Tool Bar) £¯ß£kzxP.

· ÁiÁø©¨¦US  AÁ]¯©õÚ P¸Â°ß 

«x ö\õhUSP. AÀ»x

· Format → Character  GßÓ ö\õÀ»õhØ 

ö£miø¯z vÓ¢x öPõÒP.

AÆÁõÖ J÷µ \¢uº¨£zvÀ £» E£Pµn[ 

PøÍ¨ ö£ØÖUöPõÒÍ •i²® Gß£øuU 

P¸zvØ öPõÒP.
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ö\¯Ø£õk

}º £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸øÍz vÓ¢x 

¤ßÁ¸® ö\¯À£õmiøÚa ö\´P.

1. E©x BÁnzvøÚ¨ ¤ßÁ¸©õÖ u¯õ›USP.

AÍÄ (Size) - A4  vø\÷PõÒ

(Orientation)
£UP GÀø» (Margins)
Á»x ©ØÖ® Chx GÀø» & 2'' 
÷©À ©ØÖ® RÌ GÀø»  &- 1.5'' 

£UP ÁiÁø©¨¦ ö\õÀ»õhØ ö£mi°øÚz (Page setup dialog box) vÓ¢x-

öPõÒÁuß ‰»® J÷µ •øÓ°À CøÁ AøÚzøu²® ö\´xöPõÒÍ •i²®.

ö\¯Ø£õmk  E¸ 2 CÀ EÒÍ £¢v°øÚ umha_ ö\´x AuøÚ ''Assign 2'' GÚ 

E©x  ÷Põ¨¦ EøÓ°ÝÒ ÷\ªUP ÷Ásk®. ¤ßÚº AuøÚ ‰kP. 

2. ''Assign 2''   CøÚ «Íz vÓ¢x öPõÒP. Av¾ÒÍ Á\Ú[PøÍ ö\¯Ø£õmk 

E¸ 3 CÀ Põmh¨£mkÒÍÁõÖ «Ò ÁiÁø©¨¦a ö\´P.  ¤ßÚº  ''Assign 
3'' GßÝ® ö£¯›À E©x ÷Põ¨¦ EøÓ°ÝÒ (Folder) AuøÚ ÷\ªzx  

BÁnzøu ‰kP.

      

ö\¯Ø£õmk E¸ 2

ö\¯Ø£õmk E¸ 3

What is a computer?

A computer is an electronic device that manipulates information 
or data. It has the ability to store, retrieve and process data.

You can use a computer to type documents, send email and browse 
the Web. You can also use it to handle spreadsheets, accounting,  
database management, presentations, games and more.

What is a computer?
A computer is an electronic device that manipulates information or 
data. It has the ability to store, retrieve and process data.

You can use a computer to type documents, send email and browse 
the Web. You can also use it to handle spreadsheets, accounting,  
database management, presentations, games and more.



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À196 197

6.3.5  £¢v   ÁiÁø©¨¦a  ö\´uÀ   (Paragraph Formatting)  

÷|º¨£kzuÀ  Alignment

          E¸ 6.16  £¢v ÁiÁø©¨¦

 

6. Ch¨£UP©õP ÷|º¨£kzuÀ (Left Align)    

7. ©zv°À ÷|º¨£kzuÀ  (Center Align)   

8. Á»¨£UP©õP ÷|º¨£kzuÀ  (Right Align)  

9. C¸ £UP[PøÍ²® \©©õP ÷|º¨£kzuÀ (Justify)  

 ² EÒuÒÐuÀ  (Indentation) (E¸ 6.16 ©ØÖ® 6.17)

10. Ch¨£UPzv¼¸¢x EÒuÒÐuÀ (Left Indentation)  

11. Á»¨£UPzv¼¸¢x EÒuÒÐuÀ (Right Indentation) 

12. •u»õÁx Á›°øÚ EÒuÒÐuÀ (First Line Indentation)

13. •uÀ Á› uÂº¢u HøÚ¯ Á›PøÍ EÒuÒÐuÀ (Hanging Indentation)

14.  Á› CøhöÁÎ CkuÀ (Line spacing) 

15.  £¢v CøhöÁÎ CkuÀ (Paragraph spacing) 
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   Computer is an electronic device 
  which accepts data, processes
  and produces desired
  information.

The computer memory refers to the 
storage area of a computer where all 
the data and instructions are stored. 

 The storage capacity of the computer memory 

is expressed in terms of bits and bytes. The more memory 

a computer has, the more memory it can store.

Computer hardware is the collection of physical elements 
 that constitutes a computer system. 
 Computer hardware refers to the physical 
 parts or components of a computer such as 
 the monitor, mouse, keyboard,

10
14

11

15

12

13

 

 

Computer hardware is the collection 
of physical elements that constitutes a 
computer system. Computer hardware 
refers to the physical parts or components 
of a computer such as the monitor, mouse, 
keyboard, computer data storage, hard 
drive disk (HDD) etc...

Software is any set of machine-readable 
instructions that directs a computer's 
processor to perform specific operations. 
A combination of hardware and software 
forms a               

 

 

E¸ 6.17

Microsoft Word  CÀ 
     

E©x ö\õØPÒ AÀ»x £¢vPøÍz öu›Ä 

ö\´P.

 ² E©x ÁiÁø©¨¦USz ÷uøÁ¯õÚ 

P¸Â°ß  «x ö\õhUSP. 

 ² Home → Font AÀ»x    

 ² Paragraph ö\õÀ»õhØ ö£miø¯ ^Dia-
logue Box& vÓ¢x öPõÒP.

 ² AÆÁõÖ J÷µ \¢uº¨£zvÀ £» 

P¸ÂPøÍ¨ ö£ØÖUöPõÒÍ •i²® 

Gß£øuU P¸zvØöPõÒP.

LibreOffice Writer CÀ

   E©x ö\õØPÒ AÀ»x £¢vPøÍz 

öu›Ä ö\´P.

 ² £mi¯À £møh°¾ÒÍ (Format-
ting Tool Bar) E£Pµn[PÎÀ E©US 

÷uøÁ¯õÚøuz öu›Äö\´P. CÀø» 

÷¯À Format →Paragraph ö\õÀ»õhØ 

ö£mi°øÚ (Dialogue Box) vÓ¢x 

öPõÒP.

 ² AÆÁõÖ J÷µ \¢uº¨£zvÀ £» 

P¸ÂPøÍ¨ ö£ØÖUöPõÒÍ •i²® 

Gß£øuU P¸zvØöPõÒP.
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}º £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸ÎÀ 

¤ßÁ¸® ö\¯Ø£õkPøÍa ö\´P.

1. HØPÚ÷Á }º ö\´u "Assign 3" ÷Põ¨¤øÚz vÓ¢xöPõÒP. Av¾ÒÍ 

£¢v°øÚ ö\¯Ø£õmk E¸ 4 CÀ Põmh¨£mkÒÍ Âu©õP ÁiÁø©zx 

AuøÚ E©x ÷Põ¨¦øÓ°ÝÒ   "Assign 4" GÚ ÷\ªUP. ¤ßÚº ÷Põ¨¤øÚ 

‰kP.

2. "Assign 3" CøÚ «Íz vÓUP. ö\¯Ø£õmk E¸ 5 CÀ Põmh¨£mkÒÍ 

Âu©õP AuøÚ «Í ÁiÁø©zx  "Assign 5"  GßÓ ö£¯›À E©x 

÷Põ¨¦øÓ°ÝÒ  AuøÚ  ÷\ªUP. ¤ßÚº ÷Põ¨¤øÚ ‰kP.

   

What is a computer?
A computer is an electronic device that manipulates information or 
data. It has the ability to store, retrieve and process data.
You can use a computer to type documents, send email and browse 
the Web. 
You can also use it to handle spreadsheets, accounting,  database 
management, presentations, games and more.

ö\¯Ø£õmk  E¸  4

What is a computer?
A computer is an electronic device that 
   manipulates information or data. 
   It has the ability to store, retrieve   
   and process data.
You can use a computer to type documents, send email 
and browse the Web. 

ö\¯Ø£õmk  E¸  5 

ö\¯Ø£õk
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6.3.6   SskUSÔPÒ, C»UP[PÎÚx (Bullets and Numbering)    
           ÁiÁø©¨¦UPÒ  

There are two types of Memory. They are,
1. Primary Memory
 1.1.    ROM
 1.2.    RAM

2. Secondary Memory
 a)    Hard Disk
 b)    Floppy Diskette
 c)    Pen drive
 d)    CD / DVD  

 

Storage
 Capacity 

 Bit
 Nibble
    Byte
    Megabyte
 Gigabyte

17

 

18

19 16

20

E¸ 6.18                 

16. SskUSÔ¨ £mi¯À (Bullet List)

17. C»UP¨ £mi¯À (Number List)

18. £ÀxøÓ¨ £mi¯À (Multilevel List)

19. {ÇØ£kzuÀ / ¤ßÚo {ÓªkuÀ (Shading / Background colour)

20. GÀø»°kuÀ / ÂÎ®¤kuÀ (Border)

PÁÛUP : ÷uº¢öukzu ÁõUQ¯[PÐUS £¢v¨ (Paragraph) ¤›Â¼¸¢x 

SskUSÔ ©ØÖ® £UP AmhÁønPøÍ Em¦Szu •i²®. GÛÝ®, ¤µuõÚ 

£mi¯¼ß CÖv°À (Multilevel list) £ÀxøÓ¨ £mi¯ø» Bµ®¤¨£uØS 

¤ßÁ¸® £i•øÓPøÍU øP¯õÍÄ®.

·  Âø\¨£»øP°À   (Keyboard)    EÒÍ  Tab \õÂø¯ AÊzxP.

·  ¤µuõÚ £mi¯À £ÀxøÓ¨ £mi¯¾hß CønÁuØS, £ÀxøÓ¨ 

£mi¯¼ß CÖv°À  Shift + tab \õÂø¯ AÊzxP.
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21.  {ÇØ£kzuÀ / ¤ßÚo {ÓªkuÀ ©ØÖ® BÁnzxUS ÂÎ®¤kuÀ

LibreOffice writer  CÀ 

£¢vUS ¤ßÚo {ÓªkuÀ 

öuõhº£õP

♦ Format → Character → back        
ground C¼¸¢x ÷uøÁ¯õÚ 

¤ßÚoø¯ öu›Äö\´P.

ÂÎ®¦ öuõhº£õP  

♦ Format → paragraph → Border  
C¼¸¢x E›¯ ÂÎ®ø£                                                                                                                                     

öu›Äö\´P.
...............................................

BÁnzvØS  ö£õ¸zu©õÚ 

{Ózøu CkÁuØS 

♦ Format → Page → Background 
C¼¸¢x  ö£õ¸zu©õÚ {Óz 

øuz  öu›Äö\´P.  

ÂÎ®¦ öuõhº£õP  

♦ Format → Page → Border FhõP 

ö£õ¸zu©õÚ  ÂÎ®¤øÚ²® 

ÂÎ®¤ØPõÚ   {Ózøu²® 
öu›Äö\´P 

♦  Ok ö\´P.

Microsoft word  CÀ

BÁnzvøÚ öu›Äö\´P.

♦ Page layout Page Back ground ¤›Â¾ 

ÒÍ Page Borders I öu›Äö\´P.   

♦ Borders and Shading ö\õÀ»õhØ 

ö£mi°ÝÒ  Borders / Page Border / 
Shading CøÚ öu›Äö\´P

♦ Ok  ö\´P.

  ö\¯Ø£õk

}º £¯ß£kzx® ö\õÀ •øÓ 

ÁÈ¨£kzuÀ ö©ßö£õ¸ÎøÚz 

vÓ¢x ¤ßÁ¸® ö\¯Ø£õkPøÍa 

ö\´P'

1.  ¦v¯ J¸ £UPzvøÚz vÓ¢xöPõÒP. ö\¯Ø£õmk 

E¸ 6 CÀ Põmh¨£mkÒÍ Âu©õPU  SskUSÔ¨ 

£mi¯À   (Bullet list) JßÔøÚz u¯õ›UP.  ¤ßÚº 

÷Põ¨¤øÚ 'Assign 6' GÝ®  ö£¯›À   E©x ÷Põ¨¦øÓ 

øÓ°ÝÒ ÷\ªzu ¤ßÚº ÷Põ¨¤øÚ ‰kP.

2. }[PÒ ÷\ªzu 'Assign 6' ÷Põ¨¤øÚ «Íz vÓ¢x 

öPõÒP. £UPzvøÚa _ØÔ ÂÎ®¤kP (Border). 
AÆÁõÖ ©õØÔ¯ ÷Põ¨¤øÚ  Microsoft  Word 
£¯ÚõÍºPÒ Save as FhõP  Word 97,  Word 2003 CÀ 

'Assign 7' GÝ® ö£¯›À ÷\ªUP.

Different type of software

 Antivirus
           AVG
           Semantic
           Kaspersky
 E-mail
  Outlook
  Yahoo mail
  Gmail
 Games
  Worlds of Warcraft
  Car race
 Internet browser
  Firefox
  Explore 
  Google
 Operating system
  Windows XP
  Windows 7
  Linux

ö\¯Ø£õmk E¸ 6
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 }º u¯õ›zu BÁn® AÀ»x PiuzvøÚ öuÎÁõPÄ® PÁºa]Pµ©õPÄ® 

ö£ØÖU öPõÒÁuØS £À÷ÁÖ A®\[PøÍ Em¦Szu •i²®.

8

5

1

2

5
3

6

4

7

4
1.  ÁiÁ[PÒ (Shapes / Objects)

2.  £h[PÒ 

 ( Pictures / Images / Clip Art)

3 SÔ±kPÒ (Symbols) 

4.  AmhÁønPÒ (Tables)

5.  ÷©ØSÔ¨¦®  AiUSÔ¨¦® 

 (Header and Footer)

6. £UP C»UP[PÒ 

 (Page Numbers)

7.  {µÀPÒ (Columns)

8.  ö\õØPø» (Word Art / Font work)

E¸ 6.19

6.4.1  ÁiÁ•®  (Shapes) £i©[PÐ® (Images) 

      }[PÒ u¯õ›zu BÁn[PøÍ ªPz öuÎÁõPÄ® PÁºa]Pµ©õPÄ® ö£ØÖU 

öPõÒÁuØS¨ £i©[PøÍ²® (Images) ÁiÁ[PøÍ²® (Shapes)  EÒÎh»õ®. 

CuØöPÚ •u¼À £i©[PÒ (Images) AÀ»x ÁiÁ[PÒ  (Shapes) ÷uøÁ¨£k® 

ChzvÀ {ø»Põmiø¯ (Cursor) øÁzx AÁØøÓ EÒÎkP.

 Microsoft Word CÀ 

Insert I²® Auß £miø¯²® 

£¯ß£kzxP

♦  ÁiÁø©¨£uõ°ß

 Insert →  Shapes I öu›Äö\´P.

♦ E›¯ ÁiÁzvß «x ö\õhUQ 

AuøÚ ö£õ¸zu©õÚ ChzxUS 

CÊzx ÁµÄ®.  
♦  £i©zvøÚ CkÁuØS Insert CÀ 
 C¸¢x Picture / Clip Art  I 

öu›Äö\´P.

♦  }[PÒ Â¸®¦® £i©zvøÚ 

vÓ¢x öPõÒP.

 LibreOffice Writer CÀ 

♦  £mi¯À £møh°¾ÒÍ Insert I 

£¯ß£kzxP.

♦ ÁiÁø©¨£uõ°ß Insert Objects 
OLE object öu›Äö\´P AÀ»x 

Drawing Tool C¼¸¢x E›¯            

ÁiÁzvß «x ö\õhUQ AuøÚ 

E›¯ £UPzxUS (Drag) CÊzxa 

ö\À»Ä® 

♦ J¸ £i©zvøÚ CkÁuØS 

Insert → Picture → From File  I 

öu›Äö\´P.

♦ }[PÒ Â¸®¦® £i©zvøÚz 

vÓ¢x öPõÒP.

 6.4   BÁnzvøÚ ö©¸TmkuÀ (Formating Document)
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ÁiÁzvøÚ                    

/ £hzvøÚ                  

_ÇØÖÁuØPõP

ÁiÁzvøÚ 

/ £hzvøÚ  

A[S® C[S® 

|PºzxÁuØS 

ÁiÁ®                   

/ £iÁzvß 

AÍÂøÚ 

©õØÖÁuØS

 E¸ 6.20 £h® AÀ»x Põm]ø¯ JÊ[Pø©zuÀ    

   6.4.2  ÁiÁ® AÀ»x £i©[PøÍ ÁiÁø©zuÀ  

 E©x BÁnzvÝÒ Em¦Szv¯ £h® AÀ»x ÁiÁzvøÚ ÷uøÁU 

÷PØ£ ÁiÁø©zxU öPõÒÍ•i²®. Auß AÍÂøÚ²® {ÓzvøÚ²® 

ÂÎ®¦PøÍ²® (Border) ©ØÖ® ChzvøÚ²® ©õØÔU öPõÒÍ •i²®.  
(E¸  6.20) £hzvÀ  AÀ»x  ÁiÁzvÀ ©õØÓ[PøÍa ö\´¯ •ßÚº Auß 

«x _miø¯ øÁzxa ö\õhUQ öu›uÀ ÷Ásk®. AÆÁõÖ ÷uº¢öukzuuß 

¤ßÚº ÷uõßÖ® £h® AÀ»x ÁiÁzvøÚ  ÁiÁø©¨£uØPõÚ P¸Â¨ 

£møh°øÚ¨ £¯ß£kzu •i²®.

 

Microsoft Word  |õhõÂÀ ÁiÁzvøÚ ÁiÁø©UP £¯ß£kzu¨£hÀ

E¸UP¸Â

LibreOffice  Writer  JÊ[Pø©UP  £¯ß£kzu¨£k®  P¸Â¨ £møh 

   6.4.3  SÔ±kPÒ (Symbols) 
 

 BÁn[PøÍ u¯õ›US®÷£õx £À÷ÁÖ SÔ±kPøÍ¨ £¯ß£kzu 

÷Ási HØ£k®. GÛÝ®, |õ® £¯ß£kzx® Âø\¨£»øP°À (Keyboard)  
SÔ¨¤mh AÍÄ SÔ±kP÷Í  Põn¨£kQßÓÚ. GÚ÷Á, ÷©»vP SÔ± 

kPøÍ¨  ö£ØÖUöPõÒÁuØS ¤ßÁ¸® £i•øÓPøÍU øP¯õÍ ÷Ásk®.
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Microsoft Word CÀ

Insert→ Symbol ‰»®  vÓUP¨£k®                         

\mhPzvÀ EÒÍ  SÔ±kPøÍz ÷uº¢ 

öukzx Insert «x ö\õhUSÁuß ‰»® 

BÁnzvÀ Em¦Szu •i²®.

Libre Office Writer  CÀ

Insert→ Special Character ‰»® 

vÓUP¨£k® \mhPzvÀ EÒÍ 

SÔ±kPøÍ ÷uº¢öukzx 

OK «x ö\õhUSÁuß  ‰»® 

BÁnzvÀ Em¦Szu •i²®.

  

   6.4.4  uø»¨¦, Ai (Header and Footer) ©ØÖ® £UP GsPÒ 

(Page Numbers)

 BÁn[PÒ ©ØÖ® \g]øPPøÍ E¸ÁõUS®÷£õx uø»¨¦, AiU 

SÔ¨¦ ÷£õßÓÚÄhß £UP GsPÒ Ch¨£kÁx® ]Ó¢uuõS®. CuØPõP Insert 
Header and Footer ©ØÖ® Insert Page Number  CøÚ £¯ß£kzv BÁnzvØS 

ö£õ¸zu©õÚÁõÖ uø»¨¦, AiUSÔ¨¦ ©ØÖ® £UP GsPøÍ²® CkP. 

Microsoft Word  CÀ

  uø»¨¦, AiUSÔ¨¦ P¸ÂPÒ

   6.4.5   {µÀ (Column) 

 £zv›øPPÒ ©ØÖ® \g]øPPøÍ E¸ÁõUS®÷£õx CÆÁ\v¯õÚx 

AiUPi £¯ß£kzu¨£kQÓx.

 {µ»õÚx   SÔzu Á›ø¯ / £¢vø¯ umha]h •ßÚº AÀ»x umha 

]mh ¤ßÚº ÷uøÁU÷PØ£ Ch¨£h •i²®. CuØPõP •u¼À umha]mh 

Á›ø¯ / £¢vø¯ öu›Ä ö\´uÀ ÷Ásk®.

Microsoft Word CÀ

PageLayout → Columns → BÁnzvØS 

ö£õ¸zu©õÚÁõÖ {µÀPÎß Gs 

oUøPø¯z öu›Ä ö\´P.

LibreOffice Writer  CÀ

Formatting → Columns → BÁnz 

vØS ö£õ¸zu©õÚÁõÖ {µÀ 

PÎß  GsoUøPø¯z öu›Ä 

ö\´P.
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  ö\¯Ø£õk

1.  }[PÒ £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzuÀ  ö©ßö£õ¸øÍz vÓ¢x 

¤ßÁ¸® ö\¯Ø£õmøh ÷©ØöPõÒÍ ¦v¯  £UPö©õßøÓz vÓ¢x 

öPõÒP. 

  ö\¯Ø£õmk E¸ 7 CÀ Põmh¨£mkÒÍ £¢v°øÚ BÁn¨£kzxP. 

¤ßÚº AvÀ Põmh¨£mkÒÍÁõÖ AuøÚ ÁiÁø©UP. AÆ BÁnz 

xUS ""Word Pass'' GÚ PhÄa ö\õÀø» ÁÇ[SÁxhß ′Assign 10′ GÝ® 

ö£¯›À E[PÍx ÷Põ¨¦øÓ°ÝÒ ÷\ªUP. 

Electronic waste (E - waste): what is it and how do 
we get rid of it ?
This term applies to consumer and business 

electronic equipment that is near or at the end of its useful 
life There is no clear definition for electronic waste (e - 
waste) at this time, but if you can plug it in an electrical

outlet or it contains circuit boards or chips, it is 
most likely e - waste. These products can contain 
heavy metals like cadmium, lead, copper, and 
chromium that can contaminate the environment 
Do NOT dispose of these items in the trash or your 
recycling bins.

Examples of electronic waste include, but not limited to :
 � TVs, computer monitors, Printers, Scanners, Keyboards, mice, cables, circuit boards, 

lamps, clocks, flashlight, calculators, phones, answering machines, digital / video 
cameras, radios, VCRs, DVD players, MP3 and CD players.

 � Kitchen equipment (toasters, coffee makers, microwave evens)
 � Laboratory equipment (hot plates, microscopes, calorimeters)
 � Broken computer monitors, television tubes (CRTs)

Student E - waste Recycling Options
Any laboratory equipment that has the possibility 
of being contaminated with chemical, biological, 
or radioactive substances must be cleared through 
EH&S and Departmental Facilities Office before 
disposal. 

If you live on - campus you can dispose of your electronic 
waste easity and conveniently by creating a Fix It Ticket or 
contacting your college maintenance office.
If you live off - campus, learn more about the Sants Cruz 
County electronic waste disposal program:

Additional information on disposal / recycling of e - waste and other regulated items can 
be found in all college mailrooms, Graduate Student Housing Mailroom and the Village 
Laundry Community room. Multibins are blue cabinets built to collect batteries, small 
electronics, printer cartideges, and CDs. They are located in every college mailroom.

ö\¯Ø£õmk E¸ 7 

Electronic Waste DisPosal

6.4.6  AmhÁønPÒ (Tables)  
 

   BÁn[PøÍz   u¯õ›US®÷£õx ]» uµÄPøÍ AmhÁøn£kzu 

÷|›k®. AuØöPÚ AmhÁønö¯õßÔøÚ¨ ö£õ¸zu©õPz  u¯õ›zxU 

öPõÒÍ ÷Ásk®. ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸ÎÀ CuØPõÚ  Á\

vPÒ  Põn¨£kQßÓÚ. (E¸ 6.21  I¨ £õºUP).
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1.  AmhÁønUS AÁ]¯¨£k® {øµPÒ (Rows) ©ØÖ® {µÀPÒ (Columns)
Gß£ÁØøÓ Em¦SzuÀ AÀ»x ÁøµuÀ

2.  AÁ]¯©ØÓ Á›PÒ ©ØÖ® {µÀPøÍ }USuÀ

3.  ÷©»vP Á›PÒ ©ØÖ® {µÀPøÍ Em¦SzuÀ

4.  AmhÁøn°¾ÒÍ P»[PÎøÚ CønzuÀ. (Merge  Cell)

5.  AmhÁøn°¾ÒÍ J¸ P»zvøÚ £» £õP[PÍõP ¤›zuÀ (Split Cell)

6.    AmhÁønUS {Ó® öPõkzuÀ

7.   ö\õØPÎß vø\°øÚ ©õØÖuÀ (Changing Text Direction) 
 ÷£õßÓ £»  Á\vPÒ Põn¨£kQßÓÚ.

Merge 
Cells

E¸  6.21   AmhÁøn  (Table)

Time Monday     Tuesday  Wednesday Thursday  Friday
                 TIME TABLE

A
B

C

Split 
Cells

Interval

Text Direction

X
ZY

·      AmhÁøn  u¯õ›US® Âu®

Microsoft Office  CÀ

·  Insert→Table I öu›P.

· ÷£õx©õÚ AÍÄ Á›PÒ ©Ø 

Ö® {µÀPøÍ öu›Ä ö\´P. 

AÀ»x Insert→Table CÀ AÁ] 

¯©õÚ {øµPÒ  ©ØÖ®   {µÀ

 PøÍ ÁÇ[SP.

·  OK CøÚ ö\õhUSP.

LibreOffice Writer  CÀ 

·  Table → Insert → Table I Em¦Sz 

xP. 
· Insert → Table AÁ]¯©õÚ 

{øµPÒ  ©ØÖ® {µÀPøÍ 

ÁÇ[SP.

· Insert  I   ö\õhUSP. 
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·  AmhÁøn°øÚz u¯õ›UP •ßÚº AmhÁøn / {øµPÒ / {µÀPÒ /                          

Pmh[PÒ BQ¯ÁØøÓz öu›Äö\´P.

·  AmhÁøn°¾ÒÍ Pmh[PÐUQøh÷¯ A[S® C[S® |PºÁuØS 

Âø\¨ £»øP²hß vø\a \õÂPÒ AÀ»x Tab \õÂ AÀ»x _mi°ÞhõP 

ö\õhUSuÀ ÷£õßÓÁØøÓ £¯ß£kzu •i²®. 

AmhÁønU P¸Â
Microsoft Word GÛß

 

AmhÁønö¯õßøÓz u¯õ›UP B¯zu©õÚ Eh÷Ú AmhÁønU P¸Â |õhõ ö\¯Ø£h 

Bµ®¤US® E[PÍõÀ ÷uº¢öukUP¨£mh  AmhÁøn {øµ / {µÀ / P»[PøÍ ÷uøÁ 

÷PØÓÁõÖ JÊ[Pø©zxU öPõÒÍ C[SÒÍ Design ©ØÖ® Layout  |õhõøÁz öu›Ä 

ö\´xöPõÒÍ •i²®. 

P»[PøÍ Cøn¨£uØS, 

1'  CønUP Gvº£õºUS®  {øµ / {µÀPøÍz öu›Äö\´P.

2'  Table Tools  CÀ Layout |õhõÂ¾ÒÍ  Merge CøÚ ö\õhUSP.            

 

LibreOffice Writer  CÀ

 AmhÁønö¯õßøÓz u¯õ›¨£uØS ÷uøÁ¯õÚ P¸ÂPøÍz öu›Äö\´P. 

£mi¯¼¾ÒÍ Table £miø¯ ö\õhUSP. Av¼¸¢x Delete, Select, Insert, Split, 
Merge Gß£ÁØøÓ ÷uøÁU÷PØ£ £¯ß£kzxP.

AÀ»x  Table → Table Properties → Table Format I £¯ß£kzv AmhÁønø¯z 

u¯õ›UP.
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1'  ¦v¯ £UPö©õßøÓ¨  ö£ØÖU öPõÒP. ö\¯Ø£õmk E¸ 8 
CÀ Põmh¨£mkÒÍÁõÖ  AmhÁøn  JßøÓz u¯õ›UP.  

2'  Auß ¤ß A¢u BÁnzøu  "Assign 11" GßÝ® ö£¯›À  

E©x ÷Põ¨¦øÓ°ÝÒ ÷\ªUPÄ®.   

   ö\¯Ø£õk

ö\¯Ø£õmk E¸ 8

6.5  \µøÁ£õº¨¦   (Proofreading)  

6.5.1  GÊzx ©ØÖ® C»UPn¨ ¤øÇPøÍz v¸zxuÀ

        _¯©õP÷Á GÊzx¨ ¤øÇPÒ ©ØÖ® C»UPn¨ ¤øÇPøÍU PshÔ¢x 

AÁØøÓ CÚ[PõmkÁxhß ]» ö£õ¸zu©õÚ v¸zu[PøÍ²® CÚ[ 

Põmk®. GÊzx¨ ¤øÇPÐhÚõÚ   ö\õØPÒ   ]Á¨¦ {ÓU ÷PõmiÚõÀ  CÚ[ 

Põmh¨£k®. C»UPn¨ ¤øÇPÒ £aø\ {ÓU ÷PõmiÚõÀ CÚ[ Põmh¨£k®. 

umha_a ö\´¯¨£mh  BÁnö©õßÔÀ CÆÁõÓõÚ ¤øÇPøÍ {Áºzv ö\´¯ 

÷Áskö©Ûß,

Pmh®  1 :
  
BÁnzvß  Bµ®£¨ £SvUS  _miø¯ (Cursor) Gkzxaö\ÀP.

 Microsoft  Word  CÀ Libre Office  Writer  CÀ

  
· Review   Spelling and Grammar 
  I ö\õhUSP.

· Type   Spelling and Grammar 
  I ö\õhUSP.
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Pmh® 2 

 ]Á¨¦ {ÓzvÚõÀ AÀ»x £aø\ {ÓzvÚõÀ CÚ[Põmh¨£mh  

¤øÇPøÍ v¸zxÁuØS ö£õ¸zu©õÚ ö\õÀø» £›¢xøµ  (Sugestion) 
£Sv°¼¸¢x öu›Äö\´x  Change CøÚ ö\õhUSP. B[Q» APµõv°À 

CÀ»õu ö\õØPøÍ (£À÷ÁÖ ö£¯ºPÒ, uÛ¯õº ö£¯º, Qµõ©[PÎß ö£¯º, 

|õkPÎß ö£¯º) }USÁuØPõP  Ignore CøÚa ö\õhUSP.

6.5.2  {Psk (Thesaurus)

         BÁn[PøÍz u¯õ›US®÷£õx |õ® £¯ß£kzx® ö\õØPÐUS¨£v»õP 

Auß P¸zxUPøÍ²øh¯ ÷ÁÖ ö\õØPøÍ¨ £¯ß£kzxÁuØS® AÁØøÓ 

÷uøÁ¯õÚ Ch[PÎÀ ö£õ¸zxÁuØS®  {Psk £¯ß£kzu¨£kQßÓx. 

CuØöPÚ,

Microsoft Word CÀ

Review  Thesaurus 
I ö\õhUSP.

LibreOffice Writer  CÀ

Tools  Language  Thesaurus
I ö\õhUSP.

  6.5.3  ö\õØPøÍz ÷ukuÀ ©ØÖ® AÁØÖUS ÷ÁÖ  ö\õØPøÍ ©õØÕk 

ö\´uÀ (Find and Replace)

 E[PÍõÀ    u¯õ›UP¨£mh   BÁnzvÀ  EÒÍ ö\õÀö»õßøÓ  }UP   

÷Áskö©ÚU öPõÒÐ[PÒ. E[PÐøh¯ BÁn® £» £UP[PøÍU öPõsh 

uõPÄ® E›¯ ö\õÀø»z ÷ukÁx PiÚ©õPÄ® C¸UP»õ®. CuØöPÚ ÷ukuÀ 

(Find) Á\vPøÍ E[PÐUS £¯ß£kzu •i²®. CuØöPÚ 

• BÁnzvß  Bµ®£zvØS {ø»UPõmiø¯  Gkzxa ö\ÀP.

Microsoft Word  CÀ

Home →Editing  öuõSv°À Find CøÚ öu›Ä ö\´P.

 · ÷©÷» Põmh¨£mkÒÍÁõÖ vÓUP¨£k® P¸Â°À EÒÍ Á›°À 

 Search  Document  GÝ®   ChzvÀ  ÷uku¾US›¯  ö\õØPøÍ  um 

 ha_  ö\´P. 
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LibreOffice Writer  CÀ

Edit → Find öuõSv°À Find I ö\õhUSP. 
 Find Next 

÷©÷» Põmh¨£mkÒÍÁõÖ  vÓUP¨£k® P¸Â°À ÷ukuÀ (Find) 
GßÓ ChzvÀ ÷uku¾UPõÚ ö\õÀø» umha_ ö\´¯Ä®. ¤ßÚº 

Find Next «x  ö\õhUSP.

 ² BÁnzvÀ EÒÍ J¸ ö\õÀ¾US ©õØÕhõP ÷ÁÖ J¸ ö\õÀø» 

Em¦SzxÁuØS  ö\õÀ ©õØÕk ö\´²® Á\vPÒ Põn¨£kQßÓÚ.

Microsoft Word CÀ

Home Editing ¤›ÂÀ Replace «x 

ö\õhUSP.  

LibreOffice Writer CÀ  

Edit £mi¯¼À Replace I 

ö\õhUSP.  

 ² ÷uh÷Ási¯ ö\õÀ¼øÚ AuØS›¯ ö\õÀ»õhØ ö£mi°À EÒÍ Find 
What  AÀ»x  Search for GÝ® ChzvÀ umha_ ö\´x  Replace / Replace All  I 

ö\õhUSP.  (E¸ 6.22)

  

E¸ 6.22
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}[PÒ £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzx® ö©ßö£õ¸øÍ 

vÓ¢x ¤ßÁ¸® ö\¯Ø£õmøh ö\´P.

1.  ö\¯Ø£õmk E¸ 9 CÀ öPõkUP¨£mkÒÍ £¢vø¯ 

umha_ ö\´P. ¤ßÚº AÆ BÁnzøu ''Assign 12'' GÝ® 

ö£¯›À  ÷Põ¨¦øÓ°ÝÒ ÷\ªUPÄ®. 

ö\¯Ø£õmk E¸ 9

2.  ¤ßÁ¸® •øÓ°À BÁnzv¾ÒÍ ö\õØPøÍz v¸zxP.

• Businasses    - Businesses
• Camputing   - Computing
• Natwork       - Network
• Prommises      - Promises
• Resourses - Resource

3.  ¤ßÚº GÊzx ©ØÖ® C»UPn¨ ¤øÇPøÍU PshÔ¢x AÁØøÓ 

«Íz v¸zxP. (Spelling and Grammar) 

4.   ö\õÀ ÷ukuÀ  Á\v°øÚ¨ £¯ß£kzv R÷Ç öPõkUP¨£mkÒÍ ö\õØ                              

     
PøÍz  ÷ukP. 

 Web mail, Information, Storage

5.  ö\õØPøÍ ©õØÕk (Replace) ö\´uÀ Á\v°øÚ¨ £¯ß£kzv ¤ßÁ¸®                    

ö\õØPøÍ ©õØÕkö\´P.

• Business      Trade
• Expensive    Luxurious
• Connection  Relation

6.  ö\õØPøÍ ©õØÕk ö\´u ¤ßÚº AuøÚ  'Assign 13' GÝ®  ö£¯›À 

E[PÍx ÷Põ¨¦øÓ°ÝÒ (Folder) ÷\ªUSP.

   ö\¯Ø£õk
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6.6  Aa]kuÀ (Print)

6.6.1  Aa]kuÀ  •ßPõm] (Print Preview)

 u¯õ›zx •izu BÁnzvøÚ Aa]h •ßÚº Ax G©x ÷uøÁU 

÷PØÓÁõÖ ÁiÁø©¨¦PÒ (Format), GÀø»PÒ (Margins) ÷£õßÓÚ \›¯õP Aa]

h¨£k©õ GÚ AÁuõÛ¨£uØS •ßPõm] (Print Preview) EuÄQßÓx. 

6.6.2  Aa]kuÀ (Print)

BÁn[PøÍ Aa]kÁuØS ¤ßÁ¸® P¸Â £¯ß£kzu¨£kQßÓx:
File → Print I öu›Äö\´²®÷£õx Aa]kÁuØPõP ö\õÀ»õhØ ö£mi QøhUP¨ 

ö£Ö®.

Microsoft Office Print ©ØÖ® LibreOffice Print

E¸ 6'23 MicrosoftOffice Print E¸ 6'24 LibreOffice Print

}[PÒ £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸Îß Ai¨£øh°À 

vÓUP¨£k® ö\õÀ»õhØ ö£mi ¤ßÁ¸® Á\vPøÍ ÁÇ[SQÓx.

*    BÁnzvøÚ   Aa]kÁuØS  ö£õ¸zu©õÚ   Aa]¯¢vµzvøÚ    öu›Ä  

      ö\´uÀ

*  Aa]h ÷Ási¯x öu›Äö\´¯¨£mh J¸ £UPzøu¯õ AÀ»x £» 

£UP[PøÍ¯õ AÀ»x •Ê BÁnzøu²©õöÁÚ wº©õÛzuÀ (Current 
page, page 3 or All)
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*  ö£ØÖUöPõÒÍ¨£k® ¤µvPÎß GsoUøPPøÍ wº©õÛzuÀ (Number 
of  Copies)

 

6.7  Ag\À JßÔøn¨¦  (Mail Merge)

 u¯õ›UP¨£mh ÁõÌzx©hÀ, Piu® AÀ»x \õßÔuÌ ÷£õßÓÁØøÓ 

£»¸US Â{÷¯õQUPöÁÚz u¯õ›¨£uØS Ag\À JßÔøn¨¦ (Mail Merge)  
£¯ß£kzu¨£kQßÓx. Cuß÷£õx  ö©ßö£õ¸ÎÀ ÷\ªzx øÁUP¨£mh 

uµÄ AÀ»x E[PÍõÀ Ag\À JßÔøn¨ø£¨ £¯ß£kzvz u¯õ›UP¨£mk 

EÒÍhUP¨£mh uµÄPøÍ¨ £¯ß£kzu •i²®. Ax©mk©ßÔ u£õ»møh 

PÐUS Â»õ\[PøÍ²® Cmk Aa]h •i²®.

Ag\À JßÔøn¨¤øÚ ÷©ØöPõÒÍÀ

* •u¼À E[PÍx BÁnzøuz umha_ ö\´¯Ä®.

uµÄ ‰»®

(Data Soure)
¤µuõÚ BÁn®

(Master Document)

Piu[PÒ, Â»õ\ •P¨¦ Aøh¯õÍ®

(Letters)      (Address Label) 

....... ....... .......

....... ....... .......

Ag\À JßÔøn¨¦a 

ö\¯Ø£õk:
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Microsoft Word CÀ

●   Pmh® 1.   Mailing  I  öu›Äö\´P

●   Pmh® 2.  Start Mail Merge → letter I öu›Äö\´P

                      (Data Source) I {º©õoUP AÀ»x öu›Äö\´P.

●   Pmh® 3.  Select Recipient → Type New List I öu›Äö\´P. 

  PÁÛUP :  HØPÚ÷Á   ÷\ªUP¨£mh  uµÄPøÍ ö£ØÖU öPõÒÍ 

öÁÛß Use Existing List I öu›Äö\´P.

●   Pmh® 4. New Address List GßÓ ö\õÀ»õhÀ ö£mi°¾ÒÍ  Âh¯[ 

PÎÀ Customize   I ö\õhUSÁuß ‰»® BÁnzxUS HØÓ 

Âu©õP  ¦»[PøÍ  "New Address List window"ÂÀ ©õØÔ                    

Aø©UPÄ®.  AøÁ¯õÁÚ :  
                      a.  Add (¦v¯ ¦»zvØPõP)
                      b.  Delete (¦»ö©õßøÓ }USÁuØS)
                      c.  Rename (¦»zvß ö£¯›øÚ ©õØÖÁuØPõP)  
●  Pmh® 5.   ©õØÓ[PøÍ ö\´x OK I ö\õhUPÄ®

●  Pmh® 6.   ÷uøÁ¯õÚ uPÁÀPøÍ umha_ ö\´¯Ä®, CuØS ¤ßÁ¸ 

ÁÚÁØøÓ £¯ß£kzuÄ®

  a. New Entry (¦v¯ Â»õ\zvØPõP) 
           b. Delete Entry (Â»õ\ö©õßÔøÚ }USÁuØS)
  c. Find (÷\ªzx øÁUP¨£mkÒÍ •PÁ›ö¯õßÔøÚ ÷uk 

ÁuØPõP) 

●  Pmh® 7.   ©õØÓ[PÒ ö\´x OK CøÚ ö\õhUQ ÷\ªUPÄ®. •PÁ› 

öuõSv°øÚ (Address Block) E¸ÁõUPÄ® £¯ß£kzuÄ® 

¤ßÁ¸ÁÚÁØøÓ ¤ß£ØÖP.

           a. £À÷ÁÖ Â»õ\[PøÍ öu›Ä ö\´¯ More Gß£øu 

£¯ß£kzxP

         b.  A¢u   •PÁ›PøÍ   E[PÒ  •PÁ›PÐhß J¨¤kÁuØS 

  Match Field  CøÚ £¯ß£kzu •i²®. 

●  Pmh® 8.   ö£õ¸zu©õÚÁõÖ ©õØÔ¯ ¤ß  Next AÀ»x OK I ö\õhUPÄ®.

●  Pmh® 9. ÁõÌzx Á›°øÚ (Greeting Line) ÷\ºzxUöPõÒÍ CuøÚ                 

£¯ß£kzuÄ®.

●  Pmh® 10.  ö£õ¸zu©õÚ •øÓ°À ©õØÓgö\´u ¤ß Next AÀ»x OK   I 

ö\õhUSP Insert Merge Field  Gß£øu¨ £¯ß£kzv  ÷©»vP 

¦»[PøÍ ÷\ºzxUöPõÒÍ •i²®. AuØöPÚ {ø»UPõmiø¯ 

(Cursor)  ÷uøÁ¯õÚ ChzvÀ  øÁUPÄ®. ¤ßÚº

● Pmh® 11.  Insert Merge Field I ö\õhUSÁuß ‰»® ÷uøÁ¯õÚ ¦»[PøÍ 

BÁnzvÀ   ÷\ºUPÄ®. 
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LibreOffice Writer CÀ

●  Pmh®  1.  Tool → Mailing Wizard  öu›Äö\´P.

●  Pmh®  2.  Select Starting Document → Use the current Document → Next I                      
öu›Äö\´P. 

●  Pmh® 3.    Select  the  document Type → Letter → Next    •PÁ›¨   £mi¯ø»   

                  E¸ÁõUP AÀ»x öu›Ä ö\´P.

●  Pmh® 4.    Insert  Address Block → Select Address List → Create I öu›Äö\´P.

  *PÁÛUP     HØPÚ÷Á PoÛ°À EÒÍhUP¨£mi¸¢u uµÄPøÍ «sk®   

                  ö£ØÖUöPõÒÍ Add I öu›Äö\´P.

●  Pmh® 5.   New   Address  List  GßÓ ö\õÀ»õhÀ ö£mi°¾ÒÍ ¦»[PøÍ     

                    Customize I ö\õhUSÁuß ‰»® BÁnzxUS¨ ö£õ¸zu©õÚ  

          Âu©õP ©õØÔU öPõÒÍÄ®. AuØöPÚ :
  a.  Add (¦v¯ ¦»ö©õßÖUPõP)
  b.  Delete (¦»ö©õßøÓ }USÁuØS)
  c. Rename (¦»ö©õßÔß ö£¯›øÚ ©õØÖÁuØPõP) £¯ß£kz 

    xP.        
●  Pmh® 6.   ©õØÓ® ö\´u¤ß OK I ö\õhUPÄ®. 

●  Pmh® 7.   ÷uøÁ¯õÚ  uµÄPøÍz  umha_  ö\´ÁuØS

  a.  New (¦v¯ Â»õ\zxUPõP)
          b. Delete (Â»õ\ö©õßøÓ }USÁuØS)
            c. Find (÷\ªUP¨£mkÒÍ  Â»õ\zøu ÷ukÁuØPõP)        

  £¯ß£kzxP.

●  Pmh® 8. ©õØÓ® ö\´u¤ß  OK   CøÚa   ö\õhUS. ¤ßÚº  ö£õ¸zu©õÚ  

ChzvÀ  ö£õ¸zu©õÚ  ö£¯øµ  Cmk ÷\ªzxU öPõÒÍÄ®.

●  Pmh® 9.    «sk® OK CøÚ  ö\õhUPÄ®.    

●  Pmh® 10. Insert Address block  \õÍµzv¾ÒÍ  2, 3, 4 B® £i•øÓPøÍ 

JÊ[S  •øÓ¯õP ¤ß£ØÓÄ®

           a. •PÁ› öuõSv°À (Address Block)  Â»õ\® Aø©¯ ÷Ás¯         

                     ÂuzvøÚz  wº©õÛzuÀ. Cx ¤ßÁ¸ÁÚÁØÖPõP £¯ß£kz 

u¨£k®

           b. £À÷ÁÖ •PÁ›PøÍ öu›Äö\´¯ (More) 
           c. A¢u •PÁ›PøÍ E[PÒ •PÁ›PÐhß J¨¤kÁuØS                        

   Match Field  CøÚ¨ £¯ß£kzu •i²®.

 öÁÆ÷ÁÓõP   Piu[PøÍ  ö£ØÖU öPõÒÍ, 

●  Pmh® 12. Finish & Merge Edit individual Document CøÚ öu›Ä ö\´P.

●  Pmh® 13.  u¯õ›UP¨£mh Piu[PøÍ ö£õ¸zu©õÚ •øÓ°À ÷\ªzx 

Aa]hÄ®.
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●  Pmh® 11.  ö£õ¸zu©õÚ •øÓ°À ©õØÓgö\´u¤ß Next I  ö\õhUPÄ®.

●  Pmh® 12. ÂÎ¨¦PøÍ E¸ÁõUP  (Create a Salutation) C¢u \õÍµzøu 

£¯ß£kzxP. ö£õ¸zu©õÚÁõÖ ©õØÓ® ö\´P.

●  Pmh® 13.  Next I  ö\õhUSP.

●  Pmh® 14. E[PÍx  Â»õ\zvøÚ CkÁuØS  Adjust Layout of Address 
Block and solutation GÝ® \õÍµzøu £¯ß£kzxP. Next I                                        

ö\õhUSP.

 ●  Pmh® 15.Piuzøu¨ ö£ØÖU öPõÒ÷Áõøµ ÷uº¢öuk¨£uØS® BÁ 

nzvß  •ßPõm]ø¯¨ ö£ØÖU öPõÒÍÄ® Preview and Edit 
the  Document   GßÓ  \õÍµzøu  £¯ß£kzxP. ¤ßÚº Next I  
ö\õhUPÄ®.

●  Pmh® 16. Personalise Document \õÍµzvß ‰»® Â»õ\[PøÍ ÷ui¨ 

ö£ØÖU öPõÒÍÄ® BÁn® JßøÓz  u¯õ›UPÄ® •i²®.

● Pmh® 17.  Return to Mail Merge Wizard I ö\õhUSÁuß ‰»® Mail Merge 
Menu I  CønUP. Next I ö\õhUQ öuõhºP.

●  Pmh® 18.  £À÷ÁÖ Âu©õÚ  ÷\ª¨¦ ©ØÖ® Aaö\k¨£uØS 

                   Save, Print or send Document  I £¯ß£kzxP.

 a.  Save starting Document -  Ai¨£øhU Piuzøu ÷\ª¨£uØS

 b. Save Merged Document - Ag\À Cøn¨¦ ö\´u Piuzøu 

÷\ª¨£uØS

 c. Print  Merged Document -Ag\À Cøn¨¦ ö\´u Piuzøu 

Aa]kÁuØS

 d. Send Merged Document as email - Ag\À Cøn¨¦ ö\´u 

Piuzøu ªßÚg\À ö\´ÁuØS. 



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À216 217

  

}[PÒ £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸øÍ 

vÓ¢x ¤ßÁ¸® ö\¯Ø£õmiøÚ ÷©ØöPõÒP. 

1. ö\¯Ø£õmk E¸ 10 CÀ Põmh¨£mkÒÍ PiuzvøÚ umha_ 

ö\´P. B°Ý®  "<>" GÝ® Aøh¯õÍzøu²® AuÛøh÷¯ 

GÊu¨£mkÒÍ ö\õØPøÍ²® umha_a ö\´¯ ÷Áshõ®. 

CuØöPÚ Kº CøhöÁÎø¯ ÂkP. Auß ¤ßÚº AuøÚ 

'Assign 10' GÝ® ö£¯›À ÷Põ¨¦øÓ°ÝÒ ÷\ªUPÄ®.  

Computer Resource Centre
Senkadagala
28. 04.2014

‹Title› ‹First Name› ‹Last Name›
‹Address Line 1›
‹Address Line 2›

Teacher Parent Interact day

Please take this opportunity to discuss the progress of your child 
‹child’s Name› by meeting the class teacher on ‹Date› at ‹Time› 
at the classroom.

Principal

 

2.  Ag\À Cøn¨ø£¨ £¯ß£kzxP. •PÁ›¨ £mi¯À/uµÄ ÁÍzvØPõP 

R÷Ç Põmh¨£mkÒÍ AmhÁøn ÷£õßÖ £zx¨ |£ºPÐUS 

AÝ¨¦ÁuØ÷PØ£  •PÁ›PøÍ  EÒÎkP'

ö\¯Ø£õmk E¸ 10

Title First Name

Chaminda Sampath
Chandrabose

Pelawaththa Battaramulla
Colombo

Yawaha 26.06.2014
26.06.2014
26.06.2014

Derwin
SharmilaDehiwala

Mattakkuliya
Hill StreetAmith

9.00 am
9.30 am
10.00 am

Pushparani
Mohamed

Child-
NameLast Name Address 1 Address 2 Date Time

Mr.

Mr.
Mrs.

 ö\¯Ø£õk
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1' }[PÒ £¯ß£kzx® ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸øÍ 

vÓ¢x R÷Ç Põmh¨£mkÒÍ BÁn[PøÍz u¯õ›UP •¯Ø                                                  

]UPÄ®'

*  \õßÔuÌ    *  Piu®

*  AøÇ¨¤uÀ    *  AÔÂzuÀ

*  Âsn¨£¨£iÁ®  *  £uõøP

2' }[PÒ u¯õ›zu BÁn[PøÍa ÷\ªUPÄ®. ¤ßÚº AÁØÔøÚ Aa]hÄ®. 

3' PDF ÷Põ¨¦PøÍ E¸ÁõUPÄ®.

4' ªPÄ® AvP©õP £¯ß£kzu¨£k® ö\õÀ•øÓ ÁÈ¨£kzuÀ ö©ß 

ö£õ¸ÒPøÍ  £mi¯Ø£kzxP.

   ö\¯Ø£õk

6.7.1 SÖUSÁÈa  \õÂPÒ (Shortcut Keys) 

 PoÛ  öuõhº£õÚ  £oPøÍ  ÷ÁP©õPa  ö\´ÁuØS   SÖUSÁÈa 

\õÂPÒ £¯ß£kzu¨£kQßÓÚ. AÆÁõÖ £¯ß£kzu¨£k® ]» \õÂPÒ 

©ØÖ® AÁØÔß ö\¯Ø£õkPÒ R÷Ç Põmh¨£mkÒÍÚ. CÁØøÓ E[PÍx 

ö\¯Ø£õmkUPõP¨ £¯ß£kzv ÷|µzøu ªa\¨£kzvU öPõÒÐ[PÒ.

SÖUS ÁÈ  \õÂPÒ
 

ö\¯Ø£õkPÒ

Ctrl + N = ¦v¯ BÁn® JßøÓ ö£ØÖU öPõÒÁuØS

Ctrl + S = BÁnzøu  ÷\ª¨£uØS

Ctrl + O = BÁnzøu vÓ¢x öPõÒÁuØS

Ctrl + A = BÁnö©õßÔ¾ÒÍ AøÚzøu²® öu›Ä 

ö\´ÁuØS

Ctrl + C = GÊzx / BÁn[PøÍ¨ ¤µv ö\´ÁuØS

Ctrl +X = GÊzx / BÁn[PøÍ öÁmiö¯k¨£uØS

Ctrl + V = GÊzx / BÁn[PøÍ JmkÁuØS

Ctrl + H = ö\õØPøÍ ¤µv±k ö\´ÁuØS

Ctrl + Home = {ø»UPõmiø¯ BÁnzvß Bµ®£zvØS 

Gkzx ö\ÀÁuØS

Ctrl + End = {ø»Põmiø¯ BÁnzvß CÖvUS Gkzx 

ö\ÀÁuØS
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ö£õÈ¨¦

6.1  ö\õÀ •øÓÁÈ¨£kzuÀ Gß£x BÁn[PøÍz u¯õ›zuÀ BS® :
 

CuØöPÚ ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸øÍ¨ £¯ß£kzv 

BÁnzøu AÇS£kzv PÁºa]¯õUQU öPõÒÁuØS® AÁØøÓ                   

÷\ª¨£uØS® ÷uøÁ¨£iß AÁØøÓ «Í¨ö£ØÖU öPõÒÁuØS® 

Aa_¨¤µv GkUPÄ® •i²®.

£»ÁøP¯õÚ ö\õÀ•øÓ ÁÈ¨£kzuÀ ö©ßö£õ¸ÒPÒ Põn¨ 

£kQßÓÚ. CÁØÔÀ ]» £n® öPõkzx ö£ØÖUöPõÒÍ 

•i²©õ°Ý® Cøn¯z uÍzvÀ C»Á\©õP £vÂÓUP®  (Download) 
ö\´x PoÛ°À {ÖÂU öPõÒÍ»õ®.

6.2  ¦v¯ BÁn® JßøÓ u¯õ›¨£uØPõÚ •UQ¯ Âh¯[PÒ :
*  ¦v¯ BÁnzøu¨ ö£ØÖUöPõÒÍÀ

*  ÷\ªUS® •øÓ ©ØÖ® BÁnzøu ‰kuÀ

*  ÷\ªUS® BÁnzøu «ÍzvÓzuÀ

6.3  BÁn® JßøÓ u¯õ›US®÷£õx PÁÚzvÀ öPõÒÍ ÷Ási¯øÁ :
*  £UPÁiÁø©¨¦

*  öu›Ä ö\´²® •øÓPÒ

*  ÁiÁø©zuÀ : GÊzx, ÁiÁø©¨¦, £¢v ÁiÁø©¨¦, 

C»UP® ©ØÖ® SskSÔ°kuÀ, {Ç¼hÀ.

6.4       BÁnö©õßÔøÚ ÁiÁø©zuÀ :
         *  ÁiÁ[PÒ, £i©[PøÍ ÷\ºzu¾® ©õØÓ[PÒ ö\´u¾®

         *  SÔ±kPøÍ £¯ß£kzuÀ

         *     ÷©ØSÔ¨¦ ©ØÖ® RÌUSÔ¨¦, £UP Gs ÷£õßÓÁØøÓ 

       ÷\ºzuÀ 

         *     {µÀPøÍ  E¸ÁõUSuÀ

         *     AmhÁønPøÍ ¦Szu¾®  ©õØÓ[PÒ ö\´u¾®

6.5  \µøÁ£õºzu¾® Aa_¨¤µv  Gkzu¾® :
*     Á\Ú¨ ¤øÇPÒ ©ØÖ® C»UPn¨ ¤øÇPøÍ PshÔu¾®  

       v¸zu®  ö\´u¾®

*     {PskPøÍ¨ £¯ß£kzuÀ

*     ö\õØPøÍ ÷ukuÀ ©ØÖ® ©õØÖ ö\õØPøÍ ¤µv±k ö\´uÀ

*     BÁn[PøÍ Aaö\kzuÀ

6.6  Ag\À Cøn¨£õUP® ö\´uÀ :
*     uµÄ ‰»zøu u¯õº ö\´uÀ

*     Ag\À Cøn¨¤ØS ¦»[PøÍ ÷\ºzuÀ

*     Aaö\kzuÀ.
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C»zvµÛ¯À Â›uõÒPÒ

   

 C¨ £õhzøuU PØÓ¤ßÚº }[PÒ,

  •	 Â›uõÎß Ai¨£øh Á\vPÒ ©ØÖ® ö\¯Ø£õkPÒ

• £ozuõÎß TÖPÒ 

• £ozuõÎÀ uµÄPøÍ Em¦Szu¾® JÊ[Pø©zu¾®

•	 C»S Pozu¾US›¯ ö\´øPPÒ  ö£Ö©õÚ[PøÍ¨ £¯ß£kzva 

`zvµ[PøÍ E¸ÁõUSuÀ

• `zvµ[PøÍ GÊxÁuØS P»•PÁ›PøÍ²®,  \õº¦PøÍ²®     

£¯ß£kzuÀ

• £ozuõÒPøÍ JÊ[S£kzuÀ

• \õº£õÚ ©ØÖ® \õº£ØÓ P»•PÁ›PøÍ¨ £¯ß£kzuÀ

• Áøµ¦PøÍ u¯õ›zuÀ 

  Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

 7.1  C»zvµÛ¯À Â›uõÒPÒ 

 ©UPÍx  AßÓõh  P¸©[PÐUS  ©mk©ßÔ  öuõÈÀŸv¯õÚ ÷uøÁ

PÐUS® £À÷ÁÖ PozuÀPøÍa ö\´Áx AÁ]¯©õS®. C¢uU 

PozuÀPøÍa ö\´ÁuØS ©UPÒ £À÷ÁÖ E£õ¯[PøÍ¨ £¯ß£kzxQßÓÚº. 

Pozu¾UPõÚ ¤µa]Ú[PÎß ußø©PøÍ¨ ö£õÖzx £À÷ÁÖ •øÓPÒ 

øP¯õÍ¨£kQßÓÚ. PozuÀPÐUöPÚ ©Úøu²® ÂµÀPøÍ²® E£÷¯õ 

QUQßÓÚº. ]UP»õÚ PozuÀPøÍz wº¨£uØS  GÊvwºzuÀ AÀ»x 

PozuØ ö£õÔPÒ £¯ß£kzu¨£kQßÓÚ. GÛÝ®, C¢uU PozuÀ £oPøÍ 

ö\®ø©¯õPÄ® C»SÁõPÄ® ö\´ÁuØöPÚ C»zvµÛ¯À Â›uõÒPøÍ 

GÆÁõÖ £¯ß£kzu»õö©ß£x £ØÔ AÔ¢xöPõÒ÷Áõ®. 

E¸   7.1

7
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 •øÓ¯õPÄ®, GÊzx ‰»•® PozuÀPøÍa ö\´ÁuØPõP Pouz 

uõÒPøÍ £¯ß£kzxÁx G©x ÁÇø©¯õS®. CzuõÒPÒ {ø»USzx 

{µÀPøÍ²® Qøh¯õÚ {øµPøÍ²® öPõskÒÍÚ.    Cuß  Ai¨£øh°÷»÷¯ 

ö£Ö©ÍÄ {µÀPøÍ²®  {øµPøÍ²® öPõsh C»zvµÛ¯À  Â›zuõÒPÒ 

Aø©UP¨£mkÒÍÚ.

 

 C»zvµÛ¯À Â›uõÒPøÍ¨ (Electronic Spreadsheets) £¯ß£kzxÁuß 

‰»® ¤ßÁ¸® £oPøÍ ªP C»SÁõPÄ® ÷|ºzv¯õPÄ®  ö\®ø©¯õPÄ® 

ö\´¯•i²®.

² C»SÁõÚx® PiÚ©õÚx©õÚ PozuÀPøÍa ö\´uÀ

² Áøµ¦PÒ ‰»® uµÄPøÍ ÂÍUSuÀ

² uµÄPøÍ HÖÁ›ø\ ©ØÖ® CÓ[SÁ›ø\°À JÊ[S¨£kzvU Põm 

kuÀ

² ÷uøÁ¯õÚ uµÄPøÍ ©õzvµ® ÷ÁÖ£kzuÀ

² uµÄPÎß |®£Pz ußø©°øÚ £›^¼zuÀ

² PhÄaö\õÀø»¨ (Password) £¯ß£kzv uµÄPøÍ¨ £õxPõzuÀ

² GvºPõ» £õÁøÚUPõP ÷\ªzx øÁzuÀ.

7.1.1  C»zvµÛ¯À Â›uõÒ  ¤µ÷¯õP ö©ßö£õ¸ÒPÒ

 £À÷ÁÖ ö©ßö£õ¸Ò EØ£zv {ÖÁÚ[PÒ ‰»® E¸ÁõUP¨£mkÒÍ 

C»zvµÛ¯À Â›uõÒ ¤µ÷¯õP ö©ßö£õ¸ÒPÒ  £» AmhÁøn 7.1 CÀ 

Põmh¨£mkÒÍÚ.

             ö©ßö£õ¸ÒPÒ                EØ£zv {ÖÁÚ[PÒ

                    Excel           Microsoft Corporation
                    Numbers           Apple Inc
                    LibreOffice Calc           The Document Foundation 

Open office Calc           Apache Foundation
            AmhÁøn 7.1 £À÷ÁÖ  Â›uõÒ ¤µ÷¯õP ö©ßö£õ¸Ò ÁøPPÐ® AÁØÔß   

 EØ£zv  {ÖÁÚ[PÐ®.  

   

7.1.2  Â›uõÒ ö©ßö£õ¸ÒPøÍ¨ £¯ß£kzuÀ

  Â›uõÒ ö©ßö£õ¸ÒPÎÀ  Microsoft  Office  2010  ©ØÖ®  LibreOffice Calc 
BQ¯ ö©ßö£õ¸PÒ £ØÔ ©õzvµ÷© C¨£Sv°À P»¢xøµ¯õh¨£kQßÓx. 

C®  ö©ßö£õ¸ÒPøÍz  öuõÈØ£h  ö\´²® •øÓPÒ, £oö\¯À •øÓ 

ø©PÒ ©ØÖ® Auß £v¨¦PÒ Gß£ÁØÖU÷PØ£  ÷ÁÖ£h»õ®. 

 Microsoft Office EØ£zvPÒ  AÝ©v¨£zvµzxhß öPõÒÁÚÄ   ö\´¯¨£h 

÷Ásk®. LibreOffice EØ£zvPøÍ C»Á\©õP¨  £¯ß£kzu •i²®.
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Microsoft Office Excel 2010 CÀ

Start → Programs→ Microsoft 
Office→ Microsoft Office Excel 2010

LibreOffice Calc CÀ

Start → Programs →  LibreOffice  → 
LibreOffice Clac

    7.1.3 Microsoft Excel 2010 Cß Cøh•P•® Auß TÖPÐ®

10' kdu fldgqj

    Name Box

6' ö\¸SuÀ

      (Insert) 

 7' uzuÀ     

    (Tab)
8' `zvµ¨ £møh    

  (Formula Bar) 9' {µÀPÎß 

uø»¨¦ 

(Column Headings)

1' x›u  ¤µ÷Á\ P¸Â¨ £møh       

 (Quick Accese Tool Bar)   2'uø»¨¦¨ £møh

   (Title Bar)

   3' |õhõ

   (Ribbon)

4'EuÂ

  (Help)

 5.Pmk¨£õmk¨ 

   ö£õzuõßPÒ   
    (Control Buttons) 

12' C¯US P»® 

     (Active Cell) 

13' Á›ø\z uø»¨¦

     (Row Heading) 

14' £ozuõÒ      

      {ÖzuÀ

  {ø»    
(Sheet Tab)

11' }Ò_¸Ò £møh

     (Verticle Scroll Bar)

15' Qøh_¸Ò £møh

     (Horizontal Scoll Bar)

19' E¸ Pmk¨£õmk 

           P¸Â 

    (Zoom Control)

E¸   7.2  Microsoft Excel 2010  Cß Cøh•P®

18' Põm]£kzuÀ

     ö£õzuõß 
     (View Buttons)

17'{ø»ø©¨

   £møh

    (Status Bar)

16' £ozuõÒ

      ÁÈ   

    PshÔuÀ

    ö£õzuõß

    (Sheet Tab 
     Scroll Button)

10' ö£¯º ö£mi-

Name   box 

{
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           EÒÍhUP®                   ÂÁµ®

1'   x›u  ¤µ÷Á\ P¸Â¨ £møh Save,  Print  Preview,   Undo,   New  ÷£õßÓ 

AiUPi   £¯ß£kzu¨£k®   P¸ÂPøÍ¨ 

ö£ØÖUöPõÒÍ EuÄ®

2'   uø»¨¦¨ £møh ¤µ÷¯õP ö©ßö£õ¸Ò ö£¯øµU Põm]¨£kzx®

3'   |õhõ Home, Insert, Page layout  ÷£õßÓ uzuÀ 

PøÍ²® P¸ÂPøÍ²® öPõsi¸US®.

4'   EuÂ EuÂPøÍ¨ ö£ØÖUöPõÒÍ £¯ß£k®

5'   Pmk¨£õmk ö£õzuõßPÒ £ozuõÒ \õÍµzøu Â›Ä¨£kzuÀ _¸USuÀ 

©ØÖ® ‰kuÀ

6'   ö\¸SuÀ `zvµ[PøÍ  E¸ÁõUSÁuØS AÁ]¯©õÚ 

ö\õÀ»õhÀ ö£miø¯  ö£ØÖUöPõkzuÀ

7'   uzuÀ |õhõøÁ ©õØÓ EuÄ®

 8.   `zvµ¨ £møh `zvµ[PøÍ öÁÎ¨£kzxÁuØS® 

P»[PÎß EÒÍhUPzøu öÁÎ¨£kzuÄ® 

EuÄ®

9.    {µÀPÎß uø»¨¦ {µÀPÎß uø»¨¦UPøÍ öÁÎ¨£kzx®

10. ö£¯ºU Tk ö\¯Ø£õmkU P»zvß •PÁ›°øÚ 

öÁÎ¨£kzx®

11. }Ò_¸m £møh £ozuõøÍU Qøh¯õPU |Pºzu EuÄ®

12. C¯US P»® uµÄ  Em£kzu¨£mh  P»zøuU  Põmk®

13. Á›ø\z uø»¨¦ Á›ø\ C»UPzøuU Põmk®

14. £ozuõÒ {ÖzuÀ {ø» £ozuõøÍ¨ ¤µv{vzxÁ¨£kzx®

15. Qøha _¸m £møh £ozuõøÍ ö\[SzuõPU ÷©¾® RÊ® |Pºzu 

EuÄ®

16. £ozuõÒ ÁÈPshÔuÀ

      ö£õzuõß

£ozuõÒPøÍ ©õØÖÁuØS EuÄ®

17. {ø»ø©¨ £møh £ozuõÐhß Cøn¢u {ø»ø©PøÍU 

Põm]¨£kzx®

18. Põm]¨£kzuÀ  ö£õzuõß £ozuõøÍ   Põm]¨£kzuU  Ti¯   ÷ÁÖ¨ 

£mh •øÓPøÍ öÁÎ¨£kzx®

19.  E¸ Pmk¨£õmkU P¸Â £ozuõÒPøÍ Â›ÁõUSÁuØS AÀ»x 

_¸UQ¨ £õºUP EuÄ®

AmhÁøn   7.2  Microsoft Excel  Cß TÖPÒ
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3' {¯©U P¸Â¨£møh 
    (Standard Tool Bar)

2'£mi¯À £møh                                                                                                                                             
  (Menu Bar)

1'uø»¨¦¨ £møh

   (Title Bar)

5' ö£¯º ö£mi    

   (Name Box)

9' C¯[S P»® 

   (Active Cell) 

6'ö\¸SuÀ (Insert) 

7' `zvµ¨ £møh   

  (Formula Bar) 11' }Ò_¸Ò £møh

    (Vertical Scroll Bar)

13' Qøha_¸Ò£møh

   (Horizontal Scroll Bar)

16' {ø»ø©¨ £møh  
     (Status Bar)

15'  £ozuõÒ ÁÈ  

     PshÔuÀ ö£õzuõß

      (sheet Scroll Button)

E¸ 7.3  LibreOffice Calc   Cß  Cøh•P®

12' Á›ø\z uø»¨¦ 

     (Row Heading) 

17'Pmk¨£õmkU    

   P¸Â (Zoom Control)

4' Pmk¨£õmk ö£õzuõßPÒ 
   (Control Buttons)

8. ÁiÁø©¨¦U P¸Â¨£møh

         (Formating Tool Bar)

14' £ozuõÒ uzuÀPÒ       
     (Sheet Tab)

10'Á›ø\zuø»¨¦ 

  (Column Heading)

           EÒÍhUP®                   Â£µ®

1'  uø»¨¦¨ £møh ö©ßö£õ¸Îß  ö£¯øµU Põm]¨£kzx®

2'  £mi¯À £møh ¤µuõÚ PmhøÍPøÍz öu›Äa ö\´¯ EuÄ®

3'  {¯©U P¸Â¨ £møh {¯©U P¸ÂPøÍ öu›Äa ö\´¯ £¯ß£hU 

Ti¯x

4'  Pmk¨£õmk ö£õzuõß £ozuõÒ \õÍµzøu Â›Ä¨£kzuÀ _¸USuÀ 

©ØÖ® ‰kuÀ

5'  ö£¯º¨ ö£mi ö\¯Ø£õmkU P»zvß •PÁ›ø¯ öÁÎ¨£kzx®

6'  ö\¸SuÀ `zvµ[PøÍ E¸ÁõUSÁuØS AÁ]¯©õÚ 

SÔ±mk •P¨¤øÚ Põm]¨£kzx®.

7'  `zvµ¨ £møh `zvµ[PøÍ öÁÎ¨£kzxÁuØS® P»[PÎß 

EÒÍhUPzøu öÁÎ¨£kzuÄ® EuÄ®. 

8'  ÁiÁø©¨¦U P¸Â¨ £møh £ozuõÎøÚ ÁiÁø©UP EuÄ®

9'  C¯USU P»® uµÄ Em¦Szv¯ P»zøuU Põmk®

7.1.4  LibreOffice Calc 4.1 Cß Cøh•P•® Auß TÖPÐ®
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10' {µÀPÎß uø»¨¦ {µÀPÎß uø»¨¦UPøÍ Põmk®

11' }Ò_¸Ò £møh £ozuõøÍ Qøh¯õP |Pºzu EuÄ® 

12' Á›ø\z uø»¨¦ Á›ø\ C»UPzøu Põmk®

13' Qøha _¸Ò £møh £ozuõøÍa ö\[SzuõP |Pºzu EuÄ®

14' £ozuõÒ uzuÀ £ozuõøÍ¨ ¤µv{v¨£kzx®

15' £ozuõÒ ÁÈPshÔuÀ 

    ö£õzuõß

£ozuõÒPøÍ ©õØÖÁuØS EuÄ®.

16' {ø»ø©¨ £møh £ozuõÐhß Cøn¢u {ø»ø©PøÍU 

Põm]¨£kzx®

17' E¸ Pmk¨£õmkU P¸Â £ozuõÒPøÍ Â›ÁõUSÁuØS AÀ»x _¸UQ¨ 

£õºUP EuÄ®

                    AmhÁøn   7'3  LibreOffice calc Cß TÖPÒ

7.1.5  £ozuõÒ  (Worksheet)

 C¸ £›©õnz uÍzvÀ {µÀPÒ (Columns) ©ØÖ® {øµPÒ ^Rows& GßÓ 

ÁõÖ Aø©¯¨ö£ØÓ P»[PÎß öuõS¨¦UPøÍU öPõsk £ozuõÒPÒ 

{¸©õoUP¨£mkÒÍÚ. CøÁ £ozuõÒ uzuÀPÒ (Sheet Tab) ‰»® 

öÁÎUPõmh¨£kQßÓÚ.
 

7.1.6  £ozuõÒPÎß  {µÀPøÍ¨  ö£¯›hÀ

£ozuõÎÀ EÒÍ {µÀPÒ ¤ßÁ¸©õÖ B[Q»¨ ÷£öµÊzxUPÒ ‰»®  

AÀ»x GÊzxzöuõSvPÒ ‰»® ö£¯›h¨£kQßÓÚ.  E¸ 7.4  I¨ £õºUPÄ®.

A, B, C, D,...... Z Áøµ²®

AA, AB, AC, AD, AE, ... AZ Áøµ²®

BA, BB, BC, BD, BF, ... BZ Áøµ²® GßÓÁõÖ ö£¯›h¨£k®.

7.1.7   £ozuõÒPÎß  {øµPøÍ¨  ö£¯›hÀ

1, 2, 3, 4, 5, ... GßÓ Âu©õP÷Á £ozuõÎß {øµPÒ ö£¯›h¨£mi¸US®       

E¸ 7.4 I¨ £õºUP.

{øµPÒ

(Rows)
  {µÀPÒ

(Columns)

E¸ 7.4 £ozuõÎß {µÀPÒ, {øµPÎß Aø©¨¦
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ö£õxÁõP £ozuõÒ JßÔß {øµPÎß GsoUøP²® {µÀPÎß GsoU 

øP²® 2 Cß AkUS¨ ö£Ö©õÚ[PÎ÷»÷¯ Põn¨£kQßÓÚ.

Â›uõÒ ö©ßö£õ¸Ò  {øµPÎß  {µÀPÎß

     GsoUøP  GsoUøP  

Microsoft Excel 2003   65536 ^216&  256 ^28&

Microsoft Excel 2007$2010  1048576 ^220&  16384 ^214&

LibreOffice Calc  4.1   1048576 ^220&  1024 ^210&

7.1.8   C¯[S  P»® (Active Cell) 
 

 £ozuõÎÀ uµÄPøÍ EÒÎh •ßÚº E›¯ P»zvøÚz öu›uÀ 

÷Ásk®. AÆÁõÖ ÷uº¢öukUP¨£mh P»zvøÚ C¯[S P»® (Active Cell) 
GÚ AøÇUP¨£k®. R÷Ç Põmh¨£mkÒÍ E¸ 7.5 CÀ B3 C¯[S P»©õP 

CÚ[Põmh¨£mkÒÍx. C¯[S  P»©õÚx Ga\¢uº¨£zv¾® ui¨¤ß ‰»® 

GÀø»PøÍU Põmi {ØS®.

E¸  7.5  £ozuõÎÀ Põmh¨£mkÒÍ C¯[S P»®

 7.2  £ozuõÎÀ ö\¯Ø£hÀ

 £ozuõöÍõßÔÀ uµÄPøÍ Em£kzu •ßÚº AuØS›¯ P»zøu 

C¯[Pa ö\´uÀ ÷Ásk®.

 R÷Ç Põmh¨£mkÒÍ \õÂ/\õÂz öuõSvPøÍ C¯USÁuß ‰»® 

£ozuõÎÀ EÒÍ G¢uöÁõ¸ P»zvøÚ²® C¯[Pa ö\´¯ •i²®.
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      \õÂ/\õÂz öuõSv                  ö£Ö÷£Ö

Arrow keys G¢uöÁõ¸ vø\US® (Ch®, Á»®, 

÷©À, RÌ) 
Ctrl  + Arrow Keys SÔzuöÁõ¸  vø\°À uµÄ Ãa]ß 

•iÄUS |P¸®

Home C¯[S  P»®  C¸US®  {øµ°ß 

FhõP {µÀ  A I ÷|õUQ |P¸®

Ctrl + Home A1 P»zvøÚ ÷|õUQ  |P¸®

Ctrl + End uµÄ Ãa]ß Á»¨£UP CÖvU P»zøu 

÷|õUQ  |P¸®

Page Up £ozuõÎÀ, J¸ vøµ (Screen) 
÷©»õP |P¸®

Page Down £ozuõÎÀ, J¸ vøµ RÇõP |P¸®

 7.2.1  P» •PÁ›  (Cell Address)

 P»¨ö£¯µõÚx •u»õÁuõP {µ¼ß GÊzøu²® öuõhº¢x {øµ°ß 

C»UPzøu²® öPõsk BUP¨£k®. Cx  P»•PÁ› GÚ¨£k®. GkzxU 

PõmhõP E¸ 7.6 CÀ C¯[S P»zvß •PÁ›¨ ö£¯º ö£mi°À  D {µ¾® 

‰ßÓõÁx Á›ø¯²® Cønzx P»® D 3 GÚ ö£¯›h¨£mkÒÍx.  

ö£¯º ö£mi 

Name Box C¯[S P»®

Active Cell 

E¸ 7.6  £ozuõÎß P»•PÁ›

 ö\¯Ø£õk 

 KD74 GÝ® P»•PÁ› Aø©¢xÒÍ {µÀ .......... BÁ÷uõk 

{øµ ............ BS®.
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 7.2.2  P»Ãa_  (Cell Range)

 £ozuõÒ JßÔß £» P»[PøÍ CønzxU PõmkÁx P»Ãa_ 

GÚ¨£k®. R÷Ç Põmh¨£mkÒÍ £ozuõøÍ AÁuõÛUPÄ®.

E¸ 7.7  £ozuõÎÀ {µÀ FhõÚ 

Põmh¨£k® P»Ãa_

     

 CU P»Ãa]À B2, B3, B4, B5  
BQ¯ |õßS P»[PÒ EÒÍhUP¨£m-

kÒÍÚ. P»Ãa_  B2 CÀ Bµ®¤zx B5 

CÀ •iÁøh¢xÒÍx. CU P» Ãa_ 

B2:B5 GÚ Põmh¨£h ÷Ásk®. J¸ 

{µ¼À Põmh¨£k® P»Ãa]À {µ¼ß 

ö£¯º {ø»¯õÚuõPU Põn¨£k® E¸ 

7.7 I¨ £õºU PÄ®

 CUP»Ãa_ A3, B3, C3 GßÓ 

‰ßÖ P»[PøÍ EÒÍhUQ¯uõP 

Põn¨£kQßÓx.  CUP»Ãa_  A3 : C3
GÚ Põmh¨£h ÷Ásk®. Á›ø\ 

°ÞhõP  Põmh¨£k® P»Ãa]À,     

Á›ø\°ß C»UP® {ø»¯õÚuõS®. 

E¸ 7.8 I¨ £õºUPÄ®.

 C¨£ozuõÎÀ Ãa\õÚx B2, 
B3, B4, C2, C3, C4 GßÓ BÖ P»[PøÍ 

EÒÍhUQ²ÒÍx. CU P»Ãa_ B2:C4 

GÚ CÚ[Põmh¨£h ÷Ásk®. Â›ÁõU 

P¨£mh £» {øµPÒ ©ØÖ® {µÀPøÍ 

öPõsk Aø©¢xÒÍ P»Ãa]ß {µÀ 

C»UP•® {øµ GÊzx® ÷ÁÖ£k®. E¸ 

7.9 I¨ £õºUPÄ®.

E¸ 7.8  £ozuõÎÀ {øµö¯õßÔß FhõÚ 

P»Ãa_

 E¸ 7'9 £ozuõÎÀ Â›ÁõUP¨£mh

£» {µÀPÒ ©ØÖ® {øµPÒ Aø©¢x-

ÒÍ  P»Ãa_  
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SÔ¨¦ ( £ozuõöÍõßÔÀ JßÖUS ÷©Ø£mh P»Ãa_UPøÍz öu›Ä 

ö\´ÁuØS  Pmk¨£õmka \õÂ  (Control  key) £¯ß£kzu¨ 

£kQßÓx. Pmk¨£õmka \õÂ Âø\¨£»øP°À (Ctrl)GÚ 

CÚ[Põmh¨£mi¸US®.

  ö\¯Ø£õk

E¸ 7.10 Cß ‰»® Põmh¨£mkÒÍ £ozuõÎøÚ AÁuõÛzx 

R÷Ç uµ¨£mkÒÍ ÂÚõUPÐUS Âøh¯ÎUP.

^1&  R 1 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ •u»õÁx P»zvß •PÁ› ¯õx?

^2& R 1 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ CÖv P»zvß •PÁ› ¯õx?

^3& R 1 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ P»Ãaø\  GÊxP.

^4& R 2 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ  P»Ãaø\  GÊxP.

^5& Á› JßÔÞhõP  EÒÍ P»Ãa]ß ö£¯º GßÚ? 

^6& {µÀ JßÔÞhõP EÒÍ P»Ãa]ß ö£¯º GßÚ? 

^7& R 3 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ Ãaø\U SÔzxU PõmkP.

^8& R 3 CÚõÀ Aøh¯õÍ¨£kzu¨£mkÒÍ Ãa]¾ÒÍ     P»[PÎß  Gs  

    oUøP  ¯õx?

R1
R2R3

E¸ 7.10 £ouõÎÀ EÒÍ P» Ãa_PÒ
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  E¸ 7'11 - £ozuõÎß •P¨¦ Aøh¯õÍ® Ch¨£UP©õP Aø©uÀ

7.2.3  uµÄPøÍ EÒÎhÀ

 Â›uõÎÀ uµÄPøÍ £v¯ •ßÚº E›¯ P»zvøÚ C¯[Paö\´uÀ 

AÁ]¯©õS®. Auß¤ßÚ÷µ uµÄPøÍ EÒÎh ÷Ásk®. J¸ P»zvÝÒ 

•P¨¦ Aøh¯õÍ® (Label), ö£Ö©õÚ® (Value) AÀ»x `zvµ® (Formula) 
÷£õßÓÁØÔÀ HuõÁx JßÖ EÒÎh¨£k®.  

1. •P¨¦ Aøh¯õÍ® (Label)
 umha_ ö\´¯¨£mh GÊzxUPÒ (Letters), GsPÒ (Numbers),  Â÷\h 

SÔ±kPÒ (Special Symbols) ‰»® AÀ»x AÁØÔß ÷\º©õÚ® ‰»® ö£ØÖU 

öPõÒÍ¨£mh ö\õØöÓõhº (Text) ÷£õßÓÚ •P¨¦ Aøh¯õÍ® GÚ¨£k®. 

ö£õxÁõP P»zvÀ Ch¨£UPzvÀ ÷|º£kzu¨£mhuõP  (Left Align) Cx  

Põn¨£k®. E¸ 7.11 Cß  ‰»® Â›uõÒ JßÔÀ Põn¨£k® •P¨¦ 

Aøh¯õÍzvß ©õv›ø¯ AÁuõÛUP •i²®. 

SÔ¨¦ : öuõø»÷£] C»UP[PÒ R÷Ç Põmh¨£mkÒÍÁõÖ  Põm]¨ 

£kzu¨£h©õmhõx.  (öuõø»÷£]  C»UPzvß •u»õÁx  C»U

 P©õÚ §a]¯® Põm]¨£kzu¨£h©õmhõx). öuõø»÷£] C»UPz 

vøÚ Em¦Szuz ÷uøÁ¨£k® P» Ãa]øÚ £õh©õP (Text) ©õØÔ 

Aø©UP  ÷Ásk®. P»[PøÍ ÁiÁø©zuÀ  öuõhº£õP ¤ßÚº 

P»¢xøµ¯õh¨£k®.

2. ö£Ö©õÚ[PÒ

 C»UP ÁiÂÀ Põn¨£k® uµÄ ö£Ö©õÚ[PÒ GÚ¨£k®. ö£õxÁõP 

ö£Ö©õÚ[PÒ P»zvß Á»x £UPzvÀ ÷|º¨£kzu¨£mi¸US®. (Right Align) 
E¸ 7.12  CÀ CuØPõÚ EuõµnzøuU Põn»õ®. 

ö£¯º

£Âzµß

©xñß

ªßÚg\À •PÁ›öuõø»÷£] Gs©õPõn®©õÁmh®

AìªÚõ

h¯Úõ

öPõÊ®¦

Psi

÷PPõø»

©õzuøÓ öuß

÷©À

©zv¯

\¨µP•Á madhukshan@gmail.com

asmina@hotmail.com

daina@live.com

pavithran@yahoo.com
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SÔ¨¦ ( ¤ßÚ ÁiÂ»ø©¢u ö£Ö©õÚ® JßøÓ EÒÏk ö\´²®÷£õx 

{øÓöÁsøn •u¼À  umha_¨ ö\´x J¸ CøhöÁÎ Âmk 

(Single Space) ¤ßÚº «v¨ £Sv°øÚ umha_  ö\´¯÷Ásk®.

3. `zvµ[PÒ  (Formula)
 Po¨¥kPøÍa ö\´ÁuØPõP \©ß (=) Aøh¯õÍzøu •u¼À 

Cmk ö£Ö©õÚ[PÒ, P»•PÁ› ©ØÖ® u\©uõÚ® Gß£ÁØøÓ Em 

¦Szv GÊu¨£k® SÔ±k `zvµ® GÚ¨£k®. £ouõÎß P»zvÝÒ 

`zvµö©õßÔøÚ  Em¦Szx®÷£õx  AuÞhõPU PnUQh¨£k® ö£Ö©õÚ® 

P»zvÀ  öuß£kÁ÷uõk  `zvµ® A¢ua `zvµ¨£møh°À öuß£k®. 

Euõµn® 1
A1  ©ØÖ®  B1 P»[PÎÀ EÒÍ ö£Ö©õÚ[PÎß  ö©õzu® C1 P»zvÀ ö£ØÖU 

öPõÒÍÀ (E¸ 7.13 I¨ £õºUP.) 

`zvµzvß ‰»® ö£Ó¨£mh ö£Ö©õÚ®.

`zvµ¨ £møh

C1 P»zvØS Em¦Szu¨£mh `zvµ®

E¸  7.13  `zvµ® £¯ß£kzu¨£k® Âu®.

{øÓöÁs

u\©uõÚ®

£n®

  E¸ 7.12  £ozuõÎÀ ö£Ö©õÚ[PÒ Á»¨£UP©õP Aø©uÀ

÷|µ®

vPv

AÔÂ¯À ö£Ö©õÚ®

£SÂ¯À ö£Ö©õÚ®

Ãu®
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    7.3  `zvµ[PøÍ GÊu¨ £¯ß£kzu¨£k® PouU  SÔ±kPÒ

SÔ±kPÒ    Poua ö\´øPPÒ

+ TmhÀ

− PÈzuÀ

                               * ö£¸USuÀ

/ ÁSzuÀ

^ Á¾

      

SÔ¨¦ :
SÔ±kPÒ ö\¯Ø£h ÷Ási¯  JÊ[QøÚ Aøh¨¦PÒ Aø©zx 

÷ÁÖ£kzu •i²®. (Aøh¨¦USÒ EÒÍ £Sv •u»õÁuõPU 

PoUP¨£k®).

Poua ö\´øPU SÔ±kPÒ ö\¯Ø£k® •ßÝ›ø© JÊ[S  (Operator 
Precedence) 

 •u»õÁx ^ &

 CµshõÁx ^
 ‰ßÓõÁx * , /
 |õßPõÁx + , − 

   7.3.1  ö£Ö©õÚ[PøÍ²® ö\´øPU SÔ±kPøÍ²® £¯ß£kzva   

  ö\¯Ø£kzu¨£k® GÎ¯ PozuÀ •øÓø©PÒ 

 GsPøÍ²® ö\´øPU SÔ±kPøÍ²® £¯ß£kzv GÊu¨£mh C»S 

ÁõÚ `zvµ[PÒ ]» E¸ 7.4 ‰»® Põmh¨£mkÒÍÚ.

   

      ö\´øP            `zvµ®         ö£Ö÷£Ö

TmhÀ  ^ + &            = 2+4              6

PÈzuÀ   ^ − &            = 5−2              3

ö£¸USuÀ ^ * &            = 4*5             20

ÁSzuÀ ^ / &            = 12$6              2

Á¾U PõnÀ  ^^& 
 

           = 2^4             16

                         AmhÁøn  7.4  `zvµ[PøÍ GÊxuÀ

>

÷©¼¸¢x RÇõP •ßÝ›ø© SøÓÁøh²®
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 `zvµö©õßÔÀ JßÖUS ÷©Ø£mh PozuÀ SÔ±kPÒ Põn¨£h»õ® 

AUSÔ±kPÒ JÊ[S •øÓ°À ö\¯Ø£k® ÂuzvøÚ AmhÁøn 7.5 ©ØÖ® 

AmhÁøn 7.6 ‰»® AÁuõÛUP •i²®. 

           ö\´øP `zvµ®        ö£Ö÷£Ö

     = 2+4*3       = 2+12            = 14
     = ^2+4&*3       = 6*3            = 18
     = 4*3^2       = 4*9            = 36
     = (4*3)^2       = 12^2            = 144

   

Euõµn® = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5
wºUP¨£k® 

•øÓ
= 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5

= 5¬2*9$6-3 = 5¬2*3^2$3 = 8/2*3-8¬5
= 5¬18$6-3 = 5¬2*9$3 = 4*3-8¬5
= 5¬3 - 3 = 5¬18$3 = 12-8¬5
= 8-3 = 5¬6 = 4¬5

Âøh = 5 = 11 = 9

 7.3.2  P»•PÁ›ø¯²® SÔ±kPøÍ²® £¯ß£kzv `zvµ[PøÍ E¸ÁõUSuÀ
 

 P»•PÁ›ø¯²® SÔ±kPøÍ²® £¯ß£kzv ̀ zvµ[PøÍ GÊxÁuõÀ 

HØ£k®  ¤µuõÚ AÝT»® `zvµzvØS›¯ P»[PÎÀ ©õØÓ[PÒ {PÊ® 

ö£õÊx Po¨¤h¨£mh ö£Ö©õÚ[PÒ C¯À£õP÷Á  ©õØÓ©øhÁuõS®.

SÔ¨¦ : Aøh¨¦USÔ £¯ß£kzu£hÂÀø»ö¯Ûß \©©õÚ ©mhzv¾ÒÍ 

ö£¸UPÀ ^ * &, ÁSzuÀ  ^ $ & BQ¯ ö\´øPPÐ® TmhÀ ^ + &, 

PÈzuÀ ^ − & BQ¯ ö\´øPPÐ® `zvµzvß Chx £UPzv¼¸¢x 

Á»x £UP©õP C¸US® JÊ[QÀ wºUP¨£k®.

  ö\¯Ø£õk

¤ßÁ¸® \©ß£õkPøÍ wºUP.

 ^1& = 6-4$2  ^6& = 4¬5*2^3  ^11& = 5$2¬1^3*4
 ^2& = 5*4¬3  ^7& = 8$4*2  ^12& = 3-4*3$2
 ^3& = 3¬4*5  ^8& = -4$2¬2  ^13& = 6$3*2^1-3
 ^4& = 2^5¬3  ^9& = 1¬2^2*3  ^14& = 3*^2¬4&$9¬1
 ^5& = 3¬5^2        ^10& = 3*4$2  ^15& = 2^3$^5-1^3&*5

AmhÁøn  7.5 GÎ¯ \©ß£õkPÎÀ Aøh¨¦USÔPøÍ £¯ß£kzuÀ

AmhÁøn 7.6  \©ß£õkPÒ ©v¨¤h¨£k® •øÓPÒ
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Euõµn® 1

 ö\ÆÁPö©õßÔß _ØÓÍÄ ©ØÖ® £µ¨£ÍÄ Gß£ÁØøÓU Po¨£uØS 

Auß }Í®, AP»® Gß£ÁØøÓ •øÓ÷¯  A2 ©ØÖ® B2 P»[PÎÀ Em¦Szx 

÷Áõ®. _ØÓÍøÁU  Põs£uØPõÚ ̀ zvµ[PøÍ  C2, C3, C4  BQ¯ P»[PÎ¾® 

£µ¨£ÍøÁU Põs£uØPõÚ `zvµ®  D2 P»zv¾® GÊu¨£mkÒÍx. E¸ 7.14 
I £õºUP.

     E¸ 7.14  ö\ÆÁPö©õßÔß _ØÓÍÄ® £µ¨£ÍÄ®

  ö\¯Ø£õk

 }[PÒ E£÷¯õQUS® Â›uõÒ ö©ßö£õ¸øÍ¨ £¯ß£kzv 

÷©÷» E¸ 7.14 C¾ÒÍ £ozuõøÍz u¯õ›UPÄ®. A2 

©ØÖ® B2 P»[PÎß ö£Ö©õÚ[PøÍ ©õØÔ C ©ØÖ® D 

Á›PÎÀ Põmh¨£mkÒÍ `zvµ[PÎß ö£Ö÷£ÖPøÍ 

AÁuõÛUP. 

•UQ¯ SÔ¨¦

D2 P»zvØPõÚ `zvµ® D2=A2*B2 GÚ GÊxÁuß ‰»® Ax J¸ •P¨¦  

Aøh¯õÍ©õP ©õÔÚõ¾® Po¨¥k {PÇ©õmhõx (E¸ 7.15 I¨ £õºUP). 
GÚ÷Á, `zvµ® GÊx®÷£õx  ‘‘ = ” Aøh¯õÍzxUS Chx £UPzvÀ GxÄ® 

GÊuU Thõx. (E¸ 7.16 I¨ £õºUP).

     E¸  7.15  `zvµ® GÊx®

            ¤øÇ¯õÚ •øÓ

           E¸  7.16  `zvµ® GÊx®

                    \›¯õÚ •øÓ
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Euõµn® 2

¦zuPö©õßÔß Âø» ©ØÖ® ö£ß]ö»õßÔß Âø» Gß£øÁ E¸ 7.17 CÀ 

Põmh¨£mkÒÍÚ. C[S £¯ß£kzu¨£mkÒÍ `zvµzvøÚ AÁuõÛUP.

  ö\¯Ø£õk
}[PÒ E£÷¯õQUS® Â›uõÒ ö©ßö£õ¸øÍ¨ £¯ß£kzv 

E¸ 7.17 CÀ EÒÍÁõÖ £ozuõÎøÚz u¯õ›UP. B1  ©ØÖ® 

B2 P»[PÎß ö£Ö©õÚ[PøÍ ©õØÖÁuß ‰»® B3, B4, 
B5, B6 BQ¯ P»[PÎÀ QøhUP¨ö£Ö® ö£Ö©õÚ[PøÍ 

AÁuõÛUP. 

Euõµn® 3

\xµ•Qö¯õßÔß £UP® JßÔß }Í® uµ¨£k®÷£õx Auß ÷©Ø£µ¨£ÍøÁ²® 

PÚÁÍøÁ²® PõnÀ. (E¸ 7.18 I¨ £õºUP.)  

E¸ 7.18  \xµ•Q°ß £µ¨£ÍÄ® PÚÁÍÄ®

  ö\¯Ø£õk 

E¸ 7.18 C¾ÒÍ £ozuõÎøÚ }[PÒ £¯ß£kzx® Â›uõÒ 

ö©ßö£õ¸øÍ¨ £¯ß£kzv B1  P»zvß ö£Ö©õÚ[PøÍ 

©õØÔ B2, B3, B4 BQ¯ P»[PÎÀ SÔ¨¤h¨£mkÒÍ 

`zvµ[PÎß ö£Ö©õÚ[PøÍ  AÁuõÛUP.

E¸ 7.17 Âø»PøÍU PozuÀ

¦zuP® JßÔß Âø»

ö£ß]À JßÔß Âø»

¦zuP® JßÔÚx® ö£ß]À JßÔÚx® Âø»

‰ßÖ ¦zuP[PÎß Âø»

¦zuP® JßÔÚx® ö£ß]À JßÔÚx®

Âø»PÐUQøh°»õÚ Âzv¯õ\®

4 ¦zuP[PÎÚx® 2 ö£ß]ÀPÎÚx® Âø»

\xµ•Q°ß J¸ £UP }Í®

\xµ•Q°ß J¸ £UP £µ¨£ÍÄ

\xµ•Q°ß •Ê ÷©Ø£µ¨£ÍÄ

\xµ•Q°ß PÚÁÍÄ
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               `zvµ®                  ö£Ö÷£Ö

=A1*B1-D2
=D1−C2/A2
=B3^C3−A3
=A1*C1/C3
=D2*C4*E1
=A3/B3+A2*D1
=A1+(B2*C2)−B3+C2/B2
=B2−B3+B1*(D1+D2^B1)
=A2^B3-C2+A3*(B3+C1)
=A3/C3*(D2*D1)
=D3/C3/B3*A3+B2
=(D3/(A1+B2))^C2

                                     AmhÁøn  7.8

SÔ¨¦ :  P»•PÁ›ø¯¨   £¯ß£kzv    GÊu¨£mh    `zvµ[PÒ     ‰»® 

 QøhUS® ö£Ö÷£ÖPÒ Ga\¢uº¨£zv¾® `zvµ[PøÍ GÊu¨ 

£¯ß£kzu¨£k® P»[PÎÀ HØ£kzu¨£k® ©õØÓzvØ÷PØ£ 

CØøÓ¨£kzu¨£k®.

  ö\¯Ø£õk

 R÷Ç Põmh¨£mkÒÍ £ozuõøÍ²®  (E¸ 7.19) AmhÁøn 

7.8 CÀ SÔ¨¤h¨£mkÒÍ `zvµ[PøÍ²® |ßÓõP PØP. 

uØ÷£õx AÁØÔß •ßÝ›ø©¨£i Po¨¥k ö\´x ö£Ó¨£k® 

ö£Ö©õÚ[PøÍ  ö£Ö÷£Ö {µ¼À GÊxP.  

`zvµ® Âøh

=A1+B1 12
=C1+C2+C3 17
=B2+C3+B3 7
=A2*C1 12
=C2/A2*D1 6
=B3^A2+D1 10

E¸ 7.19 uµÄPøÍ EÒÍhUQ¯ £ozuõÒ

    AmhÁøn 7.7
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 7.4  Pozu¾US \õº¦PøÍ¨ £¯ß£kzuÀ
 

 uµÄPÎß   GsoUøP   AvP›US®÷£õx   P»•PÁ›°øÚ  ©õzvµ® 

£¯ß£kzva `zvµ[PøÍ Aø©¨£x PiÚ©õPÄ® ]UP»õPÄ® Aø©²®. 

AÆÁõÓõÚ \¢uº¨£[PÎÀ `zvµ[PÐUS¨ £v»õP \õº¦PøÍ¨ 

£¯ß£kzu •i²®. Â›uõÒ ö©ßö£õ¸Ò  xøÓPÎÀ Põn¨£k® £À÷ÁÖ 

÷uøÁPÐU÷PØ£ öÁÆ÷ÁÓõÚ \õº¦PÒ Põn¨£kQßÓÚ.   AÁØÖÒ   AvP® 

£¯ß£õmiÀ EÒÍ Ai¨£øha \õº¦PÒ ]»ÁØøÓ AÔ¢xöPõÒ÷Áõ®. 

(AmhÁøn  7.9  I¨ £õºUP) 

\õº¦PÎß 

ö£¯º
     (Syntax) öuõh›¯À       £¯ß£õk

SUM =SUM (Number 1, Number 2......) P»Ãa]À  EÒÍ ö£Ö©õÚ[ 

PÎß Tmkz öuõøPø¯  

AÔuÀ

AVERAGE =AVERAGE(Number1, Number 2.......) P»Ãa]À  EÒÍ ö£Ö©õÚ[ 

PÎß \µõ\›°øÚ AÔuÀ

 MAX =MAX(Number1, Number 2.......) P»Ãa]À EÒÍ ö£Ö©õ 

Ú[PÎÀ ªP¨ ö£›¯ 

Gsøn  AÔuÀ

 MIN =MIN(Number1, Number 2......) P»Ãa]À  EÒÍ ö£Ö©õ 

Ú[PÎß ªPa]Ô¯ Gsøn 

AÔuÀ

COUNT =COUNT(Number 1, Number 2.......) P»Ãa]À   EÒÍ P»[PÎß 

GsoUøP°øÚ AÔuÀ

 

 Euõµn©õP £ozuõöÍõßÔß uµÄPÍx TmkzöuõøP°øÚ 

Cµsk •øÓPÎÀ ö£ØÖUöPõÒÍ •i²®. R÷Ç \©ß£õk  CÀ CÚ[ 

Põmh¨£mkÒÍ     A1 P»® •uÀ   A10  P»®  Áøµ°»õÚ ö£Ö©õÚ[PÎÚx 

TmkzöuõøP°øÚ, P»•PÁ›ø¯ ©õzvµ® GÊxÁuß ‰»® ö£ØÖU 

öPõÒÍ»õ®. AÆÁõ÷Ó AÁØÔß TmkzöuõøP°øÚ  R÷Ç \©ß£õk 

CÀ Põmh¨£mkÒÍÁõÖ \õº¤øÚ¨ £¯ß£kzv²® ö£ØÖUöPõÒÍ»õ®. 

CøÁ CµsiÚx® ö£Ö÷£ÖPÒ \©ÚõS®. CÆÂµsk `zvµ[PøÍ²® 

J¨¤k®÷£õx P»Ãa_ AvP›US®÷£õx  CµshõÁuõPU Põmh¨£mkÒÍ              

\õº¤øÚ¨  £¯ß£kzxÁx C»SÁõÚuõP Aø©²®.

    AmhÁøn  7.9

1

2
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= A1+A2+A3+A4+A5+A6+A7+A8+A9+A10     1

= SUM(A1:A10)         
2

=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10

           =SUM( A1: A10)

    

 J¸ \õº¤ÝÒ Em¦Szu¨£k®  P»Ãa\õÚx Bµ®£U P»•PÁ›ø¯²®  

CÖvU P»•PÁ›ø¯²®  öPõsi¸US®.

E¸ 7.20 ‰»® Põmh¨£mkÒÍ £ozuõÎÀ EÒÍ `zvµ[PøÍ¨ £¯ß£kzv 

\õº¦PøÍ E¸ÁõUSP.

\õº¤øÚ¨  £¯ß£kzuU  Ti¯ £À÷ÁÖ \¢uº¨£[PøÍ¨ £ØÔ AÔ÷Áõ®

SUM \õº¦  ^AmhÁøn 7'10 £õºUP&

`zvµ® ÂÁµ® ö£Ö÷£Ö

= SUM (A1,B1,C1) A1, B1 ©ØÖ® C1 BQ¯ P»[PÍx ö£Ö 

©õÚ[PÎß TmkzöuõøP

        12

= SUM (A1:C1) A1  ©ØÖ® C1  Áøµ°»õÚ  P»[PÎÀ  Aø©¢ 

xÒÍ ö£Ö©õÚ[PÎß Tmkz öuõøP

        12

= SUM (A1:C1,B2) A1 öuõhUP® C1  Áøµ°»õÚ  P»[PÎÀ 

Aø©¢xÒÍ  ö£Ö©õÚ[PÒ  ©ØÖ®   B2  P»z

vÀ EÒÍ ö£Ö©õÚ® BQ¯ÁØÔß Tmkz 

öuõøP

        15

= SUM (B1:C2) B1 öuõhUP® C2 Áøµ°»õÚ P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÎß Tmkz öuõøP

        20

= SUM (A1:A3,C1:C3) A1 öuõhUP® A3 Áøµ²ÒÍx® C1 öuõhUP® 

C3 Áøµ²ÒÍx©õÚ  P»[PÎÀ Aø©¢xÒÍ 

ö£Ö©õÚ[PÎß TmkzöuõøP

            35

E¸  7.20  £ozuõÒ

                                       AmhÁøn 7.10



C»Á\¨ £õh¡À238

AVERAGE \õº¦ 

`zvµ® Â£µ® ö£Ö÷£Ö

= AVERAGE (A1,B1,C1) A1, B1 ©ØÖ® C1 BQ¯ P»[PÍx ö£Ö 

©õÚ[PÎß \µõ\›

           

4'00

= AVERAGE (A1:C1) A1  öuõhUP® C1  Áøµ°»õÚ  P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÎß \µõ\›

           

4'00

= AVERAGE (A1:C1,B2) A1 öuõhUP® C1 Áøµ°»õÚ  P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÒ ©ØÖ® B2 
P»zvÀ EÒÍ ö£Ö©õÚ® BQ¯ÁØÔß 

\µõ\›

           

3'75

= AVERAGE (B1:C2) B1 öuõhUP®  C2 Áøµ°»õÚ  P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÎß \µõ\›

           

5'00

= AVERAGE(A1:A3,C1:C3) A1 öuõhUP® A3 Áøµ²ÒÍx® C1 
öuõhUP® C3 Áøµ²ÒÍx©õÚ  P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÎß \µõ\›

                
5.83

                                  AmhÁøn 7.11    

SÔ¨¦( \µõ\›¨ ö£Ö©õÚ[PÐUPõÚ ö£Ö÷£ÖPÒ ö£¸®£õ¾® u\©uõÚ[

 PÎÀ QøhUP¨ö£Ö®. A¨÷£ÖPøÍ EÒÍhUQ¯ P»[PÎÀ 

÷uøÁ¯õÚ  u\©uõÚ[PøÍ¨ ö£ØÖUöPõÒÍ  AÁØøÓ ÁiÁø©¨¦ 

(Format) ö\´xöPõÒÍ ÷Ásk®.
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MAX \õº¦  

           `zvµ®                    Â£µ®  ö£Ö÷£Ö

= MAX(A1,B2,C1) A1, B2 ©ØÖ® C1 BQ¯ P»[PÎÀ EÒÍ ªP¨ 

ö£›¯ ö£Ö©õÚ®
       4

= MAX(A2:C2,B3) A2   öuõhUP®   C2   Áøµ°»õÚ    P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÒ ©ØÖ® B3 
P»zvÀ EÒÍ ö£Ö©õÚ® BQ¯ÁØÔÀ ªP¨ 

ö£›¯ ö£Ö©õÚ®

       9

= MAX(A1:C1) A1 öuõhUP® C1  Áøµ°»õÚ  P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÎß ªP¨ ö£›¯ 

ö£Ö©õÚ®

       6

= MAX(A1,B1:C2) A1 ©ØÖ® B1 öuõhUP®  C2 Áøµ°»õÚ 

P»[PÎÀ Aø©¢xÒÍ ö£Ö©õÚ[PÎß 

ªP¨ ö£›¯ ö£Ö©õÚ® 
       7

MIN \õº¦  

    

        `zvµ®                 Â£µ®      ö£Ö÷£Ö

= MIN(A1,B2,C1) A1, B2 ©ØÖ® C1 BQ¯ P»[PÎÀ EÒÍ 

ªPa ]Ô¯ ö£Ö©õÚ®

        2

= MIN(A2:C2,B3) A2  öuõhUP®  C2  Áøµ°»õÚ  P»[PÎÀ 

Aø©¢xÒÍ ö£Ö©õÚ[PÒ ©ØÖ® B3 

P»zvÀ EÒÍ ö£Ö©õÚ® BQ¯ÁØÔÀ 

ªPa ]Ô¯ ö£Ö©õÚ®

        3

= MIN(A1:C1) A1 öuõhUP® C1 Áøµ°»õÚ  P»[PÎÀ 

Aø©¢xÒÍ   ö£Ö©õÚ[PÎß     ªPa 

]Ô¯ ö£Ö©õÚ®

        2

= MIN(A1,B1:C2) A1 ©ØÖ® B1 öuõhUP® C2 Áøµ°»õÚ 

P»[PÎÀ Aø©¢xÒÍ ö£Ö©õÚ[PÎß 

ªPa  ]Ô¯ ö£Ö©õÚ® 

        2

                                         AmhÁøn 7.13

AmhÁøn  7.12
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 COUNT \õº¦ 

`zvµ® Â£µ® ö£Ö÷£Ö

= COUNT(A1,  B1) A1, B1 BQ¯ P»[PÎÀ EÒÍ 

ö£Ö©õÚ[PÎß GsoUøP

          2

= COUNT(A1:C1) A1 öuõhUP®  C1  Áøµ¯õÚ 

P»[PÎÀ EÒÍ ö£Ö©õÚ[ 

PÎß GsoUøP

          3

= COUNT(A1:A3) A1 öuõhUP®  A3  Áøµ°»õÚ 

P»[PÎÀ EÒÍ ö£Ö©õÚ[ 

PÎß GsoUøP

          3

= COUNT(A1:C1, B2) A1 öuõhUP®  C1 Áøµ¯õÚ 

P»[PÎ¾®  B2  P»zv¾® 

EÒÍ ö£Ö©õÚ[PÎß Gs 

oUøP

          4

= COUNT(B1:C3) B1 öuõhUP®  C3 Áøµ¯õÚ  

P»[PÎÀ EÒÍ ö£Ö©õÚ[ 

PÎß GsoUøP

          6

=COUNT(A1:A3, C1:C3) A1 öuõhUP®  A3 Áøµ¯õÚ 

P»[PÎÚx®  C1 öuõhUP®  C3  
Áøµ¯õÚ P»[PÎÚx® ö£Ö 

©õÚ[PÎß GsoUøP

          6

                                          AmhÁøn  7.14  

 

 £õh\õø»ö¯õßÔÀ uµ® 10 CÀ uPÁÀ öuõhº£õhÀ 

öuõÈÝm£¨ £õhzvøÚ PØS® BÖ ©õnÁºPÒ ‰ßÖ uÁøn 

PÎ¾® ö£ØÓ ¦ÒÎPÒ E¸ 7.21 CÀ Põmh¨£mkÒÍÚ.  

©õnÁºPÒ •u»õ® 
uÁøn

Cµshõ®
  uÁøn

‰ßÓõ®
  uÁøn

H. M. |õuß

T.  á¯ßuß

M.M. {¯õì

R. S©õ›

P.W. ÷uÂ

M.A.F ~ð»õ

ab

E¸  7.21

  ö\¯Ø£õk 



C»Á\¨ £õh¡À 241

\õº¦PøÍ ©õzvµ® £¯ß£kzv ¤ßÁ¸® ÂÚõUPÐUS Âøh u¸P.

^1& H. M |õuß ö£ØÖU öPõsh ¦ÒÎPÎß ö©õzuzvøÚ AÔ¯ E2 P»zvÝÒ 

Em¦Szu ÷Ási¯ \õº¤øÚU SÔ¨¤kP.

^2& T.  á¯¢uß ö£ØÖU öPõsh ¦ÒÎPÎß \µõ\›°øÚ AÔ¯ E3 P»zvÝÒ 

Em¦Szu ÷Ási¯ \õº¤øÚU SÔ¨¤kP.

^3& •u»õ® uÁøn°À ö£ØÖUöPõsh AvTi¯ ¦ÒÎ°øÚ AÔ¢x 

öPõÒÁuØöPÚ B8 P»zvÝÒ Em¦Szu ÷Ási¯ \õº¤øÚ SÔ¨¤kP.

^4&  Cµshõ® uÁøn¨ £Ÿmø\US ÷uõØÔ¯ ©õnÁºPÍx GsoUøPø¯ 

     AÔ¢u öPõÒÍ C8 P»zvÝÒ Em¦Szu ÷Ási¯ \õº¤øÚ SÔ¨¤kP.

^5& ‰ßÓõ® uÁøn¨ £Ÿmø\°À ö£ØÖU öPõsh ªPU SøÓ¢u ¦ÒÎø¯ 

AÔÁuØS D8 P»zvÝÒ Em¦Szu ÷Ási¯ \õº¤øÚ SÔ¨¤kP.

 7.5  £ozuõÎøÚ ÁiÁø©zuÀ

 £ozuõÒ JßÔÝÒ EÒÍ GÊzxUPøÍ  ©ØÖ® ö£Ö©õÚ[PøÍ 

ÁiÁø©¨£uØS (Formatting) ÁiÁø©¨¦ P¸Â¨ £møhø¯ AÀ»x 

P»ÁiÁø©¨¦¨ £møhø¯¨ £¯ß£kzu •i²®.

7.5.1  Microsoft Excel 2010 Cß P» ÁiÁø©¨¦ £møh 

21 3

1310 11 151412

5 6

9

7

8

4

 E¸ 7.22  Microsoft Excel 2010 P»ÁiÁø©¨¦¨ £møh

C» PmhøÍ ÂÁµ®

      1 Font £ozuõÎÀ  £À÷ÁÖ  Âu©õÚ GÊzx¸ 

ÁiÁ[PøÍ Aø©zuÀ

      2 Font Size £ozuõÎÀ £À÷ÁÖ AÍÂ»õÚ GÊzx 

¸PøÍ  Aø©zuÀ

      3 Vertical Top Alignment P»zvÝÒ £õhzøu (Text) ÷©»õP 

÷|º¨£kzuÀ

      4 Vertical Middle Alignment P»zvÝÒ £õhzøu ©zv°À                           

÷|º¨£kzuÀ    
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      5 Vertical Bottom Alignment P»zvÝÒ £õhzøu RÇõP ÷|º¨£kzuÀ

      6 Orientation P»zvÝÒ £õhzvß  {ø»z ÷uõØÓ®

      7 Number Format
P»zvÝÒ   ö£Ö©õÚ[PÒ Põm]¨£kz 

u¨£h÷Ási¯       {ø»z÷uõØÓzøu  

JÊ[Pø©zuÀ

      8 Bold P»zvß EÒÍhUP[PøÍ ui¨£õUSuÀ

      9 Italic
P»zvß EÒÍhUP[PøÍ \õ´ÁõP 

Aø©zuÀ

     10 Underline
P»zvß  EÒÍhUP[PÎß   RÌU  ÷Põi-

kuÀ

     11 Left Alignment
P»zvß  EÒÍhUPzøu  Ch©õP  ÷|º¨ 

£kzuÀ

     12 Center Alignment
P»zvß EÒÍhUPzøu ©zv°À ÷|º¨ 

£kzuÀ  

     13 Right Alignment
P»zvß  EÒÍhUPzøu  Á»©õP  ÷|º¨ 

£kzuÀ  

     14 Increase decimal places 
ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

AvP›zuÀ

     15 Decreased  decimal places
ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

SøÓzuÀ

                                              AmhÁøn 7.15

7.5.2  LibreOffice  Calc Cß P» ÁiÁø©¨¦¨ £møh

8

3 4 5 61 2

7 9 10

 E¸ 7.23  LibreOffice  Calc 4.1 P» ÁiÁø©¨¦¨ £møh

C»UP® PmhøÍ ÂÁµ®

1 Font £ozuõÎÀ £À÷ÁÖ Âu©õÚ GÊz 

x¸UPøÍU Aø©zuÀ

2 Font Size £ozuõÎÀ £À÷ÁÖ AÍÂ»õÚ

GÊzx¸UPøÍU Aø©zuÀ



C»Á\¨ £õh¡À 243

3 Bold P»zvß EÒÍhUP[PøÍz ui¨£õUSuÀ

4 Italic P»zvß EÒÍhUP[PøÍa \õ´ÁõP 

Aø©zuÀ

5 Underline P»zvß EÒÍhUP[PÎß RÌ ÷Põi-

kuÀ

6 Left Alignment P»zvß EÒÍhUPzøu Ch©õP ÷|º¨ 

£kzuÀ

7 Center Alignment P»zvß EÒÍhUPzøu ©zv°À ÷|º¨ 

£kzuÀ 

8 Right Alignment P»zvß  EÒÍhUPzøu  Á»©õP ÷|º¨ 

£kzuÀ

9 Increase decimal places ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

AvP›zuÀ

10 Decreased  decimal 
places

ö£Ö©õÚ[PÎß u\©uõÚ[PøÍ 

SøÓzuÀ

      AmhÁøn 7.16

7.5.3  ö£Ö©õÚ[øÍ   ÁiÁø©¨£uØPõP  ö\õÀ»õhØ  ö£miø¯¨  

          £¯ß£kzuÀ 
 

J¸ P»® AÀ»x P»Ãa]øÚ ÁiÁø©¨£uØS P» ÁiÁø©¨¦ ö\õÀ»õhØ 

ö£miPøÍ¨ (Format Cells Dialog Box) £¯ß£kzu•i²®. 

    E¸ 7.24 P» ÁiÁø©¨¦ ö\õÀ»õhØö£mi                 E¸ 7.25 P» ÁiÁø©¨¦ 

          ö\õÀ»õhØö£mi

Microsoft Office Excel 2010 CÀ 

Home Tab  → Number Group LibreOffice Calc CÀ

Format→Cells
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7.5.4  P»Ãa]À  u\©  GsPøÍ  ÁiÁø©zuÀ 

 ö£Ö©õÚ[PøÍ ÁSUS®÷£õx £À÷ÁÖ Âu©õÚ u\© AÍÄPÎÀ 

ö£Ö÷£ÖPÒ QøhUS®. AÁØøÓ {ø»¯õÚ u\© ö£Ö©õÚzvÀ SÔ¨¤kuÀ 

÷Ásk®. E¸ 7.26 I¨ £õºUP'

             E¸ 7.26 Cµsk u\©  uõÚ[PÐUS ÁiÁø©zuÀ

ÁiÁø©UP

•ß

Cµsk u\© 

uõÚ[PÐUS 

ÁiÁø©zu ¤ß

 

 ÷uøÁ¯õÚ u\©uõÚ[PøÍ¨ ö£ØÖUöPõÒÍ ¤ßÁ¸® ÁiÁø©¨ 

¤øÚU øP¯õÒP. 

7.5.5 P»Ãa]øÚ   •P¨¦   Aøh¯õÍ©õP  ÁiÁø©zuÀ

 öuõø»÷£] C»UP® JßÔÀ 10 C»UP[PÒ Aø©¢v¸US®. GÛÝ®, 

CÆÂ»UP[PÎß Bµ®£zv¾ÒÍ §a]¯® (0) Â›uõÎÀ öuß£kÁvÀø». 

CuØSU Põµn® AuøÚ²® J¸ ö£Ö©õÚ©õP P¸xÁuõS®. GÚ÷Á 

öuõø»÷£] C»UP[PøÍ Em£kzu •ßÚº  E›¯ P»[PøÍ £õh (Text) 
•øÓUS ©õØÖuÀ ÷Ásk® (E¸ 7.27 I²® E¸ 7.11 Cß D {µø»²® £õºUP).

Microsoft Office Excel  2010 CÀ

1' P»[PøÍ öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ     ÁiÁø©US®  

   ö\õÀ»õhØö£miø¯    ö£ØÖU  

   öPõÒÐuÀ

3'  Number Tab I öu›Ä ö\´uÀ  

4' Number I öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»[PøÍ  öu›Ä  ö\´uÀ  

2' ö£Ö©õÚ[PøÍ  ÁiÁø©US®  

   ö\õÀ»õhØö£miø¯  ö£ØÖU  

   öPõÒÐuÀ 

3' Numbers Tab I öu›Ä ö\´uÀ  

4' Number I öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ
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E¸ 7.27 P»[PøÍ £õh (Text) •øÓUS ©õØÖuÀ 

ö£Ö©õÚ[PÍõP Põn¨£hÀ ÁiÁø©¨¦US Em£kzv¯uß ¤ß

P»Ãaø\ £õh (Text) •øÓUS ÁiÁø©UP ¤ßÁ¸©õÖ ö\¯Ø£hÄ®'

7.5.6  P»Ãa]øÚ  \uÃu[PÒ    öu›¯UTi¯ Âu©õP ÁiÁø©zuÀ          

 
 J¸ ö£Ö©õÚzvøÚ CßöÚõ¸ ö£Ö©õÚzvÚõÀ ÁSzx¨ ö£Ö® 

ö£Ö©õÚzvøÚ \uÃuzvÀ (Percentage) PõmhUTi¯ Âu©õP ÁiÁø©UP 

÷Ásk®.   ¦zuP Pøhö¯õßÔß •u»õ® Põ»õskUPõÚ ©õuõ¢u C»õ£      

\uÃu® £ozuõÎÀ  Põmh¨£mkÒÍøu (E¸ 7.28 CÀ) Põn»õ®.

Microsoft Office Excel  2010 CÀ

1' P»[PøÍ  öu›Ä ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   ö\õÀ»õhØö£miø¯  ö£ØÖU  

   öPõÒÍÀ

3'  Number Tab I öu›Ä ö\´uÀ  

4' Text Iz öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚzøu EÒÎhÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»[PøÍ  öu›Ä ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   ö\õÀ»õhØö£miø¯  ö£ØÖU  

   öPõÒÐuÀ 

3' Numbers Tab I öu›Ä ö\´uÀ  

4' Text  Iz öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚzøu EÒÎhÀ

6' OK ö\´uÀ
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            E¸ 7.28 P»Ãa]øÚ \uÃu©õP ÁiÁø©zxU PõmkuÀ

P»Ãa]øÚ \uÃu©õP ÁiÁø©UP ¤ßÁ¸® £i•øÓ°À ö\¯Ø£kzxP.

Microsoft Office Excel CÀ

1' P»[PøÍz öu›Äö\´uÀ  

2' ö£Ö©õÚzvøÚ ÁiÁø©US® 

   ö\õÀ»õhØö£miø¯  ö£ØÖU  

   öPõÒÍÀ

3' Number Tab I öu›Äö\´uÀ  

4' Percentage I  öu›Äö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»[PøÍ öu›Äö\´uÀ  

2' ö£Ö©õÚzvøÚ ÁiÁø©US® 

   ö\õÀ»õhØö£miø¯  ö£ØÖU

   öPõÒÍÀ

3'  Numbers Tab I öu›Äö\´uÀ  

4' Percentage I  öu›Äö\´uÀ

5' ÷uøÁ¯õÚ u\©uõÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ

7.5.7  P»Ãa]øÚ  ÂgbõÚ  SÔ•øÓ  {¯©©õP   ÁiÁø©zuÀ                                                                                                                  

 Â›uõÒPÎÀ ªPa]Ô¯ uõÚ[PÒ •uÀ ªP¨ö£›¯ uõÚ[PøÍU ThU 

PnUQk® Á\vPÒ EÒÍÚ. AÆÁõÓõÚ ö£Ö©õÚ[PøÍ G©US Áõ]zx 

ÂÍ[Q öPõÒÁuØS® AuøÚ •ßøÁ¨£uØS® •i¯õx GÛÝ®, ÂgbõÚ 

SÔ±hõP (Scientific) E¸ÁõUQ¯  ¤ßÚº \P» ö£Ö©õÚ[PÐ® J÷µ ÁiÁzvß 

RÌ Á¸ÁuÚõÀ AÁØøÓ Áõ]zx  ÂÍ[QU öPõÒÁuØS® •ßøÁ¨£uØS®  

Á\v¯õP  Aø©²®. (E¸ 7.29 I £õºUPÄ®)

©õu® Á¸©õÚ® C»õ£ \uÃu®

áÚÁ›

ö£¨£µÁ›

©õºa

H¨¤µÀ
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E¸ 7.29 AÔÂ¯À ö£Ö©õÚ[PÒ 

Â£µ® ö£Ö©õÚ®  ÂgbõÚ SÔ•øÓ

P»Ãa_UPøÍz ÂgbõÚ SÔ•øÓPÍõP ©õØÓ ¤ßÁ¸® £i•øÓPøÍU 

øP¯õÒP.

Microsoft Office Excel  CÀ

1' P»[PøÍ  öu›Ä  ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   ö\õÀ»õhØö£miø¯¨ ö£ØÖU    

   öPõÒÍÀ

3' Number Tab I öu›Ä ö\´uÀ  

4' Scientific I öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»[PøÍ öu›Ä ö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©US® 

   •P¨¤øÚ ö£ØÖUöPõÒÍÀ

3'  Numbers Tab Iz öu›Ä ö\´uÀ  

4' Scientific Iz öu›Ä ö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ

 

7.5.8  P»Ãa]À   vPvPøÍU  PõmhUTi¯  Âu©õP ÁiÁø©zuÀ        
 

  PoÛz vPv°øÚ (Date) 5$19$2014 GÚU PõmiÚõÀ Auß ÂÍUP® 

2014  ÷© ©õu® 19 B® vPv¯õS®. Cx Aö©›UP •øÓ¯õS® (mm ©õu® dd 

vPv yyyy Á¸h®) Â›uõÒPÎÀ vPvPøÍ £À÷ÁÖ Âu[PÎÀ Põmh•i²®. 

E¸ 7.30 I¨ £õºUP.

 
    E¸ 7.30 vPv°øÚ¨ £À÷ÁÖ Âu[PÎÀ PõmkuÀ

vPvø¯U Põmk® £À÷ÁÖ •øÓPÒ

J¸ öµÓõ ø£ØÔøÚ ¤ØÖPÎÀ GÊxuÀ

                   ö|QÌÁmiß öPõÒÍÍÄ öµÓõ ø£ØÖPÎÀ
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Microsoft Office Excel  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPUTi¯ 

   ö\õÀ»õhØö£miø¯¨      ö£ØÖU  

   öPõÒÍÀ

3' Number Tab Iz öu›Äö\´uÀ  

4' Date Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

  Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»Ãa]øÚ öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   ö\õÀ»õhØö£miø¯¨   ö£ØÖU  

   öPõÒÍÀ

3'  Numbers Tab Iz öu›Äö´uÀ  

4' Date  Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ

7.5.9 P»Ãa]À  ÷|µzøuU  PõmhUTi¯ Âu©õP   ÁiÁø©zuÀ  

 PoÛ JßÔÀ ÷|µ® (Time) 10:35:53 AM GÚ  SÔzxU Põmh¨£k®. 

C[S  hh:mm:ss:AM/PM GÚ ö£õxÁõPU Põmh¨£k®. E¸ 7.31 I¨ £õºUP.  hh 

Gß£x ©ozv¯õ»zøu²® mm Gß£x {ªhzøu²® ss Gß£x ö\UPøÚ²® 

AM Gß£x •Ø£Pø»²® PM ¤Ø£Pø»²® SÔzx {ØQßÓx. 

E¸ 7.31 £À÷ÁÖ ÷|µ® Põmk® •øÓPÒ

÷|µzøu JÊ[PõP PõmkuÀ

Microsoft Office Excel  2010 CÀ

1' P»Ãa]ß öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   ö\õÀ»õhØö£miø¯¨ ö£ØÖU  

   öPõÒÍÀ

3' Number Tab Iz öu›Ä ö\´uÀ  

4' Time Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»Ãa]øÚ öu›Äö\´uÀ  

2' ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   ö\õÀ»õhØö£miø¯¨      ö£ØÖU  

   öPõÒÍÀ

3'  Numbers Tab I öu›Äö\´uÀ  

4' Time I öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ AÍÂøÚ   

   Aø©zuÀ

6' OK ö\´uÀ
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7.5.10  P»Ãa]À {v¨ ö£Ö©õÚ[PøÍ  ÁiÁø©zuÀ          

 {v¨ ö£Ö©õÚ[PÐUS›¯ ^Currency& SÔ±kPøÍ ^$- öhõ»º, Rs - 
¹£õ& A¨ö£Ö©õÚzvß    •ßÚõÀ GÊu ÷Ásk®. E¸ 7.28 CÀ {øµ°øÚ¨ 

£õºUP.

P»Ãa_ JßÔÀ {v¨ö£Ö©õÚ[PøÍU PõmkÁuØS ¤ßÁ¸® £i•øÓø¯U 

øP¯õÒP.

Microsoft Office Excel  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ  

2. ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   ö\õÀ»õhØö£miø¯¨     ö£ØÖU  

   öPõÒÍÀ

3'  Number Tab I öu›Äö\´uÀ  

4' Currency I öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ 

   AÍÂøÚ  Aø©zuÀ

6' OK ö\´uÀ 

LibreOffice Calc CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ  

2. ö£Ö©õÚ[PøÍ ÁiÁø©UPU Ti¯ 

   ö\õÀ»õhØö£miø¯¨  ö£ØÖU  

   öPõÒÍÀ

3' Numbers Tab Iz öu›Äö\´uÀ  

4' Currency Iz öu›Äö\´uÀ

5' ÷uøÁ¯õÚ ö£Ö©õÚ 

  AÍÂøÚ  Aø©zuÀ

6' OK ö\´uÀ

7.5.11  P»Ãa]¾ÒÍ ö£Ö©õÚ[PøÍ ÷|º¨£kzuÀ ^Alignment&  ö\´uÀ

 P»[PÎÀ EÒÍ ö£Ö©õÚ[PøÍ   Chx, Á»x, ©zv GßÓÁõÖ ÷|º¨ 

£kzvU ^Alignment& öPõÒÍ»õ®.

 

          (Left Alignment)    (Center Alignment)            (Right Alignment)
   

Chx ÷|º¨£kzuÀ      ©zv¯ ÷|º¨£kzuÀ       Á»x ÷|º¨£kzuÀ
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Microsoft Office Excel  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ

2' Format Celles dialog Box I ö£ØÖU 

   öPõÒP.

3'  Alignment Tab I öu›Äö\´uÀ.

4' Ch®, Á»®, ©zv Gß£ÁØÔÀ 

   ö£õ¸zu©õÚøuz öu›Ä ö\´P.

5' OK ö\´P.

LibreOffice Calc  CÀ

1' P»Ãa]øÚz öu›Äö\´uÀ

2' Format celles dialog Box I ö£ØÖU 

   öPõÒP.

3'  Alignment Tab I öu›Äö\´uÀ.

4' Ch®,Á»®,©zv Gß£ÁØÔÀ 

   ö£õ¸zu©õÚøuz öu›Äö\´P.

5' OK ö\´P.

ö\¯Ø£õk

ÁiÁø©zuÀ P¸ÂPøÍ¨ £¯ß£kzv²® `zvµ[PøÍ GÊv²®  

R÷Ç  E¸ 7.32  CÀ Põmh¨£mkÒÍ £ozuõÎøÚz u¯õ›UP'

E¸ 7.32  £À÷ÁÖ ÁiÁø©zuÀ •øÓPÐhß Ti¯ £ozuõÒ

1.  A  {µø»²® 2 B®  {øµø¯²®  ©zv  Ai¨£øh°À  ÷|º¨£kzxP.

2.   CµshõÁx {øµø¯ ui¨£õUP® (Bold)  ö\´P.

3.  •u»õÁx {øµ°¾ÒÍ uø»¨¦USU RÌU ÷PõikP. GÊzxUPÎß AÍøÁ 

(Font size) 10 BP ©õØÖP.

4.  A3, A4, A5  P»[PøÍ \õ´ÁõP (Italic) ©õØÖP.

5.   B6 P»zvÀ áÚÁ› ©õu ö©õzuzvøÚ  Põs£uØPõÚ  SUM  \õº¤øÚ 

GÊxP.

6.  B7 P»zvØS áÚÁ›©õua \µõ\›ø¯U Põs£uØPõÚ AVERAGE  \õº¤øÚ 

GÊxP.

7. ÷©÷» B6, B7 P»[PÎÀ EÒÍ `zvµ[PøÍ¨ ¤µvö\´x HøÚ¯ 

©õu[PÎß ö©õzuzøu²® \µõ\›ø¯²® PõsP.

8.  E3  P»zvØS, P»[PÎß ö©õzuzøuU Põs£uØS  SUM  \õº¤øÚ GÊxP.

9.  F3 P»zvØS, P»[PÎß  \µõ\›°øÚ Põs£uØS GÚ AVERAGE                           
\õº¤øÚ GÊxP.

10. ÷©÷» E3, F3 P»[PÎ¾ÒÍ `zvµ[PøÍ¨ ¤µvö\´x HøÚø¯ 

¤›ÄPÎß ö©õzuzøuø¯²® \µõ\›ø¯²® PõsP. 

£õh\õø» Áõ]P\õø» £¯ß£õk  (P.ö£õ.u E¯ºuµ ¤›ÄPÒ Ai¨£øh°À)

Pø»

  áÚÁ›  ö£¨µÁ›    ©õºa  ö©õzu®    \µõ\›

ÁºzuP®

ÂgbõÚ®

ö©õzu®

\µõ\›

¤›ÄPÒ



C»Á\¨ £õh¡À 251

 7.6  \õº£õÚ  ©ØÖ®  \õº£ØÓ (•ØÖÖ)  P»[PøÍ  CÚ[PõnÀ

7.6.1  `zvµ® JßøÓ¨ ¤µvö\´uÀ

      £õh\õø»ö¯õßÔÀ  uÁøn¨   £Ÿmø\   JßÖ  •iÁøh¢u ¤ßÚº                                                                                                                      

©õnÁºPÍx  ö©õzu¨ ¦ÒÎPÒ,  \µõ\› ÷£õßÓÁØøÓ   EÒÍhUQ¯  ¦ÒÎ¨

£iÁ[PøÍ¨  ÷£qÁx  ÁÇø©¯õS®.  GÛÝ®, C»zvµÛ¯À Â›uõøÍ¨

£¯ß£kzv ¦ÒÎ¨ £mi¯ø»z u¯õ›¨£x ªPÄ® £¯ÝÖv EÒÍ J¸ 

•øÓ¯õS®. GÊu¨£mh  `zvµ[PøÍ¨  ¤µvö\´x ªP C»SÁõP  Po¨     

¥kPøÍ ö\´¯ •i²®. £ozuõÒ JßÔß {µ¼ß«x AÀ»x {øµ°ß«x 

J¸ `zvµzøu¨ ¤µv±k ö\´Áx GÆÁõÖ Gß£øu CÛ |õ®  PÁÛ¨÷£õ®. 

7.6.2  P»zvß {µ¨¦¨ ¤i (Fill handle)

 £ozuõÎÀ G¢uöÁõ¸ P»zv¾® Á»¨£UP RÌ ‰ø»°À EÒÍ ªPa 

]Ô¯ \xµ® {µ¨¦¨ ¤i (Fill handle) GÚ¨£k®. (E¸ 7'33 I¨ £õºUP.)

 E¸ 7.33 
{µ¨¦¨ ¤i

7.6.3  `zvµ[PøÍ¨ ¤µvö\´ÁuØöPÚ {µ¨¦¨ ¤i°øÚ¨ 

          £¯ß£kzuÀ

{µ¨¦¨ ¤i°øÚ¨ £¯ß£kzv `zvµ[PøÍ¨ ¤µvö\´ÁuØPõP 

¤ßÁ¸®  £i•øÓPøÍ¨ ¤ß£ØÖP. 

^1& `zvµ® Ah[Q²ÒÍ P»zvøÚz öu›uÀ

^2& P»zvß Á»¨£UP RÌ ‰ø»°À {µ¨¦¨ ¤i°øÚz öu›uÀ

^3& {µ¨¦¨ ¤i°øÚ ÷uøÁ¯õÚ P»[PøÍ ÷|õUQ CÊzxa ö\À»À.
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7.6.4  `zvµ[PøÍ   ¤µvö\´ÁuØS  ¤µv  (Copy),  Jmk  (Paste)                                                    
          Gß£ÁØøÓ¨   £¯ß£kzuÀ.

 Copy, Paste Gß£ÁØøÓU öPõsk ¤µvö\´ÁuØS ¤ßÁ¸® ÁÈ 

•øÓPøÍU øP¯õÒP.

^1&  `zvµ® EÒÍh[Q¯ P»zvøÚz öu›uÀ   

^2& öu›Ä ö\´¯¨£mh P»zv¾ÒÍ EÒÍhUPzøu ¤µv ö\´x öPõÒÍÀ 

^Ctrl + C&

^3& ¤µvö\´ÁuØPõÚ  P»®/P»Ãaø\  öu›uÀ

^4& öu›Ä ö\´¯¨£mh P»®/P»Ãa]À JmkuÀ (Paste) / ^Ctrl + V&

7.6.5  \õº£õÚ ©ØÖ® \õº£ØÓ (•ØÖÖ) P»[PøÍ¨ ö£ØÖU öPõkzuÀ

      P»•PÁ›,  {µÀ GÊzxUPøÍ²® {øµ C»UP[PøÍ²® öPõsi¸US®. 

`zvµö©õßÔÀ  Põn¨£k®  AÆÁõÓõÚ   P»•PÁ›   \õº£õÚ P» •PÁ› 

GÚ¨£k®. öhõ»º ^$& Aøh¯õÍzvøÚ {øµ C»UPzvß •ß÷Ú CkÁuß 

‰»® •ØÖÖ {øµ ö£Ó¨£k®.  öhõ»º ($) {µÀ GÊzxPÎß •ß÷Ú 

CkÁuß ‰»® •ØÖÖ {øµ ö£Ó¨£k®.  Aøh¯õÍzvøÚ {øµ C»UP® 

©ØÖ® {µÀ GÊzx BQ¯ÁØÖUS •ß÷Ú CkÁuß ‰»®   •ØÖÖ {øµ²® 

•ØÖÖ {µ¾® ö£Ó¨£k®.

Euõµn®

H2 - \õº£õÚ P»•PÁ› ^Relative cell reference&
H$2  - {øµ •ØÖÖ P»•PÁ› ^Row absolute cell reference&
$H2 - {µÀ •ØÖÖ P»•PÁ› ^Column absolute cell reference&
$H$2 - {øµ ©ØÖ® {µÀ •ØÖÖ P»•PÁ› ^Row and column absolute cell   
    reference&

7.6.6  \õº£õÚ P»[PÒ

 `zvµ® JßøÓ ¤µvö\´²®÷£õx AøÁ EÒÍhUS® P»•PÁ›°Úx 

{µÀ GÊzxUPÒ, {øµ C»UP[PÒ ©õÖ£k©õ°ß AU P»•PÁ›PÒ \õº£õÚ 

P» •PÁ›PÒ (Relative cell reference) GÚ¨£k®.  
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Euõµn®

 C1 P»zvÝÒ GÊu¨£mkÒÍ  = A1+B1 GßÝ® `zvµ®  C {µ¼ 

ÞhõPÄ® •u»õÁx {øµ°ÞhõP Qøh¯õPÄ® ¤µv ö\´¯¨£k®÷£õx 

P»•PÁ› E¸  7.34 CÀ Põmh¨£mkÒÍÁõÖ ©õÖ® Cuß £i   A1 ©ØÖ® B1 
BQ¯ P»•PÁ›PÒ \õº¦ P»÷©Ø÷PõÒ GÚ AøÇUP¨£k®'

7.6.7  {øµ •ØÖÖ P»•PÁ›
 

 `zvµ® JßÖ J¸ Á›°ÞhõP¨ ¤µvö\´¯¨£k®÷£õx P» 

•PÁ›PÎÀ {øµ C»UP[PÒ ©õÓõÂiß AÆÁõÓõÚ P»•PÁ›PÒ {øµ 

•ØÖÖ P»•PÁ›PÒ GÚ¨£k®.  ^Row absolute cell reference& 

Euõµn® 

 C1 P»zvÝÒ GÊu¨£mkÒÍ = A$1+B$1 GßÝ® `zvµ® C 
{µ¼ÞhõPÄ® •u»õÁx {øµ°ÞhõP Qøh¯õPÄ® ¤µv ö\´¯¨£k®÷£õx 

{øµ°ÞhõP {µÀ ö£¯º ©õØÓ©øh²® A÷u÷ÁøÍ {øµ C»UP® 

©õØÓ©øh¯õx. Auß£i   A$1 ©ØÖ® B$1 BQ¯ P» •PÁ›PÒ {øµ •ØÖÖ 

P» •PÁ›PÒ  GÚ AøÇUP¨£k®. E¸ 7.35 I £õºUP.

E¸ 7.34   \õº¦ EÒÏkPÒ öPõsh £ozuõÒ 

{µ¼ß ö£¯º ©õØÓ©øh²®'

{øµ C»UP®

©õØÓ©øh²®

{øµ°ÞhõP ¤µv ö\´¯¨£k® ÷£õx 

{µÀ ö£¯º ©õÖ£k®

{µ¼ÞhõP ¤µv ö\´¯¨£k® 

÷£õx {øµ C»UP® ©õÖ£hõx.

                                                             E¸ 7.35
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Euõµn® 2

 J¸ ö£ß]¼ß Âø» öPõkUP¨£mkÒÍ {ø»°À £» ö£ß]ÀPÎÚx 

Âø»°øÚ AÔuÀ R÷Ç E¸ 7.36 ‰»® Põmh¨£mkÒÍx.

ö£ß]ÀPÎß GsoUøP

                                                         E¸ 7.36

 ÷©÷» EÒÍ £ozuõÎÀ  C {µ¼ÞhõP ö£ß]ÀPÎß AÍÄUSU 

÷PØ£ ö£Ö©v°øÚU Po¨¥k ö\´¯   C2 P»zvÝÒ GÊu¨£h÷Ási¯ 

`zvµ®  =A2*B2 BS®. CuøÚ  C2 {µ¼ß FhõP R÷Ç CÊ¨£uß ‰»® 

ö£ß]¼ß AÍÄPÎß ö£Ö©õÚzøu AÔ¯ •i¯õx.

 

 `zvµzvøÚ¨ ¤µv ö\´²®÷£õx A2 Âu©õP÷Á A3, A4, A5 ÷£õßÓ 

ÁõÖ \õº£õP ©õØÓ[PøÍ HØ£kzu ÷Ásk® GÛÝ® \P» \¢uº¨£[PÎ¾®  

B2  P»zvß  `zvµ®  ©õÓõv¸zuÀ ÷Ásk®. P»zvÝÒ GÊu¨£h ÷Ás 

i¯ `zvµ®  =A2*B$2 BS®.

7.6.8  {µÀ •ØÖÖ P»•PÁ› 

 {µ¼ÞhõP J¸ ̀ zvµzvøÚ¨ ¤µvö\´²®÷£õx ̀ zvµ® Ah[Q²ÒÍ 

P»•PÁ›PÍx {µÀ GÊzxUPÒ ©õÓõÂiß AÆÁõÓõÚ P»•PÁ›PÒ {µÀ         

•ØÖÖ P»•PÁ› GÚ¨£k®. (Column absolute cell reference) 

Euõµn® 1  

          C1 P»zvÝÒ GÊu¨£mkÒÍ  = $A1+$B1 GßÝ® ̀ zvµ® RÌ÷|õUQ²® 

©ØÖ® •u»õÁx Á›°ÞhõP SÖUPõPÄ® ¤µv ö\´²®÷£õx R÷Ç E¸  7'37 

CÀ SÔ¨¤h¨£mkÒÍÁõÖ  {µ¼ÞhõP {øµ C»UP[PÒ ©õØÓ©øh²®. 

GÛÝ®, P»•Á›PÍx {µÀ GÊzxPÒ ©õØÓ©øh¯õx. Auß£i   $A1 ©ØÖ®  

$B1  BQ¯ P»•PÁ›PÒ •ØÖÖ P» ÷©Ø÷PõÒPÒ GßÖ AøÇUP¨£k®.

J¸ ö£ß]¼ß Âø»     ¹. TmkzöuõøP    ¹.
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Euõµn®  

 R÷Ç öPõkUP¨£mkÒÍ  7'38 £ozuõÎß ‰ßÓõÁx {µ¼ÞhõP 

JÆöÁõ¸ 6 £¢x Ãa_ •iÂ¾® (KÁº& ö£ØÖU öPõÒÍ¨£mh ö©õzu 

Kmh[PøÍ AÔ¢x öPõÒÁuØS ÷uøÁ¯õÚ `zvµ®  =SUM($B2:B2& BS®.

E¸ 7.38 {µÀ \õº£ØÓ P» EÒÏkPÐhß Ti¯ £ozuõÒ

‰ßÓõÁx {øµ°ß FhõP ¤µv ö\´¯¨£k®÷£õx R÷Ç E¸ 7.39 EÒÍ 

Âu©õPU Põn¨£k®.

E¸ 7.39 {µÀ •ØÖÖ P» ÷©Ø÷PõÒPÐhß Ti¯ £ozuõÒ

7.6.9  {øµ ©ØÖ® {µÀ •ØÖÖ P»•PÁ›PÒ

 `zvµ® JßÔøÚ J¸ {øµ°ÞhõP¨ ¤µvö\´²®÷£õx®  {øµ 

°ÞhõP ¤µvö\´²®÷£õx®  ̀ zvµzvÝÒ Ah[Q²ÒÍ P»•PÁ›PÍx {µÀ 

GÊzxUPÒ ©ØÖ® {øµ C»UP[PÒ ©õÓõÂiß AÆÁõÓõÚ P»•PÁ›PÒ 

{øµ ©ØÖ® {µÀ •ØÖÖ P»•PÁ›PÒ GÚ¨£k®. (Row and Column absolute 
cell Reference)

KÁº GsoUøP

ö£ØÓ Kmh[PÒ

TmkzöuõøP

{µÀ GÊzxUPÒ ©õØÓ©øh¯õx.

{øµ GÊzxUPÒ ©õØÓ 

©øh²®.

E¸ 7.37 {µÀ •ØÖÖ ÷©Ø÷PõÒPÐhß Ti¯ £ozuõÒ

KÁº GsoUøP

ö£ØÓ Kmh[PÒ

TmkzöuõøP
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Euõµn® 1 
 C1 P»zvÝÒ GÊu¨£mkÒÍ = $A $1  +  $B $1 ̀ zvµzvøÚ   C  {µ¼ÞhõP  

R÷Ç²® •u»õÁx {øµ°ÞhõPU SÖUPõPÄ® ¤µvö\´²®÷£õx R÷Ç E¸ 
7.40 Cß £i P»•PÁ› ©õÖ£h©õmhõx

{øµ GÊzxPÒ ©õØÓ©øh¯õx.

{µÀ GÊzxPÒ 

©õØÓ©øh¯õx.

E¸ 7.40 {µÀ ©ØÖ® {øµ •ØÖÖ P»•PÁ›PÐhß 

      Ti¯ `zvµ[PÒ EÒÍhUQ¯ £ozuõÒ

Auß£i {øµ ©ØÖ® {µÀ •ØÖÖ P»•PÁ›PøÍU öPõsh `zvµ® Jß 

ÔøÚ {øµ AÀ»x {µÀ FhõP ¤µv ö\´²®÷£õx `zvµzvß P»•PÁ›PÒ 

©õÓõx.

Euõµn® 2
 R÷Ç öPõkUP¨£mkÒÍ E¸ 7.41 £ozuõÎÀ D4 •uÀ I 4 Áøµ ¦z 

uP[PÎß Âø»²® C5 •uÀ C10 Áøµ  h]ßPÐUPõÚ  Âø»²® AÔ¯ 

÷Ási²ÒÍx. C1 P»zxUS J¸ ¦zuPzvß Âø»°øÚ Em¦Szv¯ Eh÷Ú 

AuØS›¯ Âø»²® öu›¯UTi¯  Âu©õP ö£õ¸zu©õÚ  `zvµzvøÚ  

GÊx÷Áõ®. `zvµzvÝÒ C1 P»•PÁ›  •ØÖÖÁõP C¸zuÀ ÷Ásk®. 

AuØSU Põµn® `zvµ® 4 BÁx {øµ°ÞhõPÄ®  C {µ¿hõPÄ® ¤µv 

ö\´¯¨£k®÷£õx `zvµzvÝÒ C1 ©õÓUThõx Gß£uõS®. GÚ÷Á E›¯ 

`zvµzvÝÒ  $C$1 GÚ Em¦Szu ÷Ásk®.

 

E¸ 7'41 {øµ ©ØÖ® {µÀ \õº£ØÓ P» EÒÏk 

¦zuPzvß Âø»

Âø»

¦zuP[PÎß GsoUøP

h
]

ß
P
Î

ß
 

G
s

o
U
ø

P
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  ö\¯Ø£õk

1'  R÷Ç öPõkUP¨£mkÒÍ `zvµ[PøÍ {µÀPÐhÚõPÄ® {øµPÐ

    hÚõPÄ® ¤µvö\´²®÷£õx  P»[PÎÀ  C¯À£õP÷Á  HØ£k® 

    öÁÎ¨£õkPøÍ GÊxP.

         

2. \õº£õÚ ©ØÖ® •ØÖÖ P»•PÁ›PÎøh÷¯ EÒÍ Âzv¯õ\zøu GÊxP.

        E¸  7.42

=K3-M2+N4
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7.7  Â›uõÒPøÍ¨ £¯ß£kzv Áøµ¦PøÍz u¯õ›zuÀ

 GsPÎß ‰»® uµÄPøÍ •ßøÁUS®÷£õx AÁØøÓ J¨¤mk 

÷|õUSuÀ, £S¨£õ´Ä ö\´uÀ, ÂÍ[QU öPõÒÐuÀ ©ØÖ® •ßøÁzuÀ 

BQ¯Ú C»SÁõÚußÖ. BÚõÀ, Á›¨£h® ‰»® uµÄPøÍ •ßøÁU 

S®÷£õx ÷©ØTÔ¯ ¤µa\øÚPÒ uÂºUP¨£mk C»SÁõUP¨£kQßÓÚ.

CuØöPÚ Â›uõÒ ö©ßö£õ¸ÒPøÍ GÆÁõÖ £¯ß£kzxÁx Gß£øu 

AÁuõÛ¨÷£õ®.

Áøµ¦PÎß ÁøPPøÍ AÔ¢xöPõÒ÷Áõ®.

   

  Áøµ¦PÎß ÁøPPÒ    uÍU÷Põ»® £¯ß£õk

{µÀ Áøµ¦ (Column 
Chart)

£À÷ÁÖ uµÄPøÍ J÷µ 

£õºøÁ°À £S¨£õ´Ä 

ö\´¯ •i²®.

\»õøP Áøµ¦ (Bar 
Chart)

£À÷ÁÖ uµÄPøÍ J÷µ 

£õºøÁ°À £S¨£õ´Ä 

ö\´¯ •i²®.

÷Põmk Áøµ¦ (Line 
Chart)

£À÷ÁÖ uµÄPøÍ J÷µ 

£õºøÁ°À £S¨£õ´Ä 

ö\´¯ •i²®.

Ámh Áøµ¦   (Pie 
Chart)

£À÷ÁÖ uµÄPøÍ 

ÂQuõ\õµ •øÓ°À 

£S¨£õ´Ä ö\´¯ 

•i²®

XY ]uÓÀ Áøµ¦ (XY 
Scatter Chart)

P»¨£h©õÚ uµÄPøÍ 

J¨¤mk AÔ¯ •i²®

                                            AmhÁøn 7.17  Áøµ¦ ÁøPPÒ

E¸  7'43  Áøµ¦UPõÚ ¦ÒÎ  ÂÁµ[PÐhß Ti¯ £ozuõÒ

  ö\¯Ø£õk

AmhÁøn 7'17 CÀ Põmh¨£mkÒÍ JÆöÁõ¸ Áøµ¦US® ö£õ¸z 

u©õÚ  Euõµn[PÒ CÆÂµsøhz u¸P. 

ö£¯º

ÂPõè

A«º

ìjÁß

Ag\Úõ

|ì›¯õ

ì÷Áuõ

Pou® ÂgbõÚ® B[Q»® Áµ»õÖ uªÌ TmkzöuõøP
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Áøµ¦PøÍz u¯õ›UP ¤ßÁ¸® £i•øÓPøÍU øP¯õÒP.

Áøµ¦US uø»¨¦ JßÔøÚ ÁÇ[P ¤ßÁ¸® £i•øÓ°øÚU øP¯õÒP.

Áøµ¤ß Aa_UPÎß ö£¯ºPøÍ SÔUP ¤ßÁ¸® £i•øÓ°øÚU øP¯õÒP.

Microsoft Office Excel 2010 CÀ

1. uµÄ P»Ãa]øÚ öu›uÀ

   ( A1 : F3)
2. Insert → Chart
3. Áøµ¦ ÁøPPøÍ öu›uÀ

4. ö£õ¸zu©õÚ Áøµ¤øÚ 

   öu›uÀ

LibreOffice Calc 4.1 CÀ

1. uµÄ P»Ãa]øÚ   öu›uÀ

    ( A1 : F3)
2. Insert → Chart
3. Áøµ¦ ÁøPPøÍ öu›uÀ

4. ö£õ¸zu©õÚ Áøµ¤øÚ  

   öu›uÀ

5. Finish ö£õzuõøÚ ö\¯Ø£kzuÀ

Microsoft Office Excel 2010 CÀ

Áøµ¤øÚz öu›uÀ

Layout →  Chart Title → Above 
chart
uø»¨¤øÚ umha_a ö\´P.

LibreOffice Calc 4.1 CÀ

Áøµ¤øÚz öu›uÀ

Insert →  Title
uø»¨¤øÚ umha_a ö\´x 

Ok ö\´uÀ.

Microsoft Office Excel 2010 CÀ

1. Áøµ¤øÚz öu›uÀ

2. Layout → Axis Title
3. Axis Type ( Vertical or Horizontal) 
   GÊzxPøÍ¨ ö£¯›kuÀ 

LibreOffice Calc 4.1 CÀ

1. Áøµ¤øÚz öu›uÀ

2. Insert →  Chart
3. GÊzxPøÍ¨ ö£¯›kuÀ

4. Ok ö\´uÀ
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©õnÁº ö£ØÓ ¦ÒÎPøÍ Ámh Áøµ¤À Em¦Szx÷Áõ®.

  

Microsoft Office Excel 2010 CÀ

1.uµÄ P»Ãa_  A1: A7 ©ØÖ® 

G1:G7 P»Ãaø\z öu›Äö\´P.

2. Insert → Chart →  Pie chart 
 

LibreOffice Calc 4.1 CÀ

1.  uµÄ   P»Ãa_  A1:A7       

   ©ØÖ®    G1: G7   P» 

   Ãaø\z öu›Ä ö\´P.  

   

2. Insert → Chart →  Pie chart

      
ÂPõè A«º ìjÁß Ag\Úõ |ì›¯õ ì÷Áuõ

ÂPõè A«º ìjÁß Ag\Úõ |ì›¯õ ì÷Áuõ

Pou®

ÂgbõÚ®

B[Q»®

Áµ»õÖ

uªÌ

¦ÒÎPÒ

uµ® 10 ©õnÁºPÒ £Ÿmø\ö¯õßÔÀ ö£ØÓ ¦ÒÎPÒ

ö£¯ºPÒ

E¸  7.45

E¸  7.44
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Euõµn®   Y= X2 - 5X - 3  C¸£ia \©ß£õmiØPø©¯ Áøµø£z u¯õ›zuÀ

Pmh® :1   £ozuõÎÀ  Põmh¨£mkÒÍÁõÖ  x  CØS  - 2  •uÀ  7  Áøµ  

               ö£Ö©õÚ[PøÍ Em¦SzxP. 

Pmh® : 2  B2 P»zxUS ¤ßÁ¸® `zvµzvøÚ Em¦SzxP = B1 ^ 2 - 5 * B1 - 3
Pmh® : 3   B2 P»zvÝÒ Em¦Szv¯ `zvµzvøÚ K2 P»® Áøµ°À ¤µv   

       ö\´P.  
Pmh® : 4   uµÄ Ãa\õP A1 : K2 Ãaø\z öu›Äö\´P.

Pmh® : 5   Insert → Chart → XY scatter

E¸   7.47

E¸ 7.46
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£°Ø]

¤ßÁ¸® £ozuõøÍ¨ £¯ß£kzv R÷Ç EÒÍ ÂÚõUPÐUS Âøh u¸P'

1)  2, 6, 10, 14 GÝ® C»UP[PÐUS›¯ P»Ãa]øÚz u¸P.

2)  9, 10, 11, 12 GÝ® C»UP[PÐUS›¯ P»Ãa]øÚz u¸P.

3) 6, 7,  8, 9, 10, 11, 12   GÝ® C»UP[PÐUS›¯ P»Ãa]øÚz u¸P.

4)  A1 •uÀ  A4 Áøµ°»õÚ ö£Ö©õÚ[PÎß TmkzöuõøP°øÚ A5 CÀ 

ö£ØÖUöPõÒÁuØS P»•PÁ›°øÚ ©mk® £¯ß£kzxP.

5)  A3  •uÀ  D3  Áøµ°»õÚ  ö£Ö©õÚ[PÎß    TmkzöuõøP°øÚ    E3  

P»zvÝÒ  ö£ØÖUöPõÒÍ¨ ö£õ¸zu©õÚ `zvµzvøÚa  \õº¤øÚ¨ 

£¯ß£kzv GÊxP.

6)  E3 CÀ EÒÍ `zvµzvøÚ  E4 US ¤µvö\´²® •øÓ°øÚU SÔ¨¤kP.

7)  E5   P»zxUS  A1   •uÀ   D4  Áøµ°À   \µõ\›¨   ö£Ö©õÚzvøÚ  ö£ØÖU  

öPõÒÁuØS AÁ]¯©õÚ `zvµzvøÚ \õºö£õßÔøÚ¨ £¯ß£kzv 

GÊxP.

E¸  7.48
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ö\¯Ø£õk                                                  

Â›uõÒ ö©ßö£õ¸øÍ¨ £¯ß£kzv ¤ßÁ¸® £ozuõÎøÚ Aø©UP. 

£Ÿmø\USz ÷uõØÓõu ©õnÁºPÐUS ab GÚ SÔUP¨£mkÒÍx.

µ®¯õ

AßÁº

÷Áo

öá¯¢v

{íõµõ

£õ¦

Pou® ÂgbõÚ® B[Q»® Áµ»õÖ uªÌ

uÛö¯õ¸  \õº¤øÚ  £¯ß£kzv  E›¯  `zvµ[PøÍ  Aø©USP.

1) µ®¯õ ö£ØÖUöPõsh ¦ÒÎPÎß  ö©õzuzvøÚ AÔÁuØS ö£õ¸zu©õÚ  

`zvµzvøÚ G2 P»zvÝÒ Em¦SzxP.

2) µ®¯õ ö£ØÖUöPõsh ¦ÒÎPÎß \µõ\›°øÚU Po¨£uØS ö£õ¸zu©õÚ    

   `zvµzvøÚ  H2 P»zvÝÒ Em¦SzxP. 

3) Pou¨ £õhzvÀ ©õnÁºPÒ ö£ØÖÒÍ ¦ÒÎPÎÀ Av Ti¯ ¦ÒÎ°øÚ  

   ÷uº¢öukUP ö£õ¸zu©õÚ `zvµzvøÚ B9  P»zvÝÒ Em¦SzxP.

4) ©õnÁºPÒ JÆöÁõ¸ £õhzv¾® ö£ØÖÒÍ ªPUSøÓ¢u ¦ÒÎPøÍ 

   AÔ¢x öPõÒÁuØS ö£õ¸zu©õÚ ̀ zvµzvøÚ B10 P»zvÝÒ Em¦SzxP.

5) JÆöÁõ¸ £õhzxUS® ÷uõØÔ¯ ©õnÁºPÎß GsoUøP°øÚ AÔ¢x 

   öPõÒÁuØS ö£õ¸zu©õÚ `zvµzvøÚ B11 P»zvÝÒ Em¦SzxP.

6) JÆöÁõ¸ £õhzv¾® ©õnÁº ö£ØÖÒÍ \µõ\› ¦ÒÎPøÍ AÔ¢x 

   öPõÒÁuØS ö£õ¸zu©õÚ `zvµzvøÚ B12 P»zvÝÒ Em¦SzxP.

E¸  7.49
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ö£õÈ¨¦

²   {µÀPÒ (Columns) ©ØÖ® {øµPÒ (Rows)  GÚ  Aø©¢xÒÍ  P»z öuõSv°ß  

‰»® £ozuõÒ  (Work Sheet) Aø©UP¨£mkÒÍx.

²  £ozuõÎß {µÀPÒ B[Q» ÷£öµÊzvß ‰»©õP÷Áõ GÊzxzöuõSv 

‰»©õP÷Áõ SÔUP¨£k®.

²  £ozuõÎß {øµPÒ C»UP[PÍõÀ ö£¯º SÔUP¨£k®.

² •u¼À {µÀPÎß GÊzxUPøÍ²® Akzx {øµPÎß C»UP[PøÍ²® 

Em¦Szv P»zxUPõÚ ö£¯º SÔ¨¤h¨£k®. Ax P»•PÁ› GÚ¨£k®.

² EÒÍhUP® •P¨¦ Aøh¯õÍ® (Label), ö£Ö©õÚ® (Values) AÀ»x 

`zvµ[PÒ (Formula), ÷£õßÓÁØÔÀ HuõÁx JßÔøÚU öPõsi¸US®.

² `zvµ® (=) \©ß Aøh¯õÍzøu Bµ®£©õPU öPõsk Aø©²®.

² Poua ö\´øPPÐUS (Operators) •ßÝ›ø© JÊ[S EÒÍx.

² `zvµ[PøÍ GÊu P»•PÁ› C¯UPUSÔ ©ØÖ® \õº¦ Gß£Ú    

£¯ß£kzu¨£k®.

² `zvµ® JßÔøÚ C»SÁõP¨ ¤µvö\´ÁuØS {µ¨¦¨ ¤i°øÚ¨ (Fill 

handle) £¯ß£kzu»õ®. 

² \õº¦U P» EÒÏmiøÚ JßÔøÚ (Relative Cell Reference) •ØÖÖ ö\´ÁuØS  

(Absolute) öhõ»º Aøh¯õÍ® ($)  £¯ß£kzu¨£k®.

²  uµÄPøÍ¨ ¦ÒÎÂÁµ Ai¨£øh°À ÂÍUSÁøu Âh Áøµ¦PÒ FhõP 

ÂÍUSÁx C»SÁõÚuõS®.
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C»zvµÛ¯À   {PÌzxøP8

 

S©õº : ~íõ..... C®•øÓ G©x uPÁØ öuõÈÝm£z vÚzvß÷£õx 

Põm]¨£kzuöÁÚ G©x £õh\õø»°ß Áµ»õÖ ©ØÖ® uPÁÀ 

öuõÈÝm£ £¯ß£õk £ØÔ ]Ó¢u J¸ BUPzvøÚ öuõÈÝm£ Eu-

Â²hß u¯õ›US®£i G©x B]›¯º SÔ¨¤mhõº.

~íõ : S©õº.... A¨£iö¯ßÓõÀ öuõÈÝm£z vÚzvØS |õ® GßÚ 

ö\´Áx? 

S©õº : |õ® AøÚÁ¸® Cøn¢x ]Ó¢u C»zvµÛ¯À {PÌzxøPø¯z 

u¯õ›UP»õö©Ú {øÚUQ÷Óß. A¨£i¯õ°ß, G©x £õh\õø» 

°¾ÒÍ £À¿hP GÔøÁø¯¨  (Multimedia Projector) £¯ß£kzv 

ö£õx©UPÐUSU Põs¤UPÄ®  •i²®.

~íõ : Ax |À»x, G©x B]›¯›ß C»UP•øÓU P©µõÂß (Digital Camera) 
‰»® £õh\õø»°ß •UQ¯ Ch[PøÍ¨ £h® GkUPÄ® •i²®.  

]» {PÌÄPøÍ JÎ²¸ (PõönõÎ (Video)) ‰»® Põs¤UPÄ®  

•i²®.

S©õº : B® ~íõ, Ax©mk©À» G©x £õh\õø»°ß C»a]øÚ, öPõi 

÷£õßÓÁØøÓ Aø\Åmh® ö\´x AÇQ¯ £hÂÀø»PÍõP 

Aø©UPÄ®  •i²®.

C¨£õhzøuU PØÓ ¤ßÚº }[PÒ

 ² {PÌzxøP £ØÔ¯ AÔ•P®

 ² C»zvµÛ¯À  {PÌzxøP°ß C¯À¦PÒ

 ² {PÌzxøP ö©ßö£õ¸ÒPÎÀ EÒÍ Ai¨£øh A®\[PøÍ¨ £¯ß 

£kzv PÁºa]Pµ©õÚ GÎ¯ C»zvµÛ¯À {PÌzxøPPøÍ E¸ÁõUSuÀ

 ² £hÂÀø»¨ ¤ßÚo, £hÂÀø»¨ £iÁ®, £hÂÀø» ©õv› ÁiÁ® 

Gß£ÁØøÓ J¸[QønzuÀ

 ² C»zvµÛ¯À {PÌzxøP°¼¾ÒÍ £hÂÀø»PÎÝÒ ö£õ¸zu©õÚ 

E¸Á[PÒ AÀ»x Põm]PøÍ Em¦SzuÀ

 ² C»zvµÛ¯À {PÌzxøPPÎÀ Aø\Åmh[PøÍ Em¦SzuÀ

Gß£Ú  £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À266 267

~íõ : Azxhß C»zvµÛ¯À {PÌzxøP°ß  Aa]h¨£mh ¤µv JßÔ 

øÚ²® ]Ó¨¦ AvvPÐUS ÁÇ[P •i²® AÀ»Áõ?

S©õº : B® ~íõ,  J¸ ]Ó¢u C»zvµÛ¯À {PÌzxøP JßøÓ u¯õ›¨£x 

GÆÁõÖ Gß£x £ØÔ C¨÷£õ÷u |õ® B]›¯›h®  ÷Pmk AÔ¢x 

öPõÒ÷Áõ®.  

8.1  {PÌzxøP AÔ•P®

 Presentation  Gß£x ""{PÌzxøP'', ""AÔUøP    AÎUøP'', ""•ß øÁzuÀ'', 

""\©º¨¤zuÀ'' ÷£õßÓ £À÷ÁÖ P¸zxUPÎÀ ÂÍUP¨£kQßÓx. ""SÔ¨¤mh 

J¸ |£º AÀ»x £»º u©x  Gsn[PÒ, P¸zxUPÒ ©ØÖ® AÔÂøÚ J¸ 

ö£¸® Tmhzuõ¸hß £›©õØÔU  öPõÒÁuØPõP ÷©ØöPõÒÍ¨£k® •¯Ø]'' 

{PÌzxøP GÚ¨£k®. Ca\¢uº¨£zvÀ AÁºPÒ £À÷ÁÖ ~m£[PÒ, A[P 

Aø\ÄPÒ ©ØÖ® E£Pµn[PøÍ¨ £¯ß£kzv £õºøÁ¯õÍºPøÍ AÔÄÖzu 

•¯Ø]UQßÓÚº. 

              

E¸ 8.1 ÷©¢uø» GÔøÁ

 Asø©U Põ»zvÀ ö£›x® £¯ß£kzu¨ 

£k® E£Pµn[PÍõP ÁÊUQ GÔøÁ (Slide 
projector) ©ØÖ® ÷©¢uø» GÔøÁ (Over-
head projector) Gß£ÁØøÓU SÔ¨¤h»õ®. 

÷©¢uø» GÔøÁ°ß £¯ß£õmiøÚ Âh 

ÁÊUQ GÔøÁ°ß £¯ß£õk Âzv¯õ\©õÚx. 

Â›Äøµö¯õßÔß÷£õx ÂÍUPzxUPõP¨ £¯ß 

£kzu¨£k® Fk¦PÂk® uõÒPøÍ (Transpar-
ency Sheet) E¸ 8.1 CÀ  Põmh¨£mkÒÍÁõÖ 

÷©¢uø» GÔøÁ°À £¯ß£kzu •iÁ÷uõk 

AvÀ ÷uøÁ¨£iß GÊv ÂÍUP©ÎUPÄ® 

•i²®. BÚõÀ, u¯õ›UP¨£mh Fk¦PÂk® uõÒPøÍ «Í¨ £¯ß£kzu 

•i¯õx. Azxhß Aø\ÅmhzvøÚ  AÀ»x J¼°øÚ HØ£kzu •i¯õx. 

BÚõÀ, CuøÚ C»SÁõP £¯ß£kzu •i²®. CÆÁõÖ öuõÈÝm£ 

E£Pµn[PøÍ¨ £¯ß£kzv BUP§ºÁ©õÚ {PÌzxUPøÍ ÷©ØöPõÒÐ® 

\¢uº¨£[PÒ AvP›zxÒÍÚ. ÁÊUQ GÔøÁø¯ £¯ß£kzx®÷£õx E›¯ 

£hÂÀø»ø¯ u¯õ›¨£uØöPÚ ÷©»vP •¯Ø]PøÍ ÷©ØöPõÒÍ ÷Ási 

HØ£kQßÓx. ¦øP¨£h® JßÔøÚ¨ ¦øP¨£h B´ÄUThzvÀ «Í  

JÊ[Pø©zuuß ¤ßÚ÷µ CÆÄ£PµnzvÚõÀ £¯ß£kzu•i²®. GÛÝ®, 

CvÀ Aø\²® £h[PøÍ²® J¼°øÚ²® Em¦Szu •i¯õx. 

 PoÛ öuõÈÝm£ ©ØÖ® C»zvµÛ¯À öuõÈÝm£ •ß÷ÚØÓzvß 

ÂøÍÁõP JÎ²¸U  P©µõ (Video Camera) ©ØÖ® £À¿hP GÔøÁ (Multimedia 
projector) ÷£õßÓÁØøÓ¨  {PÌzxøP¯õÍºPÒ £¯ß£kzxQßÓÚº. 
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E¸ 8.2  ÁÊUQ GÔøÁ

£À¿hP GÔøÁ ‰»® {PÌzxøPPøÍ {PÌzx® 

£¯ß£õk uØPõ»zvÀ ¤µ£À¯® Aøh¢xÒÍx. 

CuøÚ¨ £¯ß£kzv ÷©ØöPõÒÍ¨£k® {PÌzx-

øPPÒ ªPU SÖQ¯Põ» GÀø»USÒ {øÓÁøh-

QßÓÚ. £À¿hP[PÒ GÚ CÚ[Põmh¨£k® 

C»UP[PÒ,  GÊzxUPÒ,  £h[PÒ,     ]zvµ[PÒ,                                              

£i©[PÒ  (Images),  AmhÁønPÒ, Áøµ¦PÒ, 

J¼PÒ  ©ØÖ® Aø\Åmh[PÐ® JÎ²¸UPÐ® 

(Animations and Videos) ÷£õßÓÁØøÓ C»zvµÛ¯À {PÌzxøPPÎÝÒ Em 

¦Szu •iQßÓÚ.

                       

E¸ 8.3  £À¿hP GÔøÁ 

    CÆÁõÖ E¸ÁõUP¨£k® {PÌzxøPPÒ  

£À¿hP C»zvµÛ¯À {PÌzxøPPÒ  GÚ 

AøÇUP¨£kQßÓÚ. £À¿hP C»zvµÛ¯À 

P¸ÂPÒ   |ÃÚ   öuõÈÝm£     ÁÍºa]°ß 

Põµn©õP  ªPa]Ô¯   ÁiÁzv¾®  £À÷ÁÖ 

Á\vPÐhÝ® Aø©¯¨ ö£ØÖÒÍÚ.

 ö\¯Ø£õk

1. \õuõµn {PÌzxøPUS® C»zvµÛ¯À {PÌzxøPUS® 

Cøh°»õÚ Âzv¯õ\[PøÍ ÂÍUQ, Av¾ÒÍ |ßø© 

wø©PøÍ GkzxU Põmk® AmhÁønø¯z u¯õ›USP.

2. }[PÒ SÔ¨¤mkÒÍ |ßø©PøÍ E©x PÀÂ |hÁiUøP 

PÎß÷£õx GÆÁõÖ £¯ß£kzu»õö©ß£øu GÊxP.

8.2   uµ©õÚ C»zvµÛ¯À {PÌzxøP JßÔß C¯À¦PÒ

 |õ® •ßøÁUS® P¸zxUPøÍ E›¯ •øÓ°À £õºøÁ¯õÍºPÒ ÂÍ[QU 

öPõÒÁuØS  C»zvµÛ¯À {PÌzxøPö¯õßÖ AÁ]¯©õS®. C»zvµÛ¯À 

{PÌzxøPö¯õßÔß EÒÍhUP® öuõhº£õPU Ti¯ PÁÚ® ö\¾zxÁuß 

‰»® Auß uµzvøÚ AvP›zxU öPõÒÍ•i²®. CzuµzvøÚ AvP›UPz 

÷uøÁ¨£k® Âh¯[PÒ GßÚöÁß£x £ØÔU R÷Ç P»¢xøµ¯õk÷Áõ®.

* EÒÍh[Q°¸UP ÷Ási¯ ÁõUQ¯[PÒ ©ØÖ® Á›ø\PÎß  AÍÄ

 GÊzxUPÎß  AÍøÁ¨ ÷£õ»÷Á £hÂÀø» (Slide) JßÔÝÒ EÒÍh[P

 ÷Ási¯ ÁõUQ¯[PÎß GsoUøP²® •UQ¯©õS®. J¸ £hÂÀø» 

°ÝÒ  ö£¸®£õ¾®  BÖ  •uÀ  Jß£x  Áøµ°»õÚ ÁõUQ¯[P÷Í 

EÒÍhUP¨£mi¸UP ÷Ásk®. CuØS ÷©»vP©õP ÁõUQ¯[PøÍ 
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EÒÍhUS®÷£õx GÊzxUPÎß AÍÄ ]ÔuõQ £õºøÁ¯õÍºPÍõÀ                         

Áõ]zx ÂÍ[QUöPõÒÍ •i¯õu {ø» HØ£k®.

* GÊzxUPÎß AÍÄ

 C»zvµÛ¯À {PÌzxøP £hÂÀø»°ÝÒ Ah[SQßÓ ÁõUQ¯[PÒ, 

GÊzxPÎß AÍÄ ©mk©ßÔ {PÌzxøPUS® £õºøÁ¯õÍºPÐUS©õÚ 

CøhöÁÎ Gß£ÚÄ® •UQ¯©õS®. GÊzxUPÎß AÍÄ 32 Points AÀ»x 

AøuÂh¨ ö£›uõP C¸UP÷Ásk®. A¨÷£õx {PÌzxøP°À EÒÍ 

Âh¯[PøÍ¨ £õºøÁ¯õÍºPÒ öuÎÁõP Áõ]UP •i²®.

 ]Ôx ]¢v²[PÒ }[PÒ AÁuõÛzu C»zvµÛ¯À {PÌzxøPPÎÀ 

C[S SÔ¨¤h¨£mkÒÍ Âh¯[PÒ G¢u AÍÄ ÷£n¨£mi¸¢uÚ Gß£øu 

]¢vzx¨ £õ¸[PÒ. GvºPõ»zvÀ }[PÒ Põn¨÷£õS® {PÌzxøPPÎÀ Th, 

CøÁ G¢u AÍÄ ÷£n¨£mkÒÍÚ Gß£øu¨ £›^¼UPz uÁÓõwºPÒ. 

*  GÊzx ÁiÁ•® ö©õÈ¨ ¤µ÷¯õP•® 

 u¯õ›UP¨£mh C»zvµÛ¯À {PÌzxøPPÎÀ £¯ß£kzu¨£mkÒÍ 

GÊzxUPÐ® ö©õÈ|øh²® ¤øÇ°ßÔz öuÎÁõPU Põn¨£kQßÓÚÁõ 

Gß£øu AÁuõÛUP ÷Ásk®.

* £h[PÒ, ]zvµ[PÒ,  AmhÁønPÒ  ©ØÖ® Á›¨£h[PøÍ  Em¦SzuÀ

 £h[PÒ, ]zvµ[PÒ, AmhÁønPÒ, Á›¨£h[PÒ ÷£õßÓÁØøÓ Em 

¦SzxÁuõ°ß,  J¸ £hÂÀø»°ÝÒ BPUTi¯x Cµsøh ©õzvµ÷© 

Em¦Szu •i²®. AuØS ÷©»vP©õP CÁØøÓ Em¦SzxÁuß ‰»® 

öuÎÂßø© HØ£k®.

* {Ó[PøÍ¨ £¯ß£kzuÀ 

 C»zvµÛ¯À {PÌzxøP°ß÷£õx £¯ß£kzu¨£k® {Ó[PÐ® ªP 

•UQ¯©õS®. •UQ¯©õÚ Âh¯[PøÍ Pk®{Ó[PÒ (Dark Colour), 
ui¨£õÚ GÊzxUPÒ ©ØÖ® Âzv¯õ\©õÚ GÊzx ÁiÁ[PÒ ‰»® 

öuÎÄ£kzu»õ®. ]Á¨¦ Áºnzøu £hÂÀø» •ÊÁx® £¯ß£kzxÁx 

£õºøÁ¯õÍºPÐUS Aö\ÍP›¯©õS®. BÚõÀ, •UQ¯©õÚ J¸ Âh¯zøu, 

GÊzøu, Aøh¯õÍzøu ]Á¨¤À PõmkÁx ¤øÇ¯ßÖ. GÆÁõöÓÛÝ® 

{Ó[PøÍ¨ £¯ß£kzxÁx ÷£õ»÷Á AÁØÔß ö£õ¸zu¨£õk £ØÔ²®  

PÁÚzvÀ öPõÒÍ÷Ásk®.

* Aø\Åmh® ©ØÖ® JÎ²¸UPÒ 

 Aø\Åmh®  ©ØÖ®  JÎ²¸UPøÍ  (Animations  and  Videos)  Em¦Szx-

Áuõ°ß   J¸  £hÂÀø»°À  JßøÓ  ©õzvµ® Em¦SzxÁx ö£õ¸zu©õÚ

 uõS®. CÀø»ö¯ÛÀ AÁØÖUS Em¦Szv²ÒÍ J¼°ß uõUPzvÚõÀ 

£õºøÁ¯õÍºPÐUS Aö\ÍP›¯[PÒ HØ£k®.
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* ÷|õUP[PøÍU P¸zvØ öPõÒÍÀ 

 £À¿hPzøu £¯ß£kzx®÷£õx £õºøÁ¯õÍºPÎß ÷|õUP[PøÍ P¸z-

vÀ öPõÒÍÀ •UQ¯©õS®. C»zvµÛ¯À {PÌzxøP ‰»® Gvº£õºUS® 

P¸zxPÐUS ¦Ó®£õP Âzv¯õ\©õÚ Âh¯[PÎß £UP® £õºøÁ¯õÍºPøÍ 

vø\v¸¨£õu Âu©õP £À¿hP[PÎß EÒÍhUP® C¸zuÀ AÁ]¯®. 

Euõµn©õP Aø\Åmh[PøÍ AÍÄUPvP©õP¨ £¯ß£kzxÁuß ‰»® 

£õºøÁ¯õÍºPÎß PÁÚ® vø\v¸¨£¨£mk {PÌzxøP°Ò ÷|õUP[PÒ 

{øÓ÷ÁÓõ©À ÷£õP»õ®. 

 ö\¯Ø£õk

1. £À¿hP C»zvµÛ¯À {PÌzxøP°øÚz u¯õ›US®÷£õx 

AÁØÔß uµzxUS ÷©»vP©õP ÷©¾® AvÀ EÒÍh[P 

÷Ási¯ •UQ¯©õÚ Âh¯[PøÍ Bµõ´¢x £mi¯Ø 

£kzxP.

2. A¨£mi¯ø»¨ £¯ß£kzv uµ©õÚx® BUP§ºÁ©õÚx©õÚ 

C»zvµÛ¯À {PzxøPPøÍz u¯õ›US® •øÓ £ØÔ \÷Põuµ 

©õnÁºPøÍ AÔÅmhöÁÚ C»zvµÛ¯À {PÌzxøPø¯z 

     
u¯õ›UP. 

8.3  C»zvµÛ¯À {PÌzxøP ö©ßö£õ¸Ò (Presentation Software) 
  

 C»zvµÛ¯À   {PÌzxøP  ö©ßö£õ¸Ò Gß£x J¸ SÔ¨¤mh uø»¨¦ 

AÀ»x {PÌÄ öuõhº£õP öuõSUP¨£mh Âh¯[PøÍ JÊ[S •øÓ¯õP 

HøÚ÷¯õ¸US GkzxøµUP EuÄ® £À¿hP ußø©PøÍ EÒÍhUQ¯ PoÛ 

ö©ßö£õ¸Ò BS®.

 ¤µ£À¯©õÚ C»zvµÛ¯À {PÌzxøP ö©ßö£õ¸ÒPÒ £» Põn¨£k 

QßÓÚ. CÁØÖÒ C»Á\©õP¨ ö£ÓzuUP ö©ßö£õ¸ÒPÒ (Free and Open 
Source Software) GÚÄ®  £n® ö\¾zv ö£ÓzuUP ö©ßö£õ¸ÒPÒ (Commercial 
Software) GÚÄ®  C¸ ÁøPPÒ EÒÍÚ.

 CuØS ÷©»vP©õP E[PÍx PoÛ°À A¾Á»P ö©ßö£õ¸Ò                       

(Office Software) EÒÍhUP¨£mi¸UPõÂiß E[PÐUS C»zvµÛ¯À {PÌzx-

øPø¯  u¯õ›¨£x  PiÚ©õS®.   GÛÝ®,    Cøn¯uÍzvÝÒ   ¤µ÷Á]zx 

Cloud Services Cß EuÂ²hß AuØPõÚ Á\vPøÍ¨ ö£ØÖUöPõÒÍ •i²®. 

Euõµn©õP Ms Office 365 PowerPoint , Google Presentation,   Microsoft sky Drive 
PowerPoint ÷£õßÓ HuõÁx JßÔÀ ¤µ÷Á]zx E©x ÷uøÁø¯ {øÓÄ ö\´x 

öPõÒÍ»õ®. Ax©mk©ßÔ E›¯ ÷PõøÁø¯a ÷\ªUS® (Save)  Á\vPÐ® 

CÁØÔÀ Põn¨£kQßÓÚ.
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ö©ßö£õ¸Îß ö£¯º EØ£zv {ÖÁÚ®
vÓ¢u ©ØÖ® C»Á\©õÚuõ? / 

£n® ö\¾zu ÷Ási¯uõ?

Apple Keynote Apple Inc. £n® ö\¾zu ÷Ási¯x

Corel Presentation Corel Corporation £n® ö\¾zu ÷Ási¯x

LibreOffice Impress Document Foundation C»Á\ ö©ßö£õ¸Ò

Microsoft PowerPoint Microsoft Corporation £n® ö\¾zu ÷Ási¯x

Open Office. org Impress Apache Corp. C»Á\ ö©ßö£õ¸Ò

Cøn¯zvÝÒ ¤µ÷Á]zx ÷©÷» EÒÍ ö©ßö£õ¸ÒPÎß ]Ó¨¦U 

PøÍ Bµõ´¢uÔP.

8.4  C»zvµÛ¯À   {PÌzxøP   ö©ßö£õ¸ÒPÎÀ   EÒÍ 

Ai¨£øh  A®\[PÒ

 A¾Á»P ö©ßö£õ¸Ò öuõSv JßÔ¾ÒÍ Microsoft PowerPoint ‰»•® 

LibreOffice öuõSv°¾ÒÍ Impress C»zvµÛ¯À {PÌzxøP ö©ßö£õ¸ÒPÒ 

‰»•® FhõPÄ® C»zvµÛ¯À {PÌzxøP JßøÓ GÆÁõÖ u¯õ›U  

P»õö©Ú  R÷Ç Põmh¨£mkÒÍx.

Microsoft Office PowerPoint CøÚ Bµ®¤zuÀ 

MS PowerPoint 2010 I ¤ßÁ¸©õÖ Bµ®¤UP»õ®.

Start  All programs   Microsoft Office  Microsoft Office PowerPoint 2010 (£oö\¯À 

•øÓø©UPø©¯ ÷ÁÖ£h»õ®).

1' ÂøµÁõP ~øÇ²® 

P¸Â¨£møh

  (Quick Access Tool Bar)

2' uø»¨¦¨       

    £møh           

(Title Bar)

6' £o°h¨      

      £µ¨¦        

 (Workspace)

7' öPõÒ£o

     \õÍµ AkUS                           

       (Task Pane)

8'  SÔ¨¦¨  

      \õÍµ AkUS    

  (Notes Pane)

10' Põm]

      uzuÀ          

   (View Tab)

4' |õhõ       

  (Ribbon)

11' E¸UPmk¨     

    £õmkU P¸Â

     (Zoom Control)

P¸Â¨

£møh 

(Tool Bar)

3' uzuÀPÒ                      

    (Tabs)

5' £hÂÀø»

    \õÍµ AkUS

    (Slide Pane)

9' {ø»ø©¨   

    £møh

    (Status Bar)

E¸ 8.4  Microsoft PowerPoint  2010    Cß Cøh•P®
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 ÷©÷», E¸ 8.4 CÀ C»zvµÛ¯À {PÌzxøP ö©ßö£õ¸Îß Cøh         

•PzvÀ EÒÍ £mi¯À ©ØÖ® P¸Â¨£møhPÒ  (Tool bars) ]» Põmh¨£m-

kÒÍÚ. CvÀ EÒÍ £À÷ÁÖ PmhøÍPÒ ö\õÀ•øÓ ÁÈ¨£kzuÀ 

ö©ßö£õ¸Î¾® Ch®ö£ÖQßÓÚ. 

1. ÂøµÄ ~øÇÄU P¸Â¨£møh (Quick  Access  Tool  Bar)

 Cx uø»¨¦ {øµ°ß Ch¨£UP ‰ø»°À Aø©¢xÒÍx. Cx C»SÁõ 

PÄ® ÷ÁP©õPÄ® C¯[PU Ti¯x. AiUPi ÷uøÁ¨£k® Âh¯[PøÍ 

CuÝÒ ÷uUQ øÁUPUTi¯ Á\vPÒ ö\´¯¨£mkÒÍÚ. uø»¨¦ {øµ°ß 

Á»¨£UP A®¦zuø»°øÚ RÌ÷|õUQa ö\¾zxÁuÚõÀ QøhUS® 

£mi¯À ‰»® ÷©¾® £» Âh¯[PøÍa ÷\ºzxU öPõÒÍ •i²®. 

CuøÚ¨ £¯|›ß  ÷uøÁU÷PØ£ ©õØÔU öPõÒÍ•i²®.

2. uø»¨¦¨ £møh (Title Bar)

 Cøh•P¨¤ß •u»õÁx {øµ°À Cx Põn¨£kQßÓx. ö©ßö£õ¸Îß 

ö£¯º ©ØÖ® vÓUP¨£mkÒÍ {PÌzxøP°ß ö£¯º Gß£Ú CvÀ 

Põm]¨£kzu¨£k®. vøµ°ß ]ÔuõUPÀ ö£õzuõß (Minimize), ö£› 

uõUPÀ ö£õzuõß (Maximize),  ‰k ö£õzuõß (Close) ÷£õßÓÚ Á»x£UP 

÷©À ‰ø»°À Põn¨£k®.

3. uzuÀ (Tab)

ö©ßö£õ¸ÎÀ Põn¨£k® P¸Â¨£møh, |õhõ (Ribbon) GÚ AøÇU 

P¨£k®. |õhõÂÀ EÒÍ JÆöÁõ¸ uzuÀPÐUS® E›¯ C»a]øÚPÒ 

£hÄ¸UPÍõP (Icons) öuß£k®. Euõµn©õP Home GÝ® £Sv°À £» 

¤›ÄPÒ Põn¨£kQßÓÚ. CvÀ J¸ ¤›÷Á GÊzx¸UPÒ BS®. CuÝÒ÷Í 

GÊzx¸UPÐUS›¯ £» P¸ÂPÒ Põn¨£k®. (E¸ 8.5 I¨ £õºUP). 
C»SÁõP £¯ß£kzuzuUP Âu©õP C¢u |õhõ u¯õ›UP¨£mi¸UQÓx.

4.  |õhõ (Ribbon)

 £mi¯À (Menu) BÚx  ªP C»SÁõP £›^¼UP •i²©õÚ Âu©õPz 

u¯õ›UP¨£mkÒÍx. C[S JÆöÁõ¸ Âh¯zxUS® ÷uøÁ¯õÚ 

£hÄ¸UPÒ (Icons) öuÎÁõPU Põn¨£kÁ÷uõk AøÁ J¸ SÊ©©õPÄ® 

öuß£kÁx Cuß ]Ó¨£®\©õS®. ÷©¾®, AÁØÔß ö\¯Ø£õkPÒ 

C»SÁõUP¨£mkÒÍ÷uõk £›^»øÚ ö\´ÁuØS ö£õ¸zu©õPÄ® 

EÒÍx.

E¸  8.5 - Ribbon
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5.  £hÂÀø» \õÍµ AkUS  (Slide Pane)   

\õÍµzvß Ch¨£UP ÷©À ‰ø»°À Cx Aø©¢xÒÍx. CuøÚ ÷uº¢ 

öukUS®÷£õx   \mhP®   ªPa  ]ÔuõP÷Á   öuß£k®.  ÷uøÁ¯õÚ ]Ô¯

\mhPzvß «x _miø¯a ö\õhUS®÷£õx ö£›uõQ E›¯ £ha\mhP® 

öuß£k®. A¨÷£õx E›¯ \mhPzvøÚ ÁiÁø©UP÷Áõ {øÓÄ ö\´¯ 

÷Áõ •i²®.

6.  £o°h¨£µ¨¦ (WorkSpace) 

C»zvµÛ¯À {PÌzxøP CÆÂhzv÷»÷¯ u¯õ›UP¨£kQßÓx.

7. öPõÒ£o \õÍµ AkUS (Task Pane)  

C»zvµÛ¯À {PÌzxøP u¯õ›UP¨£k®÷£õx ©õØÖ ÁÈPøÍ ÷uº¢                                                                                                                            

öukUP Ca\õÍµ® •UQ¯©õS®.  Euõµn©õP Aø\Åmh[PøÍ Em 

¦Szx ÁuØS Cx AÁ]¯¨£kQßÓx.

8. SÔ¨¦ \õÍµ AkUS (Notes Pane)

Cx  C»zvµÛ¯À {PÌzxøPUS›¯  £hÂÀø»°À ÷uøÁ¨£k® 

SÔ¨¦UPøÍ GÊu¨ £¯ß£kzu¨£k®. CÆÁõÖ Em¦Szu¨£k® 

SÔ¨¦UPÒ {PÌzxøP°ß÷£õx ö£¸®£õ¾® £õºøÁ¯õÍºPÐUSz 

öuß£h©õmhõx 

9.  {ø»ø©¨ £møh (Status Bar)

C»zvµÛ¯À {PÌzxøP°À u¯õ›UP¨£mkÒÍ £hÂÀø»PÎß Gs 

oUøPÒ,  uØ\©¯®  ÷uº¢öukUP¨£mkÒÍ £hÂÀø»°ß C»UP®, 

ö©õÈ ‰»® BQ¯Ú CvÀ öuß£k®.

10.  Põm]z uzuÀ (View Tab)

MS Office \mhPzvÀ £hÂÀø»  öuß£k® ÂuzvøÚ  C¢uU Põm]z 

uzu¼¾ÒÍ  £hÄ¸ (Icon) ‰»® ©õØÔ¯ø©UP •i²®. CuøÚ ¤ßÁ¸® 

£hzvß ‰»® ÂÍUP¨£mkÒÍx.

E¸ 8.6  Põm]z uzuÀ (View Tab)

 \õuõµn £õºøÁ 

(Normal View)
£hÂÀø»°ß Á›ø\¨ 

£kzuÀ £õºøÁ

(Slide Sorter View)

 •Êø©¯õÚ

£õºøÁ  (Slide Show)

Áõ]¨¦¨ £õºøÁ 

(Reading View)
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* \õuõµn £õºøÁ (Normal view) : Cøh•P¨¤À  £hÂÀø» CÆÁõ÷Ó 

öuß£k®. C¢u \õuõµn £õºøÁ°À C¸¢x \õuõµn {PÌzxøP°øÚz 

u¯õ›UP»õ®.

* £hÂÀø»°ß Á›ø\¨£kzuÀ £õºøÁ (Slide sorter view) : {PÌzxøP°ÝÒ 

Ah[Q²ÒÍ \P» £hÂÀø»PÐ® ]ÔuõPz öuß£k®. Cuß ‰»® 

AÁØÔß Á›ø\ø¯  ÷uøÁ¨£iß ©õØÔ Aø©UP»õ®. «sk®                   

Normal View  CØS ö\À» ÷Áskö©ÛÀ, SÔzu £hÂÀø» «x C¸•øÓ 

ö\õhUSÁuß ‰»® AuøÚ¨ ö£ØÖU öPõÒÍ •i²®.

* Áõ]¨¦¨ £õºøÁ (Reading view) : ÷uº¢öukUP¨£mkÒÍ £h ÂÀø»°øÚ  

•Êø©¯õP Cuß‰»® £õºUP •i²®. £hÂÀø»°ÝÒ EÒÍ \P» uP 

ÁÀPøÍ²® CvÀ £õºUP»õ®. Cv¼¸¢x öÁÎ÷¯ÖÁuõ°ß Esc \õÂø¯ 

AÊzu ÷Ásk®.

* •Êø©¯õÚ £õºøÁ (Slide show) : uØ\©¯® ÷uº¢öukUP¨£mkÒÍ £h 

ÂÀø»°øÚ Cuß ‰»® •Êø©¯õP AÁuõÛUP •i²®. C»zvµÛ¯À 

{PÌzxøP°øÚ¨ £õºøÁ¯õÍºPÐUS •ßøÁUP Cx EuÄQßÓx. 

CuØS ÷©»vP©õP F5 \õÂ°øÚ AÊzxÁuß ‰»® {PÌzxøP°øÚ 

Bµ®£® •uÀ •Êø©¯õÚ £õºøÁ°À £õºøÁ°h»õ®.

11. E¸UPmk¨£õmkU P¸Â (Zoom control) : C»zvµÛ¯À {PÌzxøP°ß 

EÒÍhUPzøu  ö£›uõUQ²® ]ÔuõUQ²® £õºUP  EuÄ®.

  8.5  LibreOffice Impress  CøÚ Bµ®¤zuÀ

 ¤ßÁ¸® £i•øÓ ‰»® LibreOffice  4.1 C»zvµÛ¯À {PÌzxøP 

ö©ßö£õ¸øÍ E©US vÓ¢x öPõÒÍ •i²®.

Start  All programs  LibreOffice 4.1  LibreOffice lmpress (£oaö\¯À 

•øÓUPø©¯ ÷ÁÖ£k®).

 R÷Ç EÒÍ E¸ÂÀ LibreOffice ö©ßö£õ¸Ò öuõSv°ß •P¨¦ 

öuß£kQßÓx. Cv¾ÒÍ ö£¸®£õ»õÚ PmhøÍPÒ LibreOffice ö\õÀ•øÓ 

ÁÈ¨£kzuÀ ö©ßö£õ¸Î¾® Põn¨£kQßÓÚ. 
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2'  £mi¯Ø     

     £møh  

  (Menu Bar)

5' £o°h¨

£µ¨¦ (Work Space)

6' öPõÒ£o    

    \õÍµ  AkUS  

    (Tasks Pane)

 E¸ 8.7  - LibreOffice 4.1  Impress Cøh•P®

4' £hÂÀø» \õÍµ 

 AkUS (Slide Pane)

1' uø»¨¦¨ £møh 

     (Title Bar)

7' ÁøµuÀ P¸Â¨ 

£møh (Drawing Tool 
Bar)

8' {ø»ø©¨

   £møh 

   (Status Bar)

9' E¸UPmk¨

£õmkU P¸Â 

(Zoom Control)

3' {¯©U P¸Â¨£møh

    (Standard Tool Bar)

                         

1. uø»¨¦¨ £møh (Title Bar)

 •P¨¦a \mhPzvß •u»õÁx {øµ°À  Cx                                                

öuß£kQßÓx. CvÀ ö©ßö£õ¸Îß  ö£¯ ̧ ®, 

Põm]¨£kzu¨£mkÒÍ {PÌzxøP°ß ö£¯¸®  

Põm]¨£k®.  CuØS ÷©»vP©õP ]ÔuõUPÀ, 

ö£›uõUPÀ, ‰kuÀ BQ¯ ö£õz uõßPÒ Á»¨ 

£UP ÷©À •øÚ°À Põn¨£k®.

2. £mi¯Ø £møh (Menu Bar)

 C»zvµÛ¯À {PÌzxøP°øÚz u¯õ›¨£uØS 

AÁ]¯©õÚ \P» £mi¯ÀPøÍ²®  Cuß ‰»® 

ö£ØÖU öPõÒÍ»õ®.

3. {¯©U  P¸Â¨£møh (Standard Tool Bar)

 £mi¯Ø £møh°¾ÒÍ ]» £mi¯ÀPøÍ 

C»SÁõP £¯ß£kzu £hÄ¸UPÒ (Icons) C[S 

Em¦Szu¨£mkÒÍÚ. 

E¸ 8.8 öPõÒ£o \õÍµ AkUS   

(Tasks Pane)
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4. £hÂÀø» \õÍµ AkUS (Slide Pane)

 Cx •P¨¦z  vøµ°ß  Ch¨£UPzvÀ Aø©¢xÒÍx. CuøÚz ÷uº¢ 

öukzuõÀ  \mhP®  ªPa  ]ÔuõP÷Á  öuß£k®.  Cuß«x    _miø¯a 

ö\õhUQÚõÀ Ax ö£›uõS®.  CuÚõÀ  Ca \mhPzvß ‰»® £v¨¦PøÍ  

÷©ØöPõÒÍÄ® AuøÚ {øÓÄö\´¯Ä® •i²®. 

5. £o°h¨£µ¨¦ (Work Space)

 C»zvµÛ¯À {PÌzxøP°øÚ CvÀ u¯õ›UP»õ®.

6. öPõÒ£o  \õÍµ AkUS (Tasks Pane)

 Cx I¢x ¤›ÄPøÍU öPõshuõP EÒÍx. CÆ I¢x ¤›ÄPÐ® vøµ°À 

J÷µ ÷|µzvÀ Põm]¨£kÁvÀø». CøÁ JÆöÁõßøÓ²® Põm]¨£kzu 

E›¯ öPõÒ£oPÎß  «x ö\õhUP ÷Ásk®. (E¸ 8.8 I AÁuõÛUP).

* ¤µuõÚ £UP[PÒ (Master Pages) 

 C[S {PÌzxøP°ß ÁiÁzvøÚz u¯õ›UP •i²®. ö©ßö£õ¸Ò ‰»® 

u¯õ›UP¨£mh £hÂÀø»PÒ £» C[S Põn¨£k®.

* uÍU÷Põ»® (Layouts) : 

 HØPÚ÷Á u¯õ›UP¨£mh £hÂÀø»PÎß uÍU÷Põ»® (Layouts) ö©ß 

ö£õ¸ÎÝÒ÷Í ÷\P›UP¨£mi¸US®. ÷uøÁ¯õÚ÷£õx ÷uøÁ¨£k® 

£hÂÀø»PøÍz öu›Äö\´¯Ä®, «Ò ©õØÓ[PøÍa ö\´x  £¯ß 

£kzuÄ® •i²®.

* AmhÁøn ÁiÁ[PÒ (Table Design) : 

 C[S AmhÁønPøÍz u¯õ›¨£uØS›¯ ÁiÁø©¨¦UPøÍ¨ ö£ØÖU 

öPõÒÍ»õ®. Azxhß ÷uøÁ¯õÚ÷£õx ©õØÔ¯ø©zxU öPõÒÍÄ® 

•i²®. 

* uÛ¨£¯ß Aø\Åmh[PÒ (Custom Animation) :

 £h ÂÀø»°ÝÒ EÒÍ Á\Ú[PÒ, ]zvµ[PÒ, Põm]PÒ ÷£õßÓÁØøÓ 

£»Âu©õÚ Aø\Åmh[PøÍa ö\´x  Põm]¨£kzu •i²®. ÷uøÁU÷PØ£ 

Aø\Åmh[PøÍa ÷\ºUPÄ®,  }UPÄ®, ©õØÓÄ® •i²®.
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* £hÂÀø»  {ø»©õÓÀ (Slide Transition) : 

 J¸ £hÂÀø»°¼¸¢x CßöÚõ¸ £hÂÀø»US  ©õÖÁuØS £À÷ÁÖ 

ÁÈ•øÓPÒ Põn¨£kQßÓÚ. CuØS¨ ö£õ¸zu©õÚ ©õØÖ   ÁÈPøÍ  

Cuß‰»® ö£ØÖUöPõÒÍ •i²®. ÷ÁP®, J¼, £hÂÀø»PÎß 

ußÛaø\¯õÚ £›©õØÓ® ÷£õßÓÁØøÓ  Cuß‰»® ÷©ØöPõÒÍ»õ®.

7. ÁøµuÀ  P¸Â¨ £møh (Drawing Tool Bar) 

 {PÌzxøP°À «x £À÷ÁÖ ÁiÁ[PøÍ Áøµ¯ AÁ]¯©õÚ P¸ÂPøÍ 

Cuß ‰»® ö£ØÖU öPõÒÍ•i²®.

8. {ø»ø©¨ £møh (Status Bar) 

 u¯õ›UP¨£mkÒÍ {PÌzxøPPÎ¾ÒÍ £hÂÀø»PÎß GsoUøP, 

uØ\©¯® ÷uº¢öukzxÒÍ £hÂÀø»°ß  Gs, ÷uº¢öukzxÒÍ ö©õÈ, 

E¸UPmk¨£õmkU P¸Â ÷£õßÓÚ CvÀ öuß£k®.

E¸ 8.9  {ø»ø©¨ £møh (Status Bar)

9. E¸UPmk¨£õmkU P¸Â (Zoom Control)

 C»zvµÛ¯À {PÌzxøP°¾ÒÍ EÒÍhUPzøu ö£›uõUQ, ]ÔuõUQ 

£õº¨£uØS Cx EuÄ®.



C»Á\¨ £õh¡ÀC»Á\¨ £õh¡À276 277

Microsoft Office Presentation CÀ                               
£hÂÀø» AÍÂøÚ (Slide Size) JÊ[Pø©zuÀ

C»zvµÛ¯À {PÌzxøP°ß÷£õx £hÂÀø»°ß AÍÄ 

(Slide Size) ÷uøÁU÷PØ£ JÊ[Pø©UP¨£k®. ÷©¾® £h 

ÂÀø»°ß ÁøP, }Í®, AP»®, AÍÄ, ÷£õUS (Orienta-
tion) ÷£õßÓÚ Cuß ‰»® JÊ[Pø©UP¨£kQßÓÚ.

• Design  → Page Setup (£UP Aø©Ä)

E¸ 8.10  MS PowerPoint ö©ßö£õ¸Îß £UP Aø©Ä

LibreOffice Impress CÀ

£hÂÀø» AÍÂøÚ (Slide Size) JÊ[Pø©zuÀ. 

C»zvµÛ¯À {PÌzxøP°ß £hÂÀø»°ß AÍÂøÚ 

÷uøÁU÷PØ£ ©õØÔ  Aø©UP  •i²®.  ÷©¾®  £hÂÀø»°ß  

ÁøP, }Í®, AP»®, AÍÄ, ÷£õUS (Orientation) ÷£õßÓÚ 

Cuß ‰»® JÊ[Pø©UP¨£kQßÓÚ.

 
E¸ 8.11  & LibreOffice Impress ö©ßö£õ¸Îß £UP Aø©Ä

£hÂÀø»z uÍU÷Põ»® (Slide layouts)

 £UPzvøÚ¨ ÷£õx©õÚ AÍÄUS u¯õº ö\´uuß ¤ßÚº u¯õ›UP 

Gvº£õºUS® {PÌzxøP°ß uÍU÷Põ»zøu  (Office Theme / Slide layouts) ÷uº¢ 

öukUP •i²®. CÆÂh¯zvÀ  Ms Office CØS® LibreOffice CØS® Cøh°À 

]Ö Âzv¯õ\® Esk. 
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Microsoft Office Presentation  CÀ

• Home → New Slide AÀ»x Lay-
out → Office Theme, Cuß÷£õx-

QøhUS® Office Theme, \õÍµzvß 

Kº vøµ ÁiÁzvøÚ  E¸ 8.12  Põm-

kQÓx.  

 ² {PÌzxøPUS AÁ]¯©õÚ uÍU 

÷Põ»[PÒ ]»ÁØøÓ Cuß ‰»® 

÷uº¢öukUP»õ®. ÷ÁÖ uÍU ÷Põ» 

[PøÍ ö£ØÖUöPõÒÍ Slides From 
Outside £mi°ß ‰»® •i²®.

• Reuse Slide £mi°øÚ £¯ß£kzv 

•ßÚº u¯õ›UP¨£mh Põm]PøÍ 

{PÌzxøPUSÒ Em¦Szu •i²®.

E¸ 8.12 -
Office Theme

LibreOffice Impress  CÀ

• Format → Slide → Layout , 
Cuß÷£õx QøhUP¨ö£Ö® ö\¯Ø 

£õmk   \õÍµzvß ‰»® Põm]a 

\mhP ©õv› AÀ»x uÍU÷Põ»z-

vøÚ ÷uº¢öukUP •i²®. Auß 

«x _miø¯ ö\õhUPÄ®.  {PÌzx-

øPUS›¯ £hÂÀø» ©õv›PÒ 

]»ÁØøÓ Cuß‰»® ÷uº¢öukUP 

•i²®  (E¸ 8.13 I AÁuõÛUP).
• Format → Slide Layout → Master 

Pages, C[S ö©ßö£õ¸Ò ‰»©õP 

HØPÚ÷Á u¯õ›UP¨£mh uÍU 

÷Põ»[PÒ £»ÁØøÓ ÷uº¢öuk-

UPU Ti¯ Áõ´¨¦UPÒ QøhU 

QßÓÚ. PÁºa]Pµ©õP CøÁ 

u¯õ›UP¨£mi¸US®.

          

E¸ 8.13 - Slide Layouts

 C»zvµÛ¯À {PÌzxøP JßÔøÚz u¯õ›UPöÁÚ Aø©UP¨£mh 

Bµ®£ £hÂÀø» uÍU÷Põ»zvØS (Slide Layout) uø»¨ö£õßøÓ ÁÇ[ 

SÁuØS uÍU÷Põ»® JßøÓ ÷uº¢öukUSP. CuØöPÚ Title slide GÝ® 

uÍU÷Põ»zøu ÷uº¢öuk¨÷£õ®. CÛ E[PÍx  C»zvµÛ¯À {PÌzx-

øPUPõÚ uø»¨ø£²® E£uø»¨ø£²® umha_a ö\´P. (E¸ 8.14 I¨ 

£õºUP).
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E¸  8.14 - uø»¨¦¨ £hÂÀø» (Title Slide)

Microsoft Office Presentation  LibreOffice Impress

AuØPõÚ ö£¯º JßøÓ 

ÁÇ[S÷Áõ®.

C»zvµÛ¯À {PÌzxøP 

JßøÓz u¯õ›¨÷£õ®.

uØ÷£õx  RÌÁ¸® ö\¯Ø£õmøh ÷©ØöPõÒP.

Microsoft Office Presentation  CÀ

· Home → New Slide AÀ»x Layout 
Office Theme I öu›Ä ö\´P. ÷©¾® 

J¸ ¦v¯ uÍU÷Põ»zøu Em¦SzxP.

· £mi¯Ø £møh°¾ÒÍ Slide  show 
from  beginning    I   ö\õhUPÄ®.  Ca                                                 

\¢uº¨£zvÀ   {PÌzxøP  •Êzvøµ                                   

°¾®  öu›¯Á¸®. F5  \õÂø¯ AÊz 

xÁuß ‰»•® CuøÚ¨ ö£ØÖU 

öPõÒÍ •i²®. {PÌzxøP°øÚ 

Ca \¢uº¨£zvÀ  AÁuõÛUP»õ®.  

«sk®  _miø¯ ö\õhUQ Bµ®£z 

vøµUS ÁµÄ®. 

LibreOffice Impress  CÀ

·  Format →  Slide Layout… → (QøhUP¨ 

ö£Ö® ö\¯Ø£õmk \õÍµzvÞhõP)  
÷©¾® J¸ uÍU÷Põ»zvøÚ AÀ 

»x Office Theme JßøÓ  öu›¢x 

öPõÒÍÄ®. 

·  £mi¯Ø £møh°¾ÒÍ  View → Start 
from first slide I  ö\õhUPÄ®.  Ca \¢

    uº¨£zvÀ {PÌzxøP •Êzvøµ 

°¾® öu›¯Á¸®. F5 \õÂø¯ AÊz 

xÁuß ‰»•® CuøÚ¨ ö£ØÖU 

öPõÒÍ •i²®. {PÌzxøP°øÚ 

Ca\¢uº¨£zvÀ AÁuõÛUP»õ®. 

«sk® _miø¯ ö\õhUQ Bµ®£z 

vøµUS ÁµÄ®. 

C»zvµÛ¯À {PÌzxøP°øÚ ÷\ªzuÀ  (Saving)

File  Save as  Folder Name  File Name (÷PõøÁUS (File) ö£¯º JßøÓz 

umha_ ö\´P)  Save (Cuß ‰»® E[PÍx C»zvµÛ¯À {PÌzxøP°øÚ 

PoÛ°ÝÒ {ø»¯õP  ÷\ªzxU öPõÒÍÄ® ÷uøÁ÷¯Ø£k®÷£õx «sk® 

AuøÚ vÓ¢x öPõÒÍÄ® •i²®).

C»zvµÛ¯À {PÌzxøP 

JßøÓz u¯õ›¨÷£õ®

AuØPõP ö£¯º JßøÓ 

ÁÇ[S÷Áõ®
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  LibreOffice Impress  CÀ

• File → Save as → My Documents → File 
Folder → File Name   (File  Cß ö£¯øµ 

umha_ ö\´P) → Save (A¨÷£õx 

PoÛ°ÝÒ  {µ¢uµ©õP ÷\ªUP 

•i²®)

Microsoft Office Presentation  CÀ

• File → Save as → My Documents 
→ File Name (File Cß ö£¯øµ 

umha_ ö\´P) → Save (A¨÷£õx 

PoÛ°ÝÒ {µ¢uµ©õP ÷\ªUP 

*   u¯õ›zu {PÌzxøP°øÚ «Íz vÓzuÀ (Open an Existing Presentation) 

LibreOffice Impress  CÀ

• Start →All Programs → LibreOffice 
4.1 → LibreOffice Impress → File → 
Open

 ÷\ªzu (Save) {PÌzxøP°ß ö£¯ 

øµU SÔ¨¤mk «Íz vÓ¢x (Open) 
öPõÒP.

Microsoft Office Presentation  CÀ

• Start →All Programs → Microsoft 
Office → Microsoft Office PowerPoint 
2010→ File → Open

 ÷\ªzu  (Save) {PÌzxøP°ß 

 ö£¯øµU SÔ¨¤mk «Íz vÓ¢x 

 (Open) öPõÒP. 

* £hÂÀø»°ß ¤ßÚo (Slide Background)

 }[PÒ u¯õ›zu C»zvµÛ¯À {PÌzxøPUSz ÷uøÁ¯õÚ £hÂÀø» 

¤ßÚoø¯ (Slide Background) Aø©¨£uØS ö©ßö£õ¸ÎÀ Á\vPÒ 

Esk. £À÷ÁÖ {Ó[PÒ, £h[PÒ,  ]zvµ[PÒ ©ØÖ® Aø©¨¦UPøÍ 

Em¦SzuUTi¯ Á\vPÐ®  Põn¨£kQßÓÚ.

 Microsoft Office Presentation  CÀ

· Design→ Background Styles
· Background Styles CÀ EÒÍ ÁiÁ[PøÍ 

£hÂÀø»°ß ¤ßÚo¯õP Aø©zxU 

öPõÒÍ •i²®. (E¸ 8.15 I AÁuõÛUP).

 E¸ 8.15 ¤ßÚo¨ £õ[SPÒ (Background Styles)

· Background→ Format Background 
(Cuß ‰»® £À÷ÁÖ {Ó[PÒ, £h[PÒ 

AÀ»x ]zvµ[PÒ ©ØÖ® Aø©¨¦UPøÍ 

Em¦SzvU öPõÒÍ•i²®).

 LibreOffice Impress  CÀ

· Format →  Page → Background Gß£uß 

‰»® ¤ßÚoUS {Ó® AÀ»x ]Ó¢u

 Pmhø©¨ø£ Aø©zxU öPõÒÍ •i 

²®. (E¸ 8.16 I AÁuõÛUP).

E¸ 8.16 ¤ßÚo {Ó[PÒ

(Background colours)
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C»zvµÛ¯À {PÌzxøP £hÂÀø»US  GÊzxUPøÍ  ÷\ºzuÀ (Adding Text)

LibreOffice Impress  CÀ

* £hÂÀø»°ÝÒ Click to Add Title 
GÝ® ö£¯›¾ÒÍ Ch® (Place 
holder) GÚ AøÇUP¨£kQßÓx. 

CÆ Âhzvß  «x _miø¯a  

ö\õhUQ ÷uøÁ¯õÚ ö\õØPøÍ 

umha_ ö\´¯»õ®.

* (Place holder)  CÀ»õu ChzvÀ  

umha_  ö\´uÀ.

 View → Tool Bars → Drawing (Cuß 

‰»® \õÍµzvÝÒ ÁøµuÀ 

E£Pµn¨ £Svø¯¨ ö£ØÖU 

öPõÒÍ •i²®). A[SÒÍ Tool Tip 
PmhøÍ ‰»® QøhUP¨ö£Ö® 

£õh¨ ö£mi (Text box) «x                              

ö\õhUQ £hÂÀø»°ß E›¯ 

Chzvß «x CÊUPÄ® (Drag) 
Cuß ‰»® QøhUS® £õh¨ 

ö£mi°À    ÷uøÁ¯õÚ     ö\õØ                                                                                 

PøÍ umha_ ö\´¯»õ®. 

  LibreOffice Writer CÀ }[PÒ 

AÔ¢xU öPõsh GÊzxUPøÍ 

CvÀ ¤µ÷¯õQUP»õ®.

Microsoft Office Presentation   CÀ

* £hÂÀø»°ÝÒ Click to Add 
Title GÝ® ö£¯›À EÒÍ 

Ch®  Place holder GÝ® ö£¯ 

›À AøÇUP¨£kQßÓx. Auß

   «x _miø¯a ö\õhUSÁuß 

‰»® umha_ ö\´¯»õ®.

 Place holder CÀ»õu ChzvÀ 

umha_ ö\´uÀ.

* Insert → Text box, £õh¨ö£mi 

(Text box) PmhøÍø¯ ö\õhU 

QÚõÀ öuß£k® Põm]a                                                                 

\mhzvøÚ E›¯ Chzvß 

«x CÊUPÄ® (Drag). ¤ßÚº 

÷uøÁ¯õÚ £¢vø¯ umha_ 

ö\´¯Ä®. MS Word CÀ                                                        

}[PÒ AÔ¢xUöPõsh GÊz 

x¸UPøÍ CvÀ ¤µ÷¯õQU 

P»õ®.

£hÂÀø»°ÝÒ E¸UPøÍ Em¦SzuÀ (Insert Object) 

GÊzxUPøÍ umha_ ö\´¯ •ßÚº AÀ»x ¤ßÚº E¸UPøÍ (Object) 
Em¦Szu •i²®. AÁØÔÀ ]» ¤ßÁ¸©õÖ

♦ E¸UPÒ / ÁiÁ[PÒ (Shapes / Objects)  
♦ •ß B¯zu¨ £h®  (Clip art) 
♦  £h[PÒ  (Pictures) 
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E¸UPÒ / ÁiÁ[PøÍ  Em¦SzuÀ (Shapes / Objects)

Microsoft Office Presentation  CÀ

Insert →   (Illustration) - Shapes.     C[S

ÁiÁ[PøÍz öu›¢öukzx  ö£Ó¨£k® 

£mi¯À ‰»® ÷uøÁ¯õÚ A»[Põµ[ 

PøÍ öu›¢x AÁØÔß «x _miø¯a                                                

ö\õhUQ Põm]a \mhPzvß E›¯ 

ChzxUS  CÊzxU öPõÒÍÄ® (Drag). 
Auß ¤ßÚº AuøÚa _ØÔ²ÒÍ ]Ô¯                                                                           

\xµzvÝÒ _miø¯a ö\õhUQ CÊ¨ 

£uß ‰»® ÷£õv¯ÍÂØS ö£¸¨¤zx 

AÀ»x ]Ö¨¤zxU öPõÒÍ»õ®. (E¸ 

8.17 I £õºUP).

E¸ 8.17 _mi°ÚõÀ ÷uøÁ¯õÚ 

AÍÂøÚ Aø©zuÀ

LibreOffice Impress  CÀ

View → Tool bars → Drawing - (\õÍµz-

vÝÒ ÁøµuÀ E£Pµnzøu ö£ØÖU 

öPõÒÍ •i²®). A[SÒÍ Tool Tip 

‰»® ÷uøÁ¯õÚ A»[Põµ[PÒ «x 

ö\õhUQ E›¯ ChzxUS CÊUPÄ® 

(Drag) Auß  ¤ß AuøÚa _ØÔ²ÒÍ 

]Ô¯ \xµzvÝÒ _miø¯a ö\õhUQ 

CÊ¨£uß ‰»® ÷£õv¯ AÍÂØS¨ 

ö£¸¨¤zx AÀ»x ]Ö¨¤zxU 

öPõÒÍ»õ® (E¸ 8.18 I £õºUP).

E¸ 8.18 _mi°ÚõÀ ÷uøÁ¯õÚ 

AÍÂøÚ Aø©zuÀ

 ÁiÁ[PÍx {Ó[PøÍ ©õØÖuÀ (Changing the colour of Shapes / Objects)

 £À÷ÁÖ ÁøP¯õÚ ÁiÁ[PøÍ²® E¸UPøÍ²® C»zvµÛ¯À     

{PÌzxøP £hÂÀø»°ÝÒ Em¦Szv ÷uøÁ¯õÚ ©õv›PøÍ AÀ»x 

GÊzx E¸Á[PøÍ Aø©zxU öPõÒÍ •i²®. CuØöPÚ¨ ¤ßÁ¸® 

£i•øÓ°øÚU øP¯õÍ»õ®.

Microsoft Office Presentation  CÀ

 ² E›¯ ÁiÁzvß «x _miø¯ øÁzx 

Á»¨£UP ö£õzuõøÚa ö\õhUPÄ®.    

Auß ‰»® ö£Ó¨£k® Format Shapes 
-ö\õÀ»õhØ ö£mi°¾ÒÍ ©õØÕk-

PøÍ £¯ß£kzv ö£õ¸zu©õÚ 

{Ó[PÒ, £h[PÒ, A»[Põµ[PøÍ 

÷\ºzxU öPõÒÍ»õ®.

LibreOffice Impress  CÀ

 ² View → Tool bars → Line and filling 
GÝ® \õÍµzvÝÒ Line and Fillings 
P¸Âø¯ ö£Ó •i²®. ÷uøÁ¯õÚ 

{Ó[PøÍz ÷uº¢öukzx ÷©÷» 

EÒÍ P¸Â¨ £mi°À  EÒÍ  Tool 
Tip FhõP Area style / Filling I 

÷uº¢öukzx {Ó[PøÍ¨ ö£ØÖU 

öPõÒÍ»õ®.
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♦ £hÂÀø»°À B¯zu¨ £hzvøÚ (Clip Art) Em¦SzuÀ (Inserting  Clip Art / 
Gallery theme) 

 ö©ßö£õ¸Ò FhõP E¸ÁõUP¨£mh £À÷ÁÖ •ß B¯zu¨ £h[PøÍ 

÷uº¢öukzx C»zvµÛ¯À {PÌzxøP°ÝÒ Em¦Szu •i²®. CuØöPÚ 

¤ßÁ¸® £i•øÓPøÍU øP¯õÍ»õ®.

Microsoft Office Presentation  CÀ

* Insert → Clip Art (Cuß ‰»® ö£Ó¨ 

£k® \õÍµzvÀ Search for CÀ ö£õ¸z 

u©õÚ Clip Art ÁøP°ß ö£¯øµz 

umha_ ö\´P. ¤ßÚº QøhUP¨ 

ö£Ö® Clip Art «x ö\õhUSP). ¤ßÚº  

AuøÚa `ÇÄÒÍ ]Ô¯ \xµzvß «x 

_miø¯a ö\õhUQ CÊzxa (Drag) 
ö\ÀÁuß ‰»® ÷uøÁ¯õÚ AÍÄU-

Sa ö£¸¨¤zx AÀ»x ]Ö¨¤zxU 

öPõÒÍ»õ®.

    LibreOffice Impress  CÀ

* Drawing Tool bar → Gallery AÀ»x 

Tools → Gallery 

* C¢{ø»°À QøhUP¨ö£Ö® 

Gallery \õÍµzvÀ C¸¢x New 
Theme  C¾ÒÍ  EøÓ°À (Fold-
er) Põn¨£k® •ß B¯zuzvøÚ 

(Clip Art Folder) vÓ¢x ö£õ¸zu©õÚ 

JßøÓz ÷uº¢öukzx £ozuõ 

ÐUS CÊzx ö\ÀP (Drag). ¤ßÚº  

AuøÚa  `ÇÄÒÍ  ]Ô¯   xµzvß

      «x _miø¯a     ö\õhUQ  CÊzxa 

ö\ÀÁuß ‰»® ÷uøÁ¯õÚ AÍ 

ÂøÚU ö£¸¨¤zxAÀ»x ]Ö¨ 

¤zxU öPõÒÍ»õ®.

£h[PøÍ Em¦SzuÀ (Inserting Pictures) 

PoÛ°ß ‰»® AÀ»x ÷ÁÖ ÁÈPÎÀ C¸¢x ö£ØÖUöPõÒÍ¨£mh 

£À÷ÁÖ £h[PøÍ  C»zvµÛ¯À {PÌzxøP JßÔÝÒ Em¦Szu •i²®.

Microsoft Office Presentation  CÀ

* Insert → Picture (QøhUP¨ ö£Ö®                 

\õÍµzøu £¯ß£kzv ö£õ¸zu©õÚ 

£hzvøÚ Em¦SzxP).

* •ßÚøµ¨ ÷£õßÖ AuøÚa `Ç 

ÄÒÍ ]Ô¯ \xµzvß «x _miø¯ 

ö\õhUQ CÊzxa ö\ÀÁuß ‰»® 

ö£õ¸zu©õÚ AÍøÁU TmiU 

SøÓzx  öPõÒÍ»õ®.

LibreOffice Impress  CÀ

* P¸Â¨ £møh°¾ÒÍ Insert → Pic-
ture → From File  (QøhUP¨ö£Ö®

 \õÍµzøu £¯ß£kzv ö£õ¸zu©õÚ 

£hzvøÚ Em¦SzxP).

* Insert →  Picture →  Photo Album 
 (QøhUP¨ö£Ö® \õÍµzvÝÒ 

Add Button I ö\õhUQ £hzvøÚ¨ 

ö£ØÖU öPõÒP. Insert Slide ö£õz 

uõøÚ ö\õhUQ £hzvøÚ Em 

¦SzxP).
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 ö\¯Ø£õk

1. }[PÒ HØPÚ÷Á u¯õ›zu My first presentation GÝ® ö£¯›À 

PoÛ°ÝÒ ÷\ªzu C»zvµÛ¯À {PÌzxøP°øÚz 

vÓ¢x (Open) öPõÒP.

2. ¦v¯ uÍU÷Põ»® JßøÓ Em¦Szv, ö£õ¸zu©õÚ •ß 

B¯zu¨ £hzvøÚ  ©ØÖ® £hzvøÚ  Em¦SzxP. 

3. A¢u  {PÌzxøPUS¨ ö£õ¸zu©õÚ ÷©¾ö©õ¸ uÍU÷Põ»zøu  

Em¦Szv AuØS¨ ö£õ¸zu©õÚ J¼²¸UPøÍ²® (Audio Clip) 
JÎ²¸UPøÍ²® (Video Clip) Em¦SzxP. 

* J¸ £hÂÀø»°À C¸¢x CßöÚõ¸ £hÂÀø»US ©õÖ® Põm]PøÍ 

Em¦SzuÀ (Inserting Slide Transition Effects) 

Microsoft Office Presentation  CÀ

* Transition (Transition to this Slide) CÀ 

EÒÍ ö£õ¸zu©õÚ A»[Põµzøu 

÷uº¢öukzx £hÂÀø»US ö£õ¸zu 

©õÚ Aø\Åmh[PøÍ Em¦Szv 

PÁºa]¨£kzxP.

* Transition → Transition to this Slide → 
Effect Options -‰»® £» uµ¨£mh 

ÁiÁ[PøÍ²øh¯ Aø\Åmh[ 

PÎß ö\¯Ø£õmiøÚ AÔ¢x 

öPõÒÐ[PÒ.

* Transition → Sound -‰»® ÷uº¢öukzu 

A»[PõµzxUS J¼²¸ÂøÚ (Sound 
Clip) Em¦SzxP.

* Transition → Sound → Apply to All 
Slides ‰»®- -÷uº¢öukzu  J¼ 

²¸ÂøÚ {PÌzxøP°ß \P»£h 

ÂÀø»PÐUS® Em¦SzxP.

LibreOffice Impress  CÀ

* Format → Slide layout → Or  (Tasks 
pane)    →   Slide Transition   CØSa 

ö\ÀP.                      

* Apply to Selected Slide (ö£õ¸zu©õÚ 

A»[Põµzøuz ÷uº¢öukUP).

* Modify  Transition → Speed ‰»® 

÷uº¢öukzu A»[Põµzvß ÷ÁP 

zøu ©õØÖP.

* Modify Transition → Sound ‰»® 

÷uº¢öukzu A»[PõµzxUS ö£õ¸

 zu©õÚ J¼²¸ÂøÚ Em¦SzxP. 

* Modify Transition → Advanced Slide 
→ on Mouse Click / Automatically                                  
After. ÷uº¢öukzu A»[Põµzvß 

«x _miø¯a ö\õhUSÁuß 

‰»©õ AÀ»x _¯©õPÁõ C¯[Pa 

ö\´Áx GÚz wº©õÛUP.

* Modify Transition → Apply to All Slides. 
Põm]°ß \P» £hÂÀø»PÐUS® 

÷uº¢öukzu A»[Põµ[PøÍ Em 

¦Szu ÷Ásk©õ GÚz wº©õÛUP.
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Aø\Åmh[PøÍ Em¦SzuÀ (Inserting Animations) 

 £hÂÀø»  JßÔÝÒ Em¦Szu¨£mkÒÍ £¢vPÒ, A»[Põµ[PÒ,                  

£h[PÒ ÷£õßÓ GuøÚ²® Aø\ÅmhzvØS Em¦Szu •i²®. CuØS›¯ 

EÒÍhUPzøu _mi°ÚõÀ ÷uº¢öukzx ¤ßÁ¸® £i•øÓø¯U øP¯õÍ 

÷Ásk®.

Microsoft Office Presentation  CÀ

●  Aø\Åmh •øÓ°ÝÒ → (Ani-
mation) ¤›ÄUSÒ EÒÍÁØøÓ¨ 

£õºzx Âzv¯õ\[PøÍ AÁuõÛUP.

●  Animation  (Timing) → Start Av÷» 

EÒÍ ©õØÕkPøÍ ÷uº¢öukzx _m 

iø¯ ö\õhUSÁuß ‰»©õPÁõ? 

AÀ»x _¯©õPÁõ? C¯[Pa ö\´Áx 

GÚz wº©õÛUP.

LibreOffice Impress  CÀ

● £mi¯Ø £møh°¾ÒÍ Format → Slide 
Layout  → (Tasks Pane) → Custom Ani-
mation CØS ö\ÀP. 

● Custom Animation → Modify Effect 
→ Add → ^Custom Animation \õÍµz-

vÀ Entrance, Emphasis, Exit,  Motion 
paths, Misc, Effects ÷£õßÓÁõÖ _¯©õP 

C¯[S® £À÷ÁÖ Põm]a \mhP[PÒ 

Põn¨£kQßÓÚ. CøÁ JßÖUöPõßÖ

Âzv¯õ\©õÚ Aø\Åmh[PøÍU öPõs 

i¸US®).

E¸ 8.20 
Aø\Åmh[PøÍ ÷\ºzuÀ

• Custom Animation → Modify 
effect → Change → HØPÚ÷Á 

÷uº¢öukzu Aø\Åmh[PøÍ 

«sk® ©õØÔ Aø©UP •i²®. 

Custom Animation → Modify Effect 
→ Remove ‰»® (÷uº¢öukzu 

Aø©¨¦PøÍ }UQU öPõÒÍ 

•i²®).

• Animation •øÓ°ÝÒ (Timing) → 
Duration / Delay → Start (©õØÕkPøÍ 

÷uº¢öukzx Aø\Åmh[PÒ _¯©õP 

C¯US® ÷|µzvøÚ ÷uøÁ¯õÚ 

•øÓ°À TmiU SøÓUP •i²®).             
(E¸ 8.19 I AÁuõÛUP).

E¸ 8.19 Aø\ÅmhÀ ÷|µ®

  ·        Animation  •øÓ°ÝÒ   (Advanced 
Animation)  → Animation  Pane  →                          
\õÍµzvøÚ ö£ØÖU öPõÒP. Auß‰»® 

Em¦Szu¨£mh Aø\Åmh[PøÍ AÈ 

zuÀ, ©õØÖuÀ, AÇS£kzuÀ  ©ØÖ® 

ö£õzuõß ‰»® C¯USuÀ ÷£õßÓ Âh 

¯[PøÍa ö\´¯»õ®.
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J¼°øÚ Em¦SzuÀ (Inserting Sounds) 

C»zvµÛ¯À {PÌzxøP°À ¤ßÁ¸® £i•øÓPøÍU øP¯õÒÁuß ‰»® 

J¼°øÚ Em¦SzvU öPõÒÍ •i²®.

                                                                                                                                                                                                                           
LibreOffice Impress  CÀ

(J¼°øÚ Em¦SzuÀ)   Insert → Movie and 
Sounds (QøhUP¨ ö£ØÓ \õÍµzv¼¸¢x 

Em¦Szu ÷Ási¯ J¼ Aø©¨¦PøÍ 

vÓ¢x öPõÒP. EÒÁõ[P¨£mh ¤ßÚo 

J¼°øÚ Em¦Szu ö£õ¸zu©õÚ Aø\

ÅmhzvøÚ²® ö£ØÖUöPõÒP).

Microphone ‰»® ö£ØÖUöPõÒÍ¨£mh 

J¼°øÚ Th CÁØÔÝÒ Em¦Szu 

•i²®.

Microsoft Office Presentation  CÀ

Insert → Media → Audio (C[S Media from 
file, Clip Art Audio  ©ØÖ® Record Audio GÚ 

‰ßÖ ©õØÕkPÒ Põn¨£kQßÓÚ). Me-
dia from file C¼¸¢x PoÛ°ÝÒ EÒÍ 

AÀ»x öÁÎÁõ›¯õPU QøhUP¨ö£Ö® 

Media file  CøÚ Cuß‰»® {PÌzxøPUS 

Em¦Szu •i²®. Record Audio → Micro-
phone ‰»® PoÛø¯ öuõhº¦£kzv 

ö£ØÖU öPõsh J¼°øÚ PoÛ°ß 

{øÚÁPzvÀ (Memory) ÷uUP •i²®. 

E›¯ Record Audio  Option  I öu›¢öukUS® 

\¢uº¨£zvÀ P¤»{Ó¨ ¦ÒÎ²hß 

Ti¯ ö£õzuõøÚa ö\õhUSÁuß ‰»® 

J¼¨£vÄ ö\´x öPõÒÍ»õ®.

 ² JÎ²¸ÂøÚ Em¦SzuÀ  (Inserting Video) 

Microsoft Office Presentation  CÀ

• Insert → Media → Video ^C[S Video 
from File, Video from Website ©ØÖ® 

Clip Art Video GÚ ‰ßÖ ©õØÕkPÒ 

Põn¨£kQßÓÚ.)

• Video from File.. → ^PoÛ°ÝÒ 

EÒÍ AÀ»x öÁÎÁõ›¯õP  

QøhUP¨ö£Ö® JÎ²¸U ÷Põ¨¦  

(Video File) JßÔøÚ Cuß ‰»® 

{PÌzxøP°ÝÒ Em¦SzvU öPõÒP.&

• Video  from Website    ^Cøn¯ 
uÍzv¾ÒÍ   JÎ²¸      JßÔøÚ  

{PÌzxøP°ÝÒ         Em¦SzvU 

öPõÒP.&

• Clip   Art  Video  ^•ß B¯zu  •øÓ 

°À     u¯õ›UP¨£mkÒÍ      JÎ²¸ 

JßÔøÚ  {PÌzxøP°ÝÒ      Em 

¦SzvU öPõÒP.&

LibreOffice Impress  CÀ

 ² £mi¯Ø £møh°¼¸¢x Insert → 
Movie and Sound  → ^QøhUP¨ 

ö£Ö® \õÍµzv¼¸¢x Em¦Szu 

÷Ási¯vøÚ vÓ¢x öPõÒP.&

 ² Em¦Szu¨£mkÒÍ JÎ²¸U Põm

]°øÚ  E¸¨ö£¸¨¤zxU öPõÒP.

 ² A¢u JÎ²¸U Põm]US Aø\Åm 

h®  JßøÓ Em¦SzvU öPõÒP.
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 ö\¯Ø£õk

1. }[PÒ HØPÚ÷Á u¯õ›zu My  First Presentation GÝ® ö£¯›À 

PoÛ°ÝÒ ÷\ªzu  C»zvµÛ¯À {PÌzxøP°øÚz 

vÓ¢x öPõÒP.

2. CuØS ¤ßÁ¸® Aø\Åmh[PøÍ Em¦SzxP.

·  £hÂÀø»  ©õÖ® Põm] (Slide Transitions).
·  Em¦Szv²ÒÍ E¸UPÐUS  (Objects)   ÁÇø©¯õÚ  Aø\Åmh[PøÍ     

(Custom Animation) ÁÇ[SP. 

*  C»zvµÛ¯À {PÌzxøP°øÚ Aa]hÀ  (Printing  a  Presentation)

File → Print  Cuß ‰»® C»zvµÛ¯À {PÌzxøP°øÚ Aa]h •i²®.    

Aa]kÁuØS GÚ QøhUP¨ö£Ö® ö\õÀ»õhØ ö£mi ‰»® ¤ßÁ¸® 

ö\¯Ø£õkPøÍa ö\´x Aa]h  •i²®.

Microsoft Office Presentation  CÀ

• Printer (- ^PoÛ²hß CønUP¨ 

£mkÒÍ Aa_¨ ö£õÔø¯ ^Printer& 
öu›Ä ö\´P.& ^E¸ 8.21  I¨ £õºUP&.

• Settings (- ^\P» £hÂÀø»PøÍ²®    
Aa]kÁuõ? AÀ»x SÔ¨¤mh C»U 

P[PøÍ²øh¯ £hÂÀø»PøÍ  AÀ 

»x ]» £hÂÀø»PøÍ ©mk® Aa]

kÁuõ? GÚ wº©õÛzx, AÁØøÓ 

Aa]kÁuØS AvÀ EÒÍ Á\vø¯ 

£¯ß£kzxP&.

 E¸ 8.21 - Aa]hÀ

  ÷uøÁU÷PØ£Ä®,  Phuõ]°ß  AÍÄU   

  ÷PØ£Ä® ö£›uõUQ AÀ»x ]ÔuõUQ  

  Aa]h •i²®.

LibreOffice Impress  CÀ

• General   →    Printer  (-    ^Aa_¨ 

ö£õÔø¯ öu›Ä ö\´P&.

• Range and Copies (- ^\P» £hÂÀ 

ø»PøÍ²® Aa]kÁuõ? AÀ»x 

SÔ¨¤mh  C»UP[PÐøh¯  £h 

ÂÀø»PøÍ AÀ»x ]» £hÂÀ 

ø»PøÍ  ©mk® Aa]kÁuõ? GÚ 

wº©õÛzx, AÁØøÓ Aa]kÁuØS 

AvÀ EÒÍ Á\vø¯ £¯ß£kzxP. 

• Number of Copies (- ^÷uøÁ¯õÚ 

¤µvPÎß öuõøP°øÚ SÔ¨¤kP.&

• Print (- ^C[S öuß£k® Document 
CØS Gv÷µ EÒÍ PmhzvÝÒ 

÷uøÁ¯õÚ ©õØÕkPøÍz öu›¢x 

Aa]kP. ^E¸ 8.22 I £õºUP.&

E¸ 8.22 - Aa]hÀ 

÷uøÁU÷PØ£Ä® Phuõ]°ß AÍÄU 

÷PØ£Ä® ö£›uõUQ AÀ»x ]ÔuõUQ 

Aa]h •i²®.
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 ö\¯Ø£õk

 ² C»zvµÛ¯À {PÌzxøPø¯ Põm]zvøµ°À ©mk 

©ßÔ øP÷¯hõPÄ® ö£ØÖUöPõÒÍ •i²®.

 E©US C»zvµÛ¯À {PÌzxøPö¯õßøÓ PoÛ°À 

AÁuõÛUP»õ®. AuøÚ AvP©õÚÁºPÒ £õºUP ÷Áskö©Ûß AuØS 

ö£›¯vøµ ÷uøÁ¨£k®. Azxhß C»zvµÛ¯À {PÌzxøP°ß Aa_¨ 

¤µvø¯²® £õºøÁ¯õÍºPÐUS ÁÇ[P •i²®.

· File  Print ‰»® QøhUP¨ö£Ö® ö\õÀ»õhØ ö£mi°¾ÒÍ 

øP÷¯kPÒ (Handouts) Á\vø¯ £¯ß£kzv   AuøÚ   Aa]mk £õºøÁ 

¯õÍºPÒ AøÚÁ¸US® Â{÷¯õQUP •i²®. CÆ Aa_¨ ¤µvø¯ 

£õºøÁ¯õÍºPÒ Hx® GÊuU Ti¯Âu©õPÄ® u¯õ›UP •i²®. 

£hÂÀø»

£hÂÀø»

£hÂÀø»
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 ö\¯Ø£õk

1. }[PÒ ÷©÷» PØÖUöPõsh £i•øÓPøÍ ¤ß£ØÔ ¦v¯ 

{PÌzxøP JßÔøÚ u¯õ›UP.

2. AuØS ö£õ¸zu©õÚ ©õv›z vmhö©õßÔøÚ öu›¢x-

R÷Ç²ÒÍ £hÂÀø»°À Põn¨£k® uø»¨¤øÚ²® 

E£uø»¨¤øÚ²® Em¦SzxP.  

3. C»zvµÛ¯À {PÌzxøP°øÚz u¯õ›US®÷£õx £Sv 8.2 CÀ 

SÔ¨¤h¨£mkÒÍ Ai¨£øh C¯À¦PÐUS ÷©»vP©õP, •UQ¯ö©ÚU                    

P¸x® C¯À¦PøÍ¨ £mi¯À£kzxP.

4. }[PÒ PØÓ £õhö©õßøÓ BUP§ºÁ©õPÄ® ]Ó¨£õPÄ® ©õnÁºPÐUS  

ÂÍUSÁuØS ö£õ¸zu©õÚ C»zvµÛ¯À {PÌzxøPö¯õßÔøÚz 

u¯õ›UP. AvÀ ¤ßÁ¸® Âh¯[PøÍ EÒÍhUSP. £õhzøu ÂÍUS® 

£¢vPÐUS ÷©»vP©õP £h[PÒ, AmhÁønPÒ, Aø\Åmh[PÒ, J¼²¸ 

Aø©¨¦, JÎ²¸ Aø©¨¦ ©ØÖ® JßÖUöPõßÖ Âzv¯õ\©õÚ ¤ßÚo 

{Ó[PÒ, J¸ £hÂÀø»°¼¸¢x  CßöÚõ¸ £hÂÀø»US öÁÎaö\

À¾® E£õ¯[PÒ Gß£ÁØøÓ Em¦SzxP.

5. ÁS¨£øÓ°À, P¸®£»øPø¯¨ £¯ß£kzv ÂÍUP •i¯õu J¸ 

Âh¯zvøÚ £À¿hP GÔøÁ (Multimedia Projector) ‰»® C»SÁõP 

•ßøÁUP •i²©õÚ  £õhzuø»¨ö£õßÔøÚ öu›Äö\´x, C»zvµÛ¯À 

{PÌzxøP ö©ßö£õ¸Ò ‰»® ÂÍUSP. 
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Green Computing …
£_ø©U PoÛ

 £_ø©U PoÛ Gß£x PoÛ ÁÍ[PøÍ E›¯ •øÓ°¾® AÔÄ 

§ºÁ©õPÄ®,   ö\¯ß•øÓ¯õPÄ®  £¯ß£kzxÁuõS®.  C¢u  ÷Áø»z                    

vmhzvß Ai¨£øh ÷|õUP®, {ø»¯õÚ Pmhø©¨¤ß RÌ  JÊ[Pø©U 

P¨£mhx® \‰P©¯©õUP¨£mhx©õÚ Ai¨£øha ö\¯Ø£õkPÒ ‰»® 

GvºPõ» E»øPa ]Ó¨£õUSÁuØSz ÷uøÁ¯õÚ vmh[PøÍ ÁS¨£uõS®.

 

     |ÃÚ  uPÁÀ  öuõÈÝm£ •øÓø©¯õÚx  BÇ©õÚ ©Ûuz öuõhº 

¦PÐhß Ti¯ Cøn¯® ©ØÖ® ö©ßö£õ¸ÒPÒ «x u[Q²ÒÍx. 

PoÛ°ß AizuÍ©õP Cx Aø©¯ ÷Ási¯xhß, C¯ØøP²hß 

øP÷Põºzx `ÇÀ ¤µa]øÚPÐUS £›Põµ® AÎUS® xøÓ¯õPÄ® Cx 

P¸u¨£k®. CvÀ £¯ß£kzx£ÁºPÍx v¸¨v, «ÒJÊ[Pø©zuÀ, 

•Põø©zxÁ®, •øÓ¯õP C»zvµÛ¯À PÈÄPøÍ APØÖuÀ, Põzvµ©õÚ 

öuõhº¦, \P» ÁÍ[PÎÚx® uµ EÖv¨£õk, ]UPÚ©õÚ ªß\õµ¨ £¯ß£õk, 

£»ÃÚ©ØÓ AÝ\µøÚa ö\»ÂÚ® ©ØÖ® •u½kPøÍ «Í¨ö£ÓÀ ÷£õßÓ 

Âh¯[PÒ EÒÍh[SQßÓÚ. 

 ö\¯Ø£õk

* ÷©÷» EÒÍ £_ø©U PoÛ (Green Computing) öuõhº£õÚ 

P¸zvøÚ Áõ]zx, ¦zuP[PÒ, \g]øPPÒ ©ØÖ® 

Cøn¯zuÍ® ‰»® ÷©»vP Âh¯[PøÍz ÷ui 

Bµõ´¢x E[PÍx B]›¯›ß EuÂ÷¯õk C»zvµÛ¯À 

{PÌzxøPö¯õßÔøÚz u¯õ›UP.

¤ßÁ¸® Âh¯[PÒ £ØÔ Auß÷£õx Ti¯ PÁÚ® ö\¾zxP.

* Aø\Åmh[PÑhõÚ ö£õ¸zu©õÚ uø»¨¦

* ö£õ¸zu©õÚ £h[PÒ 

* _¸UP©õÚ JÎ²¸ Aø©¨¦ (Video Clip) 

* Áõ´ö©õÈ EhÚõÚ J¼ Aø©¨¦ (Sound Clip)

* £õºøÁ¯õÍºPÐUS EuÄ® •øÓ¯õÚ £hÂÀø»°¼¸¢x £hÂÀø»¨ 

£mi¯¾US (Slide Menu) uõÄ® ö£õzuõß 

* £_ø©U PoÛ öuõhº£õÚ Âv•øÓPÒ
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 ² {PÌzxøP ©ØÖ® C»zvµÛ¯À {PÌzxøP Gß£ÁØÖUQøh°»õÚ 

Âzv¯õ\[PÒ.

 ² uµ©õÚ C»zvµÛ¯À {PÌzxøP JßÔÀ C¸UP ÷Ási¯ ]Ó¨£®\

[PÒ.

 ² {PÌzxøP ö©ßö£õ¸ÒPÎÀ EÒÍ Ai¨£øh A®\[PøÍ¨ 

£¯ß£kzv PÁºa]Pµ©õÚ £À¿hP C»zvµÛ¯À {PÌzxøP JßøÓ 

u¯õ›zuÀ.

 ² £hÂÀø»°ß ¤ßÚo, £hÂÀø» ©õv›, £hÂÀø»z uÍU÷Põ»® 

÷£õßÓÚ E¸ÁõUP¨£k® •øÓ°øÚ¨ £i¨£i¯õP¨ ¤ß£ØÔ C»z-

vµÛ¯À {PÌzxøPö¯õßøÓz u¯õ›zuÀ.

 ² C»zvµÛ¯À {PÌzxøPö¯õßÔÀ EÒÍ £hÂÀø»°ÝÒ ö£õ¸zu©õÚ 

£h® AÀ»x Á›¨£hzvøÚ Em¦SzxuÀ.

 ² C»zvµÛ¯À {PÌzxøP°À  £hÂÀø» JßÔÝÒ uPÁÀPøÍ Em¦ 

SzuÀ.

 ² A¢u {PÌzxøPUS Aø\Åmh® ÁÇ[SuÀ.

 ² C»zvµÛ¯À {PÌzxøP°øÚ Aa]k® •øÓ°øÚ ÂÍUSuÀ.

ö£õÈ¨¦
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C¨£õhzøuU PØÓ ¤ßÚº }[PÒ,

 ² uµÄzuÍzøu ÁøµÂ»UPn¨£kzuÀ

 ² uµÄzuÍzøu £¯ß£kzxÁuß AÝT»[PÒ

 ² uµÄzuÍzvß ]Ó¨¤¯À¦PÒ

 ² AmhÁønPøÍ Aø©¨£uØS ¦»[PÎß £¯ß£õk

 ² \õÂ¨ ¦»[PøÍ CÚ[PõnÀ

 ² öuõhº¦øhø©z uµÄzuÍ®

 ² AmhÁønPÐUQøh°»õÚ öuõhº¦PÒ

 ² uPÁÀPøÍ¨ ö£ÖÁuØS ÂÚÁ¼ß £¯ß£õk

 ² uµÄ©¯¨ £iÁ¨ £¯ß£õk

 ² uPÁÀPøÍ \©º¨¤UP AÔUøPø¯ £¯ß£kzuÀ

Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

 9.1  uµÄzuÍ® £ØÔ¯ GsnUP¸

uµÄzuÍö©õßÔß CßÔ¯ø©¯õø©ø¯ Bµõ´÷Áõ®.

 }[PÒ uµÄ, uPÁÀ BQ¯Ú £ØÔ¯ ÂÍUPzøu •u»õ® Azv¯õ¯zvÀ 

ö£ØÖÒÏºPÒ. C[S uµÄPøÍ GÆÁõÖ JÊ[S¨£kzu¨£mh •øÓ°À £vÄ 

^EÒÏk& ö\´¯  •i²ö©ß£x £ØÔ Bµõ´÷Áõ®.

 AvP GsoUøP¯õÚ uµÄPøÍ bõ£PzvÀ øÁzv¸¨£x   PiÚ©õS®. 

AÆÁõÓõÚ \¢uº¨£zvÀ uµÄPøÍ GÊv øÁzv¸¨£x  Kº wºÁõS®. CuøÚ 

øP•øÓ uµÄzuÍ® (Manual database) GÚ AøÇ¨£º. AÆÁõÔß÷ÓÀ ¤Ô÷uõº 

•øÓ¯õP C»zvµÛ¯À  \õuÚ[PÎÀ uµÄPøÍ¨ £vÄö\´x øÁUPÄ® 

•i²®. Cx C»zvµÛ¯À uµÄz uÍ® (Electronic database) GÚ¨£k®. 

uµÄzuÍzvß ‰»® uµÄPøÍ JÊ[S¨£kzu¨£mh •øÓ°À ÷\ª¨£uõÀ, 

÷uøÁU÷PØ£ AÁØøÓ C»SÁõP «Í¨ö£Ó •i²®. GÚ÷Á, uµÄzuÍzvÀ 

ªP AvP GsoUøP²øh¯ uµÄPøÍa ÷\ªUP •iÁxhß AÁØøÓz 

÷uøÁU÷PØ£ ªP ÷ÁP©õP «Í¨ö£ÓÄ® •i²®.

 

9
                               uµÄzuÍ®9
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 E©x |s£ºPÎß ö£¯ºPøÍ bõ£PzvÀ øÁzv¸¨£x  C»SöÁÛÝ® 

AÁºPÎß ö£¯¸US›¯ öuõø»÷£] C»UP[PøÍ  bõ£PzvÀ øÁzv¸¨£x  

PiÚ©õS®. CuØPõP ö£¯¸hß öuõø»÷£] C»UPzøu ¦zuPö©õßÔÀ  

GÊvøÁ¨£uß ‰»® AÀ»x øP¯hUPz öuõø»÷£]°÷» ÷\ª¨£uß 

‰»®  ÷uøÁU÷PØ£  CÁØøÓ¨ ö£Ó•i²®. CÆÁõÓõÚ öuõø»÷£] C»UP 

ÂÁµ[PÒ Ah[Q¯ uµÄPøÍ GÎ¯ uµÄzuÍ©õP P¸u •i²®.  

        

E¸ 9.1  öuõø»÷£] C»UP® 

      (øP•øÓ)
E¸ 9.2  öuõø»÷£] C»UP® 

               (C»zvµÛ¯À) 
 

uµÄzuÍzvß ÁøµÂ»UPn®

 JÊ[S£kzu¨£mh •øÓ°À ÷\P›UP¨£mh uµÄPÎß Tmh÷© 

uµÄzuÍö©Ú¨£k®.

9.1.1  C»zvµÛ¯À uµÄzuÍzvß (Database) AÝT»[PÒ

 C»zvµÛ¯À uµÄzuÍzv÷» £» AÝT»[PÒ Põn¨£kQßÓÚ. 

AÁØÔÀ ]» ¤ßÁ¸©õÖ 

·   uPÁÀPøÍ ÂøÚzvÓÝhß ÷uiUöPõÒÍ •iuÀ 

  uµÄzuÍzv¾ÒÍ AmhÁønPÎ÷» uµÄPÒ JÊ[S£kzu¨£mh 

•øÓ°÷» £v¯¨£mi¸¨£uÚõÀ ÷Ási¯ uPÁÀ/uµøÁ SøÓ¢u ÷|µzv÷» 

÷uiU öPõÒÍ•i²®.

·  C»SÁõP¨ ¤µvPøÍ ö£Ó•iuÀ

 C»zvµÛ¯À uµÄzuÍ[PøÍ ªP C»SÁõP¨ ¤µvö¯kUP •i²®.

·  uµÄPøÍa ÷\ª¨£uØPõP ªPU SøÓ¢u Ch® / öPõÒÍÍÄ ÷£õx©õP C¸zuÀ

 øP•øÓ ‰»®  AvP uµÄPøÍU öPõsh uµÄzuÍzøu øP¯õÍ AvP 

ö£ÍvP Ch® ÷uøÁ¨£iÝ® C»zvµÛ¯À \õuÚ[PÒ ‰»® uµÄPøÍa 

÷\ªUP ªPU SøÓ¢u Ch® / öPõÒÍÍÄ ÷£õx©õÚuõS®.

 Euõµn®
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·  uµÄPøÍ  C»SÁõPÄ®  ÷ÁP©õPÄ® £S¨£õ´Äö\´¯ •iuÀ

uµÄPÎ÷» ÷uøÁ¯õÚÁØøÓ ©õzvµ® ¤›zöukUPÄ® AÁØøÓ 

•øÓÁÈ¯õUP® ö\´¯ •i²®.

·  uµÄzuÍzøu £Qµ •iuÀ

SÔzu uµÄzuÍzøu £À÷ÁÖ£mh C¯[S ö©ßö£õ¸ÒPÍõÀ J÷µ ÷|µzvÀ 

£Qº¢x £¯ß£kzu •i²®

·  uµÄPÎß _¯õwÚzußø© Põn¨£hÀ

uµÄzuÍ•® C¯[S ö©ßö£õ¸Ð® JßÖhöÚõßÖ ÷\º¢x C¯[QÚõ¾® 

C¯[S ö©ßö£õ¸ÐUS £õv¨¦ HØ£hõuÁsn® uµÄzuÍzv¾ÒÍ 

AmhÁøn°À EÒÍ uµÄPøÍ CØøÓ¨£kzu •i²®. CuÚõÀ uµÄPÐ® 

C¯[S ö©ßö£õ¸Ð® JßÔ¼¸¢x ©ØöÓõßÖ _¯õwÚ©õÚuõPU 

Põn¨£k®.

9.1.2  uµÄzuÍzvß C¯À¦PÒ

 uµÄPøÍa ÷\ªUS®÷£õx SÔzu J÷µ uµÁõÚx £» AmhÁønPÎÀ 

÷\ªUP¨£kÁx uµÄ ©Ö£vÁõUP® (Data Redundancy) GÚ¨£k®.

 SÔzu  £õh\õø»°÷»  ©õnÁºPÎß  ö£¯µõÚx AÁºPÎß AÝ©v

Amøh°¾® ¡»Pzvß A[PzxÁ Amøh°¾® uÛzuÛ¯õP GÊu¨ 

£mkÒÍx. C¢{ø»°À SÔzuöÁõ¸ ©õnÁ›ß ö£¯›À ©õØÓ® HØ£iß 

AuøÚ JÆ÷Áõº Amøh°¾® uÛzuÛ÷¯ ©õØÓ® ö\´¯ ÷Ásk®. C[S  

"Ag\Úõ' GßÝ® ©õnÂ°ß ö£¯º  "Ag\Úõ ö\ÀÁµõáõ' GÚ ©õØÓ¨£k® 

\¢uº¨£zøuU P¸xP.

                       

©õnÁº 

C»UP®
©õnÁº ö£¯º ¤Ó¢u vPv

AÝ©v ö£ØÓ 

vPv

£õxPõÁ»º 

ö£¯º

100 G®.H.íºåõm 2$9$2000 1$1$2006 H.G®.Aí©x

101          Ag\Úõ 4$2$2000 1$1$2006 Gß. ö\ÀÁµõáõ

   AmhÁøn 9.1  ©õnÁº AÝ©v  Amøh     
                          

©õnÁº ö£¯º ¦zuPzvß ö£¯º ö£Ó¨£mh vPv
J¨£øhUP ÷Ási¯ 

vPv

          Ag\Úõ £õhÀPÒ 2$9$2014 16$9$2014

G®.H.íºåõm |õhP® 3$9$2014 17$9$2014

Ag\Úõ
Ai¨£øhU Pou 

GsnUP¸
3$9$2014 17$9$2014

G®.H.íºåõm |õhP® 4$10$2014 18$10$2014

                       AmhÁøn 9.2  ¡»P A[PzxÁ Amøh  
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 C[S öuõhº¦{ø»z uµÄzuÍ AmhÁønPÒ £¯ß£kzu¨£iß, 

uµÄ ©Ö£vÁõUP® |øhö£ÖÁøu  uÂºUP / SøÓUP •i²®. R÷Ç 

uµ¨£mkÒÍ AmhÁønPÎÀ ©õnÁ›ß ö£¯º J¸ AmhÁøn°À ©mk® 

£vÄö\´¯¨£mkÒÍøu AÁuõÛUP.

  
 AmhÁøn 9.3  öuõhº¦hø©z uµÄz uÍ®  (Relational Database)

● uµÄPÎß EÖvz ußø© (xÀ¼¯z ußø©) ÷£nÀ

 uµÄ ©Ö£vøÁ  (Redundancy) }USÁuõÀ / Pmk¨£kzxÁuõÀ SÔzu 

uµÁõÚx £» AmhÁønPÎÀ £vÄö\´Áøu }UP / SøÓUP •i²®. C¢ 

{ø»°÷» uµÄPÎß EÖvz ußø© ÷£n¨£k®.

 ÷©¾ÒÍ öuõhº¦{ø»z uµÄzuÍzøuU P¸xP. C[S ©õnÁº Â£µ®, 

¦zuP Â£µ®, ¦zuP¨ £¯ß£õmk Â£µ® ÷£õßÓÚ uÛzuÛ÷¯ öÁÆ÷ÁÖ 

AmhÁønPÎÀ £vÄ ö\´¯¨£mkÒÍøuU Põn»õ®. C¢{ø»°À 

©õnÁ›ß ö£¯º, ¦zuPzvß ö£¯º ÷£õßÓÚ J¸ •øÓ ©õzvµ÷© 

£vÄö\´¯¨£kÁuõÀ uµÄPÎß EÖvz ußø© ÷£n¨£mkÒÍx.

©õnÁº 

C»UP®
©õnÁº ö£¯º ¤Ó¢u vPv

AÝ©v ö£ØÓ 

vPv

£õxPõÁ»º 

ö£¯º 

100 G®.H.íºåõm 2/9/2000 1/1/2006 G®.H.AP©x

101 Ag\Úõ ö\ÀÁµõáõ  4/2/2000 1/1/2006 Gß.ö\ÀÁµõáõ

©õnÁº 

C»UP®

¦zuPzvß 

C»UP® 

ö£Ó¨£mh 

vPv

J¨£øhUP 

÷Ási¯ vPv

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/10/2014 18/10/2014

¦zuPzvß 

C»UP® 

¦zuPzvß ö£¯º ¡»õ]›¯›ß 

ö£¯º

1111 Ai¨£øh Pou 

GsnUP¸

]Áuõ\ß 

µõ©|õuß

2222 £õhÀPÒ EøÁì

3333 |õhP® ]u®£µ|õuß
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●  ÂøÚzvÓß AvP›zuÀ

 uµÄzuÍzv÷» AmhÁønPÒ ]Ó¢u •øÓ°÷» JÊ[S£kzu¨ 

£mkÒÍuõÀ uµÄPøÍ¨ £vÄö\´uÀ, «Í¨ö£ÓÀ ^Áõ]zuÀ& ÷£õßÓ 

ö\¯Ø£õkPøÍ ªP÷ÁP©õP ÷©ØöPõÒÍ •i²®. CuÚõÀ ÂøÚzvÓß 

AvP›US®.

 ÷©¾ÒÍ Euõµnzv÷» "Ag\Úõ' GÝ® ö£¯º  " Ag\Úõ ö\ÀÁµõáõ '  

GÚ ©õØÓ¨£k® \¢uº¨£zøuU P¸xP. C[S SÔzu J÷µ uµÁõÚx (Ag\Úõ) 
£» AmhÁønPÎÀ £vÄ ö\´¯¨£kÁuõÀ AmhÁøn 9.2 CÀ CÆÁõÓõÚ 

GÀ»õ Ch[PøÍ²® ÷ukÁuØS AvP ÷|µ® ÷uøÁ¨£k®. C¢{ø»°÷» 

ÂøÚzvÓß SøÓÁøh²®. BÚõÀ, öuõhº¦øhø©z uµÄz uÍzv÷» 

uµÄPÎß uÛzxÁ® Põµn©õP (AmhÁøn 9.3) uµÄPøÍz ÷uhÀ ÷ÁP©õP 

|øhö£ÖÁxhß ÂøÚzvÓÝ® AvP©õS®.

●  AvP ö\®ø© 

 uµÄzuÍzv÷» uµÄPÒ ©Ö£vÄ ö\´¯¨£kÁøuU Pmk¨£kzu 

•iÁuõÀ uµÄPÎß uÛzxÁ® £õxPõUP¨£kÁxhß ö£Ó¨£k® uPÁÀPÐ® 

ö\®ø©¯õPU (Accuracy) Põn¨£k®.

 ÷©¾ÒÍ Euõµnzv÷» "Ag\Úõ' GÝ® ö£¯º "Ag\Úõ  ö\ÀÁµõáõ'                                         

GÚ ©õØÓ¨£mh \¢uº¨£zøuU P¸xP. C[S £» Ch[PÎÀ ©õØÓ® 

|øhö£Ó÷Ási¯uõÀ (AmhÁøn 9.3) Hx® Kº ChzvÀ ©õØÓ® 

|øhö£ÓÂÀø»ö¯ÛÀ ö£Ó¨£k® uPÁÀ v¸zu©ØÓuõPU Põn¨£k®.

 BÚõÀ, öuõhº¦{ø» uµÄzuÍzv÷» Kº AmhÁøn°À ©õzvµ®   

"Ag\Úõ'   CØS¨ £v»õP "Ag\Úõ ö\ÀÁµõáõ' GÚ ©õØÓ®ö\´¯ ÷Ási¯ 

uõÀ uµÄPÎß uÛzxÁ® £õxPõUP¨£kÁxhß, AÁØÔß v¸zu•® 

AvP›US®.

●  ö\À¾£iz ußø©

 uµÄz uÍzøu E¸ÁõUS®÷£õx AmhÁøn°¾ÒÍ ¦»[PÎß 

C¯À¦PøÍ ÷uøÁU÷PØ£ ©õØÔ¯ø©UP •iÁuõÀ uµÄPøÍ EÒÏk ö\´²® 

{ø»°÷» AÁØøÓ¨ £›÷\õvzxz uµÄzuÍzvß  ö\À¾£izußø©ø¯ 

(Validity) AvP›UP •i²®.
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Euõµn©õPU  öPõk¨£ÚÄU  Pmhn®  Cµsk   u\©uõÚ©õP Põn¨£h 

÷Ási¯xhß ö\¾zu¨£h÷Ási¯ SøÓ¢u£m\U Pmhn® ¹£õ. 1000 BPU 

Põn¨£h ÷Áskö©ÛÀ, CuØPõP ¤ßÁ¸® C¯À¦PøÍ ©õØÔ¯ø©UP 

÷Ásk®.

öPõk¨£ÚÄ Pmhn®

¦»¨ ö£¯º uµÄ ÁøP

 ¦»zvß 

C¯À¦PÒ

    E¸  9.3 & uµÄPÎß ußø©UPø©¯ ¦»zvß C¯À¦PÒ

●  £õxPõ¨¦ 

 uµÄzuÍzvØS PhÄaö\õÀ (Password) ÁÇ[SÁuß ‰»•® uµÄU 

SÔ•øÓ¯õUP®  (Data Encryption) ö\´Áuß ‰»•® AÝ©v¯ØÓ öÁÎ |£º 

PÎß  uø»±mi¼¸¢x  uPÁÀPøÍ¨ £õxPõUP •i²®.  

 uµÄU SÔ•øÓ¯õUP® (Data Encryption) Gß£x AÝ©v¯ØÓ öÁÎ 

|£ºPÐUS uµÄPøÍ Áõ]UP •i¯õuÁsn® ©õØÔ¯ø©¨£uõS®.

 RÊÒÍ Employee Table  BÚx uµÄU SÔ•øÓ¯õUPzvß ‰»® 

öÁÎ|£ºPÐUS ÂÍ[QUöPõÒÍ •i¯õuÁõÖ ©õØÓ¨£mkÒÍøuU Põmk 

QÓx. 
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9.1.3  C»zvµÛ¯À,  øP•øÓz uµÄzuÍ[PÒ 

 C»zvµÛ¯À uµÄzuÍ[PøÍ  E¸ÁõUPU SøÓ¢u öPõÒÍÍøÁU 

öPõsh ÷\ª¨£P® ÷uøÁ¨£kÁx Â÷\h©õÚuõS®. ¤ßÁ¸® Amh 

Áøn¯õÚx øP•øÓ, C»zvµÛ¯À uµÄzuÍ[PÐUQøh÷¯¯õÚ ÷ÁÖ 

£õkPøÍU PõmkQÓx.

 

øP•øÓz uµÄzuÍ®  C»zvµÛ¯À uµÄzuÍ®

ÂøÚzvÓß SøÓÄ ÂøÚzvÓß AvP®

v¸zu® SøÓÄ v¸zu® AvP®

|®£Pzußø© SøÓÄ |®£Pzußø© AvP®

uµÄPøÍ¨ £S¨£õ´Ä ö\´uÀ PiÚ 

©õS®

uµÄPøÍ £S¨£õ´Ä ö\´uÀ C»S 

ÁõS®

EÒÏk ö\´¯¨£mh Á›ø\°÷» Põm 

]¨£kzu¨£k®

EÒÏk ö\´¯¨£mh Á›ø\ ©õØ 

Ô¯ø©UP¨£mk Põm]¨£kzu¨ 

£h»õ®

÷uøÁ¯ØÓ uµÄPøÍ }USÁx PiÚ 

©õS®

÷uøÁ¯ØÓ uµÄPøÍ }USÁx C» 

SÁõS®

uµÄPøÍ CØøÓ¨£kzxÁx (Update) 
PiÚ©õS®

uµÄPøÍ  CØøÓ¨£kzxÁx        

(Update) C»SÁõS®

uµÄPøÍa ÷\ªUP AvP Ch® ÷uøÁ¨ 

£k®

uµÄPøÍa ÷\ªUP SøÓ¢u Ch® 

÷£õx©õÚuõS®

AvP ©ÛuÁÍ® ÷uøÁ¨£k® SøÓ¢u ©ÛuÁÍ® ÷£õx©õÚ 

uõS®

E¸  9.4 uµÄU SÔ•øÓ¯õUP®

AmhÁøn 9.4 C»zvµÛ¯À, øP•øÓz uµÄz uÍ[PÐUQøh÷¯¯õÚ J¨¥k
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 9.1.4  öuõhº¦{ø»z uµÄzuÍzvß AÔ•P®

 SÔzu Kº C»USö£õ¸Ò AÀ»x |£º \®£¢u©õÚ £À÷ÁÖ£mh 

¦»[PÎß Tmh® £vÁõPU (Record) P¸u¨£k®. £vÄPÎß Tmh® Amh           

Áøn¯õPU P¸u¨£k®. JßÖhöÚõßÖ öuõhº¦øh¯ AmhÁønPÎß 

Tmh® öuõhº¦{ø»z uµÄzuÍ©õPU P¸u¨£k®.

©õnÁº 

C»UP®

©õnÁº ö£¯º ¤Ó¢u vPv £õxPõÁ»º 

ö£¯º

100 G®.H.íºåõm 2/9/2000 G®.H.AP©x

101 Ag\Úõ ö\ÀÁµõáõ  4/2/2000 Gß.ö\ÀÁµõáõ

©õnÁº 

C»UP®

¦zuPzvß 

C»UP®

ö£Ó¨£mh

vPv

J¨£øhUP 

÷Ási¯ 

vPv

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/10/2014 18/10/2014

AmhÁøn

£vÄ

^öuõhº¦{ø»z uµÄzuÍ®&
(Relational Database)¦»®

öuõhº¦{ø»z uµÄz uÍö©õßøÓ E¸ÁõUS® £i•øÓø¯ uØ÷£õx AÁuõ 

Û¨÷£õ®. (AmhÁøn 9.5) ¦»[PÎß ÷\º©õÚ® £vÁõPU P¸u¨£kÁxhß , 

£» £vÄPÎß ÷\º©õÚ®  AmhÁøn¯õPU P¸u¨£k®. £» AmhÁønPøÍU 

öPõsh÷u öuõhº¦{ø»z uµÄz uÍ©õS®.

AmhÁøÚ 9.5

öuõhº¦{ø» uµÄzuÍ® (Relational Database)

AmhÁøn 1 ¬AmhÁøn 2 ¬ AmhÁøn 3 ¬ AmhÁøn 4 ''' (Tables)

           £vÄ 1 ¬ £vÄ 2 ¬ £vÄ 3 ¬ £vÄ 4 ''''''' (Records)

          AmhÁøn

£vÄ 

           ¦»® 1 ¬ ¦»® 2 ¬ ¦»® 3 ¬ ¦»® 4 ''''''' (Fields)
E¸ 9.5 öuõhº¦{ø»z uµÄzuÍ® E¸ÁõUP¨£k® •øÓ
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Euõµn®

         £õh\õø»°¾ÒÍ JÆ÷Áõº ©õnÁ¸US® AÁµÁº ©õnÁº £vÄ¨ ¦zuP® 

ªP •UQ¯©õÚ AÔUøP¯õS®. CvÀ ©õnÁºPÍx uÛ¨£mh Âh¯[PÒ, 

JÆöÁõ¸ ÁS¨¤¾® ‰ßÖ uÁøn¨ £Ÿmø\°À ö£ØÓ £õh¨¦ÒÎPÒ, 

JÆöÁõ¸ uÁøn°¾® AÁºPÍx {ø» ÷£õßÓ ÂÁµ[PÒ Põn¨£k®.

‰ßÖ ©õnÁºPÍx ÂÁµ[PÒ RÊÒÍ AmhÁøn°À Põmh¨£mkÒÍx.

 AÝ©v C»UP® ( 1426 AÝ©v C»UP® ( 1427 AÝ©v C»UP® ( 1428

ö£¯º : PÂx ¤µ£õèÁº ö£¯º( «Úõ÷uÂ µõ©|õuß ö£¯º( ö©õí©m ©›UPõº

¤Ó¢u vPv : 2005'05'23 ¤Ó¢u vPv : 2005'08'12 ¤Ó¢u vPv ( 2005'02'07

£õÀ : Bs £õÀ :  ö£s £õÀ : Bs

öuõø»÷£] C»UP® (   

0352287571

öuõø»÷£] C»UP® ( 

0352235696

öuõø»÷£] C»UP® ( 

0352815402

          AmhÁøn 9.6  ©õnÁºPÍx ÂÁµ¨£mi¯À  

 ÷©¾ÒÍ AmhÁøn¯õÚx JÆ÷Áõº ©õnÁµx® öu›Äö\´¯¨£mh 

ÂÁµ[PøÍU Põm]¨£kzxQÓx. CvÀ PÂx ¤µ£õèÁº, «Úõ÷uÂ µõ©|õuß 

©ØÖ® ö©õí©m ©›UPõº GÝ® uµÄPÒ ‰»® J¸ ¦»® E¸ÁõUP¨£kQÓx. 

CÆÁõÓõÚ ¦»[PøÍ¨ ö£¯›h "¦»¨ö£¯º' £¯ß£kzu¨£k®.

JÆ÷Áõº ¦»¨ö£¯¸US® ö£õ¸zu©õÚ uµÄPøÍ ÁÇ[SÁuß ‰»® 

AmhÁønö¯õßøÓ E¸ÁõUP»õ®.

AÝ©v 

C»UP® 
ö£¯º ¤Ó¢u vPv £õÀ öuõø»÷£] C»UP®

1426 PÂx ¤µ£õèÁº  2005'05'23   Bs  0352287571   

1427 «Úõ÷uÂ µõ©|õuß  2005'08'12   ö£s  0352235696

1428 ö©õí©m ©›UPõº  2005'02'07   Bs  0352815402 

                                   AmhÁøn 9.7  ©õnÁº £vÄ

 AmhÁønö¯õßÔß {µÀPÒ ‰»® ¦»[PÒ Põm]¨£kzu¨£k®. 

÷©¾ÒÍ AmhÁøn°À I¢x ¦»[PÒ Põn¨£kQßÓÚ. AÝ©v C»UP®, 

©õnÁº ö£¯º, ¤Ó¢u vPv, £õÀ ©ØÖ® öuõø»÷£] C»UP® BQ¯Ú÷Á 

AøÁ¯õS®.  

¦»[PÒ AøÚzvÚx® ÷\º©õÚ® ‰»® £vÄPÒ E¸ÁõUP¨ £k®. CuØPø©¯ 

÷©¾ÒÍ AmhÁøn°À ‰ßÖ £vÄPÒ Põn¨£kQßÓÚ.

uµÄPøÍU öPõsh AmhÁønö¯õßÔß J¸ £Sv R÷Ç Põmh¨£mkÒÍx.
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¦»¨ ö£¯º (Field Names)

©õnÁº

C»UP®
•Ê¨ ö£¯º

¤Ó¢u 

vPv
£õÀ

öuõø»÷£] 

C»UP®

1426 PÂx ¤µ£õèÁº 2005'05'23    Bs 0352287571

1427 «Úõ÷uÂ µõ©|õuß 2005'08'12    ö£s 0352235696

1428 ö©õí©m ©›UPõº 2005'02'07    Bs 0352815402

 £vÄ (Record) {µÀ (Column)

{øµ (Row)

 

    C[S ©õnÁº ö£¯º, ¤Ó¢u vPv, £õÀ ©ØÖ® öuõø»÷£] C»UP® 

÷£õßÓ uµÄPÒ «sk® £vÄö\´¯¨£h Áõ´¨¦sk. BÚõÀ, AÝ©v 

C»UP® GÝ® ¦»zvÀ £vÄö\´¯¨£mh uµÁõÚx «sk® £vÄö\´¯¨£mh 

•i¯õx. GÚ÷Á, AÝ©v C»UPzvß ‰»® £vÄ JßøÓz uÛzxÁ©õP 

Aøh¯õÍ¨£kzu •i²®.

 RÊÒÍ öuõhº{ø» AmhÁønPÒ ‰»® Ag\Úõ ö\ÀÁµõáõ ö£ØÓ 

¦zuP[PÎß ÂÁµ® Põm]¨£kzu¨£kQÓx.

©õnÁº

C»UP®
      ö£¯º ¤Ó¢u vPv

AÝ©v ö£ØÓ 

vPv

£õxPõÁ»›ß

ö£¯º

100 G®.H. íº\õm 2$9$2000 1$1$2006 G®.H.AP©x

101 Ag\Úõ ö\ÀÁµõáõ 4$2$2000 1$1$2006 Gß.ö\ÀÁµõáõ

©õnÁº

C»UP®

 ¦zuP 

C»UP®

 ö£Ó¨£mh 

vPv

J¨£øhUP 

÷Ási¯ vPv

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/10/2014 18/10/2014

¦zuP 

C»UP®

¦zuPzvß 

uø»¨¦ 
¡»õ]›¯›ß ö£¯º

1111 Ai¨£øh 

Pou 

GsnUP¸

]Áuõ\ß µõ©|õuß

2222 £õhÀPÒ EøÁì

3333 |õhP® ]u®£µ|õuß

AmhÁøn 9.9

AmhÁøn 9.8  uµÄ AmhÁønö¯õßÔß £Sv
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9.1.5  •uß{ø»a \õÂ / •ußø©a \õÂ ^Primary Key& 

 AmhÁøn°÷»  £vÄ JßøÓz  uÛzxÁ©õP (Unique) Aøh¯õÍ¨ 

£kzu¨ £¯ß£kzu¨£kQßÓ ¦»® (AÀ»x ¦»a÷\º©õÚ®) •uÀ{ø»a                        

\õÂ¯õPU (•ußø©a \õÂ / Primary Key) P¸u¨£kQÓx. 

               

Euõµn® - 
BÒ Aøh¯õÍ Amøh C»UP®, £õh\õø» 

AÝ©v C»UP®

                             
       

 

 SÔ¨¦ 

•uÀ{ø»a \õÂö¯õßÔß Â÷\h A®\[PÒ

● `Û¯©õPU ^öÁÖø©¯õP& Põn¨£h •i¯õx (uµÄPÒ   

   Põn¨£kÁx Azv¯õÁ]¯©õS®).
 ● uµÄPÒ «Ò£vÄ |øhö£Óõx. (J÷µ uµÁõÚx  «Í¨ £vÄ  

   ö\´¯¨£h©õmhõx.)

Euõµn©õP¨ ¤ßÁ¸® uµÄPøÍU öPõsh AmhÁønø¯ AÁuõÛUP.

£vÄ

C»UP®

uø»¨¦ ¡»õ]›¯º ö£¯º ¦zuPzvß 

Âø»

¦zuPzvß 

GsoUøP

2131 Cøn¯zvß AÔ•P® ©÷Pè PßP¢u Rs.275.00 10

2132 PoÛö©õÈU PØøP _µÛ©» £ì|õ¯P Rs.300.00 5

2133 Pmkøµ GÊxuÀ {©õ¼ ÷£õ÷Põh Rs. 225.00 12

2134 PÀÂ EÍÂ¯À u¯|õz á¯÷\Pµ Rs.400.00 6

2135 uªÌö©õÈø¯U PØ÷£õ® µõä _uõPµß Rs.225.00 8

2136 PoÛö©õÈU PØøP ö©õí©m ›¯õì Rs.150.00 4

2137 ][PÍ & uªÌ APµõv µõä _uõPµß Rs.325.00 6

AmhÁøn 9.10  ¦zuP ÂÁµ AmhÁøn

CÆ AmhÁøn°÷»,

● C¸÷ÁÖ  ¦zuP[PÐUS  J÷µ  £vÂ»UP®  C¸UP  •i¯õx.                        

   (uÛzxÁ©õÚx) 
● PoÛö©õÈU PØøP GÝ® ¦zuPzøu _µÛ©» £ì|õ¯P, ö©õí©m   

   {¯õì  GÝ® B]›¯ºPÒ GÊv²ÒÍÚº.

● µõä _uõPµß GÝ® B]›¯µõÀ uªÌö©õÈø¯U PØ÷£õ®, ][PÍ 

   uªÌ APµõv ÷£õßÓ ¦zuP[PÒ GÊu¨£mkÒÍÚ.

● Pmkøµ GÊxuÀ, uªÌ ö©õÈø¯U PØ÷£õ® BQ¯ Cµsk 

   ¦zuP[PÎÚx®  Âø»PÒ \©ÚõP EÒÍÚ.
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● PÀÂ EÍÂ¯À ©ØÖ® ][PÍ uªÌ APµõv ÷£õßÓ ¦zuP[PÎß GsoUøP   

   6 BP Põn¨£kQÓx.

 CUPõµoPÎß Ai¨£øh°÷» ¦zuPzvß £vÄ C»UP©õÚx 

uÛzxÁ©õPU Põn¨£kÁuõÀ •uÀ{ø»a \õÂ¯õPz öu›Äö\´¯¨£mh 

ªP¨ö£õ¸zu©õÚ ¦»©õS®.

   SÔ¨¦ : AmhÁønö¯õßÔ÷» •uÀ{ø» \õÂø¯ Aøh¯õÍ¨£kzu   

               AuØS AiU÷Põk Ch¨£k®. ^AmhÁøn 9.11 I AÁuõÛUP& 

£vÄ C»UP®     uø»¨¦
¡»õ]›¯º 

ö£¯º 

 ¦zuPzvß            

 Âø»

¦zuPzvß 

GsoUøP

               AmhÁøn 9.11  •uÀ{ø»a \õÂø¯ Aøh¯õÍ¨£kzuÀ

   

  9.1.6  Cøn¢u / ÷\º©õÚa \õÂ (Composite Primary Key)  

  AmhÁønö¯õßÔ÷» £vÄöÁõßøÓ uÛzxÁ©õP Aøh¯õÍ¨ 

£kzvUöPõÒÍ £¯ß£kzu¨£kQßÓ Cµsk AÀ»x AuØS ÷©Ø£mh 

¦»[PÎß ÷\º©õÚ÷© ''÷\º©õÚa \õÂ''  (''Composite Primary Key'') BPU 

P¸u¨£k®. RÊÒÍ AmhÁøn, £õh\õø»ö¯õßÔß ÂøÍ¯õmkzxøÓz 

uø»Áº, E£uø»Áº \®£¢u©õÚ ÂÁµ[PøÍU Põm]¨£kzxQÓx.

Bsk ÂøÍ¯õmk uø»Áº E£uø»Áº

2013   Q›UöPm µèª ÷\Úõ|õ¯UP •£õµU íûø\ß

2013   PõÀ£¢x áõ¼¯ \õµ[P Â÷Úõuß µõä

2013   Tøh¨£¢x Aí©m |Áõì _÷µè uµ[P

2014   Q›UöPm •£õµU íûø\ß £õÝ u¯õµzÚ

2014   PõÀ£¢x áõ¼¯ \õµ[P Aí©m |Áõì

2014   Tøh¨£¢x £õv¯ P®»z _÷µè uµ[P

   AmhÁøn  9.12 ÂøÍ¯õmkzxøÓ 

Composite Key C[S £vöÁõßøÓz uÛzxÁ©õP CÚ[Põn Bsk, 

ÂøÍ¯õmk ÷£õßÓ C¸ ¦»[PÐ® Azv¯õÁ]¯©õÚuõS®. 

 

CÆ AmhÁøn°÷» JÆöÁõ¸ {µ¼¾® ]» uµÄPÒ «Í¨ £v¯¨£mi 

¸¨£øu Põn»õ®. CuÚõÀ £vöÁõßøÓz uÛzxÁ©õP Aøh¯õÍ¨£kzu 

J¸ uÛ¨ ¦»zøu¨ ̂ {µø»& £¯ß£kzu•i¯õx. Azxhß SÔzu Kº BsiÀ 

J¸ ÂøÍ¯õmkUPõP {µ¢uµz uø»Áº, E£uø»Áº Põn¨£hÀ ÷Ásk®. 

CuÚõÀ Bsk, ÂøÍ¯õmk ÷£õßÓ C¸ ¦»[PÎß ÷\º©õÚzøu •uÀ{ø»a                                                                                                                           

\õÂ¯õPU P¸u•iÁxhß, Ca÷\º©õÚzvß ‰»® E¸ÁõUP¨£kQßÓ 
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Composite key BÚx •uÀ{ø»a \õÂUS¨ ö£õ¸zu©õS®. ÷\º©õÚ 

•uÀ{ø»a \õÂø¯ Aøh¯õÍ¨£kzxÁuØPõP C¨¦»[PÐUS uÛzuÛ÷¯ 

AiU÷Põk Ch¨£mi¸US®.

Bsk ÂøÍ¯õmk        uø»Áº        E£uø»Áº

                     AmhÁøn   9.13  ÷\º©õÚ •uÀ{ø» \õÂø¯ CÚ[PõnÀ

÷©¾ÒÍ AmhÁøn°÷» •uÀ{ø»a \õÂ  =  Bsk  + ÂøÍ¯õmk 

 9.1.7  A¢{¯a \õÂ (Foreign Key) 
 J¸ AmhÁøn°¾ÒÍ ¦»® (AÀ»x ¦»a÷\º©õÚ®) ‰»® ÷Á÷Óõº 

AmhÁøn°¾ÒÍ £vöÁõßÖ uÛzxÁ©õP Aøh¯õÍ¨£kzu¨£k©õ°ß, 

A¨¦»® (AÀ»x ¦»a÷\º©õÚ®) CÆÁmhøn°¾ÒÍ A¢{¯a  \õÂ¯õPU 

P¸u¨£k®. A¢{¯a\õÂ ‰»® Cµsk AmhÁønPÐUQøh÷¯ öuõhº¦ 

E¸ÁõUP¨£k®. 

AÝ©v 

C»UP® 

     ö£¯º ¤Ó¢u vPv AÝ©v 

ö£ØÓ vPv

£õxPõÁ»º

ö£¯º

100 G®.H.íº\õm 2/9/2000 1/1/2006 H.G®.Aí©x

101 Ag\Úõ ö\ÀÁµõáõ 4/2/2000 1/1/2006 Gß.ö\ÀÁµõáõ

 ©õnÁº 

AmhÁøn      

^Student Table&

•uÀ{ø»

 \õÂ

÷©¾ÒÍ AmhÁønPÎ÷» AÝ©v C»UP©õÚx 

©õnÁº AmhÁøn°÷» (AmhÁøn 9.14) •uÀ 

{ø» \õÂ¯õP P¸u¨£kÁxhß £õh AmhÁøn°÷»                      

(AmhÁøn 9.15)  AÝ©v C»UP©õÚx  A¢{¯a              

\õÂ¯õPU P¸u¨£k®. Azxhß £õh AmhÁøn°÷» 

÷ÁÖ •uÀ{ø»a \õÂ Põn¨£kÁxhß Ax £Ÿmø\               

_möhs BP Põn¨£k®.

£õh 

AmhÁøn      

^Subject Table&

£Ÿmø\                

_möhs
Pou® ÂgbõÚ® ][PÍ® B[Q»®

AÝ©v 

C»UP® 

449683 B A C C 100
449697 A B B A 101

AmhÁøn   9.15
SÔ¨¦ 

 A¢{¯a \õÂ°ß Â÷\h A®\[PÒ

·  Cµsk AmhÁønPÐUQøh÷¯ öuõhºø£ E¸ÁõUSuÀ

· öuõhº¦£mh AmhÁønPÎ÷» •uÀ{ø»a  \õÂø¯U öPõsh                                                                                                                                            

    ¦»zxhß öuõhº¦øh¯ uµÄPÒ ©õzvµ÷© Põn¨£h •i²®.

· Kº AmhÁøn°¾ÒÍ A¢{¯a \õÂ¯õÚx Cß÷Úõº Amh                                                                                                                                              

    Áøn°÷» •uÀ{ø» \õÂ¯õPU Põn¨£k®.

A¢{¯a

  \õÂ

AmhÁøn   9.14
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Euõµn®

uPÁØ öuõhº£õhÀ öuõÈÝm£¨ £õhzøu PØS® ‰ßÖ ©õnÁºPÍx 

•u»õ® uÁøn¨ ¦ÒÎPøÍU RÊÒÍ AmhÁøn PõmkQÓx.

AÝ©v C»UP® ©õnÁº ö£¯º ¤Ó¢u vPv ¦ÒÎ uÁøn  Bsk

1426 PÂx ¤µ£õèÁº 2005'05'23 69  1 2014

1427 «Úõ÷uÂ µõ©|õuß 2005'08'12 82  1 2014

1428 ö©õí©m ©›UPõº 2005'02'07 47  1 2014

                   AmhÁøn  9.16  •u»õ® uÁøn¨ ¦ÒÎPÒ

 A®©õnÁºPÎß Cµshõ® uÁøn¨ ¦ÒÎPÒ CÆ AmhÁøn°÷» 

£vÄö\´¯¨£kö©ÛÀ, AÝ©v C»UP®, ©õnÁº ö£¯º, ¤Ó¢u vPv 

÷£õßÓ ¦»[PÎ÷» «sk® J÷µ uµÄPÒ £v¯¨£k®.(AmhÁøn 9.17 I 

AÁuõÛUP).          

AÝ©v C»UP®    ö£¯º ¤Ó¢u vPv ¦ÒÎ uÁøn Bsk

1426 PÂx ¤µ£õèÁº 2005'05'23 69 1 2014

1427 «Úõ÷uÂ µõ©|õuß  2005'08'12 82 1 2014

1428 ö©õí©m ©›UPõº 2005'02'07 47 1 2014

1426 PÂx ¤µ£õèÁº 2005'05'23 79 2 2014

1427 «Úõ÷uÂ µõ©|õuß 2005'08'12 68 2 2014

1428 ö©õí©m ©›UPõº 2005'02'07 66 2 2014

                        AmhÁøn 9.17  uµÄ «Ò£vÁõUP®

 

 CÆÁõÖ AmhÁønö¯õßÔ÷» J¸ uµÁõÚx £» {øµPÎ÷» 

£vÄö\´¯¨£mi¸¨£x uµÄ «Ò£vÁõUP®  ^Data Duplication& BPU P¸u¨ 

£k®. AmhÁønö¯õßÔ÷» uµÄ «Ò£vÄ |øhö£ÖÁuõÀ ¤ßÁ¸® ¤µv 

T»[PÒ HØ£kQßÓÚ.

(i) £vÄPÎß uÛzxÁzøu¨ ÷£n •uÀ{ø»a \õÂ¯õP ¦»® JßøÓ öu›Ä 

ö\´¯ •i¯õø©

(ii) uµÄPøÍz v¸zu©õP¨ £S¨£õ´Äö\´¯ •i¯õø©

 ÷©¾ÒÍ AmhÁøn°÷» 60 ¦ÒÎPÐUS AvP©õP¨ ö£ØÓ ©õnÁºPÒ 

5 ÷£º GÚU Põmh¨£iÝ® SÔzu ÁS¨¤÷» 3 ©õnÁºP÷Í Põn¨ 

£kQßÓÚº. GÚ÷Á, uµÄPøÍ v¸zu©õP¨ £S¨£õ´Äö\´¯ •i¯õx.

(iii) uµÄz uÍzvß ÂøÚzvÓß SøÓÁøhuÀ

 ÷©¾ÒÍ AmhÁøn°÷» £» BskPÐUPõÚ uÁønPÎß ¦ÒÎ 

PøÍ EÒÏk ö\´²®÷£õx AÝ©v C»UP®,  ©õnÁº ö£¯º, ¤Ó¢u 

vPv ÷£õßÓ ¦»[PÎß uµÄPøÍ¨ £vÄö\´ÁuØS AvPPõ»® ÷uøÁ¨ 

£kÁuõÀ ÂøÚzvÓß SøÓÁøh²®.
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(iv) uµÄPÒ v¸zu©ØÓuõP¨ ö£Ó¨£kÁuØS  AvP Áõ´¨¦ HØ£hÀ

 ÷©¾ÒÍ AmhÁøn°÷» J÷µ uµÁõÚx «Í £vÄö\´¯¨£kÁuõÀ 

v¸zu® SøÓÁøh¯ Áõ´¨¦sk. Euõµn©õP ©õnÁº ö£¯º ö©õí©m 

©›UPõº  GÚ Kº Chzv¾® ö©õí©m ©»UPõº  GÚ Cß÷Úõº Chzv¾® 

£vÄö\´¯¨£h Áõ´¨¦sk. CuÚõÀ v¸zu® SøÓÁøh²®.

  (v) uµÄPøÍ EÒÏk ö\´Áx ]µ©©õuÀ

 SÔzu ©õnÁº ö£ØÓ ¦ÒÎø¯ EÒÏk ö\´¯ ÷Áskö©ÛÀ, AÁ›ß 

ö£¯º, ¤Ó¢u vPv ÷£õßÓ uµÄPøÍ «Í EÒÏkö\´¯ ÷Ásk®.

 (vi) uµÄPøÍ }US® ÷£õx uÁÖPÒ HØ£hÀ

 SÔzu ©õnÁº \®£¢u©õÚ £» £vÄPÒ Põn¨£kÁuõÀ AÁØøÓ                        

}US®÷£õx uÁÖPÒ HØ£h»õ®.

(vii) uµÄPøÍ CØøÓ¨£kzu ]µ©©õuÀ

 SÔzu ©õnÁº \®£¢u©õÚ £» £vÄPÒ Põn¨£kÁuõÀ CØøÓ¨£kzx® 

÷£õx JÆ÷Áõº £vøÁ²® P¸zvÀ öPõsk CØøÓ¨£kzu ÷Ásk®.

 ÷©¾ÒÍ ¤µa]øÚPÒ HØ£h Kº AmÁøn°÷» GÀ»õz uµÄPÐ® 

Põn¨£kÁ÷u Põµn©õS®. CuØPõP CÆ AmhÁønø¯ CßÝ® £» 

AmhÁønPÍõP¨ ¤›¨£÷u ]Ó¢u wºÁõS®.

 C¢{ø»°À uµÄ «Ò£vÄ |øhö£ÓU Põµn©õÚ ¦»zøu }US•P©õP 

CÆAmhÁøn¯õÚx C¸ AmhÁønPÍõP¨ ¤›UP¨£k®. ^©õnÁº 

AmhÁøn, ¦ÒÎ AmhÁøn&.

 ©õnÁº AmhÁøn°÷» AÝ©v C»UP®, ©õnÁº ö£¯º, ¤Ó¢u vPv 

÷£õßÓ ¦»[PÒ Põn¨£k®.

 C®©õnÁº AmhÁøn°÷» ©õnÁº ö£¯º, ¤Ó¢u vPv ÷£õßÓ 

uµÄPÒ «Í¨£vÄö\´¯¨£h Áõ´¨¦sk. BÚõÀ, AÝ©v C»UP® 

«Í¨£vÄö\´¯¨£h •i¯õx. GÚ÷Á, £vÄPøÍ uÛzxÁ©õP 

Aøh¯õÍ¨£kzu •uÀ{ø»a \õÂ¯õP AÝ©v C»UP® ö£õ¸zu©õÚ 

¦»©õS®.

 

   AÝ©v C»UP®      ©õnÁº ö£¯º        ¤Ó¢u vPv

1426    PÂx ¤µ£õèÁº 2005'05'23

1427 «Úõ÷uÂ µõ©|õuß  2005'08'12

1428 ö©õí©m ©›UPõº 2005'02'07

AmhÁøn  9.18 ©õnÁº AmhÁøn

 AÝ©v C»UP®, ¦ÒÎ, uÁøn, Á¸h® ÷£õßÓ ¦»[PøÍ¨ £¯ß£kzv 

¦ÒÎPÒ Ah[Q¯ AmhÁøn E¸ÁõUP¨£k®.
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AÝ©v C»UP® ¦ÒÎ uÁøn Á¸h®

1426 69 1 2014

1427 82 1 2014

1428 47 1 2014

1426 79 2 2014

1427 68 2 2014

1428 66 2 2014

 

 ¦ÒÎ AmhÁøn°÷» AÝ©v C»UP® GÝ® ¦»zv¾ÒÍ                   

uµÄ / uµÄPÐhß öuõhº¦øh¯ J¸ uµÄ ©õzvµ÷© ©õnÁº AmhÁøn°À 

Põn¨£kQÓx. 

 C[S ©õnÁº AmhÁøn°¾ÒÍ AÝ©v C»UP® •uÀ{ø»a                                                                                       

\õÂ¯õP P¸u¨£kÁxhß, ¦ÒÎ AmhÁøn°¾ÒÍ AÝ©v C»UP©õÚx 

A¢{¯a \õÂ¯õP P¸u¨£k®.

 9. 2  øP•øÓz  uµÄz uÍö©õßøÓ E¸ÁõUSuÀ

uµÄ ÁøP (  Kº ¦»zxhß öuõhº¦øh¯ uµøÁ ÁøPSÔUP uµÄÁøP 

                   £¯ß£kzu¨£k®. AvP©õP¨ £¯ß£kzu¨£k®  uµÄ

                   ÁøPPÎÀ ]» ¤ßÁ¸©õÖ.

• Gs\õº ^Numeric& ( GsPouU Po¨¦PÐUPõP¨ £¯ß£kzu¨£kQÓx. 

Cx £À÷ÁÖ£mh ÁøPPÎÀ Põn¨£kQÓx.

 ∗ Integer ({øÓö¯s) ( ÷|º AÀ»x ©øÓ SÔ öPõshuõPU Põn¨£k®                                                                                                                                          

                                  {øÓö¯sPÒ     

                                   Euõµn® ( 12" - 23

        ∗ Real (ö©´ö¯s) ( ÷|º  AÀ»x  ©øÓ  SÔ öPõshuõPU Põn¨£k®  

                                     u\©uõÚ¨ ö£Ö©vPÒ Euõµn® ( 8'125" -2'64" 4'00 

• £õh® ^Text& ( GÊzxUPÒ,   GsPÒ    AÀ»x    Â÷\h    SÔ±kPøÍU                               

                         (%, *, -) öPõshx. GsPÒ £¯ß£kzu¨ £iÝ® GsPøÍ 

                          Po¨¦PÐUS Em¦Szu •i¯õx. 

                         Euõµn®  (  ÷u]¯ Aøh¯õÍ Amøh  C»UP® 889534731v
                                    öuõø»÷£] C»UP® 0112785123" 0112-785123

• |õn¯® ^Currency& (  |õn¯©õØÖ¨ ö£Ö©vPøÍ ÁøPSÔUP £¯ß£kz 

                                    u¨£k®.

                          Euõµn®  (  $ 12'45" Rs 35'00

AmhÁøn  9.19 ¦ÒÎ AmhÁøn 
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• vPv / ÷|µ® ^Date /Time& ( vPvø¯²® ÷|µzøu²® ÁøPUSÔUP    

                                            £¯ß£kzu¨£k®.

                                 Euõµn® (  12$23$2013" 7'35 a.m

• §¼¯ß ^Boolean& ( Esø©  ^True&$  ö£õ´  ^False&  ÷£õßÓ  C¸ §¼¯ß  

                            ^Logical  uºUPÂ¯À&  ö£Ö©vPøÍ  ©õzvµ®   ÁøP           

                                SÔUP¨    £¯ß£kzu¨£k®.  ¦»zvß   £¸©ß   A¨ 

                                ¦»zvÀ   £vÄö\´¯¨£k®   uµÄPÎß   ÁøP,  uµÄ 

                                PÎß  GsoUøP  ÷£õßÓ   PõµoPøÍ   Ai¨£øh 

                                ¯õPU öPõsk ©õØÓ©øh¯»õ®.

Euõµn® (  ¦»¨ö£¯º ^{µ¼ß ö£¯º&   ¦»zvß £¸©ß ^¦»zvß AÍÄ&  

  £õhzvß ö£¯º   15

  £õhzvß SÔ    5

AmhÁønö¯õßøÓ E¸ÁõUS®÷£õx ¦»zxUS¨ ö£õ¸zu©õÚ uµÄ 

ÁøPø¯z öu›Äö\´¯ ÷Ásk®.

            ¦»¨ö£¯º (Field name)                  uµÄ ÁøP (Data type)
              £vÄ C»UP®  £õh® ^Text&

uø»¨¦ £õh® ^Text&
¡»õ]›¯›ß ö£¯º £õh® ^Text&
¦zuPzvß Âø» |õn¯® ^Currency)

¦zuPzvß GsoUøP Gs ^Number&
AmhÁøn 9.20

^1& £õh\õø» ¡»PzvÀ 10 ¦zuP[PÎß ÂÁµ[PøÍ ÷©¾ÒÍ     

¦»[PøÍU öPõsh AmhÁøn°÷» Põm]¨£kzxP.

^2& ÁS¨£øÓ°÷» ©õnÁºPÒ ö£ØÓ ¦ÒÎPøÍ Põm]¨£kzu 

ö£õ¸zu©õÚ AmhÁønø¯ E¸ÁõUSP. CÆ AmhÁøn°÷» 

AÝ©v C»UP®, ö£¯º ©ØÖ® £õh¨ ¦ÒÎPÒ Põn¨£h 

÷Ásk®.

 

^3&  R÷Ç uµ¨£mkÒÍ AmhÁøn°÷» ¦»[PÐUS ªP¨ ö£õ¸z 

u©õÚ uµÄ ÁøPø¯ GÊxP.

      

  ö\¯Ø£õk
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               ¦»® ^Field&      uµÄ ÁøP ^Data type&
   AÝ©v C»UP® ^Admission_number&

AÝ©v ö£ØÓ vPv  ^Date_of_admission&
£õhUSÔ  ^Subject_code&

øÁzv¯º Pmhn® ^Doctor’s_fee&

vønUPÍzvß ö£¯º  ^Department_name&

£¯oPÒ GsoUøP ^Number_of_passengers &

£v¯¨£mkÒÍuõ? ^Is_registered?&

                                AmhÁøn 9.21  uµÄÁøP AmhÁøn

^4& ¦»ö©õßÖUSU ö£õ¸zu©õÚ uµÄÁøP öu›Äö\´¯¨£h ÷Ási¯uß 

    ÷|õUPzøu Euõµnzxhß ÂÍUSP.

 9.3 øP•øÓz uµÄzuÍzøu C»zvµÛ¯À uµÄzuÍ©õP ©õØÖuÀ  

 øP•øÓz uµÄzuÍzøu C»zvµÛ¯À uµÄzuÍ©õP ©õØÖÁuØPõP 

uµÄzuÍ •Põø©zxÁz öuõSvø¯¨ £¯ß£kzx® •øÓø¯ Bµõ´÷Áõ®.    

ÁøµÂ»UPn®

 £¯|¸US uµÄz uÍ[PøÍ E¸ÁõUPÄ® •Põø©zxÁ® ö\´¯Ä©õÚ 

Á\vPøÍ öPõsh AÔUøPPÎß Tmh÷© uµÄzuÍ •Põø©zxÁz öuõSv 

^Database Management System-DBMS& BS®.

uµÄzuÍ •Põø©zxÁz öuõSv¯õÚx AmhÁøn, ÂÚÁÀ, £iÁ® ©ØÖ® 

AÔUøP ÷£õßÓ C»US¨ ö£õ¸ÒPøÍU öPõsi¸zuÀ.

£iÁ®

ÂÚÁÀ

AmhÁøn

AÔUøP

 uµÄzuÍ 

•Põø©zxÁ 

öuõSv

(DBMS)
(Report)

(Form)

E¸ 9.6 uµÄzuÍ •Põø©zxÁ öuõSv°¾ÒÍ C»US¨ ö£õ¸ÒPÒ

(Querie)

(Table) öuõhº¦hø© uµÄPÎß 

Tmh®

uµÄPøÍ EÒÏk 

ö\´¯, Põm]£kzu

E¸ÁõUP¨£k® 

Cøh•P®

uµÄPÎß \õµõ®\zøu 
Aa]h  Põn¨£k® 
Á\v

AmhÁøn ‰»®
ö£Ó¨£mh uµÄPÒ

      

AmhÁøn (Table)

ÂÍÁÀ (Qaerie)£iÁ® (form)

AÔUøP (Report)
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9.3.1  uµÄzuÍ •Põø©zxÁ öuõSv (Database Management System)      

          ö©ßö£õ¸Ò

 £À÷ÁÖ£mh ö©ßö£õ¸Ò u¯õ›¨¦ {ÖÁÚ[PÎÚõÀ E¸ÁõUP¨£m-

kÒÍ uµÄzuÍ •Põø©zxÁz öuõSv ö©ßö£õ¸ÒPøÍ  ^DBMS Software& 
AmhÁøn 9.20 CÀ Põn»õ®.

   

            ö©ßö£õ¸Ò           E¸ÁõUQ¯ {ÖÁÚ®

Access Microsoft Company
Base The Document Foundation
Oracle Oracle Corporation

    AmhÁøn 9.22  £À÷ÁÖ£mh ö©ßö£õ¸ÒPÐ® AÁØøÓ E¸ÁõUQ¯ {ÖÁÚ[PÐ®

9.3.2  uµÄzuÍ  •Põø©zxÁ  öuõSv  ö©ßö£õ¸øÍ  |øh•øÓ¨£kzuÀ

 uµÄzuÍ •Põø©zxÁ öuõSv ö©ßö£õ¸ÒPÎÀ Microsoft Office 
Access, LibreOffice Base ÷£õßÓ ö©ßö£õ¸ÒPÒ £ØÔ ©õzvµ÷© CÆA»QÀ 

Bµõ´÷Áõ®. ö©ßö£õ¸øÍ Bµ®¤US® •øÓ¯õÚx £oö\¯À •øÓø©US 

HØ£ ©õØÓ©øh¯»õ® Gß£øuU PÁÛUP.

1'   uµÄzuÍ ö©ßö£õ¸øÍ Bµ®¤zuÀ

  

Microsoft Office  Access CÀ 

Start→ Programs → Microsoft Office 
→ Microsoft Office Access → Blank 
Database → Select Folder and Type 
Name → Create 

LibreOffice Base  CÀ 

Start → Programs → LibreOffice →
LibreOffice Base → Create a new 
database → Next → Finish → Select 
Folder and Type Name → Save

2'  uµÄ AmhÁønø¯z vmhªhÀ

 uµÄzuÍ ö©ßö£õ¸øÍ Bµ®¤zx R÷Ç Põmh¨£mkÒÍ E¸ 9.7 

CØPø©¯ ¦»®, uµÄ ÁøP  BQ¯ÁØøÓU  öPõsh AmhÁønø¯ 

E¸ÁõUSP. AuøÚ "¡»P®'  GßÓ ö£¯›÷» ÷\ªUP.

Microsoft Office  Access CÀ 

Create →Table Design →  ¦»¨ö£¯º , uµÄ 

ÁøPø¯z öu›Ä ö\´P →  ¦»[PÎß 

C¯À¦PøÍ ©õØÖP → AmhÁønø¯ 

÷\ªUP'

 

LibreOffice Base  CÀ 

Select Table in Design View → ¦»¨ö£¯º, 

uµÄ ÁøPø¯ öu›Ä ö\´P → ¦»[PÎß 

C¯À¦PøÍ ©õØÖP →AmhÁønø¯a 

÷\ªUP.
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E¸ 9.7  ¡»P AmhÁøn°÷» ¦»[PÐ®, uµÄÁøPPÐ®

£vÄ C»UP®

uø»¨¦

¡»õ]›¯›ß ö£¯º

¦zuPzvß Âø»

¦zuPzvß GsoUøP

¡»P®

3'  uµÄ AmhÁøn°÷» •uÀ{ø»a \õÂø¯ E¸ÁõUSuÀ

 AmhÁøn°÷» £vÄPøÍz uÛzxÁ©õP Aøh¯õÍ¨£kzu AøÁ 

«Í¨ £vÄö\´¯¨£hõ©À Põn¨£hÀ ÷Ásk®. AmhÁøn°÷» J¸ ¦»® 

AÀ»x ¦»a÷\º©õÚzøu •uÀ{ø»a \õÂ¯õPz öu›Äö\´ÁuõÀ £vÄPÎß 

uÛzxÁzøu¨  ÷£n•i²®.   ÷©¾ÒÍ  E¸ 9.7   CÀ  £vÄ  C»UP®  •uÀ 

{ø»a \õÂ¯õPz öu›Äö\´¯ ö£õ¸zu©õÚ ¦»©õS®.

   

Microsoft Office  Access CÀ 

Create →  Table Design → ¦»¨ö£¯º  

uµÄ ÁøPø¯z öu›Äö\´P → 
•uÀ{ø»a \õÂ¯õPz öu›Äö\´¯ 

÷Ási¯ Á› AÀ»x Á›PøÍz öu›Ä 

ö\´P → •uÀ{ø»a \õÂ ÷©À                                        

ö\õkUSP.  →  AmhÁønø¯  ÷\ªUP

 

LibreOffice Base  CÀ 

Select Table in Design View → 
¦»¨ö£¯º  uµÄ ÁøPø¯z öu›Ä 

ö\´P →  •uÀ{ø»a \õÂ¯õP öu›Ä 

ö\´¯ ÷Ási¯ Á› AÀ»x Á›PøÍz 

öu›Äö\´x Á»x £UP¨ ö£õzuõøÚ 

ö\õkUSP. → •uÀ{ø»a \õÂø¯ 

öu›Äö\´P →  AmhÁønø¯            

÷\ªUP'   

  

               E¸ 9.8 •uÀ{ø»a \õÂø¯U öPõsh ¡»P AmhÁøn

¦zuPzvß GsoUøP

¦zuPzvß Âø»

¡»õ]›¯›ß ö£¯º

uø»¨¦

£vÄ C»UP®

¡»P®

   

4'  AmhÁøn°÷» uµÄPøÍ EÒÎhÀ

     E¸ÁõUP¨£mh AmhÁøn°÷» uµÄPøÍ EÒÏk ö\´¯ Auß Põm]ø¯   

    ©õØÔ¯ø©UP ÷Ásk®.
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Microsoft Office Access CÀ 

All Access Objects vøµ°À Amh 

Áønø¯ öu›Ä ö\´P → Data Sheet 
View I öu›Ä ö\´P  → uµÄPøÍ 

EÒÏk ö\´P → AmhÁønø¯ ‰kP.                

                

LibreOffice Base CÀ 

Tables Cß RÌ Põn¨£k® Am-

hÁøn°÷» C¸•øÓ ö\õkUSP. 

AÀ»x _mi°ß Á»x £UP¨ 

ö£õzuõøÚa ö\õkUQ Open ö\´P 

→ uµÄPøÍ EÒÏk ö\´P. →Am-

hÁønø¯ ‰kP. 

¡»P AmhÁøn°÷» E¸ 9.9 CÀ Põmh¨£mkÒÍ uµÄPøÍ EÒÏk ö\´uÀ.

    

 9.4   öuõhº¦{ø»z uµÄzuÍzøu E¸ÁõUSuÀ (Relational Database)            

 AmhÁønö¯õßÔß •uÀ{ø»a \õÂ, A¢{¯a \õÂ \®£¢u©õÚ 

ÂÍUPzøu E£ Azv¯õ¯® 9.1 CÀ ö£ØÖÒÏºPÒ.

 J¸ uÛ AmhÁøn°÷» £» uµÄPøÍ¨ £vÄö\´Áøu Âh £» 

AmhÁønPÒ  ‰»®  uµÄPøÍ  EÒÏk ö\´uÀ, CØøÓ¨£kzuÀ  (Update), 
}USuÀ ÷£õßÓ  ö\¯Ø£õkPøÍ ªP C»SÁõPa ö\´¯ •iÁxhß Cx J¸  

]Ó¢u •øÓ²©õS®.

 CuØPõP uµÄ AmhÁønø¯ £» GÎ¯ AmhÁønPÍõP¨ ¤›¨£uß 

‰»® AÁØÖUQøh÷¯ öuõhº¦øhø©ø¯ E¸ÁõUSÁx £ØÔ¯ AÔøÁ¨ 

ö£Ó C¨£Svø¯z öuÎÁõP PØ÷£õ®. öuõhº¦{ø»z uµÄzuÍzøu 

E¸ÁõUS®÷£õx AmhÁønPÐUQøh÷¯ £À÷ÁÖ£mh öuõhº¦øhø©PÒ 

Põn¨£h»õ®. AøÁ JßÖUöPõßÖ (one-to-one) öuõhº¦øhø©, JßÖU 

S¨ £» (one-to-many) öuõhº¦øhø©, £»ÂØS¨ £»  (many-to-many) 
öuõhº¦øhø© GÚ ÁøP¨£kzu¨£k®.

~»P®

¦zuPzvß C»UP®              uø»¨¦

Cøn¯zvß AÔ•P®

PoÛö©õÈU PØøP

Pmkøµ GÊxuÀ

PÀÂ EÍÂ¯À

uªÌö©õÈø¯U PØ÷£õ®

PoÛö©õÈU PØøP

][PÍö©õÈ APµõv

¡»õ]›¯›ß ö£º

©÷íì PßP¢u

_µo©» £ì|õ¯UP

{©õ¼÷£õöPõh

u¯õ{v á¯÷\Pµ

µõä _uõPµß

ö©õí©m {¯õì

µõä _uõPµß

E¸ 9.9 ¡»P AmhÁøn 

Âø» GsoUøP
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9.4.1  JßÖUS JßÖ öuõhº¦øhø©  (one-to-one Relationship)

 AmhÁønö¯õßÔß J¸ £vÁõÚx Cß÷Úõº AmhÁøn°ß J¸ 

£vÄhß  ©õzvµ®  öuõhº¦øh¯öuÛÀ,  CÆÂµsk AmhÁønPÐUQøh÷¯ 

JßÖUS JßÖ ^one-to-one&öuõhº¦øhø© Põn¨£kÁuõPU P¸u¨£k®.

  C[S AmhÁøn  A,  AmhÁøn B ÷£õßÓÁØøÓ P¸vß Amh 

Áøn  A C¾ÒÍ J¸ £vÄhß ©õzvµ® AmhÁøn B  C¾ÒÍ J¸ £vÄ 

öuõhº¦øh¯uõPU  Põn¨£k®. Azxhß AmhÁøn  B  C¾ÒÍ J¸ 

£vÄhß ©õzvµ® AmhÁøn  A  C¾ÒÍ J¸ £vÄ öuõhº¦øh¯uõPU 

Põn¨£k®.

Euõµn®

I¢uõ® uµ¨ ¦»ø©¨£›]À £Ÿmø\°÷» ©õnÁºPÒ ö£ØÓ ¦ÒÎPøÍ 

AmhÁøn 9.23 PõmkQÓx.

AÝ©v C»UP®            ö£¯º ¤Ó¢u vPv
£Ÿmø\ 

_möhs
¦ÒÎ

1426    PÂx ¤µ£õèÁº 2005'05'23 23234 151

1427   «Úõ÷uÂ µõ©|õuß 2005'08'12 23876 186

1428   ö©õí©m ©›UPõº 2005'02'07 23758 172

1429    µèª á÷Úõuµõ 2005'06'16 23765 193

AmhÁøn 9.23 C¾ÒÍ uµÄPøÍ, ¦ÒÎ AmhÁøn, (AmhÁøn 9.24)  
©õnÁº AmhÁøn (AmhÁøn 9.25) ÷£õßÓ C¸ AmhÁønPÎÀ Põm-

k÷Áõ®.

 

 

 ¦ÒÎ AmhÁøn°÷» J¸ £vÁõÚx ©õnÁº AmhÁøn°÷» J¸ 

£vÄhß ©õzvµ® öuõhº¦øh¯x. Azxhß ©õnÁº AmhÁøn°¾ÒÍ J¸ 

£vÁõÚx ¦ÒÎPÒ AmhÁøn°¾ÒÍ J¸ £vÄhß ©õzvµ® öuõhº¦øh¯x.

 ©õnÁº AmhÁøn°À AÝ©v C»UP® •uÀ{ø»a \õÂ¯õPU 

Põn¨£kÁxhß ¦ÒÎ AmhÁøn°÷» AÝ©v C»UP® A¢{¯a   \õÂ¯õP 

Põn¨£kQÓx.

AmhÁøn 9.23 ¦»ø©¨ £›]À £Ÿmø\ ¦ÒÎPÒ

£Ÿmø\

_möhs
¦ÒÎ

AÝ©v 

C»UP®

AÝ©v 

C»UP®
ö£¯º

¤Ó¢u 

vPv

PÂx ¤µ£õèÁº

«Úõ÷uÂ µõ©|õuß

ö©õí©m ©›UPõº

µèª á÷Úõuµõ

AmhÁøn 9.24 ¦ÒÎ AmhÁøn                       AmhÁøn 9.25  ©õnÁº AmhÁøn
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¦ÒÎ AmhÁøn°÷» £Ÿmø\  _möhs, •uÀ{ø»a \õÂ¯õPU Põn¨ 

£kQÓx. CÆÂ¸ AmhÁønPÐUQøh÷¯ öuõhº¦øhø©ø¯ E¸ÁõUP 

A¢{¯a\õÂ £¯ß£kzu¨£kÁxhß Ax JßÖUS JßÖ öuõhº¦øhø© 

ÁøPø¯a \õ¸®. ^E¸ 9.10 I¨ £õºUP&

©õnÁº AmhÁøn

AÝ©v C»UP® ©õnÁº ö£¯º ¤Ó¢u vPv

¦ÒÎ AmhÁøn   

£Ÿmø\  _möhs ¦ÒÎ AÝ©v C»UP®

 

AmhÁønPÐUQøh÷¯ öuõhº¦øhø©ø¯U PõmkÁuØPõP A¢{¯a                        

\õÂ°¼¸¢x •uÀ{ø»a \õÂ°ØS A®¦USÔ Áøµ¯¨£k®.

              
E¸ 9.10  JßÖUS - JßÖ öuõhº¦øhø©ø¯ PõmkuÀ

  

9.4.2  JßÖUS & £» öuõhº¦øhø© (one-to-many Relationship)

 AmhÁønö¯õßÔ¾ÒÍ J¸ £vÁõÚx Cß÷Úõº AmhÁøn°¾ÒÍ 

£» £vÄPÐhß öuõhº¦øh¯öuÛÀ, CÆÂ¸ AmhÁønPÐUQøh÷¯ 

Põn¨£k® öuõhº¦øhø©¯õÚx  JßÖUS & £»  ^one-to-many& öuõhº¦ 

øhø© GÚ¨£kQÓx. 

 AmhÁønPÒ A, B CÀ B BÚx öuõhº¦øhø©ø¯ öPõsh 

AmhÁønö¯ÛÀ, CøÁ CµskUSªøh÷¯ Põn¨£k® JßÖUS & £» 

öuõhºø£ ¤ßÁ¸® AmhÁøn PõmkQÓx. 

            AmhÁøn A                 AmhÁøn B 

AmhÁøn A  C¾ÒÍ Kº £vÁõÚx 

AmhÁøn  B C¾ÒÍ £» 

£vÄPÐhß öuõhº¦£h •i²®.

AmhÁøn B  C¾ÒÍ Kº £vÁõÚx 

AmhÁøn A C¾ÒÍ J¸ £vÄhß  

©õzvµ® öuõhº¦£h •i²®.

AmhÁøn B  ²hß öuõhº£ØÓ 

£vÄPÒ Põn¨£h •i²®.

AmhÁøn A ²hß öuõhº£ØÓ £vÄPÒ 

Põn¨£h •i¯õx.

AmhÁønPÐUQøh÷¯ öuõhº¦øhø©ø¯ E¸ÁõUSuÀ

©õnÁº AmhÁøn ¦ÒÎ AmhÁøn

AÝ©v C»UP® £Ÿmø\ _möhs

©õnÁº ö£¯º ¦ÒÎ

¤Ó¢u vPv AÝ©v C»UP®
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•uÀ{ø» \õÂø¯ Eøh¯ ¦»zv÷» 

uµÄPÒ «Ò £vÄö\´¯¨£h •i¯õx.

A¢{¯a \õÂø¯ Eøh¯ ¦»zv÷» 

uµÄPÒ «Ò £vÄö\´¯¨£h •i²®'

AmhÁøn A C¾ÒÍ £vÄhß 

öuõhº¦øh¯ £vöÁõßÖ 

AmhÁøn  B  C÷» Põn¨£kÁx 

Azv¯õÁ]¯ªÀø»

AmhÁøn  B  C¾ÒÍ £vÄhß öuõhº 

¦øh¯ Kº £vÁõÚx AmhÁøn A  
C÷» Põn¨£kÁx Azv¯õÁ]¯©õS® 

       AmhÁøn 9.26  JßÖUS  £» öuõhº¦hø© C¯À¦PÒ

Euõµn® 

 ©õnÁºPÍx uÛ¨£mh uµÄhß Á\vUPmhn öPõk¨£ÚÄ Ah[Q¯ 

RÊÒÍ AmhÁønø¯U P¸xP.

 AÝ©v 

C»UP®

©õnÁº 

ö£¯º

¤Ó¢u 

vPv

£ØÖa^mk 

C»UP®

vPv Pmhn® 

1426 PÂx 

¤µ£õèÁº
2005'05'23 1000 2014'01'04 40'00

1427 «Úõ÷uÂ 

µõ©|õuß   
2005'08'12

1428 ö©õí©m 

©›UPõº
2005'02'07 1001 2014'01'06 120'00

1426 PÂx 

¤µ£õèÁº
2005'05'23 1002 2014'01'12 80'00

                          AmhÁøn 9.27 Á\vU Pmhn AmhÁøn 

 

 CÆ AmhÁøn°÷» £ØÖa^mk C»UP® GßÓ ¦»zvÀ Pmhn®, 

vPv ÷£õßÓ ¦»[PÒ u[Q²ÒÍÚ. Azxhß £ØÖa^mk C»UP ¦»zv÷» 

uÛzxÁ©õÚ uµÄPÒ ©õzvµ÷© Põn¨£kQßÓÚ. CuØSU Põµn® £ØÖa^mk 

C»UP® JßÖhß JßÖ ÷ÁÖ£kÁuõS®. £ØÖa^mhõÚx ÁÇ[P¨£kÁx 

Pmhn® ö\¾zu¨£k® JÊ[Q»õS®. CuÚõÀ §µn¨£kzu¨£hõu £vÄPÒ 

Põn¨£h Áõ´¨¦sk' ^AmhÁøn°÷» {øµ R  ‰»® Põmh¨£mkÒÍx&' 

Azxhß CÆAmhÁøn°÷» uµÄ «Ò£vÄö\´¯¨£mkÒÍøu²® 

AÁuõÛUP»õ®'

 

 GÚ÷Á, CÆ AmhÁøn¯õÚx  ©õnÁº AmhÁøn ^9.28& Á\vU 

Pmhn  AmhÁøn  ^9.29&  GÚ  C¸  AmhÁønPÍõP¨    ¤›UP¨£kÁx  

]Ó¢uuõS®. C[S £ØÖa^mk C»UP® Á\vUPmhn AmhÁøn°÷» 

•uÀ{ø»a \õÂ¯õP Põn¨£k®.  Azxhß Á\vU Pmhn AmhÁøn°÷» 

AÝ©v C»UP® A¢{¯a  \õÂ¯õP Põn¨£k®.

R
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AÝ©v C»UP®    ©õnÁº       ö£¯º ¤Ó¢u vPv

1426   PÂx ¤µ£õèÁµ 2005.05.23

1427 «Úõ÷uÂ µõ©|õuß 2005.08.12

1428  ö©õí©m ©›UPõº 2005.02.07

          

£ØÖa^mk vPv Pmhn® AÝ©v C»UP®

1000 2014'01'04 40'00 1426

1001 2014'01'06 120'00 1428

1002 2014'01'12 80'00 1426

 

 ©õnÁº J¸Á¸US u©x Á\vU Pmhnzøu AvP£m\® ‰ßÖ 

uÁønPÎÀ ö\¾zu •i²ö©ÛÀ, ©õnÁº AmhÁøn°÷» J¸ £vÄhß 

öuõhº¦øh¯  0" 1" 2 AÀ»x 3 £vÄPÒ Á\vUPmhn AmhÁøn°÷» 

Põn¨£h»õ®.

•  £vÄPÎß GsoUøP 0 Gß£x Á\vU Pmhn® ö\¾zu¨£hÂÀø»   

    Gß£øuU SÔUS®.

•  £vÄPÎß GsoUøP 1 Gß£x Á\vU Pmhn® Kº uhøÁ ©õzvµ®   

    ö\¾zu¨£mkÒÍøuU SÔUS®.

•  £vÄPÎß GsoUøP   2 Gß£x Á\vU Pmhn® C¸ uhøÁPÒ    

   ö\¾zu¨£mkÒÍøuU SÔUS®

•  £vÄPÎß GsoUøP  3 Gß£x Á\vU Pmhn® ‰ßÖ uhøÁPÒ   

   ö\¾zu¨£mkÒÍøuU SÔUS® 

 

 CuØPø©¯ ©õnÁº AmhÁøn°÷» J¸ £vÄhß öuõhº¦øh¯ 

§a]¯® AÀ»x JßÖ AÀ»x AuØS ÷©Ø£mh £vÄPÒ Á\vUPmhn                                         

AmhÁøn°÷» Põn¨£h»õ®. CuÚõÀ C¢u Cµsk AmhÁøn-

PÐUQøh÷¯ JßÖUS & £» öuõhº¦øhø© Põn¨£kQÓx' ^E¸ 9'11 I¨ 

£õºUP.&

AÝ©v C»UP® ©õnÁº ö£¯º ¤Ó¢u vPv

£ØÖa^mk 

C»UP®

  vPv Pmhn® AÝ©v C»UP®

 

©õnÁº AmhÁøn 

Á\vUPmhn AmhÁøn 

AmhÁøn 9.29 Á\vU Pmhn AmhÁøn

AmhÁøn 9.28 ©õnÁº AmhÁøn
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E¸ 9.11  JßÖUS  £» öuõhº¦øhø©ø¯ PõmkuÀ

©õnÁº AmhÁøn

AÝ©v C»UP®

©õnÁº ö£¯º

¤Ó¢u vPv
AÝ©v C»UP®

Pmhn®

vPv

£ØÖa^mk C»UP®

Á\vU Pmhn AmhÁøn

               

   

 9.4.3  £»ÂØS & £» öuõhº¦øhø© (many-to-many Relationship)

 Kº AmhÁøn°À £vöÁõßÖhß ¤Ô÷uõº AmhÁøn°ß £» 

£vÄPÒ öuõhº¦øh¯uõ²®, Azxhß öuõhº¦øhø© AmhÁøn°À 

£vöÁõßÖhß •u»õ® AmhÁøn°ß £» £vÄPÒ öuõhº¦øh¯uõ²® 

C¸¨¤ß, AmhÁønPÐUQøh÷¯¯õÚ öuõhº¦øhø© £»ÂØS & £» 

^many-to-many& öuõhº¦øhø© BP P¸u¨£k®.

Euõµn® 

 £õh\õø» ©õnÁºPÒ PÀÂ\õµõa ö\¯Ø£õhõP SÊ ÂøÍ¯õmkPøÍ 

ÂøÍ¯õkQßÓÚº. CuØPõP Q›UöPm, Tøh¨£¢x, PõÀ£¢x ÷£õßÓ 

ÂøÍ¯õmkUPÒ Põn¨£kÁxhß ©õnÁöµõ¸Áº SøÓ¢u£m\® J¸ 

ÂøÍ¯õmøh÷¯Ý® ÂøÍ¯õh ÷Ásk®. Azxhß J¸ ÂøÍ¯õmkUPõP 

©õnÁº SÊ Põn¨£hÀ ÷Ásk®.

RÊÒÍ uµÄPÒ Ah[Q¯ ¤ßÁ¸® AmhÁønø¯U P¸xP.

AÝ©v 

C»UP®

©õnÁº 

ö£¯º
¤Ó¢u vPv

ÂøÍ¯õmk 

C»UP®
ÂøÍ¯õmk Ao

A[PzuÁº

GsoUøP

1426 PÂx 

¤µ£õèÁº
2005'05'23 S001  Q›UöPm A 11

1426 PÂx 

¤µ£õèÁº
2005'05'23 S002 PõÀ£¢x A 16

1428 ö©õí©m 

©›UPõº
2005'02'07 S001  Q›UöPm B 11

1428 ö©õí©m 

©›UPõº
2005'02'07 S002 PõÀ£¢x A 16

1428 ö©õí©m 

©›UPõº
2005'02'07 S003 Tøh¨£¢x B 06

1429 áÛz A÷åP 2005'04'15 S001  Q›UöPm A 11

1429 áÛz A÷åP 2005'04'15 S003 Tøh¨£¢x A 06
           AmhÁøn 9.30  ÂøÍ¯õmiÀ £[S £ØÖ® ©õnÁº AmhÁøn
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                  CÆ AmhÁøn°À uµÁõÚx £»•øÓ «Ò £vÄö\´¯¨£mkÒÍøuU 

Põn»õ®. C¢{ø»ø¯z uÂº¨£uØPõP CuøÚz uÛzuÛ AmhÁønPÍõP¨ 

¤›¨÷£õ®. ©õnÁº  ÂÁµ[PøÍ ©õnÁº AmhÁøn°¾®  ^AmhÁøn 

9'31& ÂøÍ¯õmk ÂÁµ[PøÍ ÂøÍ¯õmk AmhÁøn°¾® ^AmhÁøn 

9'32&  ÁøPSÔ¨÷£õ®' 

AÝ©v 

C»UP®

©õnÁº 

ö£¯º

¤Ó¢u vPv

1426 2005'05'23

1428 2005'02'07

1429 2005'04'15

AmhÁøn 9.31 ©õnÁº AmhÁøn

ÂøÍ¯õmk   

C»UP®

ÂøÍ¯õmk A[PzuÁº 

GsoUøP

S001 Q›UöPm 11

S002 PõÀ£¢x 16

S003 Tøh¨£¢x 6

    AmhÁøn 9.32 ÂøÍ¯õmk  AmhÁøn

PÂx ¤µ£õèÁº

ö©õí©m 

©›UPõº

áÛz A÷åP

 

 ©õnÁº, ÂøÍ¯õmk AmhÁønPÐUQøh÷¯ £»ÂØS £» 

öuõhº¦øhø© (many-to-many) Põn¨£kQÓx. CuøÚ öuõhº¦{ø»z 

uµÄzuÍzv÷» «sk® JßÖUS¨ £» öuõhº¦øhø©¯õP ©õØÔ¯ø©UP 

•i²®.  CuØPõP   C¢u  C¸  AmhÁønPÐUS  ÷©»vP©õP  Cß÷Úõº  

‰ßÓõ®  AmhÁøn  ÷uøÁ¨£kQÓx.  (CuøÚ AmhÁøn  9.33  & 

©õnÁº_ÂøÍ¯õmk AmhÁøn¯õPU P¸x÷Áõ®). ©õnÁºPøÍ ¤µv 

{vzxÁ¨£kzu ©õnÁº AmhÁøn°À  AÝ©v  C»UP®, ÂøÍ¯õmøh¨ 

¤µv{vzxÁ¨£kzu ÂøÍ¯õmk AmhÁøn°À ÂøÍ¯õmk C»UP® 

÷£õßÓ ¦»[PøÍU öPõshuõP ©õnÁº_ÂøÍ¯õmk AmhÁøn Põn¨ 

£k®.
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AÝ©v C»UP®       ©õnÁº ö£¯º ¤Ó¢u vPv

1426 PÂx ¤µ£õèÁº 2005'05'23

1428 ö©õí©m ©›UPõº 2005'02'07

1429 áÛz A÷åP 2005'04'15

               ©õnÁº AmhÁøn

AÝ©v 

C»UP®

ÂøÍ¯õmk 

C»UP®

Ao

1426 S001 A
1426 S002 A
1428 S001 B
1428 S002 A
1428 S003 B
1429 S001 A
1429 S003 A

ÂøÍ¯õmk 

C»UP®

ÂøÍ¯õmk A[PzuÁºPÎß 

GsoUøP

S001 Q›UöPm 11
S002 PõØ£¢x 16
 S003 Tøh¨£¢x 6

AmhÁøn  9.33  ©õnÁº _ ÂøÍ¯õmk AmhÁøn

 AÝ©v C»UP®, ©õnÁº AmhÁøn°À •uÀ{ø»a \õÂ¯õS®. 

BÚõÀ, ©õnÁº - ÂøÍ¯õmk AmhÁøn°À A¢{¯a \õÂ¯õS®'

 ÂøÍ¯õmk C»UP® ÂøÍ¯õmk AmhÁøn°À •uÀ{ø»a                                

\õÂ¯õS®. BÚõÀ, ©õnÁº_ÂøÍ¯õmk AmhÁøn°À A¢{¯a                                                                                                               

\õÂ¯õS®'

 ©õnÁº_ÂøÍ¯õmk AmhÁøn°÷» •uÀ{ø»a \õÂ¯õÚx 

AÝ©v C»UP® + ÂøÍ¯õmk C»UP® BS®.

 ©õnÁº, ÂøÍ¯õmk AmhÁønPÐUQøh÷¯ £»ÂØS & £» 

öuõhº¦øhø© Põn¨£kQÓx. CuøÚ JßÖUS & £» öuõhº¦øhø©ø¯U 

öPõsh AmhÁønPÍõP¨ £õS£kzu¨£k® {ø»°À ö£Ó¨£k® öuõhº 

¦øhø©ø¯ RÊÒÍ E¸ 9.12 PõmkQÓx.

             ÂøÍ¯õmk  AmhÁøn
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AÝ©v C»UP® ö£¯º ¤Ó¢u vPv

AÝ©v C»UP® ÂøÍ¯õmk C»UP® Ao

ÂøÍ¯õmk C»UP® ÂøÍ¯õmk A[PzuÁºPÎß GsoUøP

 £»ÂØS & £»  öuõhº¦øhø©ø¯U öPõsh C¸ AmhÁøn-

PøÍ JßÖUS & £» öuõhº¦øhø©ø¯U öPõsh AmhÁønPÍõPU 

Põm]¨£kzuÀ.

  

E¸ 9'12 

Cuß ‰»®" 

©õnÁº, ©õnÁº_ÂøÍ¯õmk AmhÁønPÐUQøh÷¯ JßÖUS & £» 

öuõhº¦øhø© Põn¨£k®.

ÂøÍ¯õmk, ©õnÁº _ ÂøÍ¯õmk AmhÁønPÐUQøh÷¯ JßÖUS & £» 

öuõhº¦øhø© Põn¨£k®.

 GÚ÷Á, £»ÂØS - £» öuõhº¦øhø©ø¯ JßÖUS - £» öuõhº 

¦øhø©PÍõP ÷©»vP AmhÁønö¯õßøÓ E¸ÁõUSÁuß ‰»® ©õØÔ 

¯ø©UP •i²®.

9.5 uµÄz uÍ  •Põø©zxÁ  öuõSv  ö©ßö£õ¸øÍ¨  £¯ß£kzv  

      öuõhº¦{ø»z uµÄzuÍzøu E¸ÁõUSuÀ

 uµÄzuÍ •Põø©zxÁ ö©ßö£õ¸øÍ¨ £¯ß£kzv AmhÁøn-

PÐUQøh÷¯ öuõhº¦øhø©ø¯ ^Relationships& E¸ÁõUSÁx £ØÔ uØ÷£õx 

Bµõ´÷Áõ®. CuØPõP R÷Ç Põmh¨£mkÒÍÁõÖ ¦»¨ö£¯º, uµÄÁøPø¯U 

öPõsh ©õnÁº AmhÁøn ^E¸ 9'13& ©ØÖ® ¦ÒÎ AmhÁøn ^E¸ 9'14& 

÷£õßÓ C¸ AmhÁønPøÍ E¸ÁõUSP.

©õnÁº

AÝ©v C»UP®

©õnÁº ö£¯º

¤Ó¢u vPv

©õnÁº ÂøÍ¯õmk

AÝ©v C»UP®

ÂøÍ¯õmk

ÂøÍ¯õmk C»UP®

ÂøÍ¯õmk C»UP®

 Ao
ÂøÍ¯õmk

A[PzuÁºPÎß  Gs 

oUøP
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             E¸ 9.13 ©õnÁº AmhÁøn°÷» ¦»¨ö£¯º, uµÄÁøPPÒ

AÝ©v C»UP®

•uö»Êzxhß ö£¯º

¤Ó¢u vPv

öuõø»÷£] C»UP®

AÝ©vU Pmhn®

©õnÁº

                
  E¸ 9.14 ¦ÒÎ AmhÁøn°÷» ¦»¨ ö£¯º, uµÄ ÁøPPÒ

9.5.1  C¸ AmhÁønPÐUQøh÷¯ öuõhº¦øhø©ø¯ E¸ÁõUPÀ

Microsoft Office Access CÀ

Database Tools Iz öu›Äö\´P  

Relationship PmhøÍø¯z öu›Äö\´P 

 öuõhºø£ HØ£kzu ÷Ási¯ 

AmhÁønø¯z  öu›Äö\´P  Add 
PmhøÍ¨ ö£õzuõøÚa ö\õkUSP.

(÷uøÁ¯õÚ AmhÁøn GsoUøP 

Áøµ)  öuõhºø£ HØ£kzuz 

÷uøÁ¯õÚ AmhÁøn°ß A¢{¯a         

\õÂUS •uÀ{ø»a \õÂ¼¸¢x 

öuõhºø£ ÁøµP ^E¸  9'15&  Edit 
Relationship CÀ Põm]¨£kzu¨£k® 

Enforce Referential Integrity Iz öu›Äö\´P 

^E¸ 9'16 &  Cascade Update Related 
Field, Cascade Delete  Related Records 
Iz öu›Äö\´P  Create  PmhøÍ¨ 

ö£õzuõøÚa ö\õkUSP.   

LibreOffice CÀ

Tools Iz öu›Äö\´P  Rela-
tionship PmhøÍø¯z öu›Äö\´P 

 öuõhºø£ HØ£kzu ÷Ási¯ 

AmhÁønø¯z öu›Äö\´P  Add 
PmhøÍ¨ ö£õzuõøÚa       ö\õkUSP. 

^÷uøÁ¯õÚ AmhÁøn GsoUøP 

Áøµ&  öuõhºø£ HØ£kzuz 

÷uøÁ¯õÚ AmhÁøn°ß A¢{¯a 

\õÂUS •uÀ{ø»a \õÂ¼¸¢x 

öuõhºø£ ÁøµP  Relationship 
C÷» Á»x ö\õkUQ  Edit Iz öu›P 

 Relations CÀ  Põm]¨£kzu¨£k® 

Update Option CÀ Põn¨£k®   Up-
date cascade Iz öu›Äö\´P Delete 
Option CÀ Põn¨£k®   Delete cas-
cade Iz öu›Äö\´P. ̂E¸ 9'17&  OK 
PmhøÍ¨ ö£õzuõøÚa ö\õkUSP.

£Ÿmø\ _möhs

AÝ©v C»UP®

 Pou®

ÂgbõÚ®

B[Q»®

Á¸h®

¦ÒÎPÒ
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AÝ©v C»UP®

•uö»Êzxhß ö£¯º

¤Ó¢u vPv

öuõø»÷£] C»UP®

AÝ©vU Pmhn®

£Ÿmø\ _möhs 

AÝ©v C»UP®

Pou®

ÂbbõÚ®

B[Q»®

Á¸h®

E¸ 9.15  C¸ AmhÁønPÐUQøh÷¯ JßÖUS £» - öuõhº¦øhø©

            
E¸ 9.16  Editing Relationship ö\õÀ»õhØ ö£mi (Access)

©õnÁº ¦ÒÎPÒ

AÝ©v C»UP® AÝ©v C»UP®

E¸ 9.17  Relations ö\õÀ»õhØ ö£mi (LibreOffice Base)
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©õnÁº AmhÁøn°÷» AÝ©v C»UP® •uÀ{ø» \õÂ¯õS®. ¦ÒÎPÒ  

AmhÁøn°÷» Ax A¢{¯a \õÂ¯õS®.

SÔ¨¦ 

 AmhÁønPøÍ öuõhº¦£kzxÁuõÀ HØ£k® Â÷\h A®\[PÒ

  Referential Integrity Á\v ‰»® ©õnÁº AmhÁøn°¾ÒÍ 

•uÀ{ø» \õÂ°ß ö£Ö©v ©õØÓ¨£iß, A÷u ÷|õUPzvÀ 

CuÝhß öuõhº¦øh¯ AmhÁøn°ß A¢{¯a \õÂ°ß ö£Ö©õÚ•® 

ußÛaø\¯õP ©õØÓ©øh²®.

 Azxhß ©õnÁº AmhÁøn°À Kº £vÁõÚx }UP¨£iß, AuÝhß 

öuõhº¦øh¯ AmhÁøn°ß SÔzu £vÄhß öuõhº¦øh¯ £vÁõÚx 

ußÛaø\¯õP }UP¨£k®.

 C[S •u»õÁuõP ©õnÁº AmhÁønUS uµÄPÒ EÒÏkö\´uÀ 

÷Ásk®. ¤ßÚº ¦ÒÎPÒ AmhÁønUS uµÄPÒ EÒÎh¨£h •i²®.

 ©õnÁº AmhÁønUS uµÄPÒ EÒÏk ö\´u ¤ßÚº CÆ Am-

hÁøn ‰»® ¦ÒÎPÒ AmhÁønUS uµÄPÒ EÒÏk ö\´¯•i²®. 

CuØPõP ©õnÁº AmhÁøn°À AÝ©v C»UP® •ß£õP EÒÍ 

Aøh¯õÍzøu  ö\õkUSP C¢{ø»°À ¦ÒÎPÒ AmhÁønUS C»SÁõP 

uµÄPøÍ EÒÏkö\´¯ •i²®' ^E¸ 9'18 I AÁuõÛUP'&

.

E¸  9'18 - ©õnÁº, ¦ÒÎ AmhÁønPÐUS uµÄPøÍ EÒÏk ö\´uÀ

©õnÁº

öuõø»÷£] C»AÝ©v C»UP® AÝ©vU Pmhn®¤Ó¢u vPv•uö»Êzxhß ö£¯º

H.Bº.µSÁµß

£Ÿmø\ _möhß Pou® ÂgbõÚ® B[Q»® Á¸h®

£Ÿmø\ _möhß Pou® ÂgbõÚ® B[Q»® Á¸h®

GÀ.A÷\õU

G®.£›©Íõ

H.¼÷Úõ

H.H.H®.B°åõ

G®.G®.£ëÚõ

öá.Q›ìiÚõ
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 9.6 uµÄPøÍ    EÒÏk   ö\´ÁuØS®  Põm]¨£kzxÁuØS®   

       uµÄ¨ £iÁ[PøÍ E¸ÁõUSuÀ

 AmhÁønö¯õßøÓz vÓ¢x Av÷» uµÄPøÍ EÒÏk ö\´uÀ 

£ØÔ¯ AÔøÁ C¨÷£õx }º ö£ØÖÒÏº. uµÄzuÍ •Põø©zxÁz  

öuõSv°÷» AmhÁønUSz uµÄPøÍ EÒÏkö\´¯ £iÁ[PÒ ^Forms& 
£¯ß£kzu¨£kQßÓÚ. Azxhß AmhÁøn°÷» EÒÏkö\´u uµÄPøÍU 

Põm]¨£kzuÄ® £iÁ[PÒ £¯ß£kzu¨£kQßÓÚ.

       AmhÁøn 9.34 AmhÁøn²® uµÄ¨£iÁ•®

     ö£¯º   Â»õ\® öuõø»÷£]    ªßÚg\À

    AßÁº   Ax¸Q›¯ 0773684949 anvmom@dd.uk
     {©À   P÷»öÁ» 07184632481 nigl@ya.com
    _uõPµß    Psi 0817587484 suda@gmal.com
    \©ß   ÷PPõø»

ö£¯º

ö£¯º
 {©À

 \©ß
P÷»öÁ»

÷PPõø»
07184637481

Â»õ\®

Â»õ\®

öuõø»÷£]

öuõø»÷£]

ªßÚg\À

ªßÚg\À nigl@ya.com

       £iÁzvß ‰»® uµÄPøÍU Põm]¨£kzuÀ

£iÁzvß ‰»® uµÄPøÍ EÒÎhÀ 

 £iÁzvß ‰»® JÆ÷Áõº £vÁõP AmhÁønUS uµÄPøÍ EÒÏk 

ö\´¯ •i²®' ^AmhÁøn 9'34 I AÁuõÛUP&

 
C[S EÒÏk ö\´¯¨£k® AøÚzx® £vÄPÐ® AmhÁøn°ß 

CÖv°÷» JÆöÁõßÓõPa ÷\ºUP¨£k®. AmhÁøn°¾ÒÍ JÆ÷Áõº 

£vøÁ²® £iÁzvß ‰»® JÆöÁõßÓõPU Põm]¨£kzu •i²®. CuØPõP  
Record Navigation bar £¯ß£kzu¨£k®' ^E¸ 9'19 I¨ £õºUP &

E¸   9.19 uµÄ¨£iÁzvß ‰»® £vÄPøÍ AÁuõÛzuÀ

  
¦v¯ £vÄ

•uÀ £vÄ

•ßøÚ¯ £vÄ 
uØ÷£õøu¯ 

£vÄ
£vÄPÎß ö©õzu 

GsoUøP

Akzu £vÄ CÖv¨ £vÄ
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1'  uµÄ¨ £iÁö©õßøÓ E¸ÁõUSuÀ

Microsoft Office Access CÀ

Create → Form Design → Add Existing Fields → Show Tables → ÷uøÁ¯õÚ Am-

hÁønø¯z öu›Äö\´P → AmhÁøn°¾ÒÍ ¦»[PøÍ¨ £iÁzv÷» ÁøµP. 

^E¸ 9'20 I¨ £õºUP &

                E¸ 9.20  ©õnÁº AmhÁøn°À uµÄPøÍ EÒÎh¨ £¯ß£kzx® £iÁ®

•uö»Êzxhß ö£¯º

  öuõø»÷£]   C»UP®

¤Ó¢u vPv

AÝ©vU Pmhn®

•uö»Êzxhß ö£¯º

¤Ó¢u vPv

  öuõø»÷£]   C»UP®

AÝ©vU Pmhn®

AÝ©v C»UP®

¦v¯ £vøÁ EÒÏk ö\´uÀ £vøÁ }USuÀ

AÝ©v C»UP®

             

2'  AmhÁøn°¾ÒÍ £vÄPøÍ £iÁzvß ‰»® Põm]¨£kzuÀ

Microsoft Office Access CÀ

Home Tab →  View → Form View  ^E¸ 9'21 I¨ £õºUP&
 

E¸ 9'21 - ©õnÁº AmhÁøn°¾ÒÍ £vÄPøÍ Põm]¨£kzuÀ

£vøÁ }USuÀ

AÝ©v  C»UP®

¤Ó¢u vPv

öuõø»÷£] C»UP®

AÝ©vU Pmhn®

¦v¯ £vøÁ EÒÎhÀ

Ã.µõ©Q¸ìnß•uö»Êzxhß ö£¯º
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3'  £iÁzxUS Pmk¨£õmk ÁÈPõmiø¯a (Control Wizard) ÷\ºzuÀ

Microsoft Office Access CÀ

Design Tab → Control Wizards Iz öu›Äö\´P. ^E¸ 9'22 I¨ £õºUP&→xxxx GÚ 

Aøh¯õÍªh¨£mh ö£õzuõøÚz öu›Äö\´P' → £iÁzv÷» ö£õzuõøÚ CkP'

→ Command Button Wizard CÀ Record Operation Iz öu›Äö\´P. ̂ E¸ 9'23 I¨ £õºUP& → 
EÒÏk ö\´¯¨£k®  Action Iz öu›Äö\´P. ̂ E + ® - Add New Record& → ö£õzuõÝUS 

E›¯ ö£¯øµ ÁÇ[SP' → Finish ö£õzuõøÚa ö\õkUSP.

  
E¸ 9'22 - Pmk¨£õmkU P¸ÂPÒ

 
E¸ 9'23 - Command Button Wizard
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 9.7     uPÁÀPøÍ¨   ö£ÖÁuØPõP   ÂÚÁÀ    (Query)   JßøÓ 
         E¸ÁõUSuÀ

 ÂÚÁÀ ‰»® JßÖhöÚõßÖ öuõhº¦øh¯ AmhÁønPÎ¾ÒÍ 

uµÄPÎ¼¸¢x ÷uøÁ¯õÚ uPÁÀPøÍ¨ ö£Ó•i²®' ÂÚÁÀ ‰»® JÆ÷Áõº 

AmhÁøn°¾® öu›Ä ö\´¯¨£mh ¦»[PÐUS ö£õ¸zu©õÚ uµÄPÒ 

ÁøPUSÔUP¨£k®' ^AmhÁøn 9'35 I¨ £õºUP'&

©õnÁº 

C»UP®

ö£¯º ªßÚg\À

A1 ¦¦x Pu2@gmail.com
A2 £õ›ì pari@yahoo.com
A3 P©»ß Kam_n@hotmal.

com
A4 uÝáõ Thanu7@slt.lk

 

©õnÁº 

C»UP®

£õh 

Gs

¦ÒÎ 

A1 B1 67
A2 B3 89
A1 B3 50
A4 B2 75

£õh 

Gs

£õh®

B1 Pou®

B2 ÂgbõÚ®

B3 B[Q»®

÷©¾ÒÍ ‰ßÖ AmhÁønPÎÀ C¸¢x ÂÚÁÀ ‰»® ö£¯º, £õh®, ¦ÒÎ 

÷£õßÓ ÂÁµ[PÒ ö£Ó¨£iß, Ax ¤ßÁ¸©õÖ Põmh¨£k®.
 

AmhÁøn 9.35  ÂÚÁÀ ‰»® AmhÁønPÎ¼¸¢x uPÁÀPøÍ¨ ö£ÓÀ

 

 

 

ö£¯º £õh® ¦ÒÎ

¦¦x    Pou® 67
£õ›ì    B[Q»® 89
¦¦x    B[Q»® 50
uÝáõ    ÂgbõÚ® 75



C»Á\¨ £õh¡À328

ÂÚÁÀ JßøÓ E¸ÁõUSuÀ

 

Microsoft OfficeAccess CÀ

Create Tab → Query Design → ÷uøÁ¯õÚ AmhÁøn/ AmhÁønPøÍz öu›Ä 

ö\´P.  ̂  E¸ 9.24 I¨ £õºUP& → AmhÁøn / AmhÁønPÎÀ ÷uøÁ¯õÚ ¦»[PøÍz 

öu›Äö\´P ^E¸ 9.25 I¨ £õºUP& → ÂÚÁø» ö\¯Ø£kzxP' ^Run& 

              E¸ 9.24  AmhÁønPøÍz öu›Äö\´²® ö\õÀ»õhØ ö£mi

¦ÒÎPÒ
©õnÁº

AÝ©v C»UP®

¤Ó¢u vPv

öuõø»÷£] C»UP®

AÝ©v Pmhn®

£Ÿmø\ _möhß

©õnÁº

Pou®

ÂgVõÚ®

B[Q»®

Á¸h®

         

 

©õnÁº

E¸ 9.25  ÂÚÁø» E¸ÁõUS® vøµ

AÝ©v C»UP®
•uö»Êzxhß ö£¯º

  Pou®

   ¦ÒÎ

•uö»Êzxhß ö£¯º

          ©õnÁº

  AÝ©v C»UP®

     ©õnÁº

AÝ©v C»UP®
£Ÿmø\ _möhs

Á¸h®

  ¦ÒÎ

¤Ó¢u vPv

öuõø»÷£] C»UP®

AÝ©vU Pmhn®

Pou®

ÂgbõÚ®

B[Q»®

Á¸h®
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ÂÚÁø»a ö\¯Ø£kzv¯ ¤ßÚº ö£Ó¨£k® ÂøÍÁõÚx ¤ßÁ¸©õÖ 

Aø©²®'

         E¸  9. 26 ÂÚÁø»a ö\¯Ø£kzv¯ ¤ßÚº ö£Ó¨£mh uPÁÀ

 E¸ 9.26,  2013, 2014 BQ¯ Á¸h[PÎÀ ©õnÁº ö£ØÓ ¦ÒÎPøÍU 

PõmkQßÓx. C[S 2014 B® BsiÀ ©õzvµ® ©õnÁºPÒ ö£ØÓ ¦ÒÎPøÍ 

ö£Ó ÷Áskö©ÛÀ 2014 I Criteria BP ÁÇ[SÁuß ‰»® ^E¸ 9.27 I¨ 

£õºUP& 2014 B® BskUS›¯ ¦ÒÎPøÍ¨ ö£Ó•i²®. 

E¸ 9.28 ÂÚÁø» Criteria Ehß ö\¯Ø£kzx®÷£õx ö£Ó¨£k® uPÁÀ 

ÂÚÁÀ ‰»® ¦»[PÎ¾ÒÍ uµÄPøÍU Po¨¦PÐUS Em£kzu •i²®. 

©õnÁºPÒ ö£ØÓ ö©õzu¨ ¦ÒÎPøÍ¨ ö£Ö® Âu® £ØÔ Bµõ´÷Áõ®.

P¸nõãÁ Bº. ÷P. ]

P¸nõãÁ Bº. ÷P. ]

÷\õ©µzÚ H.¥.â

÷\õ©µzÚ H.¥.â

µõ\¦zµ® Gì. Gß

µõ\¦zµ® Gì. Gß

á¯÷\Pß GÀ. ÷P. Bº

á¯÷\Pß GÀ. ÷P. Bº

©›UPõº G®. Gß

©›UPõº G®. Gß

µõuQ¸ènõ j.³

µõuQ¸ènõ j.³

£ì¼Úõ G®. â

£ì¼Úõ G®. â

Pou®ö£¯º Á¸h®AÝ©v C»UP®

AÝ©v C»UP® •uö»Êzxhß ö£¯º Pou® Á¸h®

©õnÁº©õnÁº ¦ÒÎPÒ ¦ÒÎPÒ

P¸nõãÁ Bº. ÷P. ]

÷\õ©µzÚ H.¥.â

µõ\¦zµ® Gì. Gß

á¯÷\Pß GÀ. ÷P. Bº

©›UPõº G®. Gß

µõuQ¸ènõ j.³

£ì¼Úõ G®. â

Á¸h®Pou®

ÂÚÁø» Criteria Ehß ö\¯Ø£kzv¯ ¤ßÚº ö£Ó¨£k® ÂøÍÄ ¤ßÁ¸©õÖ Aø©²®

AÝ©v C»UP® •uö»Êzxhß ö£¯º

E¸ 9. 27 ÂÚÁÀ JßÔÀ Criteria I ÁÇ[SuÀ
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•uö»Êzxhß ö£¯º

©õnÁº

B[Q»® ö©õzu® Á¸h®

ö©õzu®

¦ÒÎ ¦ÒÎ ¦ÒÎ

¦ÒÎ ¦ÒÎ ¦ÒÎPou® ÂgbõÚ® B[Q»®

E¸ 9.30  ÷PõøÁø¯ E¸ÁõUS® ö\õÀ»õhØ ö£mi

 ÂÚÁ¼À ¦v¯÷uõº {µø» ö©õzu® GßÓ ö£¯›À E¸ÁõUQ, Av÷» 

|øhö£Ó ÷Ási¯ Poua ö\´øPUPõÚ ÷PõøÁø¯ ÁÇ[SuÀ ÷Ásk®.

       AuõÁx £õh[PÎß ö©õzu¨ ¦ÒÎø¯¨ ö£ÖÁuØPõP, ö©õzu®( 

[¦ÒÎ] æ [Pou®] ¬ [¦ÒÎ] æ [ÂgbõÚ®] ¬ [¦ÒÎ]æ [B[Q»®] GÚ umha_a 

ö\´uÀ ÷Ásk®. ^E¸ 9. 29 I¨ £õºUP& AÆÁõÔÀø»ö¯ÛÀ ÷PõøÁø¯ 

E¸ÁõUSÁuØS ö©õzu¨ ¦ÒÎPøÍU Põn÷Ási¯ {µ¼÷» Á»x 

ö£õzuõøÚa ö\õkUQ Build GßÓ PmhøÍø¯a ö\¯Ø£kzu ÷Ásk®. 

C¢{ø»°À ö£Ó¨£k® ö\õÀ»õhØ ö£mi ^ Dialogue box) I £¯ß£kzxP.   

^ E¸ 9.30 I¨ £õºUP&

E¸ 9.29 ÂÚÁ¼÷» ö©õzu¨ ¦ÒÎPÒ ö£Ó¨£k® {µø»U Põm]¨£kzuÀ

ö©õzu®: ^¦ÒÎ& ! ^Pou®& + ^¦ÒÎ & !                  

             ^ÂgbõÚ®& + ^¦ÒÎ& ! ^B[Q»®&

 

 

•uö»Êzxhß ö£¯º

Pou®

ÂgbõÚ®

B[Q»®

ö©õzu®

Pou® ÂgbõÚ®
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 CÆÁõÖ E¸ÁõUP¨£mh ÂÚÁø»a ö\¯Ø£kzv¯ ¤ßÚº ö£Ó¨£k® 

ÂøÍÄPÒ ¤ßÁ¸©õÖ Põn¨£k®. ^E¸ 9.31 I¨ £õºUP)
 

E¸ 9.31 - 2013 B® BsiÀ ©õnÁºPÒ ö£ØÓ ¦ÒÎPøÍ²®, AÁØÔß ö©õzuzøu²® 

Põm]¨£kzuÀ

9.8   uPÁÀPøÍ •ßøÁUP AÔUøPø¯ u¯õ›zuÀ

 öuõhº¦øhø© AmhÁønPÎ¾ÒÍ uµÄPÎ¼¸¢x ö£Ó¨£k® 

•UQ¯©õÚ uPÁÀPøÍ Aa]k® ÷|õUPzxUPõP AÔUøP¯õÚx u¯õ›UP¨ 

£kQÓx. AÔUøPø¯ E¸ÁõUP AmhÁøn ©ØÖ® ÂÚÁ¼¾ÒÍ uPÁÀPÒ 

£¯ß£kzu¨£kQßÓÚ.

 ÷©÷» E¸ 9.31 CÀ Põmh¨£mkÒÍ ÂÚÁÀ ‰»® ö£Ó¨£mh 

uPÁÀPÐUPõÚ AÔUøPø¯ E¸ÁõUS® •øÓø¯ Bµõ´÷Áõ®.

AÔUøPö¯õßøÓ C»SÁõP E¸ÁõUP ''Report Wizard'' £¯ß£kzu¨£kQÓx'

Microsoft Office Access CÀ

Create Tab → Report Wizard → ÷uøÁ¯õÚ AmhÁøn/ÂÚÁø»z 

öu›Äö\´P. ^E¸ 9.32 I¨ £õºUP&→ AmhÁøn / ÂÚÁ¼¼¸¢x 

AÔUøPUS ÷uøÁ¯õÚ ¦»[PøÍz öu›Äö\´P. → Next ö£õzuõøÚa 

ö\¯Ø£kzv ÷uøÁ¯õÚÁõÖ AÔUøPø¯ E¸ÁõUSP' → CÖv°÷» 

Finish ö£õzuõøÚa ö\õkUSP. C¢{ø»°À ö£Ó¨£k® AÔUøP¯õÚx 

E¸ 9.33 CÀ Põmh¨£mkÒÍx. 

Á¸h®£Ÿmø\ _möhs Pou® ÂgbõÚ® B[Q»® ö©õzu®•uö»Êzxhß ö£¯º

P¸nõãÁ Bº. ÷P. ]

÷\õ©µzÚ H.¥.â

µõ\¦zµ® Gì. Gß

á¯÷\Pß GÀ. ÷P. Bº

©›UPõº G®. Gß

µõuQ¸ènõ j.³

£ì¼Úõ G®. â
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E¸ 9.32  AÔUøPø¯ u¯õ›UP¨ £¯ß£kzu¨£k® Report Wizard 

   
                  

E¸ 9'33 - 2013 CÀ ¦ÒÎPÎß ö©õzuzøuU Põm]¨£kzx® AÔUøP
 

AÔUøP°À Põn¨£k® Gs\õº uµÄPøÍU Po¨¦US Em£kzx® •øÓ 

£ØÔ uØ÷£õx Bµõ´÷Áõ®. 

 CuØPõP ©õnÁºPÍõÀ ö\¾zu¨£mh AÝ©vU Pmhn[PÎß 

ö©õzuzøuU    Põs÷£õ®. Report Wizard I¨ £¯ß£kzv AÝ©v  C»UP®, 

ö£¯º ©ØÖ® AÝ©vU Pmhn® ÷£õßÓÁØøÓU öPõsh AÔUøPø¯ 

u¯õ›UP. ¤ßÚº  Report View C¼¸¢x  Design View CØS ©õØÖP. C¢{ø»°À 

ö£Ó¨£k® AÔUøP°ß ÁiÁ©õÚx E¸ 9.34 CÀ uµ¨£mkÒÍx.  

Á¸h® 2013

•uö»Êzxhß ö£¯º

Pou®

ÂgbõÚ®

B[Q»®

ö©õzu®

Á¸h®

£Ÿmø\ 

_möhs
•uö»Êzxhß ö£¯º Pou® ÂgbõÚ® B[Q»® ö©õzu® Á¸h®

¦ÒÎ AmhÁøn

P¸nõãÁ Bº. ÷P. ]

÷\õ©µzÚ H.¥.â

µõ\¦zµ® Gì. Gß

á¯÷\Pß GÀ. ÷P. Bº

©›UPõº G®. Gß

µõuQ¸ènõ j.³

£ì¼Úõ G®. â

£Ÿmø\ _möhs
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E¸  9.34  AÔUøP°ß ÁiÁø©¨¦ (Design view)

 Tool bar C¾ÒÍ ab GÝ® Tool Iz öu›Äö\´x Report Footer CÀ J¸  

Text box I ÁøµP'

E¸   9.35 £õh¨ ö£miø¯  EÒÎhÀ

 Text box BÚx Unbound GÚU Põm]¨£kzu¨£k®. CuØSU Põµn® 

AuØS ¦»ö©õßÖ öuõhº¦£kzu¨£hõø©¯õS®. CuØS AÝ©vU Pmh 

n[PÎß ö©õzuzøuz öuõhº¦£kzu ÷Áskö©ÛÀ, Property Sheet CÀ  

Control Source C¾ÒÍ ‰ßÖ ¦ÒÎPÒ öPõsh ö£õzuõøÚa ö\¯Ø£kzxP. 

^E¸ 9.36 I¨ £õºUP& C¢{ø»°À ÷PõøÁø¯ E¸ÁõUSÁuØSz ÷uøÁ¯õÚ 

ö\õÀ»õhØ ö£mi Põm]¨£kzu¨£k® ^E¸ 9.37 I¨ £õºUP&.   

                       E¸ 9.36  Property Sheet

Pmhn®

AÝ©v C»UP® •uö»Êzxhß ö£¯º AÝ©vU Pmhn®

AÝ©v C»UP® •uö»Êzxhß ö£¯º AÝ©vU Pmhn®
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                                         E¸ 9.37  ÷PõøÁø¯ E¸ÁõUS® ö\õÀ»õhØ ö£mi

 AÝ©vU Pmhn[PÎß ö©õzuzøu¨ ö£Ó = Sum ([©õnÁº]![                                                                                                                     
AÝ©v Pmhn®])  GÚz umha_a ö\´¯÷Ásk®. AÀ»x CU÷PõøÁø¯ 

E¸ÁõUQ¯uß ¤ßÚº ̂  E¸ 9.37 I¨ £¯ß£kzv & OK ö£õzuõøÚa ö\õkUSP' 

CÖv¯õP Design View C¼¸¢x  Report View CØS ©õØÖP. C¢{ø»°À 

AÝ©vU Pmhn[PÎß ö©õzuzøuU Põm]¨£kzx® AÔUøP ¤ßÁ¸©õÖ 

Aø©²® ^E¸ 9.38 I¨ £õºUP&

Pmhn®

AÝ©v C»UP® •uö»Êzxhß ö£¯º AÝ©vU Pmhn®

P¸nõãÁ Bº. ÷P. ]

÷\õ©µzÚ H.¥.â

µõ\¦zµ® Gì. Gß

á¯÷\Pß GÀ. ÷P. Bº

©›UPõº G®. Gß

µõuQ¸ènõ j.³

£ì¼Úõ G®. â

ö©õzu®

©õnÁº AÝ©vU Pmhn®

¦ÒÎPÒ

©õnÁº

Pmhn®

E¸ 9.38  AÝ©vU Pmhn[PÎß ö©õzuzøuU Põm]¨£kzx® AÔUøP
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AÔUøPø¯ Aa]hÀ

 Põm]ø¯ Report View C¼¸¢x Print Preview CØS ©õØÖP. ÷uøÁ¯õÚ 

¤µvPøÍ Aa]kÁuØPõP E¸  9.39 CÀ Põmh¨£mkÒÍ Aa_¨ £hÄ¸øÁa   

ö\õkUSP.

E¸  9.39  Aa_¨ £hÄ¸

 

^1& C»zvµÛ¯À uµÄzuÍzv¾ÒÍ AÝT»[PøÍ ÂÍUSP.

^2& C»zvµÛ¯À uµÄzuÍzvß C¯À¦PøÍPøÍ Euõµn[PÐhß    

     ÂÍUSP.

^3&  C»zvµÛ¯À ©ØÖ® øP•øÓz uµÄzuÍ[PøÍ J¨¥k ö\´P.

^4&  uµÄ SÔ•øÓ¯õUP® (Data encryption) Gß£øu ÂÍUSP'

^5&  ¦»®, £vÄ AmhÁøn ÷£õßÓÁØÔÀ öuõhº¦{ø» uµÄzuÍ®                  

 (Relational database) E¸ÁõUP¨£mkÒÍ Âuzøu ÂÍUSP 

^6&  •uÀ{ø»a \õÂø¯ Áøµ¯Özx AuØS ‰ßÖ Euõµn[PøÍ GÊxP.

^7&  ÷\º©õÚa \õÂø¯ (Composite key)  Áøµ¯Özx AuØS ‰ßÖ                                                   

 Euõµn[PøÍ  GÊxP.

^8&  A¢{¯a \õÂø¯ (Foreign key) Áøµ¯Özx AuØS ‰ßÖ Euõµn[PøÍ   

 GÊxP.

^9&  uµÄ «Ò£vÁõUP® (Data duplication) BÀ HØ£k® I¢x ¤µvT»[PøÍ   

 GÊxP. 

^10& (a)  uµÄÁøP (Data type) Gß£øu ÂÍUSP, AuØS Euõµn[PøÍU                

          SÔ¨¤kP.

       (b) öuõø»÷£] C»UPzøuU öPõsh ¦»zvß uµÄÁøP¯õP (Integer)   

  ö£õ¸zu©ßÖ CuØPõÚ Põµnzøu ÂÍUSP.

^11& öuõhº¦{ø»z uµÄz uÍzvÀ £¯ß£kzu¨£k® JßÖUS & JßÖ ,  

JßÖUS & £», £»ÄUS & £» öuõhº¦hø©PøÍ ÂÍUSP. CÆÁøP-

PÐUS Cµsk Euõµn[PÒ Ãu® GÊxP

^12&  uµÄzuÍ •Põø©zxÁ öuõSv (DBMS) C¾ÒÍ C»US¨ ö£õ¸ÒPøÍ   

  (Objects) GÊxP. AÁØÔß £¯ß£õkPøÍz öuÎÁõP ÂÍUSP.

  ö\¯Ø£õk 
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ö£õÈ¨¦

● JÊ[S£kzu¨£mh uµÄPÎß öuõS¨£õÚx uµÄz uÍö©Ú¨£k®.

   1. AmhÁøn°¾ÒÍ {µ»õÚx ¦»®  ^Field& BS®'

   2. AmhÁøn°¾ÒÍ {øµ¯õÚx £vÄ ^Record& BS®'

● C»zvµÛ¯À uµÄz uÍzvß AÝT»[PÒ

  1. uPÁÀPøÍ ÂøÚzvÓÝhß ÷uiU öPõÒÍ •i²®.

  2. C»SÁõP¨ ¤µvPøÍ¨ ö£Ó •i²®.

  3. uµÄPøÍa ÷\ªUP ªPU SøÓ¢u öPõÒvÓß ÷uøÁ¯õS®. 

  4. uµÄPøÍ ªP ÷ÁP©õPÄ® C»SÁõPÄ® £S¨£õ´Ä ö\´¯ •i²®.

  5. uµÄzuÍzøu¨ £Qµ¨£h •i²®.

  6. uµÄPÎÚx _¯õwÚz ußø© Põn¨£k®.

● uµÄzuÍzvß C¯À¦PÒ

 1. «Ò£vÄ ö\´Áx uÂºUP¨£h ÷Ásk®.

 2. uµÄPÎß uÛzxÁ® ÷£n¨£k®.

 3. ÂøÚzvÓß AvP®.

 4. v¸zu® AvP®.

 5. uµÄPÎß \õzv¯z ußø© AvP®.

 6. uµÄPÎß £õxPõ¨¦ AvP®.

AmhÁøn°÷»  £vÄPøÍ  uÛzxÁ©õP  Aøh¯õÍ¨£kzu £¯ß£kzu¨ 

£k®. ¦»® (¦»a÷\º©õÚ®)  •uÀ{ø»a \õÂ ^Primary Key& BP P¸u¨£k®'

AmhÁønö¯õßÔß  ¦»® (¦»a÷\º©õÚ®) ‰»® Cß÷Úõº AmhÁøn°ß 

£vøÁ uÛzxÁ©õP Aøh¯õÍ¨£kzu •i²ö©ÛÀ, A¨¦»® A¢{¯a \õÂ 

^Foreign Key& BPU P¸u¨£k®' 

A¢{¯a \õÂ ‰»® Cµsk AmhÁønPÐUQøh÷¯ öuõhº¦øhø© ^Rela-
tionship& E¸ÁõUP¨£k®' 

AmhÁønö¯õßÔÀ JÆ÷Áõº {µ¼¾® uµÁõÚx «Ò£vÄ ö\´¯¨£kÁx 

uµÄ «Ò£vÁõUP® ^Data Duplication& GÚ AøÇUP¨£k®.

uµÄPøÍ ÷\ªUS®÷£õx J÷µ uµÁõÚx £» AmhÁønPÎÀ ÷\ªUP¨£kÁx 

uµÄ ©Ö£vÁõUP® ^Data Redundancy& GÚ AøÇUP¨£k®'

J¸ ¦»zvß ö£õ¸zu©õÚ uµÄPÍõÀ Auß uµÄÁøP ^Data Type& 
wº©õÛUP¨£k®.
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öuõhº¦{ø»z uµÄzuÍzvÀ AmhÁønPÐUQøh÷¯ JßÖUS - JßÖ   

JßÖUS - £»,  £»ÂØS - £» ÷£õßÓ ‰ßÖ öuõhº¦øhø©PÒ Põn¨£k®.

uµÄPøÍ EÒÏk ö\´¯Ä® Põm]¨£kzuÄ® uµÄ¨£iÁ[PÒ ^Forms& 
£¯ß£kzu¨£k®.

uPÁÀPøÍ¨ ö£ÖÁuØPõP, ÂÚÁÀ ^Query& £¯ß£kzu¨£k®

uPÁÀPøÍ •ßøÁUP / Aa]h AÔUøP ^Report&  £¯ß£kzu¨£k®'




